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2.7.57  CARLOSS (ML1000, ML100T, MLFX)     2-66

Clear the CARLOSS (ML1000, ML100T, MLFX) Alarm     2-66

2.7.58  CARLOSS (TRUNK)     2-67

2.7.59  CASETEMP-DEG     2-67

2.7.60  CLDRESTART     2-67

Clear the CLDRESTART Condition     2-67

2.7.61  COMIOXC     2-68

Clear the COMIOXC Alarm     2-68

2.7.62  COMM-FAIL     2-68

Clear the COMM-FAIL Alarm     2-68

2.7.63  CONTBUS-A-18     2-69

Clear the CONTBUS-A-18 Alarm     2-69

2.7.64  CONTBUS-B-18     2-69

Clear the CONTBUS-B-18 Alarm     2-69

2.7.65  CONTBUS-DISABLED     2-70

Clear the CONTBUS-DISABLED Alarm     2-70

2.7.66  CONTBUS-IO-A     2-71

Clear the CONTBUS-IO-A Alarm     2-71

2.7.67  CONTBUS-IO-B     2-72

Clear the CONTBUS-IO-B Alarm     2-72

2.7.68  CPP-INCAPABLE     2-72

Clear the CPP-INCAPABLE Alarm     2-73

2.7.69  CTNEQPT-MISMATCH     2-73

Clear the CTNEQPT-MISMATCH Condition     2-73

2.7.70  CTNEQPT-PBPROT     2-74

Clear the CTNEQPT-PBPROT Alarm     2-74

2.7.71  CTNEQPT-PBWORK     2-75
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Clear the CTNEQPT-PBWORK Alarm     2-75

2.7.72  DATA-CRC     2-76

Clear the DATA-CRC Alarm     2-77

2.7.73  DATAFLT     2-77

Clear the DATAFLT Alarm     2-77

2.7.74  DBOSYNC     2-77

Clear the DBOSYNC Alarm     2-78

2.7.75  DCU-LOSS-FAIL     2-78

2.7.76  DISCONNECTED     2-78

Clear the DISCONNECTED Alarm     2-78

2.7.77  DS3-MISM     2-79

Clear the DS3-MISM Condition     2-79

2.7.78  DSP-COMM-FAIL     2-79

2.7.79  DSP-FAIL     2-79

2.7.80  DUP-IPADDR     2-79

Clear the DUP-IPADDR Alarm     2-80

2.7.81  DUP-NODENAME     2-80

Clear the DUP-NODENAME Alarm     2-80

2.7.82  DUP-SHELF-ID     2-81

2.7.83  EHIBATVG     2-81

Clear the EHIBATVG Alarm     2-81

2.7.84  ELWBATVG     2-81

Clear the ELWBATVG Alarm     2-81

2.7.85  ENCAP-MISMATCH-P     2-81

Clear the ENCAP-MISMATCH-P Alarm     2-82

2.7.86  EOC     2-83

Clear the EOC Alarm     2-84

2.7.87  EOC-L      2-85

Clear the EOC-L Alarm     2-86

2.7.88  EQPT     2-86

Clear the EQPT Alarm     2-87

2.7.89  EQPT-DIAG     2-87

Clear the EQPT-DIAG Alarm     2-87

2.7.90  EQPT-MISS     2-87

Clear the EQPT-MISS Alarm     2-88

2.7.91  ERFI-P-CONN      2-88

Clear the ERFI-P-CONN Condition     2-88

2.7.92  ERFI-P-PAYLD     2-88

Clear the ERFI-P-PAYLD Condition     2-89

2.7.93  ERFI-P-SRVR     2-89
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Clear the ERFI-P-SRVR Condition     2-89

2.7.94  ERROR-CONFIG     2-89

Clear the ERROR-CONFIG Alarm     2-90

2.7.95  ETH-LINKLOSS     2-90

Clear the ETH-LINKLOSS Condition     2-91

2.7.96  E-W-MISMATCH     2-91

Clear the E-W-MISMATCH Alarm with a Physical Switch     2-91

Clear the E-W-MISMATCH Alarm in CTC     2-92

2.7.97  EXCCOL     2-93

Clear the EXCCOL Alarm     2-93

2.7.98  EXERCISE-RING-FAIL     2-93

Clear the EXERCISE-RING-FAIL Condition     2-94

2.7.99  EXERCISE-SPAN-FAIL     2-94

Clear the EXERCISE-SPAN-FAIL Condition     2-94

2.7.100  EXT     2-94

Clear the EXT Alarm     2-95

2.7.101  EXTRA-TRAF-PREEMPT     2-95

Clear the EXTRA-TRAF-PREEMPT Alarm     2-95

2.7.102  FAILTOSW     2-95

Clear the FAILTOSW Condition     2-96

2.7.103  FAILTOSW-PATH     2-96

Clear the FAILTOSW-PATH Condition in a Path Protection Configuration     2-96

2.7.104  FAILTOSWR     2-97

Clear the FAILTOSWR Condition in a BLSR Configuration     2-97

2.7.105  FAILTOSWS     2-99

Clear the FAILTOSWS Condition     2-99

2.7.106  FAN     2-100

Clear the FAN Alarm     2-100

2.7.107  FAPS     2-101

Clear the FAPS Alarm     2-101

2.7.108  FAPS-CONFIG-MISMATCH     2-101

2.7.109  FC-DE-NES     2-101

Clear the FC-DE-NES Alarm     2-101

2.7.110  FC-NO-CREDITS     2-102

Clear the FC-NO-CREDITS Alarm     2-102

2.7.111  FDI     2-103

2.7.112  FE-AIS     2-103

Clear the FE-AIS Condition     2-103

2.7.113  FEC-MISM     2-103

2.7.114  FE-DS1-MULTLOS     2-104
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Clear the FE-DS1-MULTLOS Condition     2-104

2.7.115  FE-DS1-NSA     2-104

Clear the FE-DS1-NSA Condition     2-104

2.7.116  FE-DS1-SA     2-105

Clear the FE-DS1-SA Condition     2-105

2.7.117  FE-DS1-SNGLLOS     2-105

Clear the FE-DS1-SNGLLOS Condition     2-105

2.7.118  FE-DS3-NSA     2-105

Clear the FE-DS3-NSA Condition     2-106

2.7.119  FE-DS3-SA     2-106

Clear the FE-DS3-SA Condition     2-106

2.7.120  FE-EQPT-NSA     2-106

Clear the FE-EQPT-NSA Condition     2-107

2.7.121  FE-FRCDWKSWBK-SPAN     2-107

Clear the FE-FRCDWKSWBK-SPAN Condition     2-107

2.7.122  FE-FRCDWKSWPR-RING     2-107

Clear the FE-FRCDWKSWPR-RING Condition     2-108

2.7.123  FE-FRCDWKSWPR-SPAN     2-108

Clear the FE-FRCDWKSWPR-SPAN Condition     2-108

2.7.124  FE-IDLE     2-108

Clear the FE-IDLE Condition     2-109

2.7.125  FE-LOCKOUTOFPR-SPAN     2-109

Clear the FE-LOCKOUTOFPR-SPAN Condition     2-109

2.7.126  FE-LOF     2-109

Clear the FE-LOF Condition     2-110

2.7.127  FE-LOS     2-110

Clear the FE-LOS Condition     2-110

2.7.128  FE-MANWKSWBK-SPAN     2-110

Clear the FE-MANWKSWBK-SPAN Condition     2-111

2.7.129  FE-MANWKSWPR-RING     2-111

Clear the FE-MANWKSWPR-RING Condition     2-111

2.7.130  FE-MANWKSWPR-SPAN     2-111

Clear the FE-MANWKSWPR-SPAN Condition     2-112

2.7.131  FEPRLF     2-112

Clear the FEPRLF Alarm on a Four-Fiber BLSR     2-112

2.7.132  FIBERTEMP-DEG     2-112

2.7.133  FORCED-REQ     2-112

Clear the FORCED-REQ Condition     2-113

2.7.134  FORCED-REQ-RING     2-113

Clear the FORCED-REQ-RING Condition     2-113
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2.7.135  FORCED-REQ-SPAN     2-114

Clear the FORCED-REQ-SPAN Condition     2-114

2.7.136  FP-LINK-LOSS     2-114

Clear the FP-LINK-LOSS Condition     2-114

2.7.137  FRCDSWTOINT     2-114

2.7.138  FRCDSWTOPRI     2-115

2.7.139  FRCDSWTOSEC     2-115

2.7.140  FRCDSWTOTHIRD     2-115

2.7.141  FRNGSYNC     2-115

Clear the FRNGSYNC Condition     2-116

2.7.142  FSTSYNC     2-116

2.7.143  FTA-MISMATCH     2-116

2.7.144  FULLPASSTHR-BI     2-116

Clear the FULLPASSTHR-BI Condition     2-117

2.7.145  GAIN-HDEG     2-117

2.7.146  GAIN-HFAIL     2-117

2.7.147  GAIN-LDEG     2-117

2.7.148  GAIN-LFAIL     2-117

2.7.149  GCC-EOC     2-117

2.7.150  GE-OOSYNC     2-117

2.7.151  GFP-CSF     2-117

Clear the GFP-CSF Alarm     2-118

2.7.152  GFP-DE-MISMATCH     2-118

Clear the GFP-DE-MISMATCH Alarm     2-118

2.7.153  GFP-EX-MISMATCH     2-119

Clear the GFP-EX-MISMATCH Alarm     2-119

2.7.154  GFP-LFD     2-119

Clear the GFP-LFD Alarm     2-120

2.7.155  GFP-NO-BUFFERS     2-120

Clear the GFP-NO-BUFFERS Alarm     2-120

2.7.156  GFP-UP-MISMATCH     2-121

Clear the GFP-UP-MISMATCH Alarm     2-121

2.7.157  HELLO     2-121

Clear the HELLO Alarm     2-122

2.7.158  HIBATVG     2-122

Clear the HIBATVG Alarm     2-122

2.7.159  HI-CCVOLT     2-122

Clear the HI-CCVOLT Condition     2-122

2.7.160  HI-LASERBIAS     2-123

Clear the HI-LASERBIAS Alarm     2-123
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2.7.161  HI-LASERTEMP     2-123

Clear the HI-LASERTEMP Alarm     2-124

2.7.162  HI-RXPOWER     2-124

Clear the HI-RXPOWER Alarm     2-125

2.7.163  HITEMP     2-125

Clear the HITEMP Alarm     2-125

2.7.164  HI-TXPOWER     2-126

Clear the HI-TXPOWER Alarm     2-126

2.7.165  HLDOVRSYNC     2-127

Clear the HLDOVRSYNC Condition     2-127

2.7.166  I-HITEMP     2-128

Clear the I-HITEMP Alarm     2-128

2.7.167  ILK-FAIL     2-128

2.7.168  IMPROPRMVL     2-128

Clear the IMPROPRMVL Alarm     2-129

2.7.169  INCOMPATIBLE-SEND-PDIP     2-130

Clear the INCOMPATIBLE-SEND-PDIP Alarm     2-130

2.7.170  INCOMPATIBLE-SW     2-130

Clear the INCOMPATIBLE-SW Alarm     2-130

2.7.171  INC-ISD     2-130

2.7.172  INHSWPR     2-131

Clear the INHSWPR Condition     2-131

2.7.173  INHSWWKG     2-131

Clear the INHSWWKG Condition     2-131

2.7.174  INTRUSION-PSWD     2-132

Clear the INTRUSION-PSWD Condition     2-132

2.7.175  INVMACADR     2-132

Clear the INVMACADR Alarm     2-133

2.7.176  IOSCFGCOPY     2-134

2.7.177  ISIS-ADJ-FAIL     2-134

Clear the ISIS-ADJ-FAIL Alarm     2-135

2.7.178  KB-PASSTHR     2-136

Clear the KB-PASSTHR Condition     2-136

2.7.179  KBYTE-APS-CHAN-FAIL     2-136

Clear the KBYTE-APS-CHAN-FAIL Alarm     2-136

2.7.180  LAN-POL-REV     2-137

Clear the LAN-POL-REV Condition     2-137

2.7.181  LASER-APR     2-137

2.7.182  LASERBIAS-DEG     2-137

2.7.183  LASERBIAS-FAIL     2-138
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2.7.184  LASEREOL     2-138

Clear the LASEREOL Alarm     2-138

2.7.185  LASERTEMP-DEG     2-138

2.7.186  LCAS-CRC     2-138

Clear the LCAS-CRC Condition     2-139

2.7.187  LCAS-RX-DNU     2-139

Clear the LCAS-RX-DNU Condition     2-140

2.7.188  LCAS-RX-FAIL     2-140

Clear the LCAS-RX-FAIL Condition     2-140

2.7.189  LCAS-RX-GRP-ERR     2-141

Clear the LCAS-RX-GRP-ERR Condition     2-141

2.7.190  LCAS-TX-ADD     2-141

2.7.191  LCAS-TX-DNU     2-141

2.7.192  LINK-KEEPALIVE     2-142

Clear the LINK-KEEPALIVE Alarm     2-142

2.7.193  LKOUTPR-S     2-142

Clear the LKOUTPR-S Condition     2-143

2.7.194  LMP-FAIL     2-143

Clear the LMP-FAIL Alarm     2-143

2.7.195  LMP-SD     2-144

Clear the LMP-SD Condition     2-145

2.7.196  LMP-SF     2-145

Clear the LMP-SF Condition     2-146

2.7.197  LMP-UNALLOC     2-146

2.7.198  LOA     2-147

Clear the LOA Alarm     2-147

2.7.199  LOCKOUT-REQ     2-148

Clear the LOCKOUT-REQ Condition     2-148

2.7.200  LOF (BITS)     2-148

Clear the LOF (BITS) Alarm     2-148

2.7.201  LOF (DS1)      2-149

Clear the LOF (DS1) Alarm     2-149

2.7.202  LOF (DS3)      2-150

Clear the LOF (DS3) Alarm     2-150

2.7.203  LOF (E1)     2-150

Clear the LOF (E1) Alarm     2-151

2.7.204  LOF (EC1)     2-151

Clear the LOF (EC1) Alarm     2-151

2.7.205  LOF (OCN)     2-152

Clear the LOF (OCN) Alarm     2-152
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2.7.206  LOF (STSTRM)     2-152

Clear the LOF (STSTRM) Alarm     2-153

2.7.207  LOF (TRUNK)     2-153

2.7.208  LOGBUFR90     2-153

2.7.209  LOGBUFROVFL     2-153

Clear the LOGBUFROVFL Alarm     2-153

2.7.210  LO-LASERBIAS     2-154

Clear the LO-LASERBIAS Alarm     2-154

2.7.211  LO-LASERTEMP     2-154

Clear the LO-LASERTEMP Alarm     2-155

2.7.212  LOM     2-155

Clear the LOM Alarm     2-155

2.7.213  LOP-P     2-155

Clear the LOP-P Alarm     2-156

2.7.214  LOP-V     2-156

Clear the LOP-V Alarm     2-157

2.7.215  LO-RXPOWER     2-157

Clear the LO-RXPOWER Alarm     2-157

2.7.216  LOS (2R)     2-158

2.7.217  LOS (BITS)     2-158

Clear the LOS (BITS) Alarm     2-158

2.7.218  LOS (DS1)     2-159

Clear the LOS (DS1) Alarm     2-159

2.7.219  LOS (DS3)     2-160

Clear the LOS (DS3) Alarm     2-161

2.7.220  LOS (E1)      2-162

Clear the LOS (E1) Alarm     2-162

2.7.221  LOS (EC1)     2-163

Clear the LOS (EC1) Alarm     2-163

2.7.222  LOS (ESCON)     2-164

2.7.223  LOS (FUDC)     2-164

Clear the LOS (FUDC) Alarm     2-164

2.7.224  LOS (ISC)     2-165

2.7.225  LOS (MSUDC)     2-165

2.7.226  LOS (OCN)     2-165

Clear the LOS (OCN) Alarm     2-166

2.7.227  LOS (OTS)     2-167

2.7.228  LOS (TRUNK)     2-167

2.7.229  LOS-O     2-167

2.7.230  LOS-P (OCH)     2-167
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2.7.231  LOS-P (OMS, OTS)      2-167

2.7.232  LOS-P (TRUNK)     2-167

2.7.233  LO-TXPOWER     2-167

Clear the LO-TXPOWER Alarm     2-168

2.7.234  LPBKCRS     2-168

Clear the LPBKCRS Condition     2-168

2.7.235  LPBKDS3FEAC     2-169

Clear the LPBKDS3FEAC Condition     2-169

2.7.236  LPBKDS3FEAC-CMD     2-169

2.7.237  LPBKFACILITY (CEMR, CE1000, CE100T)     2-169

Clear the LPBKFACILITY (CEMR, CE1000, CE100T) Condition     2-170

2.7.238  LPBKFACILITY (DS1, DS3)      2-170

Clear the LPBKFACILITY (DS1, DS3) Condition     2-170

2.7.239  LPBKFACILITY (E1)     2-171

Clear the LPBKFACILITY (E1) Condition     2-171

2.7.240  LPBKFACILITY (EC1)     2-171

Clear the LPBKFACILITY (EC1) Condition     2-172

2.7.241  LPBKFACILITY (ESCON)     2-172

2.7.242  LPBKFACILITY (FC)     2-172

2.7.243  LPBKFACILITY (FCMR)     2-172

Clear the LPBKFACILITY (FCMR) Condition     2-172

2.7.244  LPBKFACILITY (G1000)     2-172

Clear the LPBKFACILITY (G1000) Condition     2-173

2.7.245  LPBKFACILITY (GE)     2-173

2.7.246  LPBKFACILITY (ISC)     2-173

2.7.247  CLPBKFACILITY (OCN)     2-173

Clear the LPBKFACILITY (OCN) Condition     2-174

2.7.248  LPBKFACILITY (TRUNK)      2-174

2.7.249  LPBKTERMINAL (CEMR, CE1000, CE100T)     2-174

Clear the LPBKTERMINAL (CEMR, CE1000, CE100T) Condition     2-174
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Clear the LPBKTERMINAL (FCMR) Condition     2-176
xx
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Contents
2.7.256  LPBKTERMINAL (G1000)     2-177

Clear the LPBKTERMINAL (G1000) Condition     2-177
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2.7.262  MAN-REQ     2-179

Clear the MAN-REQ Condition     2-179

2.7.263  MANRESET     2-179

2.7.264  MANSWTOINT     2-179

2.7.265  MANSWTOPRI     2-180

2.7.266  MANSWTOSEC     2-180

2.7.267  MANSWTOTHIRD     2-180

2.7.268  MANUAL-REQ-RING     2-180

Clear the MANUAL-REQ-RING Condition     2-181

2.7.269  MANUAL-REQ-SPAN     2-181

Clear the MANUAL-REQ-SPAN Condition     2-181

2.7.270  MAX-STATIONS     2-181
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2.7.285  NOT-AUTHENTICATED     2-189
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Clear the OPEN-SLOT Condition     2-192
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Clear the PWR-FAIL-B Alarm     2-202
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Preface

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This section explains the objectives, intended audience, and organization of this publication and 
describes the conventions that convey instructions and other information.

This section provides the following information:

 • Revision History

 • Document Objectives

 • Audience

 • Related Documentation

 • Document Conventions

 • Obtaining Optical Networking Information

 • Obtaining Documentation and Submitting a Service Request

Revision History
This is the first issue of this publication.

Date Notes

November 2007 Added this Revision History Table

Updated APC-DISABLED alarm details in the "Alarms and Conditions Listed By 
Alphabetical Entry" and "Alarm List by Logical Object Type" sections of Chapter 
2, Alarm Troubleshooting.

April 2008  • Updated section "2.7.326 PORT-MISMATCH" (changed ML-Series to 
ML-MR-10) of Chapter 2, Alarm Troubleshooting

 • Added EID-6147 and EID-6148 in the Error Messages chapter.

June 2008 Updated FAILTOSW alarm in Chapter 2, Alarm Troubleshooting.
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Preface
  
Document Objectives
This guide gives general troubleshooting instructions, alarm troubleshooting instructions, equipment 
replacement instructions, and a list of error messages that apply to the ONS 15454. This information is 
contained in four chapters. Use this guide in conjunction with the appropriate publications listed in the 
Related Documentation section.

Audience
To use this publication, you should be familiar with Cisco or equivalent optical transmission hardware 
and cabling, telecommunications hardware and cabling, electronic circuitry and wiring practices, and 
preferably have experience as a telecomunications technician.

February 2009 Updated PORT-MISMATCH alarm details in Chapter 2, Alarm Troubleshooting.

March 2009 Deleted references to the ADD-OPWR-HDEG, ADD-OPWR-LDEG, 
ADD-OPWR-HFAIL, and ADD-OPWR-LFAIL Alarms in Chapter 2, Alarm 
Troubleshooting.

May 2009 Updated PWR-FAIL-A alarm details in Chapter 2, Alarm Troubleshooting.

June 2009 Updated PWR-FAIL-B, PWR-FAIL-RET-A, and PWR-FAIL-RET-B alarm details 
in Chapter 2, Alarm Troubleshooting.

July 2009  • Updated the COMIOXC alarm details in Chapter 2, Alarm Troubleshooting.

 • Updated the description of GFP-LFD alarm in Chapter 2, Alarm 
Troubleshooting.

August 2009 Updated MEM-GONE alarm description in Chapter 2, Alarm Troubleshooting.

November 2009  • Updated the card details for LCAS alarms in Chapter 2, Alarm 
Troubleshooting.

 • Added a caution in “Perform a Terminal Loopback on a Destination Electrical 
Port (West to East)” and “Perform a Terminal Loopback on a Source-Node 
Electrical Port (East to West)” sections in the chapter, “General 
Troubleshooting”.

 • Added a note in “TX-RAI” section in the chapter, “Alarm Troubleshooting”.

June 2010 Updated the table “Alarm Logical Object Type Definitions” in the chapter “Alarm 
Troubleshooting”.

July 2010 Updated table in Chapter Error Messages.

August 2010 Updated the tables “ONS 15454 Card Facility Loopback Behavior” and 
“ONS 15454 Card Terminal Loopback Behavior” in the chapter “General 
Troubleshooting”.

September 2010 Updated the “Clear the COMIOXC Alarm” procedure in the chapter, “Alarm 
Troubleshooting”.

Date Notes
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Preface
Related Documentation
Use the Cisco ONS 15454 Troubleshooting Guide in conjunction with the following publications:

 • Cisco ONS 15454 Procedure Guide 
Provides procedures to install, turn up, test, and maintain an ONS 15454 node and network.

 • Cisco ONS 15454 Reference Manual 
Provides card, node, and network-level reference information, including specifications and network 
element defaults.

 • Cisco ONS 15454 DWDM Procedure Guide 
Provides procedures to install, turn-up, test, and maintain an ONS 15454 ANSI (SONET) or ETSI 
(SDH) shelf in a DWDM network.

 • Cisco ONS 15454 DWDM Reference Manual 
Provides card, node, and network-level reference information for ONS 15454 DWDM 
configurations.

 • Cisco ONS SONET TL1 Command Guide 
Provides a full TL1 command and autonomous message set including parameters, AIDs, conditions 
and modifiers for the Cisco ONS 15454, ONS 15327, ONS 15600, ONS 15310-CL, and  
ONS 15310-MA systems.

 • Cisco ONS SONET TL1 Reference Guide 
Provides general information, procedures, and errors for TL1 in the Cisco ONS 15454, ONS 15327, 
ONS 15600, ONS 15310-CL, and ONS 15310-MA systems.

 • Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide  
Provides software features for all Ethernet cards and configuration information for Cisco IOS on 
ML-Series cards. 

 • Release Notes for the Cisco ONS 15454 Release 8.5 
Provides caveats, closed issues, and new feature and functionality information.

Refer to the following standards documentation referenced in this publication:

 • Telcordia GR-253 CORE

For an update on End-of-Life and End-of-Sale notices, refer to 
http://cisco.com/en/US/products/hw/optical/ps2006/prod_eol_notices_list.html.

Document Conventions
This publication uses the following conventions:

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.

[     ] Keywords or arguments that appear within square brackets are optional.
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Preface
  
Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, the user might do something that could result in equipment 
damage or loss of data.

{ x | x | x } A choice of keywords (represented by x) appears in braces separated by 
vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the 
Control key while pressing the D key.

screen font Examples of information displayed on the screen.

boldface screen font Examples of information that the user must enter.

<     > Command parameters that must be replaced by module-specific codes.

Warning IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. Use the statement number provided at the end of 
each warning to locate its translation in the translated safety warnings that accompanied this 
device. Statement 1071

SAVE THESE INSTRUCTIONS

Waarschuwing BELANGRIJKE VEILIGHEIDSINSTRUCTIES

Dit waarschuwingssymbool betekent gevaar. U verkeert in een situatie die lichamelijk letsel kan 
veroorzaken. Voordat u aan enige apparatuur gaat werken, dient u zich bewust te zijn van de bij 
elektrische schakelingen betrokken risico's en dient u op de hoogte te zijn van de standaard 
praktijken om ongelukken te voorkomen. Gebruik het nummer van de verklaring onderaan de 
waarschuwing als u een vertaling van de waarschuwing die bij het apparaat wordt geleverd, wilt 
raadplegen.

BEWAAR DEZE INSTRUCTIES

Convention Application
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Preface
Varoitus TÄRKEITÄ TURVALLISUUSOHJEITA

Tämä varoitusmerkki merkitsee vaaraa. Tilanne voi aiheuttaa ruumiillisia vammoja. Ennen kuin 
käsittelet laitteistoa, huomioi sähköpiirien käsittelemiseen liittyvät riskit ja tutustu 
onnettomuuksien yleisiin ehkäisytapoihin. Turvallisuusvaroitusten käännökset löytyvät laitteen 
mukana toimitettujen käännettyjen turvallisuusvaroitusten joukosta varoitusten lopussa näkyvien 
lausuntonumeroiden avulla.

SÄILYTÄ NÄMÄ OHJEET

Attention IMPORTANTES INFORMATIONS DE SÉCURITÉ 

Ce symbole d'avertissement indique un danger. Vous vous trouvez dans une situation pouvant 
entraîner des blessures ou des dommages corporels. Avant de travailler sur un équipement, soyez 
conscient des dangers liés aux circuits électriques et familiarisez-vous avec les procédures 
couramment utilisées pour éviter les accidents. Pour prendre connaissance des traductions des 
avertissements figurant dans les consignes de sécurité traduites qui accompagnent cet appareil, 
référez-vous au numéro de l'instruction situé à la fin de chaque avertissement.

CONSERVEZ CES INFORMATIONS

Warnung WICHTIGE SICHERHEITSHINWEISE

Dieses Warnsymbol bedeutet Gefahr. Sie befinden sich in einer Situation, die zu Verletzungen führen 
kann. Machen Sie sich vor der Arbeit mit Geräten mit den Gefahren elektrischer Schaltungen und 
den üblichen Verfahren zur Vorbeugung vor Unfällen vertraut. Suchen Sie mit der am Ende jeder 
Warnung angegebenen Anweisungsnummer nach der jeweiligen Übersetzung in den übersetzten 
Sicherheitshinweisen, die zusammen mit diesem Gerät ausgeliefert wurden.

BEWAHREN SIE DIESE HINWEISE GUT AUF.

Avvertenza IMPORTANTI ISTRUZIONI SULLA SICUREZZA 

Questo simbolo di avvertenza indica un pericolo. La situazione potrebbe causare infortuni alle 
persone. Prima di intervenire su qualsiasi apparecchiatura, occorre essere al corrente dei pericoli 
relativi ai circuiti elettrici e conoscere le procedure standard per la prevenzione di incidenti. 
Utilizzare il numero di istruzione presente alla fine di ciascuna avvertenza  per individuare le 
traduzioni delle avvertenze riportate in questo documento. 

CONSERVARE QUESTE ISTRUZIONI

Advarsel VIKTIGE SIKKERHETSINSTRUKSJONER

Dette advarselssymbolet betyr fare. Du er i en situasjon som kan føre til skade på person. Før du 
begynner å arbeide med noe av utstyret, må du være oppmerksom på farene forbundet med 
elektriske kretser, og kjenne til standardprosedyrer for å forhindre ulykker. Bruk nummeret i slutten 
av hver advarsel for å finne oversettelsen i de oversatte sikkerhetsadvarslene som fulgte med denne 
enheten.

TA VARE PÅ DISSE INSTRUKSJONENE
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Aviso INSTRUÇÕES IMPORTANTES DE SEGURANÇA 

Este símbolo de aviso significa perigo. Você está em uma situação que poderá ser causadora de 
lesões corporais. Antes de iniciar a utilização de qualquer equipamento, tenha conhecimento dos 
perigos envolvidos no manuseio de circuitos elétricos e familiarize-se com as práticas habituais de 
prevenção de acidentes. Utilize o número da instrução fornecido ao final de cada aviso para 
localizar sua tradução nos avisos de segurança traduzidos que acompanham este dispositivo.

GUARDE ESTAS INSTRUÇÕES 

¡Advertencia! INSTRUCCIONES IMPORTANTES DE SEGURIDAD

Este símbolo de aviso indica peligro. Existe riesgo para su integridad física. Antes de manipular 
cualquier equipo, considere los riesgos de la corriente eléctrica y familiarícese con los 
procedimientos estándar de prevención de accidentes. Al final de cada advertencia encontrará el 
número que le ayudará a encontrar el texto traducido en el apartado de traducciones que acompaña 
a este dispositivo. 

GUARDE ESTAS INSTRUCCIONES

Varning! VIKTIGA SÄKERHETSANVISNINGAR

Denna varningssignal signalerar fara. Du befinner dig i en situation som kan leda till personskada. 
Innan du utför arbete på någon utrustning måste du vara medveten om farorna med elkretsar och 
känna till vanliga förfaranden för att förebygga olyckor. Använd det nummer som finns i slutet av 
varje varning för att hitta dess översättning i de översatta säkerhetsvarningar som medföljer denna 
anordning.

SPARA DESSA ANVISNINGAR
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Aviso INSTRUÇÕES IMPORTANTES DE SEGURANÇA

Este símbolo de aviso significa perigo. Você se encontra em uma situação em que há risco de lesões 
corporais. Antes de trabalhar com qualquer equipamento, esteja ciente dos riscos que envolvem os 
circuitos elétricos e familiarize-se com as práticas padrão de prevenção de acidentes. Use o 
número da declaração fornecido ao final de cada aviso para localizar sua tradução nos avisos de 
segurança traduzidos que acompanham o dispositivo.

GUARDE ESTAS INSTRUÇÕES

Advarsel VIGTIGE SIKKERHEDSANVISNINGER

Dette advarselssymbol betyder fare. Du befinder dig i en situation med risiko for 
legemesbeskadigelse. Før du begynder arbejde på udstyr, skal du være opmærksom på de 
involverede risici, der er ved elektriske kredsløb, og du skal sætte dig ind i standardprocedurer til 
undgåelse af ulykker. Brug erklæringsnummeret efter hver advarsel for at finde oversættelsen i de 
oversatte advarsler, der fulgte med denne enhed.

GEM DISSE ANVISNINGER
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Obtaining Optical Networking Information
This section contains information that is specific to optical networking products. For information that 
pertains to all of Cisco, refer to the “Obtaining Documentation and Submitting a Service Request” 
section on page xliv section.

Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco Optical Transport Products Safety and 
Compliance Information document that accompanied the product. This publication describes the 
international agency compliance and safety information for the Cisco ONS 15454 system. It also 
includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is 
available in a CD-ROM package that ships with your product. The Optical Networking Product 
Documentation CD-ROM is updated periodically and may be more current than printed documentation.
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Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) 
feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds 
are a free service and Cisco currently supports RSS version 2.0. 
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C H A P T E R 1

General Troubleshooting

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter provides procedures for troubleshooting the most common problems encountered when 
operating a Cisco ONS 15454. To troubleshoot specific ONS 15454 alarms, see Chapter 2, “Alarm 
Troubleshooting.” If you cannot find what you are looking for, contact the Cisco Technical Assistance 
Center (TAC) at 1 800 553-2447.

For an update on End-of-Life and End-of-Sale notices, refer to 
http://cisco.com/en/US/products/hw/optical/ps2006/prod_eol_notices_list.html.

This chapter includes the following sections on network problems:

 • 1.1  Troubleshooting Circuit Paths with Loopbacks, page 1-2—Describes loopbacks and hairpin 
circuits, which you can use to test circuit paths through the network or logically isolate faults.

Note For dense wavelength division multiplexing (DWDM) network acceptance tests, refer to the 
Cisco ONS 15454 DWDM Procedure Guide.

 • 1.2  Troubleshooting Electrical Circuit Paths With Loopbacks, page 1-9—Explains how to use 
loopback tests described in “1.1  Troubleshooting Circuit Paths with Loopbacks” to isolate trouble 
on DS-1, DS-3, or EC-1 electrical circuits.

 • 1.3  Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With FEAC Loopbacks, 
page 1-45—Describes how DS3XM-6 and DS3XM-12 card far-end alarm and control (FEAC) 
functions.

 • 1.4  Troubleshooting Optical Circuit Paths With Loopbacks, page 1-47—Explains how to use 
loopback tests described in “1.1  Troubleshooting Circuit Paths with Loopbacks” to isolate trouble 
on OC-N optical circuits.

 • 1.5  Troubleshooting Ethernet Circuit Paths With Loopbacks, page 1-68—Explains how to use 
loopback tests described in “1.1  Troubleshooting Circuit Paths with Loopbacks” to isolate trouble 
on G-Series or CE-Series Ethernet circuits.

 • 1.6  Troubleshooting FC_MR Circuit Paths With Loopbacks, page 1-94—Explains how to use 
loopbacks tests described in “1.1  Troubleshooting Circuit Paths with Loopbacks” to isolate trouble 
on Fibre Channel (FC_MR) circuits.
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Chapter 1      General Troubleshooting
1.1    Troubleshooting Circuit Paths with Loopbacks
The remaining sections describe symptoms, problems, and solutions that are categorized according to 
the following topics:

 • 1.7  Using CTC Diagnostics, page 1-107—Explains how to perform card LED tests, download a 
diagnostic file for Cisco Technical Support, and create a bidirectional diagnostic VT circuit.

 • 1.8  Restoring the Database and Default Settings, page 1-114—Provides procedures for restoring 
software data and restoring the node to the default setup.

 • 1.9  PC Connectivity Troubleshooting, page 1-115—Provides troubleshooting procedures for PC 
and network connectivity to the ONS 15454.

 • 1.10  CTC Operation Troubleshooting, page 1-120—Provides troubleshooting procedures for 
Cisco Transport Controller (CTC) login or operation problems.

 • 1.11  Circuits and Timing, page 1-134—Provides troubleshooting procedures for circuit creation 
and error reporting as well as timing reference errors and alarms.

 • 1.12  Fiber and Cabling, page 1-139—Provides troubleshooting procedures for fiber and cabling 
connectivity errors.

 • 1.13  Power Supply Problems, page 1-148—Provides troubleshooting procedures for power supply 
problems.

1.1  Troubleshooting Circuit Paths with Loopbacks
Use loopbacks and hairpin circuits to test newly created SONET circuits before running live traffic or to 
logically locate the source of a network failure. All ONS 15454 electrical cards, OC-N cards, G-Series 
Ethernet cards, and FC_MR-4 cards allow loopbacks and hairpin test circuits. Other cards do not allow 
loopbacks, including E-Series Ethernet, ML-Series Ethernet, and DWDM cards such as Optical Booster 
(OPT-BST), Optical Preamplifier (OPT-PRE), Optical Service Channel and Combiner/Splitter Module 
(OSC-CSM), Band Optical Add/Drop Multiplexing (AD-xB-xx.x), and Channel Optical Add/Drop 
Multiplexing (AD-xC-xx.x) cards. For transponder (TXP) or muxponder (MXP) loopback information, 
refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

To create a loopback on a port, the port must be in the Out-of-Service and Management, Maintenance 
(OOS-MA,MT) service state. After you create the loopback, the service state becomes Out-of-Service 
and Management, Loopback and Maintenance (OOS-MA,LPBK & MT).

Caution Facility or terminal loopbacks can be service-affecting. To protect traffic, apply a lockout or Force 
switch to the target loopback port. Basic directions for these procedures are in Chapter 2, “Alarm 
Troubleshooting.” For more information about these operations, refer to the “Maintain the Node” chapter 
in the Cisco ONS 15454 Procedure Guide. 

Note Do not use a physical loopback to verify circuit switching time or to determine whether a situation causes 
a traffic hit. Testing in this manner can cause a hit that exceeds 60 m/sec. To test switching times, place 
a test set at both physical ends of the circuit.

Caution On all OC-N cards, a facility loopback applies to the entire card and not an individual circuit. Exercise 
caution when using loopbacks on an OC-N card carrying live traffic.
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Chapter 1      General Troubleshooting
1.1.1    Facility Loopbacks
1.1.1  Facility Loopbacks
The following sections give general information about facility loopback operations and specific 
information about ONS 15454 card loopback activity.

1.1.1.1  General Behavior

A facility loopback tests the line interface unit (LIU) of a card, the electrical interface assembly (EIA), 
and related cabling. After applying a facility loopback on a port, use a test set to run traffic over the 
loopback. A successful facility loopback isolates the LIU, the EIA, or the cabling plant as the potential 
cause of a network problem. Figure 1-1 shows a facility loopback on a DS-N electrical card. 

Figure 1-1 Facility Loopback Path on a Near-End DS-N Card

To test an OC-N card LIU, connect an optical test set to the OC-N port and perform a facility loopback. 
Alternately, use a loopback or hairpin circuit on a card that is farther along the circuit path. Figure 1-2 
shows a facility loopback on an OC-N card.

Figure 1-2 Facility Loopback Path on a Near-End OC-N Card

In CTC, OC-N cards with facility loopbacks show an icon (Figure 1-3). Loopback icons are not shown 
on other cards in this release.

Figure 1-3 OC-N Facility Loopback Indicator

Caution Before performing a facility loopback on an OC-N card, be sure the card contains at least two data 
communications channel (DCC) paths to the node where the card is installed. A second DCC provides 
a nonlooped path to log into the node after the loopback is applied, enabling you to remove the facility 
loopback. Ensuring a second DCC is not necessary if you are directly connected to the ONS 15454 
containing the loopback OC-N card.
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Chapter 1      General Troubleshooting
1.1.1    Facility Loopbacks
Caution Ensure that the facility being loopbacked is not line-timing the node. If it is, a timing loop will be 
created. 

Note CTC sometimes refers to facility loopbacks as facility (line) loopbacks. “Line” is meant to clarify that 
the loopback signal travels away from the facility where it originates and outward toward the span.

1.1.1.2  ONS 15454 Card Behavior

ONS 15454 port loopbacks either terminate or bridge the loopback signal. All ONS 15454 optical, 
electrical, Ethernet, and FC_MR-4 facility loopbacks are terminated as shown in Table 1-1. 

When a port terminates a facility loopback signal, the signal only loops back to the originating port and 
is not transmitted downstream. When a port bridges a loopback signal, the signal loops back to the 
originating port and is also transmitted downstream.

Note In Table 1-1, no alarm indication signal (AIS) is injected if the signal is bridged. If the signal is 
terminated, an applicable AIS is injected downstream for all cards except Ethernet cards.

The loopback itself is listed in the Conditions window; for example, the Conditions window would list 
the LPBKFACILITY condition for a tested port. (The Alarms window will show AS-MT, which means 
that alarms are suppressed on the facility during loopback.)

The following behaviors also occur during loopback:

 • If an electrical or optical port is in the Out-of-Service and Management, Disabled 
(OOS-MA,DSBLD) service state, the port injects an AIS signal upstream and downstream.

 • When an electrical or optical port is placed in the OOS-MA,MT service state before loopback 
testing, the port clears the AIS signal upstream and downstream unless there is a service-affecting 
defect that causes an AIS signal to be injected. For more information about placing ports into 
alternate states for testing, refer to the “Change Card Settings” chapter in the Cisco ONS 15454 
Procedure Guide. 

Table 1-1 ONS 15454 Card Facility Loopback Behavior

Card/Port Facility Loopback Signal

DS-1 Terminated

DS-3 Terminated

DS3XM-6 or DS3XM-12 Terminated

All OC-N cards Terminated

EC-1 Terminated

G-Series Ethernet Terminated1

1. G-Series facility loopback is terminated and no AIS is sent downstream. However, 
the Cisco Link Integrity signal continues to be sent downstream.

CE-Series Ethernet Terminated2

2. CE-Series facility loopback is terminated and no AIS is sent downstream. 
However, the Cisco Link Integrity signal continues to be sent downstream.
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Chapter 1      General Troubleshooting
1.1.2    Terminal Loopbacks
FC_MR-4 card facility loopbacks behave differently from other ONS 15454 cards. With a client-side 
facility loopback, the client port service state is OOS-MA,LPBK & MT; however the remaining client 
and trunk ports can be in any other service state. For cards in a trunk-side facility loopback, the trunk 
port service state is OOS-MA,LPBK & MT service state and the remaining client and trunk ports can be 
in any other service state. 

Caution A lock out of protection must be executed before putting a two-fiber or four-fiber bidirectional line 
switched ring (BLSR) span into a facility loopback state. That is, a span lockout of one side (such as the 
east side) of a two-fiber BLSR is required before operating a facility loopback on the same (east) side of 
the ring. A span lockout of one protection side (such as the east protection side) of a four-fiber BLSR is 
required before operating a facility loopback on the same (east) side of the ring. If you do not execute 
the lockout prior to creating the loopback, the ring can become stuck in an anomalous state after you 
release the loopback.

1.1.2  Terminal Loopbacks
The following sections give general information about terminal loopback operations and specific 
information about ONS 15454 card loopback activity.

1.1.2.1  General Behavior

A terminal loopback tests a circuit path as it passes through the cross-connect card and loops back from 
the card with the loopback. Figure 1-4 shows a terminal loopback on an OC-N card. The test-set traffic 
comes into the electrical port and travels through the cross-connect card to the optical card. The terminal 
loopback on the optical card turns the signal around before it reaches the LIU and sends it back through 
the cross-connect card to the electrical card. This test verifies that the cross-connect card and terminal 
circuit paths are valid, but does not test the LIU on the optical card.

Figure 1-4 Terminal Loopback Path on an OC-N Card

In CTC, OC-N cards with terminal loopbacks show an icon (Figure 1-5). Loopback icons are not shown 
on other cards in this release.

Figure 1-5 Terminal Loopback Indicator
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Chapter 1      General Troubleshooting
1.1.2    Terminal Loopbacks
Figure 1-6 shows a terminal loopback on a DS-N electrical card. The test-set traffic comes in on the 
optical card and travels through the cross-connect card to the electrical card. The terminal loopback on 
the electrical card turns the signal around before it reaches the LIU and sends it back through the 
cross-connect card to the optical card. This test verifies that the cross-connect card and terminal circuit 
paths are valid, but does not test the LIU on the electrical card.

Note CTC sometimes refers to terminal loopbacks as terminal (inward) loopbacks. “Inward” is meant to 
clarify that the loopback signal travels inward toward the facility where it originates and not outward 
toward the span.

Figure 1-6 Terminal Loopback Path on a DS-N Card

1.1.2.2  ONS 15454 Card Behavior

ONS 15454 terminal port loopbacks can either terminate or bridge the signal. In the ONS 15454 system, 
all optical, electrical, Ethernet, and FC_MR-4 terminal loopbacks are terminated as shown in Table 1-2. 
During terminal loopbacks, some ONS 15454 cards bridge the loopback signal while others terminate it. 

If a port terminates a terminal loopback signal, the signal only loops back to the originating port and is 
not transmitted downstream. If the port bridges a loopback signal, the signal loops back to the originating 
port and is also transmitted downstream.

Table 1-2 lists ONS 15454 card terminal loopback bridging and terminating behaviors. 

Note In Table 1-2, no AIS signal is injected if the signal is bridged. If the signal is terminated, an applicable 
AIS is injected downstream for all cards except Ethernet cards.
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Table 1-2 ONS 15454 Card Terminal Loopback Behavior

Card/Port Terminal Loopback Signal

DS-1 Terminated

DS-3 Bridged

DS3XM-6 or DS3XM-12 Bridged

All OC-N cards Bridged

EC-1 Bridged

G-Series Ethernet Terminated1

CE-Series Ethernet Terminated2
1-6
Cisco ONS 15454 Troubleshooting Guide, R8.5

 November 2009



 

Chapter 1      General Troubleshooting
1.1.2    Terminal Loopbacks
Bridged DS-N and OC-N terminal loopback examples are shown in Figure 1-7 and Figure 1-8. 

Figure 1-7 Terminal Loopback on a DS-N Card with a Bridged Signal 

Figure 1-8 Terminal Loopback on an OC-N Card with a Bridged Signal 

G-Series Ethernet cards placed in terminal loopback have different performance monitoring behaviors 
from other ONS 15454 cards. (For more information about performance monitoring counters, see the 
“Performance Monitoring” chapter in the Cisco ONS 15454 Reference Manual.) Setting a terminal 
loopback on the G-Series Ethernet card might not stop the Tx Packets counter or the Rx Packet counters 
on the CTC card-level view Performance > Statistics page from increasing. The counters can increment 
even though the loopbacked port has temporarily disabled the transmit laser and is dropping any received 
packets. 

The Tx Packet statistic continues to increment because the statistics are not based on packets transmitted 
by the transmit (Tx) laser but on the Tx signal inside the G-Series card. In normal in-service port 
operation, the Tx signal being recorded results in the Tx laser transmitting packets, but in a terminal 
loopback this signal is being looped back within the G-Series card and does not result in the Tx laser 
transmitting packets. 

The Rx Packet counter might also continue to increment when the G-Series card is in terminal loopback. 
Receive (Rx) packets from any connected device are dropped and not recorded, but the internally 
loopbacked packets follow the G-Series card’s normal receive path and register on the Rx Packet counter.

The loopback itself is listed in the Conditions window. For example, the Conditions window would list 
the LPBKTERMINAL condition or the LPBKFACILITY condition for a tested port. (The Alarms 
window would show AS-MT, which indicates that all alarms are suppressed on the port during loopback 
testing.)

The following behaviors also occur during loopback:

1. G-Series Ethernet terminal loopback is terminated and Ethernet transmission is disabled. No 
AIS is inserted for Ethernet, but a TPTFAIL alarm is raised on the far-end Ethernet port.

2. CE-Series Ethernet terminal loopback is terminated and Ethernet transmission is disabled. 
No AIS is inserted for Ethernet, but a TPTFAIL alarm is raised on the far-end Ethernet port.
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Chapter 1      General Troubleshooting
1.1.3    Hairpin Circuits
 • If an electrical or optical port is in the OOS-MA,DSBLD service state, the port injects an AIS signal 
upstream and downstream.

 • When an electrical or optical port is placed in the OOS-MA,MT service state before loopback 
testing, the port clears the AIS signal upstream and downstream unless there is a service-affecting 
defect that also causes an AIS signal to be injected. For more information about placing ports into 
alternate states for testing, refer to the “Change Card Settings” chapter of the Cisco ONS 15454 
Procedure Guide.

Caution A lock out of protection must occur before putting a two-fiber or four-fiber BLSR span into a terminal 
loopback state. That is, a span lockout of one side (such as the east side) of a two-fiber BLSR is required 
before operating a facility loopback on the same (east) side of the ring. A span lockout of one protection 
side (such as the east protection side) of a four-fiber BLSR is required before operating a terminal 
loopback on the same (east) side of the ring. If you do not perform the lockout prior to creating the 
loopback, the ring can become stuck in an anomalous state after you release the loopback.

1.1.3  Hairpin Circuits
A hairpin circuit sends traffic in and out an electrical port rather than sending the traffic onto the OC-N 
card. A hairpin loops back only the specific synchronous transport signal (STS) or virtual tributary (VT) 
circuit and does not cause an entire OC-N port to loop back, preventing all traffic on the OC-N port from 
dropping. The hairpin allows you to test a specific STS or VT circuit on nodes running live traffic. 
Figure 1-9 shows the hairpin circuit path on a DS-N card. 

Figure 1-9 Hairpin Circuit Path on a DS-N Card

1.1.4  Cross-Connect Loopbacks
A cross-connect (XC) loopback tests an OC-N circuit path as it passes through the cross-connect card 
and loops back to the port being tested without affecting other traffic on the optical port. Cross-connect 
loopbacks are less invasive than terminal or facility loopbacks. Facility and terminal loopback testing 
and circuit verification often involve taking down the whole line; however, a cross-connect loopback 
allows you to create a loopback on any embedded channel at supported payloads of STS-1 granularity 
and higher. For example, you can place a loopback on a single STS-6c on an optical facility without 
interrupting the other STS circuits. 

This test can be conducted locally or remotely through the CTC interface without on-site personnel. It 
takes place only on an OC-N card and tests the traffic path on that STS (or higher) circuit through the 
port and cross-connect card. The signal path is similar to a facility loopback. 
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1.2    Troubleshooting Electrical Circuit Paths With Loopbacks
The XC loopback breaks down the existing path and creates a new cross-connect—a hairpin—while the 
source of the original path is set to inject a line-side AIS-P. The loopback signal path and AIS injection 
are shown in Figure 1-10.

Figure 1-10 Network Element with SONET Cross-Connect Loopback Function

Consider the following rules when creating cross-connect loopbacks:

 • You can create a cross-connect loopback on all working or protect optical ports unless the protect 
port is used in a 1+1 protection group and is in working mode. 

 • If a terminal or facility loopback exists on a port, you cannot use the cross-connect loopback.

1.2  Troubleshooting Electrical Circuit Paths With Loopbacks
Facility loopbacks, terminal loopbacks, and hairpin circuits are often used to test a circuit path through 
the network or to logically isolate a fault. Performing a loopback test at each point along the circuit path 
systematically isolates possible points of failure.

The example in this section tests an electrical circuit on a two-node BLSR. Using a series of facility 
loopbacks, terminal loopbacks, hairpins, and (where appropriate) cross-connect loopbacks on optical 
paths carrying electrical circuits, the path of the circuit is traced and the possible points of failure are 
tested and eliminated. A logical progression of eight network test procedures apply to this sample 
scenario:

Note These procedures apply to DS-1, DS-3, and EC-1 cards. The test sequence for your circuits will differ 
according to the type of circuit and network topology.

West-to-east direction (left to right):

1. A facility loopback on the source-node electrical port (DS-N or EC-N)

2. A hairpin on the source-node electrical port

3. An XC loopback on the destination-node OC-N STS (carrying the electrical circuit)

4. A terminal loopback on the destination-node electrical port

East-to-west direction (right to left):

1. A facility loopback on the destination-node electrical port

2. A hairpin on the destination-node electrical port
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Chapter 1      General Troubleshooting
1.2.1    Perform a Facility Loopback on a Source Electrical Port (West to East)
3. An XC loopback on the source-node OC-N STS (carrying the electrical circuit)

4. A terminal loopback on the source-node electrical port

Note Facility, hairpin, and terminal loopback tests require on-site personnel.

1.2.1  Perform a Facility Loopback on a Source Electrical Port (West to East)
The facility loopback test is performed on the node’s source electrical port in the network circuit; in this 
example, the DS-N port in the source node. Completing a successful facility loopback on this port 
isolates the cabling, the electrical card, and the EIA as possible failure points. Figure 1-11 shows an 
example of a facility loopback on a source DS-N port.

Figure 1-11 Facility Loopback on a Circuit Source DS-N Port

Caution Performing a loopback on an in-service circuit is service-affecting. To protect traffic, apply a lockout or 
Force switch to the target loopback port. For more information about these operations, refer to the 
“Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Note Facility loopbacks require on-site personnel.

Note ONS 15454 DS-3 terminal loopbacks do not transmit an AIS in the direction away from the loopback. 
Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A DS3/EC1-48 
card can be provisioned to transmit AIS for a terminal loopback if desired.

Depending on your card type, complete the “Create the Facility Loopback on the Source DS-1, DS-3, 
DS3N-12, DS3i-N-12, or EC1 Port” procedure on page 1-10 or the “Create the Facility Loopback on the 
Source DS3E or DS3XM Port” procedure on page 1-11, then test and clear the loopbacks as instructed.

Create the Facility Loopback on the Source DS-1, DS-3, DS3N-12, DS3i-N-12, or EC1 Port

Step 1 Connect an electrical test set to the port you are testing.

Use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the EIA connectors 
or DSx panel for the port you are testing. The Tx and Rx terminals connect to the same port.
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1.2.1    Perform a Facility Loopback on a Source Electrical Port (West to East)
Step 2 Adjust the test set accordingly. (For specific procedures to use the test set equipment, consult the 
manufacturer.) 

Step 3 In node view, double-click the card to open the card view.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Choose OOS,MT from the Admin State column for the port being tested. If this is a multiport card, 
select the appropriate row for the port being tested.

Step 6 Choose Facility from the Loopback Type column for the port being tested. If this is a multiport card, 
select the appropriate row for the port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Note It is normal for the “LPBKFACILITY (DS1, DS3)” condition on page 2-170 to appear during 
loopback setup. The condition clears when you remove the loopback.

Step 9 Complete the “Test and Clear the DS-3, DS3N-12, DS3i-N-12, or EC1 Port Facility Loopback Circuit” 
procedure on page 1-11.

Test and Clear the DS-3, DS3N-12, DS3i-N-12, or EC1 Port Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. 
Double-click the card to open the card view.

Step 4 Depending on the card type, click the Maintenance > Loopback tabs.

Step 5 Choose None from the Loopback Type column for the port being tested.

Step 6 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Complete the “Test the Electrical Cabling” procedure on page 1-13.

Create the Facility Loopback on the Source DS3E or DS3XM Port

This procedure applies to DS3E, DS3XM-6, and DS3XM-12 cards. It does not use the DS3XM card 
FEAC loopback functions. For FEAC information, refer to the “1.3  Troubleshooting DS3XM-6 or 
DS3XM-12 Card Electrical Paths With FEAC Loopbacks” section on page 1-45.

Step 1 Connect an electrical test set to the port you are testing.
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1.2.1    Perform a Facility Loopback on a Source Electrical Port (West to East)
Use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the EIA connectors 
or DSx panel for the port you are testing. The Tx and Rx terminals connect to the same port. 

Step 2 Adjust the test set accordingly. (For specific procedures to use the test set equipment, consult the 
manufacturer.) 

Step 3 In node view, double-click the card to open the card view.

Step 4 For any of these cards, click the Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State.

Step 5 For the DS3 tab, choose OOS,MT from the Admin State column for the port being tested. If this is a 
multiport card, select the appropriate row for the port being tested. For the DS1 tab, no state selection is 
necessary unless the DS-1 is in service. The loopback/send code cannot be selected for a DS-1 if the 
derived state is OOS,DSBLD.

Step 6 Choose Facility from the Loopback Type column for the port being tested. If this is a multiport card, 
select the appropriate row for the port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Note It is normal for the “LPBKFACILITY (DS1, DS3)” condition on page 2-170 to appear during 
loopback setup. The condition clears when you remove the loopback.

Step 9 Complete the “Test and Clear the DS3E or DS3XM Port Facility Loopback Circuit” procedure on 
page 1-12.

Test and Clear the DS3E or DS3XM Port Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. 
Double-click the card to open the card view.

Step 4 For any of these cards, click the Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State. 

Step 5 Choose None from the Loopback Type column for the port being tested.

Step 6 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.
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1.2.1    Perform a Facility Loopback on a Source Electrical Port (West to East)
Step 9 Complete the “Test the Electrical Cabling” procedure on page 1-13.

Test the Electrical Cabling

Step 1 Replace the suspected bad cabling (the cables from the test set to the DSx panel or the EIA ports) with 
a known-good cable. For instructions, refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide. 

If a known-good cable is not available, test the suspected bad cable with a test set. Remove the suspected 
bad cable from the DSx panel or the EIA and connect the cable to the Tx and Rx terminals of the test 
set. Run traffic to determine whether the cable is good or defective.

Step 2 Resend test traffic on the loopback circuit with a known-good cable installed. If the test set indicates a 
good circuit, the problem was probably the defective cable. 

Step 3 Replace the defective cable.

Step 4 In card view for the electrical card, depending upon the type, click the Maintenance > Loopback tabs, 
Maintenance > DS1 tabs, or Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State. 

Step 5 Choose None from the Loopback Type column for the port being tested.

Step 6 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Complete the “Test the Electrical Card” procedure on page 1-13.

Test the Electrical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the Return Materials Authorization (RMA) process. Contact Cisco Technical 
Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 In card view for the electrical card, depending upon the type, click the Maintenance > Loopback tabs, 
Maintenance > DS1 tabs, or Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State.

Step 6 Choose None from the Loopback Type column for the port being tested.
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1.2.1    Perform a Facility Loopback on a Source Electrical Port (West to East)
Step 7 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 8 Click Apply.

Step 9 Click Yes in the confirmation dialog box.

Step 10 Complete the “Test the EIA” procedure on page 1-14.

Test the EIA

Step 1 Remove and reinstall the EIA to ensure a proper seating:

a. Remove the lower backplane cover. Loosen the five screws that secure it to the ONS 15454 and pull 
it away from the shelf assembly.

b. Loosen the nine perimeter screws that hold the EIA panel in place.

c. Lift the EIA panel by the bottom to remove it from the shelf assembly.

d. Follow the installation procedure for the appropriate EIA. Refer to the “Install the Shelf and 
Backplane Cable” procedure in the Cisco ONS 15454 Procedure Guide for instructions.

Step 2 Resend test traffic on the loopback circuit with known-good cabling, a known-good card, and the 
reinstalled EIA. If the test set indicates a good circuit, the problem was probably an improperly seated 
EIA, and you can proceed to Step 16. If the problem persists and the EIA is not shown to be improperly 
seated, proceed to Step 3.

Step 3 In card view for the electrical card, depending upon the type, click the Maintenance > Loopback tabs, 
Maintenance > DS1 tabs, or Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State. 

Step 4 Choose None from the Loopback Type column for the port being tested.

Step 5 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 6 Click Apply.

Step 7 Click Yes in the confirmation dialog box. Proceed to Step 16.

Step 8 If the test set indicates a faulty circuit, the problem is probably a defective EIA. Return the defective EIA 
to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 9 Replace the faulty EIA by completing the “Replace the Electrical Interface Assembly” procedure on 
page 2-282.

Step 10 Resend test traffic on the loopback circuit with known-good cabling, a known-good card, and the 
replacement EIA. If the test set indicates a faulty circuit, repeat all of the facility loopback procedures.

Step 11 If the test set indicates a good circuit, the problem was probably the defective EIA. Clear the facility 
loopback by clicking the Maintenance > Loopback tabs, Maintenance > DS1 tabs, or Maintenance > 
DS3 tabs.

Step 12 Choose None from the Loopback Type column for the port being tested.

Step 13 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.
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1.2.2    Perform a Hairpin Test on a Source-Node Electrical Port (West to East)
Step 14 Click Apply.

Step 15 Click Yes in the confirmation dialog box.

Step 16 Complete the “1.2.2  Perform a Hairpin Test on a Source-Node Electrical Port (West to East)” procedure 
on page 1-15.

1.2.2  Perform a Hairpin Test on a Source-Node Electrical Port (West to East)
The hairpin test is performed on the cross-connect card in the network circuit. A hairpin circuit uses the 
same port for both source and destination. Completing a successful hairpin through the port isolates the 
possibility that the cross-connect card is the cause of the faulty circuit. Figure 1-12 shows an example 
of a hairpin loopback on a source-node port.

Figure 1-12 Hairpin on a Source-Node Port

Note The ONS 15454 does not support simplex operation on the cross-connect card. Two cross-connect cards 
of the same type must be installed for each node.

Note Hairpin loopbacks require on-site personnel.

Complete the “Create the Hairpin Circuit on the Source-Node Electrical Port” procedure on page 1-15.

Create the Hairpin Circuit on the Source-Node Electrical Port

Step 1 Connect an electrical test set to the port you are testing:

a. If you just completed the “1.2.1  Perform a Facility Loopback on a Source Electrical Port 
(West to East)” procedure on page 1-10, leave the electrical test set hooked up to the electrical port 
in the source node.

b. If you are starting the current procedure without the electrical test set hooked up to the DS-N port, 
use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the DSx panel 
or the EIA connectors for the port you are testing. The Tx and Rx terminals connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the hairpin circuit on the test port:

a. In node view, click the Circuits tab and click Create.
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1.2.2    Perform a Hairpin Test on a Source-Node Electrical Port (West to East)
b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as Hairpin1.

e. Choose the Size, such as STS-1.

f. Uncheck the Bidirectional check box. Leave the default values for State, SD Threshold, and 
SF Threshold.

g. Click Next.

h. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected. Leave Use Secondary Source unchecked.

i. Click Next.

j. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box. Leave Use Secondary Destination unchecked.

k. Click Next.

l. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab and that the Dir column describes it 
as a one-way circuit.

Step 5 Complete the “Test and Delete the Electrical Port Hairpin Circuit” procedure on page 1-16.

Test and Delete the Electrical Port Hairpin Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic received by the test set. Look for errors or any other signal information that the 
test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the hairpin circuit. Clear the 
hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 4 Complete the “Test the Standby Cross-Connect Card” procedure on page 1-16.

Test the Standby Cross-Connect Card

Note Two cross-connect cards (active and standby) must be in use on a node to use this procedure.
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1.2.2    Perform a Hairpin Test on a Source-Node Electrical Port (West to East)
Step 1 Perform a reset on the standby cross-connect card to make it the active card:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. Position the cursor over the standby cross-connect card.

c. Right-click and choose RESET CARD. 

d. Click Yes in the confirmation dialog box.

Step 2 Initiate an external switching command (side switch) on the cross-connect cards before you retest the 
loopback circuit:

Caution Cross-connect side switches, with the exception of side switches using XC-VXC-10G cards, are 
service-affecting. Any live traffic on any card in the node endures a hit of up to 50 ms. XC-VXC-10G side 
switches are errorless. 

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In the node view, select the Maintenance > Cross-Connect > Cards tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 3 Resend test traffic on the loopback circuit.

The test traffic now travels through the alternate cross-connect card.

Step 4 If the test set indicates a faulty circuit, assume the cross-connect card is not causing the problem. Clear 
the hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 5 To confirm a defective original cross-connect card, complete the “Retest the Original Cross-Connect 
Card” procedure on page 1-18.
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1.2.3    Perform an XC Loopback on a Destination-Node OC-N STS (West to East) Carrying an Electrical Signal
Retest the Original Cross-Connect Card

Step 1 Initiate an external switching command (side switch) on the cross-connect cards:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In node view, select the Maintenance > Cross-Connect > Cards tabs.

c. From the Cross-Connect Cards menu, choose Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 2 Resend test traffic on the loopback circuit.

Step 3 If the test set indicates a faulty circuit, the problem is probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447 and 
proceed to Step 4. If the test does not indicate a faulty circuit, proceed to Step 5.

Step 4 Complete the “Physically Replace an In-Service Cross-Connect Card” procedure on page 2-275 for the 
defective card.

Step 5 If the test set indicates a good circuit, the cross-connect card might have had a temporary problem that 
was cleared by the side switch. Clear the hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 6 Complete the “1.2.3  Perform an XC Loopback on a Destination-Node OC-N STS (West to East) 
Carrying an Electrical Signal” procedure on page 1-18.

1.2.3  Perform an XC Loopback on a Destination-Node OC-N STS (West to East) 
Carrying an Electrical Signal

The XC loopback tests whether any problem exists on the circuit’s OC-N span, isolating this span from 
others present on the card. The loopback occurs on the cross-connect card in a network circuit. 
Figure 1-13 shows an example of an XC loopback on a destination OC-N port. The traffic pattern looks 
similar to a terminal loopback but traffic is only carried on one STS instead of affecting the entire port.

Note The XC loopback on an OC-N card does not affect traffic on other circuits.
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1.2.3    Perform an XC Loopback on a Destination-Node OC-N STS (West to East) Carrying an Electrical Signal
Note XC loopbacks do not require on-site personnel.

Note You can perform an XC loopback on either the circuit source working or the protect port of a 1+1 
protection group.

Figure 1-13 XC Loopback on a Destination OC-N Port

Create the XC Loopback on a Destination-Node OCN STS

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.2.2  Perform a Hairpin Test on a Source-Node Electrical Port (West to 
East)” procedure on page 1-15, leave the optical test set hooked up to the destination-node port. 

b. If you are starting the current procedure without the optical test set hooked up to the destination port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. The Tx and Rx terminals connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to put the circuit being tested out of service:

a. In node view, click the Circuits tab.

b. Click the circuit and then click Edit.

c. In the Edit Circuit dialog box, click the State tab.

d. Choose OOS,MT from the Target Circuit Admin State drop-down list.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Use CTC to set up the XC loopback on the circuit being tested:

a. In node view, double-click the OC-N card to open the card view.

b. Click the Maintenance > Loopback > SONET STS tabs.

c. Click the check box in the XC Loopback column for the port being tested.
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d. Check Apply.

e. Click Yes in the confirmation dialog box.

Step 5 Complete the “Test and Clear the XC Loopback Circuit” procedure on page 1-20.

Test and Clear the XC Loopback Circuit

Note This procedure is performed only on OC-N cards.

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic received by the test set. Look for errors or any other signal information that the 
test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the cross-connect. Clear the 
XC loopback:

a. In card view, click the Maintenance > Loopback > SONET STS tabs.

b. Uncheck the check box in the XC Loopback column for the circuit being tested.

c. Click Apply.

d. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the Standby Cross-Connect Card” procedure on page 1-20.

Test the Standby Cross-Connect Card

Step 1 Perform a reset on the standby cross-connect card:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. Position the cursor over the standby cross-connect card.

c. Right-click and choose RESET CARD. 

d. Click Yes in the confirmation dialog box.

Step 2 Initiate an external switching command (side switch) on the cross-connect cards before you retest the 
loopback circuit:

Caution Cross-connect side switches, with the exception of side switches using XC-VXC-10G cards, are 
service-affecting. Any live traffic on any card in the node endures a hit of up to 50 ms. XC-VXC-10G side 
switches are errorless. 

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 
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b. In the node view, select the Maintenance > Cross-Connect > Card tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 3 Resend test traffic on the loopback circuit.

The test traffic now travels through the alternate cross-connect card.

Step 4 If the test set indicates a faulty circuit, assume the cross-connect card is not causing the problem. Clear 
the XC loopback circuit:

a. Click the Circuits tab.

b. Choose the XC loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the XC loopback circuit is deleted from the Circuits tab list. If the test set indicates a 
good circuit, the problem might be a defective cross-connect card. 

Step 5 To confirm a defective original cross-connect card, complete the “Retest the Original Cross-Connect 
Card” procedure on page 1-21.

Retest the Original Cross-Connect Card

Note This procedure is performed only on OC-N and cross-connect cards.

Step 1 Initiate an external switching command (side switch) on the cross-connect cards.

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In node view, select the Maintenance > Cross-Connect > Card tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 2 Resend test traffic on the loopback circuit.
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Step 3 If the test set indicates a faulty circuit, the problem is probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447 and 
proceed to Step 4. If the circuit is not shown to be faulty and the card is not shown to be defective, you 
are finished with testing.

Step 4 Complete the “Physically Replace an In-Service Cross-Connect Card” procedure on page 2-275 for the 
defective cross-connect card and perform Step 5.

Step 5 If the test set indicates a good circuit, the cross-connect card might have had a temporary problem that 
was cleared by the side switch. Clear the XC loopback circuit:

a. Click the Circuits tab.

b. Choose the XC loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 6 If the tests indicate further problems, go to the “1.2.4  Perform a Terminal Loopback on a Destination 
Electrical Port (West to East)” procedure on page 1-22.

1.2.4  Perform a Terminal Loopback on a Destination Electrical Port (West to 
East)

The terminal loopback test is performed on the destination-node electrical port in the circuit, such as a 
destination-node electrical port. You create a bidirectional circuit that starts on the source-node electrical 
port and loops back on the destination-node electrical port. Then you proceed with the terminal loopback 
test. Completing a successful terminal loopback to a destination-node electrical port verifies that the 
circuit is good to the destination electrical port. Figure 1-14 shows an example of a terminal loopback 
on a destination DS-N port.

Figure 1-14 Terminal Loopback to a Destination DS-N Port

Caution Performing a loopback on an in-service circuit is service-affecting. To protect traffic, apply a lockout or 
Force switch to the target loopback port. For more information about these operations, refer to the 
“Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide. 

Caution In terminal loopback mode, DS3E-12 card does not support sending AIS toward the line side while 
looping back traffic at the same time, though NE defaults are the same.
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Note Terminal loopbacks require on-site personnel.

Note ONS 15454 DS-3 terminal loopbacks do not transmit an AIS in the direction away from the loopback. 
Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A DS3/EC1-48 
card can be provisioned to transmit AIS for a terminal loopback if desired.

Depending upon your card type, complete the “Create the Terminal Loopback on a Destination DS-3, 
DS3N-12, DS3i-N-12, or EC1 Port” procedure on page 1-23 or the“Create the Terminal Loopback on a 
Destination DS-3E or DS3XM Port” procedure on page 1-25. Then test and clear the loopback as 
instructed.

Create the Terminal Loopback on a Destination DS-3, DS3N-12, DS3i-N-12, or EC1 Port

Step 1 Connect an electrical test set to the port you are testing:

a. If you just completed the “1.2.3  Perform an XC Loopback on a Destination-Node OC-N STS (West 
to East) Carrying an Electrical Signal” procedure on page 1-18, leave the electrical test set hooked 
up to the source-node port. 

b. If you are starting the current procedure without the electrical test set hooked up to the electrical 
port, use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the DSx 
panel or the EIA connectors for the port you are testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 In CTC node view, click the Circuits tab and click Create.

Step 4 In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

Step 5 Click Next

Step 6 In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as DS1toDS2.

Step 7 Leave the Bidirectional check box checked.

Step 8 Click Next.

Step 9 In the Circuit Creation source dialog box, select the Node, card Slot, Port, and STS (or VT) where the 
test set is connected.

Step 10 Click Next.

Step 11 In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) used 
for the source dialog box.

Step 12 Click Next.

Step 13 In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 14 Confirm that the newly created circuit appears in the Dir column as a two-way circuit.

Note It is normal for the “LPBKTERMINAL (DS1, DS3)” condition on page 2-175 to appear during 
a loopback setup. The condition clears when you remove the loopback.
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Note ONS 15454 DS-3 terminal loopbacks do not transmit an AIS in the direction away from the loopback. 
Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A DS3/EC1-48 
card can be provisioned to transmit AIS for a terminal loopback if desired.

Step 15 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback, such as a DS-N card in the destination 
node.

c. Click the Maintenance > Loopback tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 16 Complete the “Test and Clear the DS-3, DS3N-12, DS3i-N-12, or EC1 Destination Port Terminal 
Loopback Circuit” procedure on page 1-24.

Test and Clear the DS-3, DS3N-12, DS3i-N-12, or EC1 Destination Port Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. 
Double-click the electrical card in the destination node with the terminal loopback.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Select None from the Loopback Type column for the port being tested.

Step 6 Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for the 
port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Clear the terminal loopback:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.
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Step 10 Complete the “Test the Destination Electrical Card” procedure on page 1-27. 

Create the Terminal Loopback on a Destination DS-3E or DS3XM Port

Step 1 Connect an electrical test set to the port you are testing:

a. If you just completed the “1.2.3  Perform an XC Loopback on a Destination-Node OC-N STS (West 
to East) Carrying an Electrical Signal” procedure on page 1-18, leave the electrical test set hooked 
up to the electrical port in the source node. 

b. If you are starting the current procedure without the electrical test set hooked up to the electrical 
port, use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the DSx 
panel or the EIA connectors for the port you are testing. Both Tx and Rx connect to the same port.

c. Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 2 In CTC node view, click the Circuits tab and click Create.

Step 3 In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

Step 4 Click Next.

Step 5 In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as DS1toDS3.

Step 6 Leave the Bidirectional check box checked.

Step 7 Click Next.

Step 8 In the Circuit Creation source dialog box, select the Node, card Slot, Port, and STS (or VT) where the 
test set is connected.

Step 9 Click Next.

Step 10 In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) used 
for the source dialog box.

Step 11 Click Next.

Step 12 In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 13 Confirm that the newly created circuit appears in the Dir column as a two-way circuit.

Note It is normal for the “LPBKTERMINAL (DS1, DS3)” condition on page 2-175 to appear during 
a loopback setup. The condition clears when you remove the loopback.

Note ONS 15454 DS-3 terminal loopbacks do not transmit an AIS in the direction away from the 
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. 
A DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback if desired.

Step 14 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.
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b. In node view, double-click the card that requires the loopback, such as the DS-N card in the 
destination node.

c. Click the Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State.

d. For the DS3 tab, choose OOS,MT from the Admin State column for the port being tested. If this is 
a multiport card, select the appropriate row for the port being tested. For the DS1 tab, no state 
selection is necessary unless the DS-1 is in service. The loopback/send code cannot be selected for 
a DS-1 if the derived state is OOS,DSBLD.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 15 Complete the “Test and Clear the DS-3E or DS3XM Destination Port Terminal Loopback Circuit” 
procedure on page 1-26.

Test and Clear the DS-3E or DS3XM Destination Port Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. 
Double-click the electrical card in the destination node with the terminal loopback.

Step 4 Click the Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State.

Step 5 Select None from the Loopback Type column for the port being tested.

Step 6 Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for the 
port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Clear the terminal loopback:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 10 Complete the “Test the Destination Electrical Card” procedure on page 1-27. 
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Test the Destination Electrical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective electrical 
card.

Step 5 Clear the terminal loopback state on the port:

a. Double-click the electrical card in the destination node with the terminal loopback.

b. Depending upon the card type, click the Maintenance > Loopback tabs, Maintenance > DS1 tabs, 
or Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Delete the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.2.5  Perform a Facility Loopback on a Destination-Node Electrical Port (East to West)” 
procedure on page 1-27.

1.2.5  Perform a Facility Loopback on a Destination-Node Electrical Port (East to 
West)

The facility loopback test is performed on the destination-node electrical port in the network circuit. 
Completing a successful facility loopback on this port isolates the cabling, the electrical card, and the 
EIA as possible failure points. Figure 1-15 shows an example of a facility loopback on a destination 
DS-N port.
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Figure 1-15 Facility Loopback on a Circuit Destination DS-N Port

Caution Performing a loopback on an in-service circuit is service-affecting. To protect traffic, apply a lockout or 
Force switch to the target loopback port. For basic instructions, refer to the “2.9.2  Protection Switching, 
Lock Initiation, and Clearing” section on page 2-263. For more information about these operations, refer 
to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Note Facility loopbacks require on-site personnel.

Note ONS 15454 DS-3 terminal loopbacks do not transmit an AIS in the direction away from the loopback. 
Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A DS3/EC1-48 
card can be provisioned to transmit AIS for a terminal loopback if desired.

Depending on your card type, complete the “Create the Facility Loopback on the Destination DS-1, 
DS-3, DS3N-12, DS3i-N-12, or EC-1 Port” procedure on page 1-28 or the “Create the Facility Loopback 
on the Source DS3E or DS3XM Port” procedure on page 1-29. Then test and clear the loopback as 
instructed.

Create the Facility Loopback on the Destination DS-1, DS-3, DS3N-12, DS3i-N-12, or EC-1 Port

Step 1 Connect an electrical test set to the port you are testing:

a. If you just completed the “1.2.4  Perform a Terminal Loopback on a Destination Electrical Port 
(West to East)” procedure on page 1-22, leave the electrical test set hooked up to the 
destination-node port. 

b. Use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the EIA 
connectors or DSx panel for the port you are testing. The Tx and Rx terminals connect to the same 
port. 

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 In CTC node view, double-click the card to open the card view.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Choose OOS,MT from the Admin State column for the port being tested. If this is a multiport card, 
select the appropriate row for the port being tested.

Step 6 Choose Facility from the Loopback Type column for the port being tested. If this is a multiport card, 
select the appropriate row for the port being tested.
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Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Note It is normal for a “LPBKFACILITY (DS1, DS3)” condition on page 2-170 to appear during 
loopback setup. The condition clears when you remove the loopback.

Step 9 Complete the “Test and Clear the DS-3, DS3N-12, DS3i-N-12, or EC-1 Port Facility Loopback Circuit” 
procedure on page 1-29.

Test and Clear the DS-3, DS3N-12, DS3i-N-12, or EC-1 Port Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. 
Double-click the card to open the card view.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Choose None from the Loopback Type column for the port being tested.

Step 6 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Complete the “Test the Electrical Cabling” procedure on page 1-30.

Create the Facility Loopback on the Source DS3E or DS3XM Port

This procedure applies to DS3E, DS3XM-6, and DS3XM-12 cards. It does not utilize the DS3XM card 
FEAC loopback functions. For FEAC information, refer to the “1.3  Troubleshooting DS3XM-6 or 
DS3XM-12 Card Electrical Paths With FEAC Loopbacks” section on page 1-45.

Step 1 Connect an electrical test set to the port you are testing.

Use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the EIA connectors 
or DSx panel for the port you are testing. The Tx and Rx terminals connect to the same port. Adjust the 
test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 2 In CTC node view, double-click the card to open the card view.

Step 3 For any of these cards, click the Maintenance > DS3 tabs. 

Note The DS-3 Admin State is the basis of the DS-1 Derived State.
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Step 4 For the DS3 tab, choose OOS,MT from the Admin State column for the port being tested. If this is a 
multiport card, select the appropriate row for the port being tested. For the DS1 tab, no state selection is 
necessary unless the DS-1 is in service. The loopback/send code cannot be selected for a DS-1 if the 
derived state is OOS,DSBLD.

Step 5 Choose Facility from the Loopback Type column for the port being tested. If this is a multiport card, 
select the appropriate row for the port being tested.

Step 6 Click Apply.

Step 7 Click Yes in the confirmation dialog box.

Note It is normal for the “LPBKFACILITY (DS1, DS3)” condition on page 2-170 to appear during 
loopback setup. The condition clears when you remove the loopback.

Step 8 Complete the “Test and Clear the DS3E or DS3XM Port Facility Loopback Circuit” procedure on 
page 1-30.

Test and Clear the DS3E or DS3XM Port Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. 
Double-click the card to open the card view.

Step 4 For any of these cards, click the Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State. 

Step 5 Choose None from the Loopback Type column for the port being tested.

Step 6 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Complete the “Test the Electrical Cabling” procedure on page 1-30.

Test the Electrical Cabling

Step 1 Replace the suspected bad cabling (from the test set to the DSx panel or the EIA ports) with known-good 
cable. For instructions, refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide.
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If a known-good cable is not available, test the suspected bad cable with a test set. (Refer to manufacturer 
instructions for test-set use.) Remove the suspected bad cable from the DSx panel or the EIA and connect 
the cable to the Tx and Rx terminals of the test set. Run traffic to determine whether the cable is good 
or defective.

Step 2 Resend test traffic on the loopback circuit with a known-good cable installed. If the test set indicates a 
good circuit, the problem was probably the defective cable. 

Step 3 Replace the defective cable.

Step 4 In card view for the electrical card, depending upon the type, click the Maintenance > Loopback tabs, 
Maintenance > DS1 tabs, or Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State. 

Step 5 Choose None from the Loopback Type column for the port being tested.

Step 6 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Complete the “Test the Electrical Card” procedure on page 1-31.

Test the Electrical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 In card view for the electrical card, depending upon the type, click the Maintenance > Loopback tabs, 
Maintenance > DS1 tabs, or Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State.

Step 6 Choose None from the Loopback Type column for the port being tested.

Step 7 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 8 Click Apply.

Step 9 Click Yes in the confirmation dialog box.

Step 10 Complete the “Test the EIA” procedure on page 1-32.
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Test the EIA

Step 1 Remove and reinstall the EIA to ensure a proper seating:

a. Remove the lower backplane cover. Loosen the five screws that secure it to the ONS 15454 and pull 
it away from the shelf assembly.

b. Loosen the nine perimeter screws that hold the EIA panel in place.

c. Lift the EIA panel by the bottom to remove it from the shelf assembly.

d. Follow the installation procedure for the appropriate EIA. Refer to the “Install the Shelf and 
Backplane Cable” chapter in the Cisco ONS 15454 Procedure Guide for instructions.

Step 2 Resend test traffic on the loopback circuit with known-good cabling, a known-good card, and the 
reinstalled EIA. If the test set indicates a good circuit, the problem was probably an improperly seated 
EIA, and you can proceed to Step 16. If the problem persists and the EIA is not shown to be improperly 
seated, proceed to Step 3.

Step 3 In card view for the electrical card, depending upon the type, click the Maintenance > Loopback tabs 
Maintenance > DS1 tabs, or Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State. 

Step 4 Choose None from the Loopback Type column for the port being tested.

Step 5 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 6 Click Apply.

Step 7 Click Yes in the confirmation dialog box.

Step 8 If the test set indicates a faulty circuit, the problem is probably a defective EIA. Return the defective EIA 
to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 9 Replace the faulty EIA. Complete the “Replace the Electrical Interface Assembly” procedure on 
page 2-282.

Step 10 Resend test traffic on the loopback circuit with known-good cabling, a known-good card, and the 
replacement EIA. If the test set indicates a faulty circuit, repeat all of the facility loopback procedures.

Step 11 If the test set indicates a good circuit, the problem was probably the defective EIA. Clear the facility 
loopback by clicking the Maintenance > Loopback tabs, Maintenance > DS1 tabs, or Maintenance > 
DS3 tabs.

Step 12 Choose None from the Loopback Type column for the port being tested.

Step 13 Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column for 
the port being tested.

Step 14 Click Apply.

Step 15 Click Yes in the confirmation dialog box.

Step 16 Complete the “1.2.6  Perform a Hairpin Test on a Destination-Node Electrical Port (East to West)” 
procedure on page 1-33.
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1.2.6  Perform a Hairpin Test on a Destination-Node Electrical Port (East to 
West)

The hairpin test is performed on the cross-connect card in the network circuit and uses the same port as 
source as well as destination. Completing a successful hairpin through the card isolates the possibility 
that the cross-connect card is the cause of the faulty circuit. Figure 1-16 shows an example of a hairpin 
loopback on a destination-node port.

Figure 1-16 Hairpin on a Destination-Node DS-N Port

Note The ONS 15454 does not support simplex operation on the cross-connect card. Two cross-connect cards 
of the same type must be installed for each node.

Note Hairpin loopbacks require on-site personnel.

Complete the “Create the Hairpin Circuit on the Destination-Node Port” procedure on page 1-33.

Create the Hairpin Circuit on the Destination-Node Port

Step 1 Connect an electrical test set to the port you are testing:

a. If you just completed the “1.2.5  Perform a Facility Loopback on a Destination-Node Electrical Port 
(East to West)” procedure on page 1-27, leave the electrical test set hooked up to the electrical port 
in the destination node.

b. If you are starting the current procedure without the electrical test set hooked up to the electrical 
port, use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the DSx 
panel or the EIA connectors for the port you are testing. The Tx and Rx terminals connect to the 
same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the hairpin circuit on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as Hairpin1.

e. Choose the Size, such as STS-1.
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f. Uncheck the Bidirectional check box. Leave the default values for State, SD Threshold, and 
SF Threshold.

g. Click Next.

h. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected. Leave Use Secondary Source unchecked.

i. Click Next.

j. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box. Leave Use Secondary Destination unchecked.

k. Click Next.

l. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab and that the Dir column describes it 
as a one-way circuit.

Step 5 Complete the “Test and Delete the Electrical Hairpin Circuit” procedure on page 1-34.

Test and Delete the Electrical Hairpin Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic received by the test set. Look for errors or any other signal information that the 
test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the hairpin circuit. Clear the 
hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 4 Complete the “Test the Standby Cross-Connect Card” procedure on page 1-34.

Test the Standby Cross-Connect Card

Note Two cross-connect cards (active and standby) must be in use on a node to use this procedure.

Step 1 Perform a reset on the standby cross-connect card to make it the active card:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. Position the cursor over the standby cross-connect card.

c. Right-click and choose RESET CARD. 
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d. Click Yes in the confirmation dialog box.

Step 2 Initiate an external switching command (side switch) on the cross-connect cards before you retest the 
loopback circuit:

Caution Cross-connect side switches, with the exception of side switches using XC-VXC-10G cards, are 
service-affecting. Any live traffic on any card in the node endures a hit of up to 50 ms. XC-VXC-10G side 
switches are errorless. 

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In the node view, select the Maintenance > Cross-Connect > Cards tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 3 Resend test traffic on the loopback circuit.

The test traffic now travels through the alternate cross-connect card.

Step 4 If the test set indicates a faulty circuit, assume the cross-connect card is not causing the problem. Clear 
the hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 5 To confirm a defective original cross-connect card, complete the “Retest the Original Cross-Connect 
Card” procedure on page 1-35.

Retest the Original Cross-Connect Card

Step 1 Initiate an external switching command (side switch) on the cross-connect cards:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In node view, select the Maintenance > Cross-Connect > Cards tabs.

c. From the Cross-Connect Cards menu, choose Switch.

d. Click Yes in the Confirm Switch dialog box.
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Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 2 Resend test traffic on the loopback circuit.

Step 3 If the test set indicates a faulty circuit, the problem is probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447 and 
proceed to Step 4. If the test does not indicate a faulty circuit, proceed to Step 5.

Step 4 Complete the “Physically Replace an In-Service Cross-Connect Card” procedure on page 2-275 for the 
defective cross-connect card.

Step 5 If the test set indicates a good circuit, the cross-connect card might have had a temporary problem that 
was cleared by the side switch. Clear the hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 6 Complete the “1.2.7  Perform an XC Loopback on a Source-Node OC-N STS (East to West) Carrying 
an Electrical Circuit” procedure on page 1-36.

1.2.7  Perform an XC Loopback on a Source-Node OC-N STS (East to West)  
Carrying an Electrical Circuit

The XC loopback tests whether problem exists on the circuit’s OC-N span by isolating this span from 
others on the card. The loopback also eliminates the cross-connect card as the source of trouble for a 
faulty circuit. The loopback occurs on the cross-connect card in a network circuit. Figure 1-17 shows an 
example of an XC loopback on a source OC-N port.

Note The XC loopback on an OC-N card does not affect traffic on other circuits.

Note XC loopbacks do not require on-site personnel.

Note You can perform an XC loopback on either the circuit source working port or the protect port of a 1+1 
protection group.
1-36
Cisco ONS 15454 Troubleshooting Guide, R8.5

 November 2009



 

Chapter 1      General Troubleshooting
1.2.7    Perform an XC Loopback on a Source-Node OC-N STS (East to West) Carrying an Electrical Circuit
Figure 1-17 XC Loopback on a Source OC-N Port

Complete the “Create the XC Loopback on the Source OC-N Port Carrying an Electrical Circuit” 
procedure on page 1-37.

Create the XC Loopback on the Source OC-N Port Carrying an Electrical Circuit

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.2.6  Perform a Hairpin Test on a Destination-Node Electrical Port (East 
to West)” procedure on page 1-33, leave the optical test set hooked up to the source-node port. 

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. The Tx and Rx terminals connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to put the circuit being tested out of service:

a. In node view, click the Circuits tab.

b. Click the circuit and then click Edit.

c. In the Edit Circuit dialog box, click the State tab.

d. Choose OOS,MT from the Target Circuit Admin State drop-down list.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Use CTC to set up the XC loopback on the circuit being tested:

a. In node view, double-click the OC-N card to open the card view.

b. Click the Maintenance > Loopback > SONET STS tabs.

c. Check the XC Loopback column check box for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 5 Complete the “Test and Clear the XC Loopback Circuit” procedure on page 1-38.
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Test and Clear the XC Loopback Circuit

Note This procedure is performed only on OC-N cards.

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic received by the test set. Look for errors or any other signal information that the 
test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the cross-connect. Clear the 
XC loopback:

a. In card view, click the Maintenance > Loopback > SONET STS tabs.

b. Uncheck the check box in the XC Loopback column for the circuit being tested.

c. Click Apply.

d. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the Standby Cross-Connect Card” procedure on page 1-38.

Test the Standby Cross-Connect Card

Step 1 Perform a reset on the standby cross-connect card:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. Position the cursor over the standby cross-connect card.

c. Right-click and choose RESET CARD. 

d. Click Yes in the confirmation dialog box.

Step 2 Initiate an external switching command (side switch) on the cross-connect cards before you retest the 
loopback circuit:

Caution Cross-connect side switches, with the exception of side switches using XC-VXC-10G cards, are 
service-affecting. Any live traffic on any card in the node endures a hit of up to 50 ms. XC-VXC-10G side 
switches are errorless. 

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In the node view, select the Maintenance > Cross-Connect > Cards tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.
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Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 3 Resend test traffic on the loopback circuit.

The test traffic now travels through the alternate cross-connect card.

Step 4 If the test set indicates a faulty circuit, assume the cross-connect card is not causing the problem. Clear 
the XC loopback circuit:

a. Click the Circuits tab.

b. Choose the XC loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the XC loopback circuit is deleted from the Circuits tab list. If the test set indicates a 
good circuit, the problem might be a defective cross-connect card. 

Step 5 To confirm a defective original cross-connect card, complete the “Retest the Original Cross-Connect 
Card” procedure on page 1-39.

Retest the Original Cross-Connect Card

Note This procedure is performed only on OC-N and cross-connect cards.

Step 1 Initiate an external switching command (side switch) on the cross-connect cards.

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In node view, select the Maintenance > Cross-Connect > Cards tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 2 Resend test traffic on the loopback circuit.

Step 3 If the test set indicates a faulty circuit, the problem is probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447 and 
proceed to Step 4. If the circuit is not shown to be faulty and the card is not shown to be defective, you 
are finished with testing.

Step 4 Complete the “Physically Replace an In-Service Cross-Connect Card” procedure on page 2-275 for the 
defective cross-connect card. Perform Step 5.
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Step 5 If the test set indicates a good circuit, the cross-connect card might have had a temporary problem that 
was cleared by the side switch. Clear the XC loopback circuit:

a. Click the Circuits tab.

b. Choose the XC loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. If the problem is not resolved, go to the “1.2.8  Perform a Terminal Loopback on a Source-Node 
Electrical Port (East to West)” section on page 1-40.

1.2.8  Perform a Terminal Loopback on a Source-Node Electrical Port (East to 
West)

The terminal loopback test is performed on the source-node electrical port in the circuit, such as a 
source-node electrical port. You first create a bidirectional circuit that starts on the destination-node 
electrical port and loops back on the source-node electrical port. Then you proceed with the terminal 
loopback test. Completing a successful terminal loopback to a source-node electrical port verifies that 
the circuit is good to the source electrical port. Figure 1-18 shows an example of a terminal loopback on 
a source DS-N port.

Figure 1-18 Terminal Loopback on a Source DS-N Port

Caution Performing a loopback on an in-service circuit is service-affecting. To protect traffic, apply a lockout or 
Force switch to the target loopback port. Refer to the “2.9.2  Protection Switching, Lock Initiation, and 
Clearing” section on page 2-263 for basic instructions. For more information about these operations, 
refer to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide. 

Caution In terminal loopback mode, DS3E-12 card does not support sending AIS toward the line side while 
looping back traffic at the same time, though NE defaults are the same.

Note Terminal loopbacks require on-site personnel.
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Note ONS 15454 DS-3 terminal loopbacks do not transmit an AIS in the direction away from the loopback. 
Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A DS3/EC1-48 
card can be provisioned to transmit AIS for a terminal loopback if desired.

Depending upon your card type, complete the “Create the Terminal Loopback on a Source DS-1, DS-3, 
DS3N-12, DS3i-N-12, or EC1 Port” procedure on page 1-41 or the “Create the Terminal Loopback on a 
Source DS3E or DS3XM Port” procedure on page 1-43. Then test and clear the loopback as instructed.

Create the Terminal Loopback on a Source DS-1, DS-3, DS3N-12, DS3i-N-12, or EC1 Port

Step 1 Connect an electrical test set to the port you are testing:

a. If you just completed the “1.2.7  Perform an XC Loopback on a Source-Node OC-N STS (East to 
West) Carrying an Electrical Circuit” procedure on page 1-36, leave the electrical test set hooked up 
to the DS-N port in the source node. 

b. If you are starting the current procedure without the electrical test set hooked up to the DS-N port, 
use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the DSx panel 
or the EIA connectors for the port you are testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 In CTC node view, click the Circuits tab and click Create.

Step 4 In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

Step 5 Click Next.

Step 6 In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as DS1toDS4.

Step 7 Leave the Bidirectional check box checked.

Step 8 Click Next.

Step 9 In the Circuit Creation source dialog box, select the Node, card Slot, Port, and STS (or VT) where the 
test set is connected.

Step 10 Click Next.

Step 11 In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) used 
for the source dialog box.

c. Click Next.

d. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 12 Confirm that the newly created circuit appears in the Dir column as a two-way circuit.

Note It is normal for the “LPBKTERMINAL (DS1, DS3)” condition on page 2-175 to appear during 
a loopback setup. The condition clears when you remove the loopback.

Note ONS 15454 DS-3 terminal loopbacks do not transmit an AIS in the direction away from the loopback. 
Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A DS3/EC1-48 
card can be provisioned to transmit AIS for a terminal loopback if desired.
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Step 13 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback, such as the DS-N card in the 
destination node.

c. Click the Maintenance > Loopback tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 14 Complete the “Test and Clear the DS-3, DS3N-12, DS3i-N-12, or EC1 Port Terminal Loopback” 
procedure on page 1-42.

Test and Clear the DS-3, DS3N-12, DS3i-N-12, or EC1 Port Terminal Loopback

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. 
Double-click the electrical card in the destination node with the terminal loopback.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Select None from the Loopback Type column for the port being tested.

Step 6 Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for the 
port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Clear the terminal loopback:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 10 Complete the “Test the Source Electrical Card” procedure on page 1-45. 
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Create the Terminal Loopback on a Source DS3E or DS3XM Port

Step 1 Connect an electrical test set to the port you are testing:

a. If you just completed the “1.2.7  Perform an XC Loopback on a Source-Node OC-N STS (East to 
West) Carrying an Electrical Circuit” procedure on page 1-36, leave the electrical test set hooked up 
to the DS-N port in the source node. 

b. If you are starting the current procedure without the electrical test set hooked up to the DS-N port, 
use appropriate cabling to attach the Tx and Rx terminals of the electrical test set to the DSx panel 
or the EIA connectors for the port you are testing. Both Tx and Rx connect to the same port.

c. Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 2 In CTC node view, click the Circuits tab and click Create.

Step 3 In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

Step 4 Click Next.

Step 5 In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as DS1toDS5.

Step 6 Leave the Bidirectional check box checked.

Step 7 Click Next.

Step 8 In the Circuit Creation source dialog box, select the Node, card Slot, Port, and STS (or VT) where the 
test set is connected.

Step 9 Click Next.

Step 10 In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) used 
for the source dialog box.

d. Click Next.

e. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 11 Confirm that the newly created circuit appears in the Dir column as a two-way circuit.

Note It is normal for the “LPBKTERMINAL (DS1, DS3)” condition on page 2-175 to appear during 
a loopback setup. The condition clears when you remove the loopback.

Note ONS 15454 DS-3 terminal loopbacks do not transmit an AIS in the direction away from the loopback. 
Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A DS3/EC1-48 
card can be provisioned to transmit AIS for a terminal loopback if desired.

Step 12 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback, such as the DS-N card in the 
destination node.

c. Click the Maintenance > DS3 tabs.
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Note The DS-3 Admin State is the basis of the DS-1 Derived State.

Step 13 For the DS3 tab, choose OOS,MT from the Admin State column for the port being tested. If this is a 
multiport card, select the appropriate row for the port being tested. For the DS1 tab, no state selection is 
necessary unless the DS-1 is in service. The loopback/send code cannot be selected for a DS-1 if the 
derived state is OOS,DSBLD.

d. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 14 Complete the “Test and Clear the DS3E or DS3XM Port Terminal Loopback Circuit” procedure on 
page 1-44.

Test and Clear the DS3E or DS3XM Port Terminal Loopback Circuit 

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. 
Double-click the electrical card in the destination node with the terminal loopback.

Step 4 Depending upon the card type, click the Maintenance > Loopback tabs, Maintenance > DS1 tabs, or 
Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State.

Step 5 Select None from the Loopback Type column for the port being tested.

Step 6 Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for the 
port being tested.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Clear the terminal loopback:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 10 Complete the “Test the Source Electrical Card” procedure on page 1-45. 
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Test the Source Electrical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective electrical 
card.

Step 5 Clear the terminal loopback state on the port:

a. Double-click the electrical card in the destination node with the terminal loopback.

b. Depending upon the card type, click the Maintenance > Loopback tabs, Maintenance > DS1 tabs, 
or Maintenance > DS3 tabs.

Note The DS-3 Admin State is the basis of the DS-1 Derived State. 

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Delete the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

All tests for this circuit are completed.

1.3  Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical 
Paths With FEAC Loopbacks

The DS3XM-6 card and DS3XM-12 cards support FEAC functions that are not available on basic DS-3 
cards. Click the DS3XM-6 or DS3XM-12 Maintenance > DS1 tabs at the card view to reveal the two 
additional function columns. Figure 1-19 shows the DS3 subtab and the additional Send Code and 
Inhibit FE Lbk function columns.
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Figure 1-19 Accessing FEAC Functions on the DS3XM-6 Card

The “far end” in FEAC refers to the equipment connected to the DS3XM card and not to the far end of 
a circuit. In Figure 1-20, if a DS3XM-6 (near-end) port is configured to send a line loop code, the code 
will be sent to the connected test set, not the DS3XM-6 (far-end) port. 

Figure 1-20 Diagram of FEAC Circuit

1.3.1  FEAC Send Code
The Send Code column on the DS3XM-6 or DS3XM-12 card Maintenance tab only applies to 
OOS-MA,MT ports configured for CBIT framing. The column lets a user select No Code (the default) 
or line loop code. Selecting line loop code inserts a line loop activate FEAC in the CBIT overhead 
transmitting to the connected facility. This code initiates a loopback from the facility to the ONS 15454. 
Selecting No Code sends a line-loop-deactivate FEAC code to the connected equipment, which will 
remove the loopback. You can also insert a FEAC for the 28 individual DS-1 circuits transmuxed into a 
DS-3 circuit.
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1.3.2  DS-3E and DS3i-N-12 Inhibit Loopback
DS-3E and DS-3i-N-12 cards respond to (but do not send) DS-3-level FEAC codes. You can inhibit 
FEAC response on ports for these cards using the Inhibit Lbk check box on their Maintenance windows.

1.3.3  DS3XM-6 and DS3XM-12 Inhibit FEAC Loopback
DS3XM-6 and DS3XM-12 ports and transmuxed DS-1 circuits initiate loopbacks when they receive 
FEAC line loop codes. If the Inhibit FE Lbk check box is checked for a DS-3 port, that port ignores any 
FEAC line loop codes it receives and will not loop back (return them). Only DS-3 ports can be 
configured to inhibit FEAC loopback responses; individual DS-1 ports (accessed on the DS3XM DS1 
tab) cannot inhibit their responses. If you inhibit a DS-3 port’s far end loopback response, this DS-3 port 
and the DS-1 lines it contains are not restricted from terminal or facility loopbacks.

1.3.4  FEAC Alarms
When an ONS 15454 port receives an activation code for a FEAC loopback, it raises the 
“LPBKDS3FEAC” condition on page 2-169. The condition clears when the port receives the command 
to deactivate the FEAC loopback. If a node sends a FEAC loopback command to the far end, the sending 
node raises a “LPBKDS3FEAC-CMD” condition on page 2-169 for the near-end port.

1.4  Troubleshooting Optical Circuit Paths With Loopbacks
Facility loopbacks, terminal loopbacks, and cross-connect loopback circuits are often used together to 
test the circuit path through the network or to logically isolate a fault. Performing a loopback test at each 
point along the circuit path systematically isolates possible points of failure.

The procedures in this section apply to OC-N cards. For instructions on G-Series Ethernet cards, see the 
“1.5  Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-68. The example in 
this section tests an OC-N circuit on a three-node BLSR. Using a series of facility, cross-connect, and 
terminal loopbacks, the example scenario traces the circuit path, tests the possible failure points, and 
eliminates them. The logical progression contains seven network test procedures:

Note The test sequence for your circuits will differ according to the type of circuit and network topology.

1. A facility loopback on the source-node OC-N port

2. A terminal loopback on the source-node OC-N port

3. A cross-connect loopback on the source OC-N port

4. A facility loopback on the intermediate-node OC-N port

5. A terminal loopback on the intermediate-node OC-N port

6. A facility loopback on the destination-node OC-N port

7. A terminal loopback on the destination-node OC-N port

Note Facility and terminal loopback tests require on-site personnel.
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1.4.1  Perform a Facility Loopback on a Source-Node Optical Port
The facility loopback test is performed on the node source port in the network circuit. In the testing 
situation used in this example, the source OC-N port in the source node. Completing a successful facility 
loopback on this port isolates the OC-N port as a possible failure point. Figure 1-21 shows an example 
of a facility loopback on a circuit source OC-N port.

Figure 1-21 Facility Loopback on a Circuit Source OC-N Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Facility loopbacks require on-site personnel.

Complete the “Create the Facility Loopback on the Source Optical Port” procedure on page 1-48.

Create the Facility Loopback on the Source Optical Port

Step 1 Connect an optical test set to the port you are testing.

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

Use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. The Tx and Rx terminals connect to the same port. Adjust the test set accordingly. (Refer to 
manufacturer instructions for test-set use.) 

Step 2 In CTC node view, double-click the card to open the card view.

Step 3 Click the Maintenance > Loopback > Port tabs.

Step 4 Choose OOS,MT from the Admin State column for the port being tested. If this is a multiport card, 
select the appropriate row for the desired port.

Step 5 Choose Facility from the Loopback Type column for the port being tested. If this is a multiport card, 
select the appropriate row for the desired port.

Step 6 Click Apply.

Step 7 Click Yes in the confirmation dialog box.
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Note It is normal for the “CLPBKFACILITY (OCN)” condition on page 2-173 or the 
“LPBKFACILITY (G1000)” condition on page 2-172 to appear during loopback setup. The 
condition clears when you remove the loopback.

Step 8 Complete the “Test and Clear the Facility Loopback Circuit” procedure on page 1-49.

Test and Clear the Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback:

a. Click the Maintenance > Loopback > Port tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the OC-N Card” procedure on page 1-49.

Test the OC-N Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback:

a. Click the Maintenance > Loopback > Port tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.
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Step 6 Complete the “1.4.2  Perform a Terminal Loopback on a Source-Node Optical Port” procedure on 
page 1-50.

1.4.2  Perform a Terminal Loopback on a Source-Node Optical Port
The terminal loopback test is performed on the source-node optical port. For the circuit in this example, 
it is the source OC-N port in the source node. You first create a bidirectional circuit that starts on the 
node destination optical port and loops back on the node source optical port. You then proceed with the 
terminal loopback test. Completing a successful terminal loopback to a node source port verifies that the 
circuit is good to the source port. Figure 1-22 shows an example of a terminal loopback on a source 
OC-N port. 

Figure 1-22 Terminal Loopback on a Source-Node OC-N Port

OC-N cards in terminal loopback state display an icon in CTC, shown in Figure 1-23.

Figure 1-23 Terminal Loopback Indicator

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Terminal loopbacks require on-site personnel.

Complete the “Create the Terminal Loopback on a Source-Node Optical Port” procedure on page 1-50.

Create the Terminal Loopback on a Source-Node Optical Port

Step 1 Connect an optical test set to the port you are testing:
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Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.4.1  Perform a Facility Loopback on a Source-Node Optical Port” 
procedure on page 1-48, leave the optical test set hooked up to the OC-N port in the source node.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

c. Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 2 Use CTC to set up the terminal loopback on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
OCN1toOCN2.

e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 3 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “LPBKTERMINAL (OCN)” condition on page 2-177 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 4 Create the terminal loopback on the destination port being tested:

a. In node view, double-click the card that requires the loopback, such as the destination OC-N card in 
the source node.

b. Click the Maintenance > Loopback > Port tabs.

c. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

d. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

e. Click Apply.

f. Click Yes in the confirmation dialog box.
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Step 5 Complete the “Test and Clear the Terminal Loopback Circuit” procedure on page 1-52.

Test and Clear the Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback state on the port:

a. Double-click the card in the source node with the terminal loopback.

b. Click the Maintenance > Loopback > Port tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 5 Complete the “Test the Optical Card” procedure on page 1-52. 

Test the Optical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.

Step 5 Clear the terminal loopback on the port before testing the next segment of the network circuit path:

a. Double-click the card in the source node with the terminal loopback.

b. Click the Maintenance > Loopback > Port tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.
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e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Clear the terminal loopback circuit before testing the next segment of the network circuit path:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.4.3  Perform an XC Loopback on the Source Optical Port” procedure on page 1-53.

1.4.3  Perform an XC Loopback on the Source Optical Port

Note This procedure is only performed on OC-N cards and tests the cross-connect circuit connection.

Note You can perform an XC loopback on either the circuit source working or the protect port of a 1+1 
protection group.

Note XC loopbacks do not require on-site personnel.

The XC loopback test occurs on the cross-connect card in a network circuit. Completing a successful XC 
loopback from an OC-N card through the cross-connect card eliminates the cross-connect card as the 
source of trouble for a faulty circuit. Figure 1-24 shows an example of an XC loopback path on a source 
OC-N port.

Figure 1-24 XC Loopback on a Source OC-N Port

Complete the “Create the XC Loopback on the Source-Node Optical Port” procedure on page 1-53.

Create the XC Loopback on the Source-Node Optical Port

Step 1 Connect an optical test set to the port you are testing:
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Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.4.2  Perform a Terminal Loopback on a Source-Node Optical Port” 
procedure on page 1-50, leave the optical test set hooked up to the source-node port. 

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. The Tx and Rx terminals connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to put the circuit being tested out of service:

a. In node view, click the Circuits tab.

b. Click the circuit and then click Edit.

c. In the Edit Circuit dialog box, click the State tab.

d. Choose OOS,MT from the Target Circuit Admin State drop-down list.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Use CTC to set up the XC loopback on the circuit being tested:

a. In node view, double-click the OC-N card to open the card view.

b. Click the Maintenance > Loopback > SONET STS tabs.

c. Click the check box in the XC Loopback column for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 5 Complete the “Test and Clear the XC Loopback Circuit” procedure on page 1-54.

Test and Clear the XC Loopback Circuit

Note This procedure is performed only on OC-N cards.

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic received by the test set. Look for errors or any other signal information that the 
test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the cross-connect. Clear the 
XC loopback:

a. In card view, click the Maintenance > Loopback > SONET STS tabs.

b. Uncheck the check box in the XC Loopback column for the circuit being tested.

c. Click Apply.

d. Click Yes in the confirmation dialog box.
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Step 4 Complete the “Test the Standby Cross-Connect Card” procedure on page 1-55.

Test the Standby Cross-Connect Card

Note This procedure is performed only on cross-connect cards.

Step 1 Perform a reset on the standby cross-connect card:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. Position the cursor over the standby cross-connect card.

c. Right-click and choose RESET CARD. 

d. Click Yes in the confirmation dialog box.

Step 2 Initiate an external switching command (side switch) on the cross-connect cards before you retest the 
loopback circuit:

Caution Cross-connect side switches, with the exception of side switches using XC-VXC-10G cards, are 
service-affecting. Any live traffic on any card in the node endures a hit of up to 50 ms. XC-VXC-10G side 
switches are errorless. 

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In the node view, select the Maintenance > Cross-Connect > Cards tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 3 Resend test traffic on the loopback circuit.

The test traffic now travels through the alternate cross-connect card.

Step 4 If the test set indicates a faulty circuit, assume the cross-connect card is not causing the problem. Clear 
the XC loopback circuit:

a. Click the Circuits tab.

b. Choose the XC loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.
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e. Confirm that the XC loopback circuit is deleted from the Circuits tab list. If the test set indicates a 
good circuit, the problem might be a defective cross-connect card. 

Step 5 To confirm a defective original cross-connect card, complete the “Retest the Original Cross-Connect 
Card” procedure on page 1-56.

Retest the Original Cross-Connect Card

Note This procedure is performed only on OC-N and cross-connect cards.

Step 1 Initiate an external switching command (side switch) on the cross-connect cards.

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In node view, select the Maintenance > Cross-Connect > Cards tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 2 Resend test traffic on the loopback circuit.

Step 3 If the test set indicates a faulty circuit, the problem is probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447 and 
proceed to Step 4. If the circuit is not shown to be faulty and the card is not shown to be defective, you 
are finished with testing.

Step 4 Complete the “Physically Replace an In-Service Cross-Connect Card” procedure on page 2-275 for the 
defective card.

Step 5 If the test set indicates a good circuit, the cross-connect card might have had a temporary problem that 
was cleared by the side switch. Clear the XC loopback circuit:

a. Click the Circuits tab.

b. Choose the XC loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 6 Complete the “1.4.4  Perform a Facility Loopback on an Intermediate-Node Optical Port” procedure on 
page 1-57.
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1.4.4  Perform a Facility Loopback on an Intermediate-Node Optical Port
Performing the facility loopback test on an intermediate port isolates whether this node is causing circuit 
failure. In the situation shown in Figure 1-25, the test is being performed on an intermediate OC-N port.

Figure 1-25 Facility Loopback Path to an Intermediate-Node OC-N Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Facility loopbacks require on-site personnel.

Complete the “Create a Facility Loopback on an Intermediate-Node Optical Port” procedure on 
page 1-57.

Create a Facility Loopback on an Intermediate-Node Optical Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.4.3  Perform an XC Loopback on the Source Optical Port” procedure 
on page 1-53, leave the optical test set hooked up to the source-node port.

b. If you are starting the current procedure without the optical test set hooked up to the source port 
port, use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you 
are testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the facility loopback on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
OCN1toOCN3.

e. Leave the Bidirectional check box checked.
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f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “CLPBKFACILITY (OCN)” condition on page 2-173 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 5 Create the facility loopback on the destination port being tested:

a. Go to the node view of the intermediate node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the intermediate-node card that requires the loopback.

c. Click the Maintenance > Loopback > Port tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Facility from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Facility Loopback Circuit” procedure on page 1-58.

Test and Clear the Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback from the port:

a. Click the Maintenance > Loopback > Port tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.
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e. Click Yes in the confirmation dialog box.

Step 4 Clear the facility loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 5 Complete the “Test the Optical Card” procedure on page 1-59.

Test the Optical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback from the port:

a. Click the Maintenance > Loopback > Port tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 6 Clear the facility loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.4.5  Perform a Terminal Loopback on Intermediate-Node Optical Ports” procedure on 
page 1-59.

1.4.5  Perform a Terminal Loopback on Intermediate-Node Optical Ports
In the next troubleshooting test, you perform a terminal loopback on the intermediate-node port to isolate 
whether the destination port is causing circuit trouble. In the example situation in Figure 1-26, the 
terminal loopback is performed on an intermediate optical port in the circuit. You first create a 
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bidirectional circuit that originates on the source-node optical port and loops back on the 
intermediate-node port. You then proceed with the terminal loopback test. If you successfully complete 
a terminal loopback on the node, this node is excluded from possible sources of circuit trouble. 

Figure 1-26 Terminal Loopback Path to an Intermediate-Node OC-N Port

OC-N cards placed in facility loopback state display an icon, shown in Figure 1-27.

Figure 1-27 Facility Loopback Indicator

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Terminal loopbacks require on-site personnel.

Complete the “Create a Terminal Loopback on Intermediate-Node Optical Ports” procedure on 
page 1-60.

Create a Terminal Loopback on Intermediate-Node Optical Ports

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.4.4  Perform a Facility Loopback on an Intermediate-Node Optical 
Port” section on page 1-57, leave the optical test set hooked up to the source-node port.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the terminal loopback on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.
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c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
OCN1toOCN4.

e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list and that it is described in the Dir 
column as a two-way circuit. 

Note It is normal for the “LPBKTERMINAL (OCN)” condition on page 2-177 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 5 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the intermediate node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.

c. Click the Maintenance > Loopback > Port tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Optical Terminal Loopback Circuit” procedure on page 1-61.

Test and Clear the Optical Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback from the port:

a. Double-click the intermediate-node card with the terminal loopback to open the card view.
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b. Click the Maintenance > Loopback > Port tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 5 Complete the “Test the Optical Card” procedure on page 1-62. 

Test the Optical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.

Step 5 Clear the terminal loopback on the port:

a. Double-click the source-node card with the terminal loopback.

b. Click the Maintenance > Loopback > Port tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.4.6  Perform a Facility Loopback on a Destination-Node Optical Port” procedure on 
page 1-63.
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1.4.6  Perform a Facility Loopback on a Destination-Node Optical Port
You perform a facility loopback test at the destination port to determine whether this local port is the 
source of circuit trouble. The example in Figure 1-28 shows a facility loopback being performed on a 
destination-node OC-N port.

Figure 1-28 Facility Loopback Path to a Destination-Node OC-N Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Facility loopbacks require on-site personnel.

Complete the “Create the Facility Loopback on a Destination-Node Optical Port” procedure on 
page 1-63.

Create the Facility Loopback on a Destination-Node Optical Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.4.5  Perform a Terminal Loopback on Intermediate-Node Optical Ports” 
procedure on page 1-59, leave the optical test set hooked up to the source-node port.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the hairpin circuit on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
OCN1toOCN5.
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e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “CLPBKFACILITY (OCN)” condition on page 2-173 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 5 Create the facility loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.

c. Click the Maintenance > Loopback > Port tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Facility from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Optical Facility Loopback Circuit” procedure on page 1-64.

Test and Clear the Optical Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback from the port:

a. Click the Maintenance > Loopback > Port tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.
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d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 4 Clear the facility loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 5 Complete the “Test the Optical Card” procedure on page 1-65.

Test the Optical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback on the port:

a. Click the Maintenance > Loopback > Port tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 6 Clear the facility loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.4.7  Perform a Terminal Loopback on a Destination-Node Optical Port” procedure on 
page 1-65.

1.4.7  Perform a Terminal Loopback on a Destination-Node Optical Port
The terminal loopback at the destination-node port is the final local hardware error elimination in the 
circuit troubleshooting process. If this test is completed successfully, you have verified that the circuit 
is good up to the destination port. The example in Figure 1-29 shows a terminal loopback on an 
intermediate-node destination OC-N port. 
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Figure 1-29 Terminal Loopback Path to a Destination-Node OC-N Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Terminal loopbacks require on-site personnel.

Complete the “Create the Terminal Loopback on a Destination-Node Optical Port” procedure on 
page 1-66.

Create the Terminal Loopback on a Destination-Node Optical Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.4.6  Perform a Facility Loopback on a Destination-Node Optical Port” 
procedure on page 1-63, leave the optical test set hooked up to the source port.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the terminal loopback on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
OCN1toOCN6.

e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.
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i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “LPBKTERMINAL (OCN)” condition on page 2-177 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 5 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.

c. Click the Maintenance > Loopback > Port tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Optical Terminal Loopback Circuit” procedure on page 1-67.

Test and Clear the Optical Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback from the port:

a. Double-click the intermediate-node card with the terminal loopback.

b. Click the Maintenance > Loopback > Port tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Clear the terminal loopback circuit:

a. Click the Circuits tab.
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b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

The entire circuit path has now passed its comprehensive series of loopback tests. This circuit 
qualifies to carry live traffic.

Step 5 If the test set indicates a faulty circuit, the problem might be a faulty card.

Step 6 Complete the “Test the Optical Card” procedure on page 1-68. 

Test the Optical Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good card.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.

Step 5 Clear the terminal loopback on the port:

a. Double-click the source-node card with the terminal loopback.

b. Click the Maintenance > Loopback > Port tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

The entire circuit path has now passed its comprehensive series of loopback tests. This circuit qualifies 
to carry live traffic.

1.5  Troubleshooting Ethernet Circuit Paths With Loopbacks
Facility loopbacks, terminal loopbacks, and cross-connect loopback circuits are often used together to 
test the circuit path through the network or to logically isolate a fault. Performing a loopback test at each 
point along the circuit path systematically isolates possible points of failure.
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You can use these procedures on G-Series and CE-Series Ethernet cards but not on E-Series or 
ML-Series Ethernet cards. The example in this section tests a G-Series or CE-Series card circuit on a 
three-node BLSR. Using a series of facility loopbacks and terminal loopbacks, the example scenario 
traces the circuit path, tests the possible failure points, and eliminates them. The logical progression 
contains six network test procedures:

Note The test sequence for your circuits will differ according to the type of circuit and network topology.

1. A facility loopback on the source-node Ethernet port

2. A terminal loopback on the source-node Ethernet port

3. A hairpin on the source-node Ethernet port

4. A facility loopback on the intermediate-node Ethernet port

5. A terminal loopback on the intermediate-node Ethernet port

6. A facility loopback on the destination-node Ethernet port

7. A terminal loopback on the destination-node Ethernet port

8. A hairpin on the destination-node Ethernet port

Note Facility and terminal loopback tests require on-site personnel.

1.5.1  Perform a Facility Loopback on a Source-Node Ethernet Port
The facility loopback test is performed on the node source port in the network circuit. In the testing 
situation used in this example, the source G-Series port in the source node. Completing a successful 
facility loopback on this port isolates the G-Series port as a possible failure point. Figure 1-21 shows an 
example of a facility loopback on a circuit source Ethernet port.

Note Facility loopbacks are not available for Release 4.1 or earlier G-Series cards.

Note Facility loopbacks require on-site personnel.

Figure 1-30 Facility Loopback on a Circuit Source Ethernet Port
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Caution Performing a loopback on an in-service circuit is service-affecting.

Complete the “Create the Facility Loopback on the Source-Node Ethernet Port” procedure on page 1-70.

Create the Facility Loopback on the Source-Node Ethernet Port

Step 1 Connect an optical test set to the port you are testing.

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

Use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. The Tx and Rx terminals connect to the same port. 

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 In CTC node view, double-click the card to open the card view.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Choose OOS,MT from the Admin State column for the port being tested. If this is a multiport card, 
select the appropriate row for the desired port.

Step 6 Choose Facility from the Loopback Type column for the port being tested. If this is a multiport card, 
select the appropriate row for the desired port.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Note It is normal for the “LPBKFACILITY (G1000)” condition on page 2-172 to appear during 
loopback setup. The condition clears when you remove the loopback.

Step 9 Complete the “Test and Clear the Facility Loopback Circuit” procedure on page 1-70.

Test and Clear the Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT) from the Admin State column for the port 
being tested.
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d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the Ethernet Card” procedure on page 1-71.

Test the Ethernet Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT) from the Admin State column for the port 
being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 6 Complete the “1.5.2  Perform a Terminal Loopback on a Source-Node Ethernet Port” procedure on 
page 1-71.

1.5.2  Perform a Terminal Loopback on a Source-Node Ethernet Port
The terminal loopback test is performed on the node source Ethernet port. For the circuit in this example, 
it is the source G-Series port in the source node. You first create a bidirectional circuit that starts on the 
node destination G-Series port and loops back on the node source G-Series port. You then proceed with 
the terminal loopback test. Completing a successful terminal loopback to a node source port verifies that 
the circuit is good to the source port. Figure 1-31 shows terminal loopback on a G-Series port.

Note Terminal loopbacks are not available for R4.0 and earlier G-Series cards.

Note Terminal loopbacks require on-site personnel.
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Figure 1-31 Terminal Loopback on a G-Series Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Complete the “Create the Terminal Loopback on a Source-Node Ethernet Port” procedure on page 1-72.

Create the Terminal Loopback on a Source-Node Ethernet Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.5.1  Perform a Facility Loopback on a Source-Node Ethernet Port” 
procedure on page 1-69, leave the optical test set hooked up to the Ethernet port in the source node.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the terminal loopback on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.
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d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
G1K1toG1K2.

e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “LPBKTERMINAL (G1000)” condition on page 2-177 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 5 Create the terminal loopback on the destination port being tested:

a. In node view, double-click the card that requires the loopback, such as the destination G-Series card 
in the source node.

b. Click the Maintenance > Loopback tabs.

c. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

d. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Ethernet Terminal Loopback Circuit” procedure on page 1-73.

Test and Clear the Ethernet Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback state on the port:

a. Double-click the card in the source node with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT) in the Admin State column for the port 
being tested.
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e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 5 Complete the “Test the Ethernet Card” procedure on page 1-74. 

Test the Ethernet Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.

Step 5 Clear the terminal loopback on the port before testing the next segment of the network circuit path:

a. Double-click the card in the source node with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT) in the Admin State column for the port 
being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Clear the terminal loopback circuit before testing the next segment of the network circuit path:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.5.3  Perform a Hairpin Test on a Source-Node Ethernet Port” procedure on page 1-75.
1-74
Cisco ONS 15454 Troubleshooting Guide, R8.5

 November 2009



 

Chapter 1      General Troubleshooting
1.5.3    Perform a Hairpin Test on a Source-Node Ethernet Port
1.5.3  Perform a Hairpin Test on a Source-Node Ethernet Port 
The hairpin test is performed on the cross-connect card in the network circuit. A hairpin circuit uses the 
same port for both source and destination. Completing a successful hairpin through the port isolates the 
possibility that the cross-connect card is the cause of the faulty circuit. Figure 1-32 shows an example 
of a hairpin loopback on a source-node port.

Figure 1-32 Hairpin on a Source-Node Ethernet Port

Note The ONS 15454 does not support simplex operation on the cross-connect card. Two cross-connect cards 
of the same type must be installed for each node.

Note Hairpin loopbacks require on-site personnel.

Complete the “Create the Hairpin Circuit on the Source-Node Ethernet Port” procedure on page 1-75.

Create the Hairpin Circuit on the Source-Node Ethernet Port

Step 1 Connect an Ethernet test set to the port you are testing:

a. If you just completed the “1.5.2  Perform a Terminal Loopback on a Source-Node Ethernet Port” 
procedure on page 1-71, leave the Ethernet test set hooked up to the Ethernet port in the source node.

b. If you are starting the current procedure without the Ethernet test set hooked up to the Ethernet port, 
use appropriate cabling to connect the Ethernet test set to the port you are testing.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the hairpin circuit on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as Hairpin1.

e. Choose the Size, such as STS-1.

f. Uncheck the Bidirectional check box. Leave the default values for State, SD Threshold, and 
SF Threshold.

g. Click Next.
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h. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected. Leave Use Secondary Source unchecked.

i. Click Next.

j. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box. Leave Use Secondary Destination unchecked.

k. Click Next.

l. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab and that the Dir column describes it 
as a one-way circuit.

Step 5 Complete the “Test and Delete the Ethernet Port Hairpin Circuit” procedure on page 1-76.

Test and Delete the Ethernet Port Hairpin Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic received by the test set. Look for errors or any other signal information that the 
test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the hairpin circuit. Clear the 
hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 4 Complete the “Test the Standby Cross-Connect Card” procedure on page 1-76.

Test the Standby Cross-Connect Card

Note Two cross-connect cards (active and standby) must be in use on a node to use this procedure.

Step 1 Perform a reset on the standby cross-connect card to make it the active card:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. Position the cursor over the standby cross-connect card.

c. Right-click and choose RESET CARD. 

d. Click Yes in the confirmation dialog box.

Step 2 Initiate an external switching command (side switch) on the cross-connect cards before you retest the 
loopback circuit:
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Caution Cross-connect side switches, with the exception of side switches using XC-VXC-10G cards, are 
service-affecting. Any live traffic on any card in the node endures a hit of up to 50 ms. XC-VXC-10G side 
switches are errorless. 

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In the node view, select the Maintenance > Cross-Connect > Cards tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 3 Resend test traffic on the loopback circuit.

The test traffic now travels through the alternate cross-connect card.

Step 4 If the test set indicates a faulty circuit, assume the cross-connect card is not causing the problem. Clear 
the hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 5 To confirm a defective original cross-connect card, complete the “Retest the Original Cross-Connect 
Card” procedure on page 1-77.

Retest the Original Cross-Connect Card

Step 1 Initiate an external switching command (side switch) on the cross-connect cards:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In node view, select the Maintenance > Cross-Connect > Cards tabs.

c. From the Cross-Connect Cards menu, choose Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.
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Step 2 Resend test traffic on the loopback circuit.

Step 3 If the test set indicates a faulty circuit, the problem is probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447 and 
proceed to Step 4. If the test does not indicate a faulty circuit, proceed to Step 5.

Step 4 Complete the “Physically Replace an In-Service Cross-Connect Card” procedure on page 2-275 for the 
defective card.

Step 5 If the test set indicates a good circuit, the cross-connect card might have had a temporary problem that 
was cleared by the side switch. Clear the hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 6 Complete the “1.5.4  Create a Facility Loopback on an Intermediate-Node Ethernet Port” procedure on 
page 1-78.

1.5.4  Create a Facility Loopback on an Intermediate-Node Ethernet Port
Performing the facility loopback test on an intermediate port isolates whether this node is causing circuit 
failure. It is shown in Figure 1-33.

Figure 1-33 Facility Loopback on an Intermediate-Node Ethernet Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Facility loopbacks require on-site personnel.

Complete the “Create a Facility Loopback on an Intermediate-Node Ethernet Port” procedure on 
page 1-79.
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Create a Facility Loopback on an Intermediate-Node Ethernet Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.5.2  Perform a Terminal Loopback on a Source-Node Ethernet Port” 
procedure on page 1-71, leave the optical test set hooked up to the source-node port.

b. If you are starting the current procedure without the optical test set hooked up to the source port 
port, use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you 
are testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the facility loopback on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
G1KtoG1K3.

e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “LPBKFACILITY (G1000)” condition on page 2-172 or the 
“CLPBKFACILITY (OCN)” condition on page 2-173 to appear during a loopback setup. The 
condition clears when you remove the loopback.

Step 5 Create the facility loopback on the destination port being tested:

a. Go to the node view of the intermediate node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the intermediate-node card that requires the loopback.

c. Click the Maintenance > Loopback tabs.
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d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Facility from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Ethernet Facility Loopback Circuit” procedure on page 1-80.

Test and Clear the Ethernet Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback from the port:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT) from the Admin State column for the port 
being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 4 Clear the facility loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 5 Complete the “Test the Ethernet Card” procedure on page 1-80.

Test the Ethernet Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback from the port:

a. Click the Maintenance > Loopback tabs.
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b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT) from the Admin State column for the port 
being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 6 Clear the facility loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.5.5  Create a Terminal Loopback on Intermediate-Node Ethernet Ports” procedure on 
page 1-81.

1.5.5  Create a Terminal Loopback on Intermediate-Node Ethernet Ports
In the next troubleshooting test, you perform a terminal loopback on the intermediate-node port to isolate 
whether the destination port is causing circuit trouble. In the example situation in Figure 1-34, the 
terminal loopback is performed on an intermediate Ethernet port in the circuit. You first create a 
bidirectional circuit that originates on the source-node Ethernet port and loops back on the 
intermediate-node port. You then proceed with the terminal loopback test. If you successfully complete 
a terminal loopback on the node, this node is excluded from possible sources of circuit trouble. 

Figure 1-34 Terminal Loopback on an Intermediate-Node Ethernet Port 

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Terminal loopbacks require on-site personnel.

Complete the “Create a Terminal Loopback on Intermediate-Node Ethernet Ports” procedure on 
page 1-82.
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Create a Terminal Loopback on Intermediate-Node Ethernet Ports

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.5.4  Create a Facility Loopback on an Intermediate-Node Ethernet Port” 
procedure on page 1-78 for the Ethernet circuit, leave the optical test set hooked up to the 
intermediate-node port.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the terminal loopback on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
G1K1toG1K4.

e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list and that it is described in the Dir 
column as a two-way circuit. 

Note It is normal for the “LPBKTERMINAL (G1000)” condition on page 2-177 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 5 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the intermediate node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.

c. Click the Maintenance > Loopback tabs.
1-82
Cisco ONS 15454 Troubleshooting Guide, R8.5

 November 2009



 

Chapter 1      General Troubleshooting
1.5.5    Create a Terminal Loopback on Intermediate-Node Ethernet Ports
d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Ethernet Terminal Loopback Circuit” procedure on page 1-83.

Test and Clear the Ethernet Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback from the port:

a. Double-click the intermediate-node card with the terminal loopback to open the card view.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT) in the Admin State column for the port 
being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 5 Complete the “Test the Ethernet Card” procedure on page 1-83. 

Test the Ethernet Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.
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Step 5 Clear the terminal loopback on the port:

a. Double-click the source-node card with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT) in the Admin State column for the port 
being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.5.6  Perform a Facility Loopback on a Destination-Node Ethernet Port” procedure on 
page 1-84.

1.5.6  Perform a Facility Loopback on a Destination-Node Ethernet Port
You perform a facility loopback test at the destination port to determine whether this local port is the 
source of circuit trouble. The example in Figure 1-35 shows a facility loopback being performed on an 
Ethernet port.

Figure 1-35 Facility Loopback on a Destination-Node Ethernet Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Facility loopbacks require on-site personnel.

Complete the “Create the Facility Loopback on a Destination-Node Ethernet Port” procedure on 
page 1-85.
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Create the Facility Loopback on a Destination-Node Ethernet Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.5.5  Create a Terminal Loopback on Intermediate-Node Ethernet Ports” 
section on page 1-81, leave the optical test set hooked up to the source-node port.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the hairpin circuit on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
G1K1toG1K5.

e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “LPBKFACILITY (G1000)” condition on page 2-172 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 5 Create the facility loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.

c. Click the Maintenance > Loopback tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.
1-85
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 1      General Troubleshooting
1.5.6    Perform a Facility Loopback on a Destination-Node Ethernet Port
e. Select Facility from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Ethernet Facility Loopback Circuit” procedure on page 1-86.

Test and Clear the Ethernet Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback from the port:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT) from the Admin State column for the port 
being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 4 Clear the facility loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 5 Complete the “Test the Ethernet Card” procedure on page 1-86.

Test the Ethernet Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback on the port:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.
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c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT) from the Admin State column for the port 
being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 6 Clear the facility loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.5.7  Perform a Terminal Loopback on a Destination-Node Ethernet Port” procedure on 
page 1-87.

1.5.7  Perform a Terminal Loopback on a Destination-Node Ethernet Port
The terminal loopback at the destination-node port is the final local hardware error elimination in the 
circuit troubleshooting process. If this test is completed successfully, you have verified that the circuit 
is good up to the destination port. The example in Figure 1-29 shows a terminal loopback on an 
intermediate-node destination Ethernet port. 

Figure 1-36 Terminal Loopback on a Destination-Node Ethernet Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Terminal loopbacks require on-site personnel.

Complete the “Create the Terminal Loopback on a Destination-Node Ethernet Port” procedure on 
page 1-87.

Create the Terminal Loopback on a Destination-Node Ethernet Port

Step 1 Connect an optical test set to the port you are testing:
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Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.5.6  Perform a Facility Loopback on a Destination-Node Ethernet Port” 
procedure on page 1-84, leave the optical test set hooked up to the source port.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the terminal loopback on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as 
G1K1toG1K6.

e. Leave the Bidirectional check box checked.

f. Click Next.

g. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected.

h. Click Next.

i. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box.

j. Click Next.

k. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “LPBKTERMINAL (G1000)” condition on page 2-177 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 5 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.

c. Click the Maintenance > Loopback tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.
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g. Click Yes in the confirmation dialog box.

Step 6 Complete the “Test and Clear the Ethernet Terminal Loopback Circuit” procedure on page 1-89.

Test and Clear the Ethernet Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback from the port:

a. Double-click the intermediate-node card with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT) in the Admin State column for the port 
being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

The entire circuit path has now passed its comprehensive series of loopback tests. This circuit qualifies 
to carry live traffic.

Step 5 If the test set indicates a faulty circuit, the problem might be a faulty card.

Step 6 Complete the “Test the Ethernet Card” procedure on page 1-89. 

Test the Ethernet Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good card.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.

Step 5 Clear the terminal loopback on the port:

a. Double-click the source-node card with the terminal loopback.
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b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT) in the Admin State column for the port 
being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Clear the terminal loopback circuit:

a. Click the Circuits tab.

b. Choose the loopback circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

Step 7 Complete the “1.5.8  Perform a Hairpin Test on a Destination-Node Ethernet Port” procedure on 
page 1-90.

1.5.8  Perform a Hairpin Test on a Destination-Node Ethernet Port
The hairpin test is performed on the cross-connect card in the network circuit. A hairpin circuit uses the 
same port as source as well as destination. Completing a successful hairpin through the card isolates the 
possibility that the cross-connect card is the cause of the faulty circuit. Figure 1-37 shows an example 
of a hairpin loopback on a destination-node port.

Figure 1-37 Hairpin on a Destination-Node Ethernet Port

Note The ONS 15454 does not support simplex operation on the cross-connect card. Two cross-connect cards 
of the same type must be installed for each node.

Note Hairpin loopbacks require on-site personnel.

Complete the “Create the Hairpin Circuit on the Destination-Node Port” procedure on page 1-91.
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Create the Hairpin Circuit on the Destination-Node Port

Step 1 Connect an Ethernet test set to the port you are testing:

a. If you just completed the “1.5.7  Perform a Terminal Loopback on a Destination-Node Ethernet 
Port” procedure on page 1-87, leave the Ethernet test set hooked up to the Ethernet port in the 
destination node.

b. If you are starting the current procedure without the Ethernet test set hooked up to the Ethernet port, 
use appropriate cabling to connect the Ethernet test set to the port you are testing.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Use CTC to set up the hairpin circuit on the test port:

a. In node view, click the Circuits tab and click Create.

b. In the Circuit Creation dialog box, choose the type, such as STS, and number, such as 1.

c. Click Next.

d. In the next Circuit Creation dialog box, give the circuit an easily identifiable name such as Hairpin1.

e. Choose the Size, such as STS-1.

f. Uncheck the Bidirectional check box. Leave the default values for State, SD Threshold, and 
SF Threshold.

g. Click Next.

h. In the Circuit Creation source dialog box, select the same Node, card Slot, Port, and STS (or VT) 
where the test set is connected. Leave Use Secondary Source unchecked.

i. Click Next.

j. In the Circuit Creation destination dialog box, use the same Node, card Slot, Port, and STS (or VT) 
used for the source dialog box. Leave Use Secondary Destination unchecked.

k. Click Next.

l. In the Circuit Creation circuit routing preferences dialog box, leave all defaults. Click Finish.

Step 4 Confirm that the newly created circuit appears on the Circuits tab and that the Dir column describes it 
as a one-way circuit.

Step 5 Complete the “Test and Delete the Ethernet Hairpin Circuit” procedure on page 1-91.

Test and Delete the Ethernet Hairpin Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic received by the test set. Look for errors or any other signal information that the 
test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the hairpin circuit. Clear the 
hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 
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d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 4 Complete the “Test the Standby Cross-Connect Card” procedure on page 1-92.

Test the Standby Cross-Connect Card

Note Two cross-connect cards (active and standby) must be in use on a node to use this procedure.

Step 1 Perform a reset on the standby cross-connect card to make it the active card:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. Position the cursor over the standby cross-connect card.

c. Right-click and choose RESET CARD. 

d. Click Yes in the confirmation dialog box.

Step 2 Initiate an external switching command (side switch) on the cross-connect cards before you retest the 
loopback circuit:

Caution Cross-connect side switches, with the exception of side switches using XC-VXC-10G cards, are 
service-affecting. Any live traffic on any card in the node endures a hit of up to 50 ms. XC-VXC-10G side 
switches are errorless. 

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In the node view, select the Maintenance > Cross-Connect > Cards tabs.

c. In the Cross-Connect Cards area, click Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 3 Resend test traffic on the loopback circuit.

The test traffic now travels through the alternate cross-connect card.

Step 4 If the test set indicates a faulty circuit, assume the cross-connect card is not causing the problem. Clear 
the hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 
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d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

Step 5 To confirm a defective original cross-connect card, complete the “Retest the Original Cross-Connect 
Card” procedure on page 1-93.

Retest the Original Cross-Connect Card

Step 1 Initiate an external switching command (side switch) on the cross-connect cards:

a. Determine the standby cross-connect card. On both the physical node and the CTC node view 
window, the standby cross-connect ACT/SBY LED is amber and the active card ACT/SBY LED is 
green. 

b. In node view, select the Maintenance > Cross-Connect > Cards tabs.

c. From the Cross-Connect Cards menu, choose Switch.

d. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect goes into standby mode, the original standby card becomes 
active and its ACT/SBY LED turns green. The former active card becomes standby and its 
ACT/SBY LED turns amber.

Step 2 Resend test traffic on the loopback circuit.

Step 3 If the test set indicates a faulty circuit, the problem is probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447 and 
proceed to Step 4. If the test does not indicate a faulty circuit, proceed to Step 5.

Step 4 Complete the “Physically Replace an In-Service Cross-Connect Card” procedure on page 2-275 for the 
defective cross-connect card.

Step 5 If the test set indicates a good circuit, the cross-connect card might have had a temporary problem that 
was cleared by the side switch. Clear the hairpin circuit:

a. Click the Circuits tab.

b. Choose the hairpin circuit being tested.

c. Click Delete. 

d. Click Yes in the Delete Circuits dialog box. Do not check any check boxes.

e. Confirm that the hairpin circuit is deleted from the Circuits tab list.

The entire circuit path has now passed its comprehensive series of loopback tests. This circuit qualifies 
to carry live traffic.
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1.6  Troubleshooting FC_MR Circuit Paths With Loopbacks
Facility loopbacks, terminal loopbacks, and cross-connect loopback circuits are often used together to 
test the circuit path through the network or to logically isolate a fault. Performing a loopback test at each 
point along the circuit path systematically isolates possible points of failure. FC_MR loopback tests 
differ from electrical, optical, and Ethernet testing because loopback testing does not require circuit 
creation. FC_MR client ports are statically mapped to the trunk ports so no signal needs to traverse the 
cross-connect card (in a circuit) to test the loopback.

You can use these procedures on fibre channel data storage (FC_MR) cards. The example in this section 
tests an FC_MR circuit on a three-node BLSR. Using a series of facility loopbacks and terminal 
loopbacks, the example scenario traces the circuit path, tests the possible failure points, and eliminates 
them. The logical progression contains seven network test procedures:

Note FC_MR card client ports do not appear in the Maintenance > Loopback tabs unless they have been 
provisioned. Provision ports in the card view Provisioning > Pluggable Port Modules tab. For 
information about provisioning client ports, refer to the Cisco ONS 15454 Procedure Guide.

Note The test sequence for your circuits will differ according to the type of circuit and network topology.

1. A facility loopback on the source-node FC_MR port

2. A terminal loopback on the source-node FC_MR port

3. A facility loopback on the destination-node FC_MR port

4. A terminal loopback on the destination-node FC_MR port

Note Facility, hairpin, and terminal loopback tests require on-site personnel.

1.6.1  Perform a Facility Loopback on a Source-Node FC_MR Port
The facility loopback test is performed on the node source port in the network circuit. In the testing 
situation used in this example, the source muxponder or transponder port in the source node. Completing 
a successful facility loopback on this port isolates the FC_MR port as a possible failure point. 
Figure 1-38 shows an example of a facility loopback on a circuit source FC_MR port.

Figure 1-38 Facility Loopback on a Circuit Source FC_MR Port
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Caution Performing a loopback on an in-service circuit is service-affecting.

Note Facility loopbacks require on-site personnel.

Complete the “Create the Facility Loopback on the Source-Node FC_MR Port” procedure on page 1-95.

Create the Facility Loopback on the Source-Node FC_MR Port

Step 1 Connect an optical test set to the port you are testing.

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

Use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. The Tx and Rx terminals connect to the same port. 

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 In CTC node view, double-click the card to open the card view.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Choose OOS,MT from the Admin State column for the port being tested. If this is a multiport card, 
select the appropriate row for the desired port.

Step 6 Choose Facility from the Loopback Type column for the port being tested. If this is a multiport card, 
select the appropriate row for the desired port.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Note It is normal for the “CLPBKFACILITY (OCN)” condition on page 2-173 or the 
“LPBKFACILITY (G1000)” condition on page 2-172 to appear during loopback setup. The 
condition clears when you remove the loopback.

Step 9 Complete the “Test and Clear the FC_MR Facility Loopback Circuit” procedure on page 1-95.

Test and Clear the FC_MR Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback:

a. Click the Maintenance > Loopback tabs.
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b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the FC_MR Card” procedure on page 1-96.

Test the FC_MR Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 6 Complete the “1.6.2  Perform a Terminal Loopback on a Source-Node FC_MR Port” procedure on 
page 1-96.

1.6.2  Perform a Terminal Loopback on a Source-Node FC_MR Port
The terminal loopback test is performed on the node source FC_MR muxponder or transponder port. For 
the circuit in this example, the test port is the source FC_MR port in the source node. Completing a 
successful terminal loopback to a node source port verifies that the circuit is good to the source port. 
Figure 1-39 shows an example of a terminal loopback on a source FC_MR port. 
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Figure 1-39 Terminal Loopback on a Source-Node FC_MR Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Terminal loopbacks require on-site personnel.

Complete the “Create the Terminal Loopback on a Source-Node FC_MR Port” procedure on page 1-97.

Create the Terminal Loopback on a Source-Node FC_MR Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.6.1  Perform a Facility Loopback on a Source-Node FC_MR Port” 
procedure on page 1-94, leave the optical test set hooked up to the FC_MR port in the source node.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 In node view, double-click the card that requires the loopback, such as the destination OC-N card in the 
source node.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate for 
the desired port.

Step 6 Select Terminal from the Loopback Type column. If this is a multiport card, select the row appropriate 
for the desired port.

Step 7 Click Apply.

Step 8 Click Yes in the confirmation dialog box.

Step 9 Complete the “Test and Clear the FC_MR Port Terminal Loopback Circuit” procedure on page 1-98.
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Test and Clear the FC_MR Port Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback state on the port:

a. Double-click the card in the source node with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the FC_MR Card” procedure on page 1-98. 

Test the FC_MR Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.

Step 5 Clear the terminal loopback on the port before testing the next segment of the network circuit path:

a. Double-click the card in the source node with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Complete the “1.6.3  Create a Facility Loopback on an Intermediate-Node FC_MR Port” procedure on 
page 1-99.
1-98
Cisco ONS 15454 Troubleshooting Guide, R8.5

 November 2009



 

Chapter 1      General Troubleshooting
1.6.3    Create a Facility Loopback on an Intermediate-Node FC_MR Port
1.6.3  Create a Facility Loopback on an Intermediate-Node FC_MR Port
Performing the facility loopback test on an intermediate port determines whether this node is causing 
circuit failure. In the example shown in Figure 1-40, the test is being performed on an intermediate 
FC_MR port.

Figure 1-40 Facility Loopback on an Intermediate-Node FC_MR Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Facility loopbacks require on-site personnel.

Complete the “Create a Facility Loopback on an Intermediate-Node FC_MR Port” procedure on 
page 1-99.

Create a Facility Loopback on an Intermediate-Node FC_MR Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.6.2  Perform a Terminal Loopback on a Source-Node FC_MR Port” 
procedure on page 1-96, leave the optical test set hooked up to the source-node port.

b. If you are starting the current procedure without the optical test set hooked up to the source port 
port, use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you 
are testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 In node view, double-click the intermediate-node card that requires the loopback.

Step 4 Click the Maintenance > Loopback tabs.

Step 5 Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate for 
the desired port.

Step 6 Select Facility from the Loopback Type column. If this is a multiport card, select the row appropriate 
for the desired port.

Step 7 Click Apply.
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Step 8 Click Yes in the confirmation dialog box.

Step 9 Complete the “Test and Clear the FC_MR Port Facility Loopback Circuit” procedure on page 1-100.

Test and Clear the FC_MR Port Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback from the port:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the FC_MR Card” procedure on page 1-100.

Test the FC_MR Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback from the port:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 6 Complete the “1.6.4  Create a Terminal Loopback on Intermediate-Node FC_MR Ports” procedure on 
page 1-101.
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1.6.4  Create a Terminal Loopback on Intermediate-Node FC_MR Ports
In the next troubleshooting test, you perform a terminal loopback on the intermediate-node port to isolate 
whether the destination port is causing circuit trouble. In the example situation in Figure 1-41, the 
terminal loopback is performed on an intermediate FC_MR port in the circuit. If you successfully 
complete a terminal loopback on the node, this node is excluded from possible sources of circuit trouble. 

Figure 1-41 Terminal Loopback on an Intermediate-Node FC_MR Port 

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Terminal loopbacks require on-site personnel.

Complete the “Create a Terminal Loopback on Intermediate-Node FC_MR Ports” procedure on 
page 1-101.

Create a Terminal Loopback on Intermediate-Node FC_MR Ports

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.6.3  Create a Facility Loopback on an Intermediate-Node FC_MR Port” 
section on page 1-99, leave the optical test set hooked up to the source-node port.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the intermediate node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.
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c. Click the Maintenance > Loopback tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test and Clear the FC_MR Terminal Loopback Circuit” procedure on page 1-102.

Test and Clear the FC_MR Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback from the port:

a. Double-click the intermediate-node card with the terminal loopback to open the card view.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the FC_MR Card” procedure on page 1-102. 

Test the FC_MR Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.

Step 5 Clear the terminal loopback on the port:

a. Double-click the source-node card with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.
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d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 6 Complete the “1.6.5  Perform a Facility Loopback on a Destination-Node FC_MR Port” procedure on 
page 1-103.

1.6.5  Perform a Facility Loopback on a Destination-Node FC_MR Port
You perform a facility loopback test at the destination port to determine whether this local port is the 
source of circuit trouble. The example in Figure 1-42 shows a facility loopback being performed on an 
FC_MR port.

Figure 1-42 Facility Loopback on a Destination-Node FC_MR Port 

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Facility loopbacks require on-site personnel.

Complete the “Create the Facility Loopback on a Destination-Node FC_MR Port” procedure on 
page 1-103.

Create the Facility Loopback on a Destination-Node FC_MR Port

Step 1 Connect an optical test set to the port you are testing:

Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.6.4  Create a Terminal Loopback on Intermediate-Node FC_MR Ports” 
procedure on page 1-101, leave the optical test set hooked up to the source-node port.
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b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Create the facility loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.

c. Click the Maintenance > Loopback tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Facility from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test and Clear the FC_MR Facility Loopback Circuit” procedure on page 1-104.

Test and Clear the FC_MR Facility Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the traffic received by the test set. Look for errors or any other signal information that the test 
set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary with the facility loopback. Clear the 
facility loopback from the port:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 4 Complete the “Test the FC_MR Card” procedure on page 1-104.

Test the FC_MR Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good one.

Step 2 Resend test traffic on the loopback circuit with a known-good card installed.
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Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the faulty card.

Step 5 Clear the facility loopback on the port:

a. Click the Maintenance > Loopback tabs.

b. Choose None from the Loopback Type column for the port being tested.

c. Choose the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) from the Admin State column 
for the port being tested.

d. Click Apply.

e. Click Yes in the confirmation dialog box.

Step 6 Complete the “1.6.6  Perform a Terminal Loopback on a Destination-Node FC_MR Port” procedure on 
page 1-105.

1.6.6  Perform a Terminal Loopback on a Destination-Node FC_MR Port
The terminal loopback at the destination-node port is the final local hardware error elimination in the 
circuit troubleshooting process. If this test is completed successfully, you have verified that the circuit 
is good up to the destination port. The example in Figure 1-43 shows a terminal loopback on an 
intermediate-node destination FC_MR port. 

Figure 1-43 Terminal Loopback on a Destination-Node FC_MR Port

Caution Performing a loopback on an in-service circuit is service-affecting.

Note Terminal loopbacks require on-site personnel.

Complete the “Create the Terminal Loopback on a Destination-Node FC_MR Port” procedure on 
page 1-105.

Create the Terminal Loopback on a Destination-Node FC_MR Port

Step 1 Connect an optical test set to the port you are testing:
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Note For specific procedures to connect, set up, and use the test set equipment, consult the 
manufacturer.

a. If you just completed the “1.6.5  Perform a Facility Loopback on a Destination-Node FC_MR Port” 
procedure on page 1-103, leave the optical test set hooked up to the source port.

b. If you are starting the current procedure without the optical test set hooked up to the source port, 
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are 
testing. Both Tx and Rx connect to the same port.

Step 2 Adjust the test set accordingly. (Refer to manufacturer instructions for test-set use.) 

Step 3 Confirm that the newly created circuit appears on the Circuits tab list as a two-way circuit. 

Note It is normal for the “LPBKTERMINAL (OCN)” condition on page 2-177 to appear during a 
loopback setup. The condition clears when you remove the loopback.

Step 4 Create the terminal loopback on the destination port being tested:

a. Go to the node view of the destination node:

 • Choose View > Go To Other Node from the menu bar.

 • Choose the node from the drop-down list in the Select Node dialog box and click OK.

b. In node view, double-click the card that requires the loopback.

c. Click the Maintenance > Loopback tabs.

d. Select OOS,MT from the Admin State column. If this is a multiport card, select the row appropriate 
for the desired port.

e. Select Terminal from the Loopback Type column. If this is a multiport card, select the row 
appropriate for the desired port.

f. Click Apply.

g. Click Yes in the confirmation dialog box.

Step 5 Complete the “Test and Clear the FC_MR Terminal Loopback Circuit” procedure on page 1-106.

Test and Clear the FC_MR Terminal Loopback Circuit

Step 1 If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2 Examine the test traffic being received by the test set. Look for errors or any other signal information 
that the test set is capable of indicating.

Step 3 If the test set indicates a good circuit, no further testing is necessary on the loopback circuit. Clear the 
terminal loopback from the port:

a. Double-click the intermediate-node card with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.
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d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

Step 4 If the test set indicates a faulty circuit, the problem might be a faulty card.

Step 5 Complete the “Test the FC_MR Card” procedure on page 1-107. 

Test the FC_MR Card

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the suspected bad card 
and replace it with a known-good card.

Step 2 Resend test traffic on the loopback circuit with a known-good card.

Step 3 If the test set indicates a good circuit, the problem was probably the defective card. Return the defective 
card to Cisco through the RMA process. Contact Cisco Technical Support at 1 800 553-2447.

Step 4 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the defective card.

Step 5 Clear the terminal loopback on the port:

a. Double-click the source-node card with the terminal loopback.

b. Click the Maintenance > Loopback tabs.

c. Select None from the Loopback Type column for the port being tested.

d. Select the appropriate state (IS; OOS,DSBLD; OOS,MT; IS,AINS) in the Admin State column for 
the port being tested.

e. Click Apply.

f. Click Yes in the confirmation dialog box.

The entire circuit path has now passed its comprehensive series of loopback tests. This circuit qualifies 
to carry live traffic.

1.7  Using CTC Diagnostics
CTC provides diagnostics for the following functions:

 • Verifying proper card ASICS function

 • Verifying standby card operation

 • Verifying proper card LED operation

 • Diagnostic circuit creation

 • Customer problem notifications detected via alarms

 • Provision of a downloadable, machine-readable diagnostic information file to be used by Cisco 
Technical Support.
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Some of these functions, such as ASIC verification and standby card operation, are invisibly monitored 
in background functions. Change or problem notifications are provided in the Alarms and Conditions 
window. Other diagnostic functions—verifying card LED function, creating bidirectional diagnostic 
circuits, and also downloading diagnostic files for technical support—are available to the user in the 
node view Maintenance > Diagnostic tabs. The user-operated diagnostic features are described in the 
following paragraphs.

1.7.1  Card LED Lamp Tests 
A card LED lamp test determines whether card-level indication LEDs are operational. This diagnostic 
test is run as part of the initial ONS 15454 turn-up, during maintenance routines, or any time you 
question whether an LED is in working order. Maintenance or higher-level users can complete the 
following tasks to verify LED operation.

Verify General Card LED Operation

Step 1 In node view, click the Maintenance > Diagnostic tabs (Figure 1-44).

Figure 1-44 CTC Node View Diagnostic Window

Step 2 Click Lamp Test.

Step 3 Watch to make sure all the port LEDs illuminate simultaneously for several seconds, with the following 
durations:

 • For tri-color LEDs: three 5-second cycles

 • For dual-color LEDs: one 5-second cycle and one 10-second cycle

 • For the AIC or AIC-I: one 15-second cycle
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Step 4 Click OK in the Lamp Test Run dialog box.

With the exceptions previously described, if an OC-N or DS-N LED does not light up, the LED is faulty. 
Return the defective card to Cisco through the RMA process. Contact the Cisco Technical Assistance 
Center (TAC) at 1 800 553-2447.

Verify G-Series Ethernet or FC_MR Card Port-Level LED Operation

Note G-Series and FC_MR card-level LEDs illuminate during a lamp test, but the port-level LEDs do not.

Step 1 Complete the “Verify General Card LED Operation” procedure on page 1-108 to verify that card-level 
LEDs are operational.

Step 2 Use the following list of guidelines to physically test whether the G-Series Ethernet port LEDs are 
operating correctly. If the LED appears as described when the listed state is occurring for the port, the 
LED is considered to be functioning correctly.

 • Clear port LED: Should only occur if there is a loss of receive link (such as a disconnected link or 
unplugged Gigabit Interface Converter, [GBIC]). An LOS alarm could be present on the port.

 • Amber port LED: Should only occur if a port is disabled but the link is connected, or if the port is 
enabled and the link is connected but a transport failure is present. A TPTFAIL alarm can be present 
on the port.

 • Green port LED: Should occur if the port is enabled and has no errors against it or traffic in it. Can 
also occur if the port is enabled, has no errors, and is running traffic proportionate to the blink rate. 
No traffic-affecting port alarms should be present.

Step 3 If you are unable to determine the port state, contact Cisco Technical Support at 1 800 553-2447.

Verify E-Series and ML-Series Ethernet Card Port-Level LED Operation

Note E-Series and ML-Series card-level LEDs illuminate during a lamp test, but the port-level LEDs do not.

Note For information about the ML-Series card, refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH 
Ethernet Card Software Feature and Configuration Guide.

Step 1 Complete the “Verify General Card LED Operation” procedure on page 1-108 to verify that card-level 
LEDs are operational.

Step 2 Use the following list of guidelines to physically test whether the single E-Series or ML-Series Ethernet 
port LED is operating correctly. If the LED appears as described when the listed state is occurring for 
the port, the LED is considered to be functioning correctly.

 • Clear port LED: Should only occur if there is a loss of receive link (such as a disconnected link or 
unplugged GBIC), or if traffic is flowing in one direction (either transmit or receive). A CARLOSS 
alarm could be present on the port.
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 • Amber port LED: Should only occur if the link is connected and the physical port is transmitting 
and receiving traffic.

 • Green port LED: Should occur if the link is up and no traffic is flowing on the port.

Step 3 If you are unable to determine the port state, contact Cisco Technical Support at 1 800 553-2447.

1.7.2  Retrieve Diagnostics File Button
When you click the Retrieve Diagnostics File button in the Maintenance window, CTC retrieves system 
data that can be off-loaded by a Maintenance or higher-level user to a local directory and sent to 
Technical Support for troubleshooting purposes. The diagnostics file is in machine language and is not 
human-readable, but can be used by Cisco Technical Support for problem analysis. Complete the 
following task to off-load the diagnostics file.

Note In addition to the machine-readable diagnostics file, the ONS 15454 also stores an audit trail of all 
system events such as user logins, remote logins, configuration, and changes. This audit trail is 
considered a record-keeping feature rather than a troubleshooting feature. Information about the feature 
is located in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Off-Load the Diagnostics File

Step 1 In the node view, click the Maintenance > Diagnostic tabs (Figure 1-44).

Step 2 Click Retrieve Tech Support Log.

Step 3 In the Saving Diagnostic File dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 4 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is a compressed file (gzip) that can be 
unzipped and read by Cisco Technical Support.

Step 5 Click Save.

The Get Diagnostics status window shows a progress bar indicating the percentage of the file being 
saved, then shows “Get Diagnostics Complete.”

Step 6 Click OK.

1.7.3  Bidirectional Diagnostic Circuit
CTC provides a diagnostic bidirectional loopback circuit feature that uses pseudo-random bit sequence 
(PRBS) error detection to monitor standby path protection, BLSR, 1+1, or unprotected circuit path 
readiness. 
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The diagnostic circuit is bidirectional and uses a single VT 1.5 in an STS. The circuit can traverse 
multiple nodes, but it must be carried by the same STS for the entire path. The circuit originates and 
ultimately destinates on the same node, but can be looped (by a hairpin circuit) through other nodes. 
After the circuit returns to the originating node, the signal result is detected and analyzed for errors by 
PRBS. 

This type of circuit is created much the same way as a normal standby protection channel access (PCA) 
circuit, but is designated by checking the Diagnostic check box during circuit creation. A normal circuit 
uses line cards as the endpoints, but if a circuit is configured as a diagnostic, the endpoints are 
cross-connect cards.

Each card type utilizes the diagnostic feature differently. Standby electrical cards run PRBS tests to 
ensure signal path integrity. Optical cards do not run PRBS tests, but instead run ASIC tests to test card 
operability. Cross-connect cards verify the standby paths.

The diagnostic circuit can be configured for an end-to-end or multiple-node path layout, traversing the 
transmit and receive standby paths as shown in Figure 1-45.

Figure 1-45 CTC Node View Diagnostic Window

The maximum diagnostic circuit size is VT1.5, and the maximum quantity of available diagnostic 
circuits is one per node. (In other words, if you create a diagnostic VT within an STS, the remaining 27 
VTs can still be provisioned, and they may also contain diagnostic circuits originating on other nodes.) 

As with all bidirectional circuits, a diagnostic circuit can only be created if the same STS is available on 
each span the circuit traverses. When you use a bidirectional diagnostic that traverses one or more 
intermediate nodes, create or utilize an existing bidirectional circuit on each intermediate node. At the 
terminating node, you will need to create a hairpin loopback at the end of the PRBS source span to return 
the signal.
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Note The diagnostic VT circuit does not raise a failure alarm if AIS-P or UNEQ-P is returned to the PRBS 
detector. In order to see an alarm indicating a failed diagnostic circuit, the circuit must be returned to the 
PRBS detector with a different payload than the generator sources and without the AIS-P or UNEQ-P 
conditions. 

Create a Bidirectional Diagnostic Circuit 

Step 1 Log into the node where you will create the diagnostic circuit. (For login instructions, refer to the 
“Connect the PC and Log into the GUI” chapter in the Cisco ONS 15454 Procedure Guide.) 

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, refer 
to the task for assigning a name to a port in the “Create Circuits and VT Tunnels” chapter of the 
Cisco ONS 15454 Procedure Guide. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

 • Circuit Type—Choose VT. 

 • Number of Circuits—Enter 1 (the maximum diagnostic circuit quantity available per STS). 

 • Auto-ranged—Uncheck the box. (This option is not applicable to diagnostic circuits.)

Step 6 Click Next.

Step 7 Define the circuit attributes in the Circuit Creation Dialog Box (Figure 1-46) using the following 
parameters:

Figure 1-46 Network View Circuit Creation Dialog Box

 • Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters, 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

 • Size—VT1.5 is the default. You cannot change it. 
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 • Bidirectional—This is the default value. Leave it checked for this circuit.

 • State—This option is not available when you check the Diagnostic option.

 • Diagnostic—Check this box to create a diagnostic circuit.

 • Apply to drop ports—Leave this box unchecked.

 • Create cross-connects only (TL1-like)—Not applicable to diagnostic circuits. 

 • Inter-domain (UCP) SLA—Not applicable to diagnostic circuits.

 • Protected Drops—Not applicable to diagnostic circuits.

Step 8 Click Next. 

Step 9 In the Source area of the Circuit Creation pane, complete the following: 

a. From the Node drop-down list, choose the node.

b. From the Slot drop-down list, choose PRBS Generator.

c. Click Next.

Step 10 In the Destination area of the Circuit Creation pane, complete the following:

a. From the Node drop-down list, choose the node. The only selectable item in the list is the node 
chosen as the source node.

b. From the Slot drop-down list, choose the slot where the span originates.

c. From the STS drop-down list, choose the STS.

d. From the VT drop-down list, choose the VT. 

e. Click Next.

Step 11 Click Finish. 

Step 12 In the Circuits window, verify that the new circuit(s) appear in the circuits list.

1.7.4  Data Communications Network Tool
CTC contains a data communications network (DCN) tool that assists with network troubleshooting for 
Open Shortest Path First (OSPF) networks. This tool, located in network view, is shown in Figure 1-47. 
It executes an internal dump command to retrieve information about all nodes accessible from the entry 
point.
1-113
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 1      General Troubleshooting
1.8    Restoring the Database and Default Settings
Figure 1-47 DCN Tools OSPF Dump

The dump, which provides the same information as a dump executed by special networking commands, 
is available at the network view in the Maintenance > Diagnostic tabs. You can select the access point 
node in the Select Node drop-down list. To create the dump, click Retrieve. (To clear the dump, click 
Clear.)

The contents of the dump file can be saved or printed and furnished to Cisco Technical Support for use 
in OSPF network support.

1.8  Restoring the Database and Default Settings
This section contains troubleshooting for node operation errors that require restoring software data or 
the default node setup.

1.8.1  Restore the Node Database

Symptom   One or more nodes does not function properly or has incorrect data.

Possible Cause   Incorrect or corrupted node database.

Recommended Action   Complete the procedures in the “Maintain the Node” chapter of the 
Cisco ONS 15454 Procedure Guide.
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1.9  PC Connectivity Troubleshooting
This section contains information about system minimum requirements, supported platforms, browsers, 
and JREs. It also contains troubleshooting procedures for PC and network connectivity to the 
ONS 15454.

1.9.1  PC System Minimum Requirements
Workstations running CTC Software Release 8.5 for the ONS products on Windows platforms must have 
the following minimum requirements:

 • Pentium III or higher processor

 • Processor speed of at least 700 MHz

 • 256 MB or more of RAM

 • 50 MB or more of available hard disk space

 • 20 GB or larger hard drive

1.9.2  Sun System Minimum Requirements
Workstations running Software R8.5 for the ONS products on Sun workstations need to have the 
following minimum requirements:

 • UltraSPARC or faster processor

 • 256 MB or more of RAM

 • 50 MB or more of available hard disk space

1.9.3  Supported Platforms, Browsers, and JREs
Software R8.5 supports the following platforms:

 • Windows NT

 • Windows 98

 • Windows XP

 • Windows 2000

 • Solaris 9

 • Solaris 10

Software R8.5 supports the following browsers and JREs:

 • Netscape 7 browser (PC or Solaris 9 or 10 with JRE 5.0) 

 • PC platforms with JRE 5.0

 • Internet Explorer 6.0 browser (on PC platforms with JRE 5.0)

 • Mozilla 1.7 (Solaris 9 or 10 only with JRE 5.0)
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Note You can obtain browsers at the following URLs: 
Internet Explorer: http://www.microsoft.com 
Mozilla: http://www.mozilla.org/

JRE 5.0 is required to run Software R8.5. JRE 5.0 is provided on the software CD.

1.9.4  Unsupported Platforms and Browsers
Software R8.5 does not support the following platforms:

 • Windows 95

 • Solaris 2.5

 • Solaris 2.6

Software R8.5 does not support the following browsers and JREs:

 • Netscape 4.73 for Windows.

 • Netscape 4.76 on Solaris is not supported.

 • Netscape 7 on Solaris 9 or 10 is only supported with JRE 5.0.

1.9.5  Unable to Verify the IP Configuration of Your PC

Symptom   When connecting your PC to the ONS 15454, you are unable to successfully ping the IP 
address of your PC to verify the IP configuration.

Possible Cause   The IP address and/or subnet mask was entered incorrectly.

Recommended Action   Verify that the IP address used to ping the PC matches the IP address displayed 
when in the Windows IP Configuration information retrieved from the system. See the “Verify the 
IP Configuration of Your PC” procedure on page 1-116.

Possible Cause   The IP configuration of your PC is not properly set.

Recommended Action   Verify the IP configuration of your PC. Complete the “Verify the IP 
Configuration of Your PC” procedure on page 1-116. If this procedure is unsuccessful, contact your 
Network Administrator for instructions to correct the IP configuration of your PC.

Verify the IP Configuration of Your PC

Step 1 Open a DOS command window by selecting Start > Run from the Start menu.

Step 2 In the Open field, type command and then click OK. The DOS command window appears.

Step 3 At the prompt in the DOS window, type one of the following commands:

 • For Windows 98, NT, 2000, and XP, type ipconfig and press the Enter key.

The Windows IP configuration information appears, including the IP address, subnet mask, and the 
default gateway.
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Note The winipcfg command only returns the information above if you are on a network.

Step 4 At the prompt in the DOS window, type ping followed by the IP address shown in the Windows IP 
configuration information previously displayed.

Step 5 Press the Enter key to execute the command.

If the DOS window returns multiple (usually four) replies, the IP configuration is working properly.

If you do not receive a reply, your IP configuration might not be properly set. Contact your Network 
Administrator for instructions to correct the IP configuration of your PC.

1.9.6  Browser Login Does Not Launch Java

Symptom   The message “Loading Java Applet” does not appear and the JRE does not launch during the 
initial login.

Possible Cause   The PC operating system and browser are not properly configured.

Recommended Action   Reconfigure the PC operating system java plug-in control panel and the 
browser settings. Complete the “Reconfigure the PC Operating System Java Plug-in Control Panel” 
procedure on page 1-117 and the “Reconfigure the Browser” procedure on page 1-118.

Reconfigure the PC Operating System Java Plug-in Control Panel

Step 1 From the Windows start menu, click Settings > Control Panel.

Step 2 If Java Plug-in does not appear, the JRE might not be installed on your PC:

a. Run the Cisco ONS 15454 software CD.

b. Open the CD-drive:\Windows\JRE folder.

c. Double-click the j2re-5_0-win icon to run the JRE installation wizard.

d. Follow the JRE installation wizard steps.

Step 3 From the Windows start menu, click Settings > Control Panel.

Step 4 In the Java Plug-in Control Panel window, double-click the Java Plug-in 5.0 icon.

Step 5 Click the Advanced tab on the Java Plug-in Control Panel.

Step 6 Navigate to C:\ProgramFiles\JavaSoft\JRE\5.0.

Step 7 Select JRE 5.0.

Step 8 Click Apply.

Step 9 Close the Java Plug-in Control Panel window.
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Reconfigure the Browser

Step 1 From the Start Menu, launch your browser application.

Step 2 If you are using Netscape Navigator:

a. On the Netscape Navigator menu bar, click the Edit > Preferences menus.

b. In the Preferences window, click the Advanced > Proxies categories.

c. In the Proxies window, click the Direct connection to the Internet check box and click OK.

d. On the Netscape Navigator menu bar, click the Edit > Preferences menus.

e. In the Preferences window, click the Advanced > Cache categories.

f. Confirm that the Disk Cache Folder field shows one of the following paths:

 • For Windows 98/ME, C:\ProgramFiles\Netscape\Communicator\cache

 • For Windows NT/2000/XP, C:\ProgramFiles\Netscape\username\Communicator\cache.

g. If the Disk Cache Folder field is not correct, click Choose Folder.

h. Navigate to the file listed in Step f, and click OK.

i. Click OK on the Preferences window and exit the browser.

Step 3 If you are using Internet Explorer:

a. On the Internet Explorer menu bar, click the Tools > Internet Options menus.

b. In the Internet Options window, click the Advanced tab.

c. In the Settings menu, scroll down to Java (Sun) and click the Use Java 2 v1.4.2 for applet (requires 
restart) check box.

d. Click OK in the Internet Options window and exit the browser.

Step 4 Temporarily disable any virus-scanning software on the computer. See the “1.10.4  Browser Stalls When 
Downloading CTC JAR Files From TCC2/TCC2P Card” section on page 1-123.

Step 5 Verify that the computer does not have two network interface cards (NICs) installed. If the computer 
does have two NICs, remove one.

Step 6 Restart the browser and log on to the ONS 15454.

1.9.7  Unable to Verify the NIC Connection on Your PC

Symptom   When connecting your PC to the ONS 15454, you are unable to verify that the network 
interface card (NIC) connection is working properly because the link LED is not illuminated or flashing.

Possible Cause   The Category-5 cable is not plugged in properly.

Recommended Action   Confirm that both ends of the cable are properly inserted. If the cable is not 
fully inserted due to a broken locking clip, the cable should be replaced.
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Possible Cause   The Category-5 cable is damaged.

Recommended Action   Ensure that the cable is in good condition. If in doubt, use a known-good cable. 
Often, cabling is damaged due to pulling or bending. (For information about installing cable, refer 
to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.)

Possible Cause   Incorrect type of Category-5 cable is being used.

Recommended Action   If you are connecting an ONS 15454 directly to your laptop, a PC, or a router, 
use a straight-through Category-5 cable. When connecting the ONS 15454 to a hub or a LAN switch, 
use a crossover Category-5 cable. For details on the types of Category-5 cables, see the 
“1.12.2.1  Crimp Replacement LAN Cables” section on page 1-142.

Possible Cause   The NIC is improperly inserted or installed.

Recommended Action   If you are using a Personal Computer Memory Card International Association 
(PCMCIA)-based NIC, remove and reinsert the NIC to make sure the NIC is fully inserted. (If the 
NIC is built into the laptop or PC, verify that the NIC is not faulty.)

Possible Cause   The NIC is faulty.

Recommended Action   Confirm that the NIC is working properly. If you have no issues connecting to 
the network (or any other node), then the NIC should be working correctly. If you have difficulty 
connecting a to the network (or any other node), then the NIC might be faulty and needs to be 
replaced.

1.9.8  Verify PC Connection to the ONS 15454 (ping)

Symptom   The TCP/IP connection was established and then lost.

Possible Cause   A lost connection between the PC and the ONS 15454.

Recommended Action   Use a standard ping command to verify the TCP/IP connection between the PC 
and the ONS 15454 TCC2/TCC2P card. A ping command should work if the PC connects directly 
to the TCC2/TCC2P card or uses a LAN to access the TCC2/TCC2P card. Complete the “Ping the 
ONS 15454” procedure on page 1-119.

Ping the ONS 15454

Step 1 Open a the command prompt:

a. If you are using a Microsoft Windows operating system, from the Start Menu choose Run, enter 
command in the Open field of the Run dialog box, and click OK.

b. If you are using a Sun Solaris operating system, from the Common Desktop Environment (CDE) 
click the Personal Application tab and click Terminal.

Step 2 For both the Sun and Microsoft operating systems, at the prompt enter:

ping ONS-15454-IP-address

For example:

ping 198.168.10.10
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Step 3 If the workstation has connectivity to the ONS 15454, the ping is successful and displays a reply from 
the IP address. If the workstation does not have connectivity, a “Request timed out” message appears.

Step 4 If the ping is successful, it demonstrates that an active TCP/IP connection exists. Restart CTC.

Step 5 If the ping is not successful, and the workstation connects to the ONS 15454 through a LAN, check that 
the workstation’s IP address is on the same subnet as the ONS node.

Step 6 If the ping is not successful and the workstation connects directly to the ONS 15454, check that the link 
light on the workstation’s NIC is illuminated.

1.9.9  The IP Address of the Node is Unknown

Symptom   The IP address of the node is unknown and you are unable to login.

Possible Cause   The node is not set to the default IP address.

Recommended Action   Leave one TCC2/TCC2P card in the shelf. Connect a PC directly to the 
remaining TCC2/TCC2P card and perform a hardware reset of the card. The TCC2/TCC2P card 
transmits the IP address after the reset to enable you to capture the IP address for login. Complete 
the “Retrieve Unknown Node IP Address” procedure on page 1-120.

Retrieve Unknown Node IP Address

Step 1 Connect your PC directly to the active TCC2/TCC2P card Ethernet port on the faceplate.

Step 2 Start the Sniffer application on your PC.

Step 3 Perform a hardware reset by pulling and reseating the active TCC2/TCC2P card.

Step 4 After the TCC2/TCC2P card completes resetting, it broadcasts its IP address. The Sniffer software on 
your PC will capture the IP address being broadcast.

1.10  CTC Operation Troubleshooting
This section contains troubleshooting procedures for CTC login or operation problems.
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1.10.1  CTC Colors Do Not Appear Correctly on a UNIX Workstation

Symptom   When running CTC on a UNIX workstation, the colors do not appear correctly. For example, 
both major and minor alarms appear in the same color. 

Possible Cause   When running in 256-color mode on a UNIX workstation, color-intensive 
applications such as Netscape might use all of the colors.

Recommended Action   CTC requires a full 24-color palette to run properly. When logging into CTC 
on a UNIX workstation, run as many colors as your adapter will support. In addition, you can use 
the -install or the -ncols 32 command line options to limit the number of colors that Netscape uses. 
Complete the “Limit Netscape Colors” procedure on page 1-121. If the problem persists after 
limiting Netscape colors, exit any other color-intensive applications in use.

Limit Netscape Colors

Step 1 Close the current session of Netscape.

Step 2 Launch Netscape from the command line by entering:

netscape -install (installs Netscape colors for Netscape use)

or

netscape -ncols 32 (limits Netscape to 32 colors so that if the requested color is not available, Netscape 
chooses the closest color option)

1.10.2  Unable to Launch CTC Help After Removing Netscape

Symptom   After removing Netscape and running CTC using Internet Explorer, you are unable to launch 
CTC Help and receive an “MSIE is not the default browser” error message.

Possible Cause   Loss of association between browser and Help files.

Recommended Action   When the CTC software and Netscape are installed, the Help files are 
associated with Netscape by default. When you remove Netscape, the Help files are not 
automatically associated with Internet Explorer as the default browser. Reset Internet Explorer as 
the default browser so that CTC associates the Help files to the correct browser. Complete the “Reset 
Internet Explorer as the Default Browser for CTC” procedure on page 1-121 to associate the CTC 
Help files to the correct browser.

Reset Internet Explorer as the Default Browser for CTC

Step 1 Open the Internet Explorer browser.

Step 2 From the menu bar, click Tools > Internet Options. The Internet Options window appears.

Step 3 In the Internet Options window, click the Programs tab.
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Step 4 Click the Internet Explorer should check to see whether it is the default browser check box.

Step 5 Click OK.

Step 6 Exit any and all open and running CTC and Internet Explorer applications.

Step 7 Launch Internet Explorer and open a new CTC session. You should now be able to access the CTC Help.

1.10.3  Unable to Change Node View to Network View

Symptom   When activating a large, multinode BLSR from Software R3.2 to Software R3.3, some of the 
nodes appear grayed out. Logging into the new CTC, the user is unable to change node view to network 
view on any and all nodes, from any workstation. This is accompanied by an “Exception occurred during 
event dispatching: java.lang.OutOfMemoryError” in the java window.

Possible Cause   The large, multinode BLSR requires more memory for the graphical user interface 
(GUI) environment variables.

Recommended Action   Reset the system or user CTC_HEAP environment variable to increase the 
memory limits. Complete the “Reset the CTC_HEAP Environment Variable for Windows” 
procedure on page 1-122 or the “Reset the CTC_HEAP Environment Variable for Solaris” 
procedure on page 1-122 to enable the CTC_HEAP variable change.

Note This problem typically affects large networks where additional memory is required to manage 
large numbers of nodes and circuits.

Reset the CTC_HEAP Environment Variable for Windows

Step 1 Exit any and all open and running CTC and Netscape applications.

Step 2 From the Windows Desktop, right-click My Computer and choose Properties in the shortcut menu.

Step 3 In the System Properties window, click the Advanced tab.

Step 4 Click Environment Variables to open the Environment Variables window.

Step 5 Click New under the User variables field or the System variables field.

Step 6 Enter CTC_HEAP in the Variable Name field.

Step 7 Enter 256 in the Variable Value field, and then click OK to create the variable.

Step 8 Click OK in the Environment Variables window to accept the changes.

Step 9 Click OK in the System Properties window to accept the changes.

Restart the browser and CTC software.

Reset the CTC_HEAP Environment Variable for Solaris

Step 1 From the user shell window, kill any CTC applications.
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Step 2 Kill any Netscape applications.

Step 3 In the user shell window, set the environment variable to increase the heap size:

% setenv CTC_HEAP 256 

Step 4 Restart the browser and CTC software in the same user shell window.

1.10.4  Browser Stalls When Downloading CTC JAR Files From TCC2/TCC2P 
Card

Symptom   The browser stalls or hangs when downloading a CTC Java archive (JAR) file from the 
TCC2/TCC2P card.

Possible Cause   McAfee VirusScan software might be interfering with the operation. The problem 
occurs when the VirusScan Download Scan is enabled on McAfee VirusScan 4.5 or later.

Recommended Action   Disable the VirusScan Download Scan feature. Complete the “Disable the 
VirusScan Download Scan” procedure on page 1-123.

Disable the VirusScan Download Scan

Step 1 From the Windows Start menu, choose Programs > Network Associates > VirusScan Console. 

Step 2 Double-click the VShield icon listed in the VirusScan Console dialog box. 

Step 3 Click Configure on the lower part of the Task Properties window. 

Step 4 Click the Download Scan icon on the left of the System Scan Properties dialog box. 

Step 5 Uncheck the Enable Internet download scanning check box.

Step 6 Click Yes when the warning message appears. 

Step 7 Click OK in the System Scan Properties dialog box. 

Step 8 Click OK in the Task Properties window. 

Step 9 Close the McAfee VirusScan window. 

1.10.5  CTC Does Not Launch

Symptom   CTC does not launch; usually an error message appears before the login window appears.

Possible Cause   The Netscape browser cache might point to an invalid directory.

Recommended Action   Redirect the Netscape cache to a valid directory. Complete the “Redirect the 
Netscape Cache to a Valid Directory” procedure on page 1-124.
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Redirect the Netscape Cache to a Valid Directory

Step 1 Launch Netscape. 

Step 2 Open the Edit menu.

Step 3 Choose Preferences.

Step 4 Under the Category column on the left side, expand the Advanced category and choose the Cache tab.

Step 5 Change your disk cache folder to point to the cache file location.

The cache file location is usually C:\ProgramFiles\Netscape\Users\yourname\cache. The yourname 
segment of the file location is often the same as the user name.

1.10.6  Slow CTC Operation or Login Problems

Symptom   You experience slow CTC operation or have problems logging into CTC.

Possible Cause   The CTC cache file might be corrupted or might need to be replaced.

Recommended Action   Search for and delete cache files. This operation forces the ONS 15454 to 
download a new set of Java archive (JAR) files to your computer hard drive. Complete the “Delete 
the CTC Cache File Automatically” procedure on page 1-124 or the “Delete the CTC Cache File 
Manually” procedure on page 1-125.

Delete the CTC Cache File Automatically

Caution All running sessions of CTC must be halted before deleting the CTC cache. Deleting CTC cache might 
cause any CTC running on this system to behave in an unexpected manner.

Step 1 Enter an ONS 15454 IP address into the browser URL field. The initial browser window shows a 
Delete CTC Cache button. 

Step 2 Close all open CTC sessions and browser windows. The PC operating system does not allow you to 
delete files that are in use.

Step 3 Click Delete CTC Cache on the initial browser window to clear the CTC cache. Figure 1-48 shows the 
Delete CTC Cache window.
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Figure 1-48 Deleting the CTC Cache 

Delete the CTC Cache File Manually

Caution All running sessions of CTC must be halted before deleting the CTC cache. Deleting the CTC cache 
might cause any CTC running on this system to behave in an unexpected manner.

Step 1 To delete the JAR files manually, from the Windows Start menu choose Search > For Files or Folders.

Step 2 Enter ctc*.jar or cms*.jar in the Search for files or folders named field in the Search Results dialog box 
and click Search Now.

Step 3 Click the Modified column in the Search Results dialog box to find the JAR files that match the date 
when you downloaded the files from the TCC2/TCC2P. 

Step 4 Highlight the files and press the keyboard Delete key.

Step 5 Click Yes in the Confirm dialog box.
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1.10.7  Node Icon is Gray on CTC Network View

Symptom   The CTC network view shows one or more node icons as gray in color and without a node 
name.

Possible Cause   Different CTC releases do not recognize each other.

Recommended Action   Correct the core version build as described in the “1.10.10  Different CTC 
Releases Do Not Recognize Each Other” section on page 1-128.

Possible Cause   Username and password do not match.

Recommended Action   Correct the username and password as described in the “1.10.11  Username or 
Password Do Not Match” section on page 1-129.

Possible Cause   No IP connectivity between nodes.

Recommended Action   Usually accompanied by Ethernet-specific alarms. Verify the Ethernet 
connections as described in the “1.10.16  Ethernet Connections” section on page 1-131.

Possible Cause   A lost DCC connection.

Recommended Action   Usually accompanied by an embedded operations channel (EOC) alarm. Clear 
the EOC alarm and verify the DCC connection as described in the “EOC” alarm.

1.10.8  CTC Cannot Launch Due to Applet Security Restrictions

Symptom   The error message “Unable to launch CTC due to applet security restrictions” appears after you 
enter the IP address in the browser window.

Possible Cause   You are logging into a node running CTC Software R4.0 or earlier. Releases earlier 
than R4.1 require a modification to the java.policy file so that CTC JAR files can be downloaded to 
the computer. The modified java.policy file might not exist on the computer.

Recommended Action   Install the software CD for the release of the node you are logging into. Run 
the CTC Setup Wizard (double-click Setup.exe). Choose Custom installation, then choose the Java 
Policy option. For additional information, refer to the CTC installation information in the “Connect 
the PC and Log into the GUI” chapter of the Cisco ONS 15454 Procedure Guide. If the software CD 
is not available, you must manually edit the java.policy file on your computer. Complete the 
“Manually Edit the java.policy File” procedure on page 1-126.

Manually Edit the java.policy File

Step 1 Search your computer for java.policy file and open it with a text editor (Notepad or Wordpad). 

Step 2 Verify that the end of this file has the following lines:

// Insert this into the system-wide or a per-user java.policy file.
// DO NOT OVERWRITE THE SYSTEM-WIDE POLICY FILE--ADD THESE LINES!

grant codeBase “http://*/fs/LAUNCHER.jar {
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permission java.security.AllPermission;
};

Step 3 If these five lines are not in the file, enter them manually.

Step 4 Save the file and restart Netscape.

CTC should now start correctly.

Step 5 If the error message is still reported, save the java.policy file as .java.policy. On Win98/2000/XP PCs, 
save the file to the C:\Windows folder. On Windows NT 4.0 or later PCs, save the file to all of the user 
folders on that PC, for example, C:\Winnt\profiles\joeuser.

1.10.9  Java Runtime Environment Incompatible

Symptom   The CTC application does not run properly.

Possible Cause   The compatible Java 2 JRE is not installed.

Recommended Action   The JRE contains the Java virtual machine, runtime class libraries, and Java 
application launcher that are necessary to run programs written in the Java programming language. 
The ONS 15454 CTC is a Java application. A Java application, unlike an applet, cannot rely 
completely on a web browser for installation and runtime services. When you run an application 
written in the Java programming language, you need the correct JRE installed. The correct JRE for 
each CTC software release is included on the Cisco ONS 15454 software CD. Complete the 
“Launch CTC to Correct the Core Version Build” procedure on page 1-128. If you are running 
multiple CTC software releases on a network, the JRE installed on the computer must be compatible 
with the different software releases. Table 1-3 shows JRE compatibility with ONS 15454 software 
releases.

Table 1-3 JRE Compatibility 

Software Release
JRE 1.2.2 
Compatible

JRE 1.3 
Compatible

JRE 1.4 
Compatible

JRE 1.4.2 
Compatible1

JRE 5.0 
Compatible

ONS 15454 R2.2.1 and 
earlier

Yes No No No No

ONS 15454 R2.2.2 Yes Yes No No No

ONS 15454 R3.0 Yes Yes No No No

ONS 15454 R3.1 Yes Yes No No No

ONS 15454 R3.2 Yes Yes No No No

ONS 15454 R3.3 Yes Yes No No No

ONS 15454 R3.4 No Yes No No No

ONS 15454 R4.02 No Yes No No No

ONS 15454 R4.1 No Yes No No No

ONS 15454 R4.5 No Yes No No No

ONS 15454 R4.6 No Yes Yes No No

ONS 15454 R4.7 No Yes Yes No No
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Launch CTC to Correct the Core Version Build

Step 1 Exit the current CTC session and completely close the browser.

Step 2 Start the browser.

Step 3 Enter the ONS 15454 IP address of the node that reported the alarm. This can be the original IP address 
you logged in with or an IP address other than the original.

Step 4 Log into CTC. The browser downloads the JAR file from CTC.

1.10.10  Different CTC Releases Do Not Recognize Each Other

Symptom   Different CTC releases do not recognize each other. This situation is often accompanied by the 
INCOMPATIBLE-SW alarm.

Possible Cause   The software loaded on the connecting workstation and the software on the 
TCC2/TCC2P card are incompatible.

Recommended Action   This occurs when the TCC2/TCC2P software is upgraded but the PC has not 
yet upgraded the compatible CTC JAR file. It also occurs on login nodes with compatible software 
that encounter other nodes in the network that have a newer software version. Complete the “Launch 
CTC to Correct the Core Version Build” procedure on page 1-129.

Note Remember to always log into the ONS node with the latest CTC core version first. If you initially 
log into an ONS node running a CTC core version of 2.2 or lower and then attempt to log into 
another ONS node in the network running a higher CTC core version, the lower version node 
does not recognize the new node.

ONS 15454 R5.0 No Yes Yes Yes No

ONS 15454 R6.0 No No Yes Yes No

ONS 15454 R7.0 No No No Yes Yes

ONS 15454 R7.2 No No No Yes Yes

ONS 15454 R8.0 No No No No Yes

ONS 15454 R8.5 No No No No Yes

1. JRE 1.4.2 is the recommended version and is provided on the software CD.

2. R4.0 notifies you if an earlier JRE version is running on your PC or UNIX workstation.

Table 1-3 JRE Compatibility (continued)

Software Release
JRE 1.2.2 
Compatible

JRE 1.3 
Compatible

JRE 1.4 
Compatible

JRE 1.4.2 
Compatible1

JRE 5.0 
Compatible
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Launch CTC to Correct the Core Version Build

Step 1 Exit the current CTC session and completely close the browser.

Step 2 Start the browser.

Step 3 Enter the ONS 15454 IP address of the node that reported the alarm. This can be the original IP address 
you logged on with or an IP address other than the original.

Step 4 Log into CTC. The browser downloads the JAR file from CTC.

1.10.11  Username or Password Do Not Match

Symptom   A username/password mismatch often occurs concurrently with a NOT-AUTHENTICATED 
alarm.

Possible Cause   The username or password entered does not match the information stored in the 
TCC2/TCC2P.

Recommended Action   All ONS nodes must have the same username and password created to display 
every ONS node in the network. You can also be locked out of certain ONS nodes on a network if 
your username and password were not created on those specific ONS nodes. For initial login to the 
ONS 15454, enter the CISCO15 user name in capital letters and click Login and use the password 
“otbu+1,” which is case-sensitive. Complete the “Verify Correct Username and Password” 
procedure on page 1-129. If the node has been configured for Radius authentication, the username 
and password are verified against the Radius server database rather than the security information in 
the local node database. For more information about Radius security, refer to the “Security” chapter 
in the Cisco ONS 15454 Reference Manual.

Verify Correct Username and Password

Step 1 Ensure that your keyboard Caps Lock key is not turned on and affecting the case-sensitive entry of the 
username and password. 

Step 2 Contact your system administrator to verify the username and password.

Step 3 Call Cisco Technical Support at 1 800 553-2447 to have them enter your system and create a new user 
name and password. 
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1.10.12  No IP Connectivity Exists Between Nodes

Symptom   No IP connectivity exists between nodes. The nodes have a gray icon. This problem is usually 
accompanied by alarms.

Possible Cause   A lost Ethernet connection.

Recommended Action   Usually is accompanied by Ethernet-specific alarms. Verify the Ethernet 
connections as described in the “1.10.16  Ethernet Connections” section on page 1-131.

1.10.13  DCC Connection Lost

Symptom   DCC connection is lost. The node usually has alarms and the nodes in the network view have 
a gray icon. This symptom is usually accompanied by an EOC alarm.

Possible Cause   A lost DCC connection.

Recommended Action   Usually accompanied by an EOC alarm. Clear the EOC alarm and verify the 
DCC connection as described in the “EOC” alarm.

1.10.14  “Path in Use” Error When Creating a Circuit

Symptom   While creating a circuit, you get a “Path in Use” error that prevents you from completing the 
circuit creation.

Possible Cause   Another user has already selected the same source port to create another circuit.

Recommended Action   CTC does not remove a card or port from the available list until a circuit is 
completely provisioned. If two users simultaneously select the same source port to create a circuit, 
the first user to complete circuit provisioning gets use of the port. The other user gets the “Path in 
Use” error. Cancel the circuit creation and start over, or click Back until you return to the initial 
circuit creation window. The source port that was previously selected no longer appears in the 
available list because it is now part of a provisioned circuit. Select a different available port and 
begin the circuit creation process again.
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1.10.15  Calculate and Design IP Subnets

Symptom   You cannot calculate or design IP subnets on the ONS 15454.

Possible Cause   The IP capabilities of the ONS 15454 require specific calculations to properly design 
IP subnets.

Recommended Action   Cisco provides a free online tool to calculate and design IP subnets.  
Go to http://www.cisco.com/pcgi-bin/Support/IpSubnet/home.pl.  
For information about ONS 15454 IP capability, refer to the “Management Network Connectivity” 
chapter in the Cisco ONS 15454 Reference Manual.

1.10.16  Ethernet Connections

Symptom   Ethernet connections appear to be broken or are not working properly.

Possible Cause   Improperly seated connections.

Possible Cause   Incorrect connections.

Recommended Action   You can fix most connectivity problems in an Ethernet network by following a 
few guidelines. See Figure 1-49 when using the steps in the “Verify Ethernet Connections” 
procedure on page 1-131.

Figure 1-49 Ethernet Connectivity Reference

Verify Ethernet Connections

Step 1 Verify that the alarm filter is turned OFF.

Step 2 Check for SONET and DWDM alarms on the STS that carries the VLAN Ethernet circuit. Clear any 
alarms by looking them up in Chapter 2, “Alarm Troubleshooting.”

ONS 15454 3ONS 15454 2

ONS 15454 1

192.168.1.50
255.255.255.0
VLAN test
Slot 15

192.168.1.25
255.255.255.0
VLAN test
Slot 4 32

16
1
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Step 3 Check for Ethernet-specific alarms. Clear any raised alarms by looking up that alarm in Chapter 2, 
“Alarm Troubleshooting.”

Step 4 Verify that the ACT LED on the Ethernet card is green. 

Step 5 Verify that Ports 1 and 3 on ONS 15454 #1 and Ports 1 and 2 on ONS 15454 #2 have green link-integrity 
LEDs illuminated.

Step 6 If no green link-integrity LED is illuminated for any of these ports:

a. Verify physical connectivity between the ONS 15454s and the attached device.

b. Verify that the ports are enabled on the Ethernet cards.

c. Verify that you are using the proper Ethernet cable and that it is wired correctly, or replace the cable 
with a known-good Ethernet cable.

d. Check the status LED on the Ethernet card faceplate to ensure the card booted up properly. This LED 
should be steady green. If necessary, remove and reinsert the card and allow it to reboot.

e. It is possible that the Ethernet port is functioning properly but the link LED itself is broken. 
Complete the “Verify General Card LED Operation” procedure on page 1-108.

Step 7 Verify connectivity between device A and device C by pinging between these locally attached devices. 
Complete the “1.9.8  Verify PC Connection to the ONS 15454 (ping)” procedure on page 1-119. If the 
ping is unsuccessful: 

a. Verify that device A and device C are on the same IP subnet.

b. Open the Ethernet card in CTC card view and click the Provisioning > VLAN tabs to verify that 
both Port 1 and Port 3 on the card are assigned to the same VLAN.

c. If a port is not assigned to the correct VLAN, click that port column in the VLAN row and set the 
port to Tagged or Untag. Click Apply.

Step 8 Repeat Step 7 for devices B and D.

Step 9 Verify that the Ethernet circuit that carries VLAN #1 is provisioned and that ONS 15454 #1 and 
ONS 15454 #2 ports also use VLAN #1.

1.10.17  VLAN Cannot Connect to Network Device from Untag Port

Symptom   Networks that have a VLAN with one ONS 15454 Ethernet card port set to Tagged and one 
ONS 15454 Ethernet card set to Untag might have difficulty implementing Address Resolution Protocol 
(ARP) for a network device attached to the Untag port (Figure 1-50). They might also see a higher than 
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normal runt packets count at the network device attached to the Untag port. This symptom/limitation also 
exists when ports within the same card or ports within the same chassis are put on the same VLAN, with 
a mix of tagged and untagged.

Possible Cause   The Tagged ONS 15454 adds the IEEE 802.1Q tag and the Untag ONS 15454 
removes the Q-tag without replacing the bytes. The NIC of the network device categorizes the packet 
as a runt and drops the packet.

Possible Cause   Dropped packets can also occur when ARP attempts to match the IP address of the 
network device attached to the Untag port with the physical MAC address required by the network 
access layer.

Recommended Action   The solution is to set both ports in the VLAN to Tagged to stop the stripping 
of the 4 bytes from the data packet and prevent the NIC card in the network access device from 
recognizing the packet as a runt and dropping it. Network devices with IEEE 802.1Q-compliant NIC 
cards accept the tagged packets. Network devices with non IEEE 802.1Q compliant NIC cards still 
drop these tagged packets. The solution might require upgrading network devices with 
non-IEEE 802.1Q compliant NIC cards to IEEE 802.1Q compliant NIC cards. You can also set both 
ports in the VLAN to Untag, but you will lose IEEE 802.1Q compliance.

Figure 1-50 VLAN with Ethernet Ports at Tagged and Untag

Change VLAN Port Tagged and Untag Settings

Step 1 Open the CTC card view for the Ethernet card involved in the problem VLAN.

Step 2 Click the Provisioning > Ether VLAN tabs (Figure 1-51).

55
24

3

Workstation #1 ONS Node
with Ethernet card

VLAN port set to Tagged

ONS Node
with Ethernet card
VLAN port set to Untag

SONET/SDH
Ethernet

Workstation #2
1-133
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 1      General Troubleshooting
1.11    Circuits and Timing
Figure 1-51 Configuring VLAN Membership for Individual Ethernet Ports

Step 3 If the port is set to Tagged, continue to look at other cards and their ports in the VLAN until you find 
the port that is set to Untag.

Step 4 At the VLAN port set to Untag, click the port and choose Tagged. 

Note The attached external devices must recognize IEEE 802.1Q VLANs.

Step 5 After each port is in the appropriate VLAN, click Apply.

1.11  Circuits and Timing
This section provides solutions to circuit creation and reporting errors, as well as common timing 
reference errors and alarms.
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1.11.1  OC-N Circuit Transitions to Partial State

Symptom   An automatic or manual transition of a circuit from one state to another state results in the 
OOS-PARTIAL status, which indicates that not all OC-N connections in the circuit are in the IS-NR 
service state. 

Possible Cause   During a manual transition, CTC cannot communicate with one of the nodes or one 
of the nodes is on a version of software that does not support the new state model.

Recommended Action   Repeat the manual transition operation. If the partial state persists, determine 
which node in the circuit is not changing to the desired state. Complete the “View the State of OC-N 
Circuit Nodes” procedure on page 1-135. Log into the circuit node that did not change to the desired 
state and determine the version of software. If the software on the node is Software R3.3 or earlier, 
upgrade the software. Refer to the release-specific software upgrade document for procedures. 

Note If the node software cannot be upgraded to R4.0, the partial state condition can be avoided 
by using only the circuit state supported in the earlier software version.

Possible Cause   During an automatic transition, some path-level defects and/or alarms were detected 
on the circuit.

Possible Cause   One end of the circuit is not properly terminated.

Recommended Action   Determine which node in the circuit is not changing to the desired state. 
Complete the “View the State of OC-N Circuit Nodes” procedure on page 1-135. Log onto the 
circuit node that did not change to the desired state and examine the circuit for path-level defects, 
improper circuit termination, or alarms. See Chapter 2, “Alarm Troubleshooting,” for procedures to 
clear alarms. Refer to the “Manage Circuits” chapter in the Cisco ONS 15454 Procedure Guide for 
instructions to change circuit configuration settings. Resolve and clear the defects and/or alarms on 
the circuit node and verify that the circuit transitions to the desired state.

View the State of OC-N Circuit Nodes

Step 1 Click the Circuits tab.

Step 2 From the Circuits tab list, select the circuit with the *_PARTIAL status condition.

Step 3 Click Edit. The Edit Circuit window appears.

Step 4 In the Edit Circuit window, click the State tab (if you are viewing a SONET circuit).

The State tab window lists the Node, End A, End B, CRS Admin State, and CRS Service State for each 
of the nodes in the circuit.
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1.11.2  AIS-V on DS3XM-6 or DS3XM-12 Unused VT Circuits

Symptom   An incomplete circuit path causes an AIS.

Possible Cause   The port on the reporting node is in-service but a node upstream on the circuit does 
not have an OC-N port in service.

Recommended Action   An AIS-V indicates that an upstream failure occurred at the virtual tributary 
(VT) layer. AIS-V alarms also occur on DS3XM-6 and DS3XM-12 VT circuits that are not carrying 
traffic and on stranded bandwidth. Complete the “Clear AIS-V on DS3XM-6 or DS3XM-12 Unused 
VT Circuits” procedure on page 1-136.

Clear AIS-V on DS3XM-6 or DS3XM-12 Unused VT Circuits

Step 1 Determine the affected port. 

Step 2 Record the node ID, slot number, port number, or VT number. 

Step 3 Create a unidirectional VT circuit from the affected port back to itself, such as 
Source node/Slot 2/Port 2/VT 13 cross connected to Source node/Slot 2/Port 2/VT 13.

Step 4 Uncheck the Bidirectional check box in the circuit creation window.

Step 5 Give the unidirectional VT circuit an easily recognizable name, such as delete me.

Step 6 Open the DS3XM-6 card in CTC card view. Click the Maintenance > DS1 tabs.

Step 7 Locate the VT that is reporting the alarm (for example, DS3 #2, DS1 #13).

Step 8 From the Loopback Type list, choose Facility and click Apply.

Step 9 Click Circuits.

Step 10 Find the one-way circuit you created in Step 3. Select the circuit and click Delete. Do not check any 
check boxes.

Step 11 Click Yes in the Delete Confirmation dialog box.

Step 12 Open the DS3XM-6 or DS3XM-12 card in CTC card view. Click Maintenance > DS1 tabs.

Step 13 Locate the VT in Facility Loopback.

Step 14 From the Loopback Type list, choose None and then click Apply.

Step 15 Click the Alarms tab and verify that the AIS-V alarms have cleared.

Step 16 Repeat this procedure for all the AIS-V alarms on the DS3XM-6 or DS3XM-12 cards. 
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1.11.3  Circuit Creation Error with VT1.5 Circuit

Symptom   You receive an “Error while finishing circuit creation. Unable to provision circuit. Unable to 
create connection object at node_name” message when trying to create a VT1.5 circuit in CTC.

Possible Cause   You might have run out of bandwidth on the VT cross-connect matrix at the 
ONS 15454 indicated in the error message.

Recommended Action   The matrix has a maximum capacity of 336 bidirectional VT1.5 
cross-connects. Certain configurations exhaust VT capacity with less than 336 bidirectional VT1.5s 
in a BLSR or less than 224 bidirectional VT1.5s in a path protection or 1+1 protection group. Refer 
to the “Circuits and Tunnels” chapter in the Cisco ONS 15454 Reference Manual for more 
information.

1.11.4  Unable to Create Circuit From DS-3 Card to DS3XM-6 or DS3XM-12 Card

Symptom   You cannot create a circuit from a DS-3 card to a DS3XM-6 or DS3XM-12 card.

Possible Cause   A DS-3 card and a DS3XM-6 or DS3XM-12 card have different functions.

Recommended Action   A DS3XM-6 card converts each of its six DS-3 interfaces into 28 DS-1s for 
cross-connection through the network. The DS3XM-12 converts each of its 12 interfaces into up to 
48 DS-1s. Thus, you can create a circuit from a DS3XM-6 or DS3XM-12 card to a DS-1 card, but 
not from a DS3XM card to a DS-3 card. These differences are evident in the STS path overhead. The 
DS-3 card uses asynchronous mapping for DS-3, which is indicated by the C2 byte in the STS path 
overhead that has a hex code of 04. A DS3XM-6 or DS3XM-12 has a VT payload with a C2 hex 
value of 02.

Note You can find instructions for creating circuits in the “Create Circuits and VT Tunnels” chapter 
of the Cisco ONS 15454 Procedure Guide.

1.11.5  DS-3 Card Does Not Report AIS-P From External Equipment

Symptom   A DS3-12, DS3N-12, DS3-12E, or DS3N-12E card does not report STS AIS-P from the 
external equipment/line side.

Possible Cause   The card is functioning as designed.

Recommended Action   This card terminates the port signal at the backplane so STS AIS-P is not 
reported from the external equipment/line side. DS3-12, DS3N-12, DS3-12E, and DS3N-12E cards 
have DS3 header monitoring functionality, which allows you to view PM on the DS3 path. 
Nevertheless, you cannot view AIS-P on the STS path. For more information about the PM 
capabilities of the DS3-12, DS3N-12, DS3-12E or DS3N-12E cards, refer to the “Performance 
Monitoring” chapter in the Cisco ONS 15454 Reference Manual.
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1.11.6  OC-3 and DCC Limitations

Symptom   Limitations to OC-3 and DCC usage.

Possible Cause   OC-3 and DCC have limitations for the ONS 15454.

Recommended Action   For an explanation of OC-3 and DCC limitations, refer to the “Circuits and 
Tunnels” chapter in the Cisco ONS 15454 Reference Manual.

1.11.7  ONS 15454 Switches Timing Reference

Symptom   Timing references switch when one or more problems occur.

Possible Cause   The optical or BITS input is receiving loss of signal (LOS), loss of frame (LOF), or 
AIS alarms from its timing source.

Possible Cause   The optical or building integrated timing supply (BITS) input is not functioning. 

Possible Cause   The synchronization status messaging (SSM) message is set to Do Not Use for 
Synchronization (DUS).

Possible Cause   SSM indicates a Stratum 3 or lower clock quality. 

Possible Cause   The input frequency is off by more than 15 ppm.

Possible Cause   The input clock wanders and has more than three slips in 30 seconds.

Possible Cause   A bad timing reference existed for at least two minutes.

Recommended Action   The ONS 15454 internal clock operates at a Stratum 3E level of accuracy. This 
gives the ONS 15454 a free-running synchronization accuracy of +/– 4.6 ppm and a holdover 
stability of less than 255 slips in the first 24 hours or 3.7 x 10–7/day, including temperature. 
ONS 15454 free-running synchronization relies on the Stratum 3 internal clock. Over an extended 
time period, using a higher quality Stratum 1 or Stratum 2 timing source results in fewer timing slips 
than a lower quality Stratum 3 timing source.

1.11.8  Holdover Synchronization Alarm

Symptom   The clock is running at a different frequency than normal and the “HLDOVRSYNC” alarm 
appears.

Possible Cause   The last reference input has failed.

Recommended Action   The clock is running at the frequency of the last known-good reference input. 
This alarm is raised when the last reference input fails. See the “HLDOVRSYNC” alarm on 
page 2-127 for a detailed description.
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Note The ONS 15454 supports holdover timing per Telcordia GR-436 when provisioned for external 
(BITS) timing.

1.11.9  Free-Running Synchronization Mode

Symptom   The clock is running at a different frequency than normal and the “FRNGSYNC” alarm 
appears.

Possible Cause   No reliable reference input is available.

Recommended Action   The clock is using the internal oscillator as its only frequency reference. This 
occurs when no reliable, prior timing reference is available. See the “FRNGSYNC” condition on 
page 2-115 for a detailed description. 

1.11.10  Daisy-Chained BITS Not Functioning

Symptom   You are unable to daisy chain the BITS sources.

Possible Cause   Daisy-chained BITS sources are not supported on the ONS 15454.

Recommended Action   Daisy-chained BITS sources cause additional wander buildup in the network 
and are therefore not supported. Instead, use a timing signal generator to create multiple copies of 
the BITS clock and separately link them to each ONS 15454.

1.11.11  Blinking STAT LED after Installing a Card

Symptom   After installing a card, the STAT LED blinks continuously for more than 60 seconds.

Possible Cause   The card cannot boot because it failed the Power On Shelf Test (POST) diagnostics.

Recommended Action   The blinking STAT LED indicates that POST diagnostics are being performed. 
If the LED continues to blink more than 60 seconds, the card has failed the POST diagnostics test 
and has failed to boot. If the card has truly failed, an “EQPT” alarm is raised against the slot number 
with an “Equipment Failure” description. Check the alarm tab for this alarm to appear for the slot 
where the card was installed. To attempt recovery, remove and reinstall the card and observe the card 
boot process. If the card fails to boot, replace the card. Complete the “Physically Replace a Traffic 
Card” procedure on page 2-274.

1.12  Fiber and Cabling
This section explains problems typically caused by cabling connectivity errors. It also includes 
instructions for crimping Category-5 cable and lists the optical fiber connectivity levels. 
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1.12.1  Bit Errors Appear for a Traffic Card

Symptom   A traffic card has multiple bit errors.

Possible Cause   Faulty cabling or low optical-line levels.

Recommended Action   Bit errors on line (traffic) cards usually originate from cabling problems or low 
optical-line levels. The errors can be caused by synchronization problems, especially if pointer 
justification (PJ) errors are reported. Moving cards into different error-free slots will isolate the 
cause. Use a test set whenever possible because the cause of the errors could be external cabling, 
fiber, or external equipment connecting to the ONS 15454. Troubleshoot low optical levels using the 
“1.12.2  Faulty Fiber-Optic Connections” section on page 1-140.

1.12.2  Faulty Fiber-Optic Connections

Symptom   A line card has multiple SONET/DWDM alarms and/or signal errors.

Possible Cause   Faulty fiber-optic connections.

Recommended Action   Faulty fiber-optic connections can be the source of SONET/DWDM alarms and 
signal errors. Complete the “Verify Fiber-Optic Connections” procedure on page 1-140.

Possible Cause   Faulty Category-5 cables.

Recommended Action   Faulty Category-5 cables can be the source of SONET/DWDM alarms and 
signal errors. Complete the “1.12.2.1  Crimp Replacement LAN Cables” section on page 1-142.

Possible Cause   Faulty GBICs.

Recommended Action   Faulty GBICs can be the source of SONET/DWDM alarms and signal errors. 
See the “1.12.2.2  Replace Faulty GBIC, SFP, or XFP Connectors” section on page 1-144.

Warning Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into 
beams or view directly with optical instruments. Statement 272

Warning Laser radiation presents an invisible hazard, so personnel should avoid exposure to the laser beam. 
Personnel must be qualified in laser safety procedures and must use proper eye protection before 
working on this equipment. Statement 300

Verify Fiber-Optic Connections

Step 1 Ensure that a single-mode fiber connects to the ONS 15454 OC-N card. 

Note SM or SM Fiber should be printed on the fiber span cable. ONS 15454 OC-N cards do not use 
multimode fiber. 
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Step 2 Ensure that the connector keys on the SC fiber connector are properly aligned and locked.

Step 3 Check that the single-mode fiber power level is within the specified range:

a. Remove the Rx end of the suspect fiber.

b. Connect the Rx end of the suspect fiber to a fiber-optic power meter, such as a GN Nettest LP-5000.

c. Determine the power level of fiber with the fiber-optic power meter.

d. Verify that the power meter is set to the appropriate wavelength for the OC-N card being tested 
(either 1310 nm or 1550 nm depending on the specific card).

e. Verify that the power level falls within the range specified for the card if it is an OC-N card; see the 
“1.12.3  OC-N Card Transmit and Receive Levels” section on page 1-146.

Step 4 If the power level falls below the specified range for the OC-N card:

a. Clean or replace the fiber patch cords. Clean the fiber according to site practice or, if none exists, 
follow the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide. 
If possible, do this for the OC-N card you are working on and the far-end card.

b. Clean the optical connectors on the card. Clean the connectors according to site practice or, if none 
exists, follow the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure 
Guide. If possible, do this for the OC-N card you are working on and the far-end card.

c. Ensure that the far-end transmitting card is not an ONS intermediate-range (IR) card when an ONS 
long-range (LR) card is appropriate.

IR cards transmit a lower output power than LR cards. 

d. Replace the far-end transmitting OC-N card to eliminate the possibility of a degrading transmitter 
on this OC-N card.

Caution Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this, 
perform an external switch if a switch has not already occurred. See the procedures in the 
“2.9.2  Protection Switching, Lock Initiation, and Clearing” section on page 2-263. For more 
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide. 

e. If the power level still falls below the specified range with the replacement fibers and replacement 
card, check for one of these three factors that attenuate the power level and affect link loss (LL):

 • Excessive fiber distance; single-mode fiber attenuates at approximately 0.5 dB/km.

 • Excessive number or fiber connectors; connectors take approximately 0.5 dB each.

 • Excessive number of fiber splices; splices take approximately 0.5 dB each.

Note These are typical attenuation values. Refer to the specific product documentation for the 
actual values or use an optical time domain reflectometer (OTDR) to establish precise link 
loss and budget requirements. 

Step 5 If no power level shows on the fiber, the fiber is bad or the transmitter on the OC-N card failed.

a. Check that the Tx and Rx fibers are not reversed. LOS and EOC alarms normally accompany 
reversed Tx and Rx fibers. Switching reversed Tx and Rx fibers clears the alarms and restores the 
signal. 

b. Clean or replace the fiber patch cords. Clean the fiber according to site practice or, if none exists, 
follow the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide. 
If possible, do this for the OC-N card you are working on and the far-end card. 
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c. Retest the fiber power level.

d. If the replacement fiber still shows no power, replace the OC-N card.

Caution Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this, 
perform an external switch if a switch has not already occurred. See the procedures in the 
“2.9.2  Protection Switching, Lock Initiation, and Clearing” section on page 2-263. For more 
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide. 

Step 6 If the power level on the fiber is above the range specified for the card, ensure that an ONS LR card is 
not being used when an ONS IR card is appropriate. 

LR cards transmit a higher output power than IR cards. When used with short runs of fiber, an LR 
transmitter is too powerful for the receiver on the receiving OC-N card.

Receiver overloads occur when maximum receiver power is exceeded.

Tip To prevent overloading the receiver, use an attenuator on the fiber between the ONS OC-N card 
transmitter and the receiver. Place the attenuator on the receive transmitter of the ONS OC-N cards. 
Refer to the attenuator documentation for specific instructions.

Tip Most fiber has text printed on only one of the two fiber strands. Use this to identify which fiber is 
connected to Tx and which fiber is connected to Rx.

1.12.2.1  Crimp Replacement LAN Cables

You can crimp your own LAN cables for use with the ONS 15454. Use a cross-over cable when 
connecting an ONS 15454 to a hub, LAN modem, or switch, and use a LAN cable when connecting an 
ONS 15454 to a router or workstation. Use Category-5 cable RJ-45 T-568B, Color Code (100 Mbps), 
and a crimping tool. Figure 1-52 shows the wiring of an RJ-45 connector. Figure 1-53 shows a LAN 
cable layout, and Table 1-4 shows the cable pinouts. Figure 1-54 shows a cross-over cable layout, and 
Table 1-5 shows the cross-over pinouts.

Figure 1-52 RJ-45 Pin Numbers

55
04

8

8 7 6 5 4 3 2 1 1 2 3 4 5 6 7 8

End view of RJ-45 plug Looking into an RJ-45 jack
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Figure 1-53 LAN Cable Layout

Figure 1-54 Cross-Over Cable Layout

Table 1-4 LAN Cable Pinout 

Pin Color Pair Name Pin

1 white/orange 2 Transmit Data + 1

2 orange 2 Transmit Data – 2

3 white/green 3 Receive Data + 3

4 blue 1 — 4

5 white/blue 1 — 5

6 green 3 Receive Data – 6

7 white/brown 4 — 7

8 brown 4 — 8

1
2
3
4

5
6

7
8

1
2
3
4

5
6

7
8

55
41

5

Table 1-5 Cross-Over Cable Pinout 

Pin Color Pair Name Pin

1 white/orange 2 Transmit Data + 3

2 orange 2 Transmit Data – 6

3 white/green 3 Receive Data + 1

4 blue 1 — 4

5 white/blue 1 — 5

6 green 3 Receive Data – 2

1

2

3

4

5

6

7

8

1

2

3

4

5

6

7

8

55
41

6
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Note Odd-numbered pins always connect to a white wire with a colored stripe. 

1.12.2.2  Replace Faulty GBIC, SFP, or XFP Connectors

GBICs and Small Form-factor Pluggables (SFP or XFP) are hot-swappable and can be installed or 
removed while the card or shelf assembly is powered and running. 

Warning Class 1 laser product. Statement 1008

Warning Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into 
beams or view directly with optical instruments. Statement 272

GBICs and SFPs/XFPs are input/output devices that plug into a Gigabit Ethernet card to link the port 
with the fiber-optic network. The type of GBIC or SFP determines the maximum distance that the 
Ethernet traffic can travel from the card to the next network device. For a description of GBICs and SFPs 
and their capabilities, refer to the Cisco ONS 15454 Reference Manual.

Note GBICs and SFPs must be matched on either end by type: SX to SX, LX to LX, or ZX to ZX.

Note All versions of G1K-4 cards support coarse wavelength division multiplexing (CWDM) GBICs.

GBICs are available in two different models. One GBIC model has two clips (one on each side of the 
GBIC) that secure the GBIC in the slot on the E1000-2-G, G-Series, or G1K-4 card. The other model 
has a locking handle. Both models are shown in Figure 1-55.

Figure 1-55 GBICs

7 white/brown 4 — 7

8 brown 4 — 8

Table 1-5 Cross-Over Cable Pinout (continued)

Pin Color Pair Name Pin

Receiver
Clip

Handle
Transmitter Receiver

Transmitter 51
17

8
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Note GBICs are very similar in appearance. Check the GBIC label carefully before installing it. 

Remove GBIC, SFP, or XFP Connectors

Warning Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into 
beams or view directly with optical instruments. Statement 272

Step 1 Disconnect the network fiber cable from the GBIC SC connector or XFP/SFP LC duplex connector.

Step 2 Release the GBIC or SFP/XFP from the slot by simultaneously squeezing the two plastic tabs on each 
side.

Step 3 Slide the GBIC or SFP/XFP out of the Gigabit Ethernet module slot. A flap closes over the GBIC or SFP 
slot to protect the connector on the Gigabit Ethernet card.

Install a GBIC or SFP/XFP Device

Warning Class 1 laser product. Statement 1008

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056

Note G-Series cards manufactured before August 2003 do not support DWDM GBICs. G1K-4 cards 
compatible with DWDM GBICs have a Common Language Equipment Identification (CLEI) code of 
WM5IRWPCAA. 

Note All versions of G1K-4 cards support coarse wavelength division multiplexing (CWDM) GBICs.

Note GBICs, SFPs, and XFPs are hot-swappable and can therefore be installed/removed while the card/shelf 
assembly is powered and running.

Step 1 Remove the GBIC, SFP, or XFP from its protective packaging.

Step 2 Check the label to verify that the GBIC, SFP, or XFP is the correct type for your network. For a list of 
GBICs and SFPs that are compatible with Ethernet cards, refer to the “Ethernet Cards” chapter in the 
Cisco ONS 15454 Reference Manual. For a list of GBICs that are compatible with the FC_MR-4 card, 
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refer to the “Storage Access Networking Cards” chapter in the Cisco ONS 15454 Reference Manual. For 
a list of SFPs and XFPs that are compatible with each optical card, refer to the “Optical Cards” chapter 
in the Cisco ONS 15454 Reference Manual. 

Note Before you install SFPs on the MRC-12 card, refer to the MRC-12 card information in the 
Cisco ONS 15454 Reference Manual for bandwidth restrictions based on the port where you 
install the SFP and the cross-connect card being used.

Step 3 Verify the type of GBIC, SFP, or XFP you are using:

 • If you are using a GBIC with clips, go to Step 4.

 • If you are using a GBIC with a handle, go to Step 5.

 • If you are using an SFP or XFP, go to Step 6.

Step 4 For GBICs with clips:

a. Grip the sides of the GBIC with your thumb and forefinger and insert the GBIC into the slot on the 
card.

Note GBICs are keyed to prevent incorrect installation.

b. Slide the GBIC through the flap that covers the opening until you hear a click. The click indicates 
the GBIC is locked into the slot.

c. When you are ready to attach the network fiber-optic cable, remove the protective plug from the 
GBIC, save the plug for future use, then plug the fiber connector into the GBIC.

Step 5 For GBICs with a handle:

a. Remove the protective plug from the SC-type connector.

b. Grip the sides of the GBIC with your thumb and forefinger and insert the GBIC into the slot on the 
card.

c. Lock the GBIC into place by closing the handle down. The handle is in the correct closed position 
when it does not obstruct access to an SC-type connector.

d. Slide the GBIC through the cover flap until you hear a click. 

The click indicates that the GBIC is locked into the slot.

e. When you are ready to attach the network fiber-optic cable, remove the protective plug from the 
GBIC, save the plug for future use, then plug the fiber connector into the GBIC.

Step 6 For SFPs and XFPs:

a. Plug the LC duplex connector of the fiber into a Cisco-supported SFP or XFP.

b. If the new SFP or XFP has a latch, close the latch over the cable to secure it.

c. Plug the cabled SFP or XFP into the card port until it clicks.

1.12.3  OC-N Card Transmit and Receive Levels
Each OC-N card has a transmit and receive connector on its faceplate. Table 1-6 lists these levels.
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Table 1-6 Optical Card Transmit and Receive Levels 

Card

Transmit Receive

Minimum Maximum Minimum Maximum

OC3 IR 4/STM1 SH 1310 –15 dBm –8 dBm –28 dBm –8 dBm

OC3IR/STM1SH 1310-8 –15 dBm –8 dBm –28 dBm –8 dBm

OC12 IR/STM4 SH 1310 –15 dBm –8 dBm –28 dBm –8 dBm

OC12 LR/STM4 LH 1310 –3 dBm +2 dBm –28 dBm –8 dBm

OC12 LR/STM4 LH 1550 –3 dBm +2 dBm –28 dBm –8 dBm

OC12 IR/STM4 SH 1310-4 –15 dBm –8 dBm –30 dBm –8 dBm

OC48 IR 1310 –5 dBm 0 dBm –18 dBm 0 dBm

OC48 LR 1550 –2 dBm +3 dBm –28 dBm –8 dBm

OC48 IR/STM16 SH AS 1310 –5 dBm 0 dBm –18 dBm 0 dBm

OC48 LR/STM16 LH AS 1550 –2 dBm +3 dBm –28 dBm –8 dBm

OC48 ELR/STM16 EH 100 GHz –2 dBm 0 dBm –27 dBm at 
1E-12 BER

–9 dBm

OC48 ELR/STM16 EH 200 GHz –2 dBm 0 dBm –28 dBm –8 dBm

OC192 SR/STM64 IO 1310 –6 dBm –1 dBm –11 dBm –1 dBm

OC192 IR/STM64 SH 1550 –1 dBm +2 dBm –14 dBm –1 dBm

OC192 LR/STM64 LH 1550 +7 dBm +10 dBm –19 dBm –10 dBm

OC192 LR/STM64 LH ITU 15xx.xx +3 dBm +6 dBm –22 dBm –9 dBm

15454_MRC-12 (ONS-SI-2G-S1) –10 dBm –3 dBm –18 dBm –3 dBm

15454_MRC-12 (ONS-SI-2G-I1) –5 dBm 0 dBm –18 dBm 0 dBm

15454_MRC-12 (ONS-SI-2G-L1) –2 dBm 3 dBm –27 dBm –9 dBm

15454_MRC-12 (ONS-SI-2G-L2) –2 dBm 3 dBm –28 dBm –9 dBm

15454_MRC-12 (ONS-SC-2G-30.3 
through ONS-SC-2G-60.6)

0 dBm 4 dBm –28 dBm –9 dBm

15454_MRC-12 (ONS-SI-622-I1) –15 dBm –8 dBm –28 dBm –8 dBm

15454_MRC-12 (ONS-SI-622-L1) –3 dBm 2 dBm –28 dBm –8 dBm

15454_MRC-12 (ONS-SI-622-L2) –3 dBm 2 dBm –28 dBm –8 dBm

15454_MRC-12 
(ONS-SE-622-1470 through 
ONS-SE-622-1610)

0 dBm 5 dBm –28 dBm –3 dBm

15454_MRC-12 (ONS-SI-155-I1) –15 dBm –8 dBm –30 dBm –8 dBm

15454_MRC-12 (ONS-SI-155-L1) –5 dBm 0 dBm –34 dBm –10 dBm

15454_MRC-12 (ONS-SI-155-L2) –5 dBm 0 dBm –34 dBm –10 dBm

15454_MRC-12 
(ONS_SE-155-1470 through 
ONS-SE-155-1610)

0 dBm 5 dBm –34 dBm –3 dBm

15454_MRC_12 
ONS-SI-155-I1-MM=

–9 dBm –14 dBm –14 dBm –5 dBm
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1.13  Power Supply Problems

Symptom   Loss of power or low voltage, resulting in a loss of traffic and causing the LCD clock to reset 
to the default date and time.

Possible Cause   Loss of power or low voltage.

Possible Cause   Improperly connected power supply.

Recommended Action   The ONS 15454 requires a constant source of DC power to properly function. 
Input power is –48 VDC. Power requirements range from –42 VDC to –57 VDC. A newly installed 
ONS 15454 that is not properly connected to its power supply does not operate. Power problems can 
be confined to a specific ONS 15454 or affect several pieces of equipment on the site. A loss of 
power or low voltage can result in a loss of traffic and causes the LCD clock on the ONS 15454 to 
default to January 1, 1970, 00:04:15. To reset the clock, in node view click the 
Provisioning > General > General tabs and change the Date and Time fields. Complete the “Isolate 
the Cause of Power Supply Problems” procedure on page 1-149.

Warning Only trained and qualified personnel should be allowed to install, replace, or service this equipment. 
Statement 1030

15454_MRC_12 
ONS-SI-622-I1-MM=

–9 dBm –14 dBm –14 dBm –5 dBm

15454_MRC_12 
ONS-SC-Z3-1470 through 
ONS-SC-Z3-1610

0 dBm 5 dBm –9 dBm —

15454_MRC_12 
ONS-SE-Z1=

–5 dBm 0 dBm –10 dBm 
0 dBm 
–18 dBm 
0 dBm 
0 dBm

–23 dBm (OC-3) 
–23 dBm 
(OC-12) 
0 dBm (OC-48) 
–21 dBm (FC) 
–22 dBm (GE)

OC192SR1/STM64IO Short Reach 
(ONS-XC-10G-S1)

–6 dBm –1 dBm –11 dBm –1 dBm

OC192/STM64 Any Reach 
(ONS-XC-10G-S1)

–6 dBm –1 dBm –11 dBm –1 dBm

OC192/STM64 Any Reach 
(ONS-XC-10G-I2)

–1 dBm 2 dBm –14 dBm 2 dBm

OC192/STM64 Any Reach 
(ONS-XC-10G-L2)

0 dBm 4 dBm –24 dBm –7dBm

Table 1-6 Optical Card Transmit and Receive Levels (continued)

Card

Transmit Receive

Minimum Maximum Minimum Maximum
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Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94 

Caution Operations that interrupt power supply or short the power connections to the ONS 15454 are 
service-affecting.

Isolate the Cause of Power Supply Problems

Step 1 If a single ONS 15454 show signs of fluctuating power or power loss:

a. Verify that the –48 VDC #8 power terminals are properly connected to a fuse panel. These power 
terminals are located on the lower section of the backplane EIA under the clear plastic cover.

b. Verify that the power cable is #12 or #14 AWG and in good condition.

c. Verify that the power cable connections are properly crimped. Stranded #12 or #14 AWG does not 
always crimp properly with Staycon type connectors.

d. Verify that 20-A fuses are used in the fuse panel.

e. Verify that the fuses are not blown.

f. Verify that a rack-ground cable attaches to the frame-ground terminal (FGND) on the right side of 
the ONS 15454 EIA. Connect this cable to the ground terminal according to local site practice. 

g. Verify that the DC power source has enough capacity to carry the power load.

h. If the DC power source is battery-based:

 • Check that the output power is high enough. Power requirements range from –42 VDC to 
–57 VDC.

 • Check the age of the batteries. Battery performance decreases with age.

 • Check for opens and shorts in batteries, which might affect power output.

 • If brownouts occur, the power load and fuses might be too high for the battery plant.

Step 2 If multiple pieces of site equipment show signs of fluctuating power or power loss:

a. Check the uninterruptible power supply (UPS) or rectifiers that supply the equipment. Refer to the 
UPS manufacturer’s documentation for specific instructions.

b. Check for excessive power drains caused by other equipment, such as generators.

c. Check for excessive power demand on backup power systems or batteries when alternate power 
sources are used.
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1.13.1  Power Consumption for Node and Cards

Symptom   You are unable to power up a node or the cards in a node.

Possible Cause   Improper power supply.

Recommended Action   Refer to power information in the “Hardware Specifications” appendix in the 
Cisco ONS 15454 Reference Manual.
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C H A P T E R 2

Alarm Troubleshooting

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter gives a description, severity, and troubleshooting procedure for each commonly 
encountered Cisco ONS 15454 alarm and condition. Tables 2-1 through 2-5 provide lists of ONS 15454 
alarms organized by severity. Table 2-6 on page 2-11 provides a list of alarms organized alphabetically. 
Table 2-7 gives definitions of all ONS 15454 alarm logical objects, which are the basis of the alarm 
profile list in Table 2-8 on page 2-23. For a comprehensive list of all conditions and instructions for 
using TL1 commands, refer to the Cisco ONS SONET TL1 Command Guide . 

An alarm’s troubleshooting procedure applies to both the Cisco Transport Controller (CTC) and TL1 
version of that alarm. If the troubleshooting procedure does not clear the alarm, log into the Technical 
Support Website at http://www.cisco.com/techsupport for more information or call the Cisco Technical 
Assistance Center 1 800 553-2447.

For more information about alarm profiles, refer to the “Manage Alarms” chapter in the 
Cisco ONS 15454 Procedure Guide.

2.1  Alarm Indexes by Default Severity
The following tables group alarms and conditions by their default severities in the ONS 15454 system. 
These severities are the same whether they are reported in the CTC Alarms window severity (SEV) 
column or in TL1. 

Note The CTC default alarm profile contains some alarms or conditions that are not currently implemented 
but are reserved for future use.

Note The CTC default alarm profile in some cases contains two severities for one alarm (for example, 
MJ/MN). The ONS 15454 platform default severity comes first (in this example, MJ), but the alarm can 
be demoted to the second severity in the presence of a higher-ranking alarm. This is in accordance with 
Telcordia GR-474.
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2.1.1  Critical Alarms (CR) 
Table 2-1 alphabetically lists ONS 15454 Critical (CR) alarms.

Table 2-1 ONS 15454 Critical Alarm List 

—  LOA (VCG)  MFGMEM (PPM)

—  LOF (DS3)  OPWR-HFAIL (AOTS)

 AUTOLSROFF (OCN)  LOF (EC1)  OPWR-HFAIL (OCH)

 AWG-FAIL (OTS)  LOF (OCN)  OPWR-HFAIL (OMS)

 AWG-OVERTEMP (OTS)  LOF (STSTRM)  OPWR-HFAIL (OTS)

 BKUPMEMP (EQPT)  LOF (TRUNK)  OPWR-LFAIL (AOTS)

 COMIOXC (EQPT)  LOM (STSMON)  OPWR-LFAIL (OCH-TERM)

 CONTBUS-DISABLED (EQPT)  LOM (STSTRM)  OPWR-LFAIL (OCH)

 CTNEQPT-PBPROT (EQPT)  LOM (TRUNK)  OPWR-LFAIL (OMS)

 CTNEQPT-PBWORK (EQPT)  LOP-P (STSMON)  OPWR-LFAIL (OTS)

 ENCAP-MISMATCH-P (STSTRM)  LOP-P (STSTRM)  OTUK-LOF (TRUNK)

 EQPT (AICI-AEP)  LOS (2R)  OTUK-TIM (TRUNK)

 EQPT (AICI-AIE)  LOS (DS3)  PLM-P (STSMON)

 EQPT (EQPT)  LOS (EC1)  PLM-P (STSTRM)

 EQPT (PPM)  LOS (ESCON)  PORT-FAIL (OCH)

 EQPT-DIAG (EQPT)  LOS (ISC)  SQM (STSTRM)

 EQPT-MISS (FAN)  LOS (OCN)  SWMTXMOD-PROT (EQPT)

 FAN (FAN)  LOS (OTS)  SWMTXMOD-WORK (EQPT)

 GAIN-HFAIL (AOTS)  LOS (TRUNK)  TIM (OCN)

 GAIN-LFAIL (AOTS)  LOS-P (OCH)  TIM (TRUNK)

 GE-OOSYNC (FC)  LOS-P (OMS)  TIM-P (STSTRM)

 GE-OOSYNC (GE)  LOS-P (OTS)  TIM-S (EC1)

 GE-OOSYNC (ISC)  LOS-P (TRUNK)  TIM-S (OCN)

 GE-OOSYNC (TRUNK)  MEA (AIP)  UNEQ-P (STSMON)

 HITEMP (NE)  MEA (BIC)  UNEQ-P (STSTRM)

 I-HITEMP (NE)  MEA (EQPT)  VOA-HFAIL (AOTS)

 ILK-FAIL (TRUNK)  MEA (FAN)  VOA-HFAIL (OCH)

 IMPROPRMVL (EQPT)  MEA (PPM)  VOA-HFAIL (OMS)

 IMPROPRMVL (PPM)  MFGMEM (AICI-AEP)  VOA-HFAIL (OTS)

 LINK-KEEPALIVE (ML1000)  MFGMEM (AICI-AIE)  VOA-LFAIL (AOTS)

 LINK-KEEPALIVE (ML100T)  MFGMEM (AIP)  VOA-LFAIL (OCH)

 LINK-KEEPALIVE (MLFX)  MFGMEM (BPLANE)  VOA-LFAIL (OMS)

 LINK-KEEPALIVE (MLMR)  MFGMEM (FAN)  VOA-LFAIL (OTS)
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2.1.2  Major Alarms (MJ)
Table 2-2 alphabetically lists ONS 15454 Major (MJ) alarms.

Table 2-2 ONS 15454 Major Alarm List 

 APSCNMIS (OCN)  GFP-DE-MISMATCH (GFP-FAC)  RCVR-MISS (DS1)

 AUTONEG-RFI (ML1000)  GFP-EX-MISMATCH (CE1000)  RCVR-MISS (E1)

 BAT-FAIL (PWR)  GFP-EX-MISMATCH (FCMR)  RSV-RT-EXCD-RINGLET0 (RPRIF)

 BLSROSYNC (OCN)  GFP-EX-MISMATCH (GFP-FAC)  RSV-RT-EXCD-RINGLET1 (RPRIF)

 BLSR-SW-VER-MISM (OCN)  GFP-LFD (CE1000)  RING-ID-MIS (OCN)

 CARLOSS (CE1000)  GFP-LFD (CE100T)  RING-ID-MIS (OSC-RING)

 CARLOSS (CE100T)  GFP-LFD (CEMR)  RING-MISMATCH (OCN)

 CARLOSS (CEMR)  GFP-LFD (FCMR)  RPR-PEER-MISS (RPRIF)

 CARLOSS (E1000F)  GFP-LFD (GFP-FAC)  RPR-PROT-CONFIG-MISM (RPRIF)

 CARLOSS (E100T)  GFP-LFD (ML1000)  RPR-RI-FAIL (RPRIF)

 CARLOSS (EQPT)  GFP-LFD (ML100T)  RPR-SPAN-MISMATCH (ML1000)

 CARLOSS (FC)  GFP-LFD (MLFX)  RPR-SPAN-MISMATCH (ML100T)

 CARLOSS (G1000)  GFP-LFD (MLMR)  RPR-SPAN-MISMATCH (MLFX)

 CARLOSS (GE)  GFP-NO-BUFFERS (FCMR)  RPR-SPAN-MISMATCH (MLMR)

 CARLOSS (ISC)  GFP-NO-BUFFERS (GFP-FAC)  SHELF-COMM-FAIL (SHELF)

 CARLOSS (ML1000)  GFP-UP-MISMATCH (CE1000)  SIGLOSS (ESCON)

 CARLOSS (ML100T)  GFP-UP-MISMATCH (CE100T)  SIGLOSS (FC)

 CARLOSS (MLFX)  GFP-UP-MISMATCH (CEMR)  SIGLOSS (FCMR)

 CARLOSS (MLMR)  GFP-UP-MISMATCH (FCMR)  SIGLOSS (GE)

 CARLOSS (TRUNK)  GFP-UP-MISMATCH (GFP-FAC)  SIGLOSS (ISC)

 DATA-CRC (CE100T)  GFP-UP-MISMATCH (ML1000)  SIGLOSS (TRUNK)

 DATA-CRC (ML1000)  GFP-UP-MISMATCH (ML100T)  SQM (VT-TERM)

 DATA-CRC (ML100T)  GFP-UP-MISMATCH (MLFX)  SYNCLOSS (FC)

 DATA-CRC (MLFX)  GFP-UP-MISMATCH (MLMR)  SYNCLOSS (FCMR)

 DBOSYNC (NE)  HIBATVG (PWR)  SYNCLOSS (GE)

 DSP-COMM-FAIL (TRUNK)  INVMACADR (AIP)  SYNCLOSS (ISC)

 DSP-FAIL (TRUNK)  LASERBIAS-FAIL (AOTS)  SYNCLOSS (TRUNK)

 DUP-SHELF-ID (SHELF)  LOF (DS1)  SYNCPRI (NE-SREF)

 EHIBATVG (PWR)  LOF (E1)  SYSBOOT (NE)

 ELWBATVG (PWR)  LOM (VT-TERM)  TIM-V (VT-MON)

 E-W-MISMATCH (OCN)  LOP-V (VT-MON)  TIM-V (VT-TERM)

 EXTRA-TRAF-PREEMPT (OCN)  LOP-V (VT-TERM)  TPTFAIL (CE1000)

 FC-DE-NES (FC)  LOS (DS1)  TPTFAIL (CE100T)

 FC-DE-NES (FCMR)  LOS (E1)  TPTFAIL (CEMR)
2-3
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.1.3    Minor Alarms (MN)
2.1.3  Minor Alarms (MN) 
Table 2-3 alphabetically lists ONS 15454 Minor (MN) alarms.

 FC-DE-NES (TRUNK)  LWBATVG (PWR)  TPTFAIL (FCMR)

 FC-NO-CREDITS (FC)  MAX-STATIONS (RPRIF)  TPTFAIL (G1000)

 FC-NO-CREDITS (FCMR)  MEA (SHELF)  TPTFAIL (ML1000)

 FC-NO-CREDITS (TRUNK)  MEM-GONE (EQPT)  TPTFAIL (ML100T)

 FEC-MISM (TRUNK)  ODUK-TIM-PM (TRUNK)  TPTFAIL (MLFX)

 GFP-CSF (CE1000)  OUT-OF-SYNC (FC)  TPTFAIL (MLMR)

 GFP-CSF (CE100T)  OUT-OF-SYNC (GE)  TRMT (DS1)

 GFP-CSF (CEMR)  OUT-OF-SYNC (TRUNK)  TRMT (E1)

 GFP-CSF (FCMR)  PLM-V (VT-MON)  TRMT-MISS (DS1)

 GFP-CSF (GFP-FAC)  PLM-V (VT-TERM)  TRMT-MISS (E1)

 GFP-CSF (ML1000)  PORT-MISMATCH (CEMR)  UNEQ-V (VT-MON)

 GFP-CSF (ML100T)  PORT-MISMATCH (MLMR)  UNEQ-V (VT-TERM)

 GFP-CSF (MLFX)  PRC-DUPID (OCN)  UT-COMM-FAIL (TRUNK)

 GFP-CSF (MLMR) PROV-MISMATCH (TRUNK)  UT-FAIL (TRUNK)

 GFP-DE-MISMATCH (FCMR) PTIM (TRUNK)  WVL-MISMATCH (TRUNK)

Table 2-2 ONS 15454 Major Alarm List (continued)

Table 2-3 ONS 15454 Minor Alarm List 

—  HI-LASERBIAS (TRUNK)  LO-TXPOWER (EQPT)

—  HI-LASERTEMP (EQPT)  LO-TXPOWER (ESCON)

 APC-CORR-SKIPPED (AOTS)  HI-LASERTEMP (OCN)  LO-TXPOWER (FC)

 APC-CORR-SKIPPED (OCH)  HI-LASERTEMP (PPM)  LO-TXPOWER (GE)

 APC-CORR-SKIPPED (OMS)  HI-RXPOWER (2R)  LO-TXPOWER (ISC)

 APC-CORR-SKIPPED (OTS)  HI-RXPOWER (ESCON)  LO-TXPOWER (OCN)

 —  HI-RXPOWER (FC)  LO-TXPOWER (PPM)

 APC-OUT-OF-RANGE (AOTS)  HI-RXPOWER (GE)  LO-TXPOWER (TRUNK)

 APC-OUT-OF-RANGE (OCH)  HI-RXPOWER (ISC)  MEM-LOW (EQPT)

 APC-OUT-OF-RANGE (OMS)  HI-RXPOWER (OCN)  OPWR-HDEG (AOTS)

 APC-OUT-OF-RANGE (OTS)  HI-RXPOWER (TRUNK)  OPWR-HDEG (OCH-TERM)

 APSB (OCN)  HITEMP (EQPT)  OPWR-HDEG (OCH)

 APSCDFLTK (OCN)  HI-TXPOWER (2R)  OPWR-HDEG (OMS)

 APSC-IMP (OCN)  HI-TXPOWER (EQPT)  OPWR-HDEG (OTS)

 APSCINCON (OCN)  HI-TXPOWER (ESCON)  OPWR-LDEG (AOTS)

 APSCM (OCN)  HI-TXPOWER (FC)  OPWR-LDEG (OCH-TERM)
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 APSIMP (OCN)  HI-TXPOWER (GE)  OPWR-LDEG (OCH)

 APS-INV-PRIM (OCN)  HI-TXPOWER (ISC)  OPWR-LDEG (OMS)

 APSMM (OCN)  HI-TXPOWER (OCN)  OPWR-LDEG (OTS)

 AUTORESET (EQPT)  HI-TXPOWER (PPM)  OTUK-IAE (TRUNK)

 AWG-DEG (OTS)  HI-TXPOWER (TRUNK)  PEER-NORESPONSE (MLMR)

 BPV (BITS)  ISIS-ADJ-FAIL (OCN)  PROTNA (EQPT)

 CASETEMP-DEG (AOTS)  ISIS-ADJ-FAIL (TRUNK)  PROV-MISMATCH (PPM)

 COMM-FAIL (EQPT)  KBYTE-APS-CHAN-FAIL (OCN)  PWR-FAIL-A (EQPT)

 CONTBUS-A-18 (EQPT)  LASERBIAS-DEG (AOTS)  PWR-FAIL-B (EQPT)

 CONTBUS-B-18 (EQPT)  LASERBIAS-DEG (OTS)  PWR-FAIL-RET-A (EQPT)

 CONTBUS-IO-A (EQPT)  LASEREOL (OCN)  PWR-FAIL-RET-B (EQPT)

 CONTBUS-IO-B (EQPT)  LASERTEMP-DEG (AOTS) ROUTE-OVERFLOW (NSA)

 DATAFLT (NE)  LMP-FAIL (CTRL)  SFTWDOWN (EQPT)

 DCU-LOSS-FAIL (OTS)  LMP-FAIL (GE)  SH-IL-VAR-DEG-HIGH (OTS)

 DUP-IPADDR (NE)  LMP-FAIL (OCN)  SH-IL-VAR-DEG-LOW (OTS)

 DUP-NODENAME (NE)  LMP-FAIL (TLINK)  SNTP-HOST (NE)

 EOC (OCN)  LMP-SD (GE)  SPANLEN-OUT-OF-RANGE (OTS)

 EOC (TRUNK)  LMP-SD (OCN)  SSM-FAIL (BITS)

 EOC-L (OCN)  LMP-SF (GE)  SSM-FAIL (DS1)

 EOC-L (TRUNK)  LMP-SF (OCN)  SSM-FAIL (E1)

 ERROR-CONFIG (EQPT)  LOF (BITS)  SSM-FAIL (OCN)

 EXCCOL (EQPT)  LO-LASERBIAS (EQPT)  SSM-FAIL (TRUNK)

 EXT (ENVALRM)  LO-LASERBIAS (OCN)  SYNCPRI (EXT-SREF)

 FAPS-CONFIG-MISMATCH (EQPT)  LO-LASERBIAS (PPM)  SYNCSEC (EXT-SREF)

 FEPRLF (OCN)  LO-LASERTEMP (EQPT)  SYNCSEC (NE-SREF)

 FIBERTEMP-DEG (AOTS)  LO-LASERTEMP (OCN)  SYNCTHIRD (EXT-SREF)

 FP-LINK-LOSS (EQPT)  LO-LASERTEMP (PPM)  SYNCTHIRD (NE-SREF)

 GAIN-HDEG (AOTS)  LO-RXPOWER (2R)  TIM-MON (OCN)

 GAIN-LDEG (AOTS)  LO-RXPOWER (ESCON)  TIM-MON (TRUNK)

 GCC-EOC (TRUNK)  LO-RXPOWER (FC)  TIM-P (STSMON)

HELLO (OCN)  LO-RXPOWER (GE)  VOA-HDEG (AOTS)

HELLO (TRUNK)  LO-RXPOWER (ISC)  VOA-HDEG (OCH)

 HI-LASERBIAS (2R)  LO-RXPOWER (OCN)  VOA-HDEG (OMS)

 HI-LASERBIAS (EQPT)  LO-RXPOWER (TRUNK)  VOA-HDEG (OTS)

 HI-LASERBIAS (ESCON)  LOS (BITS)  VOA-LDEG (AOTS)

 HI-LASERBIAS (FC)  LOS (FUDC)  VOA-LDEG (OCH)

 HI-LASERBIAS (GE)  LOS (MSUDC)  VOA-LDEG (OMS)

Table 2-3 ONS 15454 Minor Alarm List (continued)
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2.1.4  NA Conditions
Table 2-4 alphabetically lists ONS 15454 Not Alarmed (NA) conditions.

 HI-LASERBIAS (ISC)  LOS-O (OCH)  VOA-LDEG (OTS)

 HI-LASERBIAS (OCN) LOS-O (OMS) —

 APS-PRIM-SEC-MISM (OCN) LOS-O (OTS) —

HI-LASERBIAS (PPM)  LO-TXPOWER (2R)  —

Table 2-3 ONS 15454 Minor Alarm List (continued)

Table 2-4 ONS 15454 NA Conditions List 

 ALS (2R) FRCDSWTOSEC (NE-SREF)  SD (TRUNK)

 ALS (AOTS) FRCDSWTOTHIRD (EXT-SREF)  SD-L (EC1)

 ALS (ESCON) FRNGSYNC (NE-SREF)  SD-L (TRUNK)

 ALS (FC) FSTSYNC (NE-SREF)  SD-P (STSMON)

 ALS (GE)  FTA-MISMATCH (EQPT)  SD-P (STSTRM)

 ALS (ISC)  FULLPASSTHR-BI (OCN)  SD-V (VT-MON)

 ALS (OCN)  HI-CCVOLT (BITS)  SD-V (VT-TERM)

 ALS (TRUNK)  HLDOVRSYNC (NE-SREF)  SF (DS1)

 ALS-DISABLED (EQPT)  IDLE (DS1)  SF (DS3)

 AMPLI-INIT (AOTS)  INC-ISD (DS3)  SF (TRUNK)

APC-DISABLED (AOTS)  INHSWPR (EQPT)  SF-L (EC1)

APC-DISABLED (EQPT)  INHSWWKG (EQPT)  SF-L (OCN)

APC-DISABLED (NE)  INTRUSION-PSWD (NE)  SF-L (TRUNK)

APC-DISABLED (OCH)  IOSCFGCOPY (EQPT)  SF-P (STSMON)

APC-DISABLED (OMS)  KB-PASSTHR (OCN)  SF-P (STSTRM)

APC-DISABLED (OTS)  LAN-POL-REV (NE)  SF-V (VT-MON)

APC-DISABLED (SHELF)  LASER-APR (AOTS)  SF-V (VT-TERM)

 APC-END (NE)  LCAS-CRC (STSTRM)  SHUTTER-OPEN (OTS)

 APC-WRONG-GAIN (AOTS)  LCAS-CRC (VT-TERM)  SPAN-NOT-MEASURED (OTS)

 APS-PRIM-FAC (OCN)  LCAS-RX-DNU (STSTRM)  SPAN-SW-EAST (OCN)

 AS-CMD (2R)  LCAS-RX-DNU (VT-TERM)  SPAN-SW-WEST (OCN)

 AS-CMD (AOTS)  LCAS-RX-FAIL (STSTRM)  SQUELCH (OCN)

 AS-CMD (BPLANE)  LCAS-RX-FAIL (VT-TERM)  SQUELCHED (2R)

 AS-CMD (CE1000)  LCAS-RX-GRP-ERR (STSTRM)  SQUELCHED (ESCON)

 AS-CMD (CE100T)  LCAS-RX-GRP-ERR (VT-TERM)  SQUELCHED (FC)

 AS-CMD (CEMR)  LCAS-TX-ADD (STSTRM)  SQUELCHED (GE)

 AS-CMD (DS1)  LCAS-TX-ADD (VT-TERM)  SQUELCHED (ISC)
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 AS-CMD (DS3)  LCAS-TX-DNU (STSTRM)  SQUELCHED (OCN)

 AS-CMD (E1000F)  LCAS-TX-DNU (VT-TERM)  SQUELCHED (TRUNK)

 AS-CMD (E100T)  LKOUTPR-S (OCN)  SSM-DUS (BITS)

 AS-CMD (E1)  LMP-UNALLOC (GE)  SSM-DUS (DS1)

 AS-CMD (EC1)  LMP-UNALLOC (OCN)  SSM-DUS (E1)

 AS-CMD (EQPT)  LOCKOUT-REQ (2R)  SSM-DUS (OCN)

 AS-CMD (ESCON)  LOCKOUT-REQ (EQPT)  SSM-DUS (TRUNK)

 AS-CMD (FC)  LOCKOUT-REQ (ESCON)  SSM-LNC (BITS)

 AS-CMD (FCMR)  LOCKOUT-REQ (FC)  SSM-LNC (NE-SREF)

 AS-CMD (G1000)  LOCKOUT-REQ (GE)  SSM-LNC (OCN)

 AS-CMD (GE)  LOCKOUT-REQ (ISC)  SSM-LNC (TRUNK)

 AS-CMD (GFP-FAC)  LOCKOUT-REQ (OCN)  SSM-OFF (BITS)

 AS-CMD (ISC)  LOCKOUT-REQ (STSMON)  SSM-OFF (DS1)

 AS-CMD (ML1000)  LOCKOUT-REQ (TRUNK)  SSM-OFF (E1)

 AS-CMD (ML100T)  LOCKOUT-REQ (VT-MON)  SSM-OFF (OCN)

 AS-CMD (MLFX)  LPBKCRS (STSMON)  SSM-OFF (TRUNK)

 AS-CMD (MLMR)  LPBKCRS (STSTRM)  SSM-PRC (BITS)

 AS-CMD (NE)  LPBKDS1FE-CMD (DS1)  SSM-PRC (NE-SREF)

 AS-CMD (OCH)  LPBKDS3FEAC (DS3)  SSM-PRC (OCN)

 AS-CMD (OCN)  LPBKDS3FEAC-CMD (DS3)  SSM-PRC (TRUNK)

 AS-CMD (OMS)  LPBKFACILITY (CE1000)  SSM-PRS (BITS)

 AS-CMD (OTS)  LPBKFACILITY (CE100T)  SSM-PRS (DS1)

 AS-CMD (PPM)  LPBKFACILITY (CEMR)  SSM-PRS (E1)

 AS-CMD (PWR)  LPBKFACILITY (DS1)  SSM-PRS (NE-SREF)

 AS-CMD (SHELF)  LPBKFACILITY (DS3)  SSM-PRS (OCN)

 AS-CMD (TRUNK)  LPBKFACILITY (E1)  SSM-PRS (TRUNK)

 AS-MT (2R)  LPBKFACILITY (EC1)  SSM-RES (BITS)

 AS-MT (AOTS)  LPBKFACILITY (ESCON)  SSM-RES (DS1)

 AS-MT (CE1000)  LPBKFACILITY (FC)  SSM-RES (E1)

 AS-MT (CE100T)  LPBKFACILITY (FCMR)  SSM-RES (NE-SREF)

 AS-MT (CEMR)  LPBKFACILITY (G1000)  SSM-RES (OCN)

 AS-MT (DS1)  LPBKFACILITY (GE)  SSM-RES (TRUNK)

 AS-MT (DS3)  LPBKFACILITY (ISC)  SSM-SDH-TN (BITS)

 AS-MT (E1)  LPBKFACILITY (MLMR)  SSM-SDH-TN (NE-SREF)

 AS-MT (EC1)  LPBKFACILITY (OCN)  SSM-SDH-TN (OCN)

 AS-MT (EQPT)  LPBKFACILITY (TRUNK)  SSM-SDH-TN (TRUNK)

 AS-MT (ESCON)  LPBKTERMINAL (CE1000)  SSM-SETS (BITS)

Table 2-4 ONS 15454 NA Conditions List (continued)
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 AS-MT (FC)  LPBKTERMINAL (CE100T)  SSM-SETS (NE-SREF)

 AS-MT (FCMR)  LPBKTERMINAL (CEMR)  SSM-SETS (OCN)

 AS-MT (G1000)  LPBKTERMINAL (DS1)  SSM-SETS (TRUNK)

 AS-MT (GE)  LPBKTERMINAL (DS3)  SSM-SMC (BITS)

 AS-MT (GFP-FAC)  LPBKTERMINAL (E1)  SSM-SMC (DS1)

 AS-MT (ISC)  LPBKTERMINAL (EC1)  SSM-SMC (E1)

 AS-MT (ML1000)  LPBKTERMINAL (ESCON)  SSM-SMC (NE-SREF)

 AS-MT (ML100T)  LPBKTERMINAL (FC)  SSM-SMC (OCN)

 AS-MT (MLFX)  LPBKTERMINAL (FCMR)  SSM-SMC (TRUNK)

 AS-MT (MLMR) FRCDSWTOTHIRD (NE-SREF)  SSM-ST2 (BITS)

 AS-MT (OCH)  LPBKTERMINAL (G1000)  SSM-ST2 (DS1)

 AS-MT (OCN)  LPBKTERMINAL (GE)  SSM-ST2 (E1)

 AS-MT (OMS)  LPBKTERMINAL (ISC)  SSM-ST2 (NE-SREF)

 AS-MT (OTS)  LPBKTERMINAL (MLMR)  SSM-ST2 (OCN)

 AS-MT (PPM)  LPBKTERMINAL (OCN)  SSM-ST2 (TRUNK)

 AS-MT (SHELF)  LPBKTERMINAL (TRUNK)  SSM-ST3 (BITS)

 AS-MT (TRUNK)  MAN-REQ (EQPT)  SSM-ST3 (DS1)

 AS-MT-OOG (STSTRM)  MAN-REQ (ML1000)  SSM-ST3 (E1)

 AS-MT-OOG (VT-TERM)  MAN-REQ (ML100T)  SSM-ST3 (NE-SREF)

 AUD-LOG-LOSS (NE)  MAN-REQ (MLFX)  SSM-ST3 (OCN)

 AUD-LOG-LOW (NE)  MAN-REQ (MLMR)  SSM-ST3 (TRUNK)

 AUTOSW-LOP (STSMON)  MAN-REQ (STSMON)  SSM-ST3E (BITS)

 AUTOSW-LOP (VT-MON)  MAN-REQ (VT-MON)  SSM-ST3E (DS1)

 AUTOSW-PDI (STSMON)  MANRESET (EQPT)  SSM-ST3E (E1)

 AUTOSW-PDI (VT-MON)  MANSWTOINT (NE-SREF)  SSM-ST3E (NE-SREF)

 AUTOSW-SDBER (STSMON)  MANSWTOPRI (EXT-SREF)  SSM-ST3E (OCN)

 AUTOSW-SDBER (VT-MON)  MANSWTOPRI (NE-SREF)  SSM-ST3E (TRUNK)

 AUTOSW-SFBER (STSMON)  MANSWTOSEC (EXT-SREF)  SSM-ST4 (BITS)

 AUTOSW-SFBER (VT-MON)  MANSWTOSEC (NE-SREF)  SSM-ST4 (DS1)

 AUTOSW-UNEQ (STSMON)  MANSWTOTHIRD (EXT-SREF)  SSM-ST4 (E1)

 AUTOSW-UNEQ (VT-MON)  MANSWTOTHIRD (NE-SREF)  SSM-ST4 (NE-SREF)

 AWG-WARM-UP (OTS)  MANUAL-REQ-RING (OCN)  SSM-ST4 (OCN)

 CLDRESTART (EQPT)  MANUAL-REQ-SPAN (2R)  SSM-ST4 (TRUNK)

 CPP-INCAPABLE (MLMR)  MANUAL-REQ-SPAN (EC1)  SSM-STU (BITS)

 CTNEQPT-MISMATCH (EQPT)  MANUAL-REQ-SPAN (ESCON)  SSM-STU (DS1)

 DS3-MISM (DS3)  MANUAL-REQ-SPAN (FC)  SSM-STU (E1)

 ETH-LINKLOSS (NE)  MANUAL-REQ-SPAN (GE)  SSM-STU (NE-SREF)

Table 2-4 ONS 15454 NA Conditions List (continued)
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 EXERCISE-RING-FAIL (OCN)  MANUAL-REQ-SPAN (ISC)  SSM-STU (OCN)

 EXERCISE-SPAN-FAIL (OCN)  MANUAL-REQ-SPAN (OCN)  SSM-STU (TRUNK)

 FAILTOSW (2R)  MANUAL-REQ-SPAN (TRUNK)  SSM-TNC (BITS)

 FAILTOSW (EQPT)  MS-DEG (E1)  SSM-TNC (NE-SREF)

 FAILTOSW (ESCON)  MS-EXC (E1)  SSM-TNC (OCN)

 FAILTOSW (FC)  MT-OCHNC (OTS)  SSM-TNC (TRUNK)

 FAILTOSW (GE)  NO-CONFIG (EQPT)  STS-SQUELCH-L (OCN)

 FAILTOSW (ISC)  OCHNC-INC (OCHNC-CONN)  SW-MISMATCH (EQPT)

 FAILTOSW (OCN)  OCHTERM-INC (OCH-TERM)  SWTOPRI (EXT-SREF)

 FAILTOSW (TRUNK)  ODUK-SD-PM (TRUNK)  SWTOPRI (NE-SREF)

 FAILTOSW-PATH (STSMON)  ODUK-SF-PM (TRUNK)  SWTOSEC (EXT-SREF)

 FAILTOSW-PATH (VT-MON)  OOU-TPT (STSTRM)  SWTOSEC (NE-SREF)

 FAILTOSWR (OCN)  OOU-TPT (VT-TERM)  SWTOTHIRD (EXT-SREF)

 FAILTOSWS (OCN)  OPEN-SLOT (EQPT)  SWTOTHIRD (NE-SREF)

 FAPS (FCMR)  OSRION (AOTS)  SYNC-FREQ (BITS)

 FAPS (TRUNK)  OSRION (OTS)  SYNC-FREQ (DS1)

 FDI (OCH-TERM)  OTUK-SD (TRUNK)  SYNC-FREQ (E1)

 FDI (OCH)  OTUK-SF (TRUNK)  SYNC-FREQ (OCN)

 FE-AIS (DS3)  OUT-OF-SYNC (ISC)  SYNC-FREQ (TRUNK)

 FE-DS1-MULTLOS (DS3)  PARAM-MISM (AOTS)  TEMP-MISM (NE)

 FE-DS1-NSA (DS3)  PARAM-MISM (OCH-TERM)  TRAIL-SIGNAL-FAIL (OCH)

 FE-DS1-SA (DS3)  PARAM-MISM (OCH)  TRAIL-SIGNAL-FAIL (TRUNK)

 FE-DS1-SNGLLOS (DS3)  PARAM-MISM (OMS)  TX-IDLE (DS1)

 FE-DS3-NSA (DS3)  PARAM-MISM (OTS)  TX-RAI (DS1)

 FE-DS3-SA (DS3)  PDI-P (STSMON)  TX-RAI (DS3)

 FE-EQPT-NSA (DS3)  PDI-P (STSTRM)  TX-RAI (E1)

 FE-FRCDWKSWBK-SPAN (OCN)  PMI (OMS)  UNC-WORD (TRUNK)

 FE-FRCDWKSWPR-RING (EC1)  PMI (OTS)  VCG-DEG (VCG)

 FE-FRCDWKSWPR-RING (OCN)  PORT-MISMATCH (FCMR)  VCG-DOWN (VCG)

 FE-FRCDWKSWPR-SPAN (OCN)  RAI (DS1)  VOLT-MISM (PWR)

 FE-IDLE (DS3)  RAI (DS3)  VT-SQUELCH-L (OCN)

 FE-LOCKOUTOFPR-SPAN (OCN)  RAI (E1)  WKSWPR (2R)

 FE-LOF (DS3)  RING-SW-EAST (OCN)  WKSWPR (EQPT)

 FE-LOS (DS3)  RING-SW-WEST (OCN)  WKSWPR (ESCON)

 FE-MANWKSWBK-SPAN (OCN)  ROLL (STSMON)  WKSWPR (FC)

 FE-MANWKSWPR-RING (EC1)  ROLL (STSTRM)  WKSWPR (GE)

 FE-MANWKSWPR-RING (OCN)  ROLL (VT-MON)  WKSWPR (ISC)

Table 2-4 ONS 15454 NA Conditions List (continued)
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2.1.5  NR Conditions
Table 2-5 alphabetically lists ONS 15454 Not Reported (NR) conditions.

 FE-MANWKSWPR-SPAN (OCN)  ROLL (VT-TERM)  WKSWPR (OCN)

 FORCED-REQ (EQPT)  ROLL-PEND (STSMON)  WKSWPR (STSMON)

 FORCED-REQ (ML1000)  ROLL-PEND (VT-MON)  WKSWPR (VT-MON)

 FORCED-REQ (ML100T)  ROLL-PEND (VT-TERM)  WORK-QUEUE-FULL (EQPT)

 FORCED-REQ (MLFX)  RPR-PASSTHR (RPRIF)  WTR (2R)

 FORCED-REQ (MLMR)  RPR-PROT-ACTIVE (RPRIF)  WTR (EC1)

 FORCED-REQ (STSMON)  RPR-SD (ML1000)  WTR (EQPT)

 FORCED-REQ (VT-MON)  RPR-SD (ML100T)  WTR (ESCON)

 FORCED-REQ-RING (OCN)  RPR-SD (MLFX)  WTR (FC)

 FORCED-REQ-SPAN (2R)  SD-L (OCN)  WTR (GE)

 FORCED-REQ-SPAN (EC1)  RPR-SD (MLMR)  WTR (ISC)

 FORCED-REQ-SPAN (ESCON)  RPR-SF (ML1000)  WTR (ML1000)

 FORCED-REQ-SPAN (FC)  RPR-SF (ML100T)  WTR (ML100T)

 FORCED-REQ-SPAN (GE)  RPR-SF (MLFX)  WTR (MLFX)

 FORCED-REQ-SPAN (ISC)  RPR-SF (MLMR)  WTR (MLMR)

 FORCED-REQ-SPAN (OCN)  RPRW (ML1000)  WTR (OCN)

 FORCED-REQ-SPAN (TRUNK)  RPRW (ML100T)  WTR (STSMON)

 FRCDSWTOINT (NE-SREF)  RPRW (MLFX)  WTR (TRUNK)

 FRCDSWTOPRI (EXT-SREF)  RUNCFG-SAVENEED (EQPT)  WTR (VT-MON)

 FRCDSWTOPRI (NE-SREF)  SD (DS1)  —

 FRCDSWTOSEC (EXT-SREF)  SD (DS3)  —

Table 2-4 ONS 15454 NA Conditions List (continued)

Table 2-5 ONS 15454 NR Conditions List 

 AIS (BITS) BERT-SYNC-FAIL (DS1, DS3) OTUK-BDI (TRUNK)

 AIS (DS1) ERFI-P-CONN (STSMON) RFI (TRUNK)

 AIS (DS3) ERFI-P-CONN (STSTRM) RFI-L (EC1)

 AIS (E1) ERFI-P-PAYLD (STSMON) RFI-L (OCN)

 AIS (FUDC) ERFI-P-PAYLD (STSTRM) RFI-L (TRUNK)

 AIS (MSUDC) ERFI-P-SRVR (STSMON) RFI-P (STSMON)

 AIS (TRUNK) ERFI-P-SRVR (STSTRM) RFI-P (STSTRM)

 AIS-L (EC1) NON-CISCO-PPM (PPM) RFI-V (VT-MON)

 AIS-L (OCN) ODUK-1-AIS-PM (TRUNK) RFI-V (VT-TERM)

 AIS-L (TRUNK) ODUK-2-AIS-PM (TRUNK) ROLL-PEND (STSTRM)
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2.2  Alarms and Conditions Listed By Alphabetical Entry
Table 2-6 alphabetically lists all ONS 15454 alarms and conditions.

no

 AIS-P (STSMON) ODUK-3-AIS-PM (TRUNK) TX-AIS (DS1)

 AIS-P (STSTRM) ODUK-4-AIS-PM (TRUNK) TX-AIS (DS3)

 AIS-V (VT-MON) ODUK-AIS-PM (TRUNK) TX-AIS (E1)

 AIS-V (VT-TERM) ODUK-BDI-PM (TRUNK) TX-LOF (DS1)

 AUTOSW-AIS (STSMON) ODUK-LCK-PM (TRUNK) TX-LOF (E1)

 AUTOSW-AIS (VT-MON) ODUK-OCI-PM (TRUNK) UNQUAL-PPM (PPM)

 BERT-ENBL (DS1, DS3) OTUK-AIS (TRUNK)  —

Table 2-5 ONS 15454 NR Conditions List (continued)

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List 

—  GFP-EX-MISMATCH (GFP-FAC)  PLM-P (STSTRM)

—  GFP-LFD (CE1000) PLM-V (VT-MON)

—  GFP-LFD (CE100T)  PLM-V (VT-TERM)

—  GFP-LFD (CEMR)  PMI (OMS)

 AIS (BITS)  GFP-LFD (FCMR)  PMI (OTS)

 AIS (DS1)  GFP-LFD (ML1000)  PORT-FAIL (OCH)

 AIS (DS3)  GFP-LFD (ML100T)  PORT-MISMATCH (CEMR)

 AIS (E1)  GFP-LFD (MLFX)  PORT-MISMATCH (FCMR)

 AIS (FUDC)  GFP-LFD (MLMR)  PORT-MISMATCH (MLMR)

 AIS (MSUDC)  GFP-NO-BUFFERS (FCMR)  PRC-DUPID (OCN)

 AIS (TRUNK)  GFP-NO-BUFFERS (GFP-FAC)  PROTNA (EQPT)

 AIS-L (EC1)  GFP-UP-MISMATCH (CE1000)  PROV-MISMATCH (PPM)

 AIS-L (OCN)  GFP-UP-MISMATCH (CE100T)  PROV-MISMATCH (TRUNK)

 AIS-L (TRUNK)  GFP-UP-MISMATCH (CEMR)  PTIM (TRUNK)

 AIS-P (STSMON)  GFP-UP-MISMATCH (FCMR)  PWR-FAIL-A (EQPT)

 AIS-P (STSTRM)  GFP-UP-MISMATCH (GFP-FAC)  PWR-FAIL-B (EQPT)

 AIS-V (VT-MON)  GFP-UP-MISMATCH (ML1000)  PWR-FAIL-RET-A (EQPT)

 AIS-V (VT-TERM)  GFP-UP-MISMATCH (ML100T)  PWR-FAIL-RET-B (EQPT)

 ALS (2R)  GFP-UP-MISMATCH (MLFX)  RAI (DS1)

 ALS (AOTS)  GFP-UP-MISMATCH (MLMR)  RAI (DS3)

 ALS (ESCON)  HELLO (OCN)  RAI (E1)

 ALS (FC)  HELLO (TRUNK)  RCVR-MISS (DS1)

 ALS (GE)  HIBATVG (PWR)  RCVR-MISS (E1)

 ALS (ISC)  HI-CCVOLT (BITS)  RSV-RT-EXCD-RINGLET0 (RPRIF)
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 ALS (OCN)  HI-LASERBIAS (2R)  RSV-RT-EXCD-RINGLET1 (RPRIF)

 ALS (TRUNK)  HI-LASERBIAS (EQPT)  RFI (TRUNK)

 ALS-DISABLED (EQPT)  HI-LASERBIAS (ESCON)  RFI-L (EC1)

 AMPLI-INIT (AOTS)  HI-LASERBIAS (FC)  RFI-L (OCN)

 APC-CORR-SKIPPED (AOTS)  HI-LASERBIAS (GE)  RFI-L (TRUNK)

 APC-CORR-SKIPPED (OCH)  HI-LASERBIAS (ISC)  RFI-P (STSMON)

 APC-CORR-SKIPPED (OMS)  HI-LASERBIAS (OCN)  RFI-P (STSTRM)

 APC-CORR-SKIPPED (OTS)  HI-LASERBIAS (PPM)  RFI-V (VT-MON)

APC-DISABLED (AOTS)  HI-LASERBIAS (TRUNK)  RFI-V (VT-TERM)

APC-DISABLED (EQPT)  HI-LASERTEMP (EQPT)  RING-ID-MIS (OCN)

APC-DISABLED (NE)  HI-LASERTEMP (OCN)  RING-ID-MIS (OSC-RING)

APC-DISABLED (OCH)  HI-LASERTEMP (PPM)  RING-MISMATCH (OCN)

APC-DISABLED (OMS)  HI-RXPOWER (2R)  RING-SW-EAST (OCN)

APC-DISABLED (OTS)  HI-RXPOWER (ESCON)  RING-SW-WEST (OCN)

APC-DISABLED (SHELF)  HI-RXPOWER (FC)  ROLL (STSMON)

 APC-END (NE)  HI-RXPOWER (GE)  ROLL (STSTRM)

 APC-OUT-OF-RANGE (AOTS)  HI-RXPOWER (ISC)  ROLL (VT-MON)

 APC-OUT-OF-RANGE (OCH)  HI-RXPOWER (OCN)  ROLL (VT-TERM)

 APC-OUT-OF-RANGE (OMS)  HI-RXPOWER (TRUNK)  ROLL-PEND (STSMON)

 APC-OUT-OF-RANGE (OTS)  HITEMP (EQPT)  ROLL-PEND (STSTRM)

 APC-WRONG-GAIN (AOTS)  HITEMP (NE)  ROLL-PEND (VT-MON)

 APSB (OCN)  HI-TXPOWER (2R)  ROLL-PEND (VT-TERM)

 APSCDFLTK (OCN)  HI-TXPOWER (EQPT)  RPR-PASSTHR (RPRIF)

 APSC-IMP (OCN)  HI-TXPOWER (ESCON)  RPR-PEER-MISS (RPRIF)

 APSCINCON (OCN)  HI-TXPOWER (FC)  RPR-PROT-ACTIVE (RPRIF)

 APSCM (OCN)  HI-TXPOWER (GE)  RPR-PROT-CONFIG-MISM (RPRIF)

 APSCNMIS (OCN)  HI-TXPOWER (ISC)  RPR-RI-FAIL (RPRIF)

 APSIMP (OCN)  HI-TXPOWER (OCN)  RPR-SD (ML1000)

 APS-INV-PRIM (OCN)  HI-TXPOWER (PPM)  RPR-SD (ML100T)

 APSMM (OCN)  HI-TXPOWER (TRUNK)  RPR-SD (MLFX)

 APS-PRIM-FAC (OCN)  HLDOVRSYNC (NE-SREF)  RPR-SD (MLMR)

 APS-PRIM-SEC-MISM (OCN)  IDLE (DS1)  RPR-SF (ML1000)

 AS-CMD (2R)  I-HITEMP (NE)  RPR-SF (ML100T)

 AS-CMD (AOTS)  ILK-FAIL (TRUNK)  RPR-SF (MLFX)

 AS-CMD (BPLANE)  IMPROPRMVL (EQPT)  RPR-SF (MLMR)

 AS-CMD (CE1000)  IMPROPRMVL (PPM)  RPR-SPAN-MISMATCH (ML1000)

 AS-CMD (CE100T)  INC-ISD (DS3)  RPR-SPAN-MISMATCH (ML100T)

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)
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 AS-CMD (CEMR)  INHSWPR (EQPT)  RPR-SPAN-MISMATCH (MLFX)

 AS-CMD (DS1)  INHSWWKG (EQPT)  RPR-SPAN-MISMATCH (MLMR)

 AS-CMD (DS3)  INTRUSION-PSWD (NE)  RPRW (ML1000)

 AS-CMD (E1)  INVMACADR (AIP)  RPRW (ML100T)

 AS-CMD (E1000F)  IOSCFGCOPY (EQPT)  RPRW (MLFX)

 AS-CMD (E100T)  ISIS-ADJ-FAIL (OCN)  RUNCFG-SAVENEED (EQPT)

 AS-CMD (EC1)  ISIS-ADJ-FAIL (TRUNK)  SD (DS1)

 AS-CMD (EQPT)  KB-PASSTHR (OCN)  SD (DS3)

 AS-CMD (ESCON)  KBYTE-APS-CHAN-FAIL (OCN)  SD (TRUNK)

 AS-CMD (FC)  LAN-POL-REV (NE)  SD-L (EC1)

 AS-CMD (FCMR)  LASER-APR (AOTS)  SD-L (OCN)

 AS-CMD (G1000)  LASERBIAS-DEG (AOTS)  SD-L (TRUNK)

 AS-CMD (GE)  LASERBIAS-DEG (OTS)  SD-P (STSMON)

 AS-CMD (GFP-FAC)  LASERBIAS-FAIL (AOTS)  SD-P (STSTRM)

 AS-CMD (ISC)  LASEREOL (OCN)  SD-V (VT-MON)

 AS-CMD (ML1000)  LASERTEMP-DEG (AOTS)  SD-V (VT-TERM)

 AS-CMD (ML100T)  LCAS-CRC (STSTRM)  SF (DS1)

 AS-CMD (MLFX)  LCAS-CRC (VT-TERM)  SF (DS3)

 AS-CMD (MLMR)  LCAS-RX-DNU (STSTRM)  SF (TRUNK)

 AS-CMD (NE)  LCAS-RX-DNU (VT-TERM)  SF-L (EC1)

 AS-CMD (OCH)  LCAS-RX-FAIL (STSTRM)  SF-L (OCN)

 AS-CMD (OCN)  LCAS-RX-FAIL (VT-TERM)  SF-L (TRUNK)

 AS-CMD (OMS)  LCAS-RX-GRP-ERR (STSTRM)  SF-P (STSMON)

 AS-CMD (OTS)  LCAS-RX-GRP-ERR (VT-TERM)  SF-P (STSTRM)

 AS-CMD (PPM)  LCAS-TX-ADD (STSTRM)  SFTWDOWN (EQPT)

 AS-CMD (PWR)  LCAS-TX-ADD (VT-TERM)  SF-V (VT-MON)

 AS-CMD (SHELF)  LCAS-TX-DNU (STSTRM)  SF-V (VT-TERM)

 AS-CMD (TRUNK)  LCAS-TX-DNU (VT-TERM)  SHELF-COMM-FAIL (SHELF)

 AS-MT (2R)  LINK-KEEPALIVE (ML1000)  SH-IL-VAR-DEG-HIGH (OTS)

 AS-MT (AOTS)  LINK-KEEPALIVE (ML100T)  SH-IL-VAR-DEG-LOW (OTS)

 AS-MT (CE1000)  LINK-KEEPALIVE (MLFX)  SHUTTER-OPEN (OTS)

 AS-MT (CE100T)  LINK-KEEPALIVE (MLMR)  SIGLOSS (ESCON)

 AS-MT (CEMR)  LKOUTPR-S (OCN)  SIGLOSS (FC)

 AS-MT (DS1)  LMP-FAIL (CTRL)  SIGLOSS (FCMR)

 AS-MT (DS3)  LMP-FAIL (GE)  SIGLOSS (GE)

 AS-MT (E1)  LMP-FAIL (OCN)  SIGLOSS (ISC)

 AS-MT (EC1)  LMP-FAIL (TLINK)  SIGLOSS (TRUNK)

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)
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 AS-MT (EQPT)  LMP-SD (GE)  SNTP-HOST (NE)

 AS-MT (ESCON)  LMP-SD (OCN)  SPANLEN-OUT-OF-RANGE (OTS)

 AS-MT (FC)  LMP-SF (GE)  SPAN-NOT-MEASURED (OTS)

 AS-MT (FCMR)  LMP-SF (OCN)  SPAN-SW-EAST (OCN)

 AS-MT (G1000)  LMP-UNALLOC (GE)  SPAN-SW-WEST (OCN)

 AS-MT (GE)  LMP-UNALLOC (OCN)  SQM (STSTRM)

 AS-MT (GFP-FAC)  LOA (VCG)  SQM (VT-TERM)

 AS-MT (ISC)  LOCKOUT-REQ (2R)  SQUELCH (OCN)

 AS-MT (ML1000)  LOCKOUT-REQ (EQPT)  SQUELCHED (2R)

 AS-MT (ML100T)  LOCKOUT-REQ (ESCON)  SQUELCHED (ESCON)

 AS-MT (MLFX)  LOCKOUT-REQ (FC)  SQUELCHED (FC)

 AS-MT (MLMR)  LOCKOUT-REQ (GE)  SQUELCHED (GE)

 AS-MT (OCH)  LOCKOUT-REQ (ISC)  SQUELCHED (ISC)

 AS-MT (OCN)  LOCKOUT-REQ (OCN)  SQUELCHED (OCN)

 AS-MT (OMS)  LOCKOUT-REQ (STSMON)  SQUELCHED (TRUNK)

 AS-MT (OTS)  LOCKOUT-REQ (TRUNK)  SSM-DUS (BITS)

 AS-MT (PPM)  LOCKOUT-REQ (VT-MON)  SSM-DUS (DS1)

 AS-MT (SHELF)  LOF (BITS)  SSM-DUS (E1)

 AS-MT (TRUNK)  LOF (DS1)  SSM-DUS (OCN)

 AS-MT-OOG (STSTRM)  LOF (DS3)  SSM-DUS (TRUNK)

 AS-MT-OOG (VT-TERM)  LOF (E1)  SSM-FAIL (BITS)

 AUD-LOG-LOSS (NE)  LOF (EC1)  SSM-FAIL (DS1)

 AUD-LOG-LOW (NE)  LOF (OCN)  SSM-FAIL (E1)

 AUTOLSROFF (OCN)  LOF (STSTRM)  SSM-FAIL (OCN)

 AUTONEG-RFI (ML1000)  LOF (TRUNK)  SSM-FAIL (TRUNK)

 AUTORESET (EQPT)  LO-LASERBIAS (EQPT)  SSM-LNC (BITS)

 AUTOSW-AIS (STSMON)  LO-LASERBIAS (OCN)  SSM-LNC (NE-SREF)

 AUTOSW-AIS (VT-MON)  LO-LASERBIAS (PPM)  SSM-LNC (OCN)

 AUTOSW-LOP (STSMON)  LO-LASERTEMP (EQPT)  SSM-LNC (TRUNK)

 AUTOSW-LOP (VT-MON)  LO-LASERTEMP (OCN)  SSM-OFF (BITS)

 AUTOSW-PDI (STSMON)  LO-LASERTEMP (PPM)  SSM-OFF (DS1)

 AUTOSW-PDI (VT-MON)  LOM (STSMON)  SSM-OFF (E1)

 AUTOSW-SDBER (STSMON)  LOM (STSTRM)  SSM-OFF (OCN)

 AUTOSW-SDBER (VT-MON)  LOM (TRUNK)  SSM-OFF (TRUNK)

 AUTOSW-SFBER (STSMON)  LOM (VT-TERM)  SSM-PRC (BITS)

 AUTOSW-SFBER (VT-MON)  LOP-P (STSMON)  SSM-PRC (NE-SREF)

 AUTOSW-UNEQ (STSMON)  LOP-P (STSTRM)  SSM-PRC (OCN)

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)
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 AUTOSW-UNEQ (VT-MON)  LOP-V (VT-MON)  SSM-PRC (TRUNK)

 AWG-DEG (OTS)  LOP-V (VT-TERM)  SSM-PRS (BITS)

 AWG-FAIL (OTS)  LO-RXPOWER (2R)  SSM-PRS (DS1)

 AWG-OVERTEMP (OTS)  LO-RXPOWER (ESCON)  SSM-PRS (E1)

 AWG-WARM-UP (OTS)  LO-RXPOWER (FC)  SSM-PRS (NE-SREF)

 BAT-FAIL (PWR)  LO-RXPOWER (GE)  SSM-PRS (OCN)

 BERT-ENBL (DS1, DS3)  LO-RXPOWER (ISC)  SSM-PRS (TRUNK)

 BERT-SYNC-FAIL (DS1, DS3)  LO-RXPOWER (OCN)  SSM-RES (BITS)

 BKUPMEMP (EQPT)  LO-RXPOWER (TRUNK)  SSM-RES (DS1)

 BLSROSYNC (OCN)  LOS (2R)  SSM-RES (E1)

 BLSR-SW-VER-MISM (OCN)  LOS (BITS)  SSM-RES (NE-SREF)

 BPV (BITS)  LOS (DS1)  SSM-RES (OCN)

 CARLOSS (CE1000)  LOS (DS3)  SSM-RES (TRUNK)

 CARLOSS (CE100T)  LOS (E1)  SSM-SDH-TN (BITS)

 CARLOSS (CEMR)  LOS (EC1)  SSM-SDH-TN (NE-SREF)

 CARLOSS (E1000F)  LOS (ESCON)  SSM-SDH-TN (OCN)

 CARLOSS (E100T)  LOS (FUDC)  SSM-SDH-TN (TRUNK)

 CARLOSS (EQPT)  LOS (ISC)  SSM-SETS (BITS)

 CARLOSS (FC)  LOS (MSUDC)  SSM-SETS (NE-SREF)

 CARLOSS (G1000)  LOS (OCN)  SSM-SETS (OCN)

 CARLOSS (GE)  LOS (OTS)  SSM-SETS (TRUNK)

 CARLOSS (ISC)  LOS (TRUNK)  SSM-SMC (BITS)

 CARLOSS (ML1000)  LOS-O (OCH)  SSM-SMC (DS1)

 CARLOSS (ML100T)  LOS-O (OMS)  SSM-SMC (E1)

 CARLOSS (MLFX)  LOS-O (OTS)  SSM-SMC (NE-SREF)

 CARLOSS (MLMR)  LOS-P (OCH)  SSM-SMC (OCN)

 CARLOSS (TRUNK)  LOS-P (OMS)  SSM-SMC (TRUNK)

 CASETEMP-DEG (AOTS)  LOS-P (OTS)  SSM-ST2 (BITS)

 CLDRESTART (EQPT)  LOS-P (TRUNK)  SSM-ST2 (DS1)

 COMIOXC (EQPT)  LO-TXPOWER (2R)  SSM-ST2 (E1)

 COMM-FAIL (EQPT)  LO-TXPOWER (EQPT)  SSM-ST2 (NE-SREF)

 CONTBUS-A-18 (EQPT)  LO-TXPOWER (ESCON)  SSM-ST2 (OCN)

 CONTBUS-B-18 (EQPT)  LO-TXPOWER (FC)  SSM-ST2 (TRUNK)

 CONTBUS-DISABLED (EQPT)  LO-TXPOWER (GE)  SSM-ST3 (BITS)

 CONTBUS-IO-A (EQPT)  LO-TXPOWER (ISC)  SSM-ST3 (DS1)

 CONTBUS-IO-B (EQPT)  LO-TXPOWER (OCN)  SSM-ST3 (E1)

 CPP-INCAPABLE (MLMR)  LO-TXPOWER (PPM)  SSM-ST3 (NE-SREF)

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)
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 CTNEQPT-MISMATCH (EQPT)  LO-TXPOWER (TRUNK)  SSM-ST3 (OCN)

 CTNEQPT-PBPROT (EQPT)  LPBKCRS (STSMON)  SSM-ST3 (TRUNK)

 CTNEQPT-PBWORK (EQPT)  LPBKCRS (STSTRM)  SSM-ST3E (BITS)

 DATA-CRC (CE100T)  LPBKDS1FE-CMD (DS1)  SSM-ST3E (DS1)

 DATA-CRC (ML1000)  LPBKDS3FEAC (DS3)  SSM-ST3E (E1)

 DATA-CRC (ML100T)  LPBKDS3FEAC-CMD (DS3)  SSM-ST3E (NE-SREF)

 DATA-CRC (MLFX)  LPBKFACILITY (CE1000)  SSM-ST3E (OCN)

 DATAFLT (NE)  LPBKFACILITY (CE100T)  SSM-ST3E (TRUNK)

 DBOSYNC (NE)  LPBKFACILITY (CEMR)  SSM-ST4 (BITS)

 DCU-LOSS-FAIL (OTS)  LPBKFACILITY (DS1)  SSM-ST4 (DS1)

 DS3-MISM (DS3)  LPBKFACILITY (DS3)  SSM-ST4 (E1)

 DSP-COMM-FAIL (TRUNK)  LPBKFACILITY (E1)  SSM-ST4 (NE-SREF)

 DSP-FAIL (TRUNK)  LPBKFACILITY (EC1)  SSM-ST4 (OCN)

 DUP-IPADDR (NE)  LPBKFACILITY (ESCON)  SSM-ST4 (TRUNK)

 DUP-NODENAME (NE)  LPBKFACILITY (FC)  SSM-STU (BITS)

 DUP-SHELF-ID (SHELF)  LPBKFACILITY (FCMR)  SSM-STU (DS1)

 EHIBATVG (PWR)  LPBKFACILITY (G1000)  SSM-STU (E1)

 ELWBATVG (PWR)  LPBKFACILITY (GE)  SSM-STU (NE-SREF)

 ENCAP-MISMATCH-P (STSTRM)  LPBKFACILITY (ISC)  SSM-STU (OCN)

 EOC (OCN)  LPBKFACILITY (MLMR)  SSM-STU (TRUNK)

 EOC (TRUNK)  LPBKFACILITY (OCN)  SSM-TNC (BITS)

 EOC-L (OCN)  LPBKFACILITY (TRUNK)  SSM-TNC (NE-SREF)

 EOC-L (TRUNK)  LPBKTERMINAL (CE1000)  SSM-TNC (OCN)

 EQPT (AICI-AEP)  LPBKTERMINAL (CE100T)  SSM-TNC (TRUNK)

 EQPT (AICI-AIE)  LPBKTERMINAL (CEMR)  STS-SQUELCH-L (OCN)

 EQPT (EQPT)  LPBKTERMINAL (DS1)  SW-MISMATCH (EQPT)

 EQPT (PPM)  LPBKTERMINAL (DS3)  SWMTXMOD-PROT (EQPT)

 EQPT-DIAG (EQPT)  LPBKTERMINAL (E1)  SWMTXMOD-WORK (EQPT)

 EQPT-MISS (FAN)  LPBKTERMINAL (EC1)  SWTOPRI (EXT-SREF)

 ERFI-P-CONN (STSMON)  LPBKTERMINAL (ESCON)  SWTOPRI (NE-SREF)

 ERFI-P-CONN (STSTRM)  LPBKTERMINAL (FC)  SWTOSEC (EXT-SREF)

 ERFI-P-PAYLD (STSMON)  LPBKTERMINAL (FCMR)  SWTOSEC (NE-SREF)

 ERFI-P-PAYLD (STSTRM)  LPBKTERMINAL (G1000)  SWTOTHIRD (EXT-SREF)

 ERFI-P-SRVR (STSMON)  LPBKTERMINAL (GE)  SWTOTHIRD (NE-SREF)

 ERFI-P-SRVR (STSTRM)  LPBKTERMINAL (ISC)  SYNC-FREQ (BITS)

 ERROR-CONFIG (EQPT)  LPBKTERMINAL (MLMR)  SYNC-FREQ (DS1)

 ETH-LINKLOSS (NE)  LPBKTERMINAL (OCN)  SYNC-FREQ (E1)
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 E-W-MISMATCH (OCN)  LPBKTERMINAL (TRUNK)  SYNC-FREQ (OCN)

 EXCCOL (EQPT)  LWBATVG (PWR)  SYNC-FREQ (TRUNK)

 EXERCISE-RING-FAIL (OCN)  MAN-REQ (EQPT)  SYNCLOSS (FC)

 EXERCISE-SPAN-FAIL (OCN)  MAN-REQ (ML1000)  SYNCLOSS (FCMR)

 EXT (ENVALRM)  MAN-REQ (ML100T)  SYNCLOSS (GE)

 EXTRA-TRAF-PREEMPT (OCN)  MAN-REQ (MLFX)  SYNCLOSS (ISC)

 FAILTOSW (2R) MAN-REQ (MLMR)  SYNCLOSS (TRUNK)

 FAILTOSW (EQPT)  MAN-REQ (STSMON)  SYNCPRI (EXT-SREF)

 FAILTOSW (ESCON)  MAN-REQ (VT-MON)  SYNCPRI (NE-SREF)

 FAILTOSW (FC)  MANRESET (EQPT)  SYNCSEC (EXT-SREF)

 FAILTOSW (GE)  MANSWTOINT (NE-SREF)  SYNCSEC (NE-SREF)

 FAILTOSW (ISC)  MANSWTOPRI (EXT-SREF)  SYNCTHIRD (EXT-SREF)

 FAILTOSW (OCN)  MANSWTOPRI (NE-SREF)  SYNCTHIRD (NE-SREF)

 FAILTOSW (TRUNK)  MANSWTOSEC (EXT-SREF)  SYSBOOT (NE)

 FAILTOSW-PATH (STSMON)  MANSWTOSEC (NE-SREF)  TEMP-MISM (NE)

 FAILTOSW-PATH (VT-MON)  MANSWTOTHIRD (EXT-SREF)  TIM (OCN)

 FAILTOSWR (OCN)  MANSWTOTHIRD (NE-SREF)  TIM (TRUNK)

 FAILTOSWS (OCN)  MANUAL-REQ-RING (OCN)  TIM-MON (OCN)

 FAN (FAN)  MANUAL-REQ-SPAN (2R)  TIM-MON (TRUNK)

 FAPS (FCMR)  MANUAL-REQ-SPAN (EC1)  TIM-P (STSMON)

 FAPS (TRUNK)  MANUAL-REQ-SPAN (ESCON)  TIM-P (STSTRM)

 FAPS-CONFIG-MISMATCH (EQPT)  MANUAL-REQ-SPAN (FC)  TIM-S (EC1)

 FC-DE-NES (FC)  MANUAL-REQ-SPAN (GE)  TIM-S (OCN)

 FC-DE-NES (FCMR)  MANUAL-REQ-SPAN (ISC)  TIM-V (VT-MON)

 FC-DE-NES (TRUNK)  MANUAL-REQ-SPAN (OCN)  TIM-V (VT-TERM)

 FC-NO-CREDITS (FC)  MANUAL-REQ-SPAN (TRUNK)  TPTFAIL (CE1000)

 FC-NO-CREDITS (FCMR)  MAX-STATIONS (RPRIF)  TPTFAIL (CE100T)

 FC-NO-CREDITS (TRUNK)  MEA (AIP)  TPTFAIL (CEMR)

 FDI (OCH)  MEA (BIC)  TPTFAIL (FCMR)

 FDI (OCH-TERM)  MEA (EQPT)  TPTFAIL (G1000)

 FE-AIS (DS3)  MEA (FAN)  TPTFAIL (ML1000)

 FEC-MISM (TRUNK)  MEA (PPM)  TPTFAIL (ML100T)

 FE-DS1-MULTLOS (DS3)  MEA (SHELF)  TPTFAIL (MLFX)

 FE-DS1-NSA (DS3)  MEM-GONE (EQPT)  TPTFAIL (MLMR)

 FE-DS1-SA (DS3)  MEM-LOW (EQPT)  TRAIL-SIGNAL-FAIL (OCH)

 FE-DS1-SNGLLOS (DS3)  MFGMEM (AICI-AEP)  TRAIL-SIGNAL-FAIL (TRUNK)

 FE-DS3-NSA (DS3)  MFGMEM (AICI-AIE)  TRMT (DS1)

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)
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 FE-DS3-SA (DS3)  MFGMEM (AIP)  TRMT (E1)

 FE-EQPT-NSA (DS3)  MFGMEM (BPLANE)  TRMT-MISS (DS1)

 FE-FRCDWKSWBK-SPAN (OCN)  MFGMEM (FAN)  TRMT-MISS (E1)

 FE-FRCDWKSWPR-RING (EC1)  MFGMEM (PPM)  TX-AIS (DS1)

 FE-FRCDWKSWPR-RING (OCN)  MS-DEG (E1)  TX-AIS (DS3)

 FE-FRCDWKSWPR-SPAN (OCN)  MS-EXC (E1)  TX-AIS (E1)

 FE-IDLE (DS3)  MT-OCHNC (OTS)  TX-IDLE (DS1)

 FE-LOCKOUTOFPR-SPAN (OCN)  NO-CONFIG (EQPT)  TX-LOF (DS1)

 FE-LOF (DS3)  NON-CISCO-PPM (PPM)  TX-LOF (E1)

 FE-LOS (DS3)  OCHNC-INC (OCHNC-CONN)  TX-RAI (DS1)

 FE-MANWKSWBK-SPAN (OCN)  OCHTERM-INC (OCH-TERM)  TX-RAI (DS3)

 FE-MANWKSWPR-RING (EC1)  ODUK-1-AIS-PM (TRUNK)  TX-RAI (E1)

 FE-MANWKSWPR-RING (OCN)  ODUK-2-AIS-PM (TRUNK)  UNC-WORD (TRUNK)

 FE-MANWKSWPR-SPAN (OCN)  ODUK-3-AIS-PM (TRUNK)  UNEQ-P (STSMON)

 FEPRLF (OCN)  ODUK-4-AIS-PM (TRUNK)  UNEQ-P (STSTRM)

 FIBERTEMP-DEG (AOTS)  ODUK-AIS-PM (TRUNK)  UNEQ-V (VT-MON)

 FORCED-REQ (EQPT)  ODUK-BDI-PM (TRUNK)  UNEQ-V (VT-TERM)

 FORCED-REQ (ML1000)  ODUK-LCK-PM (TRUNK)  UNQUAL-PPM (PPM)

 FORCED-REQ (ML100T)  ODUK-OCI-PM (TRUNK)  UT-COMM-FAIL (TRUNK)

 FORCED-REQ (MLFX)  ODUK-SD-PM (TRUNK)  UT-FAIL (TRUNK)

 FORCED-REQ (MLMR)  ODUK-SF-PM (TRUNK)  VCG-DEG (VCG)

 FORCED-REQ (STSMON)  ODUK-TIM-PM (TRUNK)  VCG-DOWN (VCG)

 FORCED-REQ (VT-MON)  OOU-TPT (STSTRM)  VOA-HDEG (AOTS)

 FORCED-REQ-RING (OCN)  OOU-TPT (VT-TERM)  VOA-HDEG (OCH)

 FORCED-REQ-SPAN (2R)  OPEN-SLOT (EQPT)  VOA-HDEG (OMS)

 FORCED-REQ-SPAN (EC1)  OPWR-HDEG (AOTS)  VOA-HDEG (OTS)

 FORCED-REQ-SPAN (ESCON)  OPWR-HDEG (OCH)  VOA-HFAIL (AOTS)

 FORCED-REQ-SPAN (FC)  OPWR-HDEG (OCH-TERM)  VOA-HFAIL (OCH)

 FORCED-REQ-SPAN (GE)  OPWR-HDEG (OMS)  VOA-HFAIL (OMS)

 FORCED-REQ-SPAN (ISC)  OPWR-HDEG (OTS)  VOA-HFAIL (OTS)

 FORCED-REQ-SPAN (OCN)  OPWR-HFAIL (AOTS)  VOA-LDEG (AOTS)

 FORCED-REQ-SPAN (TRUNK)  OPWR-HFAIL (OCH)  VOA-LDEG (OCH)

 FP-LINK-LOSS (EQPT)  OPWR-HFAIL (OMS)  VOA-LDEG (OMS)

 FRCDSWTOINT (NE-SREF)  OPWR-HFAIL (OTS)  VOA-LDEG (OTS)

 FRCDSWTOPRI (EXT-SREF)  OPWR-LDEG (AOTS)  VOA-LFAIL (AOTS)

 FRCDSWTOPRI (NE-SREF)  OPWR-LDEG (OCH)  VOA-LFAIL (OCH)

 FRCDSWTOSEC (EXT-SREF)  OPWR-LDEG (OCH-TERM)  VOA-LFAIL (OMS)

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)
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2.3  Alarm Logical Objects
The CTC alarm profile list organizes all alarms and conditions according to the logical objects they are 
raised against. These logical objects represent physical objects such as cards, logical objects such as 
circuits, or transport and signal monitoring entities such as the SONET or ITU-T G.709 optical overhead 
bits. One alarm can appear in multiple entries. It can be raised against multiple objects. For example, the 
loss of signal (LOS) alarm can be raised against the optical signal (OC-N) or the optical transport layer 
overhead (OTN) as well as other objects. Therefore, both OCN: LOS and OTN: LOS appear in the list 
(as well as the other objects).

 FRCDSWTOSEC (NE-SREF)  OPWR-LDEG (OMS)  VOA-LFAIL (OTS)

 FRCDSWTOTHIRD (EXT-SREF)  OPWR-LDEG (OTS)  VOLT-MISM (PWR)

 FRCDSWTOTHIRD (NE-SREF)  OPWR-LFAIL (AOTS)  VT-SQUELCH-L (OCN)

 FRNGSYNC (NE-SREF)  OPWR-LFAIL (OCH)  WKSWPR (2R)

 FSTSYNC (NE-SREF)  OPWR-LFAIL (OCH-TERM)  WKSWPR (EQPT)

 FTA-MISMATCH (EQPT)  OPWR-LFAIL (OMS)  WKSWPR (ESCON)

 FULLPASSTHR-BI (OCN)  OPWR-LFAIL (OTS)  WKSWPR (FC)

 GAIN-HDEG (AOTS)  OSRION (AOTS)  WKSWPR (GE)

 GAIN-HFAIL (AOTS)  OSRION (OTS)  WKSWPR (ISC)

 GAIN-LDEG (AOTS)  OTUK-AIS (TRUNK)  WKSWPR (OCN)

 GAIN-LFAIL (AOTS)  OTUK-BDI (TRUNK)  WKSWPR (STSMON)

 GCC-EOC (TRUNK)  OTUK-IAE (TRUNK)  WKSWPR (VT-MON)

 GE-OOSYNC (FC)  OTUK-LOF (TRUNK)  WORK-QUEUE-FULL (EQPT)

 GE-OOSYNC (GE)  OTUK-SD (TRUNK)  WTR (2R)

 GE-OOSYNC (ISC)  OTUK-SF (TRUNK)  WTR (EC1)

 GE-OOSYNC (TRUNK)  OTUK-TIM (TRUNK)  WTR (EQPT)

 GFP-CSF (CE1000)  OUT-OF-SYNC (FC)  WTR (ESCON)

 GFP-CSF (CE100T)  OUT-OF-SYNC (GE)  WTR (FC)

 GFP-CSF (CEMR)  OUT-OF-SYNC (ISC)  WTR (GE)

 GFP-CSF (FCMR)  OUT-OF-SYNC (TRUNK)  WTR (ISC)

 GFP-CSF (GFP-FAC)  PARAM-MISM (AOTS)  WTR (ML1000)

 GFP-CSF (ML1000)  PARAM-MISM (OCH)  WTR (ML100T)

 GFP-CSF (ML100T)  PARAM-MISM (OCH-TERM)  WTR (MLFX)

 GFP-CSF (MLFX)  PARAM-MISM (OMS)  WTR (MLMR)

 GFP-CSF (MLMR)  PARAM-MISM (OTS)  WTR (OCN)

 GFP-DE-MISMATCH (FCMR)  PDI-P (STSMON)  WTR (STSMON)

 GFP-DE-MISMATCH (GFP-FAC)  PDI-P (STSTRM)  WTR (TRUNK)

 GFP-EX-MISMATCH (CE1000)  PEER-NORESPONSE (MLMR)  WTR (VT-MON)

 GFP-EX-MISMATCH (FCMR)  PLM-P (STSMON)  WVL-MISMATCH (TRUNK)
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Alarm profile list objects are defined in Table 2-7.

Note Alarm logical object names can appear as abbreviated versions of standard terms used in the system and 
the documentation. For example, the “OCN” logical object refers to the OC-N signal. Logical object 
names or industry-standard terms are used within the entries as appropriate.

Table 2-7 Alarm Logical Object Type Definitions 

Logical Object Definition

2R Reshape and retransmit (used for transponder [TXP] cards).

AICI-AEP Alarm Interface Controller–International/alarm expansion panel. A combination 
term that refers to this platform’s AIC-I card.

AICI-AIE Alarm Interface Controller-International/Alarm Interface Extension. A 
combination term that refers to this platform's AIC-I card. 

AIP Alarm Interface Panel.

AOTS Amplified optical transport section. For information about AOTS alarms, refer to 
the “Alarm Troubleshooting” chapter in the Cisco ONS 15454 DWDM 
Troubleshooting Guide.

BIC Backplane interface connector.

BITS Building integrated timing supply incoming references (BITS-1, BITS-2).

BPLANE The backplane.

CE1000 CE-1000-4 card.

CE100T CE-100T-8 card.

CEMR CE-MR-10 card.

CTRL Control channel.

DS1 A DS-1 line on a DS-1 or DS-3 electrical card (DS1-14, DS3N-12E, DS3XM-6, 
DS3XM-12).

DS3 A DS-3 line on a DS3-12, DS3N-12, DS3-12E, DS3XM-6, DS3XM-12, 
DS3/EC1-48 card.

E1 An E1 line on a DS1/E1-56 card.

E1000F An E1000 Ethernet card (E1000-2, E1000-2G).

E100T An E100 Ethernet card (E100T-12, E100T-G).

EC1 Any EC-1 port (including EC1-12 card ports).

ENVALRM An environmental alarm port.

EQPT A card, its physical objects, and its logical objects as they are located in any of the 
eight noncommon card slots. The EQPT object is used for alarms that refer to the 
card itself and all other objects on the card including ports, lines, synchronous 
transport signals (STS), and virtual tributaries (VT).

ESCON Enterprise System Connection fiber optic technology, referring to the following 
TXP cards: TXP_MR_2.5G, TXPP_MR_2.5G. For more information about ESCON 
alarms, refer to the “Alarm Troubleshooting” chapter in the 
 Cisco ONS 15454 DWDM Troubleshooting Guide.

EXT-SREF BITS outgoing references (SYNC-BITS1, SYNC-BITS2).
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FAN Fan-tray assembly.

FC Fibre channel data transfer architecture, referring to the following muxponder 
(MXP) or TXP cards: MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, 
TXPP_MR_2.5G, TXP_MR_10E. For more information about FC alarms, refer to 
the “Alarm Troubleshooting” chapter in the Cisco ONS 15454 DWDM 
Troubleshooting Guide.

FCMR An FC_MR-4 Fibre Channel card.

FUDC SONET F1 byte user data channel for ONS 15454 ML-Series Ethernet cards.

G1000 A G-Series Ethernet card.

GE Gigabit Ethernet, referring to the following MXP or TXP cards: MXP_MR_2.5G, 
MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, 
TXP_MR_10G.

GFP-FAC Generic framing procedure facility port, referring to all MXP and TXP cards.

ISC Inter-service channel, referring to TXPP_MR_2.5G or TXP_MR_2.5G cards. For 
more information about ISC alarms, refer to the “Alarm Troubleshooting” chapter 
in the Cisco ONS 15454 DWDM Troubleshooting Guide.

ML1000 An ML1000 Ethernet card (ML1000-2). 

ML100T An ML100 Ethernet card (ML100T-12).

MLFX An ML100X-8 Ethernet card.

MLMR An ML-MR-10 Ethernet card.

MSUDC Multiplex section user data channel.

NE The entire network element.

NE-SREF The timing status of the NE.

OCH The optical channel, referring to dense wavelength division multiplexing (DWDM) 
cards. For more information about OCH alarms, refer to the “Alarm 
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

OCHNC-CONN The optical channel network connection, referring to DWDM cards. For more 
information about OCHNC-CONN alarms, refer to the “Alarm Troubleshooting” 
chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

OCH-TERM The optical channel termination node, referring to DWDM cards. For more 
information about most of the alarms on this object, refer to the “Alarm 
Troubleshooting” chapter of the Cisco ONS 15454 DWDM Troubleshooting Guide.

Note The network element reports alarms or conditions on ingress ports of the 
card. Alarms detected at the internal ports (TERM side) will be ingress 
mapped to the MON side. The alarm profile entities of OCH-TERM, if 
available, should be changed to the same severity as the customized severity 
for a specific OCH-TERM alarm.

OCN An OC-N line on any OC-N card.

OMS Optical multiplex section.

OSC-RING Optical service channel ring. For more information about OSC-RING alarms, refer 
to the “Alarm Troubleshooting” chapter in the Cisco ONS 15454 DWDM 
Troubleshooting Guide.

Table 2-7 Alarm Logical Object Type Definitions (continued)

Logical Object Definition
2-21
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.3    Alarm Logical Objects
OTS Optical transport section. For more information about OTS alarms, refer to the 
“Alarm Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting 
Guide.

PPM Pluggable port module (PPM), referring to OC192-XFP, MXP, TXP, and MRC 
cards. For more information about PPM alarms, refer to the “Alarm 
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

PWR Power equipment.

RPRIF Interface for Resilient Packet Ring technology as defined in IEEE 802.17b. Also 
called RPR-IEEE. 

SHELF The shelf assembly. For more information about most of the alarms on this object, 
refer to the “Alarm Troubleshooting” chapter of the Cisco ONS 15454 DWDM 
Troubleshooting Guide.

STSMON STS alarm detection at the monitor point (upstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the 
card. Alarms detected at the internal ports (TERM side) will be ingress 
mapped to the MON side. The alarm profile entities of STSMON, if 
available, should be changed to the same severity as the customized severity 
for a specific STS alarm.

STSTRM STS alarm detection at termination (downstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the 
card. Alarms detected at the internal ports (TERM side) will be ingress 
mapped to the MON side. The alarm profile entities of STSTRM, if 
available, should be changed to the same severity as the customized severity 
for a specific STS alarm.

TLINK Traffic engineering (TE) link correlation.

TRUNK The optical or DWDM card carrying the high-speed signal; referring to MXP or 
TXP cards. For more information about TRUNK alarms, refer to the “Alarm 
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

VCG A virtual concatenation group of VTs.

VT-MON VT1 alarm detection at the monitor point (upstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the 
card. Alarms detected at the internal ports (TERM side) will be ingress 
mapped to the MON side. The alarm profile entities of VT-MON, if 
available, should be changed to the same severity as the customized severity 
for a specific VT alarm.

VT-TERM VT1 alarm detection at termination (downstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the 
card. Alarms detected at the internal ports (TERM side) will be ingress 
mapped to the MON side. The alarm profile entities of VT-TERM, if 
available, should be changed to the same severity as the customized severity 
for a specific VT alarm.

Table 2-7 Alarm Logical Object Type Definitions (continued)
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2.4  Alarm List by Logical Object Type
Table 2-8 lists all ONS 15454 alarms and logical objects as they are given in the system alarm profile. 
The list entries are organized by logical object name and then by alarm or condition name. Where 
appropriate, the alarm entries also contain troubleshooting procedures.

Note In a mixed network containing different types of nodes (such as ONS 15310-CL, ONS 15454, and 
ONS 15600), the initially displayed alarm list in the Provisioning > Alarm Profiles > Alarm Profile 
Editor tab lists all conditions that are applicable to all nodes in the network. However, when you load 
the default severity profile from a node, only applicable alarms will display severity levels. 
Nonapplicable alarms can display “use default” or “unset.”

Note In some cases this list does not follow alphabetical order, but it does reflect the order shown in CTC.

Table 2-8 Alarm List by Logical Object in Alarm Profile 

2R: ALS (NA) FC: AS-CMD (NA) OCN: MANUAL-REQ-RING (NA)

2R: AS-CMD (NA) FC: AS-MT (NA) OCN: MANUAL-REQ-SPAN (NA)

2R: AS-MT (NA) FC: CARLOSS (MJ) OCN: PRC-DUPID (MJ)

2R: FAILTOSW (NA) FC: FAILTOSW (NA) OCN: RFI-L (NR)

2R: FORCED-REQ-SPAN (NA) FC: FC-DE-NES (MJ) OCN: RING-ID-MIS (MJ)

2R: HI-LASERBIAS (MN) FC: FC-NO-CREDITS (MJ) OCN: RING-MISMATCH (MJ)

2R: HI-RXPOWER (MN) FC: FORCED-REQ-SPAN (NA) OCN: RING-SW-EAST (NA)

2R: HI-TXPOWER (MN) FC: GE-OOSYNC (CR) OCN: RING-SW-WEST (NA)

2R: LO-RXPOWER (MN) FC: HI-LASERBIAS (MN) OCN: SD-L (NA)

2R: LO-TXPOWER (MN) FC: HI-RXPOWER (MN) OCN: SF-L (NA)

2R: LOCKOUT-REQ (NA) FC: HI-TXPOWER (MN) OCN: SPAN-SW-EAST (NA)

2R: LOS (CR) FC: LO-RXPOWER (MN) OCN: SPAN-SW-WEST (NA)

2R: MANUAL-REQ-SPAN (NA) FC: LO-TXPOWER (MN) OCN: SQUELCH (NA)

2R: SQUELCHED (NA) FC: LOCKOUT-REQ (NA) OCN: SQUELCHED (NA)

2R: WKSWPR (NA) FC: LPBKFACILITY (NA) OCN: SSM-DUS (NA)

2R: WTR (NA) FC: LPBKTERMINAL (NA) OCN: SSM-FAIL (MN)

AICI-AEP: EQPT (CR) FC: MANUAL-REQ-SPAN (NA) OCN: SSM-LNC (NA)

AICI-AEP: MFGMEM (CR) FC: OUT-OF-SYNC (MJ) OCN: SSM-OFF (NA)

AICI-AIE: EQPT (CR) FC: SIGLOSS (MJ) OCN: SSM-PRC (NA)

AICI-AIE: MFGMEM (CR) FC: SQUELCHED (NA) OCN: SSM-PRS (NA)

AIP: INVMACADR (MJ) FC: SYNCLOSS (MJ) OCN: SSM-RES (NA)

AIP: MEA (CR) FC: WKSWPR (NA) OCN: SSM-SDH-TN (NA)

AIP: MFGMEM (CR) FC: WTR (NA) OCN: SSM-SETS (NA)

AOTS: ALS (NA) FCMR: AS-CMD (NA) OCN: SSM-SMC (NA)
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AOTS: AMPLI-INIT (NA) FCMR: AS-MT (NA) OCN: SSM-ST2 (NA)

AOTS: APC-CORR-SKIPPED (MN) FCMR: FAPS (NA) OCN: SSM-ST3 (NA)

AOTS: APC-DISABLED (NA) FCMR: FC-DE-NES (MJ) OCN: SSM-ST3E (NA)

AOTS: APC-OUT-OF-RANGE (MN) FCMR: FC-NO-CREDITS (MJ) OCN: SSM-ST4 (NA)

AOTS: APC-WRONG-GAIN (NA) FCMR: GFP-CSF (MJ) OCN: SSM-STU (NA)

AOTS: AS-CMD (NA) FCMR: GFP-DE-MISMATCH (MJ) OCN: SSM-TNC (NA)

AOTS: AS-MT (NA) FCMR: GFP-EX-MISMATCH (MJ) OCN: STS-SQUELCH-L (NA)

AOTS: CASETEMP-DEG (MN) FCMR: GFP-LFD (MJ) OCN: SYNC-FREQ (NA)

AOTS: FIBERTEMP-DEG (MN) FCMR: GFP-NO-BUFFERS (MJ) OCN: TIM (CR)

AOTS: GAIN-HDEG (MN) FCMR: GFP-UP-MISMATCH (MJ) OCN: TIM-MON (MN)

AOTS: GAIN-HFAIL (CR) FCMR: LPBKFACILITY (NA) OCN: TIM-S (CR)

AOTS: GAIN-LDEG (MN) FCMR: LPBKTERMINAL (NA) OCN: VT-SQUELCH-L (NA)

AOTS: GAIN-LFAIL (CR) FCMR: PORT-MISMATCH (NA) OCN: WKSWPR (NA)

AOTS: LASER-APR (NA) FCMR: SIGLOSS (MJ) OCN: WTR (NA)

AOTS: LASERBIAS-DEG (MN) FCMR: SYNCLOSS (MJ) OMS: APC-CORR-SKIPPED (MN)

AOTS: LASERBIAS-FAIL (MJ) FCMR: TPTFAIL (MJ) OMS: APC-DISABLED (NA)

AOTS: LASERTEMP-DEG (MN) FUDC: AIS (NR) OMS: APC-OUT-OF-RANGE (MN)

AOTS: OPWR-HDEG (MN) FUDC: LOS (MN) OMS: AS-CMD (NA)

AOTS: OPWR-HFAIL (CR) G1000: AS-CMD (NA) OMS: AS-MT (NA)

AOTS: OPWR-LDEG (MN) G1000: AS-MT (NA) OMS: LOS-O (MN)

AOTS: OPWR-LFAIL (CR) G1000: CARLOSS (MJ) OMS: LOS-P (CR)

AOTS: OSRION (NA) G1000: LPBKFACILITY (NA) OMS: OPWR-HDEG (MN)

AOTS: PARAM-MISM (NA) G1000: LPBKTERMINAL (NA) OMS: OPWR-HFAIL (CR)

AOTS: VOA-HDEG (MN) G1000: TPTFAIL (MJ) OMS: OPWR-LDEG (MN)

AOTS: VOA-HFAIL (CR) GE: ALS (NA) OMS: OPWR-LFAIL (CR)

AOTS: VOA-LDEG (MN) GE: AS-CMD (NA) OMS: PARAM-MISM (NA)

AOTS: VOA-LFAIL (CR) GE: AS-MT (NA) OMS: PMI (NA)

BIC: MEA (CR) GE: CARLOSS (MJ) OMS: VOA-HDEG (MN)

BITS: AIS (NR) GE: FAILTOSW (NA) OMS: VOA-HFAIL (CR)

BITS: BPV (MN) GE: FORCED-REQ-SPAN (NA) OMS: VOA-LDEG (MN)

BITS: HI-CCVOLT (NA) GE: GE-OOSYNC (CR) OMS: VOA-LFAIL (CR)

BITS: LOF (MN) GE: HI-LASERBIAS (MN) OSC-RING: RING-ID-MIS (MJ)

BITS: LOS (MN) GE: HI-RXPOWER (MN) OTS: APC-CORR-SKIPPED (MN)

BITS: SSM-DUS (NA) GE: HI-TXPOWER (MN) OTS: APC-DISABLED (NA)

BITS: SSM-FAIL (MN) GE: LMP-FAIL (MN) OTS: APC-OUT-OF-RANGE (MN)

BITS: SSM-LNC (NA) GE: LMP-SD (MN) OTS: AS-CMD (NA)

BITS: SSM-OFF (NA) GE: LMP-SF (MN) OTS: AS-MT (NA)

Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)
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BITS: SSM-PRC (NA) GE: LMP-UNALLOC (NA) OTS: AWG-DEG (MN)

BITS: SSM-PRS (NA) GE: LO-RXPOWER (MN) OTS: AWG-FAIL (CR)

BITS: SSM-RES (NA) GE: LO-TXPOWER (MN) OTS: AWG-OVERTEMP (CR)

BITS: SSM-SDH-TN (NA) GE: LOCKOUT-REQ (NA) OTS: AWG-WARM-UP (NA)

BITS: SSM-SETS (NA) GE: LPBKFACILITY (NA) OTS: DCU-LOSS-FAIL (MN)

BITS: SSM-SMC (NA) GE: LPBKTERMINAL (NA) OTS: LASERBIAS-DEG (MN)

BITS: SSM-ST2 (NA) GE: MANUAL-REQ-SPAN (NA) OTS: LOS (CR)

BITS: SSM-ST3 (NA) GE: OUT-OF-SYNC (MJ) OTS: LOS-O (MN)

BITS: SSM-ST3E (NA) GE: SIGLOSS (MJ) OTS: LOS-P (CR)

BITS: SSM-ST4 (NA) GE: SQUELCHED (NA) OTS: MT-OCHNC (NA)

BITS: SSM-STU (NA) GE: SYNCLOSS (MJ) OTS: OPWR-HDEG (MN)

BITS: SSM-TNC (NA) GE: WKSWPR (NA) OTS: OPWR-HFAIL (CR)

BITS: SYNC-FREQ (NA) GE: WTR (NA) OTS: OPWR-LDEG (MN)

BPLANE: AS-CMD (NA) GFP-FAC: AS-CMD (NA) OTS: OPWR-LFAIL (CR)

BPLANE: MFGMEM (CR) GFP-FAC: AS-MT (NA) OTS: OSRION (NA)

CE1000: AS-CMD (NA) GFP-FAC: GFP-CSF (MJ) OTS: PARAM-MISM (NA)

CE1000: AS-MT (NA) GFP-FAC: GFP-DE-MISMATCH (MJ) OTS: PMI (NA)

CE1000: CARLOSS (MJ) GFP-FAC: GFP-EX-MISMATCH (MJ) OTS: SH-IL-VAR-DEG-HIGH (MN)

CE1000: GFP-CSF (MJ) GFP-FAC: GFP-LFD (MJ) OTS: SH-IL-VAR-DEG-LOW (MN)

CE1000: GFP-EX-MISMATCH (MJ) GFP-FAC: GFP-NO-BUFFERS (MJ) OTS: SHUTTER-OPEN (NA)

CE1000: GFP-LFD (MJ) GFP-FAC: GFP-UP-MISMATCH (MJ) OTS: SPAN-NOT-MEASURED (NA)

CE1000: GFP-UP-MISMATCH (MJ) ISC: ALS (NA) OTS: SPANLEN-OUT-OF-RANGE 
(MN)

CE1000: LPBKFACILITY (NA) ISC: AS-CMD (NA) OTS: VOA-HDEG (MN)

CE1000: LPBKTERMINAL (NA) ISC: AS-MT (NA) OTS: VOA-HFAIL (CR)

CE1000: TPTFAIL (MJ) ISC: CARLOSS (MJ) OTS: VOA-LDEG (MN)

CE100T: AS-CMD (NA) ISC: FAILTOSW (NA) OTS: VOA-LFAIL (CR)

CE100T: AS-MT (NA) ISC: FORCED-REQ-SPAN (NA) PPM: AS-CMD (NA)

CE100T: CARLOSS (MJ) ISC: GE-OOSYNC (CR) PPM: AS-MT (NA)

CE100T: DATA-CRC (MJ) ISC: HI-LASERBIAS (MN) PPM: EQPT (CR)

CE100T: GFP-CSF (MJ) ISC: HI-RXPOWER (MN) PPM: HI-LASERBIAS (MN)

CE100T: GFP-LFD (MJ) ISC: HI-TXPOWER (MN) PPM: HI-LASERTEMP (MN)

CE100T: GFP-UP-MISMATCH (MJ) ISC: LO-RXPOWER (MN) PPM: HI-TXPOWER (MN)

CE100T: LPBKFACILITY (NA) ISC: LO-TXPOWER (MN) PPM: IMPROPRMVL (CR)

CE100T: LPBKTERMINAL (NA) ISC: LOCKOUT-REQ (NA) PPM: LO-LASERBIAS (MN)

CE100T: TPTFAIL (MJ) ISC: LOS (CR) PPM: LO-LASERTEMP (MN)

CEMR: AS-CMD (NA) ISC: LPBKFACILITY (NA) PPM: LO-TXPOWER (MN)
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CEMR: AS-MT (NA) ISC: LPBKTERMINAL (NA) PPM: MEA (CR)

CEMR: CARLOSS (MJ) ISC: MANUAL-REQ-SPAN (NA) PPM: MFGMEM (CR)

CEMR: GFP-CSF (MJ) ISC: OUT-OF-SYNC (NA) PPM: NON-CISCO-PPM (NR)

CEMR: GFP-LFD (MJ) ISC: SIGLOSS (MJ) PPM: PROV-MISMATCH (MN)

CEMR: GFP-UP-MISMATCH (MJ) ISC: SQUELCHED (NA) PPM: UNQUAL-PPM (NR)

CEMR: LPBKFACILITY (NA) ISC: SYNCLOSS (MJ) PWR: AS-CMD (NA)

CEMR: LPBKTERMINAL (NA) ISC: WKSWPR (NA) PWR: BAT-FAIL (MJ)

CEMR: PORT-MISMATCH (MJ) ISC: WTR (NA) PWR: EHIBATVG (MJ)

CEMR: TPTFAIL (MJ) ML1000: AS-CMD (NA) PWR: ELWBATVG (MJ)

CTRL: LMP-FAIL (MN) ML1000: AS-MT (NA) PWR: HIBATVG (MJ)

DS1: AIS (NR) ML1000: AUTONEG-RFI (MJ) PWR: LWBATVG (MJ)

DS1: AS-CMD (NA) ML1000: CARLOSS (MJ) PWR: VOLT-MISM (NA)

DS1: AS-MT (NA) ML1000: DATA-CRC (MJ) RPRIF: MAX-STATIONS (MJ)

DS1: BERT-ENBL (NR) ML1000: FORCED-REQ (NA) RPRIF: RSV-RT-EXCD-RINGLET0 
(MJ)

DS1: BERT-SYNC-FAIL (NR) ML1000: GFP-CSF (MJ) RPRIF: RSV-RT-EXCD-RINGLET1 
(MJ)

DS1: IDLE (NA) ML1000: GFP-LFD (MJ) RPRIF: RPR-PASSTHR (NA)

DS1: LOF (MJ) ML1000: GFP-UP-MISMATCH (MJ) RPRIF: RPR-PEER-MISS (MJ)

DS1: LOS (MJ) ML1000: LINK-KEEPALIVE (CR) RPRIF: RPR-PROT-ACTIVE (NA)

DS1: LPBKDS1FE-CMD (NA) ML1000: MAN-REQ (NA) RPRIF: RPR-PROT-CONFIG-MISM 
(MJ)

DS1: LPBKFACILITY (NA) ML1000: RPR-SD (NA) RPRIF: RPR-RI-FAIL (MJ)

DS1: LPBKTERMINAL (NA) ML1000: RPR-SF (NA) SHELF: APC-DISABLED (NA)

DS1: RAI (NA) ML1000: RPR-SPAN-MISMATCH 
(MJ)

SHELF: AS-CMD (NA)

DS1: RCVR-MISS (MJ) ML1000: RPRW (NA) SHELF: AS-MT (NA)

DS1: SD (NA) ML1000: TPTFAIL (MJ) SHELF: DUP-SHELF-ID (MJ)

DS1: SF (NA) ML1000: WTR (NA) SHELF: MEA (MJ)

DS1: SSM-DUS (NA) ML100T: AS-CMD (NA) SHELF: SHELF-COMM-FAIL (MJ)

DS1: SSM-FAIL (MN) ML100T: AS-MT (NA) STSMON: AIS-P (NR)

DS1: SSM-OFF (NA) ML100T: CARLOSS (MJ) STSMON: AUTOSW-AIS (NR)

DS1: SSM-PRS (NA) ML100T: DATA-CRC (MJ) STSMON: AUTOSW-LOP (NA)

DS1: SSM-RES (NA) ML100T: FORCED-REQ (NA) STSMON: AUTOSW-PDI (NA)

DS1: SSM-SMC (NA) ML100T: GFP-CSF (MJ) STSMON: AUTOSW-SDBER (NA)

DS1: SSM-ST2 (NA) ML100T: GFP-LFD (MJ) STSMON: AUTOSW-SFBER (NA)

DS1: SSM-ST3 (NA) ML100T: GFP-UP-MISMATCH (MJ) STSMON: AUTOSW-UNEQ (NA)

DS1: SSM-ST3E (NA) ML100T: LINK-KEEPALIVE (CR) STSMON: ERFI-P-CONN (NR)
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DS1: SSM-ST4 (NA) ML100T: MAN-REQ (NA) STSMON: ERFI-P-PAYLD (NR)

DS1: SSM-STU (NA) ML100T: RPR-SD (NA) STSMON: ERFI-P-SRVR (NR)

DS1: SYNC-FREQ (NA) ML100T: RPR-SF (NA) STSMON: FAILTOSW-PATH (NA)

DS1: TRMT (MJ) ML100T: RPR-SPAN-MISMATCH 
(MJ)

STSMON: FORCED-REQ (NA)

DS1: TRMT-MISS (MJ) ML100T: RPRW (NA) STSMON: LOCKOUT-REQ (NA)

DS1: TX-AIS (NR) ML100T: TPTFAIL (MJ) STSMON: LOM (CR)

DS1: TX-IDLE (NA) ML100T: WTR (NA) STSMON: LOP-P (CR)

DS1: TX-LOF (NR) MLFX: AS-CMD (NA) STSMON: LPBKCRS (NA)

DS1: TX-RAI (NA) MLFX: AS-MT (NA) STSMON: MAN-REQ (NA)

DS3: AIS (NR) MLFX: CARLOSS (MJ) STSMON: PDI-P (NA)

DS3: AS-CMD (NA) MLFX: DATA-CRC (MJ) STSMON: PLM-P (CR)

DS3: AS-MT (NA) MLFX: FORCED-REQ (NA) STSMON: RFI-P (NR)

DS3: BERT-ENBL (NR) MLFX: GFP-CSF (MJ) STSMON: ROLL (NA)

DS3: BERT-SYNC-FAIL (NR) MLFX: GFP-LFD (MJ) STSMON: ROLL-PEND (NA)

DS3: DS3-MISM (NA) MLFX: GFP-UP-MISMATCH (MJ) STSMON: SD-P (NA)

DS3: FE-AIS (NA) MLFX: LINK-KEEPALIVE (CR) STSMON: SF-P (NA)

DS3: FE-DS1-MULTLOS (NA) MLFX: MAN-REQ (NA) STSMON: TIM-P (MN)

DS3: FE-DS1-NSA (NA) MLFX: RPR-SD (NA) STSMON: UNEQ-P (CR)

DS3: FE-DS1-SA (NA) MLFX: RPR-SF (NA) STSMON: WKSWPR (NA)

DS3: FE-DS1-SNGLLOS (NA) MLFX: RPR-SPAN-MISMATCH (MJ) STSMON: WTR (NA)

DS3: FE-DS3-NSA (NA) MLFX: RPRW (NA) STSTRM: AIS-P (NR)

DS3: FE-DS3-SA (NA) MLFX: TPTFAIL (MJ) STSTRM: AS-MT-OOG (NA)

DS3: FE-EQPT-NSA (NA) MLFX: WTR (NA) STSTRM: ENCAP-MISMATCH-P 
(CR)

DS3: FE-IDLE (NA) MLMR: AS-CMD (NA) STSTRM: ERFI-P-CONN (NR)

DS3: FE-LOF (NA) MLMR: AS-MT (NA) STSTRM: ERFI-P-PAYLD (NR)

DS3: FE-LOS (NA) MLMR: CARLOSS (MJ) STSTRM: ERFI-P-SRVR (NR)

DS3: INC-ISD (NA) MLMR: CPP-INCAPABLE (NA) STSTRM: LCAS-CRC (NA)

DS3: LOF (CR) MLMR: FORCED-REQ (NA) STSTRM: LCAS-RX-DNU (NA)

DS3: LOS (CR) MLMR: GFP-CSF (MJ) STSTRM: LCAS-RX-FAIL (NA)

DS3: LPBKDS3FEAC (NA) MLMR: GFP-LFD (MJ) STSTRM: LCAS-RX-GRP-ERR (NA)

DS3: LPBKDS3FEAC-CMD (NA) MLMR: GFP-UP-MISMATCH (MJ) STSTRM: LCAS-TX-ADD (NA)

DS3: LPBKFACILITY (NA) MLMR: LINK-KEEPALIVE (CR) STSTRM: LCAS-TX-DNU (NA)

DS3: LPBKTERMINAL (NA) MLMR: LPBKFACILITY (NA) STSTRM: LOF (CR)

DS3: RAI (NA) MLMR: LPBKTERMINAL (NA) STSTRM: LOM (CR)

DS3: SD (NA) MLMR: MAN-REQ (NA) STSTRM: LOP-P (CR)

DS3: SF (NA) MLMR: PEER-NORESPONSE (MN) STSTRM: LPBKCRS (NA)
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DS3: TX-AIS (NR) MLMR: PORT-MISMATCH (MJ) STSTRM: OOU-TPT (NA)

DS3: TX-RAI (NA) MLMR: RPR-SD (NA) STSTRM: PDI-P (NA)

E1000F: AS-CMD (NA) MLMR: RPR-SF (NA) STSTRM: PLM-P (CR)

E1000F: CARLOSS (MJ) MLMR: RPR-SPAN-MISMATCH (MJ) STSTRM: RFI-P (NR)

E100T: AS-CMD (NA) MLMR: TPTFAIL (MJ) STSTRM: ROLL (NA)

E100T: CARLOSS (MJ) MLMR: WTR (NA) STSTRM: ROLL-PEND (NR)

E1: AIS (NR) MSUDC: AIS (NR) STSTRM: SD-P (NA)

E1: AS-CMD (NA) MSUDC: LOS (MN) STSTRM: SF-P (NA)

E1: AS-MT (NA) NE-SREF: FRCDSWTOINT (NA) STSTRM: SQM (CR)

E1: LOF (MJ) NE-SREF: FRCDSWTOPRI (NA) STSTRM: TIM-P (CR)

E1: LOS (MJ) NE-SREF: FRCDSWTOSEC (NA) STSTRM: UNEQ-P (CR)

E1: LPBKFACILITY (NA) NE-SREF: FRCDSWTOTHIRD (NA) TLINK: LMP-FAIL (MN)

E1: LPBKTERMINAL (NA) NE-SREF: FRNGSYNC (NA) TRUNK: AIS (NR)

E1: MS-DEG (NA) NE-SREF: FSTSYNC (NA) TRUNK: AIS-L (NR)

E1: MS-EXC (NA) NE-SREF: HLDOVRSYNC (NA) TRUNK: ALS (NA)

E1: RAI (NA) NE-SREF: MANSWTOINT (NA) TRUNK: AS-CMD (NA)

E1: RCVR-MISS (MJ) NE-SREF: MANSWTOPRI (NA) TRUNK: AS-MT (NA)

E1: SSM-DUS (NA) NE-SREF: MANSWTOSEC (NA) TRUNK: CARLOSS (MJ)

E1: SSM-FAIL (MN) NE-SREF: MANSWTOTHIRD (NA) TRUNK: DSP-COMM-FAIL (MJ)

E1: SSM-OFF (NA) NE-SREF: SSM-LNC (NA) TRUNK: DSP-FAIL (MJ)

E1: SSM-PRS (NA) NE-SREF: SSM-PRC (NA) TRUNK: EOC (MN)

E1: SSM-RES (NA) NE-SREF: SSM-PRS (NA) TRUNK: EOC-L (MN)

E1: SSM-SMC (NA) NE-SREF: SSM-RES (NA) TRUNK: FAILTOSW (NA)

E1: SSM-ST2 (NA) NE-SREF: SSM-SDH-TN (NA) TRUNK: FAPS (NA)

E1: SSM-ST3 (NA) NE-SREF: SSM-SETS (NA) TRUNK: FC-DE-NES (MJ)

E1: SSM-ST3E (NA) NE-SREF: SSM-SMC (NA) TRUNK: FC-NO-CREDITS (MJ)

E1: SSM-ST4 (NA) NE-SREF: SSM-ST2 (NA) TRUNK: FEC-MISM (MJ)

E1: SSM-STU (NA) NE-SREF: SSM-ST3 (NA) TRUNK: FORCED-REQ-SPAN (NA)

E1: SYNC-FREQ (NA) NE-SREF: SSM-ST3E (NA) TRUNK: GCC-EOC (MN)

E1: TRMT (MJ) NE-SREF: SSM-ST4 (NA) TRUNK: GE-OOSYNC (CR)

E1: TRMT-MISS (MJ) NE-SREF: SSM-STU (NA) TRUNK: HELLO (MN)

E1: TX-AIS (NR) NE-SREF: SSM-TNC (NA) TRUNK: HI-LASERBIAS (MN)

E1: TX-LOF (NR) NE-SREF: SWTOPRI (NA) TRUNK: HI-RXPOWER (MN)

E1: TX-RAI (NA) NE-SREF: SWTOSEC (NA) TRUNK: HI-TXPOWER (MN)

EC1: AIS-L (NR) NE-SREF: SWTOTHIRD (NA) TRUNK: ILK-FAIL (CR)

EC1: AS-CMD (NA) NE-SREF: SYNCPRI (MJ) TRUNK: ISIS-ADJ-FAIL (MN)

EC1: AS-MT (NA) NE-SREF: SYNCSEC (MN) TRUNK: LO-RXPOWER (MN)
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EC1: FE-FRCDWKSWPR-RING (NA) NE-SREF: SYNCTHIRD (MN) TRUNK: LO-TXPOWER (MN)

EC1: FE-MANWKSWPR-RING (NA) NE: APC-DISABLED (NA) TRUNK: LOCKOUT-REQ (NA)

EC1: FORCED-REQ-SPAN (NA) NE: APC-END (NA) TRUNK: LOF (CR)

EC1: LOF (CR) NE: AS-CMD (NA) TRUNK: LOM (CR)

EC1: LOS (CR) NE: AUD-LOG-LOSS (NA) TRUNK: LOS (CR)

EC1: LPBKFACILITY (NA) NE: AUD-LOG-LOW (NA) TRUNK: LOS-P (CR)

EC1: LPBKTERMINAL (NA) NE: DATAFLT (MN) TRUNK: LPBKFACILITY (NA)

EC1: MANUAL-REQ-SPAN (NA) NE: DBOSYNC (MJ) TRUNK: LPBKTERMINAL (NA)

EC1: RFI-L (NR) NE: DUP-IPADDR (MN) TRUNK: MANUAL-REQ-SPAN (NA)

EC1: SD-L (NA) NE: DUP-NODENAME (MN) TRUNK: ODUK-1-AIS-PM (NR)

EC1: SF-L (NA) NE: ETH-LINKLOSS (NA) TRUNK: ODUK-2-AIS-PM (NR)

EC1: TIM-S (CR) NE: HITEMP (CR) TRUNK: ODUK-3-AIS-PM (NR)

EC1: WTR (NA) NE: I-HITEMP (CR) TRUNK: ODUK-4-AIS-PM (NR)

ENVALRM: EXT (MN) NE: INTRUSION-PSWD (NA) TRUNK: ODUK-AIS-PM (NR)

EQPT: ALS-DISABLED (NA) NE: LAN-POL-REV (NA) TRUNK: ODUK-BDI-PM (NR)

EQPT: APC-DISABLED (NA) NE: SNTP-HOST (MN) TRUNK: ODUK-LCK-PM (NR)

EQPT: AS-CMD (NA) NE: SYSBOOT (MJ) TRUNK: ODUK-OCI-PM (NR)

EQPT: AS-MT (NA) NE: TEMP-MISM (NA) TRUNK: ODUK-SD-PM (NA)

EQPT: AUTORESET (MN) OCH: APC-DISABLED (NA) TRUNK: ODUK-SF-PM (NA)

EQPT: BKUPMEMP (CR) OCH-TERM: FDI (NA) TRUNK: ODUK-TIM-PM (MJ)

EQPT: CARLOSS (MJ) OCH-TERM: OCHTERM-INC (NA) TRUNK: OTUK-AIS (NR)

EQPT: CLDRESTART (NA) OCH-TERM: OPWR-HDEG (MN) TRUNK: OTUK-BDI (NR)

EQPT: COMIOXC (CR) OCH-TERM: OPWR-LDEG (MN) TRUNK: OTUK-IAE (MN)

EQPT: COMM-FAIL (MN) OCH-TERM: OPWR-LFAIL (CR) TRUNK: OTUK-LOF (CR)

EQPT: CONTBUS-A-18 (MN) OCH-TERM: PARAM-MISM (NA) TRUNK: OTUK-SD (NA)

EQPT: CONTBUS-B-18 (MN) — TRUNK: OTUK-SF (NA)

EQPT: CONTBUS-DISABLED (CR) — TRUNK: OTUK-TIM (CR)

EQPT: CONTBUS-IO-A (MN) — TRUNK: OUT-OF-SYNC (MJ)

EQPT: CONTBUS-IO-B (MN) — TRUNK: PROV-MISMATCH (MJ)

EQPT: CTNEQPT-MISMATCH (NA) OCH: APC-CORR-SKIPPED (MN) TRUNK: PTIM (MJ)

EQPT: CTNEQPT-PBPROT (CR) OCH: APC-OUT-OF-RANGE (MN) TRUNK: RFI (NR)

EQPT: CTNEQPT-PBWORK (CR) OCH: AS-CMD (NA) TRUNK: RFI-L (NR)

EQPT: EQPT (CR) OCH: AS-MT (NA) TRUNK: SD (NA)

EQPT: EQPT-DIAG (CR) OCH: FDI (NA) TRUNK: SD-L (NA)

EQPT: ERROR-CONFIG (MN) OCH: LOS-O (MN) TRUNK: SF (NA)

EQPT: EXCCOL (MN) OCH: LOS-P (CR) TRUNK: SF-L (NA)

EQPT: FAILTOSW (NA) OCH: OPWR-HDEG (MN) TRUNK: SIGLOSS (MJ)
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EQPT: FAPS-CONFIG-MISMATCH 
(MN)

OCH: OPWR-HFAIL (CR) TRUNK: SQUELCHED (NA)

EQPT: FORCED-REQ (NA) OCH: OPWR-LDEG (MN) TRUNK: SSM-DUS (NA)

EQPT: FP-LINK-LOSS (MN) OCH: OPWR-LFAIL (CR) TRUNK: SSM-FAIL (MN)

EQPT: FTA-MISMATCH (NA) OCH: PARAM-MISM (NA) TRUNK: SSM-LNC (NA)

EQPT: HI-LASERBIAS (MN) OCH: PORT-FAIL (CR) TRUNK: SSM-OFF (NA)

EQPT: HI-LASERTEMP (MN) OCH: TRAIL-SIGNAL-FAIL (NA) TRUNK: SSM-PRC (NA)

EQPT: HI-TXPOWER (MN) OCH: VOA-HDEG (MN) TRUNK: SSM-PRS (NA)

EQPT: HITEMP (MN) OCH: VOA-HFAIL (CR) TRUNK: SSM-RES (NA)

EQPT: IMPROPRMVL (CR) OCH: VOA-LDEG (MN) TRUNK: SSM-SDH-TN (NA)

EQPT: INHSWPR (NA) OCH: VOA-LFAIL (CR) TRUNK: SSM-SETS (NA)

EQPT: INHSWWKG (NA) OCHNC-CONN: OCHNC-INC (NA) TRUNK: SSM-SMC (NA)

EQPT: IOSCFGCOPY (NA) OCN: AIS-L (NR) TRUNK: SSM-ST2 (NA)

EQPT: LO-LASERBIAS (MN) OCN: ALS (NA) TRUNK: SSM-ST3 (NA)

EQPT: LO-LASERTEMP (MN) OCN: APS-INV-PRIM (MN) TRUNK: SSM-ST3E (NA)

EQPT: LO-TXPOWER (MN) OCN: APS-PRIM-FAC (NA) TRUNK: SSM-ST4 (NA)

EQPT: LOCKOUT-REQ (NA) OCN: APS-PRIM-SEC-MISM (MN) TRUNK: SSM-STU (NA)

EQPT: MAN-REQ (NA) OCN: APSB (MN) TRUNK: SSM-TNC (NA)

EQPT: MANRESET (NA) OCN: APSC-IMP (MN) TRUNK: SYNC-FREQ (NA)

EQPT: MEA (CR) OCN: APSCDFLTK (MN) TRUNK: SYNCLOSS (MJ)

EQPT: MEM-GONE (MJ) OCN: APSCINCON (MN) TRUNK: TIM (CR)

EQPT: MEM-LOW (MN) OCN: APSCM (MN) TRUNK: TIM-MON (MN)

EQPT: NO-CONFIG (NA) OCN: APSCNMIS (MJ) TRUNK: TRAIL-SIGNAL-FAIL (NA)

EQPT: OPEN-SLOT (NA) OCN: APSIMP (MN) TRUNK: UNC-WORD (NA)

EQPT: PROTNA (MN) OCN: APSMM (MN) TRUNK: UT-COMM-FAIL (MJ)

EQPT: PWR-FAIL-A (MN) OCN: AS-CMD (NA) TRUNK: UT-FAIL (MJ)

EQPT: PWR-FAIL-B (MN) OCN: AS-MT (NA) TRUNK: WTR (NA)

EQPT: PWR-FAIL-RET-A (MN) OCN: AUTOLSROFF (CR) TRUNK: WVL-MISMATCH (MJ)

EQPT: PWR-FAIL-RET-B (MN) OCN: BLSR-SW-VER-MISM (MJ) VCG: LOA (CR)

EQPT: RUNCFG-SAVENEED (NA) OCN: BLSROSYNC (MJ) VCG: VCG-DEG (NA)

EQPT: SFTWDOWN (MN) OCN: E-W-MISMATCH (MJ) VCG: VCG-DOWN (NA)

EQPT: SW-MISMATCH (NA) OCN: EOC (MN) VT-MON: AIS-V (NR)

EQPT: SWMTXMOD-PROT (CR) OCN: EOC-L (MN) VT-MON: AUTOSW-AIS (NR)

EQPT: SWMTXMOD-WORK (CR) OCN: EXERCISE-RING-FAIL (NA) VT-MON: AUTOSW-LOP (NA)

EQPT: WKSWPR (NA) OCN: EXERCISE-SPAN-FAIL (NA) VT-MON: AUTOSW-PDI (NA)

EQPT: WORK-QUEUE-FULL (NA) OCN: EXTRA-TRAF-PREEMPT (MJ) VT-MON: AUTOSW-SDBER (NA)

EQPT: WTR (NA) OCN: FAILTOSW (NA) VT-MON: AUTOSW-SFBER (NA)

Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)
2-30
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.4    Alarm List by Logical Object Type
ESCON: ALS (NA) OCN: FAILTOSWR (NA) VT-MON: AUTOSW-UNEQ (NA)

ESCON: AS-CMD (NA) OCN: FAILTOSWS (NA) VT-MON: FAILTOSW-PATH (NA)

ESCON: AS-MT (NA) OCN: FE-FRCDWKSWBK-SPAN 
(NA)

VT-MON: FORCED-REQ (NA)

ESCON: FAILTOSW (NA) OCN: FE-FRCDWKSWPR-RING (NA) VT-MON: LOCKOUT-REQ (NA)

ESCON: FORCED-REQ-SPAN (NA) OCN: FE-FRCDWKSWPR-SPAN (NA) VT-MON: LOP-V (MJ)

ESCON: HI-LASERBIAS (MN) OCN: FE-LOCKOUTOFPR-SPAN 
(NA)

VT-MON: MAN-REQ (NA)

ESCON: HI-RXPOWER (MN) OCN: FE-MANWKSWBK-SPAN (NA) VT-MON: PLM-V (MJ)

ESCON: HI-TXPOWER (MN) OCN: FE-MANWKSWPR-RING (NA) VT-MON: RFI-V (NR)

ESCON: LO-RXPOWER (MN) OCN: FE-MANWKSWPR-SPAN (NA) VT-MON: ROLL (NA)

ESCON: LO-TXPOWER (MN) OCN: FEPRLF (MN) VT-MON: ROLL-PEND (NA)

ESCON: LOCKOUT-REQ (NA) OCN: FORCED-REQ-RING (NA) VT-MON: SD-V (NA)

ESCON: LOS (CR) OCN: FORCED-REQ-SPAN (NA) VT-MON: SF-V (NA)

ESCON: LPBKFACILITY (NA) OCN: FULLPASSTHR-BI (NA) VT-MON: TIM-V (MJ)

ESCON: LPBKTERMINAL (NA) OCN: HELLO (MN) VT-MON: UNEQ-V (MJ)

ESCON: MANUAL-REQ-SPAN (NA) OCN: HI-LASERBIAS (MN) VT-MON: WKSWPR (NA)

ESCON: SIGLOSS (MJ) OCN: HI-LASERTEMP (MN) VT-MON: WTR (NA)

ESCON: SQUELCHED (NA) OCN: HI-RXPOWER (MN) VT-TERM: AIS-V (NR)

ESCON: WKSWPR (NA) OCN: HI-TXPOWER (MN) VT-TERM: AS-MT-OOG (NA)

ESCON: WTR (NA) OCN: ISIS-ADJ-FAIL (MN) VT-TERM: LCAS-CRC (NA)

EXT-SREF: FRCDSWTOPRI (NA) OCN: KB-PASSTHR (NA) VT-TERM: LCAS-RX-DNU (NA)

EXT-SREF: FRCDSWTOSEC (NA) OCN: KBYTE-APS-CHAN-FAIL 
(MN)

VT-TERM: LCAS-RX-FAIL (NA)

EXT-SREF: FRCDSWTOTHIRD (NA) OCN: LASEREOL (MN) VT-TERM: LCAS-RX-GRP-ERR (NA)

EXT-SREF: MANSWTOPRI (NA) OCN: LKOUTPR-S (NA) VT-TERM: LCAS-TX-ADD (NA)

EXT-SREF: MANSWTOSEC (NA) OCN: LMP-FAIL (MN) VT-TERM: LCAS-TX-DNU (NA)

EXT-SREF: MANSWTOTHIRD (NA) OCN: LMP-SD (MN) VT-TERM: LOM (MJ)

EXT-SREF: SWTOPRI (NA) OCN: LMP-SF (MN) VT-TERM: LOP-V (MJ)

EXT-SREF: SWTOSEC (NA) OCN: LMP-UNALLOC (NA) VT-TERM: OOU-TPT (NA)

EXT-SREF: SWTOTHIRD (NA) OCN: LO-LASERBIAS (MN) VT-TERM: PLM-V (MJ)

EXT-SREF: SYNCPRI (MN) OCN: LO-LASERTEMP (MN) VT-TERM: RFI-V (NR)

EXT-SREF: SYNCSEC (MN) OCN: LO-RXPOWER (MN) VT-TERM: ROLL (NA)

EXT-SREF: SYNCTHIRD (MN) OCN: LO-TXPOWER (MN) VT-TERM: ROLL-PEND (NA)

FAN: EQPT-MISS (CR) OCN: LOCKOUT-REQ (NA) VT-TERM: SD-V (NA)

FAN: FAN (CR) OCN: LOF (CR) VT-TERM: SF-V (NA)

FAN: MEA (CR) OCN: LOS (CR) VT-TERM: SQM (MJ)

Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)
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2.5  Trouble Notifications
The ONS 15454 system reports trouble by utilizing standard alarm and condition characteristics, 
standard severities following the rules in Telcordia GR-253-CORE, and graphical user interface (GUI) 
state indicators.These notifications are described in the following paragraphs.

The ONS 15454 uses standard Telcordia categories to characterize levels of trouble. The system reports 
trouble notifications as alarms and status or descriptive notifications (if configured to do so) as 
conditions in the CTC Alarms window. Alarms typically signify a problem that the user needs to remedy, 
such as a loss of signal. Conditions do not necessarily require troubleshooting.

2.5.1  Alarm Characteristics
The ONS 15454 uses standard alarm entities to identify what is causing trouble. All alarms stem from 
hardware, software, environment, or operator-originated problems whether or not they affect service. 
Current alarms for the network, CTC session, node, or card are listed in the Alarms tab. (In addition, 
cleared alarms are also found in the History tab.)

2.5.2  Condition Characteristics
Conditions include any problem detected on an ONS 15454 shelf. They can include standing or transient 
notifications. A snapshot of all current raised, standing conditions on the network, node, or card can be 
retrieved in the CTC Conditions window or using TL1's set of RTRV-COND commands. (In addition, 
some but not all cleared conditions are also found in the History tab.)

For a comprehensive list of all conditions, refer to the Cisco ONS SONET TL1 Command Guide . For 
more information about transient conditions, see Chapter 3, “Transient Conditions.”

Note When an entity is put in the OOS,MT administrative state, the ONS 15454 suppresses all standing alarms 
on that entity and alarms and events appear on the Conditions tab. You can change this behavior for the 
LPBKFACILITY and LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set the 
NODE.general.ReportLoopbackConditionsOnOOS-MTPorts value to TRUE on the NE Defaults tab. For 
more information about changing NE defaults, refer to the “Maintain the Node” chapter in the 
Cisco ONS 15454 Procedure Guide.

2.5.3  Severities
The ONS 15454 uses Telcordia-devised standard severities for alarms and conditions: Critical (CR), 
Major (MJ), Minor (MN), Not Alarmed (NA) and Not Reported (NR). These are described below:

 • A Critical (CR) alarm generally indicates severe, Service-Affecting (SA) trouble that needs 
immediate correction. Loss of traffic on an STS-1, which can hold 28 DS-1 circuits, would be a 
Critical (CR), Service-Affecting (SA) alarm.

FAN: MFGMEM (CR) OCN: LPBKFACILITY (NA) VT-TERM: TIM-V (MJ)

FC: ALS (NA) OCN: LPBKTERMINAL (NA) VT-TERM: UNEQ-V (MJ)

Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)
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 • A Major (MJ) alarm is a serious alarm, but the trouble has less impact on the network. For example, 
loss of traffic on more than five DS-1 circuits is Critical (CR), but loss of traffic on one to four DS-1 
circuits is Major (MJ).

 • Minor (MN) alarms generally are those that do not affect service. For example, the automatic 
protection switching (APS) byte failure (APSB) alarm indicates that line terminating equipment 
(LTE) detects a byte failure on the signal that could prevent traffic from properly executing a traffic 
switch.

 • Not Alarmed (NA) conditions are information indicators, such as for free-run synchronization state 
(FRNGSYNC) or a forced-switch to primary (FRCSWTOPRI) timing event. They could or could 
not require troubleshooting, as indicated in the entries.

 • Not Reported (NR) conditions occur as a secondary result of another event. For example, the alarm 
indication signal (AIS), with severity NR, is inserted by a downstream node when an LOS (CR or 
MJ) alarm occurs upstream. These conditions do not in themselves require troubleshooting, but are 
to be expected in the presence of primary alarms.

Severities can be customized for an entire network or for single nodes, from the network level down to 
the port level by changing or downloading customized alarm profiles. These custom severities are 
subject to the standard severity-demoting rules given in Telcordia GR-474-CORE and shown in the 
“2.5.4  Alarm Hierarchy” section on page 2-33. Procedures for customizing alarm severities are located 
in the “Manage Alarms” chapter in the Cisco ONS 15454 Procedure Guide.

2.5.4  Alarm Hierarchy
All alarm, condition, and unreported event severities listed in this manual are default profile settings. 
However in situations when traffic is not lost, such as when the alarm occurs on protected ports or 
circuits, alarms having Critical (CR) or Major (MJ) default severities can be demoted to lower severities 
such as Minor (MN) or Non-Service-Affecting (NSA) as defined in Telcordia GR-474-CORE. 

A path alarm can be demoted if a higher-ranking alarm is raised for the same object. For example, If a 
path trace identifier mismatch (TIM-P) is raised on a circuit path and then a loss of pointer on the path 
(LOP-P) is raised on the path, the LOP-P alarm stands and the TIM-P closes. The path alarm hierarchy 
used in the ONS 15454 system is shown in Table 2-9.

Facility (port) alarms also follow a hierarchy, which means that lower-ranking alarms are closed by 
higher-ranking alarms. The facility alarm hierarchy used in the ONS 15454 is shown in Table 2-10.

Table 2-9 Path Alarm Hierarchy 

Priority Condition Type

Highest AIS-P

— LOP-P

— UNEQ-P

Lowest TIM-P

Table 2-10 Facility Alarm Hierarchy 

Priority Condition Type

Highest LOS

— LOF
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Near-end failures and far-end failures follow different hierarchies. Near-end failures stand according to 
whether they are for the entire signal (LOS, LOF), facility (AIS-L), path (AIS-P, etc.) or VT (AIS-V, 
etc.). The full hierarchy for near-end failures is shown in Table 2-11. This table is taken from 
Telcordia GR-253-CORE.

— AIS-L

— SF-L

— SD-L

— RFI-L

— TIM-S

— AIS-P

— LOP-P

— SF-P

— SD-P

— UNEQ-P

— TIM-P

Lowest PLM-P

Table 2-10 Facility Alarm Hierarchy (continued)

Priority Condition Type

Table 2-11 Near-End Alarm Hierarchy 

Priority Condition Type

Highest LOS

— LOF

— AIS-L

— AIS-P1

1. Although it is not defined as a defect or failure, all-ones STS pointer relay is also higher 
priority than LOP-P. Similarly, all-ones VT pointer relay is higher priority than LOP-V.

— LOP-P2

2. LOP-P is also higher priority than the far-end failure RFI-P, which does not affect the 
detection of any near-end failures. Similarly, LOP-V is higher priority than RFI-V.

— UNEQ-P

— TIM-P

— PLM-P

— AIS-V1

— LOP-V2

— UNEQ-V

— PLM-V

Lowest DS-N AIS (if reported for outgoing 
DS-N signals)
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2.5.5    Service Effect
The far-end failure alarm hierarchy is shown in Table 2-12, as given in Telcordia GR-253-CORE.

2.5.5  Service Effect
Service-Affecting (SA) alarms—those that interrupt service—could be Critical (CR), Major (MJ), or 
Minor (MN) severity alarms. Service-Affecting (SA) alarms indicate service is affected. 
Non-Service-Affecting (NSA) alarms always have a Minor (MN) default severity. 

2.5.6  States
The Alarms or History tab State (ST) column indicate the disposition of the alarm or condition as 
follows:

 • A raised (R) event is one that is active.

 • A cleared (C) event is one that is no longer active.

 • A transient (T) event is one that is automatically raised and cleared in CTC during system changes 
such as user login, logout, loss of connection to node view, etc. Transient events do not require user 
action. These are listed in Chapter 3, “Transient Conditions.”

2.6  Safety Summary
This section covers safety considerations designed to ensure safe operation of the ONS 15454. Personnel 
should not perform any procedures in this chapter unless they understand all safety precautions, 
practices, and warnings for the system equipment. Some troubleshooting procedures require installation 
or removal of cards; in these instances users should pay close attention to the following caution.

Caution Hazardous voltage or energy could be present on the backplane when the system is operating. Use 
caution when removing or installing cards.

Some troubleshooting procedures require installation or removal of OC-192 cards; in these instances 
users should pay close attention to the following warnings.

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293

Table 2-12 Far-End Alarm Hierarchy 

Priority Condition Type

Highest RFI-L

— RFI-P

Lowest RFI-V
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2.7    Alarm Procedures
Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Warning Class 1 laser product. Statement 1008

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Warning The power supply circuitry for the equipment can constitute an energy hazard. Before you install or 
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects 
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment. 
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the 
equipment. Statement 207

2.7  Alarm Procedures
This section list alarms alphabetically and includes some conditions commonly encountered when 
troubleshooting alarms. The severity, description, and troubleshooting procedure accompany each alarm 
and condition.

Note When you check the status of alarms for cards, ensure that the alarm filter icon in the lower right corner 
of the GUI is not indented. If it is, click it to turn it off. When you are done checking for alarms, you can 
click the alarm filter icon again to turn filtering back on. For more information about alarm filtering, 
refer to the “Manage Alarms” chapter in the Cisco ONS 15454 Procedure Guide.

Note When checking alarms, ensure that alarm suppression is not enabled on the card or port. For more 
information about alarm suppression, refer to the “Manage Alarms” chapter in the Cisco ONS 15454 
Procedure Guide.

Note When an entity is put in the OOS,MT administrative state, the ONS 15454 suppresses all standing alarms 
on that entity and alarms and events appear on the Conditions tab. You can change this behavior for the 
LPBKFACILITY and LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set the 
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2.7.1    AIS
NODE.general.ReportLoopbackConditionsOnPortsInOOS-MT value to TRUE on the NE Defaults tab. 
For more information about changing NE defaults, refer to the “Maintain the Node” chapter in the 
Cisco ONS 15454 Procedure Guide.

2.7.1  AIS 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, DS3, E1, FUDC, MSUDC

DWDM Logical Object: TRUNK 

The Alarm Indication Signal (AIS) condition indicates that this node is detecting an alarm indication 
signal in the incoming signal SONET overhead. 

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit 
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on 
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised, 
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise 
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Note ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the 
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A 
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback.

Clear the AIS Condition

Step 1 Determine whether there are alarms on the upstream nodes and equipment, especially the “LOS (OCN)” 
alarm on page 2-165, or if there are out-of-service (OOS,MT or OOS,DSBLD) ports.

Step 2 Clear the upstream alarms using the applicable procedures in this chapter.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.2  AIS-L 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: EC1, OCN

DWDM Logical Object: TRUNK

The AIS Line condition indicates that this node is detecting line-level AIS in the incoming signal. This 
alarm is secondary to another alarm occurring simultaneously in an upstream node.

This condition can also be raised in conjunction with the “TIM-S” alarm on page 2-247 if AIS-L is 
enabled.
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2.7.3    AIS-P
Note ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the 
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A 
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback.

Clear the AIS-L Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-37.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.3  AIS-P 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM

The AIS Path condition means that this node is detecting AIS in the incoming path. This alarm is 
secondary to another alarm occurring simultaneously in an upstream node.

Clear the AIS-P Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-37.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.4  AIS-V 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: VT-MON, VT-TERM

The AIS VT condition means that this node is detecting AIS in the incoming VT-level path.

See the “1.11.2  AIS-V on DS3XM-6 or DS3XM-12 Unused VT Circuits” section on page 1-136 for 
more information.

Clear the AIS-V Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-37.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.5    ALS
2.7.5  ALS 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.6  AMPLI-INIT 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.7  APC-CORR-SKIPPED 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.8  APC-DISABLED 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.9  APC-END 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.10  APC-OUT-OF-RANGE 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.11  APC-WRONG-GAIN
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.12  APSB 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The APS Channel Byte Failure alarm occurs when LTE detects protection switching byte failure or an 
invalid switching code in the incoming APS signal. Some older SONET not manufactured by Cisco send 
invalid APS codes if they are configured in a 1+1 protection group with newer SONET nodes, such as 
the ONS 15454. These invalid codes cause an APSB alarm on an ONS 15454.
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2.7.13    APSCDFLTK
Step 1 Use an optical test set to examine the incoming SONET overhead to confirm inconsistent or invalid 
K bytes. For specific procedures to use the test set equipment, consult the manufacturer. If corrupted 
K bytes are confirmed and the upstream equipment is functioning properly, the upstream equipment 
might not interoperate effectively with the ONS 15454.

Step 2 If the alarm does not clear and the overhead shows inconsistent or invalid K bytes, you could need to 
replace the upstream cards for protection switching to operate properly. Complete the “Physically 
Replace a Traffic Card” procedure on page 2-274. 

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.13  APSCDFLTK
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The APS Default K Byte Received alarm occurs during bidirectional line switched ring (BLSR) 
provisioning or when a BLSR is not properly configured, for example, when a four-node BLSR has one 
node configured as a path protection configuration. When this misconfiguration occurs, a node in a path 
protection or 1+1 configuration does not send the two valid K1/K2 APS bytes anticipated by a system 
configured for BLSR. One of the bytes sent is considered invalid by the BLSR configuration. The K1/K2 
byte is monitored by receiving equipment for link-recovery information.

Troubleshooting for APSCDFLTK is often similar to troubleshooting for the “BLSROSYNC” alarm on 
page 2-58.

Clear the APSCDFLTK Alarm

Step 1 Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-262 to verify that 
each node has a unique node ID number.

Step 2 Repeat Step 1 for all nodes in the ring.

Step 3 If two nodes have the same node ID number, complete the “Change a BLSR Node ID Number” procedure 
on page 2-262 to change one node ID number so that each node ID is unique.

Step 4 If the alarm does not clear, verify correct configuration of east port and west port optical fibers. (See the 
“E-W-MISMATCH” alarm on page 2-91.) West port fibers must connect to east port fibers and east port 
fibers must connect to west port fibers. The “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide provides procedures for fibering BLSRs.

Step 5 If the alarm does not clear and the network is a four-fiber BLSR, ensure that each protect fiber is 
connected to another protect fiber and each working fiber is connected to another working fiber. The 
software does not report any alarm if a working fiber is incorrectly attached to a protect fiber.

Step 6 If the alarm does not clear, complete the “Verify Node Visibility for Other Nodes” procedure on 
page 2-262.

Step 7 If nodes are not visible, complete the “Verify or Create Node Section DCC Terminations” procedure on 
page 2-276 to ensure that section data communications channel (SDCC) terminations exist on each node.
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2.7.14    APSC-IMP
Step 8 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.14  APSC-IMP 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

An Improper SONET APS Code alarm indicates three consecutive, identical frames containing:

 • Unused code in bits 6 through 8 of byte K2.

 • Codes that are irrelevant to the specific protection switching operation being requested.

 • Requests that are irrelevant to the ring state of the ring (such as a span protection switch request in 
a two-fiber ring NE).

 • ET code in K2 bits 6 through 8 received on the incoming span, but not sourced from the outgoing 
span.

Note This alarm can occur on a VT tunnel when it does not have VT circuits provisioned on it. It can also 
occur when the exercise command or a lockout is applied to a span. An externally switched span does 
not raise this alarm because traffic is preempted. 

Note The APSC-IMP alarm may be raised on a BLSR or MS-SPRing when a drop connection is part of a 
cross-connect loopback.

Note The APSC-IMP alarm may be momentarily raised on BLSR spans during PCA circuit creation or 
deletion across multiple nodes using CTC.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the APSC-IMP Alarm

Step 1 Use an optical test set to determine the validity of the K byte signal by examining the received signal. 
For specific procedures to use the test set equipment, consult the manufacturer.
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2.7.15    APSCINCON
Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the K byte is invalid, the problem lies with upstream equipment and not with the reporting ONS 15454. 
Troubleshoot the upstream equipment using the procedures in this chapter, as applicable. If the upstream 
nodes are not ONS 15454s, consult the appropriate user documentation.

Step 2 If the K byte is valid, verify that each node has a ring name that matches the other node ring names. 
Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-262.

Step 3 Repeat Step 2 for all nodes in the ring.

Step 4 If a node has a ring name that does not match the other nodes, make that node’s ring name identical to 
the other nodes. Complete the “Change a BLSR Ring Name” procedure on page 2-262.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.15  APSCINCON 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

An APS Inconsistent alarm means that an inconsistent APS byte is present. The SONET overhead 
contains K1/K2 APS bytes that notify receiving equipment, such as the ONS 15454, to switch the 
SONET signal from a working to a protect path when necessary. An inconsistent APS code occurs when 
three consecutive frames contain nonidentical APS bytes, which in turn give the receiving equipment 
conflicting commands about switching.

Clear the APSCINCON Alarm

Step 1 Look for other alarms, especially the “LOS (OCN)” alarm on page 2-165, the “LOF (OCN)” alarm on 
page 2-152, or the “AIS” condition on page 2-37. Clearing these alarms clears the APSCINCON alarm.

Step 2 If an APSINCON alarm occurs with no other alarms, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.16  APSCM 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The APS Channel Mismatch alarm occurs when the ONS 15454 expects a working channel but receives 
a protect channel. In many cases, the working and protect channels are crossed and the protect channel 
is active. If the fibers are crossed and the working line is active, the alarm does not occur. The APSCM 
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alarm occurs only on the ONS 15454 when bidirectional protection is used on OC-N cards in a 1+1 
protection group configuration. The APSCM alarm does not occur in an optimized 1+1 protection 
configuration.

Warning On the ONS 15454 OC-192 card, the laser is on when the card is booted and the safety key is in the on 
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when 
the safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the APSCM Alarm

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Verify that the working-card channel fibers are physically connected directly to the adjoining node’s 
working-card channel fibers.

Step 2 If the fibers are correctly connected, verify that the protection-card channel fibers are physically 
connected directly to the adjoining node’s protection-card channel fibers.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.17  APSCNMIS 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: OCN

The APS Node ID Mismatch alarm occurs when the source node ID contained in the incoming APS 
channel K2 byte is not present in the ring map. The APSCNMIS alarm could occur and clear when a 
BLSR is being provisioned. If so, you can disregard the temporary occurrence. If the APSCNMIS 
remains, the alarm clears when a K byte with a valid source node ID is received.
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Clear the APSCNMIS Alarm

Step 1 Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-262 to verify that 
each node has a unique node ID number.

Step 2 If the Node ID column contains any two nodes with the same node ID listed, record the repeated node ID.

Step 3 Click Close in the Ring Map dialog box.

Step 4 If two nodes have the same node ID number, complete the “Change a BLSR Node ID Number” procedure 
on page 2-262 to change one node ID number so that each node ID is unique.

Note If the node names shown in the network view do not correlate with the node IDs, log into each 
node and click the Provisioning > BLSR tabs. The BLSR window shows the node ID of the 
login node.

Note Applying and removing a lockout on a span causes the ONS node to generate a new K byte. The 
APSCNMIS alarm clears when the node receives a K byte containing the correct node ID.

Step 5 If the alarm does not clear, use the “Initiate a Lockout on a BLSR Protect Span” procedure on page 2-269 
to lock out the span.

Step 6 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270 to clear the 
lockout.

Step 7 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.18  APSIMP 
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

SONET Logical Object: OCN

The APS Invalid Code alarm occurs if a 1+1 protection group is not properly configured at both nodes 
to send or receive the correct APS byte. A node that is either configured for no protection or is configured 
for path protection or BLSR protection does not send the right K2 APS byte anticipated by a system 
configured for 1+1 protection. The 1+1 protect port monitors the incoming K2 APS byte and raises this 
alarm if it does not receive the byte.

The alarm is superseded by an APSCM or APSMM alarm, but not by an AIS condition. It clears when 
the port receives a valid code for 10 ms. 

Clear the APSIMP Alarm

Step 1 Check the configuration of the other node in the 1+1 protection group. If the far end is not configured 
for 1+1 protection, create the group. For procedures, refer to the “Turn Up Node” chapter in the 
Cisco ONS 15454 Procedure Guide.
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Step 2 If the other end of the group is properly configured or the alarm does not clear after you have provisioned 
the group correctly, verify that the working ports and protect ports are cabled correctly.

Step 3 Ensure that both protect ports are configured for SONET.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.19  APS-INV-PRIM
Default Severity: Minor (MN), Non-Service Affecting (NSA)

SONET Logical Object: OCN

The Optimized 1+1 APS Primary Facility condition occurs on OC-N cards in an optimized 1+1 
protection system if the incoming primary section header does not indicate whether it is primary or 
secondary.

Note APS-INV-PRIM is an informational condition and does not require troubleshooting. If the APS switch 
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

2.7.20  APSMM 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

An APS Mode Mismatch failure alarm occurs on OC-N cards when there is a mismatch of the protection 
switching schemes at the two ends of the span, such as being bidirectional at one end and unidirectional 
at the other. Each end of a span must be provisioned the same way: bidirectional and bidirectional, or 
unidirectional and unidirectional. APSMM can also occur if third-party equipment is provisioned as 1:N 
and the ONS 15454 is provisioned as 1+1.

If one end is provisioned for 1+1 protection switching and the other is provisioned for path protection 
protection switching, an APSMM alarm occurs in the ONS 15454 that is provisioned for 1+1 protection 
switching. 

Clear the APSMM Alarm

Step 1 For the reporting ONS 15454, display node view and verify the protection scheme provisioning:

a. Click the Provisioning > Protection tabs.

b. Click the 1+1 protection group configured for the OC-N cards.

The chosen protection group is the protection group optically connected (with data communications 
channel, or DCC, connectivity) to the far end.

c. Click Edit.

d. Record whether the Bidirectional Switching check box is checked.

Step 2 Click OK in the Edit Protection Group dialog box.
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Step 3 Log into the far-end node and verify that the OC-N 1+1 protection group is provisioned.

Step 4 Verify that the Bidirectional Switching check box matches the checked or unchecked condition of the 
box recorded in Step 1. If not, change it to match.

Step 5 Click Apply.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.21  APS-PRIM-FAC
Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)

SONET Logical Object: OCN

The Optimized 1+1 APS Invalid Primary Section condition occurs on OC-N cards in an optimized 1+1 
protection system if there is an APS status switch between the primary and secondary facilities to 
identify which port is primary.

Note APS-PRIM-FAC is an informational condition and does not require troubleshooting. If the APS switch 
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

Clear the APS-PRIM-FAC Condition

Step 1 This condition clears when the card receives a valid primary section indication (1 or 2).

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.22  APS-PRIM-SEC-MISM
Default Severity: Minor (MN), Non-Service Affecting (NSA)

SONET Logical Object: OCN

The Optimized 1+1 APS Primary Section Mismatch condition occurs on OC-N cards in an optimized 
1+1 protection system if there is a mismatch between the primary section of the local node facility and 
the primary section of the remote-node facility.

Clear the APS-PRIM-SEC-MISM Alarm

Step 1 Ensure that the local node and remote-node ports are correctly provisioned the same way. For more 
information about optimized 1+1 configurations, refer to the “Turn Up Node” chapter in the 
Cisco ONS 15454 Procedure Guide.
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Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.23  AS-CMD 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BPLANE, CEMR, CE1000, CE100T, DS1, DS3, E1, E1000F, E100T, 
EC1, EQPT, FCMR, G1000, GFP-FAC, ML1000, ML100T, MLFX, NE, OCN, PWR

DWDM Logical Objects: 2R, AOTS, ESCON, FC, GE, ISC, OCH, OMS, OTS, PPM, SHELF, 
TRUNK

The Alarms Suppressed by User Command condition applies to the network element (NE object), 
backplane, a single card, or a port on a card. It occurs when alarms are suppressed for that object and its 
subordinate objects. For example, suppressing alarms on a card also suppresses alarms on its ports. 

Note For more information about suppressing alarms, refer to the “Manage Alarms” chapter in the 
Cisco ONS 15454 Procedure Guide.

Clear the AS-CMD Condition

Step 1 For all nodes, in node view, click the Conditions tab.

Step 2 Click Retrieve. If you have already retrieved conditions, look under the Object column and Eqpt Type 
column and note what entity the condition is reported against, such as a port, slot, or shelf.

 • If the condition is reported against a slot and card, alarms were either suppressed for the entire card 
or for one of the ports. Note the slot number and continue with Step 3.

 • If the condition is reported against the backplane, go to Step 7.

 • If the condition is reported against the NE object, go to Step 8.

Step 3 Determine whether alarms are suppressed for a port and if so, raise the suppressed alarms:

a. Double-click the card to open the card view.

b. Click the Provisioning > Alarm Profiles > Alarm Behavior tabs and complete one of the following 
substeps:

 • If the Suppress Alarms column check box is checked for a port row, deselect it and click Apply.

 • If the Suppress Alarms column check box is not checked for a port row, from the View menu 
choose  Go to Previous View.

Step 4 If the AS-CMD condition is reported for a card and not an individual port, in node view click the 
Provisioning > Alarm Profiles > Alarm Behavior tabs. 

Step 5 Locate the row number for the reported card slot.

Step 6 Click the Suppress Alarms column check box to deselect the option for the card row.

Step 7 If the condition is reported for the backplane, the alarms are suppressed for cards such as the ONS 15454 
AIP that are not in the optical or electrical slots. To clear the alarm, complete the following steps:

a. In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs.
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b. In the backplane row, uncheck the Suppress Alarms column check box.

c. Click Apply.

Step 8 If the condition is reported for the shelf, cards and other equipment are affected. To clear the alarm, 
complete the following steps:

a. In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs if you have not 
already done so. 

b. Click the Suppress Alarms check box located at the bottom of the window to deselect the option.

c. Click Apply.

Step 9 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.24  AS-MT 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: CEMR, CE1000, CE100T, DS1, DS3, E1, EC1, EQPT, FCMR, G1000, 
GFP-FAC, ML1000, ML100T, MLFX, OCN

DWDM Logical Objects: 2R, AOTS, ESCON, FC, GE, ISC, OCH, OMS, OTS, PPM, SHELF, 
TRUNK

The Alarms Suppressed for Maintenance Command condition applies to OC-N and electrical cards and 
occurs when a port is placed in the Out-of-Service and Management, Maintenance (OOS-MA,MT) 
service state for loopback testing operations.

Clear the AS-MT Condition

Step 1 Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-277.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.25  AS-MT-OOG 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSTRM, VT-TERM

The Alarms Suppressed on an Out-Of-Group VCAT Member condition is raised on an STS or VT 
member of a VCAT group whenever the member is in the IDLE (AS-MT-OOG) admin state. This 
condition can be raised when a member is initially added to a group. In the IDLE (AS-MT-OOG) state, 
all other alarms for the STS or VT are suppressed.

The AS-MT-OOG condition clears when an STS or VT member transitions to a different state from IDLE 
(AS-MT-OOG) or when the member is removed completely from the VCAT group. The condition does 
not require troubleshooting unless it does not clear.
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If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.26  AUD-LOG-LOSS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE

The Audit Trail Log Loss condition occurs when the log is 100 percent full and the oldest entries are 
being replaced while new entries are generated. The log capacity is 640 entries. The log must be 
off-loaded using the following procedure to make room for more entries. 

Clear the AUD-LOG-LOSS Condition

Step 1 In node view, click the Maintenance > Audit tabs.

Step 2 Click Retrieve.

Step 3 Click Archive.

Step 4 In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 5 Enter a name in the File Name field.

You do not have to assign an extension to the file. It is readable in any application that supports text files, 
such as WordPad, Microsoft Word (imported), etc.

Step 6 Click Save.

The 640 entries are saved in this file. New entries continue with the next number in the sequence, rather 
than starting over.

Step 7 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.27  AUD-LOG-LOW
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE

The Audit Trail Log Low condition occurs when the audit trail log is 80 percent full.

Note AUD-LOG-LOW is an informational condition and does not require troubleshooting.

2.7.28  AUTOLSROFF 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: OCN
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The Auto Laser Shutdown alarm occurs when the OC-192 card temperature exceeds 194 degrees F 
(90 degrees C). The internal equipment automatically shuts down the OC-192 laser when the card 
temperature rises to prevent the card from self-destructing.

Warning On the ONS 15454 OC-192 card, the laser is on when the card is booted and the safety key is in the on 
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when 
the safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the AUTOLSROFF Alarm

Step 1 View the temperature displayed on the ONS 15454 LCD front panel (Figure 2-1).

Figure 2-1 Shelf LCD Panel

Step 2 If the temperature of the shelf exceeds 194 degrees F (90 degrees C), the alarm should clear if you solve 
the ONS 15454 temperature problem. Complete the “Clear the HITEMP Alarm” procedure on 
page 2-125.

Step 3 If the temperature of the shelf is under 194 degrees F (90 degrees C), the HITEMP alarm is not the cause 
of the AUTOLSROFF alarm. Complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the OC-192 card.

Step 4 If card replacement does not clear the alarm, call Cisco TAC 1 800 553-2447 to discuss the case and if 
necessary open a returned materials authorization (RMA) on the original OC-192 card.

2.7.29  AUTONEG-RFI
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: ML1000

FAN FAIL

Slot

8/18/03
04.06-002L-10 

24˚C
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2.7.30    AUTORESET
The autonegotiation remote fault indication (RFI) indicates that an ML1000 Gigabit Ethernet port cannot 
detect its far-end link partner. This is typically caused by a far-end port shutdown or a unidirectional fiber 
cut. The partner node is likely raising a CARLOSS alarm.

AUTONEG-RFI may also be caused by misconfigured autonegotiation parameters. This causes more of 
a soft failure as opposed to the “CARLOSS (ML1000, ML100T, MLFX)” alarm on page 2-66, which is 
typically caused by a failure like a loss of light or optical fiber. The alarm clears when the partner node 
is detected.

Note The far end of an Ethernet link is usually a switch or router that does not use an ONS management 
system.

Clear the AUTONEG-RFI Alarm

Step 1 Check for the “CARLOSS (EQPT)” alarm on page 2-61 or the “CARLOSS (ML1000, ML100T, 
MLFX)” alarm on page 2-66 at the partner node. If the alarm exists there, follow the appropriate clearing 
procedure in this chapter.

Step 2 If the alarm does not clear or if there is no far-end CARLOSS, check the near-end Gigabit Ethernet port 
autonegotiation settings:

a. Double-click the ML1000 card to display the card view.

b. Click the upper IOS tab, then click Open IOS Connection.

c. In Privileged Executive mode, enter the following command:

router# show interface gigabitethernet 0

d. View the command output and record the autonegotiation setting, such as the following example:

Full-duplex, 1000Mb/s, Gbic not connected, Auto-negotiation
output flow-control is off, input flow-control is on

Step 3 View the autonegotiation configuration for the partner node. If it is ONS equipment, follow the previous 
step for this node. If the node is different vendor client equipment, follow that equipment documentation 
to obtain the information.

Step 4 If the alarm does not clear, check for any fiber breaks such as on the transmit cable from the partner node 
to the near-end node.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.30  AUTORESET 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Automatic System Reset alarm occurs when you change an IP address or perform any other 
operation that causes an automatic card-level reboot. AUTORESET typically clears after a card reboots 
(up to ten minutes).
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Resets performed during a software upgrade also prompt the condition. This condition clears 
automatically when the card finishes resetting. If the alarm does not clear, complete the following 
procedure.

Clear the AUTORESET Alarm

Step 1 Determine whether there are additional alarms that could have triggered an automatic reset. If there are, 
troubleshoot these alarms using the applicable section of this chapter.

Step 2 If the card automatically resets more than once a month with no apparent cause, complete the “Physically 
Replace a Traffic Card” procedure on page 2-274.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.31  AUTOSW-AIS 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, VT-MON

The Automatic Path Protection Switch Caused by an AIS condition indicates that automatic path 
protection switching occurred because of an AIS condition. If the path protection is configured for 
revertive switching, it reverts to the working path after the fault clears. The AIS also clears when the 
upstream trouble is cleared.

Note This condition is only reported if the path protection is set up for revertive switching. 

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit 
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on 
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised, 
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise 
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AUTOSW-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-37.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.32  AUTOSW-LOP (STSMON) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: STSMON
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2.7.33    AUTOSW-LOP (VT-MON)
The Automatic Path Protection Switch Caused by LOP condition for the STS monitor (STSMON) 
indicates that automatic path protection switching occurred because of the “LOP-P” alarm on 
page 2-155. If the path protection is configured for revertive switching, it reverts to the working path 
after the fault clears.

Note This condition is only reported if the path protection is set up for revertive switching. 

Clear the AUTOSW-LOP (STSMON) Condition

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-156.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.33  AUTOSW-LOP (VT-MON) 
Default Severity: Not Alarmed (NA), Service-Affecting (SA)

SONET Logical Object: VT-MON

The AUTOSW-LOP alarm for the VT monitor (VT-MON) indicates that automatic path protection 
switching occurred because of the “LOP-V” alarm on page 2-156. If the path protection is configured 
for revertive switching, it reverts to the working path after the fault clears.

Note This condition is only reported if the path protection is set up for revertive switching. 

Clear the AUTOSW-LOP (VT-MON) Condition

Step 1 Complete the “Clear the LOP-V Alarm” procedure on page 2-157.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.34  AUTOSW-PDI 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: STSMON, VT-MON

The Automatic Path Protection Switch Caused by Payload Defect Indication (PDI) condition indicates 
that automatic path protection switching occurred because of a “PDI-P” alarm on page 2-194. If the path 
protection is configured for revertive switching, it reverts to the working path after the fault clears.
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Note This condition is only reported if the path protection is set up for revertive switching. 

Clear the AUTOSW-PDI Condition

Step 1 Complete the “Clear the PDI-P Condition” procedure on page 2-195.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.35  AUTOSW-SDBER
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STSMON, VT-MON

The Automatic Path Protection Switch Caused by Signal Degrade Bit Error Rate (SDBER) condition 
indicates that a “SD-P” condition on page 2-221 caused automatic path protection switching to occur. If 
the path protection is configured for revertive switching, the path protection reverts to the working path 
when the SD-P is resolved.

Note This condition is only reported if the path protection is set up for revertive switching. 

Clear the AUTOSW-SDBER Condition

Step 1 Complete the “Clear the SD-P Condition” procedure on page 2-222.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.36  AUTOSW-SFBER 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STSMON, VT-MON

The Automatic USPR Switch Caused by Signal Fail Bit Error Rate (SFBER) condition indicates that a 
“SF-P” condition on page 2-225 caused automatic path protection switching to occur. If the path 
protection is configured for revertive switching, the path protection reverts to the working path when the 
SF-P is resolved.

Note This condition is only reported if the path protection is set up for revertive switching. 
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Clear the AUTOSW-SFBER Condition

Step 1 Complete the “Clear the SF-P Condition” procedure on page 2-225.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.37  AUTOSW-UNEQ (STSMON) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: STSMON

The Automatic Path Protection Switch Caused by Unequipped condition indicates that an “UNEQ-P” 
alarm on page 2-253, caused automatic path protection switching to occur. If the path protection is 
configured for revertive switching, it reverts to the working path after the fault clears.

Note This condition is only reported if the path protection is set up for revertive switching. 

Clear the AUTOSW-UNEQ (STSMON) Condition

Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-253.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.38  AUTOSW-UNEQ (VT-MON)
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: VT-MON

AUTOSW-UNEQ (VT-MON) indicates that the “UNEQ-V” alarm on page 2-255 caused automatic path 
protection switching to occur. If the path protection is configured for revertive switching, it reverts to the 
working path after the fault clears. 

Note This condition is only reported if the path protection is set up for revertive switching. 

Clear the AUTOSW-UNEQ (VT-MON) Condition

Step 1 Complete the “Clear the UNEQ-V Alarm” procedure on page 2-255. 
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Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA) 
problem. 

2.7.39  AWG-DEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.40  AWG-FAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.41  AWG-OVERTEMP 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.42  AWG-WARM-UP 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.43  BAT-FAIL 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: PWR

The Battery Fail alarm occurs when one of the two power supplies (A or B) is not detected. This could 
be because the supply is removed or is not operational. The alarm does not distinguish between the 
individual power supplies, so onsite information about the conditions is necessary for troubleshooting.

Clear the BAT-FAIL Alarm

Step 1 At the site, determine which battery is not present or operational.

Step 2 Remove the power cable from the faulty supply. For procedures, refer to the “Install the Shelf and 
Backplane Cable” chapter in the Cisco ONS 15454 Procedure Guide. Reverse the power cable 
installation procedure.
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Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.44  BERT-ENBL
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Object: DS1/DS3

The Bert Enabled alarm specifies that the bit error rate testing (BERT) feature is enabled.

2.7.45  BERT-SYNC-FAIL
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Object: DS1/DS3

The Bert Synchronization Fail alarm occurs when the errors injected by the Test Pattern Generator (TPG) 
reaches the Test Pattern Monitor (TPM) and connectivity fails. This alarm clears when TPG and TPM 
synchronize.

2.7.46  BKUPMEMP
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

The Primary Nonvolatile Backup Memory Failure alarm refers to a problem with the TCC2/TCC2P flash 
memory. The alarm occurs when the TCC2/TCC2P is in use and has one of four problems: 

 • Flash manager fails to format a flash partition.

 • Flash manager fails to write a file to a flash partition.

 • Problem at the driver level.

 • Code volume fails cyclic redundancy checking (CRC, a method to verify for errors in data 
transmitted to the TCC2/TCC2P).

The BKUPMEMP alarm can also cause the “EQPT” alarm on page 2-86. If the EQPT alarm is caused 
by BKUPMEMP, complete the following procedure to clear the BKUPMEMP and the EQPT alarm.

Caution A software update on a standby TCC2/TCC2P can take up to 30 minutes.

Clear the BKUPMEMP Alarm

Step 1 Verify that both TCC2/TCC2Ps are powered and enabled by confirming lighted ACT/SBY LEDs on the 
TCC2/TCC2Ps.

Step 2 Determine whether the active or standbyTCC2/TCC2P has the alarm. 
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Step 3 If both TCC2/TCC2Ps are powered and enabled, reset the TCC2/TCC2P where the alarm is raised. If the 
card is the active TCC2/TCC2P, complete the “Reset an Active TCC2/TCC2P Card and Activate the 
Standby Card” procedure on page 2-271. If the card is the standby TCC2/TCC2P:

a. Right-click the standby TCC2/TCC2P in CTC.

b. Choose Reset Card from the shortcut menu.

c. Click Yes in the Are You Sure dialog box. The card resets, the FAIL LED blinks on the physical card.

d. Wait ten minutes to verify that the card you reset completely reboots.

Step 4 If the TCC2/TCC2P you reset does not reboot successfully, or the alarm has not cleared, call Cisco TAC 
1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and 
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-273. If the Cisco TAC 
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic 
Card” procedure on page 2-274.

2.7.47  BLSROSYNC 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: OCN

The BLSR Out Of Synchronization alarm occurs is raised temporarily during a span upgrade, 
downgrade, or two-fiber to four-fiber mode upgrade and clears when the procedure is complete for all 
nodes on the ring. If the alarm does not clear, ensure that all maintenance procedures have completed for 
all nodes on the ring. If the alarm still does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 in order to 
report a Service-Affecting (SA) problem.

2.7.48  BLSR-SW-VER-MISM 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: OCN

The BLSR Software Version Mismatch alarm is raised by the TCC2/TCC2P when it checks all software 
versions for all nodes in a ring and discovers a mismatch in versions.

Clear the BLSR-SW-VER-MISM Alarm

Step 1 Clear the alarm by loading the correct software version on the TCC2/TCC2P with the incorrect load. To 
download software, refer to the release-specific software download document. 

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a 
Service-Affecting (SA) problem.
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2.7.49  BPV
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: BITS

The 64K Clock Bipolar Density Violation alarm is raised on the TCC2P card if there is a frequency 
variation in the 8K BITS clock. 

The TCC2P card contains an 8K clock and a 64K clock. Each has some bipolar variation, which is 
normal. This alarm is raised on the 8K clock if that variation discontinues. The BPV alarm is demoted 
by an LOF or LOS against the BITS clock.

Note This alarm is not raised on the TCC2 card.

Clear the BPV Alarm

Step 1 Reestablishing a normal BITS input signal clears the alarm. Clear any alarms on the incoming signal or 
against the BITS timing sources. 

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.50  CARLOSS (CEMR, CE1000, CE100T) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: CEMR, CE1000, CE100T

The Carrier Loss alarm is raised on CE-Series cards in Mapper mode when the port is In-Service (IS) state 
and if there is no carrier signal. Circuit need not be present to raise the alarm. In releases prior to 6.01 the 
Carrier Loss alarm is raised on CE-100T-8 cards in Mapper mode when there is a circuit failure due to link 
integrity. It does not get raised when a user simply puts the port in the In-Service and Normal (IS-NR) service 
state.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the CARLOSS (CEMR, CE1000, CE100T) Alarm

Step 1 Complete the “Clear the CARLOSS (G1000) Alarm” procedure on page 2-64. However, rather than 
checking for a TPTFAIL (G1000) at the end of the procedure, check for a “TPTFAIL (CEMR, CE100T, 
CE1000)” alarm on page 2-248.
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Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.51  CARLOSS (E1000F, E100T) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: E1000F, E100T 

A Carrier Loss alarm on the LAN E-Series Ethernet card is the data equivalent of the “LOS (OCN)” 
alarm on page 2-165. The Ethernet card has lost its link and is not receiving a valid signal. The most 
common causes of the CARLOSS alarm are a disconnected cable, an Ethernet Gigabit Interface 
Converter (GBIC) fiber connected to an optical card rather than an Ethernet device, or an improperly 
installed Ethernet card. Ethernet card ports must be enabled for CARLOSS to occur. CARLOSS is 
declared after no signal is received for approximately 2.5 seconds.

The CARLOSS alarm also occurs after a node database is restored. After restoration, the alarm clears in 
approximately 30 seconds after the node reestablishes Spanning Tree Protocol (STP). 

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the CARLOSS (E1000F, E100T) Alarm

Step 1 Verify that the fiber cable is properly connected and attached to the correct port. For more information 
about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in 
the Cisco ONS 15454 Procedure Guide.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If the fiber cable is properly connected and attached to the port, verify that the cable connects the card 
to another Ethernet device and is not misconnected to an OC-N card. For more information about fiber 
connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide. 

Step 3 If no misconnection to an OC-N card exists, verify that the transmitting device is operational. If not, 
troubleshoot the device.

Step 4 If the alarm does not clear, use an Ethernet test set to determine whether a valid signal is coming into 
the Ethernet port. For specific procedures to use the test set equipment, consult the manufacturer.

Step 5 If a valid Ethernet signal is not present and the transmitting device is operational, replace the fiber cable 
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and 
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step 6 If a valid Ethernet signal is present, complete the “Remove and Reinsert (Reseat) Any Card” procedure 
on page 2-274 for the Ethernet card.
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Step 7 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the Ethernet card.

Step 8 If a CARLOSS alarm repeatedly appears and clears, use the following steps to examine the layout of 
your network to determine whether the Ethernet circuit is part of an Ethernet manual cross-connect. 

An Ethernet manual cross-connect is used when another vendor’s equipment sits between ONS 15454 
nodes, and the open systems interconnect/target identifier address resolution protocol 
(OSI/TARP)-based equipment does not allow tunneling of the ONS 15454 TCP/IP-based DCC. To 
circumvent a lack of continuous DCC, the Ethernet circuit is manually cross connected to an STS 
channel riding through the non-ONS network. 

If the reporting Ethernet circuit is part of an Ethernet manual cross-connect, complete the following 
steps. The reappearing alarm could be a result of mismatched STS circuit sizes in the set up of the manual 
cross-connect. If the Ethernet circuit is not part of a manual cross-connect, the following steps do not 
apply. 

a. Right-click anywhere in the row of the CARLOSS alarm.

b. Click Select Affected Circuits in the shortcut menu that appears.

c. Record the information in the type and size columns of the highlighted circuit.

d. From the examination of the layout of your network, determine which ONS 15454 and card and card 
are hosting the Ethernet circuit at the other end of the Ethernet manual cross-connect and complete 
the following substeps:

 • Log into the ONS 15454 at the other end of the Ethernet manual cross-connect.

 • Double-click the Ethernet card that is part of the Ethernet manual cross-connect.

 • Click the Circuits tab.

 • Record the information in the type and size columns of the circuit that is part of the Ethernet 
manual cross-connect. The Ethernet manual cross-connect circuit connects the Ethernet card to 
an OC-N card at the same node.

e. Use the information you recorded to determine whether the two Ethernet circuits on each side of the 
Ethernet manual cross-connect have the same circuit size.

If one of the circuit sizes is incorrect, complete the “Delete a Circuit” procedure on page 2-276 and 
reconfigure the circuit with the correct circuit size. For more information, refer to the “Create 
Circuits and VT Tunnels” chapter in the Cisco ONS 15454 Procedure Guide.

Step 9 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.52  CARLOSS (EQPT) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: EQPT

A Carrier Loss on the LAN Equipment alarm generally occurs on OC-N cards when the ONS 15454 and 
the workstation hosting CTC do not have a TCP/IP connection. The problem involves the LAN or data 
circuit used by the RJ-45 (LAN) connector on the TCC2/TCC2P or the LAN backplane pin connection. 
This CARLOSS alarm does not involve an Ethernet circuit connected to an Ethernet port. The problem 
is in the connection and not CTC or the node.
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On TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G or MXP_2.5G_10G cards, CARLOSS is also 
raised against trunk ports when ITU-T G.709 monitoring is turned off. 

A TXP_MR_2.5G card can raise a CARLOSS alarm when the payload is incorrectly configured for the 
10 Gigabit Ethernet or 1 Gigabit Ethernet payload data types.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Note For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and 
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about 
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual. For more information 
about MRC-12, MRC-4, and OC192-XFP/STM64-XFP cards, refer to the “Optical Cards” chapter in the 
Cisco ONS 15454 Reference Manual. For more information about Ethernet cards, refer to the “Ethernet 
Cards” chapter in the Cisco ONS 15454 Reference Manual.

Clear the CARLOSS (EQPT) Alarm

Step 1 If the reporting card is an MXP or TXP card in an ONS 15454 node, verify the data rate configured on 
the pluggable port module (PPM):

a. Double-click the reporting MXP or TXP card.

b. Click the Provisioning > Pluggable Port Modules tabs.

c. View the Pluggable Port Modules area port listing in the Actual Equipment Type column and 
compare this with the contents of the Selected PPM area Rate column for the MXP or TXP multirate 
port.

d. If the rate does not match the actual equipment, you must delete and recreate the selected PPM. 
Select the PPM, click Delete, then click Create and choose the correct rate for the port rate. 

Step 2 If the reporting card is an OC-N card, verify connectivity by pinging the ONS 15454 that is reporting 
the alarm by completing the “1.9.8  Verify PC Connection to the ONS 15454 (ping)” procedure on 
page 1-119.

Step 3 If the ping is successful, it demonstrates that an active TCP/IP connection exists. Restart CTC:

a. Exit from CTC.

b. Reopen the browser.

c. Log into CTC.

Step 4 Using optical test equipment, verify that proper receive levels are achieved. (For instructions to use 
optical test equipment, refer to the manufacturer documentation.)
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Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 5 Verify that the optical LAN cable is properly connected and attached to the correct port. For more 
information about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” 
chapter in the Cisco ONS 15454 Procedure Guide.

Step 6 If the fiber cable is properly connected and attached to the port, verify that the cable connects the card 
to another Ethernet device and is not misconnected to an OC-N card. 

Step 7 If you are unable to establish connectivity, replace the fiber cable with a new known-good cable. To do 
this, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure 
Guide. 

Step 8 If you are unable to establish connectivity, perform standard network or LAN diagnostics. For example, 
trace the IP route, verify cable continuity, and troubleshoot any routers between the node and CTC. To 
verify cable continuity, follow site practices.

Step 9 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.53  CARLOSS (FC) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.54  CARLOSS (G1000) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: G1000

A Carrier Loss alarm on the LAN G-Series Ethernet card is the data equivalent of the “LOS (OCN)” 
alarm on page 2-165. The Ethernet card has lost its link and is not receiving a valid signal.

CARLOSS on the G1000-4 card is caused by one of two situations:

 • The G1000-4 port reporting the alarm is not receiving a valid signal from the attached Ethernet 
device. The CARLOSS can be caused by an improperly connected Ethernet cable or a problem with 
the signal between the Ethernet device and the G1000-4 port.

 • If a problem exists in the end-to-end path (including possibly the far-end G1000-4 card), it causes 
the reporting card to turn off the Gigabit Ethernet transmitter. Turning off the transmitter typically 
causes the attached device to turn off its link laser, which results in a CARLOSS on the reporting 
G1000-4 card. The root cause is the problem in the end-to-end path. When the root cause is cleared, 
the far-end G1000-4 port turns the transmitter laser back on and clears the CARLOSS on the 
reporting card. If a turned-off transmitter causes the CARLOSS alarm, other alarms such as the 
“TPTFAIL (G1000)” alarm on page 2-249 or OC-N alarms or conditions on the end-to-end path 
normally accompany the CARLOSS (G1000) alarm.
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Refer to the Cisco ONS 15454 Reference Manual for a description of the G1000-4 card’s end-to-end 
Ethernet link integrity capability. Also see the “TRMT” alarm on page 2-251 for more information about 
alarms that occur when a point-to-point circuit exists between two cards.

Ethernet card ports must be enabled for CARLOSS to occur. CARLOSS is declared after no signal is 
received for approximately 2.5 seconds.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the CARLOSS (G1000) Alarm

Step 1 Verify that the fiber cable is properly connected and attached to the correct port. For more information 
about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in 
the Cisco ONS 15454 Procedure Guide.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If the fiber cable is correctly connected and attached, verify that the cable connects the card to another 
Ethernet device and is not misconnected to an OC-N card.

Step 3 If no misconnection to the OC-N card exists, verify that the attached transmitting Ethernet device is 
operational. If not, troubleshoot the device.

Step 4 Verify that optical receive levels are within the normal range. The correct specifications are listed in the 
“1.12.3  OC-N Card Transmit and Receive Levels” section on page 1-146.

Step 5 If the alarm does not clear, use an Ethernet test set to determine whether a valid signal is coming into 
the Ethernet port. For specific procedures to use the test set equipment, consult the manufacturer.

Step 6 If a valid Ethernet signal is not present and the transmitting device is operational, replace the fiber cable 
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and 
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step 7 If the alarm does not clear, and link autonegotiation is enabled on the port but the autonegotiation process 
fails, the card turns off its transmitter laser and reports a CARLOSS alarm. If link autonegotiation has 
been enabled for the port, determine whether there are conditions that could cause autonegotiation to 
fail:

a. Confirm that the attached Ethernet device has autonegotiation enabled and is configured for 
compatibility with the asymmetric flow control on the card.

b. Confirm that the attached Ethernet device configuration allows reception of flow control frames.

Step 8 If the alarm does not clear, disable and reenable the Ethernet port to attempt to remove the CARLOSS 
condition. (The autonegotiation process restarts.)

Step 9 If the alarm does not clear and the “TPTFAIL (G1000)” alarm on page 2-249 is also reported, complete 
the “Clear the TPTFAIL (G1000) Alarm” procedure on page 2-249. If the TPTFAIL alarm is not raised, 
continue to the next step.
2-64
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.54    CARLOSS (G1000)
Note When the CARLOSS and the TPTFAIL alarms are reported, the reason for the condition could 
be the G1000-4 card's end-to-end link integrity feature taking action on a remote failure 
indicated by the TPTFAIL alarm.

Step 10 If the TPTFAIL alarm was not raised, determine whether a terminal (inward) loopback has been 
provisioned on the port:

a. In node view, click the card to go to card view.

b. Click the Maintenance > Loopback tabs.

c. If the service state is listed as OOS-MA,LPBK&MT, a loopback is provisioned. Go to Step 11. 

Step 11 If a loopback was provisioned, complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” 
procedure on page 2-278.

On the G1000-4, provisioning a terminal (inward) loopback causes the transmit laser to turn off. If an 
attached Ethernet device detects the loopback as a loss of carrier, the attached Ethernet device shuts off 
the transmit laser to the G1000-4 card. Terminating the transmit laser could raise the CARLOSS alarm 
because the loopbacked G1000-4 port detects the termination.

If the does not have a loopback condition, continue to Step 12.

Step 12 If a CARLOSS alarm repeatedly appears and clears, the reappearing alarm could be a result of 
mismatched STS circuit sizes in the setup of the manual cross-connect. Perform the following steps if 
the Ethernet circuit is part of a manual cross-connect:

Note An ONS 15454 Ethernet manual cross-connect is used when another vendor’s equipment sits 
between ONS nodes, and the OSI/TARP-based equipment does not allow tunneling of the 
ONS 15454 TCP/IP-based DCC. To circumvent a lack of continuous DCC, the Ethernet circuit 
is manually cross connected to an STS channel riding through the non-ONS network.

a. Right-click anywhere in the row of the CARLOSS alarm.

b. Right-click or left-click Select Affected Circuits in the shortcut menu that appears.

c. Record the information in the type and size columns of the highlighted circuit.

d. Examine the layout of your network and determine which ONS 15454 and card are hosting the 
Ethernet circuit at the other end of the Ethernet manual cross-connect and complete the following 
substeps:

 • Log into the node at the other end of the Ethernet manual cross-connect.

 • Double-click the Ethernet card that is part of the Ethernet manual cross-connect.

 • Click the Circuits tab.

 • Record the information in the type and size columns of the circuit that is part of the Ethernet 
manual cross-connect. The cross-connect circuit connects the Ethernet card to an OC-N card at 
the same node.

e. Determine whether the two Ethernet circuits on each side of the Ethernet manual cross-connect have 
the same circuit size from the circuit size information you recorded.

f. If one of the circuit sizes is incorrect, complete the “Delete a Circuit” procedure on page 2-276 and 
reconfigure the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” 
chapter in the Cisco ONS 15454 Procedure Guide for detailed procedures to create circuits.
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Step 13 If a valid Ethernet signal is present, complete the “Remove and Reinsert (Reseat) Any Card” procedure 
on page 2-274.

Step 14 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the Ethernet card.

Step 15 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.55  CARLOSS (GE) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.56  CARLOSS (ISC) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.57  CARLOSS (ML1000, ML100T, MLFX) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: ML1000, ML100T, MLFX

A Carrier Loss alarm on an ML-Series Ethernet card is the data equivalent of the “LOS (OCN)” alarm 
on page 2-165. The Ethernet port has lost its link and is not receiving a valid signal.

A CARLOSS alarm occurs when the Ethernet port has been configured from the Cisco IOS command 
line interface (CLI) as a no-shutdown port and one of the following problems also occurs:

 • The cable is not properly connected to the near or far port.

 • Autonegotiation is failing (which raises the “AUTONEG-RFI” alarm on page 2-50).

 • The speed (10/100 ports only) is set incorrectly.

Note For information about provisioning ML-Series Ethernet cards from the Cisco IOS interface, refer to the 
Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide.

Clear the CARLOSS (ML1000, ML100T, MLFX) Alarm

Step 1 Verify that the LAN cable is properly connected and attached to the correct port on the ML-Series card 
and on the peer Ethernet port. For more information about fiber connections and terminations, refer to 
the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide. 

Step 2 If the alarm does not clear, verify that autonegotiation is set properly on the ML-Series card port and the 
peer Ethernet port.
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Step 3 If the alarm does not clear, verify that the speed is set properly on the ML-Series card port and the peer 
Ethernet port if you are using 10/100 ports.

Step 4 If the alarm does not clear, the Ethernet signal is not valid, but the transmitting device is operational, 
replace the LAN cable connecting the transmitting device to the Ethernet port.

Step 5 If the alarm does not clear, disable and reenable the Ethernet port by performing a “shutdown” and then 
a “no shutdown” on the Cisco IOS CLI as in the following example:

router(config)# shut

router(config)# no shut

This action restarts autonegotiation.

Step 6 If the alarm does not clear, complete the “Create the Facility Loopback on the Source DS-1, DS-3, 
DS3N-12, DS3i-N-12, or EC1 Port” procedure on page 1-10 and test the loopback.

Step 7 If the problem persists with the loopback installed, complete the “Remove and Reinsert (Reseat) Any 
Card” procedure on page 2-274.

Step 8 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274.

Step 9 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.58  CARLOSS (TRUNK) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.59  CASETEMP-DEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.60  CLDRESTART 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

SONET Logical Object: EQPT

The Cold Restart condition occurs when a card is physically removed and inserted, replaced, or when 
the ONS 15454 power is initialized.

Clear the CLDRESTART Condition

Step 1 Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on 
page 2-273.

Step 2 If the condition fails to clear after the card reboots, complete the “Remove and Reinsert (Reseat) Any 
Card” procedure on page 2-274.
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Step 3 If the condition does not clear, complete the “Physically Replace a Traffic Card” procedure on 
page 2-274 for the card.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.61  COMIOXC 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

The Input/Output Slot To Cross-Connect Communication Failure alarm is caused by the XC10G or 
XC-VXC-10G cross-connect card when there is a communication failure for a traffic slot.

Clear the COMIOXC Alarm

Step 1 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 on the card in which the alarm is 
reported. For the LED behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section 
on page 2-261. 

Step 2 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 3 If the CTC reset does not clear the alarm, move traffic off the reporting cross-connect card. Complete 
the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-272.

Step 4 Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-274 on the card in which 
the alarm is reported.

Step 5 If the alarm does not clear, complete the “Physically Replace an In-Service Cross-Connect Card” 
procedure on page 2-275 for the reporting cross-connect card or complete the “Physically Replace a 
Traffic Card” procedure on page 2-274 on the card in which the alarm is reported.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.62  COMM-FAIL 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Plug-In Module (card) Communication Failure indicates that there is a communication failure 
between the TCC2/TCC2P and the traffic card. The failure could indicate a broken card interface.

Clear the COMM-FAIL Alarm

Step 1 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the reporting card.
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Step 2 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the card.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.63  CONTBUS-A-18 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

A Communication Failure from Controller Slot to Controller Slot alarm for the TCC2/TCC2P slot to 
TCC2/TCC2P slot occurs when the main processor on the TCC2/TCC2P in the first slot (TCC A) loses 
communication with the coprocessor on the same card. This applies to the TCC2/TCC2P in Slot 7. 

Clear the CONTBUS-A-18 Alarm

Step 1 Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-273 
to make the TCC2/TCC2P in Slot 11 active.

Step 2 Wait approximately 10 minutes for the TCC2/TCC2P in Slot 7 to reset as the standby TCC2/TCC2P. 
Verify that the ACT/SBY LED is correctly illuminated before proceeding to the next step. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

Step 3 Position the cursor over the TCC2/TCC2P in Slot 11 and complete the “Reset an Active TCC2/TCC2P 
Card and Activate the Standby Card” procedure on page 2-271 to return the card to the active state.

Step 4 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC 
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Reset an Active 
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-271. If the Cisco TAC 
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic 
Card” procedure on page 2-274.

2.7.64  CONTBUS-B-18 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

A Communication Failure from Controller Slot to Controller Slot alarm for the TCC2/TCC2P slot to 
TCC2/TCC2P slot occurs when the main processor on the TCC2/TCC2P in the second slot (TCC B) 
loses communication with the coprocessor on the same card. This applies to the Slot 11 TCC2/TCC2P. 

Clear the CONTBUS-B-18 Alarm

Step 1 Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on 
page 2-271 to make the Slot 7 TCC2/TCC2P active.
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Step 2 Wait approximately 10 minutes for the Slot 11 TCC2/TCC2P to reset as the standby TCC2/TCC2P. 
Verify that the ACT/SBY LED is correctly illuminated before proceeding to the next step. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 3 Position the cursor over the Slot 7 TCC2/TCC2P and complete the “Reset an Active TCC2/TCC2P Card 
and Activate the Standby Card” procedure on page 2-271 to return the Slot 11 TCC2/TCC2P to the active 
state.

Step 4 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC 
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and 
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-273. If the Cisco TAC 
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic 
Card” procedure on page 2-274.

2.7.65  CONTBUS-DISABLED 
Default Severity: Critical (CR), Service-Affecting (SA) 

SONET Logical Object: EQPT

The CONTBUS-DISABLED alarm is a function of the enhanced cell bus verification feature. This alarm 
occurs when a defective card is installed in the shelf assembly or when a card already installed in the 
shelf assembly becomes defective (that is, the card fails the enhanced cell bus verification test). The 
alarm persists as long as the defective card remains in the chassis. When the card is removed, 
CONTBUS-DISABLED will remain raised for a one-minute wait time. This wait time is designed as a 
guard period so that the system can distinguish this outage from a briefer card reset communication 
outage.

If no card is reinserted into the original slot during the wait time, the alarm clears. After this time, a 
different, nondefective card (not the original card) should be inserted. 

When CONTBUS-DISABLED is raised, no message-oriented communication is allowed to or from this 
slot to the TCC2/TCC2P (thus avoiding node communication failure). 

Caution CONTBUS-DISABLED clears only when the faulty card is removed for one minute. If any card at all is 
reinserted before the one-minute guard period expires, the alarm does not clear. 

CONTBUS-DISABLED overrides the “IMPROPRMVL” alarm on page 2-128 during the one-minute 
wait period, but afterward IMPROPRMVL can be raised because it is no longer suppressed. 
IMPROPRMVL is raised after CONTBUS-DISABLED clears if the card is in the node database. If 
CONTBUS-DISABLED has cleared but IMPROPRMVL is still active, inserting a card will clear the 
IMPROPRMVL alarm.

Clear the CONTBUS-DISABLED Alarm

Step 1 If the IMPROPRMVL alarm is raised, complete the “Physically Replace a Traffic Card” procedure on 
page 2-274. (For general information about card installation, refer to the “Install Cards and Fiber-Optic 
Cable” chapter in the Cisco ONS 15454 Procedure Guide.)
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Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.66  CONTBUS-IO-A 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

A TCCA to Shelf A Slot Communication Failure alarm occurs when the active Slot 7 TCC2/TCC2P 
(TCC A) has lost communication with another card in the shelf. The other card is identified by the Object 
column in the CTC alarm window.

The CONTBUS-IO-A alarm can appear briefly when the ONS 15454 switches to the protect 
TCC2/TCC2P. In the case of a TCC2/TCC2P protection switch, the alarm clears after the other cards 
establish communication with the newly active TCC2/TCC2P. If the alarm persists, the problem lies with 
the physical path of communication from the TCC2/TCC2P to the reporting card. The physical path of 
communication includes the TCC2/TCC2P, the other card, and the backplane.

Clear the CONTBUS-IO-A Alarm

Step 1 Ensure that the reporting card is physically present in the shelf. Record the card type. Click the 
Inventory tab and view the Eqpt Type column to reveal the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm on 
page 2-183 for the reporting card.

Step 2 If the alarm object is any single card slot other than the standby Slot 11 TCC2/TCC2P, perform a CTC 
reset of the object card. Complete the “Reset a Traffic Card in CTC” procedure on page 2-271. For the 
LED behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 3 If the alarm object is the standby Slot 11 TCC2/TCC2P, complete the “Reset a Traffic Card in CTC” 
procedure on page 2-271 for it. The procedure is similar.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A 
reset standby card remains standby.)

If CONTBUS-IO-A is raised on several cards at the same time, complete the “Reset an Active 
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-271.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 4 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 5 If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card” 
procedure on page 2-274 for the reporting card.

Step 6 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC 
1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and 
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-273. If the Cisco TAC 
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic 
Card” procedure on page 2-274.
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2.7.67  CONTBUS-IO-B 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

A TCC B to Shelf Communication Failure alarm occurs when the active Slot 11 TCC2/TCC2P (TCC B) 
has lost communication with another card in the shelf. The other card is identified by the Object column 
in the CTC alarm window.

The CONTBUS-IO-B alarm could appear briefly when the ONS 15454 switches to the protect 
TCC2/TCC2P. In the case of a TCC2/TCC2P protection switch, the alarm clears after the other cards 
establish communication with the newly active TCC2/TCC2P. If the alarm persists, the problem lies with 
the physical path of communication from the TCC2/TCC2P to the reporting card. The physical path of 
communication includes the TCC2/TCC2P, the other card, and the backplane.

Clear the CONTBUS-IO-B Alarm

Step 1 Ensure that the reporting card is physically present in the shelf. Record the card type. Click the 
Inventory tab and view the Eqpt Type column to reveal the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm on 
page 2-183 for the reporting card.

Step 2 If the alarm object is any single card slot other than the standby Slot 7 TCC2/TCC2P, perform a CTC 
reset of the object card. Complete the “Reset a Traffic Card in CTC” procedure on page 2-271. For the 
LED behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 3 If the alarm object is the standby Slot 7 TCC2/TCC2P, complete the “Reset a Traffic Card in CTC” 
procedure on page 2-271 for it. The procedure is similar.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A 
reset standby card remains standby.)

Step 4 If CONTBUS-IO-B is raised on several cards at the same time, complete the “Reset an Active 
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-271.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 5 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 6 If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card” 
procedure on page 2-274 for the reporting card.

Step 7 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC 
1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and 
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-273. If the Cisco TAC 
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic 
Card” procedure on page 2-274.

2.7.68  CPP-INCAPABLE
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: MLMR
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The Card Port Protection Incapable alarm indicates that the ML-MR-10 card or port is unable to provide 
protection. This condition occurs when the Resilient Packet Ring (RPR) interface on the ML-MR-10 
card is down, or when the CPP peer slot number is not configured from the Cisco IOS command line 
interface or the protection group is disabled.

Note For information about provisioning ML-MR-10 Ethernet cards from the Cisco IOS interface, refer to the 
Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide.

Clear the CPP-INCAPABLE Alarm

Step 1 Ensure that the RPR interface is not in the administratively shutdown state. 

Step 2 Ensure that the RPR interface is in the line protocol UP state.

Step 3 Ensure that the CPP peer slot is configured in Cisco IOS under the protection group configuration.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.69  CTNEQPT-MISMATCH 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Connection Equipment Mismatch condition is raised when there is a mismatch between the 
cross-connect card preprovisioned in the slot and the card actually installed in the shelf. For example, 
one type of cross-connect card could be preprovisioned in Slot 10, but another could be physically 
installed. It can also be caused by a card that is mismatched with the card. For example, 
CTNEQPT-MISMATCH is raised when an XCVT card is replaced with a XC10G card.

Cisco does not support configurations of unmatched cross-connect cards in Slot 8 and Slot 10, although 
this situation could briefly occur during the upgrade process. 

The cross-connect card you are replacing should not be the active card. (It can be in SBY state or 
otherwise not in use.)

Note During an upgrade, this condition occurs and is raised as its default severity, Not Alarmed (NA). 
However, after the upgrade has occurred, if you wish to change the condition’s severity so that it is 
Not Reported (NR), you can do this by modifying the alarm profile used at the node. For more 
information about modifying alarm severities, refer to the “Manage Alarms” chapter in the 
Cisco ONS 15454 Procedure Guide.

Clear the CTNEQPT-MISMATCH Condition

Step 1 Determine what kind of card is preprovisioned in the slot:

a. In node view, click the Inventory tab.
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b. View the information for the slot in the Eqpt Type and Actual Eqpt Type columns.

The Eqpt Type column contains the equipment that is provisioned in the slot. The Actual Eqpt Type 
contains the equipment that is physically present in the slot. For example, Slot 8 could be 
provisioned for an XCVT card, which is shown in the Eqpt Type column, but an XC10G XC10G 
card could be physically present in the slot. The XC10G would be shown in the Actual Eqpt Type 
column.

Step 2 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the mismatched card.

Step 3 If the condition does not clear, log onto http://www.cisco.com/techsupport for more information or call 
Cisco TAC 1 800 553-2447.

2.7.70  CTNEQPT-PBPROT 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

The Interconnection Equipment Failure Protect Cross-Connect Card Payload Bus Alarm indicates a 
failure of the main payload between the protect ONS 15454 Slot 10 XC10G card and the reporting traffic 
card. The cross-connect card and the reporting card are no longer communicating through the backplane. 
The problem exists in the cross-connect card and the reporting traffic card, or the TCC2/TCC2P and the 
backplane.

Note This alarm automatically raises and clears when the Slot 8 XC10G card is reseated.

Caution A software update on a standby TCC2/TCC2P can take up to 30 minutes.

Clear the CTNEQPT-PBPROT Alarm

Step 1 If all traffic cards show CTNEQPT-PBPROT alarm, complete the following steps:

a. Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on 
page 2-273 for the standby TCC2/TCC2P. 

b. If the reseat fails to clear the alarm, complete the “Physically Replace a Traffic Card” procedure on 
page 2-274 for the standby TCC2/TCC2P. 

Caution Do not physically reseat an active TCC2/TCC2P. Doing so disrupts traffic.

Step 2 If not all cards show the alarm, perform a CTC reset on the standby XC10G card. Complete the “Reset 
a Traffic Card in CTC” procedure on page 2-271. For the LED behavior, see the “2.8.2  Typical Traffic 
Card LED Activity During Reset” section on page 2-261.

Step 3 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the cross-connect reset is not complete and error-free or if the TCC2/TCC2P reboots automatically, 
call Cisco TAC 1 800 553-2447.
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Step 4 If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on 
page 2-274 for the standby OC-192 card.

Step 5 Determine whether the card is an active card or standby card in a protection group. Click the node view 
Maintenance > Protection tabs, then click the protection group. The cards and their status are displayed 
in the list.

Step 6 If the reporting traffic card is the active card in the protection group, complete the “Initiate a 1:1 Card 
Switch Command” procedure on page 2-266. After you move traffic off the active card, or if the 
reporting card is standby, continue with the following steps.

Step 7 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 on the reporting card. For the LED 
behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 8 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 9 If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on 
page 2-274 for the reporting card.

Step 10 Complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-266 to switch traffic back.

Step 11 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting traffic card.

Step 12 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.71  CTNEQPT-PBWORK 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

The Interconnection Equipment Failure Working Cross-Connect Card Payload Bus alarm indicates a 
failure in the main payload bus between the ONS 15454 Slot 8 XC10G card and the reporting traffic 
card. The cross-connect card and the reporting card are no longer communicating through the backplane. 
The problem exists in the cross-connect card and the reporting traffic card, or the TCC2/TCC2P and the 
backplane.

Note This alarm automatically raises and clears when the ONS 15454 Slot 10 XC10G card is reseated.

Clear the CTNEQPT-PBWORK Alarm

Step 1 If all traffic cards show CTNEQPT-PBWORK alarm, complete the following steps:

a. Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on 
page 2-271 for the active TCC2/TCC2P and then complete the “Remove and Reinsert (Reseat) the 
Standby TCC2/TCC2P Card” procedure on page 2-273. 

b. If the reseat fails to clear the alarm, complete the “Physically Replace a Traffic Card” procedure on 
page 2-274 for the TCC2/TCC2P. 
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Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution Do not physically reseat an active TCC2/TCC2P; it disrupts traffic.

Step 2 If all cards do not show the alarm, complete the “Side Switch the Active and Standby Cross-Connect 
Cards” procedure on page 2-272 for the active XC10G card.

Step 3 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the reporting card. For the LED 
behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 4 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 5 If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on 
page 2-274 for the standby cross-connect card.

Step 6 If the alarm does not clear and the reporting traffic card is the active card in the protection group, 
complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-266. If the card is standby, or 
if you have moved traffic off the active card, proceed with the following steps.

Step 7 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the reporting card. For the LED 
behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 8 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 9 If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card” 
procedure on page 2-274 for the reporting card.

Step 10 If you switched traffic, complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-266 to 
revert the traffic.

Step 11 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the OC-192 card.

Step 12 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting traffic card.

Step 13 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.72  DATA-CRC
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: CE100T, ML100T, ML1000, MLFX

The data cyclic redundancy check (CRC) Bad Packet Count Exceeds Threshold alarm indicates that 
Cisco proprietary ring-wrapping (RPR) has been triggered for an ML-Series card in high-level data link 
(HDLC) mode, but no SONET or data-level alarm is raised along with the “RPRW” alarm on page 2-216 
to indicate the failure. 
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In a typical scenario that triggers Cisco proprietary RPR protection, the errored node raises RPRW, and 
SONET or data errors such as the “TPTFAIL (ML100T, ML1000, MLFX)” alarm on page 2-250. If, 
however, a packet-over-SONET (POS) port is placed in down administrative state, the card will raise an 
RPRW without raising any SONET B3 bit alarms or data alarms. The DATA-CRC alarm accompanies 
this instance of RPRW to indicate the signal interruption.

Clear the DATA-CRC Alarm

Step 1 Determine whether the “RPRW” alarm on page 2-216, is raised on the ring. If so, clear it using the 
appropriate trouble-clearing procedure in this chapter.

Step 2 If the DATA-CRC alarm does not clear, check whether the alarmed card POS port is in the Down 
administrative state:

a. Double-click the ML-Series card to display the card view.

b. Click the Provisioning > POS Ports tabs.

c. View the port’s setting in the Admin State column. If it is Down, verify that both POS ports are 
properly configured. Refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card 
Software Feature and Configuration Guide for configuration information. 

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.73  DATAFLT 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: NE

The Software Data Integrity Fault alarm occurs when the TCC2/TCC2P exceeds its flash memory 
capacity.

Caution When the system reboots, the last configuration entered is not saved.

Clear the DATAFLT Alarm

Step 1 Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on 
page 2-271.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.74  DBOSYNC 
Default Severity: Major (MJ), Service-Affecting (SA)
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SONET Logical Object: NE

The Standby Database Out Of Synchronization alarm occurs when the standby TCC2/TCC2P database 
does not synchronize with the active database on the active TCC2/TCC2P.

Caution If you reset the active TCC2/TCC2P while this alarm is raised, you lose current provisioning.

Clear the DBOSYNC Alarm

Step 1 Save a backup copy of the active TCC2/TCC2P database. Refer to the “Maintain the Node” chapter in 
the Cisco ONS 15454 Procedure Guide for procedures.

Step 2 Make a minor provisioning change to the active database to see if applying a provisioning change clears 
the alarm:

a. In node view, click the Provisioning > General > General tabs.

b. In the Description field, make a small change such as adding a period to the existing entry.

The change causes a database write but does not affect the node state. The write could take up to a 
minute.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.75  DCU-LOSS-FAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.76  DISCONNECTED
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: SYSTEM

The Disconnected alarm is raised when CTC has been disconnected from the node. The alarm clears 
when CTC reconnects to the node.

Clear the DISCONNECTED Alarm

Step 1 Restart CTC.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call TAC (1-800-553-2447). 
2-78
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.77    DS3-MISM
2.7.77  DS3-MISM 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The DS-3 Frame Format Mismatch condition indicates a frame format mismatch on a signal transiting 
the ONS 15454 DS3XM-6, DS3XM-12, or DS3/EC1-48 card. The condition occurs when the 
provisioned line type and incoming signal frame format type do no match. For example, if the line type 
for a DS3XM-6 card is set to C Bit and the incoming signal frame format is detected as M13, then the 
ONS 15454 reports a DS3-MISM condition.

Clear the DS3-MISM Condition

Step 1 Display the CTC card view for the reporting DS3E-12, DS3I-12, DS3XM-6, DS3XM-12, or 
DS3/EC1-48 card.

Step 2 Click the Provisioning > Line tabs.

Step 3 For the row on the appropriate port, verify that the Line Type column is set to match the expected 
incoming signal (C Bit or M13).

Step 4 If the Line Type field does not match the expected incoming signal, select the correct Line Type in the 
drop-down list. 

Step 5 Click Apply.

Step 6 If the condition does not clear after the user verifies that the provisioned line type matches the expected 
incoming signal, use an optical test set to verify that the actual signal coming into the ONS 15454 
matches the expected incoming signal. For specific procedures to use the test set equipment, consult the 
manufacturer.

Step 7 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.78  DSP-COMM-FAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.79  DSP-FAIL
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.80  DUP-IPADDR 
Default Severity: Minor (MN), Non-Service Affecting (NSA)

SONET Logical Object: NE
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The Duplicate IP Address alarm indicates that the alarmed node IP address is already in use within the 
same DCC area. When this happens, CTC no longer reliably connects to either node. Depending on how 
the packets are routed, CTC could connect to either node (having the same IP address). If CTC has 
connected to both nodes before they shared the same address, it has two distinct NodeModel instances 
(keyed by the node ID portion of the MAC address). 

Clear the DUP-IPADDR Alarm

Step 1 Isolate the alarmed node from the other node having the same address:

a. Connect to the alarmed node using the Craft port on the TCC2/TCC2P card.

b. Begin a CTC session.

c. In the login dialog window, uncheck the Network Discovery check box.

Step 2 In node view, click the Provisioning > Network > General tabs.

Step 3 In the IP Address field, change the IP address to a unique number.

Step 4 Click Apply.

Step 5 Restart any CTC sessions that are logged into either of the duplicate IP addresses. (For procedures to log 
in or log out, refer to the “Connect the PC and Log Into the GUI” chapter in the Cisco ONS 15454 
Procedure Guide. 

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.81  DUP-NODENAME 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: NE

The Duplicate Node Name alarm indicates that the alarmed node alphanumeric name is already being 
used within the same DCC area.

Clear the DUP-NODENAME Alarm

Step 1 In node view, click the Provisioning > General > General tabs.

Step 2 In the Node Name/TID field, enter a unique name for the node.

Step 3 Click Apply.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.
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2.7.82  DUP-SHELF-ID 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.83  EHIBATVG 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: PWR

The Extreme High Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input 
voltage exceeds the extreme high power threshold. This threshold, with a default value of –56.5 VDC, 
is user-provisionable. The alarm remains raised until the voltage remains under the threshold for 
120 seconds.

Clear the EHIBATVG Alarm

Step 1 The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.84  ELWBATVG 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: PWR

The Extreme Low Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input 
voltage falls below the extreme low power threshold. This threshold, with a default value of –40.5 VDC, 
is user-provisionable. The alarm remains raised until the voltage remains over the threshold for 
120 seconds. 

Clear the ELWBATVG Alarm

Step 1 The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.85  ENCAP-MISMATCH-P 
Default Severity: Critical (CR), Service-Affecting (SA)
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SONET Logical Object: STSTRM

The Encapsulation C2 Byte Mismatch Path alarm applies to ML-Series Ethernet cards or the CE-1000 
card. It occurs when the first three following conditions are met and one of the last two is false:

 • The received C2 byte is not 0x00 (unequipped).

 • The received C2 byte is not a PDI value.

 • The received C2 does not match the expected C2.

 • The expected C2 byte is not 0x01 (equipped unspecified).

 • The received C2 byte is not 0x01 (equipped unspecified). 

(This is in contrast to the “PLM-P” alarm on page 2-196, which must meet all five criteria.) For an 
ENCAP-MISMATCH-P to be raised, there is a mismatch between the received and expected C2 byte, 
with either the expected byte or received byte value being 0x01. 

For example, an ENCAP-MISMATCH-P alarm is raised if a circuit created between two ML-Series or 
two CE-1000 cards has generic framing procedure (GFP) framing provisioned on one end and HDLC 
framing with LEX encapsulation provisioned on the other. The GFP framing card transmits and expects 
a C2 byte of 0x1B, while the HDLC framing card transmits and expects a C2 byte of 0x01.

A mismatch between the transmit and receive cards on any of the following parameters can cause the 
alarm:

 • Mode (HDLC, GFP-F)

 • Encapsulation (LEX, HDLC, PPP)

 • CRC size (16 or 32)

 • Scrambling state (on or off)

This alarm is demoted by a “PLM-P” condition on page 2-196 or a “PLM-V” condition on page 2-197.

Note By default, an ENCAP-MISMATCH-P alarm causes an ML-Series or CE-1000 card data link to go 
down. This behavior can be modified using the command line interface (CLI) command in interface 
configuration mode: no pos trigger defect encap.

Note For more information about the ML-Series or CE-1000 Ethernet cards, refer to the 
Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide.

Clear the ENCAP-MISMATCH-P Alarm

Step 1 Ensure that the correct framing mode is in use on the receive card:

a. In node view, double-click the receive ML-Series or CE-1000 card to open the card view.

b. Click the Provisioning > Card tabs.

c. In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not, 
choose it and click Apply.

Step 2 Ensure that the correct framing mode is in use on the transmit card, and that it is identical to the receiving 
card:

a. In node view, double-click the transmit ML-Series or CE-1000 card to open the card view.
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b. Click the Provisioning > Card tabs.

c. In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not, 
choose it and click Apply.

Step 3 If the alarm does not clear, use the CLI to ensure that the remaining settings are correctly configured on 
the ML-Series or CE-1000 card:

 • Encapsulation 

 • CRC size

 • Scrambling state

To open the interface, click the IOS tab and click Open IOS Command Line Interface (CLI). Refer to 
the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide entries on all three of these topics to obtain the full configuration command sequences.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.86  EOC 
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

SONET Logical Object: OCN

DWDM Logical Object: TRUNK

The SONET DCC Termination Failure alarm occurs when the ONS 15454 loses its DCC. Although this 
alarm is primarily SONET, it can apply to DWDM. For example, the OSCM card can raise this alarm on 
its OC-3 section overhead.

The SDCC consists of three bytes, D1 through D3, in the SONET overhead. The bytes convey 
information about operation, administration, maintenance, and provisioning (OAM&P). The ONS 15454 
uses the DCC on the SONET section layer to communicate network management information.

Warning On the ONS 15454 OC-192 card, the laser is on when the card is booted and the safety key is in the on 
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when 
the safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057
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Note If a circuit shows a partial state when this alarm is raised, the logical circuit is in place. The circuit is 
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when 
troubleshooting this alarm.

Clear the EOC Alarm

Step 1 If the “LOS (OCN)” alarm on page 2-165 is also reported, complete the “Clear the LOS (OCN) Alarm” 
procedure on page 2-166.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If the “SF-L” condition on page 2-224 is reported, complete the “Clear the SF-L Condition” procedure 
on page 2-224.

Step 3 If the alarm does not clear on the reporting node, verify the physical connections between the cards and 
that the fiber-optic cables are configured to carry SDCC traffic. For more information about fiber 
connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide.

If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the 
fiber span have in-service (IS-NR) ports. Verify that the ACT/SBY LED on each card is green.

Step 4 When the LEDs on the cards are correctly illuminated, complete the “Verify or Create Node Section 
DCC Terminations” procedure on page 2-276 to verify that the DCC is provisioned for the ports at both 
ends of the fiber span.

Step 5 Repeat Step 4 at the adjacent nodes.

Step 6 If DCC is provisioned for the ends of the span, verify that the port is active and in service:

a. Confirm that the card shows a green LED in CTC or on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

b. To determine whether the port is in service, double-click the card in CTC to open the card view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and click IS 
in the drop-down list. Click Apply.

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port 
service state transitions to OOS-AU,FLT.

Step 7 For all nodes, if the card is in service, use an optical test set to determine whether signal failures are 
present on fiber terminations. For specific procedures to use the test set equipment, consult the 
manufacturer.
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Caution Using an optical test set can disrupt service on the OC-N card. It could be necessary to manually switch 
traffic carrying circuits over to a protection path. Refer to the “2.9.2  Protection Switching, Lock 
Initiation, and Clearing” section on page 2-263 for commonly used switching procedures.

Step 8 If no signal failures exist on terminations, measure power levels to verify that the budget loss is within 
the parameters of the receiver. See the “1.12.3  OC-N Card Transmit and Receive Levels” section on 
page 1-146 for non-DWDM card levels and refer to the Cisco ONS 15454 DWDM Reference Manual for 
DWDM card levels.

Step 9 If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly 
terminated. For more information refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide.

Step 10 If fiber connectors are properly fastened and terminated, complete the “Reset an Active TCC2/TCC2P 
Card and Activate the Standby Card” procedure on page 2-271.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Resetting the active TCC2/TCC2P switches control to the standby TCC2/TCC2P. If the alarm clears 
when the ONS 15454 node switches to the standby TCC2/TCC2P, the user can assume that the 
previously active card is the cause of the alarm.

Step 11 If the TCC2/TCC2P reset does not clear the alarm, delete the problematic SDCC termination:

a. From the View menu in card view, choose Go to Previous View if you have not already done so.

b. Click the Provisioning > Comm Channels > SDCC tabs.

c. Highlight the problematic DCC termination.

d. Click Delete.

e. Click Yes in the Confirmation Dialog box.

Step 12 Recreate the SDCC termination. Refer to the “Turn Up Network” chapter in the Cisco ONS 15454 
Procedure Guide for procedures.

Step 13 Verify that both ends of the DCC have been recreated at the optical ports.

Step 14 If the alarm has not cleared, call Cisco TAC 1 800 553-2447. If the Cisco TAC technician tells you to 
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure 
on page 2-273. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow 
the “Physically Replace a Traffic Card” procedure on page 2-274.

2.7.87  EOC-L 
Default Severity: Minor (MN), Non-Service-Affecting (NSA) for OCN

SONET Logical Object: OCN

DWDM Logical Object: TRUNK

The Line DCC (LDCC) Termination Failure alarm occurs when the ONS 15454 loses its line data 
communications channel (LDCC) termination. In DWDM configurations, for example, the OSCM card 
can raise this alarm on its OC-3 line overhead.
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The LDCC consists of nine bytes, D4 through D12, in the SONET overhead. The bytes convey 
information about OAM&P. The ONS 15454 uses the LDCCs on the SONET line layer to communicate 
network management information.

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Note If a circuit shows a partial status when the “EOC” alarm on page 2-83, or EOC-L is raised, it occurs when 
the logical circuit is in place. The circuit is able to carry traffic when the DCC termination issue is 
resolved. You do not need to delete the circuit when troubleshooting this alarm.

Clear the EOC-L Alarm

Step 1 Complete the “Clear the EOC Alarm” procedure on page 2-84.

Step 2 If the alarm has not cleared, call Cisco TAC 1 800 553-2447. If the Cisco TAC technician tells you to 
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure 
on page 2-273. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow 
the “Physically Replace a Traffic Card” procedure on page 2-274.

2.7.88  EQPT 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Objects: AICI-AEP, AICI-AIE, EQPT

DWDM Logical Object: PPM

An Equipment Failure alarm indicates that a hardware failure has occurred on the reporting card. If the 
EQPT alarm occurs with a BKUPMEMP alarm, refer to the “BKUPMEMP” alarm on page 2-57. The 
BKUPMEMP procedure also clears the EQPT alarm.

This alarm is also invoked if a diagnostic circuit detects a card application-specific integrated circuit 
(ASIC) failure. In this case, if the card is part of a protection group, an APS switch occurs. If the card is 
the protect card, switching is inhibited and a“PROTNA” alarm on page 2-199 is raised. The standby path 
generates a path-type alarm.
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Clear the EQPT Alarm

Step 1 If traffic is active on the alarmed port, you could need to switch traffic away from it. See the 
“2.9.2  Protection Switching, Lock Initiation, and Clearing” section on page 2-263 for commonly used 
traffic-switching procedures.

Step 2 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the reporting card. For LED 
behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 3 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the 
LED status. A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a 
standby card. 

Step 4 If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card” 
procedure on page 2-274 for the reporting card.

Step 5 If the physical reseat of the card fails to clear the alarm, complete the “Physically Replace a Traffic Card” 
procedure on page 2-274 for the reporting card.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.89  EQPT-DIAG 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

An Equipment-Diagnostic Failure alarm indicates that a software or hardware failure has occurred on 
the reporting card. This alarm can be raised against a traffic card or a cross-connect card.

Clear the EQPT-DIAG Alarm

Step 1 If traffic is active on the alarmed card, you could need to switch traffic away from it. Refer to the 
“2.9.2  Protection Switching, Lock Initiation, and Clearing” section on page 2-263 for procedures.

Step 2 Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-274 for the alarmed card

Step 3 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
if it is raised against a traffic card, or complete the “Physically Replace an In-Service Cross-Connect 
Card” procedure on page 2-275 if the alarm is raised against the cross-connect card.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.90  EQPT-MISS 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: FAN
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The Replaceable Equipment or Unit Missing alarm is reported against the fan-tray assembly unit. It 
indicates that the replaceable fan-tray assembly is missing or not fully inserted. It could also indicate 
that the ribbon cable connecting the AIP to the system board is bad.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the EQPT-MISS Alarm

Step 1 If the alarm is reported against the fan, verify that the fan-tray assembly is present.

Step 2 If the fan-tray assembly is present, complete the “Replace the Fan-Tray Assembly” procedure on 
page 2-281.

Step 3 If no fan-tray assembly is present, obtain a fan-tray assembly and refer to the “Install the Fan-Tray 
Assembly,” procedure in the Cisco ONS 15454 Procedure Guide.

Step 4 If the alarm does not clear, replace the ribbon cable from the AIP to the system board with a known-good 
ribbon cable.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.91  ERFI-P-CONN 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM

The Three-Bit (Enhanced) Remote Failure Indication (ERFI) Path Connectivity condition is triggered on 
DS-1, DS-3, or VT circuits when the “UNEQ-P” alarm on page 2-253 and the “TIM-P” alarm on 
page 2-246 are raised on the transmission signal.

Clear the ERFI-P-CONN Condition

Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-253. This should clear the ERFI 
condition.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.92  ERFI-P-PAYLD 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM
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The Three-Bit ERFI Path Payload condition is triggered on DS-1, DS-3, or VT circuits when the 
“PLM-P” alarm on page 2-196 is raised on the transmission signal.

Clear the ERFI-P-PAYLD Condition

Step 1 Complete the “Clear the PLM-P Alarm” procedure on page 2-197. This should clear the ERFI condition.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.93  ERFI-P-SRVR 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM

The Three-Bit ERFI Path Server condition is triggered on DS-1, DS-3, or VT circuits when the “AIS-P” 
condition on page 2-38 or the “LOP-P” alarm on page 2-155 is raised on the transmission signal.

Clear the ERFI-P-SRVR Condition

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-156. This should clear the ERFI condition.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.94  ERROR-CONFIG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Error in Startup Configuration alarm applies to the ML-Series Ethernet cards. These cards process 
startup configuration files line by line. If one or more lines cannot be executed, the error causes the 
ERROR-CONFIG alarm. ERROR-CONFIG is not caused by hardware failure.

The typical reasons for an errored startup file are:

 • The user stored the configuration for one type of ML-Series card in the database and then installed 
another type in its slot.

 • The configuration file contained a syntax error on one of the lines.

 • The user stored the configuration for the ML-Series card and then changed the card mode from 
RPR-IEEE mode to another mode, or vice versa.

Note For information about provisioning the ML-Series Ethernet cards from the Cisco IOS interface, refer to 
the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide.
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Clear the ERROR-CONFIG Alarm

Step 1 If you have a different type of ML-Series card specified in the startup configuration file than what you 
have installed, create the correct startup configuration.

Follow the card provisioning instructions in the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet 
Card Software Feature and Configuration Guide.

Step 2 Upload the configuration file to the TCC2/TCC2P:

a. In node view, right-click the ML-Series card graphic.

b. Choose IOS Startup Config from the shortcut menu.

c. Click Local > TCC and navigate to the file location in the Open dialog box.

Step 3 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271.

Step 4 If the alarm does not clear or if your configuration file was correct according to the installed card, start 
a Cisco IOS CLI for the card:

a. Right click the ML-Series card graphic in node view.

b. Choose Open IOS Connection from the shortcut menu.

Note Open IOS Connection is not available unless the ML-Series card is physically installed in 
the shelf.

Follow the card provisioning instructions in the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet 
Card Software Feature and Configuration Guide to correct the errored configuration file line.

Step 5 Execute the CLI command:

router(config)#copy run start

The command copies the new card configuration into the database and clears the alarm.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.95  ETH-LINKLOSS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE

The Rear Panel Ethernet Link Removed condition, if enabled in the network defaults, is raised under the 
following conditions: 

 • The node.network.general.AlarmMissingBackplaneLAN field in NE default is enabled. 

 • The node is configured as a gateway network element (GNE). 

 • The backplane LAN cable is removed. 

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.
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Clear the ETH-LINKLOSS Condition

Step 1 To clear this condition, reconnect the backplane LAN cable. Refer to the “Install the Shelf and Backplane 
Cable” chapter in the Cisco ONS 15454 Procedure Guide for procedures to install this cable.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.96  E-W-MISMATCH 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: OCN

A Procedural Error Misconnect East/West Direction alarm occurs during BLSR setup, or when nodes in 
a ring have slots misconnected. An east slot can be misconnected to another east slot, or a west slot can 
be misconnected to another west slot. In most cases, the user did not connect the fibers correctly or the 
ring provisioning plan was flawed. You can physically reconnect the cable to the correct slots to clear 
the E-W-MISMATCH alarm. Alternately, you can delete and recreate the span in CTC to change the west 
line and east line designations. The CTC method clears the alarm, but could change the traditional 
east-west node connection pattern of the ring.

Note The E-W-MISMATCH alarm also appears during the initial set up of a ring with its east-west slots 
configured correctly. If the alarm appears during the initial setup, the alarm clears itself shortly after the 
ring setup is complete.

Note The lower-numbered slot at a node is traditionally labeled the west slot and the higher numbered slot is 
labeled the east slot. For example, Slot 6 is west and Slot 12 is east. 

Note The physical switch procedure is the recommend method of clearing the E-W-MISMATCH alarm. The 
physical switch method reestablishes the logical pattern of connection in the ring. However, you can also 
use CTC to recreate the span and identify the misconnected slots as east and west. The CTC method is 
useful when the misconnected node is not geographically near the troubleshooter.

Clear the E-W-MISMATCH Alarm with a Physical Switch

Step 1 Diagram the ring setup, including nodes and spans, on a piece of paper or white board.

Step 2 In node view, click View > Go to Network View.

Step 3 Click the circuit and click Edit. The network map detailed view window appears. This window contains 
the node name, slot, and port for each end of each span.

Step 4 Label each of the nodes on the diagram with the same name that appears on the network map.
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Step 5 Label the span ends on the diagram with the same information. For example, with 
Node 1/Slot 12/Port 1—Node 2/Slot 6/Port 1 (2F BLSR OC48, ring name=0), label the end of the span 
that connects Node 1 and Node 2 at the Node 1 end as Slot 12/Port 1. Label the Node 2 end of that same 
span Slot 6/Port 1.

Step 6 Repeat Steps 4 and 5 for each span on your diagram.

Step 7 Label the highest slot at each node east and the lowest slot at each node west.

Step 8 Examine the diagram. You should see a clockwise pattern of west slots connecting to east slots for each 
span. Refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure 
Guide for more information about cabling the system.

Step 9 If any span has an east-to-east or west-to-west connection, physically switching the fiber connectors 
from the card that does not fit the pattern to the card that continues the pattern should clear the alarm.

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Step 10 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

Clear the E-W-MISMATCH Alarm in CTC

Step 1 Log into the misconnected node. A misconnected node has both ring fibers connecting it to its neighbor 
nodes misconnected.

Step 2 Click the Maintenance > BLSR tabs.

Step 3 From the row of information for the fiber span, complete the “Identify a BLSR Ring Name or Node ID 
Number” procedure on page 2-262 to identify the node ID, ring name, and the slot and port in the 
East Line column and West Line column. Record the above information.

Step 4 Click View > Go to Network View.

Step 5 Delete and recreate the BLSR:

a. Click the Provisioning > BLSR tabs.

b. Click the row from Step 3 to select it and click Delete.

c. Click Create.
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d. Fill in the ring name and node ID from the information collected in Step 3.

e. Click Finish.

Step 6 Display node view and click the Maintenance > BLSR tabs.

Step 7 Change the West Line field to the slot you recorded for the East Line in Step 3.

Step 8 Change the East Line field to the slot you recorded for the West Line in Step 3.

Step 9 Click OK.

Step 10 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.97  EXCCOL 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Excess Collisions on the LAN alarm indicates that too many collisions are occurring between data 
packets on the network management LAN, and communications between the ONS 15454 and CTC could 
be affected. The network management LAN is the data network connecting the workstation running the 
CTC software to the TCC2/TCC2P. The problem causing the alarm is external to the ONS 15454.

Troubleshoot the network management LAN connected to the TCC2/TCC2P for excess collisions. You 
might need to contact the system administrator of the network management LAN to accomplish the 
following steps.

Clear the EXCCOL Alarm

Step 1 Verify that the network device port connected to the TCC2/TCC2P has a flow rate set to 10 Mb, 
half-duplex.

Step 2 If the port has the correct flow rate and duplex setting, troubleshoot the network device connected to the 
TCC2/TCC2P and the network management LAN.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.98  EXERCISE-RING-FAIL 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Exercise Ring command issues ring protection switching of the requested channel without 
completing the actual bridge and switch. The EXERCISE-RING-FAIL condition is raised if the 
command was issued and accepted but the exercise did not take place.
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Note If the exercise command gets rejected due to the existence of a higher-priority condition in the ring, 
EXERCISE-RING-FAIL is Not Reported (NR).

Clear the EXERCISE-RING-FAIL Condition

Step 1 Look for and clear, if present, the “LOF (OCN)” alarm on page 2-152, the “LOS (OCN)” alarm on 
page 2-165, or a BLSR alarm.

Step 2 Complete the “Initiate an Exercise Ring Switch on a BLSR” procedure on page 2-270.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.99  EXERCISE-SPAN-FAIL 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Exercise Span command issues span switching of the requested channel without completing the 
actual bridge and switch. The EXERCISE-SPAN-FAIL condition is raised if the command was issued 
and accepted but the exercise did not take place.

Note If the exercise command gets rejected due to the existence of a higher-priority condition in the span or 
ring, EXERCISE-SPAN-FAIL is Not Reported (NR).

Clear the EXERCISE-SPAN-FAIL Condition

Step 1 Look for and clear, if present, the “LOF (OCN)” alarm on page 2-152, the “LOS (OCN)” alarm on 
page 2-165, or a BLSR alarm.

Step 2 Complete the “Initiate an Exercise Ring Switch on a BLSR” procedure on page 2-270.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.100  EXT 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: ENVALRM

A Failure Detected External to the NE alarm occurs because an environmental alarm is present. For 
example, a door could be open or flooding could have occurred.
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Clear the EXT Alarm

Step 1 In node view double-click the AIC-I card to open the card view.

Step 2 Double-click the Maintenance > External Alarms tab.

Step 3 Follow your standard operating procedure to remedy environmental conditions that cause alarms. The 
alarm clears when the situation is remedied.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.101  EXTRA-TRAF-PREEMPT 
Default Severity: Major (MJ), Service-Affecting (SA) 

SONET Logical Object: OCN

An Extra Traffic Preempted alarm occurs on OC-N cards in two-fiber and four-fiber BLSRs when 
low-priority traffic directed to the protect system has been preempted by a working system protection 
switch.

Clear the EXTRA-TRAF-PREEMPT Alarm

Step 1 Verify that the protection switch has occurred by checking the Conditions tab.

Step 2 If a ring switch has occurred, clear the ring switch on the working system by following the appropriate 
alarm in this chapter. For more information about protection switches, refer to the “2.9.2  Protection 
Switching, Lock Initiation, and Clearing” section on page 2-263 or the “Maintain the Node” chapter in 
the Cisco ONS 15454 Procedure Guide.

Step 3 If the alarm occurred on a four-fiber BLSR and the span switch occurred on this OC-N, clear the span 
switch on the working system.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.102  FAILTOSW 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Failure to Switch to Protection Facility condition occurs when a working or protect electrical or 
optical facility switches to its companion port by using a MANUAL command. For example, if you 
attempt to manually switch traffic from an unused protect port to an in-service working port, the switch 
will fail (because traffic is already present on the working port) and you will see the FAILTOSW 
condition. 
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Clear the FAILTOSW Condition

Step 1 Look up and troubleshoot the higher-priority alarm. Clearing the higher-priority condition frees the card 
and clears the FAILTOSW.

Note A higher-priority alarm is an alarm raised on the working DS-N card using the 1:N card 
protection group. The working DS-N card is reporting an alarm but not reporting a FAILTOSW 
condition.

Step 2 If the condition does not clear, replace the working electrical or optical card that is reporting the 
higher-priority alarm by following the “Physically Replace a Traffic Card” procedure on page 2-274. 
This card is the working electrical or optical card using the protect card and not reporting FAILTOSW.

Replacing the working electrical or optical card that is reporting the higher-priority alarm allows traffic 
to revert to the working slot and the card reporting the FAILTOSW to switch to the protect card.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.103  FAILTOSW-PATH 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, VT-MON

The Fail to Switch to Protection Path condition occurs when the working circuit does not switch to the 
protection circuit on a path protection configuration. Common causes of the FAILTOSW-PATH alarm 
include a missing or defective protect port, a lockout set on one of the path protection nodes, or 
path-level alarms that would cause a path protection switch to fail including the “AIS-P” condition on 
page 2-38, the “LOP-P” alarm on page 2-155, the “SD-P” condition on page 2-221, the “SF-P” condition 
on page 2-225, and the “UNEQ-P” alarm on page 2-253.

The “LOF (OCN)” alarm on page 2-152, the “LOS (OCN)” alarm on page 2-165, the “SD-L” condition 
on page 2-221, or the “SF-L” condition on page 2-224 can also occur on the failed path.

Clear the FAILTOSW-PATH Condition in a Path Protection Configuration

Step 1 Look up and clear the higher-priority alarm. Clearing this alarm frees the standby card and clears the 
FAILTOSW-PATH condition. If the “AIS-P” condition on page 2-38, the “LOP-P” alarm on page 2-155, 
the “UNEQ-P” alarm on page 2-253, the “SF-P” condition on page 2-225, the “SD-P” condition on 
page 2-221, the “LOF (OCN)” alarm on page 2-152, the “LOS (OCN)” alarm on page 2-165, the “SD-L” 
condition on page 2-221, or the “SF-L” condition on page 2-224 are also occurring on the reporting port, 
complete the applicable alarm clearing procedure.

Note A higher-priority alarm is an alarm raised on the working electrical card using the 1:N card 
protection group. The working DS-N card is reporting an alarm but not reporting a FAILTOSW 
condition.
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Step 2 If the condition does not clear, replace the active OC-N card that is reporting the higher-priority alarm. 
Complete the “Physically Replace a Traffic Card” procedure on page 2-274. Replacing the active OC-N 
card that is reporting the higher-priority alarm allows traffic to revert to the active slot. Reverting frees 
the standby card, which can then take over traffic from the card reporting the lower-priority alarm and 
the FAILTOSW-PATH condition.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447. 

2.7.104  FAILTOSWR 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Fail to Switch to Protection Ring condition occurs when a ring switch did not complete because of 
internal APS problems.

FAILTOSWR clears in any of the following situations:

 • A physical card pull of the active TCC2/TCC2P (done under Cisco TAC supervision).

 • A node power cycle.

 • A higher-priority event such as an external switch command.

 • The next ring switch succeeds.

 • The cause of the APS switch (such as the “SD-L” condition on page 2-221 or the “SF-L” condition 
on page 2-224) clears.

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the FAILTOSWR Condition in a BLSR Configuration

Step 1 Perform the Exercise Ring command on the reporting card:

a. Click the Maintenance > BLSR tabs.

b. Click the row of the affected ring under the West Switch column.

c. Select Exercise Ring in the drop-down list.
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Step 2 If the condition does not clear, from the view menu, choose Go to Network View.

Step 3 Look for alarms on OC-N cards that make up the ring or span and troubleshoot these alarms.

Step 4 If clearing other alarms does not clear the FAILTOSWR condition, log into the near-end node.

Step 5 Click the Maintenance > BLSR tabs.

Step 6 Record the OC-N cards listed under West Line and East Line. Ensure that these OC-N cards and ports 
are active and in service:

a. Verify the LED status: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED 
indicates a standby card. 

b. Double-click the card in CTC to open the card view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose 
IS. Click Apply.

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port 
service state transitions to OOS-AU,FLT.

Step 7 If the OC-N cards are active and in service, verify fiber continuity to the ports on the recorded cards. To 
verify fiber continuity, follow site practices.

Step 8 If fiber continuity to the ports is good, use an optical test set to verify that a valid signal exists on the 
line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close 
to the receiving card as possible.

Caution Using an optical test set disrupts service on the OC-N card. It could be necessary to manually switch 
traffic carrying circuits over to a protection path. Refer to the “2.9.2  Protection Switching, Lock 
Initiation, and Clearing” section on page 2-263 for commonly used switching procedures.

Step 9 If the signal is valid, clean the fiber according to site practice. If no site practice exists, complete the 
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 10 If cleaning the fiber does not clear the condition, verify that the power level of the optical signal is within 
the OC-N card receiver specifications. The “1.12.3  OC-N Card Transmit and Receive Levels” section 
on page 1-146 lists these specifications.

Step 11 Repeat Steps 7 through 10 for any other ports on the card.

Step 12 If the optical power level for all OC-N cards is within specifications, complete the “Physically Replace 
a Traffic Card” procedure on page 2-274 for the protect standby OC-N card.

Step 13 If the condition does not clear after you replace the BLSR cards on the node one by one, repeat  
Steps 4 through 12 for each of the nodes in the ring.

Step 14 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.105  FAILTOSWS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Failure to Switch to Protection Span condition signals an APS span switch failure. For a four-fiber 
BLSR, a failed span switch initiates a ring switch. If the ring switch occurs, the FAILTOSWS condition 
does not appear. If the ring switch does not occur, the FAILTOSWS condition appears. FAILTOSWS 
clears when one of the following situations occurs:

 • A physical card pull of the active TCC2/TCC2P done under Cisco TAC supervision.

 • A node power cycle.

 • A higher-priority event such as an external switch command occurs.

 • The next span switch succeeds.

 • The cause of the APS switch (such as the “SD-L” condition on page 2-221 or the “SF-L” condition 
on page 2-224) clears.

Clear the FAILTOSWS Condition

Step 1 Perform the Exercise Span command on the reporting card:

a. Click the Maintenance > BLSR tabs.

b. Determine whether the card you would like to exercise is the west card or the east card.

c. Click the row of the affected span under the East Switch or West Switch column.

d. Select Exercise Span in the drop-down list.

Step 2 If the condition does not clear, from the view menu, choose Go to Network View.

Step 3 Look for alarms on OC-N cards that make up the ring or span and troubleshoot these alarms.

Step 4 If clearing other alarms does not clear the FAILTOSWS condition, log into the near-end node.

Step 5 Click the Maintenance > BLSR tabs.

Step 6 Record the OC-N cards listed under West Line and East Line. Ensure that these OC-N cards are active 
and in service:

a. Verify the LED status: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED 
indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card 
view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose 
IS. Click Apply.

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port 
service state transitions to OOS-AU,FLT.
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Step 7 If the OC-N cards are active and in service, verify fiber continuity to the ports on the recorded cards. To 
verify fiber continuity, follow site practices.

Step 8 If fiber continuity to the ports is good, use an optical test set to verify that a valid signal exists on the 
line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close 
to the receiving card as possible.

Caution Using an optical test set disrupts service on the OC-N card. It could be necessary to manually switch 
traffic carrying circuits over to a protection path. Refer to the “2.9.2  Protection Switching, Lock 
Initiation, and Clearing” section on page 2-263 for commonly used switching procedures.

Step 9 If the signal is valid, clean the fiber according to site practice. If no site practice exists, complete the 
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 10 If cleaning the fiber does not clear the condition, verify that the power level of the optical signal is within 
the OC-N card receiver specifications. The “1.12.3  OC-N Card Transmit and Receive Levels” section 
on page 1-146 lists these specifications.

Step 11 Repeat Steps 7 through 10 for any other ports on the card.

Step 12 If the optical power level for all OC-N cards is within specifications, complete the “Physically Replace 
a Traffic Card” procedure on page 2-274 for the protect standby OC-N card.

Step 13 If the condition does not clear after you replace the BLSR cards on the node one by one, follow  
Steps 4 through 12 for each of the nodes in the ring.

Step 14 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.106  FAN 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: FAN

The Fan Failure alarm indicates a problem with the fan-tray assembly. When the fan-tray assembly is not 
fully functional, the temperature of the ONS 15454 can rise above its normal operating range. 

The fan-tray assembly contains six fans and needs a minimum of five working fans to properly cool the 
shelf. However, even with five working fans, the fan-tray assembly could need replacement because a 
sixth working fan is required for extra protection against overheating.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the FAN Alarm

Step 1 Determine whether the air filter needs replacement. Complete the “Inspect, Clean, and Replace the 
Reusable Air Filter” procedure on page 2-279.

Step 2 If the filter is clean, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on 
page 2-281.
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Step 3 If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure 
on page 2-281. The fan should run immediately when correctly inserted.

Step 4 If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website 
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a 
Service-Affecting (SA) problem 1 800 553-2447.

2.7.107  FAPS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: FCMR

DWDM Logical Objects: TRUNK

The Fast Automatic Protection Switching condition is applicable to GEXP/10GEXP cards. This 
condition occurs when the protection port, on the master card, switches from blocking to forwarding 
state.

Clear the FAPS Alarm

Step 1 When the cause of switching disappears, the protection port switches from the forwarding to the 
blocking state, and the FAPS alarm clears.

Step 2 If the alarm does not clear even after the protection port switches back to the blocking state, log into the 
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC 
(1 800 553-2447).

2.7.108  FAPS-CONFIG-MISMATCH 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.109  FC-DE-NES
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: FCMR

DWDM Logical Objects: FC, TRUNK

The Fiber Channel Distance Extension Function Not Established condition occurs when the Fiber 
Channel client setup or distance extension configuration is incorrect.

Clear the FC-DE-NES Alarm

Step 1 Ensure that the FC client setup and distance extension configuration is correct.
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Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.7.110  FC-NO-CREDITS 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: FCMR

DWDM Logical Objects: FC, TRUNK

The Fibre Channel Distance Extension Credit Starvation alarm occurs on storage access networking 
(SAN) Fibre Channel/Fiber Connectivity (FICON) FC_MR-4 cards when the congestion prevents the 
generic framing procedure (GFP) transmitter from sending frames to the FC_MR-4 card port. For 
example, the alarm can be raised when an operator configures a card to autodetect framing credits but 
the card is not connected to an interoperable FC-SW-standards-based Fibre Channel/FICON port. 

FC-NO-CREDITS is raised only if transmission is completely prevented. (If traffic is slowed but still 
passing, this alarm is not raised.) The alarm is raised in conjunction with the GFP-NO-BUFFERS alarm. 
For example, if the FC-NO-CREDITS alarm is generated at an FC_MR-4 data port, a 
GFP-NO-BUFFERS alarm could be raised at the upstream remote FC_MR-4 data port.

Clear the FC-NO-CREDITS Alarm

Step 1 If the port is connected to a Fibre Channel/FICON switch, make sure it is configured for interoperation 
mode using the manufacturer’s instructions.

Step 2 If the port is not connected to a switch, turn off Autodetect Credits:

a. Double-click the FC_MR-4 card.

b. Click Provisioning > Port > General.

c. Under Admin State, click the cell and choose OOS,MT. 

d. Click Apply.

e. Click the Provisioning > Port > Distance Extension tabs.

f. Uncheck the Autodetect Credits column check box.

g. Click Apply.

h. Click Provisioning > Port > General.

i. Under Admin State, click the cell and choose IS. 

j. Click Apply.

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port 
service state transitions to OOS-AU,FLT.

Step 3 Program the Credits Available value based on the buffers available on the connected equipment: 
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Note The NumCredits must be provisioned to a value smaller than or equal to the receive buffers or 
credits available on the connected equipment.

a. Double-click the FC_MR-4 card.

b. Click the Provisioning > Port > Distance Extension tabs.

c. Enter a new value in the Credits Available column.

d. Click Apply.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a 
Service-Affecting (SA) problem.

2.7.111  FDI
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.112  FE-AIS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far-End AIS condition occurs when an AIS has occurred at the far-end node. FE-AIS usually occurs 
in conjunction with a downstream LOS alarm (see the “LOS (OCN)” alarm on page 2-165).

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit 
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on 
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised, 
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise 
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the FE-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-37.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.113  FEC-MISM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.114  FE-DS1-MULTLOS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far-End Multiple DS-1 LOS Detected condition occurs when multiple DS-1 signals are lost on a 
far-end DS-1 card. 

The prefix FE means the main alarm is occurring at the far-end node and not at the node reporting the 
FE-DS1-MULTLOS condition. Troubleshoot the FE alarm or condition by troubleshooting the main 
alarm at its source. The secondary alarms or conditions clear when the main alarm clears.

Clear the FE-DS1-MULTLOS Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE condition. For example, an ONS 15454 FE condition on a card in Slot 12 of Node 1 could relate to a 
main alarm from a card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting 
instructions.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.115  FE-DS1-NSA 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far End DS-1 Equipment Failure Non-Service-Affecting (NSA) condition occurs when a far-end 
DS-1 equipment failure occurs, but does not affect service because the port is protected and traffic is able 
to switch to the protect port.

Clear the FE-DS1-NSA Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an alarm from a card in an ONS 15454 Slot 12 of Node 1 could link to an alarm 
from a card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting 
instructions.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.116  FE-DS1-SA 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far End DS-1 Equipment Failure Service Affecting condition occurs when there is a far-end 
equipment failure on a DS-1 card that affects service because traffic is unable to switch to the protect 
port.

Clear the FE-DS1-SA Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in 
Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting 
instructions.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.117  FE-DS1-SNGLLOS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far-End Single DS-1 LOS condition occurs when a single DS-1 signal is lost on far-end DS-1 
equipment (within a DS3). Signal loss also causes the “LOS (OCN)” alarm on page 2-165.

Clear the FE-DS1-SNGLLOS Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could link to an alarm from 
a card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting 
instructions.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.118  FE-DS3-NSA 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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SONET Logical Object: DS3

The Far End DS-3 Equipment Failure Non-Service-Affecting (NSA) condition occurs when a far-end 
ONS 15454 DS-3 equipment failure occurs in C-bit framing mode, but does not affect service because 
the port is protected and traffic is able to switch to the protect port.

Clear the FE-DS3-NSA Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in 
Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting 
instructions.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.119  FE-DS3-SA 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far End DS-3 Equipment Failure Service Affecting condition occurs when there is a far-end 
equipment failure on an ONS 15454 DS-3 card in C-bit framing mode that affects service because traffic 
is unable to switch to the protect port.

Clear the FE-DS3-SA Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in 
Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting 
instructions.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.120  FE-EQPT-NSA 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3
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The Far End Common Equipment Failure condition occurs when a Non-Service-Affecting (NSA) 
equipment failure is detected on far-end DS-3 equipment. 

Clear the FE-EQPT-NSA Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm 
from a card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting 
instructions.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.121  FE-FRCDWKSWBK-SPAN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Far End Forced Switch Back to Working—Span condition is raised on a far-end 1+1 working port 
when it is Force switched to the working port.

Note WKSWBK-type conditions apply only to revertive circuits.

Clear the FE-FRCDWKSWBK-SPAN Condition

Step 1 Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-264 for the far-end 
port.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.122  FE-FRCDWKSWPR-RING
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EC1, OCN

The Far End Ring Working Facility Forced to Switch to Protection condition occurs from a far-end node 
when a BLSR is forced from working to protect using the Force Ring command. This condition is only 
visible on the network view Conditions tab.
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Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the 
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. 

Step 4 If the FE-FRCDWKSWPR-RING condition does not clear, complete the “Clear a BLSR External 
Switching Command” procedure on page 2-270.

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.123  FE-FRCDWKSWPR-SPAN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Far End Working Facility Forced to Switch to Protection Span condition occurs from a far-end node 
when a span on a four-fiber BLSR is forced from working to protect using the Force Span command. 
This condition is only visible on the network view Conditions tab. The port where the Force Switch 
occurred is indicated by an “F” on the network view detailed circuit map. This condition is accompanied 
by WKSWPR.

Clear the FE-FRCDWKSWPR-SPAN Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the 
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. 

Step 4 If the FE-FRCDWKSWPR-SPAN condition does not clear, complete the “Clear a BLSR External 
Switching Command” procedure on page 2-270.

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.124  FE-IDLE 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far End Idle condition occurs when a far-end node detects an idle DS-3 signal in C-bit framing 
mode. 
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Step 1 To troubleshoot the FE condition, determine which node and card link directly to the card reporting the 
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm 
from a card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm by clearing the protection switch. See the “2.9.2  Protection Switching, Lock 
Initiation, and Clearing” section on page 2-263 for commonly used traffic-switching procedures.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.125  FE-LOCKOUTOFPR-SPAN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Far-End Lock Out of Protection Span condition occurs when a BSLR span is locked out of the 
protection system from a far-end node using the Lockout Protect Span command. This condition is only 
seen on the network view Conditions tab and is accompanied by LKOUTPR-S. The port where the 
lockout originated is marked by an “L” on the network view detailed circuit map.

Clear the FE-LOCKOUTOFPR-SPAN Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the 
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Ensure there is no lockout set. Complete the “Clear a BLSR External Switching Command” procedure 
on page 2-270.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.126  FE-LOF 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far End LOF condition occurs when a far-end node reports the “LOF (DS3)” alarm on page 2-150 
in C-bit framing mode. 
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Clear the FE-LOF Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm 
from a card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Complete the “Clear the LOF (DS1) Alarm” procedure on page 2-149. It also applies to FE-LOF.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.127  FE-LOS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The Far End LOS condition occurs in C-bit framing mode when a far-end node reports the “LOS (DS3)” 
alarm on page 2-160. 

Clear the FE-LOS Condition

Step 1 To troubleshoot the FE condition, determine which node and card link directly to the card reporting the 
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm 
from a card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Complete the “Clear the LOS (DS1) Alarm” procedure on page 2-159.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.128  FE-MANWKSWBK-SPAN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Far End Manual Switch Back to Working—Span condition occurs when a far-end span with a 
Manual switch reverts to working. 

Note WKSWBK-type conditions such as FE-MANWKSWBK-SPAN apply only to nonrevertive spans.
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Clear the FE-MANWKSWBK-SPAN Condition

Step 1 To troubleshoot the FE condition, determine which node and card link directly to the card reporting the 
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm 
from a card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.129  FE-MANWKSWPR-RING 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EC1, OCN

The Far End Ring Manual Switch of Working Facility to Protect condition occurs when a BLSR working 
ring is switched from working to protect at a far-end node using the Manual Ring command. 

Clear the FE-MANWKSWPR-RING Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the 
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.130  FE-MANWKSWPR-SPAN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Far-End Span Manual Switch Working Facility to Protect condition occurs when a four-fiber BLSR 
span is switched from working to protect at the far-end node using the Manual Span command. This 
condition is only visible on the network view Conditions tab and is accompanied by WKSWPR. The port 
where the Manual Switch occurred is indicated by an “M” on the network view detailed circuit map.
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Clear the FE-MANWKSWPR-SPAN Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the 
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.131  FEPRLF 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Far End Protection Line Failure alarm occurs when an APS channel “SF-L” condition on page 2-224 
occurs on the protect card coming into the node.

Note The FEPRLF alarm occurs when bidirectional protection is used on optical cards in a 1+1 protection 
group configuration or four-fiber BLSR configuration.

Clear the FEPRLF Alarm on a Four-Fiber BLSR

Step 1 To troubleshoot the FE alarm, determine which node and card link directly to the card reporting the FE 
alarm. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm from a 
card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter in this chapter for procedures.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.132  FIBERTEMP-DEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.133  FORCED-REQ 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, ML1000, ML100T, MLFX, STSMON, VT-MON
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The Force Switch Request on Facility or Port condition occurs when you enter the Force command on a 
port to force traffic from a working port to a protect port or protection span (or from a protect port to a 
working port or span). You do not need to clear the condition if you want the Force switch to remain.

FORCED-REQ is raised for an IEEE 802.17b-based RPR span if the force was requested in the 
Cisco IOS CLI using the “rpr-ieee protection request force-switch {east | west}” command. It clears 
from the IEEE 802.17b-based RPR span when you remove the switch in the CLI. For the 
IEEE 802.17b-based RPR interface, FORCED-REQ is suppressed by the “RPR-PASSTHR” alarm on 
page 2-210. It also suppresses the following alarms:

 • MAN-REQ, page 179

 • RPR-SF, page 215

 • RPR-SD, page 214

 • WTR, page 259 

Clear the FORCED-REQ Condition

Step 1 If the condition is raised on a SONET entity, complete the “Clear a 1+1 Force or Manual Switch 
Command” procedure on page 2-264. 

Step 2 If the condition is raised on an IEEE-802.17b-based RPR span, enter the following command in the CLI 
in RPR-IEEE interface configuration mode:

router(config-if)#no rpr-ieee protection request force-switch {east | west}

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.134  FORCED-REQ-RING 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Force Switch Request Ring condition applies to optical trunk cards when the Force Ring command 
is applied to BLSRs to move traffic from working to protect. This condition is visible on the network 
view Alarms, Conditions, and History tabs and is accompanied by the “WKSWPR” alarm on page 2-259. 
The port where the FORCE RING command originated is marked with an “F” on the network view 
detailed circuit map.

Clear the FORCED-REQ-RING Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
2-113
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.135    FORCED-REQ-SPAN
2.7.135  FORCED-REQ-SPAN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EC1, OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Force Switch Request Span condition can apply to optical trunk cards in two-fiber or four-fiber 
BLSRs when the Force Span command is applied to a BLSR SPAN to force traffic from working to 
protect or from protect to working. This condition appears on the network view Alarms, Conditions, and 
History tabs. The port where the FORCE SPAN command was applied is marked with an “F” on the 
network view detailed circuit map.

FORCED-REQ can be raised in 1+1 facility protection groups. If traffic is present on a working port and 
you use the FORCE command to prevent it from switching to the protect port (indicated by “FORCED 
TO WORKING”), FORCED-REQ-SPAN indicates this force switch. In this case, the force is affecting 
not only the facility, but the span.

Clear the FORCED-REQ-SPAN Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.136  FP-LINK-LOSS 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Front Port Link Loss condition occurs when a LAN cable is not connected to the front port of the 
TCC2/TCC2P card.

Clear the FP-LINK-LOSS Condition

Step 1 Connect a LAN cable to the front port of the TCC2/TCC2P card.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.137  FRCDSWTOINT 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE-SREF

The Force Switch to Internal Timing condition occurs when the user issues a FORCE command to switch 
to an internal timing source.
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2.7.138    FRCDSWTOPRI
Note FRCDSWTOINT is an informational condition and does not require troubleshooting.

2.7.138  FRCDSWTOPRI 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Primary Timing Source condition occurs when the user issues a FORCE command 
to switch to the primary timing source.

Note FRCDSWTOPRI is an informational condition and does not require troubleshooting.

2.7.139  FRCDSWTOSEC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Second Timing Source condition occurs when the user issues a FORCE command 
to switch to the second timing source.

Note FRCDSWTOSEC is an informational condition and does not require troubleshooting.

2.7.140  FRCDSWTOTHIRD 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Third Timing Source condition occurs when the user issues a Force command to 
switch to a third timing source.

Note FRCDSWTOTHIRD is an informational condition and does not require troubleshooting.

2.7.141  FRNGSYNC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE-SREF

The Free Running Synchronization Mode condition occurs when the reporting ONS 15454 is in free-run 
synchronization mode. External timing sources have been disabled and the node is using its internal 
clock, or the node has lost its designated building integrated timing supply (BITS) timing source. After 
the 24-hour holdover period expires, timing slips could begin to occur on an ONS 15454 node relying 
on an internal clock.
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Note If the ONS 15454 is configured to operate from its internal clock, disregard the FRNGSYNC condition.

Clear the FRNGSYNC Condition

Step 1 If the ONS 15454 is configured to operate from an external timing source, verify that the BITS timing 
source is valid. Common problems with a BITS timing source include reversed wiring and bad timing 
cards. Refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual for more information.

Step 2 If the BITS source is valid, clear alarms related to the failures of the primary and secondary reference 
sources, such as the “SYNCPRI” alarm on page 2-242 and the “SYNCSEC” alarm on page 2-243.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.142  FSTSYNC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE-SREF

A Fast Start Synchronization Mode condition occurs when the node is choosing a new timing reference. 
The previous timing reference has failed.

The FSTSYNC alarm disappears after approximately 30 seconds. If the condition does not clear, log into 
the Technical Support Website at http://www.cisco.com/techsupport for more information or call 
Cisco TAC 1 800 553-2447.

Note FSTSYNC is an informational condition. It does not require troubleshooting.

2.7.143  FTA-MISMATCH
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.144  FULLPASSTHR-BI 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Bidirectional Full Pass-Through Active condition occurs on a nonswitching node in a BLSR when 
the protect channels on the node are active and carrying traffic and there is a change in the receive K byte 
from No Request.
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Clear the FULLPASSTHR-BI Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.145  GAIN-HDEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.146  GAIN-HFAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.147  GAIN-LDEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.148  GAIN-LFAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.149  GCC-EOC 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.150  GE-OOSYNC 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.151  GFP-CSF
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX
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2.7.152    GFP-DE-MISMATCH
The GFP Client Signal Fail Detected alarm is a secondary alarm raised on local GFP data ports when a 
remote Service-Affecting (SA) alarm causes invalid data transmission. The alarm is raised locally on 
FC_MR-4, ML100T, ML1000, ML100X-8, MXP_MR_25G, and MXPP_MR_25G GFP data ports and 
does not indicate that a Service-Affecting (SA) failure is occurring at the local site, but that a CARLOSS, 
LOS, or SYNCLOSS alarm caused by an event such as a pulled receive cable is affecting a remote data 
port's transmission capability. This alarm can be demoted when a facility loopback is placed on the 
FC_MR-4 port.

Note For more information about provisioning MXP or TXP cards, refer to the Cisco ONS 15454 DWDM 
Reference Manual. For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the GFP-CSF Alarm

Step 1 Clear the Service-Affecting (SA) alarm at the remote data port.

Step 2 If the GFP-CSF alarm does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a 
Service-Affecting (SA) problem.

2.7.152  GFP-DE-MISMATCH 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: FCMR, GFP-FAC

The GFP Fibre Channel Distance Extension Mismatch alarm indicates that a port configured for 
Distance Extension is connected to a port that is not operating in Cisco's proprietary Distance Extension 
mode. It is raised on Fibre Channel and FICON card GFP ports supporting distance extension. The alarm 
occurs when distance extension is enabled on one side of the transport but not on the other. To clear, 
distance extension must be enabled on both ports connected by a circuit.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the GFP-DE-MISMATCH Alarm

Step 1 Ensure that the distance extension protocol is configured correctly on both sides:

a. Double-click the card to open the card view.

b. Click the Provisioning > Port > General tabs.

c. Under Admin State, click the cell and choose OOS,MT.

d. Click Apply.

e. Click the Provisioning > Port > Distance Extension tabs.

f. Check the check box in the Enable Distance Extension column.
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g. Click Apply.

h. Click the Provisioning > Port > General tabs.

i. Under Admin State, click the cell and choose IS.

j. Click Apply.

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised 
or remains, and the port service state transitions to OOS-AU,FLT.

Step 2 If the GFP-DE-MISMATCH alarm does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a 
Service-Affecting (SA) problem.

2.7.153  GFP-EX-MISMATCH 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: CE1000, FCMR, GFP-FAC

The GFP Extension Header Mismatch alarm is raised on Fibre Channel/FICON cards when it receives 
frames with an extension header that is not null. The alarm occurs when a provisioning error causes all 
GFP frames to be dropped for 2.5 seconds.

Ensure that both end ports are sending a null extension header for a GFP frame. The FC_MR-4 card 
always sends a null extension header, so if the equipment is connected to other vendors’ equipment, 
those need to be provisioned appropriately. 

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the GFP-EX-MISMATCH Alarm

Step 1 Ensure that the vendor equipment is provisioned to send a null extension header in order to interoperate 
with the FC_MR-4 card. (The FC_MR-4 card always sends a null extension header.)

Step 2 If the GFP-EX-MISMATCH alarm does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a 
Service-Affecting (SA) problem.

2.7.154  GFP-LFD 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX
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The GFP Loss of Frame Delineation alarm applies to Fibre Channel, FICON GFP, and Ethernet ports. 
This alarm occurs if there is a bad SONET connection, if SONET path errors cause GFP header errors 
in the check sum calculated over payload length (PLI/cHEC) combination, or if the GFP source port 
sends an invalid PLI/cHEC combination. The loss causes traffic stoppage. 

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the GFP-LFD Alarm

Step 1 Look for and clear any associated SONET path errors such as LOS or AIS-L originating at the transmit 
node.

Step 2 If the GFP-LFD alarm does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a 
Service-Affecting (SA) problem.

2.7.155  GFP-NO-BUFFERS 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: FCMR, GFP-FAC

The GFP Fibre Channel Distance Extension Buffer Starvation alarm is raised on Fibre Channel/FICON 
card ports supporting GFP and the distance extension protocol when the GFP transmitter cannot send 
GFP frames due to lack of remote GFP receiver buffers. This occurs when the remote GFP-T receiver 
experiences congestion and is unable to send frames over the Fibre Channel/FICON link.

This alarm could be raised in conjunction with the “FC-NO-CREDITS” alarm on page 2-102. For 
example, if the FC-NO-CREDITS alarm is generated at an FC_MR-4 data port, a GFP-NO-BUFFERS 
alarm could be raised at the upstream remote FC_MR-4 data port.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the GFP-NO-BUFFERS Alarm

Step 1 Complete the “Clear the FC-NO-CREDITS Alarm” procedure on page 2-102.

Step 2 If the GFP-CSF alarm does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a 
Service-Affecting (SA) problem.
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2.7.156  GFP-UP-MISMATCH 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX

The GFP User Payload Mismatch is raised against Fibre Channel/FICON ports supporting GFP. It occurs 
when the received frame user payload identifier (UPI) does not match the transmitted UPI and all frames 
are dropped. The alarm is caused by a provisioning error, such as the port media type not matching the 
remote port media type. For example, the local port media type could be set to Fibre Channel—1 Gbps 
ISL or Fibre Channel—2 Gbps ISL and the remote port media type could be set to FICON—1 Gbps ISL 
or FICON—2 Gbps ISL.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the GFP-UP-MISMATCH Alarm

Step 1 Ensure that the transmit port and receive port are identically provisioned for distance extension by 
completing the following steps:

a. Double-click the card to open the card view.

b. Click the Provisioning > Port > Distance Extension tabs.

c. Check the check box in the Enable Distance Extension column.

d. Click Apply.

Step 2 Ensure that both ports are set for the correct media type. For each port, complete the following steps:

a. Double-click the card to open the card view (if you are not already in card view).

b. Click the Provisioning > Port > General tabs.

c. Choose the correct media type (Fibre Channel - 1Gbps ISL, Fibre Channel - 2 Gbps ISL, 
FICON - 1 Gbps ISL, or FICON - 2 Gbps ISL) from the drop-down list.

d. Click Apply.

Step 3 If the GFP-UP-MISMATCH alarm does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 to report a 
Service-Affecting (SA) problem.

2.7.157  HELLO 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

DWDM Logical Object: TRUNK

The Open Shortest Path First (OSPF) Hello alarm is raised when the two end nodes cannot bring an 
OSPF neighbor up to the full state. Typically, this problem is caused by an area ID mismatch, and/or an 
OSPF HELLO packet loss over the DCC.
2-121
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.158    HIBATVG
Clear the HELLO Alarm

Step 1 Ensure that the area ID is correct on the missing neighbor:

a. In node view, click the Provisioning > Network > OSPF tabs.

b. Ensure that the IP address in the Area ID column matches the other nodes.

c. If the address does not match, click the incorrect cell and correct it.

d. Click Apply.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.158  HIBATVG 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: PWR

The High Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input voltage 
exceeds the high power threshold. This threshold, with a default value of –52 VDC, is 
user-provisionable. The alarm remains raised until the voltage remains under the threshold for 
120 seconds. (For information about changing this threshold, refer to the “Turn Up Node” chapter in the 
Cisco ONS 15454 Procedure Guide.

Clear the HIBATVG Alarm

Step 1 The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.159  HI-CCVOLT
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: BITS

The 64K Composite Clock High NE Voltage alarm occurs when the 64K signal peak voltage exceeds 
1.1 VDC. 

Clear the HI-CCVOLT Condition

Step 1 Lower the source voltage to the clock.

Step 2 If the condition does not clear, add more cable length or add a 5 dBm attenuator to the cable.
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Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.160  HI-LASERBIAS 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM, TRUNK

The Equipment High Transmit Laser Bias Current alarm is raised against TXP_MR_10G, 
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, MRC-12, MRC-4, and 
OC192-XFP card laser performance. The alarm indicates that the card laser has reached the maximum 
laser bias tolerance. 

Laser bias typically starts at about 30 percent of the manufacturer maximum laser bias specification and 
increases as the laser ages. If the HI-LASERBIAS alarm threshold is set at 100 percent of the maximum, 
the laser usability has ended. If the threshold is set at 90 percent of the maximum, the card is still usable 
for several weeks or months before it needs to be replaced.

Note For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and 
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about 
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual. 

Clear the HI-LASERBIAS Alarm

Step 1 Complete the “Clear the LASEREOL Alarm” procedure on page 2-138, which can include replacing the 
card. Replacement is not urgent and can be scheduled during a maintenance window.

Caution Removing an active card can cause a traffic hit. To avoid this, perform an external switch if a switch has 
not already occurred. See the “2.9.2  Protection Switching, Lock Initiation, and Clearing” section on 
page 2-263 for commonly used traffic-switching procedures.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.161  HI-LASERTEMP 
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

SONET Logical Objects: EQPT, OCN

DWDM Logical Object: PPM
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The Equipment High Laser Optical Transceiver Temperature alarm applies to the TXP and MXP cards. 
HI-LASERTEMP occurs when the internally measured transceiver temperature exceeds the card setting 
by 35.6 degrees F (2 degrees C). A laser temperature change affects the transmitted wavelength. 

When the TXP or MXP card raises this alarm, the laser is automatically shut off. The “LOS (OCN)” 
alarm on page 2-165 is raised at the far-end node and the “DUP-IPADDR” alarm on page 2-79 is raised 
at the near end.

Note For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and 
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information 
about the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual. 

Clear the HI-LASERTEMP Alarm 

Step 1 In node view, double-click the TXP or MXP card to open the card view.

Step 2 Click the Performance > Optics PM > Current Values tabs.

Step 3 Verify the card laser temperature levels. Maximum, minimum, and average laser temperatures are shown 
in the Current column entries in the Laser Temp rows. 

Step 4 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the MXP or TXP card. 

Step 5 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting MXP or TXP card. 

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.162  HI-RXPOWER 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Equipment High Receive Power alarm is an indicator of the optical signal power that is transmitted 
to the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, MRC-12, 
MRC-4, or OC192-XFP card. HI-RXPOWER occurs when the measured optical power of the received 
signal exceeds the threshold. The threshold value is user-provisionable.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference 
Manual. 

Note When you upgrade a node to Software Release 6.0 or later, this enables received optical power PMs for 
the OC3-8, OC192-SR, OC192-IR, OC192-ITU, OC-192-XFP, MRC-12, and MRC25G-4 cards. The 
newly enabled HI-RXPOWER and LO-RXPOWER alarms require that you initialize a site-accepted 
optical power (OPR0) nominal value after the upgrade. (To do this, refer to the procedure in the “Turn 
2-124
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.163    HITEMP
Up a Node” chapter in the Cisco ONS 15454 Procedure Guide.) When you apply the value change, CTC 
uses the new OPR0 value to calculate PM percentage values. If you do not change the nominal value, the 
HI-RXPOWER or LO-RXPOWER may be raised in response to the unmodified setting.

Clear the HI-RXPOWER Alarm

Step 1 Find out whether gain (the amplification power) of any amplifiers has been changed. This change also 
causes channel power to need adjustment.

Step 2 Find out whether channels have been dropped from the fiber. Increasing or decreasing channels can 
affect power. If channels have been dropped, the power levels of all channels have to be adjusted.

Note If the card is part of an amplified DWDM system, dropping channels on the fiber affects the 
transmission power of each channel more than it would in an unamplified system.

Step 3 At the transmit end of the errored circuit, decrease the transmit power level within safe limits.

Step 4 If neither of these problems cause the HI-RXPOWER alarm, there is a slight possibility that another 
wavelength is drifting on top of the alarmed signal. In this case, the receiver gets signals from two 
transmitters at the same time and data alarms would be present. If wavelengths are drifting, the data is 
garbled and receive power increases by about +3 dBm.

Step 5 If the alarm does not clear, add fiber attenuators to the receive ports. Start with low-resistance attenuators 
and use stronger ones as needed, depending on factors such as the transmission distance, according to 
standard practice.

Step 6 If the alarm does not clear and no faults are present on the other port(s) of the transmit or receive card, 
use a known-good loopback cable to complete the “1.6.1  Perform a Facility Loopback on a 
Source-Node FC_MR Port” procedure on page 1-94 and test the loopback. 

Step 7 If a port is bad and you need to use all the port bandwidth, complete the “Physically Replace a Traffic 
Card” procedure on page 2-274. If the port is bad but you can move the traffic to another port, replace 
the card at the next available maintenance window.

Step 8 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.163  HITEMP 
Default Severity: Critical (CR), Service-Affecting (SA) for NE; Default Severity: Minor (MN), 
Non-Service-Affecting (NSA) for EQPT

SONET Logical Objects: EQPT, NE

The High Temperature alarm occurs when the temperature of the ONS 15454 is above 122 degrees F 
(50 degrees C).

Clear the HITEMP Alarm

Step 1 View the temperature displayed on the ONS 15454 LCD front panel (Figure 2-2).
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Figure 2-2 Shelf LCD Panel

Step 2 Verify that the environmental temperature of the room is not abnormally high.

Step 3 If the room temperature is not abnormal, physically ensure that nothing prevents the fan-tray assembly 
from passing air through the ONS 15454 shelf.

Step 4 If airflow is not blocked, physically ensure that blank faceplates fill the ONS 15454 shelf empty slots. 
Blank faceplates help airflow.

Step 5 If faceplates fill the empty slots, determine whether the air filter needs replacement. Refer to the 
“Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-279.

Step 6 If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure 
on page 2-281.

Note The fan should run immediately when correctly inserted.

Step 7 If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website 
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a 
Service-Affecting (SA) problem 1 800 553-2447 if it applies to the NE, or a 
Non-Service-Affecting (NSA) problem if it applies to equipment.

2.7.164  HI-TXPOWER 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM, TRUNK

The Equipment High Transmit Power alarm is an indicator on the TXP_MR_E, TXP_MR_10G, 
TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, MRC-12, MRC-4, or OC192-XFP card 
transmitted optical signal power. HI-TXPOWER occurs when the measured optical power of the 
transmitted signal exceeds the threshold.

Note For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and 
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about 
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual. 

Clear the HI-TXPOWER Alarm

Step 1 In node view, double-click the card view for the TXP_MR_10E, TXP_MR_10G, TXP_MR_2.5G, 
TXPP_MR_2.5G, MXP_2.5G_10G, or OC192-XFP card.

FAN FAIL

Slot

8/18/03
04.06-002L-10 

24˚C

97
75

8CRIT MAJ MIN

Status Port
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Step 2 Click the Provisioning > Optics Thresholds > Current Values tabs.

Step 3 Decrease (change toward the negative direction) the OPT-HIGH column value by 0.5 dBm.

Step 4 If the card transmit power setting cannot be lowered without disrupting the signal, complete the 
“Physically Replace a Traffic Card” section on page 2-274.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.165  HLDOVRSYNC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE-SREF

The Holdover Synchronization Mode condition is caused by loss of the primary and second timing 
references in the node. Timing reference loss occurs when line coding on the timing input is different 
from the configuration on the node, and it often occurs during the selection of a new node reference 
clock. The condition clears when primary or second timing is reestablished. After the 24-hour holdover 
period expires, timing slips could begin to occur on an ONS 15454 relying on an internal clock.

Clear the HLDOVRSYNC Condition

Step 1 Clear additional alarms that relate to timing, such as:

 • 2.7.141  FRNGSYNC, page 2-115

 • 2.7.142  FSTSYNC, page 2-116 

 • 2.7.200  LOF (BITS), page 2-148 

 • 2.7.217  LOS (BITS), page 2-158 

 • 2.7.264  MANSWTOINT, page 2-179 

 • 2.7.265  MANSWTOPRI, page 2-180 

 • 2.7.266  MANSWTOSEC, page 2-180 

 • 2.7.267  MANSWTOTHIRD, page 2-180 

 • 2.7.403  SWTOPRI, page 2-240 

 • 2.7.404  SWTOSEC, page 2-240 

 • 2.7.405  SWTOTHIRD, page 2-240 

 • 2.7.406  SYNC-FREQ, page 2-241 

 • 2.7.408  SYNCPRI, page 2-242 

 • 2.7.409  SYNCSEC, page 2-243 

 • 2.7.410  SYNCTHIRD, page 2-243

Step 2 Reestablish a primary and secondary timing source according to local site practice. If none exists, refer 
to the “Change Node Settings” chapter in the Cisco ONS 15454 Procedure Guide.
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Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 in order to 
report a Service-Affecting (SA) problem.

2.7.166  I-HITEMP 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: NE

The Industrial High Temperature alarm occurs when the temperature of the ONS 15454 is above 149 
degrees F (65 degrees C) or below –40 degrees F (–40 degrees C). This alarm is similar to the HITEMP 
alarm but is used for the industrial environment. If this alarm is used, you can customize your alarm 
profile to ignore the lower-temperature HITEMP alarm. 

Clear the I-HITEMP Alarm

Step 1 Complete the “Clear the HITEMP Alarm” procedure on page 2-125. 

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem. 

2.7.167  ILK-FAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.168  IMPROPRMVL 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

DWDM Logical Object: PPM

The Improper Removal equipment alarm occurs when a card is physically removed from its slot before 
it is deleted from CTC. The card does not need to be in service to cause the IMPROPRMVL alarm; it 
only needs to be recognized by CTC. The alarm does not appear if you delete the card from CTC before 
you physically remove the card from the node. It can also occur if the card is inserted into a slot but is 
not fully plugged into the backplane. For PPMs, the alarm occurs if you provision a PPM but no physical 
module is inserted on the port.

Caution Do not remove a card during a card reboot. If CTC begins to reboot a card before you remove the card, 
allow the card to finish rebooting. After the card reboots, delete the card in CTC again and physically 
remove the card before it begins to reboot.
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Note CTC gives the user approximately 15 seconds to physically remove the card before CTC begins a card 
reboot.

Note It can take up to 30 minutes for software to be updated on a standby TCC2/TCC2P.

Clear the IMPROPRMVL Alarm

Step 1 In node view, right-click the card reporting the IMPROPRMVL.

Step 2 Choose Delete from the shortcut menu.

Note CTC does not allow you to delete the reporting card if the card is in service, does have circuits 
mapped to it, is paired in a working protection scheme, has DCC enabled, or is used as a timing 
reference.

Step 3 If any ports on the card are in service, place them out of service (OOS,MT):

Caution Before placing a port out of service (OOS,MT or OOS,DSBLD), ensure that no live traffic is present.

a. In node view, double-click the reporting card to open the card view.

b. Click the Provisioning > Line tab.

c. Click the Admin State column of any in-service (IS) ports.

d. Choose OOS,MT to take the ports out of service.

Step 4 If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-276.

Caution Before deleting the circuit, ensure that the circuit does not carry live traffic.

Step 5 If the card is paired in a protection scheme, delete the protection group:

a. Click View > Go to Previous View to return to node view.

b. If you are already in node view, click the Provisioning > Protection tabs.

c. Click the protection group of the reporting card.

d. Click Delete.

Step 6 If the card is provisioned for DCC, delete the DCC provisioning:

a. Click the ONS 15454 Provisioning > Comm Channels > SDCC tabs. 

b. Click the slots and ports listed in DCC terminations.

c. Click Delete and click Yes in the dialog box that appears.

Step 7 If the card is used as a timing reference, change the timing reference:

a. Click the Provisioning > Timing > General tabs.

b. Under NE Reference, click the drop-down arrow for Ref-1.
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c. Change Ref-1 from the listed OC-N card to Internal Clock.

d. Click Apply.

Step 8 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem. 

2.7.169  INCOMPATIBLE-SEND-PDIP
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: SYSTEM

The Incompatible Software alarm is raised when the PDIP provisioning on CTC differs from the 
provisioning on the host node.

Clear the INCOMPATIBLE-SEND-PDIP Alarm

Step 1 Reconfigure the send-PDI-P-alarm capability in CTC to align with the host node settings.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call TAC (1-800-553-2447). 

2.7.170  INCOMPATIBLE-SW
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: SYSTEM

The Incompatible Software alarm is raised when CTC cannot connect to the NE due to incompatible 
versions of software between CTC and the NE. The alarm is cleared by restarting CTC in order to 
redownload the CTC jar files from the NE.

Clear the INCOMPATIBLE-SW Alarm

Step 1 Restart the CTC application.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call TAC (1-800-553-2447). 

2.7.171  INC-ISD 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3
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The DS-3 Idle condition indicates that the DS-3 card is receiving an idle signal, meaning that the payload 
of the signal contains a repeating pattern of bits. The INC-ISD condition occurs when the transmitting 
port has an OOS-MA,MT service state. It is resolved when the OOS-MA,MT state ends.

Note INC-ISD is a condition and not an alarm. It is for information only and does not require troubleshooting.

2.7.172  INHSWPR 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Inhibit Switch To Protect Request on Equipment condition occurs on traffic cards when the ability 
to switch to protect has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic 
remains locked onto the working system. If the card is part of a 1:N protection scheme, traffic can be 
switched between working cards when the switch to protect is disabled.

Clear the INHSWPR Condition

Step 1 If the condition is raised against a 1+1 port, complete the “Initiate a 1+1 Manual Switch Command” 
section on page 2-263. 

Step 2 If the condition is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command” 
procedure on page 2-266 to switch it back.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.173  INHSWWKG 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Inhibit Switch To Working Request on Equipment condition occurs on traffic cards when the ability 
to switch to working has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic 
remains locked onto the protect system. If the card is part of a 1:N protection scheme, traffic can be 
switched between protect cards when the switch to working is disabled.

Clear the INHSWWKG Condition

Step 1 If the condition is raised against a 1+1 port, complete the “Initiate a 1+1 Manual Switch Command” 
section on page 2-263. 

Step 2 If it is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command” procedure on 
page 2-266 to switch traffic back.
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Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.174  INTRUSION-PSWD 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE

The Security Intrusion Incorrect Password condition occurs after a user attempts a provisionable (by 
Superuser) number of unsuccessful logins, a login with an expired password, or an invalid password. The 
alarmed user is locked out of the system, and INTRUSION-PSWD condition is raised. This condition is 
only shown in Superuser login sessions, not in login sessions for lower-level users. The 
INTRUSION-PSWD condition is automatically cleared when a provisionable lockout timeout expires, 
or it can be manually cleared in CTC by the Superuser if the lockout is permanent.

Clear the INTRUSION-PSWD Condition

Step 1 Click the Provisioning > Security > Users tabs.

Step 2 Click Clear Security Intrusion Alarm.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.175  INVMACADR 
Default Severity: Major (MJ), Non-Service Affecting (NSA)

SONET Logical Object: AIP

The Equipment Failure Invalid MAC Address alarm occurs when the ONS 15454 MAC address is 
invalid. Each ONS 15454 has a unique, permanently assigned MAC address. The address resides on an 
AIP EEPROM. The TCC2/TCC2P reads the address value from the AIP chip during boot-up and keeps 
this value in its synchronous dynamic RAM (SDRAM). 

Under normal circumstances, the read-only MAC address can be viewed in the Provisioning/Network 
tab in CTC.

The ONS 15454 uses both IP and MAC addresses for circuit routing. When an INVMACADR alarm 
exists on a node, you see a PARTIAL circuit in the CTC circuit status column. The circuit works and is 
able to carry traffic, but CTC cannot logically display the circuit end-to-end information.

An invalid MAC address can be caused when:

 • There is a read error from the AIP during bootup; in this case, the reading TCC2/TCC2P uses the 
default MAC address (00-10-cf-ff-ff-ff).

 • There is a read error occurring on one of the redundant TCC2/TCC2Ps that read the address from 
the AIP; these cards read the address independently and could therefore each read different address 
values.

 • An AIP component failure causes a read error.
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 • The ribbon cable connecting the AIP card to the backplane is bad.

Clear the INVMACADR Alarm

Step 1 Check for any outstanding alarms that were raised against the active and standby TCC2/TCC2P and 
resolve them.

Step 2 If the alarm does not clear, determine whether the LCD display on the fan tray (Figure 2-2 on 
page 2-126) is blank or if the text is garbled. If so, proceed to Step 8. If not, continue with Step 3.

Step 3 At the earliest maintenance window, reset the standby TCC2/TCC2P:

Note The reset requires approximately five minutes. Do not perform any other step until the reset is 
complete.

a. Log into a node on the network. If you are already logged in, continue with Step b.

b. Identify the active TCC2/TCC2P.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

c. Right-click the standby TCC2/TCC2P in CTC.

d. Choose Reset Card from the shortcut menu.

e. Click Yes in the Are You Sure dialog box.

The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC 
switches to network view.

f. Verify that the reset is complete and error-free, and that no new related alarms appear in CTC. A 
green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

g. Double-click the node and ensure that the reset TCC2/TCC2P is still in standby mode and that the 
other TCC2/TCC2P is active.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

h. Ensure that no new alarms associated with this reset appear in the CTC Alarms window.

If the standby TCC2/TCC2P fails to boot into standby mode and reloads continuously, the AIP is 
probably defective. In this case, the standby TCC2/TCC2P is unsuccessfully attempting to read the 
EEPROM located on the AIP. The TCC2/TCC2P reloads until it reads the EEPROM. Proceed to Step 8.

Step 4 If the standby TCC2/TCC2P rebooted successfully into standby mode, complete the “Remove and 
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-273.

Resetting the active TCC2/TCC2P causes the standby TCC2/TCC2P to become active. The standby 
TCC2/TCC2P keeps a copy of the chassis MAC address. If its stored MAC address is valid, the alarm 
should clear.

Step 5 After the reset, note whether or not the INVMACADR alarm has cleared or is still present.

Step 6 Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on 
page 2-271 again to place the standby TCC2/TCC2P back into active mode. 

After the reset, note whether or not the INVMACADR alarm has cleared or is still present. If the 
INVMACADR alarm remains standing through both TCC2/TCC2P resets, this indicates that the AIP is 
probably defective. Proceed to Step 8.

If the INVMACADR was raised during one TCC2/TCC2P reset and cleared during the other, the 
TCC2/TCC2P that was active while the alarm was raised needs to be replaced. Continue with Step 7.
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Step 7 If the faulty TCC2/TCC2P is currently in standby mode, complete the “Physically Replace a Traffic 
Card” procedure on page 2-274 for this card. If the faulty TCC2/TCC2P is currently active, during the 
next available maintenance window complete the “Reset an Active TCC2/TCC2P Card and Activate the 
Standby Card” procedure on page 2-271 and then complete the “Physically Replace a Traffic Card” 
procedure on page 2-274.

Note If the replacement TCC2/TCC2P is loaded with a different software version from the current 
TCC2/TCC2P, the card bootup could take up to 30 minutes. During this time, the card LEDs 
flicker between Fail and Act/Sby as the active TCC2/TCC2P version software is copied to the 
new standby card.

Step 8 Open a case with Cisco TAC (1 800 553-2447) for assistance with determining the node’s previous MAC 
address.

Step 9 Replace the ribbon cable between the system board and the AIP with a known-good cable.

Step 10 If the alarm persists, complete the “Replace the Alarm Interface Panel” procedure on page 2-283.

Step 11 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.176  IOSCFGCOPY 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The IOS Configuration Copy in Progress condition occurs on ML-Series Ethernet cards when a 
Cisco IOS startup configuration file is being uploaded or downloaded to or from an ML-Series card. 
(This condition is very similar to the “SFTWDOWN” condition on page 2-225 but it applies to 
ML-Series Ethernet cards rather than to the TCC2/TCC2P.) 

The condition clears after the copy operation is complete. (If it does not complete correctly, the 
“NO-CONFIG” condition on page 2-188 could be raised.)

Note IOSCFGCOPY is an informational condition.

Note For more information about the ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

2.7.177  ISIS-ADJ-FAIL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Open System Interconnection (OSI) Intermediate System to Intermediate-System (IS-IS) Adjacency 
Failure alarm is raised by an intermediate system (node routing IS Level 1 or Level 1 and 2) when no IS 
or end system (ES) adjacency is established on a point-to-point subnet. The Intermediate-System 
Adjacency Failure alarm is not supported by ES. It is also not raised by IS for disabled routers.
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The alarm is typically caused by a misconfigured router manual area adjacency (MAA) address. For 
more information about IS-IS OSI routing and MAA configuration, refer to the “Management Network 
Connectivity” chapter in the Cisco ONS 15454 Reference Manual. For more information about 
configuring OSI, refer to the “Turn Up Node” chapter in the Cisco ONS 15454 Procedure Guide.

Clear the ISIS-ADJ-FAIL Alarm

Step 1 Ensure that both ends of the communication channel are using the correct Layer 2 protocol and settings 
(LAPD or PPP). To do this, complete the following steps:

a. At the local node, in node view, click the Provisioning > Comm Channels > SDCC tabs.

b. Click the row of the circuit. Click Edit.

c. In the Edit SDCC termination dialog box, view and record the following selections: Layer 2 protocol 
(LAPD or PPP); Mode radio button selection (AITS or UITS); Role radio button selection (Network 
or User); MTU value; T200 value, and T203 selections.

d. Click Cancel.

e. Login to the remote node and follow the same steps, also recording the same information for this 
node.

Step 2 If both nodes do not use the same Layer 2 settings, you will have to delete the incorrect termination and 
recreate it. To delete it, click the termination and click Delete. To recreate it, refer to the “Turn Up Node” 
chapter in the Cisco ONS 15454 Procedure Guide for the procedure.

Step 3 If the nodes use PPP Layer 2, complete the “Clear the EOC Alarm” procedure on page 2-84. If the alarm 
does not clear, go to Step 7.

Step 4 If both nodes use the LAPD Layer 2 protocol but have different Mode settings, change the incorrect 
node’s entry by clicking the correct setting radio button in the Edit SDCC termination dialog box and 
clicking OK.

Step 5 If the Layer 2 protocol and Mode settings are correct, ensure that one node is using the Network role and 
the other has the User role. If not (that is, if both have the same mode settings), correct the incorrect one 
by clicking the correct radio button in the Edit SDCC termination dialog box and clicking OK.

Step 6 If the Layer 2, Mode, and Role settings are correct, compare the MTU settings for each node. If one is 
incorrect, choose the correct value in the Edit SDCC dialog box and click OK. 

Step 7 If all of the preceding settings are correct, ensure that OSI routers are enabled for the communications 
channels at both ends: 

a. Click Provisioning > OSI > Routers > Setup tabs.

b. View the router entry under the Status column. If the status is Enabled, check the other end. 

c. If the Status is Disabled, click the router entry and click Edit.

d. Check the Enabled check box and click OK.

Step 8 If the routers on both ends are enabled and the alarm still has not cleared, ensure that both ends of the 
communications channel have a common MAA:

a. Click the Provisioning > OSI > Routers > Setup tabs.

b. Record the primary MAA and secondary MAAs, if configured.

Tip You can record long strings of information such as the MAA address by using the CTC export and print 
functions. Export it by choosing File > Export > html. Print it by choosing File > Print.
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c. Log into the other node and record the primary MAA and secondary MAAs, if configured.

d. Compare this information. There should be at least one common primary or secondary MAA in 
order to establish an adjacency.

e. If there is no common MAA, one must be added to establish an adjacency. Refer to the “Turn Up 
Node” chapter in the Cisco ONS 15454 Procedure Guide for procedures.

Step 9 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.178  KB-PASSTHR 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The K Bytes Pass Through Active condition occurs on a nonswitching node in a BLSR when the protect 
channels on the node are not active and the node is in K Byte pass-through state. It also occurs when a 
BLSR ring is being exercised using the Exercise Ring command.

Clear the KB-PASSTHR Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.179  KBYTE-APS-CHAN-FAIL 
Default Severity: Minor (MN), Non-Service Affecting (NSA)

SONET Logical Object: OCN

The APS Channel Failure alarm is raised when a span is provisioned for different APS channels on each 
side. For example, the alarm is raised if K3 is selected on one end and F1, E2, or Z2 is selected on the 
other end.

This alarm is also raised during checksum failure if the K1 and K2 bytes are overwritten by test 
equipment. It is not raised in bidirectional full pass-through or K-byte pass-through states. The alarm is 
overridden by the “AIS-P” alarm on page 2-38, the “LOF (OCN)” alarm on page 2-152, the “LOS 
(OCN)” alarm on page 2-165 or the “SF-P” alarm on page 2-225.

Clear the KBYTE-APS-CHAN-FAIL Alarm

Step 1 The alarm is most frequently raised due to mismatched span provisioning. In this case, reprovision one 
side of the span with the same parameters. To do this, refer to the “Turn Up Network” chapter in the 
Cisco ONS 15454 Procedure Guide.
2-136
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.180    LAN-POL-REV
Step 2 If the error is not caused by misprovisioning, it is due to checksum errors within an OC-N, cross-connect, 
or TCC2/TCC2P. In this case, complete the “Side Switch the Active and Standby Cross-Connect Cards” 
procedure on page 2-272 to allow CTC to resolve the issue. 

Step 3 If third-party equipment is involved, ensure that it is configured for the same APS channel as the 
Cisco ONS equipment.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.180  LAN-POL-REV 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE

The LAN Connection Polarity Reversed condition is not raised in shelves that contain TCC2 cards. It is 
raised during a software upgrade when the card detects that a connected Ethernet cable has reversed 
receive wire pairs. The card automatically compensates for this reversal, but LAN-POL-REV stays 
active.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the LAN-POL-REV Condition

Step 1 Replace the connected Ethernet cable with a cable that has the correct pinout. For correct pin mapping, 
refer to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.181  LASER-APR 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.182  LASERBIAS-DEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.183  LASERBIAS-FAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.184  LASEREOL 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Laser Approaching End of Life alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, 
TXP_MR_10E, and MXP_2.5G_10G cards. It is typically accompanied by the “HI-LASERBIAS” alarm 
on page 2-123. It is an indicator that the laser in the card must be replaced. How soon the replacement 
must happen depends upon the HI-LASERBIAS alarm’s threshold. If the threshold is set under 100 
percent, the laser replacement can usually be done during a maintenance window. But if the 
HI-LASERBIAS threshold is set at 100 percent and is accompanied by data errors, LASEREOL 
indicates the card must be replaced sooner.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference 
Manual.

Clear the LASEREOL Alarm

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.185  LASERTEMP-DEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.186  LCAS-CRC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSTRM, VT-TERM

The Link Capacity Adjustment Scheme (LCAS) Control Word CRC Failure condition is raised against 
ML-Series Ethernet and CE-series cards. It occurs when there is an equipment, path, or provisioning 
error on the virtual concatenation group (VCG) that causes consecutive 2.5 second CRC failures in the 
LCAS control word. 

Transmission errors would be reflected in CV-P, ES-P, or SES-P performance monitoring statistics. If 
these errors do not exist, an equipment failure is indicated.

If LCAS is not supported on the peer node, the condition does not clear.
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LCAS-CRC can also occur if the VCG source node is not LCAS-enabled, but the receiving node does 
have the capability enabled. Both source and destination nodes must have LCAS enabled. Otherwise, the 
LCAS-CRC condition persists on the VCG.

Note For more information about the ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the LCAS-CRC Condition

Step 1 Look for and clear any associated equipment failures, such as the EQPT alarm, on the receive node or 
transmit node. 

Step 2 Look for and clear any bit error rate alarms at the transmit node.

Step 3 If no equipment or SONET path errors exist, ensure that the remote node has LCAS enabled on the 
circuit:

a. In node view, click the Circuits tab.

b. Choose the VCAT circuit and click Edit.

c. In the Edit Circuit window, click the General tab. 

d. Verify that the Mode column says LCAS.

Step 4 If the column does not say LCAS, complete the “Delete a Circuit” procedure on page 2-276 and recreate 
it in LCAS mode using the instructions in the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet 
Card Software Feature and Configuration Guide. 

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.187  LCAS-RX-DNU
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: STSTRM, VT-TERM

The LCAS VCG Member Receive-Side-In Do Not Use condition is raised on CE-MR-10 cards and 
ML-MR-10 Ethernet cards when the receive side of an LCAS VCG member is in the do-not use state. 
For a unidirectional failure, this condition is only raised at the source node.

The node reporting this condition likely reports an “RFI-P” alarm on page 2-206 and “RFI-V” alarm on 
page 2-206 for CE-MR-10, and “RFI-P” alarm on page 2-206 for ML-MR-10.

Note For more information about the CE-MR-10 and ML-MR-10 Ethernet cards, refer to the 
Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide.
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Clear the LCAS-RX-DNU Condition

Step 1 Look for any SONET failures, such as the RFI-P and RFI-V alarms, on the source node. If any are 
present, clear them using the relevant procedures in this chapter.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.188  LCAS-RX-FAIL 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSTRM, VT-TERM

The LCAS VCG Member Receive-Side-In Fail condition is raised against FC_MR-4 cards, CE-series 
and ML-Series Ethernet cards with LCAS-enabled VCG.

LCAS VCGs treat failures unidirectionally, meaning that failures of the transmit or receive points occur 
independently of each other. The LCAS-RX-FAIL condition can occur on the receive side of an LCAS 
VCG member for the following reasons:

 • SONET path failure (a unidirectional failure as seen by the receive side) 

 • VCAT member is set out of group at the transmit side, but is set in group at the receive side

 • VCAT member does not exist at the transmit side but does exist and is in group at the receive side

The condition can be raised during provisioning operations on LCAS VCGs but should clear when the 
provisioning is completed.

Software-enabled LCAS VCGs treat failure bidirectionally, meaning that both directions of a VCG 
member are considered failed if either transmit or receive fails. The LCAS-RX-FAIL condition is raised 
on these VCG members when a member receive side fails due to a SONET path failure.

Note For more information about the ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Note ML-Series cards are LCAS-enabled. ML-Series and FC_MR-4 cards are SW-LCAS enabled.

Clear the LCAS-RX-FAIL Condition

Step 1 Check for and clear any line or path alarms (typically ending in “-L” or “-P”).

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.189  LCAS-RX-GRP-ERR
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: STSTRM, VT-TERM

The LCAS Sink Group Error condition is raised against ML-MR-10 and CE-MR-10 Ethernet cards. This 
condition is raised if the LCAS member sink has a group error.

Clear the LCAS-RX-GRP-ERR Condition

Step 1 Clear any LCAS member sink group errors.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.190  LCAS-TX-ADD 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSTRM, VT-TERM

The LCAS VCG Member Transmit-Side-In Add State condition is raised against ML-Series Ethernet 
and CE-series cards when the transmit side of an LCAS VCG member is in the add state. The condition 
clears after provisioning is completed. The remote likely reports a path condition such as the “AIS-P” 
condition on page 2-38 or the “UNEQ-P” alarm on page 2-253 

Note LCAS-TX-ADD is an informational condition and does not require troubleshooting.

Note For more information about the ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

2.7.191  LCAS-TX-DNU 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSTRM, VT-TERM

The LCAS VCG Member Transmit-Side-In Do Not Use condition is raised on FC_MR-4 cards, 
CE-series and ML-Series Ethernet cards when the transmit side of an LCAS VCG member is in the 
do-not use state. For a unidirectional failure, this condition is only raised at the source node. The 
LCAS-TX-DNU condition is raised when the cable is unplugged.

The node reporting this condition likely reports an “RFI-P” alarm on page 2-206, and the remote node 
likely reports a path alarm such as the “AIS-P” alarm on page 2-38 or the “UNEQ-P” alarm on 
page 2-253.

Note LCAS-TX-DNU is an informational condition and does not require troubleshooting.
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Note For more information about the ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

2.7.192  LINK-KEEPALIVE
Default Severity: Critical (CR), Non-Service-Affecting (NSA)

SONET Logical Objects: ML1000, ML100T, MLFX, OCN

The LINK-KEEPALIVE alarm indicates that a span is not receiving a defined number of keep-alive 
messages on the ML card’s IEEE 802.17b-based interface or Cisco proprietary RPR interface within 
allotted keep-alive timeout period. Although this alarm defaults to a Critical (CR) severity, it can be 
downgraded if the span is protected.

A LINK-KEEPALIVE alarm causes the “RPR-SF” alarm on page 2-215 to be raised also. 
LINK-KEEPALIVE is suppressed by the “RPR-PASSTHR” alarm on page 2-210. This alarm clears 
when a defined number of consecutive keep-alive messages is received on the interface.

Note In the Cisco IOS CLI “show ons alarms” command display, this alarm is called KEEP-ALIVE-FAIL.

Note The GFP-UP-MISMATCH, GFP-CSF, GFP-LFD, and TPTFAIL alarms suppress the 
LINK-KEEPALIVE alarm even though the LINK-KEEPALIVE alarm has higher severity than the other 
alarms. The GFP alarms are promoted because the LINK-KEEPALIVE alarm information is contained 
within a GFP frame. The TPTFAIL alarm is promoted because it is a layer 1 alarm while 
LINK-KEEPALIVE is a layer 2 alarm.

Clear the LINK-KEEPALIVE Alarm

Step 1 Verify that no SONET or GFP circuit alarms that could impact Ethernet data traffic are present. If any 
are present, clear them using the relevant procedures in this chapter.

Step 2 Verify that the “DATA-CRC” alarm on page 2-76 is not present. If it is present, complete the 
trouble-clearing procedure.

Step 3 Verify that the keep-alive timer on this IEEE RPR 802.17b-based station has the same value as its 
neighboring RPR-IEEE stations.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.193  LKOUTPR-S 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN
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The Lockout of Protection Span condition occurs when span traffic is locked out of a protect span using 
the Lockout of Protect command. This condition is visible on the network view Alarms, Conditions, and 
History tabs after the lockout has occurred and accompanies the “FE-LOCKOUTOFPR-SPAN” alarm 
on page 2-109. The port where the lockout originated is marked by an “L” on the network view detailed 
circuit map.

Clear the LKOUTPR-S Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.194  LMP-FAIL
Default Severity:Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: CLIENT, CTRL, TLINK

The Link Management Protocol Fail alarm is raised by the TCC2/TCC2P card when an LMP control 
channel fails or when there is a traffic engineering (TE) link correlation error. When the alarm is raised 
against a control channel, it uses a control channel (CTRLx) AID. When the alarm is raised against a TE 
link, a TE link AID (TLINKx) is used. 

The alarm clears when the control channel or TE link is restored.

Note LMP-FAIL occurs independently of the condition hierarchy between the “LMP-SD” alarm on 
page 2-144, the “LMP-SF” alarm on page 2-145, or the “LMP-UNALLOC” alarm on page 2-146.

Note When the LMP-FAIL alarm is reported against a control channel (CTRLx) AID, it only refers to control 
channel failure. It does not directly indicate data link or traffic engineering link status.

Note When the LMP-FAIL alarm is reported against a TE link AID (TLINKx), it refers only to TE link status, 
not to control channel or data link status.

Clear the LMP-FAIL Alarm

Step 1 Verify the AID (CTRLx or TLINKx) of the alarm. 

Step 2 If the alarm is against the control channel AID, this is caused by mismatched control channel parameters 
between the near-end ONS 15454 and the far-end node (which may be another vendor’s equipment). 
Complete the following steps:

a. Determine whether both near-end and far-end sides of the control channel are in the IS 
administrative state:
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 • Click the Provisioning > Comm Channels > LMP > Control Channel tabs and view the 
Admin State column content for the channel.

 • If the status does not say IS, change it and click Apply.

b. Determine whether the near-end node LMP configuration contains the far-end node’s IP address as 
its remote node IP. Also verify that the near-end node’s LMP configuration uses the LMP node ID 
as its own remote node ID. If one or more of these values is incorrect, enter it correctly.

c. Determine whether the far-end node LMP configuration contains the near-end node's IP address as 
its remote node IP. Also verify that the far-end node’s LMP configuration uses the LMP node ID as 
its own remote node ID. If one or more of these values is incorrect, enter it correctly.

d. Verify that the far-end node is using the near-end node’s IP address as its remote node IP address, 
and that the far end is also using the LMP node ID as its remote node ID. Update the far end’s values 
if they are incorrect.

Step 3 If instead the alarm is raised against the TE link AID, complete the following steps: 

a. Determine whether both near-end and far-end sides of the TE link are in the IS administrative state. 
If either end is currently down, update its administrative state to IS:

 • Click the Provisioning > Comm Channels > LMP > TE link tab.

 • If the status does not say IS, change it and click Apply.

b. Determine whether the near-end node’s remote TE link ID matches the far-end node’s local TE link 
ID. If the near-end node’s remote value is incorrect, enter it correctly.

c. Determine whether the far-end node’s remote TE link ID corresponds to the near-end node’s local 
TE link ID. If the far-end node’s remote value is incorrect, enter it correctly.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.195  LMP-SD
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA) 

SONET Logical Object: OCN

DWDM Logical Object: GE

The LMP Data Link Signal Degrade condition occurs for when the TCC2/TCC2P receives an LMP link 
summary or channel status message that the control channel is not available from the far end, so the data 
link level of service is not guaranteed. The degrade range is provisionable.

LMP-SD clears when the TCC2/TCC2P receives a link summary or channel status message reporting 
that the data link is in the Signal Okay (OK) state. 

LMP-SD is part of an alarm hierarchy that includes the “LMP-SF” alarm on page 2-145 and the 
“LMP-UNALLOC” alarm on page 2-146. The hierarchy is as follows: If LMP-UNALLOC is raised, 
LMP-SF and LMP-SD are suppressed. If LMP-SF is raised, it suppresses LMP-SD. LMP-SF and 
LMP-UNALLOC both suppress near-end LOS-type alarms for DWDM clients. LMP-SD, however, does 
not suppress LOS alarms.

This condition clears when the far-end trouble has been cleared. 
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Clear the LMP-SD Condition

Step 1 Look for and clear any of the following alarms in Table 2-13 and Table 2-14 occurring on the far-end 
port. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide, R7.x for DWDM trunk (Table 2-13) 
and client (Table 2-14) alarm trouble-clearing procedures.

Step 2 If the LMP-SD condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.196  LMP-SF
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA) 

SONET Logical Object: OCN

DWDM Logical Object: GE

The LMP Data Link Signal Fail condition notifies the near-end user of a far-end problem (and thus is 
NSA for the near end). The near-end’s TCC2/TCC2P receives an LMP link summary or channel status 
message that the data link service has failed. The signal fail threshold provisionable.

LMP-SF clears when the TCC2/TCC2P receives a link summary or channel status message reporting that 
the data link is in the Signal Okay (OK) state.

LMP-SF is part of an alarm hierarchy that includes the “LMP-SD” alarm on page 2-144 and the 
“LMP-UNALLOC” alarm on page 2-146. The hierarchy is as follows: If LMP-UNALLOC is raised, 
LMP-SF and LMP-SD are suppressed. If LMP-SF is raised, it suppresses LMP-SD. LMP-SF and 
LMP-UNALLOC both suppress near-end LOS-type alarms for DWDM clients, but LMP-SD does not 
suppress LOS-type alarms.

This condition clears when the far-end trouble has been cleared.

Table 2-13 Transponder Trunk Alarms that Cause LMP-SD 

Trunk Port Alarm LMP Failure Direction

SD SD Tx

OTUK-SD SD Tx

ODUK-SD-PM SD Tx

ODUK-SD-TCM1 SD Tx

ODUK-SD-TCM2 SD Tx

Table 2-14 Transponder Client Alarm that Causes LMP-SD 

Client Port Alarm LMP Failure Direction

SD SD Rx
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Clear the LMP-SF Condition

Step 1 Look for and clear any of the following alarms in Table 2-15, Table 2-16, or Table 2-17 occurring on the 
far-end port. The card alarms are located in this chapter. The Cisco ONS 15454 DWDM Troubleshooting 
Guide, R7.x contains trouble-clearing procedures for DWDM trunk (Table 2-16) and client (Table 2-17) 
alarms.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.197  LMP-UNALLOC
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA) 

Table 2-15 Transponder Card Alarms that Cause LMP-SF 

Card Alarm LMP Failure Direction

EQPT, page 86 SF Tx

IMPROPRMVL, page 128 SF Tx

Table 2-16 Transponder Trunk Alarms that Cause LMP-SF 

Trunk Port Alarm LMP Failure Direction

LOS SF Tx

OTUK-LOF SF Tx

OTUK-AIS SF Tx

 LOM SF Tx

OTUK-SF SF Tx

ODUK-SF-PM SF Tx

ODUK-SF-TCM1 SF Tx

ODUK-SF-TCM2 SF SF Tx

FEC-MISM SF Tx

Table 2-17 Transponder Client Alarms that Cause LMP-SF 

Client Alarm LMP Failure Direction

LOS SF Rx

SIGLOSS SF Rx

SYNCLOSS SF Rx

CARLOSS SF Rx

LOF SF Rx
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SONET Logical Object: OCN

DWDM Logical Object: GE

The LMP Data Link Unallocated condition is raised when the TCC2/TCC2P receives an LMP link 
summary or channel status message reporting that the data link as unallocated for data traffic. The 
condition clears when the data link is allocated and sends an LMP link summary or channel status 
message to this effect. If a data link has the LMP-UNALLOC alarm raised against it, this should suppress 
all other alarms on the client port, since the far-end node is not using the errored port. (Consequently 
you do not have to clear any alarms on the far-end node’s unused port.)

LMP-UNALLOC is part of an alarm hierarchy that includes the “LMP-SD” alarm on page 2-144 and the 
“LMP-SF” alarm on page 2-145. The hierarchy is as follows: If LMP-UNALLOC is raised, LMP-SF and 
LMP-SD are suppressed. If LMP-SF is raised, it suppresses LMP-SD. LMP-SF and LMP-UNALLOC 
both suppress near-end LOS-type DWDM client alarms, but LMP-SD does not.

In most cases, this condition is an informational notice at the near-end node that the far-end port is not 
being utilized. If, however, the far-end port should be allocated for traffic, log into the Technical Support 
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.198  LOA 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: VCG

The Loss of Alignment on a VCG is a VCAT member alarm. (VCAT member circuits are independent 
circuits that are concatenated from different time slots into a higher-rate signal.) The alarm occurs when 
members of a VCG travel over different paths in the network (due to initial operator provisioning or to 
protection or restoration events) and the differential delays between the paths cannot be recovered by 
terminating hardware buffers.

Note This alarm occurs only if you provision circuits outside of CTC, such as by using TL1.

Clear the LOA Alarm

Step 1 In network view, click the Circuits tab.

Step 2 Click the alarmed VCG and then click Edit.

Step 3 In the Edit Circuit window, view the source and destination circuit slots, ports, and STSs. 

Step 4 Identify whether the STS travels across different fibers. If it does, complete the “Delete a Circuit” 
procedure on page 2-276. 

Step 5 Recreate the circuit using the procedure in the “Create Circuits and VT Tunnels” chapter in the 
Cisco ONS 15454 Procedure Guide.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.
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2.7.199  LOCKOUT-REQ 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, OCN, STSMON, VT-MON

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Lockout Switch Request on Facility or Equipment condition occurs when a user initiates a lockout 
switch request for an OC-N port in a 1+1 facility protection group. This can be accomplished by locking 
traffic onto the working port with the LOCK ON command (thus locking it off the protect port), or 
locking it off the protect port with the LOCK OUT command. In either case, the protect port will show 
“Lockout of Protection,” and the Conditions window will show the LOCKOUT-REQ condition.

A lockout prevents protection switching. Clearing the lockout again allows protection switching and 
clears the LOCKOUT-REQ condition. 

Clear the LOCKOUT-REQ Condition

Step 1 Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-265.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.200  LOF (BITS) 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: BITS

The Loss of Frame (LOF) BITS alarm occurs when a port on theTCC2/TCC2P BITS input detects an 
LOF on the incoming BITS timing reference signal. LOF indicates that the receiving ONS 15454 has 
lost frame delineation in the incoming data.

Note The procedure assumes that the BITS timing reference signal is functioning properly. It also assumes the 
alarm is not appearing during node turn-up.

Clear the LOF (BITS) Alarm

Step 1 Verify that the line framing and line coding match between the BITS input and the TCC2/TCC2P:

a. In node or card view, note the slot and port reporting the alarm.

b. Find the coding and framing formats of the external BITS timing source. The formats should be in 
the user documentation for the external BITS timing source or on the timing source itself.

c. Click the Provisioning > Timing > BITS Facilities tabs.

d. Verify that the Coding setting matches the coding of the BITS timing source, either B8ZS or AMI.

e. If the coding does not match, click Coding and choose the appropriate coding from the drop-down 
list.
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f. Verify that Framing matches the framing of the BITS timing source, either ESF or SF (D4).

g. If the framing does not match, click Framing and choose the appropriate framing from the 
drop-down list.

Note On the timing subtab, the B8ZS coding field is normally paired with ESF in the Framing 
field and the AMI coding field is normally paired with SF (D4) in the Framing field.

Step 2 If the alarm does not clear when the line framing and line coding match between the BITS input and the 
TCC2/TCC2P, complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the 
TCC2/TCC2P.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.201  LOF (DS1) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: DS1

The DS-1 LOF alarm indicates that the receiving ONS 15454 has lost frame delineation in an incoming 
DS-1 data stream. 

Clear the LOF (DS1) Alarm

Step 1 Verify that the line framing and line coding match between the DS1 port and the signal source:

a. In CTC, note the slot and port reporting the alarm.

b. Find the coding and framing formats of the signal source for the card reporting the alarm. You could 
need to contact your network administrator for the format information.

c. Display the card view of the reporting card.

d. Click the Provisioning > Line tabs.

e. Verify that the line type of the reporting port matches the line type of the signal source (DS4 and 
DS4, unframed and unframed, or ESF and ESF). If the signal source line type does not match the 
reporting port, click the Line Type cell to reveal a drop-down list and choose the matching type.

f. Verify that the reporting Line Coding matches the signal source line coding (AMI and AMI or B8ZS 
and B8ZS). If the signal source line coding does not match the reporting port, click the Line Coding 
cell and choose the correct type from the drop-down list. 

g. Click Apply.

Note On the Line tab, the B8ZS coding field is normally paired with ESF in the Framing field. 
AMI coding is normally paired with SF (D4) in the Framing field.
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Note When you replace a card with the identical type of card, you do not need to make any 
changes to the database.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.202  LOF (DS3) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: DS3

The DS-3 LOF alarm indicates that the receiving ONS 15454 has lost frame delineation in the incoming 
DS-3 data stream on DS3XM-6, DS3XM-12, or add DS3/EC1-48 cards. The framing of the transmitting 
equipment could be set to a format that differs from the receiving system. On DS3XM cards, the alarm 
occurs only on cards with the provisionable framing format set to C Bit or M13 and not on cards with 
the provisionable framing format is set to unframed. 

Clear the LOF (DS3) Alarm

Step 1 Change the line type of the non-ONS equipment attached to the reporting card to C Bit:

a. Display the card view of the reporting card.

b. Click the Provisioning > Line tabs.

c. Verify that the line type of the reporting port matches the line type of the signal source.

d. If the signal source line type does not match the reporting port, click Line Type and choose C Bit 
from the drop-down list.

e. Click Apply.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.203  LOF (E1)
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: E1

The E1 LOF alarm appears on the DS1/E1-56 card when the card is placed in All E1 mode. It indicates 
that the receiving ONS 15454 has lost frame delineation in an incoming E1 data stream. The transmitting 
equipment could possibly have its framing set to a format that differs from the receiving node. For more 
information about the DS1/E1-56 card, refer to the “Electrical Cards” chapter in the Cisco ONS 15454 
Reference Manual.
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Note The DS1/E1-56 card only carries an E1 signal within an STS-3c/VT2 circuit. 

Clear the LOF (E1) Alarm

Step 1 Verify that the line framing and line coding match between the DS1/E1-56 port and the signal source:

a. In CTC, note the slot and port reporting the alarm.

b. Find the coding and framing formats of the signal source for the card reporting the alarm. You could 
need to contact your network administrator for this information.

c. Double-click the DS1/E1-56 card to open the card view.

d. Click the Provisioning > Line tabs.

e. Verify that the line type of the reporting port matches the line type (E1_MF, E1_CRCMF, 
AUTOFRAMED, UNFRAMED) of the signal source. If the signal source line type does not match 
the reporting port, click the Line Type cell to reveal a drop-down list and choose the matching type.

f. Verify that the reporting Line Coding matches the signal source line coding. If the signal source line 
coding does not match the reporting port, click the Line Coding cell and choose the correct type 
from the drop-down list. 

g. Click Apply.

Note When you replace a card with the identical type of card, you do not need to make any 
changes to the database.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.204  LOF (EC1) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EC1

The EC1/EC1-12 LOF alarm occurs when a port on the reporting EC1/EC1-12 or DS3/EC1-48 card has 
an LOF condition. LOF indicates that the receiving ONS 15454 has lost frame delineation in the 
incoming data. LOF occurs when the SONET overhead loses a valid framing pattern for 3 milliseconds. 
Receiving two consecutive valid A1/A2 framing patterns clears the alarm.

Clear the LOF (EC1) Alarm

Step 1 Verify cabling continuity to the port reporting the alarm. To verify cable continuity, follow site practices.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
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Step 2 If cabling continuity is good, clean the fiber according to site practice. If no site practice exists, complete 
the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 3 If the alarm does not clear, see the loopback procedures in Chapter 1, “General Troubleshooting” to 
isolate the fault causing the LOF alarm.

Step 4 If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call 
Cisco TAC to report a Service-Affecting (SA) problem 1 800 553-2447.

2.7.205  LOF (OCN) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: OCN

The LOF alarm occurs when a port on the reporting card has an LOF condition. It can also occur on 
ONS 15454 MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G,TXP_MR_10E, or TXPP_MR_2.5G 
cards reporting LOF. The alarm indicates that the receiving ONS 15454 has lost frame delineation in the 
incoming data. LOF occurs when the SONET overhead loses a valid framing pattern for 3 milliseconds. 
Receiving two consecutive valid A1/A2 framing patterns clears the alarm.

When the alarm is raised on an OC-N card, it is sometimes an indication that the OC-N card expects a 
specific line rate and the input line rate source does not match the input line rate of the optical receiver.

Note For information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the LOF (OCN) Alarm

Step 1 Verify cabling continuity to the port reporting the alarm.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. To 
verify cable continuity, follow site practices.

Step 2 If cabling continuity is good, clean the fiber according to site practice. If no site practice exists, complete 
the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Step 3 If the alarm does not clear, see the loopback procedures in Chapter 1, “General Troubleshooting” to 
isolate the fault causing the LOF alarm.

Step 4 If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call 
Cisco TAC to report a Service-Affecting (SA) problem 1 800 553-2447.

2.7.206  LOF (STSTRM) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: STSTRM
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A Loss of Frame alarm for an STS circuit termination indicates that the LOF has occurred at the 
terminating point of the circuit (such as an OC-N port). It is similar to the “LOF (OCN)” alarm on 
page 2-152. 

Clear the LOF (STSTRM) Alarm

Step 1 Complete the “Clear the LOF (OCN) Alarm” procedure on page 2-152.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.207  LOF (TRUNK) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.208  LOGBUFR90
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: SYSTEM

The Log Buffer Over 90 alarm indicates that the per-NE queue of incoming alarm, event, or update 
capacity of 5000 entries is over 90% full. LOGBUFR90 will clear if CTC recovers. If it does not clear, 
the LOGBUFROVFL alarm occurs.

Note LOGBUFR90 is an informational alarm and does not require troubleshooting.

2.7.209  LOGBUFROVFL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: SYSTEM

The Log Buffer Overflow alarm indicates that the CTC per-NE queue of incoming alarm, event, or 
updates, which has a capacity of 5000 entries, has overflowed. This happens only very rarely; if the 
alarm does occur, you must restart the CTC session. If this alarm occurs, it is likely that some updates 
are missing. 

Clear the LOGBUFROVFL Alarm

Step 1 Restart the CTC session.
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Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call TAC (1-800-553-2447). 

2.7.210  LO-LASERBIAS 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, OCN

DWDM Logical Object: PPM

The Equipment Low Transmit Laser Bias Current alarm is raised against the TXP and MXP card laser 
performance. The alarm indicates that the card laser has reached the minimum laser bias tolerance. 

If the LO-LASERBIAS alarm threshold is set at 0 percent (the default), the laser's usability has ended. 
If the threshold is set at 5 percent to10 percent, the card is still usable for several weeks or months before 
you need to replace it. 

Note For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and 
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about 
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual. 

Clear the LO-LASERBIAS Alarm 

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.211  LO-LASERTEMP 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, OCN

DWDM Logical Object: PPM

The Equipment Low Laser Optical Transceiver Temperature alarm applies to the TXP and MXP cards. 
LO-LASERTEMP occurs when the internally measured transceiver temperature falls below the card 
setting by35.6 degrees F or 2 degrees C. A laser temperature change affects the transmitted wavelength. 
(Two degrees Celsius is equivalent to about 200 picometers in the wavelength.)

When the TXP or MXP card raises this alarm, the laser is automatically shut off. The “LOS (OCN)” 
alarm on page 2-165 is raised at the far-end node and the “DUP-IPADDR” alarm on page 2-79 is raised 
at the near end. To verify the card laser temperature level, double-click the card in node view and click 
the Performance > Optics PM > Current Values tabs. Maximum, minimum, and average laser 
temperatures are shown in the Current column entries in the Laser Temp rows. 
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Note For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and 
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information 
about the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual. 

Clear the LO-LASERTEMP Alarm 

Step 1 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the reporting MXP or TXP 
card. 

Step 2 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting MXP or TXP card. 

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.212  LOM 
Default Severity: Critical (CR), Service-Affecting (SA) for STSMON, STSTRM, TRUNK; 
Major (MJ) for VT-TERM

SONET Logical Objects: STSMON, STSTRM, VT-TERM

DWDM Logical Object: TRUNK

The Optical Transport Unit (OTU) Loss of Multiframe is a VCAT member alarm. (VCAT member 
circuits are independent circuits that are concatenated from different time slots into a higher-rate signal.) 
The alarm applies to MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, or 
TXPP_MR_2.5G cards when the Multi Frame Alignment Signal (MFAS) overhead field is errored for 
more than five frames and persists for more than 3 milliseconds.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference 
Manual. 

Clear the LOM Alarm

Step 1 Complete the “Clear the SD-L Condition” procedure on page 2-221. To clear this alarm against the 
DWDM trunk, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.213  LOP-P 
Default Severity: Critical (CR), Service-Affecting (SA)
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SONET Logical Objects: STSMON, STSTRM

A Loss of Pointer Path alarm indicates that the SONET path pointer in the overhead has been lost. LOP 
occurs when valid H1/H2 pointer bytes are missing from the overhead. Receiving equipment monitors 
the H1/H2 pointer bytes to locate the SONET payload. An LOP-P alarm occurs when eight, nine, or ten 
consecutive frames do not have valid pointer values. The alarm clears when three consecutive valid 
pointers are received.

The LOP-P alarm can occur when the received payload does not match the provisioned payload. The 
alarm is caused by a circuit type mismatch on the concatenation facility. For example, if an STS-1 is sent 
across a circuit provisioned for STS-3c, an LOP-P alarm occurs. 

For the FC_MR-4 card, an LOP-P is raised if a port is configured for a SONET signal but receives an 
SONET signal instead. (This information is contained in the H1 byte bits 5 and 6.)

Clear the LOP-P Alarm

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 In node view, click the Circuits tab and view the alarmed circuit.

Step 2 Verify the circuit size listed in the Size column. If the size is different from what is expected, such as an 
STS3c instead of an STS1, this causes the alarm.

Step 3 If you have been monitoring the circuit with optical test equipment, a mismatch between the provisioned 
circuit size and the size expected by the test set can cause this alarm. For specific procedures to use the 
test set equipment, consult the manufacturer. Ensure that the test set monitoring is set up for the same 
size as the circuit provisioning.

Refer to the manufacturer’s instructions for test-set use.

Step 4 If the error is not due to an incorrectly configured test set, the error is in the provisioned CTC circuit 
size. Complete the “Delete a Circuit” procedure on page 2-276.

Step 5 Recreate the circuit for the correct size. For procedures, refer to the “Create Circuits and VT Tunnels” 
chapter in the Cisco ONS 15454 Procedure Guide.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.214  LOP-V
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: VT-MON, VT-TERM

The LOP VT alarm indicates a loss of pointer at the VT level. 

The LOP-V alarm can occur when the received payload does not match the provisioned payload. LOP-V 
is caused by a circuit size mismatch on the concatenation facility.
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Clear the LOP-V Alarm

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-156.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.215  LO-RXPOWER 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Equipment Low Receive Power alarm is an indicator for TXP_MR_10G, TXP_MR_2.5G, 
TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, MRC-12, MRC-4, and OC192-XFP card received 
optical signal power. LO-RXPOWER occurs when the measured optical power of the received signal 
falls below the threshold value, which is user-provisionable.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference 
Manual. 

Note When you upgrade a node to Software Release 6.0 or later, this enables received optical power PMs for 
the OC3-8, OC192-SR, OC192-IR, OC192-ITU, OC-192-XFP, MRC-12, and MRC25G-4 cards. The 
newly enabled HI-RXPOWER and LO-RXPOWER alarms require that you initialize a site-accepted 
optical power (OPR0) nominal value after the upgrade. (To do this, refer to the procedure in the “Turn 
Up a Node” chapter in the Cisco ONS 15454 Procedure Guide.) When you apply the value change, CTC 
uses the new OPR0 value to calculate PM percentage values. If you do not change the nominal value, the 
HI-RXPOWER or LO-RXPOWER may be raised in response to the unmodified setting.

Clear the LO-RXPOWER Alarm

Step 1 At the transmit end of the errored circuit, increase the transmit power level within safe limits.

Step 2 Find out whether new channels have been added to the fiber. Up to 32 channels can be transmitted on 
the same fiber, but the number of channels affects power. If channels have been added, power levels of 
all channels need to be adjusted.

Note If the card is part of an amplified DWDM system, adding channels on the fiber affects the 
transmission power of each channel more than it would in an unamplified system.
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Step 3 Find out whether gain (the amplification power) of any amplifiers has been changed. Changing 
amplification also causes channel power to need adjustment.

Step 4 If the alarm does not clear, remove any receive fiber attenuators or replace them with lower-resistance 
attenuators.

Step 5 If the alarm does not clear, inspect and clean the receive and transmit node fiber connections according 
to site practice. If no site practice exists, complete the procedure in the “Maintain the Node” chapter in 
the Cisco ONS 15454 Procedure Guide.

Step 6 If the alarm does not clear, ensure that the fiber is not broken or damaged by testing it with an optical 
test set. If no test set is available, use the fiber for a facility (line) loopback on a known-good port. The 
error reading you get is not as precise, but you generally know whether the fiber is faulty. For specific 
procedures to use the test set equipment, consult the manufacturer.

Step 7 If the alarm does not clear, and no faults are present on the other port(s) of the transmit or receive card, 
do a facility loopback on the transmit and receive ports with known-good loopback cable. Complete the 
“1.4.1  Perform a Facility Loopback on a Source-Node Optical Port” procedure on page 1-48 or the 
“1.4.4  Perform a Facility Loopback on an Intermediate-Node Optical Port” procedure on page 1-57 to 
test the loopback.

Step 8 If a port is bad and you need to use all the port bandwidth, complete the “Physically Replace a Traffic 
Card” procedure on page 2-274. If the port is bad but you can move the traffic to another port, replace 
the card at the next available maintenance window.

Step 9 If no ports are shown bad and the alarm does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.216  LOS (2R)
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.217  LOS (BITS) 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: BITS

The LOS (BITS) alarm indicates that the TCC2/TCC2P has an LOS from the BITS timing source. The 
LOS (BITS) means the BITS clock or the connection to it failed.

Clear the LOS (BITS) Alarm

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Verify the wiring connection from the BITS clock pin fields on the ONS 15454 backplane to the timing 
source. 

Step 2 If wiring is good, verify that the BITS clock is operating properly.
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Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.218  LOS (DS1) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: DS1

A LOS (DS1) alarm for a DS-1 port occurs when the port on the card is in service but no signal is being 
received. A cabling issue or a configuration issue could cause this alarm. If an upstream equipment 
failure causes a transmission failure, the LOS (DS1) will likely be demoted by a card-level alarm (to the 
DS1/E1-56).

Clear the LOS (DS1) Alarm

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Verify that the fiber cable is properly connected and attached from the correct transmitting port to the 
correct receiving port. For more information about fiber connections and terminations, refer to the 
“Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step 2 Clean the cable ends using site practices or, if none exists, complete the procedure in the “Maintain the 
Node” chapter of the Cisco ONS 15454 Procedure Guide.

Step 3 If the alarm is raised on a DS1/E1-56 card, verify that the card is placed in the correct service mode by 
completing the following steps:

a. Double-click the card to open the card view.

b. Click the Provisioning > Card tabs.

c. Verify that the Operating Mode column says All DS1 for your errored circuit.

Step 4 For any other DS-1 or DS-3 card, consult site records to determine whether the port raising the alarm 
has been assigned.

Step 5 If the port is not currently assigned, place the port out of service using the following steps:

a. Double-click the card to open the card view.

b. For a DS-1 card, click the Maintenance > Loopback tabs. For a DS-1 line on a DS3XM-6 or 
DS3XM-12 card, click the Maintenance > DS1 tabs.

c. Under Admin State, click OOS,DSBLD.

d. Click Apply.

Step 6 For any card, if the port is assigned, verify that the correct one is in service:

a. To confirm this physically, confirm that the LED is correctly illuminated on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
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b. To determine this virtually, double-click the card in CTC to open the card view and complete the 
following substeps:

 • Click the Provisioning > Line tabs.

 • Verify that the Admin State column lists the port as IS.

 • If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and 
choose IS. Click Apply.

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either 
raised or remains, and the port service state transitions to OOS-AU,FLT.

Step 7 Use a test set to confirm that a valid signal exists on the line. Test the line as close to the receiving card 
as possible. For specific procedures to use the test set equipment, consult the manufacturer.

Step 8 Ensure that the transmit and receive outputs from the DSx patch panel to your equipment are properly 
connected. For more information about cable connections and terminations, refer to the “Install Cards 
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step 9 If there is a valid signal but the alarm does not clear, replace the electrical connector on the ONS 15454. 

Step 10 If a valid electrical signal is not present and the transmitting device is operational, replace the fiber cable 
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and 
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step 11 Repeat Steps 1 to 10 for any other port on the card that reports the LOS.

Step 12 If the alarm does not clear, check for any card-level alarm that could affect this port.

Step 13 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting card.

Step 14 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.219  LOS (DS3) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: DS3

The LOS (DS3) for a DS-3 port occurs when the port on a DS3XM-6, DS3XM-12, or DS3/EC1-48 card 
is in service but no signal is being received. The alarm is caused by incorrect or dirty cabling, a fiber 
break, or upstream equipment failure.

Note If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is 
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when 
troubleshooting this alarm.
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Clear the LOS (DS3) Alarm

Step 1 Check for any upstream failures in the transmitting equipment.

Step 2 Verify that the cable is properly connected from the transmitting port and attached to the correct 
receiving port at the node with the LOS. For more information about fiber connections and terminations, 
refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 3 Clean the cable ends using site practices or, if none exists, complete the procedure in the “Maintain the 
Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 4 Consult site records to determine whether the port raising the alarm has been assigned.

Step 5 If the port is not currently assigned, place the port out of service using the following steps:

a. Double-click the card to open the card view.

b. Click the Maintenance > DS3 tabs.

c. Under Admin State, click OOS,DSBLD.

d. Click Apply.

Step 6 If the port is assigned, verify that the correct one is in service:

a. To confirm this physically, confirm that the LED is correctly illuminated on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine this virtually, double-click the card in CTC to open the card view and complete the 
following substeps:

 • Click the Provisioning > Line tabs.

 • Verify that the Admin State column lists the port as IS.

 • If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and 
choose IS. Click Apply.

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either 
raised or remains, and the port service state transitions to OOS-AU,FLT.

Step 7 Use a test set to confirm that a valid signal exists on the line. Test the line as close to the receiving card 
as possible. (For specific procedures to use the test set equipment, consult the manufacturer.)

Step 8 Ensure that the transmit and receive outputs from the DSx patch panel to your equipment are properly 
connected. For more information about cable connections and terminations, refer to the “Install Cards 
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step 9 If there is a valid signal but the alarm does not clear, replace the electrical connector on the ONS 15454. 

Step 10 If the test set shows signal errors but the cabling is correctly installed and the transmitting device is 
operational, the existing cabling could still be faulty. Use the test set to locate the bad cable and replace 
it. To do this, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 
Procedure Guide.

Step 11 Repeat Steps 1 to 10 for any other port on the card that reports the LOS.
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Step 12 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting card.

Step 13 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.220  LOS (E1) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: E1

An LOS (E1) alarm for a DS1/E1-56 card port occurs when the card is placed in All E1 mode and is in 
service, but the alarmed port is not receiving a signal due to a physical or provisioning problem. The 
physical causes for the alarm could be incorrectly connected or faulty cabling. The software causes could 
be improperly configured card or circuit size. 

For more information about the DS1/E1-56 card, refer to the “Electrical Cards” chapter in the 
Cisco ONS 15454 Reference Manual.

Clear the LOS (E1) Alarm

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Verify that the cable is properly connected and attached to the correct port. For more information about 
connecting cable, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 
Procedure Guide. Also refer to site records for your specific cabling scheme.

Step 2 Ensure that the transmit and receive outputs from the patch panel to your equipment are properly 
connected. For more information about cable connections and terminations, refer to the “Install Cards 
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step 3 Clean the cable using your site practices. If none exists, complete the procedure in the “Maintain the 
Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 4 Confirm that the card is properly provisioned to carry the E1 payload:

a. Double-click the card to open the card view.

b. Click the Provisioning > Card tabs.

c. Under the Operating Mode column, you should see “All E1.” If you see “All DS1,” click the 
drop-down to change it and click Apply.

Step 5 Use a test set to confirm that a valid E1 signal exists on the line. Test the line as close to the receiving 
card as possible. (For specific procedures to use the test set equipment, consult the manufacturer.) If the 
test set shows errors, the cabling could still be faulty despite being correctly installed. Use the tester to 
isolate the bad section of cable and replace it. Refer to the “Install Cards and Fiber-Optic Cable” chapter 
in the Cisco ONS 15454 Procedure Guide for procedures.

Step 6 Repeat Steps 1 to 5 for any other port on the card that reports the LOS (E1).

Step 7 If the alarm does not clear, look for any card-level alarm that could cause this alarm.
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Step 8 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting card.

Step 9 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.221  LOS (EC1) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EC1

LOS on an EC1/EC1-12 or DS3/EC1-48 port occurs when a SONET receiver detects an all-zero pattern 
for 10 microseconds or longer. An LOS (EC1) most likely means that the upstream transmitter has failed. 
If an EC1 LOS alarm is not accompanied by additional alarms, a cabling problem (such as an incorrect 
attachment, fiber cut, or other fiber error) usually causes this alarm. The condition clears when the 
problem is corrected, allowing two consecutive valid frames to be received.

Note If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is 
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when 
troubleshooting this alarm.

Clear the LOS (EC1) Alarm

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. 

Step 1 Check for any upstream equipment failures that could cause the LOS (EC1) in this node.

Step 2 If there is no cause upstream, verify cabling continuity from the transmitting port to the receiving port 
reporting LOS (EC1) To verify cable continuity, follow site practices.

If the continuity is good, clean the fiber according to site practice. If none exists, complete the procedure 
in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 3 If the cabling is good, verify that the correct EC1-12 port is in service:

a. Confirm that the LED is correctly lit on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the port is in service, double-click the card in CTC to open the card view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose 
IS. Click Apply.
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Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised 
or remains, and the port service state transitions to OOS-AU,FLT.

Step 4 If the correct port is in service, use an optical test set to confirm that a valid signal exists on the line. For 
specific procedures to use the test set equipment, consult the manufacturer. Test the line as close to the 
receiving card as possible.

Step 5 If the signal is valid, ensure that the transmit and receive outputs from the patch panel to your equipment 
are properly connected. For more information about fiber connections and terminations, refer to the 
“Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step 6 If a valid signal exists but the alarm does not clear, replace the cable connector on the ONS 15454.

Step 7 Repeat Steps 2 through 6 for any other port on the card that reports the LOS (EC1).

Step 8 If the alarm does not clear, the cabling could still be faulty despite correct attachments. Use the test set 
to locate the bad cable and replace it using the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide.

Step 9 If the alarm does not clear, look for any card-level alarm that could cause this port alarm.

Step 10 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting card.

Step 11 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.222  LOS (ESCON)
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.223  LOS (FUDC) 
Default Severity: Minor (MN), Non-Service Affecting (NSA)

SONET Logical Object: FUDC

The LOS (FUDC) alarm is raised if there is a UDC circuit created on an AIC-I UDC port but the port is 
not receiving signal input. The downstream node has an AIS condition raised against the AIC-I port 
transmitting the UDC. FUDC refers to the 64-kb user data channel using the F1 byte.

Clear the LOS (FUDC) Alarm

Step 1 Verify cable continuity to the AIC-I UDC port. To verify cable continuity, follow site practices.

Step 2 Verify that there is a valid input signal using a test set. For specific procedures to use the test set 
equipment, consult the manufacturer.

Step 3 If there is a valid signal, clean the fiber according to site practice. If no site practice exists, complete the 
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.
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Step 4 If the alarm does not clear, verify that the UDC is provisioned:

a. At the network view, click the Provisioning > Overhead Circuits tabs.

b. If no UDC circuit exists, create one. Refer to the “Create Circuits and VT Tunnels” chapter in the 
Cisco ONS 15454 Procedure Guide.

c. If a user data circuit exists (shown as User Data F1 under the Type column), check the source and 
destination ports. These must be located on AIC-I cards to function. 

Step 5 If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of 
the problem.

Step 6 If no other alarms exist that could be the source of the LOS (FUDC), or if clearing another alarm did not 
clear the LOS, complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the 
reporting card.

Step 7 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.224  LOS (ISC)
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.225  LOS (MSUDC) 
The LOS (MSUDC) alarm is not used in this platform in this release. It is reserved for future 
development.

2.7.226  LOS (OCN) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: OCN

An LOS alarm on an OC-N port occurs when a SONET receiver detects an all-zero pattern for 
10 microseconds or longer. An LOS alarm means the upstream transmitter has failed. If an OC-N LOS 
alarm is not accompanied by additional alarms, a fiber break is usually the cause of the alarm. It clears 
when two consecutive valid frames are received.

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 
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Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Note If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is 
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when 
troubleshooting this alarm.

Clear the LOS (OCN) Alarm

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Using site practices, verify fiber continuity to the port.

Step 2 If the cabling is good, verify that the correct port is in service:

a. Confirm that the LED is correctly illuminated on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card 
view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose 
IS. 

f. Click Apply.

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised 
or remains, and the port service state transitions to OOS-AU,FLT.

Step 3 If the correct port is in service, clean the fiber according to site practice. If no site practice exists, 
complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Step 4 If the alarm does not clear, verify that the power level of the optical signal is within the OC-N card 
receiver specifications. The “1.12.3  OC-N Card Transmit and Receive Levels” section on page 1-146 
lists these specifications for each OC-N card. For DWDM cards, refer to the Cisco ONS 15454 DWDM 
Reference Manual for levels.

Step 5 If the optical power level is within specifications, use an optical test set to verify that a valid signal exists 
on the line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line 
as close to the receiving card as possible.

Step 6 If a valid signal exists, replace the connector on the backplane.

Step 7 Repeat Steps 1 to 6 for any other port on the card reporting the LOS (OC-N).

Step 8 If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of 
the problem.
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Step 9 If no other alarms exist that could be the source of the LOS, or if clearing an alarm did not clear the LOS, 
complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the reporting card.

Step 10 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.227  LOS (OTS) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.228  LOS (TRUNK) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.229  LOS-O 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.230  LOS-P (OCH) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.231  LOS-P (OMS, OTS) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.232  LOS-P (TRUNK) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.233  LO-TXPOWER 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM
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The Equipment Low Transmit Power alarm is an indicator for the TXP_MR_10G, TXP_MR_2.5G, 
TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, MRC-12, MRC-4, and OC192-XFP card 
transmitted optical signal power. LO-TXPOWER occurs when the measured optical power of the 
transmitted signal falls under the threshold. The threshold value is user-provisionable.

Note For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponders and 
Muxponders” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more information about 
the cards themselves, refer to the Cisco ONS 15454 DWDM Reference Manual. 

Clear the LO-TXPOWER Alarm

Step 1 Display the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, or 
OC192-XFP card view.

Step 2 Click the Provisioning > Optics Thresholds > Current Values tabs.

Step 3 Increase the TX Power Low column value by 0.5 dBm.

Step 4 If the card transmit power setting cannot be increased without affecting the signal, complete the 
“Physically Replace a Traffic Card” procedure on page 2-274.

Step 5 If no ports are shown bad and the alarm does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.234  LPBKCRS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM

The Loopback Cross-Connect condition indicates that there is a software cross-connect loopback active 
between the optical cards. A cross-connect loopback test occurs below line speed and does not affect 
traffic.

For more information on loopbacks, see the “1.4  Troubleshooting Optical Circuit Paths With 
Loopbacks” section on page 1-47.

Note Cross-connect loopbacks occur below line speed. They do not affect traffic.

Clear the LPBKCRS Condition

Step 1 To remove the loopback cross-connect condition, double-click the optical card in CTC to open the card 
view. 

Step 2 Complete the “Clear an OC-N Card Cross-Connect (XC) Loopback Circuit” procedure on page 2-277.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.235  LPBKDS3FEAC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

A Loopback Due to FEAC Command DS-3 condition occurs when a DS3XM-6, DS3XM-12, DS3-12E, 
or DS3/EC1-48 port loopback signal is received in C-bit framing mode from the far-end node because 
of an FEAC command. An FEAC command is often used with loopbacks. LPBKDS3FEAC is only 
reported by these DS cards. DS3XM-6, DS3XM-12, and DS3/EC1-48 cards generate and report FEAC 
alarms or conditions, but a DS3-12E card only reports FEAC alarms or conditions.

Caution CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

Note LPBKDS3FEAC is an informational condition and does not require troubleshooting.

Clear the LPBKDS3FEAC Condition

Step 1 In node view, double-click the DS-3 card to open the card view.

Step 2 Click the Maintenance > DS3 tabs.

Step 3 Click the cell for the port in the Send Code column and click No Code from the drop-down list.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.236  LPBKDS3FEAC-CMD 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: DS3

The DS-3 Loopback Command Sent To Far End condition occurs on the near-end node when you send 
a DS-3 FEAC loopback on DS3XM-6, DS3XM-12, or DS3/EC1-48 cards. For more information about 
FEAC loopbacks, see the “1.3  Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With 
FEAC Loopbacks” section on page 1-45.

Note LPBKDS3FEAC-CMD is an informational condition and does not require troubleshooting.

2.7.237  LPBKFACILITY (CEMR, CE1000, CE100T) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: CEMR, CE1000, CE100T

A Loopback Facility condition on a CE-Series port occurs when a software facility (line) loopback is 
active for a port on the card.
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Note For information about troubleshooting Ethernet circuits with loopbacks, refer to the 
“1.5  Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-68.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the LPBKFACILITY (CEMR, CE1000, CE100T) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.238  LPBKFACILITY (DS1, DS3) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: DS1, DS3

A Loopback Facility condition on a DS-1 or DS-3 port occurs when a software facility (line) loopback 
is active for the reporting DS3XM-6 card, DS3XM-12 card, a DS1/E1-56 card operating in All DS1 
mode, or a DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the 
“1.5  Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-68. 

Note CTC permits loopbacks to be performed on an in-service (IS) circuit. Performing a loopback is 
Service-Affecting (SA). If you did not perform a lockout or Force switch to protect traffic, the 
LPBKFACILITY condition can be accompanied by a more serious alarms such as the “LOS (DS1)” 
alarm on page 2-159, or the “LOS (DS3)” alarm on page 2-160.

Note ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an “AIS” alarm on page 2-37, in the 
direction away from the loopback. Instead of AIS, a continuance of the signal transmitted into the 
loopback is provided. A DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback if 
desired.

Clear the LPBKFACILITY (DS1, DS3) Condition

Step 1 Complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on 
page 2-277.
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2.7.239    LPBKFACILITY (E1)
Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.239  LPBKFACILITY (E1) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: E1

A Loopback Facility on an E1 port condition occurs when a software facility (line) loopback is active 
for a DS1/E1-56 card port operating in All E1 mode.

For information about troubleshooting electrical circuits with loopbacks, refer to the 
“1.2  Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9. 

Note CTC permits loopbacks to be performed on an in-service (IS) circuit. Performing a loopback is 
Service-Affecting (SA). If you did not perform a lockout or Force switch to protect traffic, the 
LPBKFACILITY condition can be accompanied by a more serious alarms such as LOS.

Note E1 facility (line) loopbacks transmit an AIS in the direction away from the loopback, but this is 
provisionable.

Clear the LPBKFACILITY (E1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.240  LPBKFACILITY (EC1) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EC1

A Loopback Facility condition on an EC-1 port occurs when a software facility (line) loopback is active 
for a port on the reporting EC1/EC1-12 or DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the 
“1.2  Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.

Caution CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).
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2.7.241    LPBKFACILITY (ESCON)
Clear the LPBKFACILITY (EC1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.241  LPBKFACILITY (ESCON) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.242  LPBKFACILITY (FC) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.243  LPBKFACILITY (FCMR) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: FCMR

A Loopback Facility for FCMR condition occurs when a facility loopback is provisioned on an 
FC_MR-4 card.

For information about troubleshooting these circuits with loopbacks, refer to the “1.6  Troubleshooting 
FC_MR Circuit Paths With Loopbacks” section on page 1-94.

Clear the LPBKFACILITY (FCMR) Condition

Step 1 Complete the “Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.244  LPBKFACILITY (G1000) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: G1000

A Loopback Facility condition for the G1000 object occurs when a software facility (line) loopback is 
active for a port on the reporting G-Series Ethernet card.

For information about troubleshooting Ethernet circuits with loopbacks, refer to the 
“1.5  Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-68. 
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2.7.245    LPBKFACILITY (GE)
Caution CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the LPBKFACILITY (G1000) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.245  LPBKFACILITY (GE) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.246  LPBKFACILITY (ISC) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.247  CLPBKFACILITY (OCN) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

A Loopback Facility condition for an OC-N port occurs when a software facility (line) loopback is active 
for a port on the reporting OC-N card.

For information about troubleshooting optical circuits with loopbacks, refer to the “1.4  Troubleshooting 
Optical Circuit Paths With Loopbacks” section on page 1-47.

Note OC-3 facility loopbacks do not transmit an AIS in the direction away from the loopback. Instead of AIS, 
a continuance of the signal transmitted to the loopback is provided.

Caution CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).
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2.7.248    LPBKFACILITY (TRUNK)
Caution Before performing a facility (line) loopback on an OC-N card, ensure that the card contains at least two 
DCC paths to the node where the card is installed. A second DCC path provides a nonlooped path to log 
into the node after the loopback is applied, thus enabling you to remove the facility loopback. Ensuring 
a second DCC is not necessary if you are directly connected to the ONS 15454 containing the loopback 
OC-N.

Clear the LPBKFACILITY (OCN) Condition

Step 1 Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-277.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.248  LPBKFACILITY (TRUNK) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.249  LPBKTERMINAL (CEMR, CE1000, CE100T) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: CEMR, CE1000, CE100T, 

A Loopback Terminal condition on a CE-Series port occurs when a software terminal loopback is active 
for a port on the card.

Note For information about troubleshooting Ethernet circuits with loopbacks, refer to the 
“1.5  Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-68.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the LPBKTERMINAL (CEMR, CE1000, CE100T) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.250    LPBKTERMINAL (DS1, DS3)
2.7.250  LPBKTERMINAL (DS1, DS3)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: DS1, DS3

A Loopback Terminal condition for a DS-1 or DS-3 occurs when a software terminal (inward) loopback 
is active for a DS1 or DS3 port on the reporting DS3XM-6, DS3XM-12, or DS3/EC1-48 card. DS-1 and 
DS-3 terminal loopbacks do not typically return an AIS signal, but you can provision one for the 
DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the 
“1.3  Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With FEAC Loopbacks” section 
on page 1-45.

Clear the LPBKTERMINAL (DS1, DS3) Condition

Step 1 Complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on 
page 2-277.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.251  LPBKTERMINAL (E1) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: E1

A Loopback Terminal condition for an E-1 signal on a DS1/E1-56 card occurs when the card is operating 
in All E1 mode and a software terminal (inward) loopback is active for a port.

For information about troubleshooting electrical circuits with loopbacks, refer to the 
“1.3  Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With FEAC Loopbacks” section 
on page 1-45.

Clear the LPBKTERMINAL (E1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.252  LPBKTERMINAL (EC1) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EC1
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2.7.253    LPBKTERMINAL (ESCON)
A Loopback Terminal condition on an EC-1 signal occurs when a software terminal (inward) loopback 
is active for a port on the reporting EC1/EC1-12 or DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the 
“1.2  Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.

Caution CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

Clear the LPBKTERMINAL (EC1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.253  LPBKTERMINAL (ESCON) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.254  LPBKTERMINAL (FC) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.255  LPBKTERMINAL (FCMR) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: FCMR

A Loopback Terminal for FCMR condition occurs when a terminal loopback is provisioned on an 
FC_MR-4 card.

For information about troubleshooting these circuits with loopbacks, refer to the “1.6  Troubleshooting 
FC_MR Circuit Paths With Loopbacks” section on page 1-94.

Clear the LPBKTERMINAL (FCMR) Condition

Step 1 Complete the “Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.256    LPBKTERMINAL (G1000)
2.7.256  LPBKTERMINAL (G1000) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: G1000

A Loopback Terminal condition for the G1000 occurs when a software terminal (inward) loopback is 
active for a port on the reporting G-Series Ethernet card.

When a port in terminal (inward) loopback, its outgoing signal is redirected into the receive direction on 
the same port, and the externally received signal is ignored. On the G1000-4 card, the outgoing signal is 
not transmitted; it is only redirected in the receive direction. 

For more information about troubleshooting Ethernet circuits, refer to the “1.5  Troubleshooting 
Ethernet Circuit Paths With Loopbacks” section on page 1-68.

Caution CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the LPBKTERMINAL (G1000) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.257  LPBKTERMINAL (GE) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.258  LPBKTERMINAL (ISC) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.259  LPBKTERMINAL (OCN) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

A Loopback Terminal condition for an OC-N port occurs when a software terminal (inward) loopback 
is active for a port on the reporting card. 
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2.7.260    LPBKTERMINAL (TRUNK)
Note OC-N terminal loopbacks do not typically return an AIS. 

Note Performing a loopback on an in-service circuit is Service-Affecting (SA). If you did not perform a 
lockout or Force switch to protect traffic, the LPBKTERMINAL condition can also be accompanied by 
a more serious alarm such as LOS.

For information about troubleshooting circuits, refer to the loopback procedures in Chapter 1, “General 
Troubleshooting.”

Clear the LPBKTERMINAL (OCN) Condition

Step 1 Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-277. 

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.260  LPBKTERMINAL (TRUNK) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.261  LWBATVG 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: PWR

The Low Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input voltage falls 
below the low power threshold. This threshold, with a default value of –44 VDC, is user-provisionable. 
The alarm remains raised until the voltage remains above the threshold for 120 seconds. (For 
information about changing this threshold, refer to the “Turn Up Node” chapter in the Cisco ONS 15454 
Procedure Guide.

Clear the LWBATVG Alarm

Step 1 The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.
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2.7.262    MAN-REQ
2.7.262  MAN-REQ 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, ML1000, ML100T, MLFX, STSMON, VT-MON

The Manual Switch Request condition occurs on a SONET entity when a user initiates a Manual switch 
request on an OC-N port. Clearing the Manual switch clears the MAN-REQ condition. You do not need 
to clear the switch if you want the Manual switch to remain.

MAN-REQ is raised for an IEEE 802.17b-based RPR span if the manual switch was requested in the 
Cisco IOS CLI with the “rpr-ieee protection request manual-switch {east | west}” command. It clears 
from the IEEE 802.17b-based RPR span when you remove the switch in the CLI. For the RPR-IEEE, 
MAN-REQ suppresses the “RPR-SD” alarm on page 2-214, and the “WTR” alarm on page 2-259. This 
condition is suppressed by the following alarms:

 • FORCED-REQ, page 112 

 • RPR-PASSTHR, page 210

 • RPR-SF, page 215

Clear the MAN-REQ Condition

Step 1 If the condition is raised against a SONET entity, complete the “Initiate a 1+1 Manual Switch 
Command” procedure on page 2-263.

Step 2 If the condition is raised on an IEEE 802.17b-based RPR span, enter the following CLI command in 
RPR-IEEE interface configuration mode:

router(config-if)#no rpr-ieee protection request manual-switch {east | west}

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.263  MANRESET 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

A User-Initiated Manual Reset condition occurs when you right-click a card in CTC and choose Reset. 

Note MANRESET is an informational condition and does not require troubleshooting.

2.7.264  MANSWTOINT 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE-SREF

The Manual Switch To Internal Clock condition occurs when the NE timing source is manually switched 
to an internal timing source.
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2.7.265    MANSWTOPRI
Note MANSWTOINT is an informational condition and does not require troubleshooting.

2.7.265  MANSWTOPRI 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Primary Reference condition occurs when the NE timing source is manually 
switched to the primary timing source.

Note MANSWTOPRI is an informational condition and does not require troubleshooting.

2.7.266  MANSWTOSEC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Second Reference condition occurs when the NE timing source is manually 
switched to a second timing source.

Note MANSWTOSEC is an informational condition and does not require troubleshooting.

2.7.267  MANSWTOTHIRD 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Third Reference condition occurs when the NE timing source is manually 
switched to a third timing source.

Note MANSWTOTHIRD is an informational condition and does not require troubleshooting.

2.7.268  MANUAL-REQ-RING 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Manual Switch Request on Ring condition occurs when a user initiates a MANUAL RING command 
on BLSR rings to switch from working to protect or protect to working. This condition is visible on the 
network view Alarms, Conditions, and History tabs and is accompanied by WKSWPR. The port where 
the MANUAL RING command originated is marked with an “M” on the network view detailed circuit 
map.
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2.7.269    MANUAL-REQ-SPAN
Clear the MANUAL-REQ-RING Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.269  MANUAL-REQ-SPAN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EC1, OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Manual Switch Request on Ring condition occurs on BLSRs when a user initiates a Manual Span 
command to move BLSR traffic from a working span to a protect span. This condition appears on the 
network view Alarms, Conditions, and History tabs. The port where the MANUAL SPAN command was 
applied is marked with an “M” on the network view detailed circuit map.

Clear the MANUAL-REQ-SPAN Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-270.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.270  MAX-STATIONS
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: RPRIF

The Maximum IEEE 802.17b-based RPR Station Number Exceeded alarm can be raised by all ML card 
stations on a ring when the maximum quantity of stations, 255, is exceeded. This excess causes the 
IEEE 802.17b-based RPR scheme—and traffic—to break down.

IEEE 802.17b-based RPR messaging uses time-to-live (TTL), an 8-bit value. The maximum value these 
8 bits (one byte) can have is 255. As a message travels (or hops) from station to station, the TTL is 
decremented by each station. Thus one station cannot communicate with another station more than 255 
hops away. 

If you are creating a large ring (more than 127 nodes), the MAX-STATIONS alarm might be raised until 
the ring is closed and stable.

MAX-STATIONS does not suppress any other alarms. However, this alarm is suppressed by the 
“RPR-PASSTHR” alarm on page 2-210.
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2.7.271    MEA (AIP)
Clear the MAX-STATIONS Alarm

Step 1 Remove the extra stations from the ring to clear this alarm in all other stations and to restore traffic in 
the ring. For procedures to add or remove IEEE 802.17b-based RPR stations, refer to the 
Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.271  MEA (AIP) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: AIP

If the Mismatch of Equipment Attributes (MEA) alarm is reported against the AIP, the fuse in the AIP 
board blew or is missing. The MEA alarm also occurs when an old AIP board with a 2-A fuse is installed 
in a newer ANSI 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD). 

Clear the MEA (AIP) Alarm

Step 1 Complete the “Replace the Alarm Interface Panel” procedure on page 2-283.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.272  MEA (BIC) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: BIC

The Missing Equipment Attributes alarm for the backplane interface connector (BIC) indicates a 
compatibility issue in using high-density DS-3 cards with universal backplane interface connectors 
(UBIC) and an older shelf backplane. The backplane on the high-density shelf assembly, 15454-SA-HD, 
is compatible with the UBIC with horizontal connectors (UBIC-H) and UBIC with vertical connectors 
(UBIC-V) that the high-density EC-1, DS-1, and DS-3 electrical connections require. The MEA alarm 
is raised if you attempt to install a high-density card in Slot 4, 5, 6, 12, 13, or 14 in a shelf assembly with 
an older, incompatible backplane. The card is not usable in this case. It is also raised if you attempt to 
use an older BIC (also known as electrical interface assemblies [EIAs]) with the newer shelf assembly.
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Clear the MEA (BIC) Alarm

Step 1 Click the Provisioning > Inventory tabs to determine your backplane model. If the backplane is not a 
15454-SA-HD, replace the backplane or do not attempt to use high-density DS-3 cards. Table 2-18 lists 
the BICs that are compatible with various backplanes.

Step 2 If you determine that your BIC type and backplane are compatible despite the MEA alarm, or if the alarm 
does not clear after you resolve the incompatibilities, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447 in order to 
report a Service-Affecting (SA) problem.

2.7.273  MEA (EQPT) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

Table 2-18 BIC Compatibility Matrix 

BIC Type Part No.

BICs that work with the newer and older 
backplanes

MANUF_EQPT_ID_BIC_A_SMB_HD_BP

MANUF_EQPT_ID_BIC_B_SMB_HD_BP

MANUF_EQPT_ID_BIC_A_BNC_24_HD_BP

MANUF_EQPT_ID_BIC_A_BNC_48_HD_BP

MANUF_EQPT_ID_BIC_B_SMB

MANUF_EQPT_ID_BIC_B_SMB_ALT

MANUF_EQPT_ID_BIC_B_BNC_24

MANUF_EQPT_ID_BIC_B_BNC_48

New HD BICs that work only with the new 
backplanes

MANUF_EQPT_ID_BIC_A_UNIV_VERT

MANUF_EQPT_ID_BIC_B_UNIV_VERT

MANUF_EQPT_ID_BIC_A_UNIV_HORIZ

MANUF_EQPT_ID_BIC_B_UNIV_HORIZ

MANUF_EQPT_ID_BIC_A_MINI_BNC_HD_BP

MANUF_EQPT_ID_BIC_B_MINI_BNC_HD_BP

High-density BICs that work only with 
15454-SA-HD

MANUF_EQPT_ID_BIC_A_SMB 

MANUF_EQPT_ID_BIC_A_SMB_ALT

MANUF_EQPT_ID_BIC_A_BNC_24

MANUF_EQPT_ID_BIC_A_BNC_48
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The MEA alarm for equipment is reported against a card slot when the physical card inserted into a slot 
does not match the card type that is provisioned for that slot in CTC. The alarm also occurs when certain 
cards introduced in Release 3.1 or later are inserted into an older shelf assembly or when older Ethernet 
cards (E1000-2 and E100T-12) are used in a newer 10-Gbps-compatible shelf assembly.

Removing the incompatible cards clears the alarm.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Note If an OC3-8 card is installed in Slot 5 to 6 and Slot 12 to 13, it does not appear in CTC and raises an 
MEA.

Clear the MEA (EQPT) Alarm

Step 1 Physically verify the type of card that is installed in the slot reporting the MEA alarm. In node view, 
click the Inventory tab and compare it to the actual installed card.

Step 2 Determine whether the ONS 15454 shelf assembly is a newer 10-Gbps-compatible shelf assembly 
(15454-SA-ANSI or 15454-SA-HD) or an earlier shelf assembly. Under the HW Part # column, if the 
part number is 800-19857-XX or 800-19856-XX, then you have a 15454-SA-ANSI shelf. If the part 
number is 800-24848-XX, then you have a 15454-SA-HD shelf. If the number is not one of those listed 
above, then you are using an earlier shelf assembly.

Note On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and 
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI 
shelf (P/N: 800-19857), the AIP cover is metal.

Step 3 Verify the type of card that sits in the slot reported in the object column of the MEA row on the Alarms 
window by reading the name at the top of the card faceplate.

 • If you have a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and 
the card reporting the alarm is not an E1000-2 or E100T-12, proceed to Step 4. 

 • If you have a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and 
the card reporting the alarm is an E1000-2 or E100T-12, then that version of the Ethernet card is 
incompatible and must be removed. Proceed to Step 4.

Note The E1000-2-G and E100T-G cards are compatible with the newer ANSI 
10-Gbps-compatible shelf assembly and are the functional equivalent of the older, 
noncompatible E1000-2 and E100T-12 cards. E1000-2-G and E100T-G cards can be used as 
replacements for E1000-2 and E100T-12 cards in a 10-Gbps-compatible shelf assembly.

 • If you have an older shelf assembly and the card reporting the alarm is not a card introduced in 
Release 3.1 or later, which includes the OC-192, E1000-2-G, E100T-G, or OC-48 any slot (AS), 
proceed to Step 4.

 • If you have an older shelf assembly and the card reporting the alarm is a card introduced in Release 
3.1 or later, which includes the OC-192, E1000-2-G, E100T-G, or OC-48 any slot (AS), the 
reporting card is incompatible with the shelf assembly and must be removed Proceed to Step 4.
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Step 4 If you prefer the card type depicted by CTC, complete the “Physically Replace a Traffic Card” procedure 
on page 2-274 for the reporting card.

Step 5 If you prefer the card that physically occupies the slot but the card is not in service, does not have circuits 
mapped to it, and is not part of a protection group, place the cursor over the provisioned card in CTC 
and right-click to choose Delete Card.

The card that physically occupies the slot reboots, and CTC automatically provisions the card type into 
that slot.

Note If the card is in service, does have circuits mapped to it, is paired in a working protection scheme, 
has DCC communications turned on, or is used as a timing reference, CTC does not allow you 
to delete the card.

Step 6 If any ports on the card are in service, place them out of service (OOS,MT):

Caution Before placing ports out of service, ensure that live traffic is not present.

a. Double-click the reporting card to open the card view.

b. Click the Provisioning tab.

c. Click the admin state of any in-service ports.

d. Choose OOS,MT to take the ports out of service.

Step 7 If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-276.

Caution Before deleting the circuit, ensure that live traffic is not present.

Step 8 If the card is paired in a protection scheme, delete the protection group:

a. Click the Provisioning > Protection tabs.

b. Choose the protection group of the reporting card.

c. Click Delete.

Step 9 Right-click the card reporting the alarm.

Step 10 Choose Delete.

The card that physically occupies the slot reboots, and CTC automatically provisions the card type into 
that slot.

Step 11 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.274  MEA (FAN) 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: FAN
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The MEA alarm is reported against the fan-tray assembly when a newer fan-tray assembly (15454-FTA3) 
with a 5-A fuse is used with an older shelf assembly or when an older fan-tray assembly with a 2-A fuse 
is used with a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) that 
contains cards introduced in Release 3.1 or later. If a 10-Gbps-compatible shelf assembly contains only 
cards introduced before Release 3.1, then an older fan-tray assembly (15454-FTA-2) can be used and 
does not report an MEA alarm. 

Clear the MEA (FAN) Alarm

Step 1 Determine whether the shelf assembly is a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI 
or 15454-SA-HD) or an earlier shelf assembly. In node view, click the Inventory tab.

Under the HW Part # column, if the part number is 800-19857-XX or 800-19856-XX, then you have a 
15454-SA-ANSI shelf. If the part number is 800-24848-XX, you have a 15454-SA-HD shelf.

Under the HW Part # column, if the number is not one of those listed above, then you are using an earlier 
shelf assembly. 

Step 2 If you have a 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD), the alarm 
indicates that an older incompatible fan-tray assembly is installed in the shelf assembly. Obtain a newer 
fan-tray assembly (15454-FTA3) with a 5-A fuse and complete the “Replace the Fan-Tray Assembly” 
procedure on page 2-281.

Step 3 If you are using an earlier shelf assembly, the alarm indicates that you are using a newer fan-tray 
assembly (15454-FTA3), which is incompatible with the earlier version of the shelf assembly. Obtain an 
earlier version of the fan-tray assembly (15454-FTA2) and complete the “Replace the Fan-Tray 
Assembly” procedure on page 2-281.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.275  MEA (PPM) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.276  MEA (SHELF) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.277  MEM-GONE 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: EQPT
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The Memory Gone alarm occurs when data generated by software operations exceeds the memory 
capacity of the TCC2/TCC2P. The TCC2/TCC2P cards which exceed the memory capacity reboot to 
avoid failure of card operations. 

Note The alarm does not require user intervention. The MEM-LOW alarm always preceeds the MEM-GONE 
alarm.

2.7.278  MEM-LOW 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Free Memory of Card Almost Gone alarm occurs when data generated by software operations is 
close to exceeding the memory capacity of the TCC2/TCC2P. The alarm clears when additional memory 
becomes available. If additional memory is not made available and the memory capacity of the card is 
exceeded, CTC ceases to function.

Note The alarm does not require user intervention. If the alarm does not clear, log into the Technical Support 
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.279  MFGMEM 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Objects: AICI-AEP, AICI-AIE, AIP, BPLANE, FAN

DWDM Logical Object: PPM

The Manufacturing Data Memory Failure alarm occurs when the EEPROM fails on a card or component, 
or when the TCC2/TCC2P cannot read this memory. EEPROM stores manufacturing data that a system 
TCC2/TCC2P uses to determine system compatibility and shelf inventory status. Unavailability of this 
information can cause less-significant problems. The AIP EEPROM also stores the system MAC 
address. If the MFGMEM alarm indicates EEPROM failure on these panels, IP connectivity could be 
disrupted and the system icon is grayed out in CTC network view.

Tip When you lose LAN connectivity with an ONS 15454 due to an MFGMEM alarm on the AIP, you can 
reestablish node management by disconnecting the Ethernet cable from the panel and connecting it to 
the active TCC2/TCC2P LAN port.

Clear the MFGMEM Alarm

Step 1 Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on 
page 2-271.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.
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Step 2 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC 
1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and 
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-273. If the Cisco TAC 
technician tells you to remove the card and reinstall a new one, complete the “Physically Replace a 
Traffic Card” procedure on page 2-274.

Step 3 If the MFGMEM alarm continues to report after replacing the TCC2/TCC2Ps, the problem lies with the 
EEPROM.

Step 4 If the MFGMEM is reported from the fan-tray assembly, obtain a fan-tray assembly and complete the 
“Replace the Fan-Tray Assembly” procedure on page 2-281.

Step 5 If the MFGMEM is reported from the AIP, the backplane, or the alarm persists after the fan-tray 
assembly is replaced, log into the Technical Support Website at http://www.cisco.com/techsupport for 
more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.280  MS-DEG 
The MS-DEG condition is not used in this platform in this release. It is reserved for development.

2.7.281  MS-EXC 
The MS-EXC condition is not used in this platform in this release. It is reserved for development.

2.7.282  MT-OCHNC 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.283  NO-CONFIG 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The No Startup Configuration condition applies to ML-Series Ethernet cards and occurs when no startup 
configuration file has been downloaded to the TCC2/TCC2P, whether or not you preprovision the card 
slot. This alarm can be expected during provisioning. When the startup configuration file is copied to the 
active TCC2/TCC2P, the alarm clears. 

Note For more information about the ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the NO-CONFIG Condition

Step 1 Create a startup configuration for the card in Cisco IOS.
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Follow the card provisioning instructions in the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet 
Card Software Feature and Configuration Guide.

Step 2 Upload the configuration file to the TCC2/TCC2P:

a. In node view, right-click the ML-Series card graphic.

b. Choose IOS Startup Config from the shortcut menu.

c. Click Local > TCC and navigate to the file location.

Step 3 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.284  NON-CISCO-PPM 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Object: PPM

The Non-Cisco PPM Inserted condition occurs when a PPM that is plugged into a card’s port fails the 
security code check. The check fails when the PPM used is not a Cisco PPM.

Clear the NON-CISCO-PPM Condition

Step 1 Obtain the correct Cisco PPM and replace the existing PPM with the new one. 

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.285  NOT-AUTHENTICATED
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: SYSTEM

The NOT-AUTHENTICATED alarm is raised by CTC (not by the NE) when CTC fails to log into a node. 
This alarm only appears in CTC where the login failure occurred. This alarm differs from the 
“INTRUSION-PSWD” alarm on page 2-132 because INTRUSION-PSWD occurs when a user exceeds 
the login failures threshold. 

Note NOT-AUTHENTICATED is an informational alarm and is resolved when CTC successfully logs into the 
node.

2.7.286  OCHNC-INC 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.287  OCHTERM-INC
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.288  ODUK-1-AIS-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.289  ODUK-2-AIS-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.290  ODUK-3-AIS-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.291  ODUK-4-AIS-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.292  ODUK-AIS-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.293  ODUK-BDI-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.294  ODUK-LCK-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.295  ODUK-OCI-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.296  ODUK-SD-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.297  ODUK-SF-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.298  ODUK-TIM-PM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.299  OOU-TPT 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSTRM, VT-TERM

The Out of Use Transport Failure alarm is a VCAT member alarm. (VCAT member circuits are 
independent circuits that are concatenated from different time slots into a higher-rate signal.) This 
condition is raised when a member circuit in a VCAT is unused, such as when it is removed by 
SW-LCAS. It occurs in conjunction with the “VCG-DEG” condition on page 2-256.

Clear the OOT-TPT Condition

Step 1 Complete the “Clear the VCG-DEG Condition” procedure on page 2-257. Clearing that condition clears 
this condition as well.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.300  OPEN-SLOT 
Default Severity: Not Alarmed (NA) 

Logical Object: EQPT 
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The Open Slot condition indicates that there is an open slot in the system shelf. Slot covers assist with 
airflow and cooling. 

Clear the OPEN-SLOT Condition 

Step 1 To install a slot cover and clear this condition, refer to the procedures located in the “Install Cards and 
Fiber-Optic Cable” chapter of the Cisco ONS 15454 Procedure Guide. 

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.301  OPTNTWMIS 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.302  OPWR-HDEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.303  OPWR-HFAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.304  OPWR-LDEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.305  OPWR-LFAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.306  OSRION 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.307  OTUK-AIS 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.308  OTUK-BDI 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.309  OTUK-IAE 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.310  OTUK-LOF 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.311  OTUK-SD 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.312  OTUK-SF 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.313  OTUK-TIM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.314  OUT-OF-SYNC 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.315  PARAM-MISM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.316  PDI-P 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

SONET Logical Objects: STSMON, STSTRM

PDI-P is a set of application-specific codes indicating a signal label mismatch failure (SLMF) in the 
ONS 15454 STS path overhead. The condition indicates to downstream equipment that there is a defect 
in one or more of the directly mapped payloads contained in that STS synchronous payload envelope 
(SPE). For example, the mismatch could occur in the overhead to the path selector in a downstream node 
configured as part of a path protection. The PDI-P codes appear in the STS Signal Label (C2 byte).

An SLMF often occurs when the payload (for example, ATM) does not match what the signal label is 
reporting. The “AIS” condition on page 2-37 often accompanies a PDI-P condition. If the PDI-P is the 
only condition reported with the AIS, clearing PDI-P clears the AIS. PDI-P can also occur during an 
upgrade, but usually clears itself and is not a valid condition.

A PDI-P condition reported on an OC-N port supporting a G1000-4 card circuit could result from the 
end-to-end Ethernet link integrity feature of the G1000-4 card. If the link integrity is the cause of the 
path defect, it is typically accompanied by the “TPTFAIL (G1000)” alarm on page 2-249 or the 
“CARLOSS (G1000)” alarm on page 2-63 reported against one or both Ethernet ports terminating the 
circuit. If this is the case, clear the TPTFAIL and CARLOSS alarms to resolve the PDI-P condition. 

A PDI-P condition reported on an OC-N port supporting an ML-Series card circuit could result from the 
end-to-end Ethernet link integrity feature of the ML-Series card. If the link integrity is the cause, it is 
typically accompanied by the “TPTFAIL (ML100T, ML1000, MLFX)” alarm on page 2-250 reported 
against one or both POS ports terminating the circuit. If TPTFAIL is reported against one or both of the 
POS ports, troubleshooting the accompanying alarm clears the PDI-P condition. Refer to the 
Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration 
Guide for more information about ML-Series cards.

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057
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2.7.317    PEER-NORESPONSE
Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the PDI-P Condition

Step 1 Verify that all circuits terminating in the reporting card are DISCOVERED:

a. Click the Circuits tab.

b. Verify that the Status column lists the circuit as active.

c. If the Status column lists the circuit as PARTIAL, wait 10 minutes for the ONS 15454 to initialize 
fully. If the PARTIAL status does not change after full initialization, log into the Technical Support 
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a 
Service-Affecting (SA) problem 1 800 553-2447.

Step 2 After determining that the circuit is DISCOVERED, ensure that the signal source to the card reporting 
the alarm is working.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 3 If traffic is affected, complete the “Delete a Circuit” procedure on page 2-276.

Caution Deleting a circuit can affect existing traffic.

Step 4 Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter 
in the Cisco ONS 15454 Procedure Guide for detailed procedures to create circuits.

Step 5 If circuit deletion and re-creation does not clear the condition, verify that there is no problem stemming 
from the far-end OC-N card providing STS payload to the reporting card. 

Step 6 If the condition does not clear, confirm the cross-connect between the OC-N card and the reporting card.

Step 7 If the condition does not clear, clean the far-end optical fiber according to site practice. If no site practice 
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure 
Guide.

Step 8 If the condition does not clear, complete the “Physically Replace a Traffic Card” procedure on 
page 2-274 for the optical/electrical cards.

Step 9 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.317  PEER-NORESPONSE 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: MLMR
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2.7.318    PLM-P
The switch agent raises a Peer Card Not Responding alarm if either traffic card in a protection group 
does not receive a response to the peer status request message. PEER-NORESPONSE is a software 
failure and occurs at the task level, as opposed to a communication failure, which is a hardware failure 
between peer cards.

However, for ML-MR-10 cards, a peer card not responding alarm is raised if a CPP card that is active 
does not receive any heartbeat response from its peer card. This happens under the following conditions:

 • Peer card is not present in the ONS 15454 chassis

 • Peer card is not configured for protection

 • Protection is disabled on the peer card

 • Peer card has reset.

Clear the PEER-NORESPONSE Alarm

Step 1 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the reporting card. For the LED 
behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 2 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the 
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates 
a standby card.

Step 3 For ML-MR-10 card, ensure that the CPP peer card has not failed, the correct protection configuration 
is present on both CPP cards, and protection is not disabled on the CPP peer card.

Step 4 If the alarm does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.7.318  PLM-P 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Objects: STSMON, STSTRM

A Payload Label Mismatch Path alarm indicates that signal does not match its label. The condition is 
indicated by a problematic C2 byte value in the SONET path overhead. The alarm is raised if all of the 
following conditions are met:

 • The received C2 byte is not 0x00 (unequipped).

 • The received C2 byte is not a PDI value.

 • The received C2 does not match the expected C2.

 • The expected C2 byte is not 0x01 (equipped, unspecified).

 • The received C2 byte is not 0x01 (equipped, unspecified). 

For example, on nodes equipped with CTC Software R4.1 and earlier, this alarm could occur when you 
have a DS3XM-6 card connected to a DS-3 card instead of a DS-1 card. The DS3XM-6 card expects a 
C2 label byte value of 01. A DS-1 card transmits this value, but a DS-3 card transmits a value of 04. The 
mismatch between the sent and expected values causes the PLM-P alarm.
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2.7.319    PLM-V
Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the PLM-P Alarm

Step 1 Complete the “Clear the PDI-P Condition” procedure on page 2-195.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.319  PLM-V 
Default Severity: Major (MJ), Service-Affecting (SA) 

SONET Logical Object: VT-TERM, VT-MON

A Payload Label Mismatch VT Layer alarm indicates that the content of the V5 byte in the SONET 
overhead is inconsistent or invalid. PLM-V occurs when ONS 15454s interoperate with equipment that 
performs bit-synchronous mapping for DS-1 signal. The ONS 15454 uses asynchronous mapping.

Clear the PLM-V Alarm

Step 1 Verify that your signal source matches the signal allowed by the traffic card. For example, the traffic card 
does not allow VT6 or VT9 mapping.

Step 2 If the signal source matches the card, verify that the SONET VT path originator is sending the correct 
VT label value. You can find the SONET VT path originator using circuit provisioning steps.
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2.7.320    PMI
Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.320  PMI
For more information about the PMI condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.7.321  PORT-FAIL
For more information about the PORT-FAIL alarm, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.7.322  PORT-MISMATCH 
Default Severity: Major (MJ), Service-Affecting (SA) 

SONET Logical Objects: CE-MR-10, ML-MR-10, FC_MR-4

The Pluggable PORT-MISMATCH alarm applies to FC_MR-4, ML-MR-10, and CE-MR-10 Ethernet 
cards.

For the ML-MR-10 and CE-MR-10 cards the alarm indicates either of the following:

 • The provisioned payload, speed, or duplex configured on the port does not match that of the SFP 
plugged into the port.

 • A non-supported SFP is plugged into the port.

For the FC_MR-4 card the alarm indicates that a non-supported GBIC is plugged into the port.

Clear the PORT-MISMATCH Alarm 

To clear the alarm on the CE-MR-10 card, either plug-in a supported SFP into the CE-MR-10 port or 
follow these steps to provision the correct payload, speed, or duplex:

1. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the CE-MR-10 
card to open the card view. 

2. Click the Provisioning > Ether Ports tabs. 

3. Specify correct values in the Expected Speed and Expected Duplex fields to match the SFP 
configuration.

4. Click Apply.

To clear the alarm on the FC_MR-4 card, plug-in a supported GBIC into the FC_MR-4 port and follow 
these steps to provision the media type:

1. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the FC_MR-4 
card graphic to open the card. 

2. Click the Provisioning > Port > General tabs.
2-198
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.323    PRC-DUPID
3. Specify proper payload value in the Media Type field.

4. Click Apply.

For the CE-MR-10 and FC_MR-10 card, the alarm can also be cleared using TL1 commands. For 
detailed instructions, refer to the Cisco ONS 15454, Cisco ONS 15600, and Cisco ONS 15310-MA 
SONET TL1 Command Guide. 

For the ML-MR-10 card, the alarm can be cleared through Cisco IOS commands. For detailed 
instructions, refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature 
and Configuration Guide.

If the alarm does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a 
Service-Affecting (SA) problem.

2.7.323  PRC-DUPID 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: OCN

The Procedural Error Duplicate Node ID alarm indicates that two identical node IDs exist in the same 
ring. The ONS 15454 requires each node in the ring to have a unique node ID.

Clear the PRC-DUPID Alarm

Step 1 Log into a node on the ring.

Step 2 Find the node ID by completing the “Identify a BLSR Ring Name or Node ID Number” procedure on 
page 2-262.

Step 3 Repeat Step 2 for all the nodes on the ring.

Step 4 If two nodes have an identical node ID number, complete the “Change a BLSR Node ID Number” 
procedure on page 2-262 so that each node ID is unique.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.324  PROTNA 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Protection Unit Not Available alarm is caused by an OOS protection card when a TCC2/TCC2P or 
XC10G card that has been provisioned as part of a protection group is not available. Unavailable 
protection can occur when a card is reset, but the alarm clears as soon as the card is back in service. The 
alarm clears if the device or facility is brought back in service.
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2.7.325    PROV-MISMATCH
Clear the PROTNA Alarm

Step 1 If the PROTNA alarm occurs and does not clear, and if it is raised against a controller or cross-connect 
card, ensure that there is a redundant TCC2/TCC2P installed and provisioned in the chassis.

Step 2 If the alarm is raised against a line card, verify that the ports have been taken out of service (OOS,MT):

a. In CTC, double-click the reporting card to open the card view (if the card is not an XC10G card).

b. Click the Provisioning tab.

c. Click the admin state of any in-service (IS) ports.

d. Choose OOS,MT to take the ports out of service.

Step 3 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the reporting card. For the LED 
behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 4 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the 
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates 
a standby card.

Step 5 If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on 
page 2-274 for the reporting card.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.325  PROV-MISMATCH
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.326  PTIM 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.327  PWR-FAIL-A 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONETLogical Object: EQPT

The Equipment Power Failure at Connector A alarm occurs when there is no power supply from the main 
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA), 
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM64IO Short Reach and 
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card, 
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.
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2.7.328    PWR-FAIL-B
Warning The power supply circuitry for the equipment can constitute an energy hazard. Before you install or 
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects 
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment. 
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the 
equipment. Statement 207

Clear the PWR-FAIL-A Alarm

Step 1 If a single card has reported the alarm, take the following actions depending on the reporting card:

 • If the reporting card is an active traffic line port in a 1+1 protection group or part of a path protection, 
ensure that an APS traffic switch has occurred to move traffic to the protect port. 

Note Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To 
avoid this, perform an external switch if a switch has not already occurred. See the 
“2.9.2  Protection Switching, Lock Initiation, and Clearing” section on page 2-263 for 
commonly used traffic-switching procedures. 

 • If the alarm is reported against a TCC2/TCC2P, complete the “Reset an Active TCC2/TCC2P Card 
and Activate the Standby Card” procedure on page 2-271.

 • If the alarm is reported against an OC-N card, complete the “Reset a Traffic Card in CTC” procedure 
on page 2-271.

 • If the alarm is reported against a cross-connect card, complete the “Reset a Traffic Card in CTC” 
procedure on page 2-271 for the cross-connect card. (The process is similar.)

Step 2 If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on 
page 2-274.

Step 3 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the reporting card.

Step 4 If the single card replacement does not clear the alarm, or if multiple cards report the alarm, verify the 
office power. Refer to the “Install the Shelf and Backplane Cable” chapter in the Cisco ONS 15454 
Procedure Guide for procedures. See the “1.13  Power Supply Problems” section on page 1-148 as 
necessary.

Step 5 If the alarm does not clear, reseat the power cable connection to the connector. 

Step 6 If the alarm does not clear, physically replace the power cable connection to the connector.

Step 7 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.328  PWR-FAIL-B 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT
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2.7.329    PWR-FAIL-RET-A
The Equipment Power Failure at Connector B alarm occurs when there is no power supply from the main 
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA), 
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM64IO Short Reach and 
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card, 
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

Warning The power supply circuitry for the equipment can constitute an energy hazard. Before you install or 
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects 
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment. 
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the 
equipment. Statement 207

Clear the PWR-FAIL-B Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-201.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.329  PWR-FAIL-RET-A 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Equipment Power Failure at Connector A alarm occurs when there is no power supplied to the 
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA), 
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM64IO Short Reach and 
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card, 
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-201.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.330  PWR-FAIL-RET-B 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT
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2.7.331    RAI
The Equipment Power Failure at Connector B alarm occurs when there is no power supplied to the 
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA), 
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM64IO Short Reach and 
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card, 
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-201.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.331  RAI 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: DS1, DS3, E1

The Remote Alarm Indication condition signifies an end-to-end failure. The error condition is sent from 
one end of the SONET path to the other. RAI on a DS3XM-6 card indicates that the far-end node is 
receiving a DS-3 AIS.

Clear the RAI Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-37. 

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.332  RCVR-MISS 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: DS1, E1

A Facility Termination Equipment Receiver Missing alarm occurs when the facility termination 
equipment detects an incorrect amount of impedance on its backplane connector. Incorrect impedance 
usually occurs when a receive cable is missing from a DS-1 port, or a possible mismatch of backplane 
equipment occurs. For example, an SMB connector or a BNC connector could be misconnected to a 
DS-1 card. 

Note DS-1s are four-wire circuits and need a positive (tip) and negative (ring) connection for both transmit 
and receive.
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2.7.333    RSV-RT-EXCD-RINGLET0
Clear the RCVR-MISS Alarm

Step 1 Ensure that the device attached to the DS-1 port is operational.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If the attachment is good, verify that the cabling is securely connected.

Step 3 If the cabling is good, verify that the pinouts are correct.

Step 4 If the pinouts are correct, replace the receive cable.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a service-affecting (SA) 
problem.

2.7.333  RSV-RT-EXCD-RINGLET0
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: RPRIF

The Reserved Bandwidth Exceeds Link Rate on Ringlet Zero alarm is raised by an ML-1000 card if the 
sum the of reserved bandwidth configured on each station of ringlet 0 is greater then the link rate (circuit 
bandwidth). The alarm clears when the sum of the reserved bandwidth on each station falls below the 
link rate. In the case of SW-LCAS or LCAS circuits, the link rate is the working link rate, which will 
change when members are removed

RSV-RT-EXCD-RINGLET0 does not suppress any alarms, but it is suppressed by the “RPR-PASSTHR” 
alarm on page 2-210. 

Clear the RSV-RT-EXCD-RINGLET0 Alarm

Step 1 At the CLI command prompt in privileged executive mode, enter the following command:

router# show rpr-ieee topology detail

This command’s output shows the configured reserved bandwidth rate from each station.

Step 2 Reduce the reserved bandwidth on the alarmed station until the error clears. Enter the following CLI 
command in IEEE 802.17b-based RPR interface configuration mode:

router (config-if)# rpr-ieee tx-traffic rate-limit reserved

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a service-affecting (SA) 
problem.
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2.7.334  RSV-RT-EXCD-RINGLET1
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: RPRIF

The Reserved Bandwidth Exceeds Link Rate on Ringlet One alarm is raised by an ML-1000 card if the 
sum the of reserved bandwidth configured on each station of ringlet 1 is greater then the link rate (circuit 
bandwidth). The alarm clears when the sum of the reserved bandwidth on each station falls below the 
link rate. In the case of SW-LCAS or LCAS circuits, the link rate is the working link rate, which will 
change when members are removed

RSV-RT-EXCD-RINGLET1 does not suppress any alarms, but it is suppressed by the “RPR-PASSTHR” 
alarm on page 2-210. 

Clear the RSV-RT-EXCD-RINGLET1 Alarm

Step 1 At the CLI command prompt in privileged executive mode, enter the following command:

router# show rpr-ieee topology detail

This command’s output shows the configured reserved bandwidth rate from each station.

Step 2 Reduce the reserved bandwidth on the alarmed station until the error clears. Enter the following CLI 
command in IEEE 802.17b-based RPR interface configuration mode:

router (config-if)# rpr-ieee tx-traffic rate-limit reserved

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a service-affecting (SA) 
problem.

2.7.335  RFI 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.336  RFI-L 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: EC1, OCN

DWDM Logical Object: TRUNK

A RFI Line condition occurs when the ONS 15454 detects an RFI in OC-N card SONET overhead 
because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-L condition 
in the reporting node. RFI-L indicates that the condition is occurring at the line level.

Clear the RFI-L Condition

Step 1 Log into the node at the far-end node of the reporting ONS 15454.
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Step 2 Identify and clear any alarms, particularly the “LOS (OCN)” alarm on page 2-165.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.337  RFI-P 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM

The RFI Path condition occurs when the ONS 15454 detects an RFI in the an STS-1 signal SONET 
overhead because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-P 
condition in the reporting node. RFI-P occurs in the terminating node in that path segment. 

Clear the RFI-P Condition

Step 1 Verify that the ports are enabled and in service (IS-NR) on the reporting ONS 15454:

a. Confirm that the LED is correctly illuminated on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card 
view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose 
IS. Click Apply.

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised 
or remains, and the port service state transitions to OOS-AU,FLT.

Step 2 To find the path and node failure, verify the integrity of the SONET STS circuit path at each of the 
intermediate SONET nodes.

Step 3 Clear alarms in the node with the failure, especially the “UNEQ-P” alarm on page 2-253 or the 
“UNEQ-V” alarm on page 2-255. 

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.338  RFI-V 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: VTMON, VT-TERM
2-206
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.339    RING-ID-MIS
An RFI VT Layer condition occurs when the ONS 15454 detects an RFI in the SONET overhead because 
of a fault in another node. Resolving the fault in the adjoining node clears the RFI-V condition in the 
reporting node. RFI-V indicates that an upstream failure has occurred at the VT layer.

Clear the RFI-V Condition

Step 1 Verify that the connectors are securely fastened and connected to the correct slot. For more information, 
refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If connectors are correctly connected, verify that the DS-N 

Step 3 port is active and in service (IS-NR):

a. Confirm that the LED is correctly illuminated on the physical card. A green ACT/SBY LED 
indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card 
view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS. If the Admin State column lists the port as 
OOS,MT or OOS,DSBLD, click the column and choose IS. Click Apply.

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised 
or remains, and the port service state transitions to OOS-AU,FLT.

Step 4 If the ports are active and in service, use an optical test set to verify that the signal source does not have 
errors. For specific procedures to use the test set equipment, consult the manufacturer.

Step 5 If the signal is valid, log into the node at the far-end of the reporting ONS 15454.

Step 6 Clear alarms in the far-end node, especially the “UNEQ-P” alarm on page 2-253 or the “UNEQ-V” alarm 
on page 2-255. 

Step 7 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.339  RING-ID-MIS 
Default Severity: Major (MJ), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

DWDM Logical Object: OSC-RING

The Ring ID Mismatch condition refers to the ring ID in APC. It occurs when a ring name does not match 
other detectable node ring names, and can cause problems with applications that require data exchange 
with APC. This alarm is similar to the “RING-MISMATCH” alarm on page 2-208, but rather than apply 
to BLSDR ring protection, RING-ID-MIS applies to DWDM node discovery within the same network. 
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2.7.340    RING-MISMATCH
Note For more information about APC, refer to the Cisco ONS 15454 DWDM Procedure Guide.

Clear the RING-ID-MIS Alarm

Step 1 Complete the “Clear the RING-MISMATCH Alarm” procedure on page 2-208.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.340  RING-MISMATCH 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: OCN

A Procedural Error Mismatch Ring alarm occurs when the ring name of the ONS 15454 node that is 
reporting the alarm does not match the ring name of another node in the BLSR. Nodes connected in a 
BLSR must have identical ring names to function. This alarm can occur during BLSR provisioning.

RING-MISMATCH is somewhat similar to RING-ID-MIS, but it applies to BLSR protection discovery 
instead of DWDM node discovery.

Note For more information about DWDM cards, refer to the Cisco ONS 15454 DWDM Reference Manual.

Clear the RING-MISMATCH Alarm

Step 1 In node view, click the Provisioning > BLSR tabs.

Step 2 Note the name in the Ring Name field.

Step 3 Log into the next ONS 15454 node in the BLSR.

Step 4 Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-262.

Step 5 If the ring name matches the ring name in the reporting node, repeat Step 4 for the next ONS 15454 in 
the BLSR.

Step 6 Complete the “Change a BLSR Ring Name” procedure on page 2-262.

Step 7 Verify that the ring map is correct.

Step 8 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.341  RING-SW-EAST 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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2.7.342    RING-SW-WEST
SONET Logical Object: OCN

The Ring Switch Is Active East Side condition occurs when a ring switch occurs at the east side of a 
BLSR using a Force Ring command. The condition clears when the switch is cleared. RING-SW-EAST 
is visible on the network view Alarms, Conditions, and History tabs. The port where the Force Ring was 
applied shows an “F” on the network view detailed circuit map.

Note RING-SW-EAST is an informational condition and does not require troubleshooting.

2.7.342  RING-SW-WEST 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Ring Switch Is Active West Side condition occurs when a ring switch occurs at the west side of a 
BLSR using a Force Ring command. The condition clears when the switch is cleared. RING-SW-WEST 
is visible on the network view Alarms, Conditions, and History tabs. The port where the Force Ring was 
applied shows an “F” on the network view detailed circuit map.

Note RING-SW-WEST is an informational condition and does not require troubleshooting.

2.7.343  ROLL
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM, VT-TERM, VT-MON

The ROLL condition indicates that circuits are being rolled. This is typically carried out to move traffic 
for a maintenance operation or to perform bandwidth grooming. The condition indicates that a good 
signal has been received on the roll destination leg, but the roll origination leg has not yet been dropped. 
The condition clears when the roll origination leg is dropped. 

Note ROLL is an informational condition and does not require troubleshooting.

2.7.344  ROLL-PEND 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM, VT-TERM, VT-MON

ROLL-PEND indicates that a roll process has been started, but a good signal has not been received yet 
by the roll destination leg. This condition can be raised individually by each path in a bulk circuit roll.

The condition clears when a good signal has been received on the roll destination leg.

Note ROLL-PEND is an informational condition and does not require troubleshooting.
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2.7.345    ROUTE-OVERFLOW
2.7.345  ROUTE-OVERFLOW
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: NE

DWDM Logical Object: NE regardless of MSTP or MSPP

The ROUTE-OVERFLOW indicates the condition when the OSPF routing table exceeds 700 routes. The 
symptoms for this condition are loss of visibility to a node or network, inability to access a node using 
CTC, CTM, Telnet, Ping, and so on.

Clear the ROUTE-OVERFLOW Condition

Step 1 Reconfigure the OSPF network to less than 700 routes.

2.7.346  RPR-PASSTHR
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: RPRIF

The IEEE 802.17 b-based RPR Interface in Pass-Through Mode condition indicates that an ML card’s 
IEEE 802.17 b-based RPR interface is not participating in a ring. Instead, the card is behaving like a 
passive device that allows the signal to transit but does not manipulate it. Pass-through mode itself is 
hitless.

You can manually place an ML card into (or out of) pass-through mode using the Cisco IOS CLI 
command SHUTDOWN (SHUT) for such reasons as adding, removing, or servicing the node. To do so 
is hitless.

The ML-1000 automatically enters pass-through mode if either of the following conditions is true:

 • Redundant interconnect (RI) is configured and the ML card is in primary mode (that is, single traffic 
queue mode), standby state.

 • RI is configured and the RI interface goes down during a “WTR” alarm on page 2-259, while the 
ML card is in secondary mode (that is, dual traffic queue mode) on a Cisco proprietary RPR ring.

Note For GFP and HDLC mode, the ML card shutdown (SHUT) command causes an “AIS-P” alarm on 
page 2-38 to be sent to the peer. But in IEEE 802.17b-based RPR mode, AIS-P is not inserted toward the 
peer.

The RPR-PASSTHR condition suppresses the following alarms:

 • FORCED-REQ, page 112 

 • LINK-KEEPALIVE, page 142

 • MAN-REQ, page 179 

 • MAX-STATIONS, page 181

 • RSV-RT-EXCD-RINGLET0, page 204

 • RSV-RT-EXCD-RINGLET1, page 205
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2.7.347    RPR-PEER-MISS
 • RPR-PROT-ACTIVE, page 212

 • RPR-PROT-CONFIG-MISM, page 213

 • RPR-SD, page 214

 • RPR-SF, page 215

 • RPR-SPAN-MISMATCH, page 216

 • WTR, page 259 

If RPR-PASSTHR is raised—meaning that this RPR-IEEE interface is not available—one or more of its 
peer nodes might raise the “RPR-PEER-MISS” alarm on page 2-211. RPR-PASSTHR does not suppress 
the “RPR-PEER-MISS” alarm on page 2-211, or the “RPR-RI-FAIL” alarm on page 2-213.

Clear the RPR-PASSTHR Condition

Step 1 If the ML card was manually configured shut down using the CLI command SHUTDOWN (SHUT), 
enter the following command at the command prompt:

router# no shut

Step 2 If the card is in pass-through mode due to being in an RI primary mode standby state, either the 
IEEE 802.17b-based RPR interface is down or the interconnect interface is down. You must clear the 
root cause of either problem to clear the pass-through. To trace the root cause problem in the RPR-IEEE 
interface setup, enter the following CLI command in privileged executive mode:

router# show interface rpr-ieee 0 

Step 3 View the command output and locate the RI information line. It displays the name of the monitored 
interfaces as “monitoring ring interface,” or “monitoring interconnect interface.”

Step 4 Locate and clear any trouble on the monitored interface. Trouble might be indicated on that interface 
through previous alarms that occurred before RPR-PASSTHR was raised.

Step 5 If the card is in pass-through mode while in RI secondary mode when the interconnect fails, pass-through 
mode should clear automatically in 60 seconds. 

Step 6 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.7.347  RPR-PEER-MISS
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: RPRIF

The IEEE 802.17-based RPR Peer Node Is Missing condition is raised by an ML card when RI is 
configured on the card, but this station does not detect its peer station in the topology. The condition 
clears when the peers detect each other.
2-211
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.348    RPR-PROT-ACTIVE
Clear the RPR-PEER-MISS Condition

Step 1 Determine whether the peer MAC address is properly configured by completing the following steps:

a. Enter the following CLI command in privileged executive mode:

router# show interface rpr-ieee 0

This command’s output will include information, similar to the following, about the RPR-IEEE 
interface raising the condition:

Hardware is RPR-IEEE Channelized SONET, address is 000e.8312.bcf0 (bia 
000e.87312.bfc0)

b. Verify that the alarmed interface’s configured peer MAC address is the correct MAC address for the 
peer card. A card in primary mode need to list the peer MAC address of the card operating in 
secondary mode; the secondary card needs to list the peer MAC address of the primary card. Peer 
MAC address information is contained in the same “show interface rpr-ieee 0” command output. In 
the following line example, the RPR-IEEE interface raising the alarm is primary; it is in active mode, 
and its configured peer, the secondary card, is MAC address 000e.8312.b870:

RI: primary,active peer mac 000e.8312.b870

Note The primary and secondary cards do not have to be neighbors on the ring. 

Note If RI is configured, then RI information is displayed in the “show interface rpr 0" output.

To correct the MAC address configuration, refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH 
Ethernet Card Software Feature and Configuration Guide for procedures.

Step 2 If the condition does not clear, enter the following command in privileged executive mode:

router# show rpr-ieee protection

Step 3 The command output, similar to the following lines, shows whether any protection switches are active:

West Span Failures: none
East Span Failures: none

A protection switch can cause an RPR-PEER-MISS condition. You may also see the 
“RPR-PROT-ACTIVE” alarm on page 2-212 raised for a span. Clear any protection issues.

Step 4 If the condition does not clear, correct any issues on the peer node that would cause it to go into 
pass-through mode, which can cause the peer to raise RPR-PEER-MISS.

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.348  RPR-PROT-ACTIVE
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: RPRIF
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2.7.349    RPR-PROT-CONFIG-MISM
The IEEE 802.17b-based RPR Protection is Active condition, raised by the ML card, indicates that ring 
protection is active and that steering protection as defined in IEEE 802.17b is active. 

IEEE 802.17b-based RPR provides hitless protection switching for all protected traffic on a ring. Its 
steering protection mechanism ensures that each station receives span change information (such as fail 
or restoration) in time to make protection switching decisions within the 50-millisecond time frame. 

The condition clears when steering protection is no longer active.For more information about steering, 
refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and 
Configuration Guide.

This condition is suppressed by the “RPR-PASSTHR” alarm on page 2-210.

Clear the RPR-PROT-ACTIVE Condition

Step 1 Locate and clear any service-affecting SONET error that might have caused a protection switch, in turn 
triggering the RPR-PROT-ACTIVE condition. Clearing the SONET condition will clear 
RPR-PROT-ACTIVE.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.349  RPR-PROT-CONFIG-MISM
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: RPRIF

The IEEE 802.17b-based RPR Protection Configuration Mismatched alarm is raised by an ML card 
when it detects that its steering protection scheme is mismatched with other vendors’ equipment 
configured for wrapping protection. The ONS 15454 does not support IEEE 802.17b’s optional 
wrapping scheme.

The alarm clears when the other vendor’s equipment configuration is changed to utilize steering 
protection.

RPR-PROT-CONFIG-MISM is suppressed by the “RPR-PASSTHR” alarm on page 2-210.

Clear the RPR-PROT-CONFIG-MISM Alarm

Step 1 You cannot clear this alarm from the ONS 15454; rather, it is caused by incompatible vendor equipment 
configuration. See that equipment’s support information to correct the configuration for steering instead 
of wrapping. This, in turn, will cause RPR-PROT-CONFIG-MISM to clear.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.7.350  RPR-RI-FAIL
Default Severity: Major (MJ), Service-Affecting (SA)
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2.7.351    RPR-SD
SONET Logical Object: RPRIF

The IEEE 802.17b-based RPR RI Fail condition is raised by an ML card in primary or secondary mode. 
If a card is in primary mode, a Gigabit Ethernet interface can cause an interconnect interface (IC) failure. 
(The IC includes the Gigabit Ethernet interface and possibly a port channel interface.) In primary mode, 
RPR-RI-FAIL can also be raised in response to a downed ring interface. In secondary mode, the only 
possible cause of this condition is IC failure.

The alarm clears when the IEEE 802.17b-based RPR interface returns to Init modes and faults, if present, 
are cleared. RPR-RI-FAIL is suppressed by the “RPR-PASSTHR” alarm on page 2-210.

Clear the RPR-RI-FAIL Condition

Step 1 If the card is in primary mode, enter the following command at the CLI in privileged executive mode:

router# show interface rpr-ieee 0

Step 2 The RI information line displays the name of the monitored interfaces and says either “monitoring ring 
interface,” or “monitoring interconnect interface.”

Step 3 Determine why the monitored interface is down. It can occur because the ring interface has been shut 
down using the “shutdown” CLI command, or because both SONET circuits are down or OOS.

Step 4 If correcting the previous problem on a primary interface does not clear the condition, or if the condition 
is raised on a card is secondary mode, the IC failure root cause must be corrected. This can be due to a 
fiber pull, having link protocol down, or shut down interfaces.

 • Link state is indicated in the “show interface rpr-ieee 0” output on the following line:

RPR-IEEE0 is up, line protocol is up 

 • A shutdown is indicated if a node is in pass-through mode. The same command output indicates 
whether or not this is the case:

MAC passthrough not set 

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.7.351  RPR-SD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: ML100T, ML1000, MLFX

The IEEE 802.17b-based RPR Signal Degrade condition indicates that a minor signal degradation has 
occurred on an IEEE- RPR ring that, if not overridden, can deactivate the link.The RPR-SD condition is 
reported if the SONET “SD-P” alarm on page 2-221, is raised on the circuit which carries the span. The 
RPR-SD condition clears when the SONET signal degrade clears. 

RPR-SD suppresses the “MAN-REQ” alarm on page 2-179 and the “WTR” alarm on page 2-259.

It is suppressed by the following alarms:

 • FORCED-REQ, page 112 

 • RPR-PASSTHR, page 210
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2.7.352    RPR-SF
 • RPR-SF, page 215

Clear the RPR-SD Condition

Step 1 Complete the “Clear the SD-P Condition” procedure on page 2-222 to clear this secondary condition.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a 
Service-Affecting (SA) problem.

2.7.352  RPR-SF
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: ML100T, ML1000, MLFX

The IEEE 802.17b-based RPR Signal Fail condition indicates a signal loss or major signal degradation 
that deactivates the RPR-IEEE link. The failure that raises RPR-SF can be attributable to any of the 
following alarms:

 • AIS-P, page 38

 • GFP-LFD, page 119

 • LOP-P, page 155

 • PDI-P, page 194

 • PLM-P, page 196

 • RFI-P, page 206

 • TIM-P, page 246

 • UNEQ-P, page 253

 • VCG-DOWN, page 257

The RPR-SF condition can also occur if a SONET circuit’s state is UNASSIGNED (not provisioned).

This condition clears when these primary cause alarms are cleared. RPR-SF is suppressed by the 
“RPR-PASSTHR” alarm on page 2-210 or the “FORCED-REQ” alarm on page 2-112. RPR-SF itself 
suppresses the following alarms:

 • MAN-REQ, page 179 

 • RPR-SD, page 214

 • WTR, page 259 

Clear the RPR-SF Condition

Step 1 Complete the trouble-clearing procedure in this chapter for any primary cause SONET failure condition 
as previously listed.
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2.7.353    RPR-SPAN-MISMATCH
Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a 
Service-Affecting (SA) problem.

2.7.353  RPR-SPAN-MISMATCH
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: ML100T, ML1000, MLFX

The IEEE 802.17b-based RPR-SPAN-MISMATCH alarm is caused by span misprovisioning, span 
forced switching, physical miscabling, or a circuit loopback. 

Miscabling problems between this node’s east or west span and its neighboring span in the same 
direction can also cause this alarm, as will provisioning an XC loopback on a circuit that carries 
RPR-IEEE traffic. 

If a traffic-affecting issue such as the “AIS-P” alarm on page 2-38, the “GFP-LFD” alarm on page 2-119, 
the “LOP-P” alarm on page 2-155, the “RFI-P” alarm on page 2-206, or the “UNEQ-P” alarm on 
page 2-253 occurs, it in turn suppresses RPR-SPAN-MISMATCH.

Note Clearing a circuit XC loopback does not always cause the loopback to clear. If this is the case, a FORCE 
switch is used to clear the RPR-SPAN-MISMATCH alarm. The FORCE might cause a traffic hit.

RPR- SPAN-MISMATCH is suppressed by “RPR-PASSTHR” alarm on page 2-210. 

Clear the RPR-SPAN-MISMATCH Alarm

Step 1 Locate and clear any primary cause provisioning errors.

Step 2 If the alarm does not clear, locate and correct any span cabling errors.

Step 3 If the alarm does not clear, look for and clear XC loopbacks on the spans.

Step 4 If the alarm does not clear, configure a FORCE switch on the 802.17b-based RPR span and then clear 
the switch. To do this, enter the following CLI command in RPR-IEEE interface provisioning mode:

router(config)# rpr-ieee protection request forced-switch {east | west}

Clear the switch by entering the following command:

router(config)# no rpr-ieee protection request forced-switch {east | west}

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.7.354  RPRW
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: ML100T, ML1000, MLFX
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2.7.355    RUNCFG-SAVENEED
The Cisco proprietary RPR Wrapped condition applies to CE100T-8 and ML-Series cards and occurs 
when the Cisco proprietary RPR protocol initiates a ring wrap due to a fiber cut, node failure, node 
restoration, new node insertion, or other traffic problem. It can also be raised if the POS port has an 
Admin down condition. (In this case, you will not see any SONET-level alarms or the “TPTFAIL 
(ML100T, ML1000, MLFX)” alarm on page 2-250.) 

When the wrap occurs, traffic is redirected to the original destination by sending it in the opposite 
direction around the ring after a link state change or after receiving any SONET path-level alarms.

Note ML-Series card POS interfaces normally send the “PDI-P” alarm on page 2-194 to the far end when the 
POS link goes down or when Cisco proprietary RPR wraps. ML-Series card POS interfaces do not send 
a PDI-P alarm to the far end when this alarm is detected, when the alarm is being sent to the far end, or 
when the only defects being detected are the “GFP-LFD” alarm on page 2-119, the “GFP-CSF” alarm 
on page 2-117, the VCAT “LOM” alarm on page 2-155, or the VCAT “SQM” alarm on page 2-232.

Note For more information about ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the RPRW Condition

Step 1 Look for and clear any service-affecting SONET path-level alarms on the affected circuit, such as the 
“LOP-P” alarm on page 2-155, the “LOS-P (TRUNK)” alarm on page 2-167, the “PLM-P” alarm on 
page 2-196, or the “TIM-P” alarm on page 2-246. Clearing such an alarm can also clear RPRW.

Step 2 If the condition does not clear, look for and clear any service alarms for the ML-Series card itself, such 
as the “CARLOSS (CEMR, CE1000, CE100T)” alarm on page 2-59, the “CARLOSS (ML1000, 
ML100T, MLFX)” alarm on page 2-66, the “TPTFAIL (CEMR, CE100T, CE1000)” alarm on 
page 2-248, or the “TPTFAIL (ML100T, ML1000, MLFX)” alarm on page 2-250. 

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.7.355  RUNCFG-SAVENEED 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Run Configuration Save Needed condition occurs when you change the running configuration file 
for ML-Series cards. It is a reminder that you must save the change to the startup configuration file for 
it to be permanent. 

The condition clears after you save the running configuration to the startup configuration, such as by 
entering the following command in privileged executive mode in the CLI:

router# copy run start

If you do not save the change, the change is lost after the card reboots. If the command “copy run start” 
is executed in configuration mode and not privileged executive mode, the running configuration will be 
saved, but the alarm will not clear.
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2.7.356    SD (DS1, DS3)
Note For more information about the ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

2.7.356  SD (DS1, DS3) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: DS1, DS3

A Signal Degrade (SD) condition for DS-1 or DS-3 occurs when the quality of an electrical signal on a 
DS3XM-6, DS3XM-12, or DS3/EC1-48 card has exceeded the BER signal degrade threshold. Signal 
degrade is defined by Telcordia as a soft failure condition. SD and signal fail (SF) both monitor the 
incoming BER and are similar, but SD is triggered at a lower bit error rate than SF. 

The BER threshold is user-provisionable and has a range for SD from 1E–9 dBm to 1E–5 dBm.

SD can be reported on electrical card ports that are In-Service and Normal (IS-NR); Out-of-Service and 
Autonomous, Automatic In-Service (OOS-AU,AIS); or Out-of-Service and Management, Maintenance 
(OOS-MA,MT), but not in the Out-of-Service and Management, Disabled (OOS-MA,DSBLD) service 
state. The BER count increase associated with this alarm does not take an IS-NR port out of service, but 
if it occurs on an AINS port, the alarm prevents the port from going into service. 

The SD condition clears when the BER level falls to one-tenth of the threshold level that triggered the 
condition. A BER increase is sometimes caused by a physical fiber problem such as a faulty fiber 
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice. SD can also 
be caused by repeated XC10G card switches that in turn can cause switching on the lines or paths.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Note Some levels of BER errors (such as 1E–9 dBm) take a long period to raise or clear, about 9,000 seconds, 
or 150 minutes. If the SD threshold is provisioned at 1E–9 dBm rate, the SD alarm needs at least one 
and one-half hours to raise and then another period at least as long to clear.

Note The recommended test set for use on all SONET ONS electrical cards is the Omniber 718. For specific 
procedures to use the test set equipment, consult the manufacturer.
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Clear the SD (DS1, DS3) Condition

Step 1 If the condition applies for a DS-3 line on a DS3XM-6, DS3XM-12, DS3E-12, or DS3/EC1-48 card, 
complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on 
page 2-277. If the condition applies to any other DS-N card (DS3i-N-14, DS3-12, DS3i-N-14, or 
DS1/E1-56) complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on 
page 2-278.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 Ensure that the fiber connector for the card is completely plugged in. For more information about fiber 
connections and card insertion, refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide.

Step 3 If the BER threshold is correct and at the expected level, use an optical test set to measure the power 
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment, 
consult the manufacturer.

Step 4 If the optical power level is good, verify that optical receive levels are within the acceptable range.

Step 5 If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists, 
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step 6 If the condition does not clear, verify that single-mode fiber is used.

Step 7 If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node. 

Step 8 Clean the fiber connectors at both ends for a signal degrade according to site practice.

Step 9 Verify that a single-mode laser is used at the far end.

Step 10 If the problem does not clear, the transmitter at the other end of the optical line could be failing and 
require replacement. Refer to the “2.9.4  Physical Card Reseating, Resetting, and Replacement” section 
on page 2-273.

Step 11 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.357  SD (E1)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: E1

An SD condition for an E1 occurs on a DS1/E1-56 card in E1 only mode when the quality of an electrical 
signal has exceeded the BER signal degrade threshold. 

SD is triggered at a lower bit error rate than SF. The SD BER threshold is user-provisionable and ranges 
from 1E–9 dBm to 1E–5 dBm.

SD can be reported on electrical card ports that are In-Service and Normal (IS-NR); Out-of-Service and 
Autonomous, Automatic In-Service (OOS-AU,AIS); or Out-of-Service and Management, Maintenance 
(OOS-MA,MT) but not in the Out-of-Service and Management, Disabled (OOS-MA,DSBLD) service 
state. The BER count increase associated with this alarm does not take an IS-NR port out of service, but 
if it occurs on an AINS port, the alarm prevents the port from going into service. 
2-219
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.357    SD (E1)
The SD condition clears when the BER level falls to one-tenth of the threshold level that triggered the 
condition. A BER increase is sometimes caused by a physical fiber problem such as a faulty fiber 
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice. SD can also 
be caused by repeated XC10G card switches that in turn can cause switching on the lines or paths.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Note Some levels of BER errors (such as 1E–9 dBm) take a long period to raise or clear, about 9,000 seconds, 
or 150 minutes. If the SD threshold is provisioned at 1E–9 dBm rate, the SD alarm needs at least one 
and a half hours to raise and then another period at least as long to clear.

Note The recommended test set for use on all SONET ONS electrical cards is the Omniber 718. For specific 
procedures to use the test set equipment, consult the manufacturer.

Clear the SD (E1) Condition

Step 1 Complete the “Clear Other Electrical Card or Ethernet Card Loopbacks” procedure on page 2-278.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 Ensure that the fiber connector for the card is completely plugged in. For more information about fiber 
connections and card insertion, refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15454 Procedure Guide.

Step 3 If the BER threshold is correct and at the expected level, use an optical test set to measure the power 
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment, 
consult the manufacturer.

Step 4 If the optical power level is good, verify that optical receive levels are within the acceptable range.

Step 5 If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists, 
complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Step 6 If the condition does not clear, verify that single-mode fiber is used.

Step 7 If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node. 

Step 8 Clean the fiber connectors at both ends for a signal degrade according to site practice.

Step 9 If the problem does not clear, the transmitter at the other end of the optical line could be failing and 
require replacement. Refer to the “2.9.4  Physical Card Reseating, Resetting, and Replacement” section 
on page 2-273.
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Step 10 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.358  SD (TRUNK) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.359  SD-L 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EC1, OCN

An SD Line condition is similar to the “SD (DS1, DS3)” condition on page 2-218. It applies to the line 
level of the SONET signal and travels on the B2 byte of the SONET overhead. 

An SD-L on an Ethernet or OC-N card does not cause a protection switch. If the alarm is reported on a 
card that has also undergone a protection switch, the SD BER count continues to accumulate. The 
condition is superseded by higher-priority alarms such as the “LOF (EC1)” alarm on page 2-151, the 
“LOF (OCN)” alarm on page 2-152, the “LOS (EC1)” alarm on page 2-163, and the “LOS (OCN)” alarm 
on page 2-165.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the SD-L Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-219.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.360  SD-L (TRUNK)
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.361  SD-P 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

SONET Logical Objects: STSMON, STSTRM
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An SD Path condition is similar to the “SD (DS1, DS3)” condition on page 2-218, but it applies to the 
path (STS) layer of the SONET overhead. A path or STS-level SD alarm travels on the B3 byte of the 
SONET overhead.

For path protection protected circuits, the BER threshold is user-provisionable and has a range for SD 
from 1E–9 dBm to 1E–5 dBm. For BLSR 1+1 and unprotected circuits, the BER threshold value is not 
user-provisionable and the error rate is hard-coded to 1E–6 dBm.

On path protection configurations, an SD-P condition causes a switch from the working card to the 
protect card at the path (STS) level. On BLSR, 1+1, and on unprotected circuits, an SD-P condition does 
not cause switching.

The BER increase that causes the condition is sometimes caused by a physical fiber problem such as a 
poor fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The SD clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.

Clear the SD-P Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-219.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.362  SD-V 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: VT-MON, VT-TERM

An SD-V condition is similar to the “SD (DS1, DS3)” condition on page 2-218, but it applies to the VT 
layer of the SONET overhead.

For path protection protected circuits, the BER threshold is user-provisionable and has a range for SD 
from 1E–9 dBm to 1E–5 dBm. For BLSR 1+1 and unprotected circuits, the BER threshold value is not 
user-provisionable and the error rate is hard-coded to 1E–6 dBm.

On path protection configurations, an SD-V condition does not cause a switch from the working card to 
the protect card at the path (STS) level. On BLSR, 1+1, and on unprotected circuits, an SD-V condition 
does not cause switching.

The BER increase that causes the alarm is sometimes caused by a physical fiber problem such as a poor 
fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The SD alarm clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.

Clear the SD-V Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-219.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.363  SF (DS1, DS3) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: DS1, DS3

A Signal Fail (SF) condition occurs when the quality of the signal has exceeded the BER signal failure 
threshold. Signal failure is defined by Telcordia as a “hard failure” condition. The SD and SF conditions 
both monitor the incoming BER error rate and are similar conditions, but SF is triggered at a higher BER 
than SD.

The BER threshold is user-provisionable and has a range for SF from 1E–5 dBm to 1E–3 dBm. 

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the SF (DS1, DS3) Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-219.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.364  SF (E1)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: E1

An SF condition for an E1 occurs on a DS1/lE1-56 card in E1 only mode when the quality of the signal 
has exceeded the BER signal failure threshold. 

SF monitors the incoming BER error rate just as SD does, but SF is triggered at a higher BER than SD. 
The SF BER threshold is user-provisionable and has a range for SF from 1E–5 dBm to 1E–3 dBm. 

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 
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Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the SF (E1) Condition

Step 1 Complete the “Clear the SD (E1) Condition” procedure on page 2-220.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.365  SF (TRUNK) 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.366  SF-L 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EC1, OCN

An SF Line condition is similar to the “SF (DS1, DS3)” condition on page 2-223, but it applies to the 
line layer B2 overhead byte of the SONET signal. It can trigger a protection switch.

The SF-L condition clears when the BER level falls to one-tenth of the threshold level that triggered the 
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber 
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The condition is superseded by higher-priority alarms such as the “LOF (EC1)” alarm on page 2-151, 
the “LOS (EC1)” alarm on page 2-163, and the “LOS (OCN)” alarm on page 2-165.

Clear the SF-L Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-219.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.367  SF-L (TRUNK)
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.368  SF-P 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: STSMON, STSTRM

An SF Path condition is similar to the “SF (DS1, DS3)” condition on page 2-223, but it applies to the 
path (STS) layer B3 byte of the SONET overhead. It can trigger a protection switch.

The SF-P condition clears when the BER level falls to one-tenth of the threshold level that triggered the 
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber 
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

Clear the SF-P Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-219.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.369  SFTWDOWN 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

A Software Download in Progress alarm occurs when the TCC2/TCC2P is downloading or transferring 
software. 

If the active and standby TCC2/TCC2Ps have the same versions of software, it takes approximately three 
minutes for software to be updated on a standby TCC2/TCC2P.

If the active and standby TCC2/TCC2Ps have different software versions, the transfer can take up to 
30 minutes. Software transfers occur when different software versions exist on the two cards. After the 
transfer completes, the active TCC2/TCC2P reboots and goes into standby mode after approximately 
three minutes.

No action is necessary. Wait for the transfer or the software download to complete. If the alarm does not 
clear, log into the Technical Support Website at http://www.cisco.com/techsupport for more information 
or call Cisco TAC 1 800 553-2447.

Caution Updating software on a standby TCC2/TCC2P can take up to 30 minutes. Wait the full time period before 
removing the card. Premature removal can cause flash corruption.
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Note When you upgrade a TCC2 to card to a TCC2P, the SFTWDOWN alarm can be raised and cleared more 
than once before the software download is complete. For example, when you remove the standby TCC2 
card in Slot 11 and replace it with a TCC2P card, the SFTWDOWN alarm occurs within moments of this 
replacement. It can briefly clear and then raise again before it is finally cleared at the end of the upgrade 
process.

Note SFTWDOWN is an informational alarm.

2.7.370  SF-V 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: VT-MON, VT-TERM

An SF-V condition is similar to the “SF (DS1, DS3)” condition on page 2-223, but it applies to the VT 
layer of the SONET overhead.

Clear the SF-V Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-219.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.371  SHELF-COMM-FAIL
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.372  SH-IL-VAR-DEG-HIGH 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.373  SH-IL-VAR-DEG-LOW 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.374  SHUTTER-OPEN 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.375  SIGLOSS 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: FCMR

DWDM Logical Objects: ESCON, FC, GE, ISC, TRUNK

The Signal Loss on Data Interface alarm is raised on FC_MR-4 card receive client ports and MXP card 
FC and ISC client data ports when there is a loss of signal. (Loss of Gigabit Ethernet client signal results 
in a “CARLOSS (GE)” alarm on page 2-66, not SIGLOSS.) SIGLOSS can also be raised on the MXP 
trunk port.

If the “SYNCLOSS” alarm on page 2-241, was previously raised on the port, the SIGLOSS alarm will 
demote it.

Clear the SIGLOSS Alarm

Step 1 Ensure that the data port connection at the near-end card’s port of the SONET link is operational. 

Step 2 Verify fiber continuity to the port. To verify fiber continuity, follow site practices.

Step 3 Check the physical port LED on the card. The port LED looks clear (that is, not lit green) if the link is 
not connected. 

Step 4 If the alarm does not clear, log onto http://www.cisco.com/techsupport for more information or call 
Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) problem. 

2.7.376  SNTP-HOST 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: NE

The Simple Network Timing Protocol (SNTP) Host Failure alarm indicates that an ONS 15454 serving 
as an IP proxy for the other ONS 15454 nodes in the ring is not forwarding SNTP information to the 
other nodes in the network. The forwarding failure can result from two causes: either the IP network 
attached to the ONS 15454 proxy node is experiencing problems, or the ONS 15454 proxy node itself is 
not functioning properly.

Clear the SNTP-HOST Alarm

Step 1 Ping the SNTP host from a workstation in the same subnet to ensure that communication is possible 
within the subnet by completing the “1.9.8  Verify PC Connection to the ONS 15454 (ping)” procedure 
on page 1-119.
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Step 2 If the ping fails, contact the network administrator who manages the IP network that supplies the SNTP 
information to the proxy and determine whether the network is experiencing problems, which could 
affect the SNTP server/router connecting to the proxy ONS 15454 system.

Step 3 If no network problems exist, ensure that the ONS system proxy is provisioned correctly:

a. In node view for the ONS 15454 serving as the proxy, click the Provisioning > General tabs.

b. Ensure that the Use NTP/SNTP Server check box is checked.

c. If the Use NTP/SNTP Server check box is not checked, click it.

d. Ensure that the Use NTP/SNTP Server field contains a valid IP address for the server.

Step 4 If proxy is correctly provisioned, refer to the “Timing” chapter in the Cisco ONS 15454 Reference 
Manual for more information on SNTP Host.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.377  SPANLEN-OUT-OF-RANGE
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.378  SPAN-SW-EAST 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Span Switch Is Active East Side condition occurs when a span switch occurs at the east side of a 
four-fiber BLSR span using a Manual Switch, APS switch, or Force Span command. The condition 
clears when the switch is cleared. SPAN-SW-EAST is visible on the network view Alarms, Conditions, 
and History tabs. The port where the Force Span was applied shows an “F” on the network view detailed 
circuit map.

Note SPAN-SW-EAST is an informational condition and does not require troubleshooting.

2.7.379  SPAN-SW-WEST 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Span Switch Is Active West Side condition occurs when a span switch occurs at the west side of a 
four-fiber BLSR span using a Manual Switch, APS switch, or Force Span command. The condition 
clears when the switch is cleared. SPAN-SW-WEST is visible on the network view Alarms, Conditions, 
and History tabs. The port where the Force Span was applied shows an “F” on the network view detailed 
circuit map.
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Note SPAN-SW-WEST is an informational condition and does not require troubleshooting.

2.7.380  SQUELCH 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

The Ring Squelching Traffic condition occurs in a BLSR when a node that originates or terminates STS 
circuits fails or is isolated by multiple fiber cuts or maintenance Force Ring commands. The isolation or 
failure of the node disables circuits that originate or terminate on the failed node. SQUELCH conditions 
appear on one or both of the nodes on either side of the isolated or failed node. The “AIS-P” condition 
on page 2-38 also appears on all nodes in the ring except the isolated node. 

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the SQUELCH Condition

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Determine the isolated node:

a. From the View menu, choose Go to Network View.

b. The grayed out node with red spans is the isolated node.

Step 2 Verify fiber continuity to the ports on the isolated node. To verify cable continuity, follow site practices.

Step 3 If fiber continuity is good, verify that the proper ports are in service:

a. Confirm that the LED is correctly illuminated on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card 
view.

c. Click the Provisioning > Line tabs.
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d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose 
IS. Click Apply.

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised 
or remains, and the port service state transitions to OOS-AU,FLT.

Step 4 If the correct ports are in service, use an optical test set to verify that a valid signal exists on the line. 
For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close to 
the receiving card as possible.

Step 5 If the signal is valid, verify that the power level of the optical signal is within the optical card receiver 
specifications. Refer to the Cisco ONS 15454 Reference Manual for card specifications.

Step 6 If the receiver levels are good, ensure that the optical transmit and receive fibers are connected properly.

Step 7 If the connectors are good, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the OC-N card.

Step 8 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.381  SQUELCHED
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Client Signal Squelched condition is raised by a TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G, 
TXPP_MR_2.5G, MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, or MXPP_MR_2.5G card. 

The condition can be raised in the following situations:

 • An MXP or TXP client facility detects that an upstream receive facility has experienced a loss of 
signal (such as an Ethernet CARLOSS, DWDM SIGLOSS, or optical LOS). In response, the 
facility’s transmit is turned off (SQUELCHED). The upstream receive facilities are the trunk receive 
on the same card as the client, as well as the client receive on the card at the other end of the trunk 
span.

 • The client will squelch if the upstream trunk receive (on the same card) experiences the “SIGLOSS” 
alarm on page 2-227, the “CARLOSS (FC)” alarm on page 2-63, the “CARLOSS (GE)” alarm on 
page 2-66, the “CARLOSS (ISC)” alarm on page 2-66, the “LOS (2R)” alarm on page 2-158, the 
“LOS (ESCON)” alarm on page 2-164, the “LOS (ISC)” alarm on page 2-165, or the “LOS 
(TRUNK)” alarm on page 2-167. In some transparent modes, the client is squelched if the trunk 
detects the “AIS” alarm on page 2-37 or the “TIM” alarm on page 2-245.

 • The client will squelch if the upstream client receive (on the card at the other end of the DWDM 
span) experiences the “SIGLOSS” alarm on page 2-227, the “CARLOSS (FC)” alarm on page 2-63, 
the “CARLOSS (GE)” alarm on page 2-66, the “CARLOSS (ISC)” alarm on page 2-66, the “LOS 
(2R)” alarm on page 2-158, the “LOS (ESCON)” alarm on page 2-164, the “LOS (ISC)” alarm on 
page 2-165, or the “LOS (TRUNK)” alarm on page 2-167.
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In an example situation, an upstream MXP_2.5G_10G client port receive experiences a “loss of light,” 
and this port raises CARLOSS, SIGLOSS, or LOS (determined by the payload type) locally. The port 
also sends client signal fail to its downstream card. The downstream card raises a “GFP-CSF” alarm on 
page 2-117, turns off the client transmit laser, and raises the SQUELCHED condition.

The local client raises SQUELCHED if it also raises one of the following alarms for the client, all of 
which are signalled by the upstream node:

 • 2.7.151  GFP-CSF, page 2-117 

 • 2.7.154  GFP-LFD, page 2-119 

 • 2.7.155  GFP-NO-BUFFERS, page 2-120 

 • 2.7.152  GFP-DE-MISMATCH, page 2-118 

 • 2.7.153  GFP-EX-MISMATCH, page 2-119 

 • 2.7.288  ODUK-1-AIS-PM, page 2-190 

 • 2.7.289  ODUK-2-AIS-PM, page 2-190 

 • 2.7.290  ODUK-3-AIS-PM, page 2-190 

 • 2.7.291  ODUK-4-AIS-PM, page 2-190 

On the MXP_MR_10G, the local client raises a SQUELCHED condition if the upstream client detects 
one of the following alarms. Note that no corresponding local alarm is raised to indicate which of these 
conditions is present upstream.

 • LOS for the clients including the “LOS (2R)” alarm on page 2-158, the “LOS (ESCON)” alarm on 
page 2-164, and the “LOS (ISC)” alarm on page 2-165

 • CARLOSS for the clients including the “CARLOSS (FC)” alarm on page 2-63, the “CARLOSS 
(GE)” alarm on page 2-66, and the “CARLOSS (ISC)” alarm on page 2-66.

The local client raises a SQUELCHED condition if the local trunk raises one of the following alarms:

 • 2.7.307  OTUK-AIS, page 2-193 

 • 2.7.310  OTUK-LOF, page 2-193 

 • 2.7.228  LOS (TRUNK), page 2-167

 • 2.7.313  OTUK-TIM, page 2-193 (squelching enabled)

 • 2.7.292  ODUK-AIS-PM, page 2-190 

 • 2.7.294  ODUK-LCK-PM, page 2-190 

 • 2.7.298  ODUK-TIM-PM, page 2-191 (squelching enabled)

 • 2.7.413  TIM, page 2-245 (for the OC-N, squelching enabled)

 • 2.7.205  LOF (OCN), page 2-152

 • 2.7.226  LOS (OCN), page 2-165

 • 2.7.58  CARLOSS (TRUNK), page 2-67

 • 2.7.444  WVL-MISMATCH, page 2-260 (client or trunk)

When troubleshooting the SQUELCHED condition locally, look for failures progressing upstream in the 
following order. (If you are troubleshooting this alarm remotely, reverse the order of progress.)

 • Local client alarms, as above

 • Local trunk alarms, as above

 • Remote (upstream) client receive alarms, as above
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Note If you see a SQUELCHED condition on the trunk, this can only be caused by a transponder (TXP) card.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference 
Manual. 

Clear the SQUELCHED Condition

Step 1 If the object is reported against any object besides ESCON, determine whether the remote node and local 
node reports and LOF or the LOS alarm (for the client trunk, as listed above). If it does, turn to the 
relevant section in this chapter and complete the troubleshooting procedure.

Step 2 If no LOF or LOS is reported, determine whether any other listed remote node or local node conditions 
as listed above has occurred. If so, turn to the relevant section of this chapter and complete the 
troubleshooting procedure.

Step 3 If none of these alarms is reported, determine whether the local port reporting the SQUELCHED 
condition is in loopback. (You will see LPBKFACILITY or LPBKTERMINAL condition for this 
particular client type in the Condition window.) If it is in loopback, complete the following steps:

a. Double-click the client card to open the card view.

b. Click the Maintenance > Loopback > Port tabs.

c. If the port Admin State column says OOS,MT or OOS,DSBLD, click the cell to highlight it and 
choose IS from the drop-down list. Changing the state to IS also clears any loopback provisioned on 
the port.

Note If ports managed into IS admin state are not receiving signals, the LOS alarm is either raised 
or remains, and the port service state transitions to OOS-AU,FLT.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.382  SQM 
Default Severity: Critical (CR), Service-Affecting (SA) for STSTRM; Major (MJ), 
Service-Affecting (SA) for VT-TERM

SONET Logical Objects: STSTRM, VT-TERM

The Sequence Mismatch alarm is a virtual concatenated (VCAT) member alarm. (VCAT member circuits 
are independent circuits that are concatenated from different time slots into a higher-rate signal.) The 
alarm occurs when the expected sequence numbers of VCAT members do not match the received 
sequence numbers.
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Clear the SQM Alarm

Step 1 For the errored circuit, complete the “Delete a Circuit” procedure on page 2-276.

Step 2 Recreate the circuit using the “Create Circuits and VT Tunnels” chapter of the Cisco ONS 15454 
Procedure Guide.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.383  SSM-DUS 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, OCN

DWDM Logical Object: TRUNK

The Synchronization Status (SSM) Message Quality Changed to Do Not Use (DUS) condition occurs 
when the synchronization status message (SSM) quality level degrades to DUS or is manually changed 
to DUS. 

The signal is often manually changed to DUS to prevent timing loops from occurring. Sending a DUS 
prevents the timing from being reused in a loop. The DUS signal can also be sent for line maintenance 
testing.

Note SSM-DUS is an informational condition and does not require troubleshooting.

2.7.384  SSM-FAIL 
Single Failure Default Severity: Minor (MN), Non-Service-Affecting (NSA); Double Failure 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: BITS, DS1, E1, OCN

DWDM Logical Object: TRUNK

The SSM Failed alarm occurs when the synchronization status messaging received by the ONS 15454 
fails. The problem is external to the ONS 15454. This alarm indicates that although the ONS 15454 is 
set up to receive SSM, the timing source is not delivering valid SSM messages.

Clear the SSM-FAIL Alarm

Step 1 Verify that SSM is enabled on the external timing source.

Step 2 If timing is enabled, use an optical test set to determine that the external timing source is delivering SSM. 
For specific procedures to use the test set equipment, consult the manufacturer.
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Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.385  SSM-LNC 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

SONET Logical Objects: BITS, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Local Node Clock (LNC) Traceable condition occurs on MXP trunk ports when the SSM (S1) 
byte of the SONET overhead multiplexing section has been changed to signify that the line or BITS 
timing source is the LNC. 

Note SSM-LNC is an informational condition and does not require troubleshooting. 

2.7.386  SSM-OFF
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, OCN

DWDM Logical Object: TRUNK

The SSM Off condition applies to references used for timing the node. It occurs when the SSM for the 
reference has been turned off. The node is set up to receive SSM, but the timing source is not delivering 
SSM messages.

Clear the SSM-OFF Condition

Step 1 Complete the “Clear the SSM-FAIL Alarm” procedure on page 2-233.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.387  SSM-PRC
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

SONET Logical Objects: BITS, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Primary Reference Clock (PRC) Traceable condition occurs when the SONET transmission 
level for an MXP trunk port is PRC. 
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Note SSM-PRC is an informational condition and does not require troubleshooting. 

2.7.388  SSM-PRS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Primary Reference Source (PRS) Traceable condition occurs when the SSM transmission level 
is changed to Stratum 1 Traceable. 

Note SSM-PRS is an informational condition and does not require troubleshooting.

2.7.389  SSM-RES
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Reserved (RES) For Network Synchronization Use condition occurs when the synchronization 
message quality level is changed to RES.

Note SSM-RES is an informational condition and does not require troubleshooting.

2.7.390  SSM-SDH-TN 
The SSM-SDH-TN condition is not used in this platform in this release. It is reserved for development.

2.7.391  SSM-SETS 
The SSM-SETS condition is not used in this platform in this release. It is reserved for development.

2.7.392  SSM-SMC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM SONET Minimum Clock (SMC) Traceable condition occurs when the synchronization 
message quality level changes to SMC. The login node does not use the clock because the node cannot 
use any reference beneath its internal level, which is ST3.
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Note SSM-SMC is an informational condition and does not require troubleshooting.

2.7.393  SSM-ST2
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Stratum 2 (ST2) Traceable condition occurs when the synchronization message quality level 
is changed to ST2.

Note SSM-ST2 is an informational condition and does not require troubleshooting.

2.7.394  SSM-ST3 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Stratum 3 (ST3) Traceable condition occurs when the synchronization message quality level 
is changed to ST3. 

Note SSM-ST3 is an informational condition and does not require troubleshooting.

2.7.395  SSM-ST3E 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Stratum 3E (ST3E) Traceable condition indicates that the synchronization message quality 
level is changed to ST3E from a lower level of synchronization. SSM-ST3E is a Generation 2 SSM and 
is used for Generation 1.

Note SSM-ST3E is an informational condition and does not require troubleshooting.

2.7.396  SSM-ST4 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN

DWDM Logical Object: TRUNK
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The SSM Stratum 4 (ST4) Traceable condition occurs when the synchronization message quality level 
is lowered to ST4. The message quality is not used because it is below ST3.

Note SSM-ST4 is an informational condition and does not require troubleshooting.

2.7.397  SSM-STU 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Synchronization Traceability Unknown (STU) condition occurs when the reporting node is 
timed to a reference that does not support SSM, but the ONS 15454 has SSM support enabled. SSM-STU 
can also occur if the timing source is sending out SSM messages but SSM is not enabled on the 
ONS 15454.

Clear the SSM-STU Condition

Step 1 In node view, click the Provisioning > Timing > BITS Facilities tabs.

Step 2 Complete one of the following depending upon the status of the Sync Messaging Enabled check box:

 • If the Sync. Messaging Enabled check box for the BITS source is checked, uncheck the box.

 • If the Sync. Messaging Enabled check box for the BITS source is not checked, check the box.

Step 3 Click Apply.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.398  SSM-TNC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, NE-SREF, OCN

DWDM Logical Object: TRUNK

The SSM Transit Node Clock (TNC) Traceable condition occurs when the synchronization message 
quality level is changed to TNC.

Note SSM-TNC is an informational condition and does not require troubleshooting.

2.7.399  STS-SQUELCH-L
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: OCN
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The Ring is Squelching STS traffic condition is raised on an OC-N facility. If the node failure scenario 
includes the source or destination node, then switching the nodes will squelch all the STSs that originate 
from or destinate to the failure node. The condition resolves when the node is no longer failing. 

This condition has an NA severity by default. However, the condition indicates that traffic is squelched 
due to node failure, that is, traffic outage. Traffic outage can be caused by different problems, such as 
multiple LOS alarms, AIS-L, or node power outage. STS-SQUELCH-L is symptomatic and indicates 
that the user must investigate which node in a ring is being isolated and what is causing the node 
isolation.

Note STS-SQUELCH-L is an informational condition.

2.7.400  SW-MISMATCH
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: EQPT

The Software Mismatch condition occurs during software upgrade when there is a mismatch between 
software versions. The card connecting to the TCC2/TCC2P is running an older version than the 
TCC2/TCC2P is. 

Clear the SW-MISMATCH Condition

Step 1 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the errored card.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.401  SWMTXMOD-PROT
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

The Switching Matrix Module Failure on Protect Slot alarm is raised by the Slot 10 cross connect card 
if this card is active (ACT). Any kind of cross-connect card can raise this alarm. (Two exceptions are 
given in the following paragraph.) SWMTXMOD-PROT occurs when a logic component internal to the 
Slot 10 cross connect is out of frame (OOF) with a traffic card in the system. In this case, the alarm is 
raised against the traffic card slot.

The XC-VXC-10G card can raise this alarm (in Slot 10) whether it is ACT or standby (SBY). The XCVT 
card can raise SWMTXMOD-PROT against itself if the cross-connect card is OOF with a second logic 
component on the same cross connect card.

Clear the SWMTXMOD-PROT Alarm

Step 1 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the Slot 10 card. For the LED 
behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.
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Step 2 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 3 If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on 
page 2-274 for the Slot 10 cross-connect card. 

Step 4 Complete the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-272.

Note After the active cross-connect card goes into standby mode, the original standby slot becomes 
active. The former standby card ACT/SBY LED becomes green.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.402  SWMTXMOD-WORK
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Object: EQPT

The Switching Matrix Module Failure on Working Slot alarm is raised by the Slot 8 cross connect card 
if this card is active (ACT). Any kind of cross-connect card can raise this alarm. (Two exceptions are 
given in the following paragraph.) SWMTXMOD-WORK occurs when a logic component internal to the 
Slot 8 cross connect is OOF with a traffic card in the system. In this case, the alarm is raised against the 
traffic card slot.

The XC-VXC-10G card can raise this alarm (in Slot 8) whether it is ACT or standby (SBY). The XCVT 
card can raise SWMTXMOD-WORK against itself if the cross-connect card is OOF with a second logic 
component on the same cross connect card.

Clear the SWMTXMOD-WORK Alarm

Step 1 Complete the “Reset a Traffic Card in CTC” procedure on page 2-271 for the Slot 8 card. For LED 
behavior, see the “2.8.2  Typical Traffic Card LED Activity During Reset” section on page 2-261.

Step 2 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 3 If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on 
page 2-274 for the Slot 8 cross-connect card. 

Step 4 Complete the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-272.

Note After the active cross-connect card goes into standby mode, the original standby slot becomes 
active. The former standby card ACT/SBY LED becomes green.
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Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.403  SWTOPRI 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Primary Reference condition occurs when the ONS 15454 switches to 
the primary timing source (reference 1). The ONS 15454 uses three ranked timing references. The timing 
references are typically two BITS-level or line-level sources and an internal reference. 

Note SWTOPRI is an informational condition and does not require troubleshooting.

2.7.404  SWTOSEC 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Secondary Reference condition occurs when the ONS 15454 has 
switched to a secondary timing source (reference 2).

Clear the SWTOSEC Condition

Step 1 To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI” 
alarm on page 2-242.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.405  SWTOTHIRD 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Third Reference condition occurs when the ONS 15454 has switched to 
a third timing source (reference 3). 

Clear the SWTOTHIRD Condition

Step 1 To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI” 
alarm on page 2-242 or the “SYNCSEC” alarm on page 2-243.
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Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.406  SYNC-FREQ 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BITS, DS1, E1, OCN

DWDM Logical Object: TRUNK

The Synchronization Reference Frequency Out of Bounds condition is reported against any reference 
that is out of the bounds for valid references. The login node fails the reference and chooses another 
internal or external reference to use.

Clear the SYNC-FREQ Condition

Step 1 Use an optical test set to verify the timing frequency of the line or BITS timing source and ensure that 
it falls within the proper frequency. For specific procedures to use the test set equipment, consult the 
manufacturer. 

For BITS, the proper timing frequency range is approximately –15 PPM to 15 PPM. For optical line 
timing, the proper frequency range is approximately –16 PPM to 16 PPM. 

Step 2 If the reference source frequency is not outside of bounds, complete the “Physically Replace a Traffic 
Card” procedure on page 2-274 for the TCC2/TCC2P.

Note It takes up to 30 minutes for the TCC2/TCC2P to transfer the system software to the newly 
installed TCC2/TCC2P. Software transfer occurs in instances where different software versions 
exist on the two cards. When the transfer completes, the active TCC2/TCC2P reboots and goes 
into standby mode after approximately three minutes.

Step 3 If the SYNC-FREQ condition continues to report after replacing the TCC2/TCC2P, log into the 
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC 
1 800 553-2447.

2.7.407  SYNCLOSS 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: FCMR

DWDM Logical Objects: FC, GE, ISC, TRUNK

The Loss of Synchronization on Data Interface alarm is raised on FC_MR-4 client ports and MXP cards 
client or trunk ports when there is a loss of signal synchronization on the port. This alarm is demoted by 
the SIGLOSS alarm.
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Clear the SYNCLOSS Alarm

Step 1 Ensure that the data port connection at the near-end card’s port of the SONET link is operational. 

Step 2 Verify fiber continuity to the port. To do this follow site practices.

Step 3 View the physical port LED to determine whether the alarm has cleared: 

 • If the LED is green, the alarm has cleared. 

 • If the port LED is clear (that is, not illuminated green), the link is not connected and the alarm has 
not cleared.

 • If the LED is red, this indicates that the fiber is pulled.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.408  SYNCPRI 
Default Severity: Minor (MN), Non-Service-Affecting (NSA) for EXT-SREF;Major (MJ), 
Service-Affecting (SA) for NE-SREF

SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Primary Reference alarm occurs when the ONS 15454 loses the primary timing 
source (reference 1). The ONS 15454 uses three ranked timing references. The timing references are 
typically two BITS-level or line-level sources and an internal reference. If SYNCPRI occurs, the 
ONS 15454 should switch to its secondary timing source (reference 2). Switching to the secondary 
timing source also triggers the “SWTOSEC” alarm on page 2-240.

Note The SYNCPRI alarm will be escalated to Major (MJ), Service-Affecting if no other valid 
references (SYNCSEC, SYNCTHIRD) are available. If any other reference are available 
then SYNCPRI gets raised as Minor (MN), non service affecting.

Clear the SYNCPRI Alarm

Step 1 In node view, click the Provisioning > Timing > General tabs.

Step 2 Verify the current configuration for REF-1 of the NE Reference.

Step 3 If the primary timing reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure 
on page 2-158.

Step 4 If the primary reference clock is an incoming port on the ONS 15454, complete the “Clear the LOS 
(OCN) Alarm” procedure on page 2-166.

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.
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2.7.409  SYNCSEC 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Secondary Reference alarm occurs when the ONS 15454 loses the secondary 
timing source (reference 2). If SYNCSEC occurs, the ONS 15454 should switch to a third timing source 
(reference 3) to obtain valid timing for the ONS 15454. Switching to a third timing source also triggers 
the “SWTOTHIRD” alarm on page 2-240.

Note The severity of SYNCSEC alarm is dependent on the alarm profile it is associated with. If 
the alarm profile it is associated with is Major (MJ), then this  condition is raised as MJ, 
service affecting, even if alternate source of references are available.

Clear the SYNCSEC Alarm

Step 1 In node view, click the Provisioning > Timing > General tabs.

Step 2 Verify the current configuration of REF-2 for the NE Reference. 

Step 3 If the secondary reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on 
page 2-158.

Step 4 Verify that the BITS clock is operating properly.

Step 5 If the secondary timing source is an incoming port on the ONS 15454, complete the “Clear the LOS 
(OCN) Alarm” procedure on page 2-166.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.410  SYNCTHIRD 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Third Reference alarm occurs when the ONS 15454 loses the third timing source 
(reference 3). If SYNCTHIRD occurs and the ONS 15454 uses an internal reference for source three, 
the TCC2/TCC2P could have failed. The ONS 15454 often reports either the “FRNGSYNC” condition 
on page 2-115 or the “HLDOVRSYNC” condition on page 2-127 after a SYNCTHIRD alarm.

Note The severity of  SYNCTHIRD alarm is dependent on the alarm profile it is assosicated with. 
If the alarm profile it is associated with is Major (MJ), then this condition is raised as MJ, 
service affecting, even if alternate source of references are available.

Clear the SYNCTHIRD Alarm

Step 1 In node view, click the Provisioning > Timing > General tabs.
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Step 2 Verify that the current configuration of REF-3 for the NE Reference. For more information about 
references, refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual.

Step 3 If the third timing source is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on 
page 2-158.

Step 4 If the third timing source is an incoming port on the ONS 15454, complete the “Clear the LOS (OCN) 
Alarm” procedure on page 2-166. 

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 5 If the third timing source uses the internal ONS 15454 timing, complete the “Reset an Active 
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-271.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 6 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC 
1 800 553-2447. If the Cisco TAC technician tells you to reseat the card, complete the “Remove and 
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-273. If the Cisco TAC 
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic 
Card” procedure on page 2-274.

2.7.411  SYSBOOT 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: NE

The System Reboot alarm indicates that new software is booting on the TCC2/TCC2P. No action is 
required. The alarm clears when all cards finish rebooting the new software. The reboot takes up to 
30 minutes.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

Note SYSBOOT is an informational alarm. It only requires troubleshooting if it does not clear.

2.7.412  TEMP-MISM
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: NE

Temperature Reading Mismatch Between Control Cards is raised when the temperature readings on the 
two TCC2/TCC2Ps are out of range of each other by more than some predefined difference (such as 5 
degrees C). A message containing power monitoring and temperature information is exchanged between 
the two TCC2/TCC2Ps, allowing the values to be compared. The temperature of each TCC2/TCC2P is 
read from a system variable.

This condition can be caused by a clogged fan filter or by fan tray stoppage.
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Clear the TEMP-MISM Condition

Step 1 Complete the “Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-279.

Step 2 If the condition does not clear, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on 
page 2-281.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.413  TIM 
Default Severity: Critical (CR), Service-Affecting (SA) 

SONET Logical Object: OCN

DWDM Logical Object: TRUNK

The Section TIM alarm occurs when the expected J0 section trace string does not match the received 
section trace string. This occurs because the data being received is not correct, and the receiving port 
could not be connected to the correct transmitter port.

If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed due to 
a fibering misconnection, a TL1 routing change, or to someone entering an incorrect value in the Current 
Transmit String field. 

TIM occurs on a port that has previously been operating without alarms if someone switches optical 
fibers that connect the ports. TIM is usually accompanied by other alarms, such as the “LOS (OCN)” 
alarm on page 2-165 or the “UNEQ-P” alarm on page 2-253. If these alarms accompany a TIM alarm, 
reattach or replace the original cables/fibers to clear the alarms. If a Transmit or Expected String was 
changed, restore the original string.

Clear the TIM Alarm

Step 1 Ensure that the physical fibers are correctly configured and attached. To do this, consult site documents. 
For more information about cabling the ONS 15454, refer to the “Install Cards and Fiber-Optic Cable” 
chapter in the Cisco ONS 15454 Procedure Guide. 

Step 2 If the alarm does not clear, you can compare the J0 expected and transmitted strings and, if necessary, 
change them:

a. Log into the circuit source node and click the Circuits tab.

b. Select the circuit reporting the condition, then click Edit.

c. In the Edit Circuit window, check the Show Detailed Circuit Map check box and click Apply.

d. On the detailed circuit map, right-click the source circuit port and choose Edit J0 Path Trace (port) 
from the shortcut menu.

e. Compare the Current Transmit String and the Current Expected String entries in the Edit J0 Path 
Trace dialog box.

f. If the strings differ, correct the Transmit or Expected strings and click Apply.

g. Click Close.
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Step 3 If the alarm does not clear, ensure that the signal has not been incorrectly routed. (Although the 
ONS 15454 routes circuits automatically, the circuit route could have been changed using TL1.) If 
necessary, manually correct the routing using TL1. For instructions, refer to the Cisco ONS SONET TL1 
Reference Guide and the Cisco ONS SONET TL1 Command Guide .

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem if necessary.

2.7.414  TIM-MON
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SONET Logical Object: OCN

DWDM Logical Object: TRUNK

The TIM Section Monitor TIM alarm is similar to the “TIM-P” alarm on page 2-246, but it applies to 
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, and MXP_2.5G_10G cards when 
they are configured in transparent mode. (In transparent termination mode, all SONET overhead bytes 
are passed through from client ports to the trunk ports or from trunk ports to client ports.)

Note For more information about MXP and TXP cards, refer to the Cisco ONS 15454 DWDM Reference 
Manual. 

Clear the TIM-MON Alarm

Step 1 Complete the “Clear the TIM-P Alarm” procedure on page 2-247.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.415  TIM-P 
Default Severity: Critical (CR), Service-Affecting (SA) for STSTRM; Default Severity: 
Minor (MN), Non-Service-Affecting (NSA) for STSMON

SONET Logical Objects: STSMON, STSTRM

The TIM Path alarm occurs when the expected path trace string does not match the received path trace 
string. Path Trace Mode must be set to Manual or Auto for the TIM-P alarm to occur.

In manual mode at the Path Trace window, the user types the expected string into the Current Expected 
String field for the receiving port. The string must match the string typed into the Transmit String field 
for the sending port. If these fields do not match, the login node raises the TIM-P alarm. In Auto mode 
on the receiving port, the card sets the expected string to the value of the received string. If the alarm 
occurs on a port that has been operating with no alarms, the circuit path has changed or someone entered 
a new incorrect value into the Current Transmit String field. Complete the following procedure to clear 
either instance.
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Clear the TIM-P Alarm

Step 1 Complete the “Clear the TIM Alarm” procedure on page 2-245. (The option will say “Edit J1 Path Trace” 
rather than “Edit J0 Path Trace.”)

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447. If the alarm applies to the STSTRM object, it 
is Service-Affecting (SA).

2.7.416  TIM-S
Default Severity: Critical (CR), Service-Affecting (SA) 

SONET Logical Objects: EC1, OCN

The TIM for Section Overhead alarm occurs when there is a mismatch between the expected and 
received J0 section overhead strings in either Manual or Auto mode.

In manual mode at the DS3/EC1-48 card Section Trace window, the user enters the expected string into 
the Current Expected String field for the receiving port. The string must match the string typed into the 
Transmit String field for the sending port. If these fields do not match, the login node raises the TIM-S 
alarm. 

In Auto mode on the receiving port, the card sets the expected string to the value of the received string. 
If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed or 
someone entered a new incorrect value into the Current Transmit String field. Complete the following 
procedure to clear either problem.

TIM-S also occurs on a port that has previously been operating without alarms if someone switches the 
cables or optical fibers that connect the ports. If TIM-S is enabled on the port, the “AIS-L” alarm on 
page 2-37 can be raised downstream and the “RFI-L” alarm on page 2-205 can be raised upstream. 

Note AIS-L and RFI-L are disabled or enabled in the Provisioning > EC1 > Section Trace tab Disable 
AIS/RDI on TIM-S? check box.

Clear the TIM-S Alarm

Step 1 Double-click the DS3/EC1-48 card to open the card view.

Step 2 Click the Provisioning > EC1 > Section Trace tabs.

Step 3 Choose the port from the Port pull-down.

Step 4 In the Expected area, enter the correct string into the Current Expected String field.

Step 5 Click Apply.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447. If the alarm applies to the STSTRM object, it 
is Service-Affecting (SA).
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2.7.417  TIM-V
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: VT-TERM, VT-MON

The VT Path TIM alarm is raised on VT terminations when the J2 path trace is enabled and is 
mismatched with the expected trace string. 

Clear the TIM-V Alarm

Step 1 Complete the “Clear the TIM Alarm” procedure on page 2-245.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.418  TPTFAIL (CEMR, CE100T, CE1000)
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: CEMR, CE100T, CE1000

The Transport (TPT) Layer Failure alarm for the CE-Series card indicates a break in the end-to-end 
Ethernet link integrity feature of the card. TPTFAIL indicates a far-end condition and not a problem with 
the port reporting TPTFAIL.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the TPTFAIL (CEMR, CE100T, CE1000) Alarm

Step 1 Complete the “Clear the TPTFAIL (G1000) Alarm” procedure on page 2-249. 

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 to report a Service-Affecting (SA) problem.

2.7.419  TPTFAIL (FCMR) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: FCMR

The Transport Fail alarm is raised against a local Fibre Channel (FC) port on an FC_MR-4 card when 
the port receives another SONET error such as the “AIS-P” alarm on page 2-38, the “LOP-P” alarm on 
page 2-155; “UNEQ-P” alarm on page 2-253, the “PLM-P” alarm on page 2-196, the “TIM-P” alarm on 
page 2-246, the “LOM” alarm on page 2-155 (for VCAT only), or the “SQM” alarm on page 2-232 (for 
VCAT only). 
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This TPTFAIL can be raised against Fibre Channel cards if the remote FC card port is down from 
SIGLOSS or SYNCLOSS. In that case, the remote FC card port sends a PDI-P error code in the SONET 
C2 byte and signals the local FC port transmitter to turn off (thus causing the local FC port to raise the 
TPTFAIL alarm). A TPTFAIL can also be raised when a far-end receive fiber is pulled. This alarm can 
be demoted when a facility loopback is placed on the FC_MR-4 port.

Clear the TPTFAIL (FCMR) Alarm

Step 1 Find and clear any path alarms applying to the port. Refer to the correct section of this chapter for trouble 
clearing instructions. Clearing the path alarm also clears the TPTFAIL.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.420  TPTFAIL (G1000) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Object: G1000

The Transport Layer Failure alarm for the G-Series Ethernet card indicates a break in the end-to-end 
Ethernet link integrity feature of the ONS 15454 G1000-4 cards. TPTFAIL indicates a far-end condition 
and not a problem with the port reporting TPTFAIL.

The TPTFAIL alarm indicates a problem on either the SONET path or the remote Ethernet port that 
prevents the complete end-to-end Ethernet path from working. If any SONET path alarms such as the 
“AIS-P” alarm on page 2-38, the “LOP-P” alarm on page 2-155, the “PDI-P” alarm on page 2-194, or 
the “UNEQ-P” alarm on page 2-253 exist on the SONET path used by the Ethernet port, the affected port 
causes a TPTFAIL alarm. Also, if the far-end G1000-4 port Ethernet port is administratively disabled or 
it is reporting the “CARLOSS (G1000)” alarm on page 2-63, the C2 byte in the SONET path overhead 
indicates the “PDI-P” alarm on page 2-194, which in turn causes a TPTFAIL to be reported against the 
near-end port.

When a TPTFAIL alarm occurs, the near-end port is automatically disabled (transmit laser turned off). 
In turn, the laser shutoff can also cause the external Ethernet device attached at the near end to detect a 
link down and turn off its transmitter. This also causes a CARLOSS alarm to occur on the reporting port. 
In all cases, the source problem is either in the SONET path being used by the G1000-4 port or the far- 
end G1000-4 port to which it is mapped.

An occurrence of TPTFAIL on an ONS 15454 G1000-4 port indicates either a problem with the SONET 
path that the port is using or with the far-end G1000-4 port that is mapped to the port. 

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the TPTFAIL (G1000) Alarm

Step 1 Clear any alarms being reported by the OC-N card on the G1000-4 circuit.
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Step 2 If no alarms are reported by the OC-N card, or if the “PDI-P” condition on page 2-194 is reported, the 
problem could be on the far-end G1000-4 port. Clear any alarms, such as CARLOSS, reported against 
the far-end port or card.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.421  TPTFAIL (ML100T, ML1000, MLFX) 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: ML100T, ML1000, MLFX

The TPT Layer Failure alarm for the ML-Series Ethernet card indicates a break in the end-to-end 
packet-over-SONET (POS) link integrity feature of the ML-Series POS cards. TPTFAIL indicates a 
far-end condition or misconfiguration of the POS port.

The TPTFAIL alarm indicates a problem on the SONET path, a problem on the remote POS port, or a 
misconfiguration of the POS port that prevents the complete end-to-end POS path from working. If any 
SONET path alarms such as the “AIS-P” condition on page 2-38, the “LOP-P” alarm on page 2-155, the 
“PDI-P” condition on page 2-194, or the “UNEQ-P” alarm on page 2-253 exist on the circuit used by the 
POS port, the affected port could report a TPTFAIL alarm. If the far-end ML POS port is 
administratively disabled, it inserts an “AIS-P” condition on page 2-38 that is detected by the near-end 
port. The near-end port could report TPTFAIL in this event. If the POS port is misconfigured at the 
Cisco IOS CLI level, the misconfiguration causes the port to go down and report TPTFAIL.

Note For more information about the ML-Series Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the TPTFAIL (ML100T, ML1000, MLFX) Alarm

Step 1 If there are no SONET alarms reported against the POS port circuit, verify that both POS ports are 
properly configured. Refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software 
Feature and Configuration Guide for configuration information.

Step 2 If the “PLM-P” alarm on page 2-196 is the only one reported against the POS port circuit, verify that 
both POS ports are properly configured. Refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide for configuration 
information.

Step 3 If the “PDI-P” condition on page 2-194 is the only one reported against the POS port circuit and the 
circuit is terminated by a G-Series card, determine whether a “CARLOSS (G1000)” alarm on page 2-63 
is reported against the G-Series card, and if so, complete the “Clear the CARLOSS (G1000) Alarm” 
procedure on page 2-64.

Step 4 If the “AIS-P” alarm on page 2-38, the “LOP-P” alarm on page 2-155, or the “UNEQ-P” alarm on 
page 2-253 is present, clear those alarms using the procedures in those sections.
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Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.422  TRMT 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: DS1, E1

A Missing Transmitter alarm occurs when there is a transmit failure on the ONS 15454 DS-1 card 
because of an internal hardware failure. The card must be replaced.

Clear the TRMT Alarm

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-274 for the reporting DS-1 card.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.423  TRMT-MISS 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: DS1, E1

A Facility Termination Equipment Transmitter Missing alarm occurs when the facility termination 
equipment detects an incorrect amount of impedance on its backplane connector. Incorrect impedance is 
detected when a transmit cable is missing on the DS-1 port or the backplane does not match the inserted 
card. For example, an SMB connector or a BNC connector could be connected to a DS-1 card instead of 
a DS-3 card. 

Note DS-1s are four-wire circuits and need a positive and negative connection for both transmit and receive.

Clear the TRMT-MISS Alarm

Step 1 Verify that the device attached to the DS-1 port is operational.

Step 2 If the device is operational, verify that the cabling is securely connected.

Step 3 If the cabling is secure, verify that the pinouts are correct.

Step 4 If the pinouts are correct, replace the transmit cable.
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Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.424  TX-AIS 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: DS1, DS3, E1

The (TX) Transmit Direction AIS condition is raised by the ONS 15454 backplane when it receives a 
far-end DS-1 LOS.

Clear the TX-AIS Condition

Step 1 Determine whether there are alarms on the downstream nodes and equipment, especially the “LOS 
(OCN)” alarm on page 2-165, or OOS ports.

Step 2 Clear the downstream alarms using the applicable procedures in this chapter.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.425  TX-LOF 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: DS1, E1

The Transmit Direction LOF condition is transmitted by the backplane when it receives a DS-1 TX-LOF.

This alarm is raised only at the transmit (egress) side.

Clear the TX-LOF Condition

Step 1 Complete the “Clear the LOF (DS1) Alarm” procedure on page 2-149.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.426  TX-RAI 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: DS1, DS3, E1
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The Transmit Direction RAI condition is transmitted by the backplane when it receives a DS-1 TX-AIS. 
This alarm is raised only at the transmit side, but RAI is raised at both ends.

Note The DS1-56 card operating in retiming mode reports a Transmit Condition remote alarm indication 
(TX-RAI) alarm in the alarm log. However, the physical signal that is transmitted out does not have TX- 
RAI in the frame. Hence, TX-RAI is not transmitted in the DS1 signal. This causes the client equipment 
not to detect TX-RAI in the incoming signal.

Clear the TX-RAI Condition

Step 1 Complete the “Clear the TX-AIS Condition” procedure on page 2-252.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.427  UNC-WORD 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.428  UNEQ-P 
Default Severity: Critical (CR), Service-Affecting (SA)

SONET Logical Objects: STSMON, STSTRM

An SLMF UNEQ Path alarm occurs when the path does not have a valid sender. The UNEQ-P indicator 
is carried in the C2 signal path byte in the SONET overhead. The source of the problem is the node that 
is transmitting the signal into the node reporting the UNEQ-P.

The alarm could result from a PARTIAL circuit or an empty VT tunnel. UNEQ-P occurs in the node that 
terminates a path. 

Note If a newly created circuit has no signal, a UNEQ-P alarm is reported on the OC-N cards and the “AIS-P” 
condition on page 2-38 is reported on the terminating cards. These alarms clear when the circuit carries 
a signal.

Caution Deleting a circuit affects traffic.

Clear the UNEQ-P Alarm

Step 1 In node view, choose Go to Network View from the View menu. 

Step 2 Right-click the alarm to display the Select Affected Circuits shortcut menu.

Step 3 Click Select Affected Circuits.
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Step 4 When the affected circuits appear, look in the Type column for VTT, which indicates a VT tunnel circuit. 
A VT tunnel with no VTs assigned could be the cause of an UNEQ-P alarm.

Step 5 If the Type column does not contain VTT, there are no VT tunnels connected with the alarm. Go to 
Step 7.

Step 6 If the Type column does contain VTT, attempt to delete these rows:

Note The node does not allow you to delete a valid VT tunnel or one with a valid VT circuit inside.

a. Click the VT tunnel circuit row to highlight it. Complete the “Delete a Circuit” procedure on 
page 2-276.

b. If an error message dialog box appears, the VT tunnel is valid and not the cause of the alarm.

c. If any other rows contain VTT, repeat Step 6.

Step 7 If all nodes in the ring appear in the CTC network view, determine whether the circuits are complete:

a. Click the Circuits tab.

b. Verify that PARTIAL is not listed in the Status column of any circuits.

Step 8 If you find circuits listed as PARTIAL, use an optical test set to verify that these circuits are not working 
circuits that continue to pass traffic. For specific procedures to use the test set equipment, consult the 
manufacturer.

Step 9 If the PARTIAL circuits are not needed or are not passing traffic, delete the PARTIAL circuits.

Complete the “Delete a Circuit” procedure on page 2-276.

Step 10 Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter 
in the Cisco ONS 15454 Procedure Guide.

Step 11 Log back in and verify that all circuits terminating in the reporting card are active:

a. Click the Circuits tab.

b. Verify that the Status column lists all circuits as active.

Step 12 If the alarm does not clear, clean the far-end optical fiber according to site practice. If no site practice 
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure 
Guide.

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057
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Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 13 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-274 
for the OC-N and electrical cards.

Step 14 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.429  UNEQ-V 
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: VT-MON, VT-TERM

An SLMF UNEQ VT alarm indicates that the node is receiving SONET path overhead with Bits 5, 6, 
and 7 of the V5 overhead byte all set to zeroes. The source of the problem is not the node raising the 
alarm, but the node transmitting the VT signal to it. The V in UNEQ-V indicates that the failure has 
occurred at the VT layer.

Warning On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position 
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the 
safety key is off (labeled 0). Statement 293.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the UNEQ-V Alarm

Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-253.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
2-255
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.7.430    UNQUAL-PPM
Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447 in order to report a Service-Affecting (SA) 
problem.

2.7.430  UNQUAL-PPM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SONET Logical Objects: PPM

The Unqualified PPM Inserted condition occurs when a PPM with a nonqualified product ID is plugged 
into the card’s port; that is, the PPM passes the security code check as a Cisco PPM but is not qualified 
for use on the particular card.

Clear the UNQUAL-PPM Condition

Step 1 Obtain the correct Cisco PPM and replace the existing PPM with the new one.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.431  UT-COMM-FAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.432  UT-FAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.433  VCG-DEG 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: VCG

The VCAT Group Degraded alarm is a VCAT group alarm. (VCATs are groups of independent circuits 
that are concatenated from different time slots into higher-rate signals.) The alarm occurs when one 
member circuit carried by the ML-Series Ethernet card is down. This alarm is accompanied by the 
“OOU-TPT” alarm on page 2-191. It only occurs when a Critical (CR) alarm, such as LOS, causes a 
signal loss. 

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.
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Clear the VCG-DEG Condition

Step 1 Look for and clear any Critical (CR) alarms that apply to the errored card, such as the “LOS (2R)” alarm 
on page 2-158 or “LOS (OTS)” alarm on page 2-167.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.434  VCG-DOWN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Object: VCG

The VCAT Group Down alarm is a VCAT group alarm. (VCATs are groups of independent circuits that 
are concatenated from different time slots into higher-rate signals.) The alarm occurs when one or more 
member circuits carried by an ML-Series or CE-Series Ethernet card are down. This alarm occurs in 
conjunction with another Critical (CR) alarm, such as the “LOS (2R)” alarm on page 2-158.

Note If LCAS (Link Capacity Adjustment Scheme) is not enabled, the VCAT group transitions to the down 
state with even a single member down.  If SW-LCAS is enabled on the VCAT group for ML1 cards, or 
HW LCAS is enabled for CE cards, the VCAT group transitions to the VCG-DOWN state only when all 
the members are down. The presence of at least one working member causes the VCAT group to remain 
in VCG-DEG (VCG degraded) state.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Clear the VCG-DOWN Condition

Step 1 Complete the “Clear the VCG-DEG Condition” procedure on page 2-257.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.435  VOA-HDEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.7.436  VOA-HFAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.437  VOA-LDEG 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.438  VOA-LFAIL 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.7.439  VOLT-MISM
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

SONET Logical Object: PWR

The Power Monitoring Mismatch Between Control Cards alarm is raised against the shelf when the 
power voltages of both TCC2/TCC2Ps are out of range of each other by more than 5 VDC. 

Clear the VOLT-MISM Condition

Step 1 Check the incoming voltage level to the shelf using a voltmeter. Follow site practices or refer to the 
“Install the Shelf and Backplane Cable” chapter in the Cisco ONS 15454 Procedure Guide for power 
installation procedures.

Step 2 Correct any incoming voltage issues.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447.

2.7.440  VT-SQUELCH-L
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

SONET Logical Object: OCN

The Ring is Squelching VT Traffic condition is raised on an OC-N facility. If the node failure scenario 
includes the source node, the node dropping VT will squelch VT traffic. The condition resolves when 
the node failure is recovered.
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This condition is raised as NA severity by default. However, it indicates that traffic is squelched due to 
node failure, that is, traffic outage. Traffic outage can be caused by different problems, such as multiple 
instances of the “LOS (OCN)” alarm on page 2-165, the “AIS-L” condition on page 2-37, or node power 
outage. VT-SQUELCH-L is symptomatic and indicates that the user must investigate which node in a 
ring is being isolated and what causes node isolation.

Note VT-SQUELCH-L is an informational condition.

2.7.441  WKSWPR 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EQPT, OCN, STSMON, VT-MON

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC

The Working Switched To Protection condition occurs when a line experiences the “LOS (OCN)” alarm 
on page 2-165, the “SD (DS1, DS3)” condition on page 2-218, or the “SD (TRUNK)” condition on 
page 2-221. 

This condition is also raised when you use the Manual Switch, APS Switch, FORCE SPAN, FORCE 
RING or MANUAL SPAN command at the network level. WKSWPR is visible on the network view 
Alarms, Conditions, and History tabs.

Clear the WKSWPR Condition

Step 1 Complete the “Clear the LOS (OCN) Alarm” procedure on page 2-166.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.442  WORK-QUEUE-FULL
Default Severity: Not Alarmed (NA) 

Logical Object: EQPT 

The Work Queue Full condition occurs when the netTask Queue in VxWorks has filled up and task 
operations for the card is postponed.

2.7.443  WTR 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: EC1, EQPT, ML1000, ML100T, MLFX, OCN, STSMON, VT-MON

DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Wait To Restore condition for SONET and DWDM objects occurs when the “WKSWPR” condition 
on page 2-259 is raised, but the wait-to-restore time has not expired, meaning that the active protect path 
cannot revert to the working path. The condition clears when the timer expires and traffic switches back 
to the working path.
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If the condition is raised on an IEEE 802.17b-based RPR span, it indicates that the wait-to-restore timer 
is active after a span failure has cleared.

Caution DS-1 traffic loss can occur on a DS-1 with 1:N protection if a DS-1 card is reset with the protect card in 
the WTR state.

Note Generally, WTR is an informational condition and does not require troubleshooting.

Clear the WTR Condition on an IEEE 802.17b-Based RPR Span

Step 1 Determine the setting for the IEEE 802.17b-based RPR interface’s WTR timer setting. In privileged 
executive mode, enter the following command:

router#show interface rpr protection

View the WTR timer setting.

Step 2 If the timer is set to “never,” clear the WTR condition by requesting a forced switch on the span. Enter 
the following command at the RPR-IEEE interface configuration mode command prompt:

router(config-if)#rpr-ieee protection request force-switch {east | west}

Step 3 If you configured a FORCE on the span, clear the switch with the following command:

router(config-if)#no rpr-ieee protection request force-switch {east | west}

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC 1 800 553-2447.

2.7.444  WVL-MISMATCH 
For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the 
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8  Traffic Card LED Activity
ONS 15454 traffic card LED behavior patterns are listed in the following sections. These sections give 
behavior for card insertion, reset, and side-switch.

2.8.1  Typical Traffic Card LED Activity After Insertion
When a card is inserted, the following LED activities occur:

1. The red FAIL LED turns on and remains illuminated for 20 to 30 seconds. 

2. The red FAIL LED blinks for 35 to 45 seconds.

3. All LEDs blink once and turn off for 5 to 10 seconds.
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4. The ACT or ACT/SBY LED turns on. The SF LED can persist until all card ports connect to their 
far-end counterparts and a signal is present. 

2.8.2  Typical Traffic Card LED Activity During Reset
While a card resets, the following LED activities occur:

1. The FAIL LED on the physical card blinks and turns off.

2. The white LED with the letters “LDG” appears on the reset card in CTC.

3. The green ACT LED appears in CTC.

2.8.3  Typical Card LED State After Successful Reset
When a card successfully resets, the following LED states are present:

 • If you are looking at the physical ONS 15454, the ACT/SBY LED is illuminated.

 • If you are looking at node view of the ONS 15454, the current standby card has an amber LED 
depiction with the initials “SBY,” and this has replaced the white “LDG” depiction on the card in 
CTC.

 • If you are looking at node view of the ONS 15454, the current active card has a green LED depiction 
with the initials “ACT,” and this has replaced the white “LDG” depiction on the card in CTC. 

2.8.4  Typical Cross-Connect LED Activity During Side Switch 
When a XC10G card is switched in CTC from active (ACT) to standby (SBY) or from SBY to ACT, the 
following LED activities occur:

1. The FAIL LED on the physical card blinks and turns off.

2. The standby card yellow SBY LED becomes a green ACT LED, indicating it is now active.

3. The active card green ACT LED becomes a yellow SBY LED, indicating it is now standby.

2.9  Frequently Used Alarm Troubleshooting Procedures
This section gives common procedures that are frequently used when troubleshooting alarms. Most of 
these procedures are summarized versions of fuller procedures existing elsewhere in the ONS 15454 
documentation. They are included in this chapter for the user’s convenience. For further information, 
please refer to the Cisco ONS 15454 Procedure Guide.

2.9.1  Node and Ring Identification, Change, Visibility, and Termination
The following procedures relate how to identify or change BLSR names and node IDs, and how to verify 
visibility from other nodes.
2-261
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.9.1    Node and Ring Identification, Change, Visibility, and Termination
Identify a BLSR Ring Name or Node ID Number

Step 1 Log into a node on the network. 

Step 2 In node view, choose Go to Network View from the View menu.

Step 3 Click the Provisioning > BLSR tabs.

Step 4 From the Ring Name column, record the ring name, or in the Nodes column, record the Node IDs in the 
BLSR. The Node IDs are the numbers in parentheses next to the node name.

Change a BLSR Ring Name

Step 1 Log into a node on the network. 

Step 2 In node view, choose Go to Network View from the View menu.

Step 3 Click the Provisioning > BLSR tabs.

Step 4 Highlight the ring and click Edit.

Step 5 In the BLSR window, enter the new name in the Ring Name field.

Step 6 Click Apply.

Step 7 Click Yes in the Changing Ring Name dialog box.

Change a BLSR Node ID Number

Step 1 Log into a node on the network. 

Step 2 In node view, choose Go to Network View from the View menu.

Step 3 Click the Provisioning > BLSR tabs.

Step 4 Highlight the ring and click Edit.

Step 5 In the BLSR window, right-click the node on the ring map.

Step 6 Select Set Node ID from the shortcut menu.

Step 7 In the Edit Node ID dialog box, enter the new ID. The Node ID is the number in parentheses after the 
Node Name.

Step 8 Click OK.

Verify Node Visibility for Other Nodes

Step 1 Log into a node on the network. 

Step 2 In node view, click the Provisioning > BLSR tabs.

Step 3 Highlight a BLSR.
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Step 4 Click Ring Map.

Step 5 In the BLSR Ring Map window, verify that each node in the ring appears on the ring map with a node 
ID and IP address.

Step 6 Click Close.

2.9.2  Protection Switching, Lock Initiation, and Clearing
The following sections give instructions for port, ring, and span switching and switch-clearing 
commands, as well as lock-ons and lockouts.

Initiate a 1+1 Force Switch Command

This procedure switches 1+1 protection group traffic from one port in the group to the other using a 
Force switch. 

Caution The Force command overrides normal protective switching mechanisms. Applying this command 
incorrectly can cause traffic outages.

Caution Traffic is not protected during a Force protection switch.

Note A Force command switches traffic on a working path even if the path has signal degrade (SD) or signal 
fail (SF) conditions. A Force switch does not switch traffic on a protect path. A Force switch preempts 
a Manual switch. 

Step 1 In node view, click the Maintenance > Protection tabs. 

Step 2 In the Protection Groups area, select the protection group with the port you want to switch. 

Step 3 In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out 
this command for the working or protect port. For example, if you need to replace the card with the 
Protect/Standby port, click this port.

Step 4 In the Switch Commands area, click Force.

Step 5 Click Yes in the Confirm Force Operation dialog box.

Step 6 If the switch is successful, the group says “Force to working” in the Selected Groups area.

Initiate a 1+1 Manual Switch Command

This procedure switches 1+1 protection group traffic from one port in the group to the other using a 
Manual switch. 
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Note A Manual command switches traffic if the path has an error rate less than the signal degrade. A Manual 
switch is preempted by a Force switch. 

Step 1 In node view, click the Maintenance > Protection tabs. 

Step 2 In the Protection Groups area, select the protection group with the port you want to switch. 

Step 3 In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out 
this command for the working or protect port. For example, if you need to replace the card with the 
protect/standby port, click this port.

Step 4 In the Switch Commands area, click Manual.

Step 5 Click Yes in the Confirm Force Operation dialog box.

Step 6 If the switch is successful, the group now says “Manual to working” in the Selected Groups area.

Clear a 1+1 Force or Manual Switch Command

Note If the 1+1 protection group is configured as revertive, clearing a Force switch to protect (or working) 
moves traffic back to the working port. In revertive operation, the traffic always switches back to 
working. There is no revert to the protect. If ports are not configured as revertive, clearing a Force switch 
to protect does not move traffic back.

Note If the Force Switch was user-initiated, the reversion occurs immediately when the clear command is 
issued. The five-minute WTR period is not needed in this case. If the Force was system-initiated, allow 
the five-minute waiting period (during WTR) before the reversion occurs.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, choose the protection group containing the port you want to clear.

Step 3 In the Selected Group area, choose the port you want to clear.

Step 4 In the Switching Commands area, click Clear.

Step 5 Click Yes in the Confirmation Dialog box. 

The Force switch is cleared. Traffic immediately reverts to the working port if the group was configured 
for revertive switching.

Initiate a Lock-On Command

Note For 1:1 and 1:N electrical protection groups, working or protect cards can be placed in the Lock On state. 
For a 1+1 optical protection group, only the working port can be placed in the Lock On state.
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Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the protection group where you want to apply a lock-on.

Step 3 If you determine that the protect card is in standby mode and you want to apply the lock-on to the protect 
card, make the protect card active if necessary:

a. In the Selected Group list, click the protect card.

b. In the Switch Commands area, click Force.

Step 4 In the Selected Group list, click the active card where you want to lock traffic.

Step 5 In the Inhibit Switching area, click Lock On.

Step 6 Click Yes in the confirmation dialog box.

Initiate a Card or Port Lockout Command

Note For 1:1 or 1:N electrical protection groups, working or protect cards can be placed in the Lock Out state. 
For a 1+1 optical protection group, only the protect port can be placed in the Lock Out state.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the protection group that contains the card you want to lockout.

Step 3 In the Selected Group list, click the card where you want to lock out traffic.

Step 4 In the Inhibit Switching area, click Lock Out.

Step 5 Click Yes in the confirmation dialog box.

The lockout has been applied and traffic is switched to the opposite card. 

Clear a Lock-On or Lockout Command

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the protection group that contains the card you want to clear.

Step 3 In the Selected Group list, click the card you want to clear.

Step 4 In the Inhibit Switching area, click Unlock.

Step 5 Click Yes in the confirmation dialog box.

The lock-on or lockout is cleared.
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Initiate a 1:1 Card Switch Command

Note The Switch command only works on the Active card, whether it is working or protect. It does not work 
on the Standby card.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 Click the protection group that contains the card you want to switch.

Step 3 Under Selected Group, click the active card.

Step 4 Next to Switch Commands, click Switch. 

The working slot should change to Working/Active and the protect slot should change to 
Protect/Standby.

Initiate a Force Switch for All Circuits on a Path Protection Span 

This procedure forces all circuits in a path protection configuration from the working span to the protect. 
It is used to remove traffic from a card that originates or terminates path protection circuits. 

Caution The Force command overrides normal protective switching mechanisms. Applying this command 
incorrectly can cause traffic outages.

Caution Traffic is not protected during a Force protection switch.

Step 1 Log into a node on the network. 

Step 2 In node view, choose Go to Network View from the View menu.

Step 3 Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations, 
and a color code showing which circuits are active on the span.

Step 4 Click the Perform Path Protection span switching field. 

Step 5 Choose Force Switch Away from the drop-down list. 

Step 6 Click Apply. 

Step 7 In the Confirm Path Protection Switch dialog box, click Yes.

Step 8 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is FORCE. Unprotected circuits do 
not switch.
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Initiate a Manual Switch for All Circuits on a Path Protection Span 

This procedure manually switches all circuits in a path protection configuration from the working span 
to the protect. It is used to remove traffic from a card that originates or terminates path protection 
circuits. 

Caution The Manual command does not override normal protective switching mechanisms. 

Step 1 Log into a node on the network.

Step 2 Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations, 
and a color code showing which circuits are active on the span.

Step 3 Click the Perform Path Protection span switching field. 

Step 4 Choose Manual from the drop-down list. 

Step 5 Click Apply. 

Step 6 In the Confirm Path Protection Switch dialog box, click Yes.

Step 7 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is Manual. Unprotected circuits do 
not switch.

Initiate a Lockout for All Circuits on a Protect Path Protection Span 

This procedure prevents all circuits in a path protection working span from switching to the protect span. 
It is used to keep traffic off cards that originate or terminate path protection circuits. 

Caution The Lock Out of Protect command overrides normal protective switching mechanisms. 

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations, 
and a color code showing which circuits are active on the span.

Step 3 Click the Perform Path Protection span switching field. 

Step 4 Choose Lock Out of Protect from the drop-down list. 

Step 5 Click Apply. 

Step 6 In the Confirm Path Protection Switch dialog box, click Yes.

Step 7 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is LOCKOUT. Unprotected circuits 
do not switch.
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Clear an External Switching Command on a Path Protection Span

Note If the ports terminating a span are configured as revertive, clearing a Force or Manual switch to protect 
moves traffic back to the working port. If ports are not configured as nonrevertive, clearing a Force 
switch to protect does not move traffic back.

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations, 
and a color code showing which circuits are active on the span.

Step 3 Initiate a Force switch for all circuits on the span:

a. Click the Perform Path Protection span switching field. 

b. Choose Clear from the drop-down list. 

c. Click Apply. 

d. In the Confirm Path Protection Switch dialog box, click Yes.

e. In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is Clear. Unprotected circuits do 
not switch.

Initiate a Force Ring Switch on a BLSR

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 From the View menu choose Go to Network View.

Step 3 In network view, click the Provisioning > BLSR tabs.

Step 4 Click the row of the BLSR you are switching, then click Edit. 

Step 5 Right-click a BLSR node west port and choose Set West Protection Operation. 

Step 6 In the Set West Protection Operation dialog box, choose Force Ring from the drop-down list.

Step 7 Click OK.

Step 8 Click Yes in the two Confirm BLSR Operation dialog boxes that appear.

Initiate a Force Span Switch on a Four-Fiber BLSR

Step 1 Log into a node on the network.

Step 2 From the View menu choose Go to Network View.

Step 3 In network view, click the Provisioning > BLSR tabs.

Step 4 Click the row of the BLSR you are switching, then click Edit. 
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Step 5 Right-click a BLSR node west port and choose Set West Protection Operation. 

Step 6 In the Set West Protection Operation dialog box, choose Force Span from the drop-down list.

Step 7 Click OK.

Step 8 Click Yes in the two Confirm BLSR Operation dialog boxes that appear.

Initiate a Manual Span Switch on a BLSR

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Choose the BLSR and click Edit. 

Step 4 Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a 
west channel) or Set East Protection Operation (if you chose an east channel).

Step 5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose 
Manual Span from the drop-down list. 

Step 6 Click OK.

Step 7 Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate a Manual Ring Switch on a BLSR

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Choose the BLSR and click Edit. 

Step 4 Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a 
west channel) or Set East Protection Operation (if you chose an east channel).

Step 5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose 
Manual Ring from the drop-down list. 

Step 6 Click OK.

Step 7 Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate a Lockout on a BLSR Protect Span

Step 1 From the View menu choose Go to Network View. 

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Choose the BLSR and click Edit. 

Step 4 Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a 
west channel) or Set East Protection Operation (if you chose an east channel).
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Step 5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose 
Lockout Protect Span from the drop-down list. 

Step 6 Click OK.

Step 7 Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate an Exercise Ring Switch on a BLSR

Step 1 Log into a node on the network. 

Step 2 Click View > Go to Network View.

Step 3 Click the Provisioning > BLSR tabs.

Step 4 Click the row of the BLSR you are exercising, then click Edit. 

Step 5 Right-click the west port of a node and choose Set West Protection Operation. 

Step 6 In the Set West Protection Operation dialog box, choose Exercise Ring from the drop-down list. 

Step 7 Click OK.

Step 8 Click Yes in the Confirm BLSR Operation dialog box.

Initiate an Exercise Ring Switch on a Four Fiber BLSR

Step 1 Log into a node on the network. 

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Provisioning > BLSR tabs.

Step 4 Click the row of the BLSR you are exercising, then click Edit. 

Step 5 Right-click the west port of a node and choose Set West Protection Operation. 

Step 6 In the Set West Protection Operation dialog box, choose Exercise Span from the drop-down list. 

Step 7 Click OK.

Step 8 Click Yes in the Confirm BLSR Operation dialog box.

Clear a BLSR External Switching Command

Step 1 Log into a node on the network. 

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Provisioning > BLSR tabs.

Step 4 Click the BLSR you want to clear.

Step 5 Right-click the west port of the BLSR node where you invoked the switch and choose Set West 
Protection Operation. 
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Step 6 In the Set West Protection Operation dialog box, choose Clear from the drop-down list. 

Step 7 Click OK. 

Step 8 Click Yes in the Confirm BLSR Operation dialog box.

2.9.3  CTC Card Resetting and Switching
This section gives instructions for resetting traffic cards, TCC2/TCC2Ps, and cross-connect cards.

Caution For TXP and MXP cards placed in a Y-cable protection group, do not perform a software reset on both 
cards simultaneously. Doing so will cause a traffic hit of more than one minute. For more information 
about Y-cable protection groups, refer to the Cisco ONS 15454 DWDM Procedure Guide.

Caution Resetting the active card in a Y-cable group will cause a traffic outage if the standby card is down for 
any reason. 

Note When an AIC-I card is reset in CTC, any subsequent user client operations (such as CTC or TL1 activity) 
is paused for approximately 5-10 seconds. The reset does not cause any conditions to be raised. 

Note For more information about MXP and TXP cards, refer to the Cisco ONS 15454 DWDM Reference 
Manual.

Reset a Traffic Card in CTC

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 In node view, position the cursor over the optical or electrical traffic card slot reporting the alarm.

Step 3 Right-click the card. Choose Reset Card from the shortcut menu.

Step 4 Click Yes in the Resetting Card dialog box.

Reset an Active TCC2/TCC2P Card and Activate the Standby Card

Caution Resetting an active TCC2/TCC2P can be service-affecting.

Note Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change 
you made to avoid losing any changes to the database.
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Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Identify the active TCC2/TCC2P:

If you are looking at the physical ONS 15454 shelf, the ACT/SBY LED of the active card is green. The 
ACT/STBLY LED of the standby card is amber.

Step 3 Right-click the active TCC2/TCC2P in CTC.

Step 4 Choose Reset Card from the shortcut menu.

Step 5 Click Yes in the Confirmation Dialog box.

The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC 
switches to network view.

Step 6 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. For LED 
appearance, see the “2.8.3  Typical Card LED State After Successful Reset” section on page 2-261.

Step 7 Double-click the node and ensure that the reset TCC2/TCC2P is in standby mode and that the other 
TCC2/TCC2P is active. Verify the following:

 • If you are looking at the physical ONS 15454 shelf, the ACT/SBY LED of the active card is green. 
The ACT/STBLY LED of the standby card is amber.

 • No new alarms appear in the Alarms window in CTC.

Side Switch the Active and Standby Cross-Connect Cards

Caution The cross-connect card side switch is usually service-affecting.

Step 1 Log into a node on the network. For instructions regarding how to log into a node, refer Cisco ONS 15454 
Procedure Guide, Release 8.0. If you are already logged in, continue with Step 2.

Step 2 Display node view.

Step 3 Determine the active or standby XC10G card.

The ACT/SBY LED of the active card is green. The ACT/SBY LED of the standby card is amber.

Note You can also position the cursor over the card graphic to display a popup identifying the card as 
active or standby.

Step 4 In node view, click the Maintenance > Cross-Connect > Cards tabs.

Step 5 Click Switch.

Step 6 Click Yes in the Confirm Switch dialog box. See the “2.8.4  Typical Cross-Connect LED Activity During 
Side Switch” section on page 2-261 for LED information.

Note During a maintenance side switch or soft reset of an active XC10G card, the 1+1 protection 
group might display a protection switch. To disallow the protection switch from being displayed, 
the protection group should be locked at the node where XC switch or soft reset of an active XC 
switch is in progress.
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Caution Active cross connect (XC10G/XCVT) cards should not be physically removed.

The following rules must be followed for removing an Active Cross Connect Card (XC10G/XCVT):

If the active cross connect has to be removed, perform an XCVT/XC10G side switch to change the status 
of the card from active to standby and then remove the cross connect card once it goes back to standby.

OR

Perform a lockout on all circuits that originate from the node whose active cross connect card has to be 
removed (performing a lockout on all spans will also accomplish the same goal).

2.9.4  Physical Card Reseating, Resetting, and Replacement
This section gives instructions for physically reseating and replacing TCC2/TCC2P, cross-connect, and 
traffic cards.

Caution Do not physically replace a card without first making provisions to switch or move traffic to a different 
card or circuit. General procedures for this are located in the “2.9.2  Protection Switching, Lock 
Initiation, and Clearing” section on page 2-263. In-depth traffic switching procedures and information 
can be found in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution Do not perform this action without the supervision and direction of Cisco TAC 1 800 553-2447.

Caution The TCC2/TCC2P reseat could be service-affecting. Refer to the “2.9.2  Protection Switching, Lock 
Initiation, and Clearing” section on page 2-263 for traffic-switching procedures.

Note Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change 
you made to avoid losing any changes to the database.

Note When a standby TCC2/TCC2P card is removed and reinserted (reseated), all three fan lights could 
momentarily turn on, indicating that the fans have also reset. 

Step 1 Log into a node on the network. 
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Ensure that the TCC2/TCC2P you want to reseat is in standby mode. A standby card has an amber 
ACT/SBY (Active/Standby) LED illuminated. 

Step 2 When the TCC2/TCC2P is in standby mode, unlatch both the top and bottom ejectors on the 
TCC2/TCC2P.

Step 3 Physically pull the card at least partly out of the slot until the lighted LEDs turn off.

Step 4 Wait 30 seconds. Reinsert the card and close the ejectors.

Note The TCC2/TCC2P requires several minutes to reboot and display the amber standby LED after 
rebooting. Refer to the Cisco ONS 15454 Reference Manual for more information about LED 
behavior during a card reboot.

Remove and Reinsert (Reseat) Any Card 

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Open the card ejectors.

Step 2 Slide the card halfway out of the slot along the guide rails.

Step 3 Slide the card all the way back into the slot along the guide rails.

Step 4 Close the ejectors.

Physically Replace a Traffic Card

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this, 
perform an external switch if a switch has not already occurred. refer to the procedures in the 
“2.9.2  Protection Switching, Lock Initiation, and Clearing” section on page 2-263. For more 
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

When you replace a card with the identical type of card, you do not need to make any changes to the 
database.

Step 1 Open the card ejectors.

Step 2 Slide the card out of the slot.

Step 3 Open the ejectors on the replacement card.
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Step 4 Slide the replacement card into the slot along the guide rails.

Step 5 Close the ejectors.

Physically Replace an In-Service Cross-Connect Card

Caution The cross-connect reseat could be service-affecting. Refer to the “2.9.2  Protection Switching, Lock 
Initiation, and Clearing” section on page 2-263 for traffic-switching procedures prior to completing this 
procedure. 

Note This procedure is placed in the chapter as a quick guide for the user’s convenience. A more detailed 
procedure is located in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

When you replace a card with the identical type of card, you do not need to make any changes to the 
database.

Step 1 Determine the active cross-connect card (XCVT/XC10G/XC-VXC-10G). The ACT/SBY LED of the 
active card is green. The ACT/SBY LED of the standby card is amber.

Note You can also place the cursor over the card graphic to display a popup identifying the card as 
active or standby.

Step 2 Switch the active cross-connect card to standby:

a. In the node view, click the Maintenance > Cross-Connect tabs.

b. Under Cross Connect Cards, choose Switch.

c. Click Yes in the Confirm Switch dialog box.

Note After the active cross-connect card becomes standby, the original standby slot becomes active. 
This causes the ACT/SBY LED to become green on the former standby card.

Step 3 Physically remove the new standby cross-connect card from the ONS 15454.

Note An improper removal (IMPROPRMVL) alarm is raised when a card reseat is performed, unless 
the card is first deleted in Cisco Transport Controller (CTC). The alarm clears after the card is 
replaced.

Step 4 Insert the replacement cross-connect card into the empty slot.

The replacement card boots up and becomes ready for service after approximately one minute.
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2.9.5  Generic Signal and Circuit Procedures
This section gives instructions for verify BER thresholds, deleting circuits, provisioning SDCC 
terminations, and clearing loopbacks.

Verify the Signal BER Threshold Level

Step 1 Log into a node on the network.

Step 2 In node view, double-click the card reporting the alarm to open the card view.

Step 3 Click the Provisioning > Line tabs.

Step 4 Under the SD BER (or SF BER) column in the Provisioning window, verify that the cell entry is 
consistent with the originally provisioned threshold. The default setting is 1E-7.

Step 5 If the entry is consistent with the original provisioning, go back to your original procedure.

Step 6 If the entry is not consistent with what the system was originally provisioned for, click the cell to reveal 
the range of choices and click the original entry.

Step 7 Click Apply.

Delete a Circuit

Step 1 Log into a node on the network. 

Step 2 In node view, click the Circuits tab.

Step 3 Click the circuit row to highlight it and click Delete.

Step 4 Click Yes in the Delete Circuits dialog box.

Verify or Create Node Section DCC Terminations

Note Portions of this procedure are different for ONS 15454 DWDM nodes.

Step 1 Log into a node on the network. 

Step 2 In node view, click the Provisioning > Comm Channels > SDCC tab.

Step 3 View the Port column entries to see where terminations are present for a node. If terminations are 
missing, proceed to Step 4.

Step 4 If necessary, create a DCC termination:

a. Click Create.

b. In the Create SDCC Terminations dialog box, click the ports where you want to create the DCC 
termination. To select more than one port, press the Shift key.

c. In the port state area, click the Set to IS radio button.
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d. Verify that the Disable OSPF on Link check box is unchecked.

e. Click OK.

Clear an OC-N Card Facility or Terminal Loopback Circuit

Step 1 Log into a node on the network. 

Step 2 Double-click the reporting card in CTC to open the card view.

Step 3 Click the Maintenance > Loopback > Port tabs. 

Step 4 In the Loopback Type column, determine whether any port row shows a state other than None.

Step 5 If a row contains another state besides None, click in the column cell to display the drop-down list and 
select None.

Step 6 In the Admin State column, determine whether any port row shows a state other than IS. 

Step 7 If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.

Step 8 Click Apply.

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port 
service state transitions to OOS-AU,FLT.

Clear an OC-N Card Cross-Connect (XC) Loopback Circuit

Step 1 Log into a node on the network. 

Step 2 Double-click the reporting card in CTC to open the card view.

Step 3 Click the Maintenance > Loopback > SONET STS tabs.

Step 4 Uncheck the XC Loopback check box.

Step 5 Click Apply.

Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit

Step 1 Log into a node on the network. 

Step 2 Double-click the reporting card in CTC to open the card view.

Step 3 Click the Maintenance > DS3 tabs or the Maintenance > DS1 tabs.

Step 4 In the Loopback Type column, determine whether any port row shows a state other than None.

Step 5 If a row contains another state besides None, click in the column cell to display the drop-down list and 
select None.

Step 6 In the Admin State column, determine whether any port row shows a state other than IS.
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Step 7 If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.

Step 8 Click Apply.

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port 
service state transitions to OOS-AU,FLT.

Clear Other Electrical Card or Ethernet Card Loopbacks

Note This procedure does not apply to DS3XM-6 or DS3XM-12 cards.

Note For more information about Ethernet cards, refer to the Cisco ONS 15454 and 
Cisco ONS 15454 SDH Ethernet Card Software Feature and Configuration Guide.

Step 1 Log into a node on the network. 

Step 2 Double-click the reporting card in CTC to open the card view.

Step 3 Click the Maintenance > Loopback tabs.

Step 4 In the Loopback Type column, determine whether any port row shows a state other than None.

Step 5 If a row contains another state besides None, click in the column cell to display the drop-down list and 
select None.

Step 6 In the Admin State column, determine whether any port row shows a state other than IS.

Step 7 If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.

Step 8 Click Apply.

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port 
service state transitions to OOS-AU,FLT.

Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit

Step 1 Log into a node on the network. 

Step 2 Double-click the reporting card in CTC to open the card view.

Step 3 Click the Maintenance > Loopback tabs.

Step 4 In the Loopback Type column, determine whether any port row shows a state other than None.

Step 5 If a row contains another state besides None, click in the column cell to display the drop-down list and 
select None.
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Step 6 In the Admin State column, determine whether any port row shows an admin state other than IS, for 
example, OOS,MT.

Step 7 If a row shows an admin state other than IS, click in the column cell to display the drop-down list and 
select IS.

Note If a port in the IS admin state does not receive a signal, the LOS alarm is raised and the port 
service state transitions to OOS-AU,FLT.

Step 8 Click Apply.

2.9.6  Air Filter and Fan Procedures
This section gives instructions for cleaning or replacing the air filter and reseating or replacing the fan 
tray assembly.

Inspect, Clean, and Replace the Reusable Air Filter

To complete this task, you need a vacuum cleaner or detergent and water faucet, a spare filter, and a 
pinned hex key. 

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Although the filter works if it is installed with either side facing up, Cisco recommends that you install 
it with the metal bracing facing up to preserve the surface of the filter. 

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell, 
polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later 
versions of the ONS 15454 use a reusable air filter. 

Step 2 If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being 
careful not to dislodge any dust that could have collected on the filter. If the filter is installed beneath 
the fan tray and not in the external filter brackets, open and remove the front door assembly by 
completing the following steps:

a. Open the front door of the shelf assembly by completing the following substeps.(If it is already open 
or if the shelf assembly does not have a front door, continue with Step 3.) 

 • Open the front door lock.

 • Press the door button to release the latch. 

 • Swing the door open. 

b. Remove the front door by completing the following substeps (optional):
2-279
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 2      Alarm Troubleshooting
2.9.6    Air Filter and Fan Procedures
 • Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

 • Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

 • Secure the dangling end of the ground strap to the door or chassis with tape.

Step 3 Push the outer side of the handles on the fan-tray assembly to expose the handles. 

Step 4 Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait 
until the fans stop. 

Step 5 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step 6 Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that could have 
collected on the filter.

Step 7 Visually inspect the air filter material for dirt and dust.

Step 8 If the reusable air filter has a concentration of dirt and dust, either vacuum or wash the air filter. Prior to 
washing the air filter, replace the dirty air filter with a clean air filter and also reinsert the fan-tray 
assembly. Wash the dirty air filter under a faucet with a light detergent. 

Spare ONS 15454 filters should be kept in stock for this purpose.

Note Cleaning should take place outside the operating environment to avoid releasing dirt and dust 
near the equipment.

Step 9 If you washed the filter, allow it to completely air dry for at least eight hours.

Caution Do not put a damp filter back in the ONS 15454.

Step 10 If the air filter should be installed in the external filter brackets, slide the air filter all the way to the back 
of the brackets to complete the procedure.

Step 11 If the filter should be installed beneath the fan-tray assembly, remove the fan-tray assembly and slide the 
air filter into the recessed compartment at the bottom of the shelf assembly. Put the front edge of the air 
filter flush against the front edge of the recessed compartment. Push the fan tray back into the shelf 
assembly.

Caution If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and 
readjust the position of the reusable filter until the fan tray fits correctly.

Note On a powered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly 
inserted. 

Step 12 To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray 
assembly is activated and displays node information.

Step 13 Rotate the retractable handles back into their compartments.

Step 14 Replace the door and reattach the ground strap.
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Remove and Reinsert a Fan-Tray Assembly

Step 1 Use the retractable handles embedded in the front of the fan-tray assembly to pull it forward several 
inches.

Step 2 Push the fan-tray assembly firmly back into the ONS 15454.

Step 3 Close the retractable handles.

Replace the Fan-Tray Assembly

Caution The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 R3.1 and later shelf assemblies 
(15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). It includes a pin that does not 
allow it to be installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1 
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can 
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or 
the connectors on the backplane.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities. 

Step 1 Open the front door of the shelf assembly by completing the following steps. If the shelf assembly does 
not have a front door, continue with Step 3. 

a. Open the front door lock.

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 2 Remove the front door (optional):

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c. Secure the dangling end of the ground strap to the door or chassis with tape.

Step 3 Push the outer side of the handles on the fan-tray assembly to expose the handles. 

Step 4 Fold out the retractable handles at the outside edges of the fan tray.

Step 5 Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait 
until the fans stop. 

Step 6 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly. 

Step 7 If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the 
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.
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If you are replacing the fan-tray air filter and it is installed in the external bottom bracket, you can slide 
the existing air filter out of the bracket and replace it at anytime. For more information on the fan-tray 
air filter, see the “Inspect, Clean, and Replace the Reusable Air Filter” section on page 2-279.

Step 8 Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into 
the corresponding receptacle on the backplane.

Step 9 To verify that the tray has plugged into the backplane, check that the LCD on the front of the fan tray is 
activated.

Step 10 If you replace the door, be sure to reattach the ground strap.

2.9.7  Interface Procedures
This section includes instructions for replacing an EIA and an AIP.

Replace the Electrical Interface Assembly

Note You need a #2 Phillips screwdriver. If you use high-density BNC EIAs, you also need a BNC insertion 
and removal tool. 

Step 1 To remove the lower backplane cover, loosen the five screws that secure it to the ONS 15454 and pull it 
away from the shelf assembly.

Step 2 Loosen the nine perimeter screws that hold the backplane sheet metal cover or EIA in place. Do not 
remove the interior screws.

If you are removing an AMP Champ EIA, remove the fastening plate before proceeding. To remove the 
fastening plate, loosen the two thumbscrews. 

Step 3 If a backplane cover is attached to the ONS 15454, lift the panel by the bottom to remove it from the 
shelf assembly and store the panel for later use.

Step 4 If an EIA is attached to the ONS 15454, lift the EIA handles and gently pull it away from the backplane. 

Note Attach backplane sheet metal covers whenever EIAs are not installed. 

Step 5 Line up the connectors on the new EIA with the mating connectors on the backplane. 

Step 6 Gently push the EIA until both sets of connectors fit together snugly. 

Step 7 Replace the nine perimeter screws that you removed while removing the backplane cover.

Step 8 If you are installing an AMP Champ EIA, attach the fastening plate with the two thumbscrews.

Step 9 Reattach the lower backplane cover.
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Replace the Alarm Interface Panel

Caution Do not use a 2A AIP with a 5A fan-tray assembly; doing so causes a blown fuse on the AIP.

Caution If any nodes in an Ethernet circuit are not using Software R4.0 or later, there is a risk of Ethernet traffic 
disruptions. Contact Cisco TAC at 1 800 553-2447 when prompted to do so in the procedure.

Note Perform this procedure during a maintenance window. Resetting the active TCC2/TCC2P can cause a 
service disruption of less then 50 ms to OC-N or DS-N traffic. Resetting the active TCC2/TCC2P can 
cause a service disruption of 3 to 5 minutes on all Ethernet traffic due to spanning tree reconvergence if 
any nodes in the Ethernet circuit are not using Software R4.0 or later.

Caution Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and 
result in a loss of data. For assistance with AIP replacement contact Cisco TAC 1 800 553-2447.

Caution Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454. 
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

This procedure replaces an existing AIP with a new AIP on an in-service node without affecting traffic. 
Ethernet circuits that traverse nodes with a software release prior to R4.0 is affected. 

You need a #2 Phillips screwdriver. 

Step 1 Ensure that all nodes in the affected network are running the same software version before replacing the 
AIP and repairing circuits:

a. In network view, click the Maintenance > Software tabs. The working software version for each 
node is listed in the Working Version column.

b. If you need to upgrade the software on a node, refer to the release-specific software upgrade 
document for procedures. No hardware should be changed or circuit repair performed until after the 
software upgrade is complete. If you do not need to upgrade software or have completed the software 
upgrade, proceed to Step 2.

Step 2 Record the MAC address of the old AIP:

a. Log into the node where you are replacing the AIP. For login procedures, refer to the “Connect the 
PC and Log into the GUI” chapter in the Cisco ONS 15454 Procedure Guide.

b. In node view, click the Provisioning > Network > General tabs.

c. Record the MAC address.

Step 3 Call Cisco TAC 1 800 553-2447 for assistance in replacing the AIP and maintaining the original MAC 
address.

Step 4 Unscrew the five screws that hold the lower backplane cover in place.

Step 5 Grip the lower backplane cover and gently pull it away from the backplane.
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Step 6 Unscrew the two screws that hold the AIP cover in place.

Step 7 Grip the cover and gently pull away from the backplane.

Note On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and 
15454-SA-R1 (P/N: 800-07149) shelves the AIP cover is clear plastic. On the 15454-SA-ANSI 
shelf (P/N: 800-19857), the AIP cover is metal.

Step 8 Grip the AIP and gently pull it away from the backplane.

Step 9 Disconnect the fan-tray assembly power cable from the AIP.

Step 10 Set the old AIP aside for return to Cisco.

Caution The type of shelf the AIP resides in determines the version of AIP that should replace the failed AIP. The 
15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A AIP, 
(P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149) 
shelves and earlier use the 2A AIP (P/N: 73-5262-01). 

Caution Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD 
(P/N: 800-24848) shelf; doing so causes a blown fuse on the AIP.

Step 11 Attach the fan-tray assembly power cable to the new AIP.

Step 12 Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.

Step 13 Replace the AIP cover over the AIP and secure the cover with the two screws.

Step 14 Replace the lower backplane cover and secure the cover with the five screws.

Step 15 In node view, click the Provisioning > Network tabs.

Caution Cisco recommends TCC2/TCC2P resets be performed in a maintenance window to avoid any potential 
service disruptions.

Step 16 Reset the standby TCC2/TCC2P:

a. Right-click the standby TCC2/TCC2P and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears 
on the card in CTC.The reset takes approximately five minutes. Do not perform any other steps until 
the reset is complete.

Step 17 Reset the active TCC2/TCC2P:

a. Right click the active TCC2/TCC2P and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a Ldg indication appears on the card 
in CTC. The reset takes approximately five minutes and CTC loses its connection with the node.

Step 18 From the File drop-down list, choose Exit to exit the CTC session.

Step 19 Log back into the node. At the Login dialog box, choose (None) from the Additional Nodes drop-down 
list. 
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Step 20 Record the new MAC address:

a. In node view, click the Provisioning > Network > General tabs.

b. Record the MAC address.

Step 21 In node view, click the Circuits tab. Note that all circuits listed are PARTIAL.

Step 22 In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box 
appears.

Step 23 Read the instructions in the Circuit Repair dialog box. If all the steps in the dialog box have been 
completed, click Next. Ensure that you have the old and new MAC addresses.

Step 24 The Node MAC Addresses dialog box appears. Complete the following steps:

a. From the Node drop-down list, choose the name of the node where you replaced the AIP.

b. In the Old MAC Address field, enter the old MAC address that was recorded in Step 2.

c. Click Next.

Step 25 The Repair Circuits dialog box appears. Read the information in the dialog box and click Finish.

The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes or more 
depending on the number of circuits provisioned on it.

When the circuit repair is complete, the Circuits Repaired dialog box appears.

Step 26 Click OK.

Step 27 In the node view of the new node, click the Circuits tab. Note that all circuits listed are DISCOVERED. 
If all circuits listed do not have a DISCOVERED status, call the Cisco TAC 1 800 553-2447 to open a 
Return Material Authorization (RMA).
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C H A P T E R 3

Transient Conditions

This chapter gives a description, entity, SNMP number, and trap for each commonly encountered 
Cisco ONS 15454 transient condition. 

3.1  Transients Indexed By Alphabetical Entry
Table 3-1 alphabetically lists all ONS 15454 transient conditions and their entity, SNMP number, and 
SNMP trap.

Note The CTC default alarm profile might contain conditions that are not currently implemented but are 
reserved for future use.

Table 3-1 ONS 15454 Transient Condition Alphabetical Index 

Transient Condition Entity SNMP Number SNMP Trap

3.3.1  ADMIN-DISABLE, page 3-4 NE 5270 disableInactiveUser

3.3.2  ADMIN-DISABLE-CLR, page 3-4 NE 5280 disableInactiveClear

3.3.3  ADMIN-LOCKOUT, page 3-4 NE 5040 adminLockoutOfUser

3.3.4  ADMIN-LOCKOUT-CLR, page 3-4 NE 5050 adminLockoutClear

3.3.5  ADMIN-LOGOUT, page 3-5 NE 5020 adminLogoutOfUser

3.3.6  ADMIN-SUSPEND, page 3-5 NE 5340 suspendUser

3.3.7  ADMIN-SUSPEND-CLR, page 3-5 NE 5350 suspendUserClear

3.3.8  AUD-ARCHIVE-FAIL, page 3-5 EQPT 6350 archiveOfAuditLogFailed

3.3.9  AUTOWDMANS, page 3-5 NE 5690 automaticWdmAnsFinish
ed

3.3.10  BLSR-RESYNC, page 3-5 OCN 2100 blsrMultiNodeTableUpdat
eCompleted

3.3.11  DBBACKUP-FAIL, page 3-5 EQPT 3724 databaseBackupFailed

3.3.12  DBRESTORE-FAIL, page 3-6 EQPT 3726 databaseRestoreFailed
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3.3.13  EFM-ERR-FRM, page 3-6 ML100T, 
ML1000, 
MLFX, 
ML2

6800 efmLinkMonitoringError
edFrameEvent

3.3.14  EFM-FRM-PER, page 3-6 ML100T, 
ML1000, 
MLFX, 
ML2

6810 efmLinkMonitoringError
edFramePeriodEvent

3.3.15  EFM-FRM-SEC, page 3-6 ML100T, 
ML1000, 
MLFX, 
ML2

6820 efmLinkMonitoringError
edFrameSecondsSummar
y

3.3.16  EFM-RLBK-FAIL, page 3-6 ML100T, 
ML1000, 
MLFX, 
ML2

6830 efmRemoteLoopbackReq
uestFailed

3.3.17  EFM-SYM-PER, page 3-7 ML100T, 
ML1000, 
MLFX, 
ML2

6790 efmLinkMonitoringError
edSymbolPeriodEvent

3.3.18  FIREWALL-DIS, page 3-7 NE 5230 firewallHasBeenDisabled

3.3.19  FRCDWKSWBK-NO-TRFSW, 
page 3-7

OCN 5560 forcedSwitchBackToWor
kingResultedInNoTraffic
Switch

3.3.20  FRCDWKSWPR-NO-TRFSW, 
page 3-7

OCn 5550 forcedSwitchToProtectRe
sultedInNoTrafficSwitch

3.3.21  INTRUSION, page 3-7 NE 5250 securityIntrusionDetUser

3.3.22  IOSCFG-COPY-FAIL, page 3-7 — 3660 iosConfigCopyFailed

3.3.23  LOGIN-FAIL-LOCKOUT, 
page 3-8

NE 5080 securityInvalidLoginLock
edOutSeeAuditLog

3.3.24  LOGIN-FAIL-ONALRDY, 
page 3-8

NE 5090 securityInvalidLoginAlre
adyLoggedOnSeeAuditLo
g

3.3.25  LOGIN-FAILURE-PSWD, 
page 3-8

NE 5070 securityInvalidLoginPass
wordSeeAuditLog

3.3.26  LOGOUT-IDLE-USER, page 3-8 — 5110 automaticLogoutOfIdleU
ser

3.3.27  MANWKSWBK-NO-TRFSW, 
page 3-8

OCN 5540 manualSwitchBackToWor
kingResultedInNoTraffic
Switch

3.3.28  MANWKSWPR-NO-TRFSW, 
page 3-8

OCN 5530 manualSwitchToProtectR
esultedInNoTrafficSwitch

Table 3-1 ONS 15454 Transient Condition Alphabetical Index (continued)

Transient Condition Entity SNMP Number SNMP Trap
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3.2  Trouble Notifications
The ONS 15454 system reports trouble by using standard condition characteristics that follow the rules 
in Telcordia GR-253 and graphical user interface (GUI) state indicators. 

The ONS 15454 uses standard Telcordia categories to characterize levels of trouble. The system reports 
trouble notifications as alarms and reports status or descriptive notifications (if configured to do so) as 
conditions in the CTC Alarms window. Alarms typically signify a problem that you need to remedy, such 
as a loss of signal. Conditions do not necessarily require troubleshooting.

3.2.1  Condition Characteristics
Conditions include any problem detected on an ONS 15454 shelf. They can include standing or transient 
notifications. You can retrieve a snapshot of all currently raised conditions on the network, node, or card 
in the CTC Conditions window or by using the RTRV-COND commands in TL1. 

Note Some cleared conditions are found on the History tab.

3.3.29  PM-TCA, page 3-8 — 2120 performanceMonitorThre
sholdCrossingAlert

3.3.30  PS, page 3-9 EQPT 2130 protectionSwitch

3.3.31  RMON-ALARM, page 3-9 — 2720 rmonThresholdCrossingA
larm

3.3.32  RMON-RESET, page 3-9 — 2710 rmonHistoriesAndAlarms
ResetReboot

3.3.33  SFTWDOWN-FAIL, page 3-9 EQPT 3480 softwareDownloadFailed

3.3.34  USER-LOCKOUT, page 3-9 NE 5030 userLockedOut

3.3.35  USER-LOGIN, page 3-9 NE 5100 loginOfUser

3.3.36  USER-LOGOUT, page 3-9 NE 5120 logoutOfUser

3.3.37  WORK-QUEUE-FULL, page 3-10 EQPT

3.3.38  WKSWBK, page 3-10 EQPT, 
OCN

2640 switchedBackToWorking

3.3.39  WKSWPR, page 3-10 2R, 
TRUNK, 
EQPT, 
ESCON, 
FC, GE, 
ISC, OCN, 
STSMON, 
VT-MON

2650 switchedToProtection

3.3.40  WTR-SPAN, page 3-10 — 3420 spanIsInWaitToRestoreSt
ate

Table 3-1 ONS 15454 Transient Condition Alphabetical Index (continued)

Transient Condition Entity SNMP Number SNMP Trap
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3.2.2    Condition States
For a comprehensive list of conditions, refer to the Cisco ONS SONET TL1 Command Guide. 

3.2.2  Condition States
The History tab state (ST) column indicates the disposition of the condition, as follows:

 • A raised (R) event is active.

 • A cleared (C) event is no longer active.

 • A transient (T) event is automatically raised and cleared in CTC during system changes such as user 
login, log out, and loss of connection to node view. Transient events do not require user action. 

3.3  Transient Conditions
This section lists in alphabetical order all the transient conditions encountered in Software Release 7.2. 
The description, entity, SNMP number, and SNMP trap accompany each condition.

3.3.1  ADMIN-DISABLE 
The Disable Inactive User (ADMIN-DISABLE) condition occurs when the administrator disables the 
user or the account is inactive for a specified period.

This transient condition does not result in a standing condition.

3.3.2  ADMIN-DISABLE-CLR 
The Disable Inactive Clear (ADMIN-DISABLE-CLR) condition occurs when the administrator clears 
the disable flag on the user account.

This transient condition does not result in a standing condition.

3.3.3  ADMIN-LOCKOUT 
The Admin Lockout of User (ADMIN-LOCKOUT) condition occurs when the administrator locks a user 
account.

This transient condition does not result in a standing condition.

3.3.4  ADMIN-LOCKOUT-CLR 
The Admin Lockout Clear (ADMIN-LOCKOUT-CLR) condition occurs when the administrator unlocks 
a user account or the lockout time expires.

This transient condition does not result in a standing condition.
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3.3.5  ADMIN-LOGOUT 
The Admin Logout of User (ADMIN-LOGOUT) condition occurs when the administrator logs off a user 
session.

This transient condition does not result in a standing condition.

3.3.6  ADMIN-SUSPEND 
The Suspend User (ADMIN-SUSPEND) condition occurs when the password for a user account expires.

This transient condition does not result in a standing condition.

3.3.7  ADMIN-SUSPEND-CLR 
The Suspend User Clear (ADMIN-SUSPEND-CLR) condition occurs when the user or administrator 
changes the password.

This transient condition does not result in a standing condition.

3.3.8  AUD-ARCHIVE-FAIL
The Archive of Audit Log Failed (AUD-ARCHIVE-FAIL) condition occurs when the software cannot 
archive the audit log. The condition normally occurs when the user refers to an FTP server that does not 
exist, or uses an invalid login when trying to archive. The user must log in again with correct user name, 
password, and FTP server details.

This transient condition does not result in a standing condition.

3.3.9  AUTOWDMANS 
The Automatic WDM ANS Finish (AUTOWDMANS) condition indicates that an automatic node setup 
command has been initiated. It normally occurs when you replace DWDM cards; the condition is an 
indication that the system has regulated the card.

This transient condition does not result in a standing condition.

3.3.10  BLSR-RESYNC 
The BLSR Multinode Table Update Completed (BLSR-RESYNC) condition might occur when you 
create or delete circuits on a bidirectional line switched ring (BLSR), change a ring topology (for 
example, add or delete a BLSR node), or change the BLSR circuit state and ring ID. 

This transient condition does not result in a standing condition.

3.3.11  DBBACKUP-FAIL
The Database Backup Failed (DBBACKUP-FAIL) condition occurs when the system fails to back up the 
database when the backup command is initiated.
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This condition can occur when the server is not able to handle the backup operation due to network or 
server issues. Repeat the same operation again and check to see if it is successful. If the backup fails, it 
could be due to a network issue or software program failure. Contact TAC for assistance; see the 
“Obtaining Documentation and Submitting a Service Request” section on page xliv as needed. 

3.3.12  DBRESTORE-FAIL 
The Database Restore Failed (DBRESTORE-FAIL) condition occurs when the system fails to restore the 
backed up database when the restore command is initiated.

This condition can be due to server issues, network issues, or human error (pointing to a file that does 
not exist, wrong file name, etc.). Retrying the database restore with the correct file will usually succeed. 
If the network issue persists, you must contact network lab support. If the condition is caused by a 
network element (NE) failure, contact TAC for assistance. See the “Obtaining Documentation and 
Submitting a Service Request” section on page xliv as needed. 

3.3.13  EFM-ERR-FRM
The EFM Link Monitoring - Errored Frame Event condition occurs when the number of error frames 
detected on the remote NE is equal to or greater than the specified threshold for a specified period, and 
the remote NE notifies local NE of the same. A period is specified by time interval. 

This transient condition does not result in a standing condition.

3.3.14  EFM-FRM-PER
The EFM Link Monitoring - Errored Frame Period Event condition occurs when the number of errored 
frames detected on the remote NE is equal to or greater than the specified threshold for a specified 
period, and the remote NE notifies local NE of the same. A period is specified by the number of received 
frames.

This transient condition does not result in a standing condition.

3.3.15  EFM-FRM-SEC
The EFM Link Monitoring - Errored Frame Seconds Summary condition occurs when the number of 
errored frame seconds (a 1-second interval wherein at least one frame error was detected) on the remote 
NE crosses the configured threshold. The remote NE notifies local NE of the condition. 

3.3.16  EFM-RLBK-FAIL
The EFM - Remote Loopback Request Failed condition occurs when a request fails. When the user 
triggers a remote loopback request on the local NE, the request is forwarded to the remote NE. If the 
remote NE does not respond to the request and the local NE times out, this condition notifies the user on 
local NE about the failure.

This transient condition does not result in a standing condition.
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3.3.17  EFM-SYM-PER
The EFM Link Monitoring - Errored Symbol Period Event condition occurs when the symbol errors 
detected at the remote NE cross a configured threshold. This condition notifies the user onthe local NE 
of this threshold crossing.

This transient condition does not result in a standing condition.

3.3.18  FIREWALL-DIS
The Firewall Has Been Disabled (FIREWALL-DIS) condition occurs when you provision the firewall to 
Disabled.

This transient condition does not result in a standing condition.

3.3.19  FRCDWKSWBK-NO-TRFSW 
The Forced Switch Back to Working Resulted in No Traffic Switch (FRCDWKSWBK-NO-TRFSW) 
condition occurs when you perform a Force Switch to the working port/card and the working port/card 
is already active.

This transient condition might result in a Force Switch (Ring or Span) standing condition for a BLSR.

3.3.20  FRCDWKSWPR-NO-TRFSW
The Forced Switch to Protection Resulted in No Traffic Switch (FRCDWKSWPR-NO-TRFSW) 
condition occurs when you perform a Force Switch to the protect port/card, and the protect port/card is 
already active.

This transient condition does not result in a standing condition.

3.3.21  INTRUSION 
The Invalid Login Username (INTRUSION) condition occurs when you attempt to login with an invalid 
user ID.

This transient condition does not result in a standing condition.

3.3.22  IOSCFG-COPY-FAIL
The IOS Config Copy Failed (IOSCFG-COPY-FAIL) condition occurs on ML-Series Ethernet cards 
when the software fails to upload or download the Cisco IOS startup configuration file to or from an 
ML-Series card. This condition is similar to the “SFTWDOWN-FAIL” condition on page 3-9, but the 
IOSCFG-COPY-FAIL condition applies to ML-Series Ethernet cards rather than the TCC2/TCC2P card.
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3.3.23  LOGIN-FAIL-LOCKOUT 
The Invalid Login–Locked Out (LOGIN-FAIL-LOCKOUT) condition occurs when you attempt to log 
into a locked account.

This transient condition does not result in a standing condition.

3.3.24  LOGIN-FAIL-ONALRDY 
The Security: Invalid Login–Already Logged On (LOGIN-FAIL-ONALRDY) condition occurs when 
you attempt to login to a node where the user already has an existing session and a Single-User-Per-Node 
(SUPN) policy exists.

This transient condition does not result in a standing condition.

3.3.25  LOGIN-FAILURE-PSWD 
The Invalid Login–Password (LOGIN-FAILURE-PSWD) condition occurs when you attempt to login 
with an invalid password.

This transient condition does not result in a standing condition.

3.3.26  LOGOUT-IDLE-USER
The Automatic Logout of Idle User (LOGOUT-IDLE-USER) condition occurs when a user session is 
idle for too long (the idle timeout expires) and the session terminates as a result. You must log in again 
to restart your session.

3.3.27  MANWKSWBK-NO-TRFSW 
The Manual Switch Back To Working Resulted in No Traffic Switch (MANWKSWBK-NO-TRFSW) 
condition occurs when you perform a Manual switch to the working port/card and the working port/ card 
is already active.

This transient condition does not result in a standing condition.

3.3.28  MANWKSWPR-NO-TRFSW
The Manual Switch to Protect Resulted in No Traffic Switch (MANWKSWPR-NO-TRFSW) condition 
occurs when you perform a Manual switch to the protect port/card and the protect port/card is already 
active.

This transient condition results in a BLSR Manual Switch (Span or Ring) standing condition.

3.3.29  PM-TCA
The Performance Monitor Threshold Crossing Alert (PM-TCA) condition occurs when network 
collisions cross the rising threshold for the first time.
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3.3.30    PS
3.3.30  PS
The Protection Switch (PS) condition occurs when the traffic switches from a working/active card to a 
protect/standby card. 

3.3.31  RMON-ALARM
The RMON Threshold Crossing Alarm (RMON-ALARM) condition occurs when the remote monitoring 
variable crosses the threshold.

3.3.32  RMON-RESET 
The RMON Histories and Alarms Reset Reboot (RMON-RESET) condition occurs when the 
time-of-day settings on the TCC2/TCC2P card are increased or decreased by more than five seconds. 
This invalidates all the history data and remote monitoring (RMON) must restart. It can also occur when 
you reset a card.

3.3.33  SFTWDOWN-FAIL
The Software Download Failed (SFTDOWN-FAIL) condition occurs when the system fails to download 
the required software.

An incorrect input that points to the wrong place or file, network issues, or a bad (corrupt) package can 
cause this failure. Retrying the operation with the correct name/location will usually succeed. If network 
issues persist, you must contact the network lab support. If the package is corrupt, contact Cisco TAC. 
See the “Obtaining Documentation and Submitting a Service Request” section on page xliv for details.

3.3.34  USER-LOCKOUT
The User Locked Out (USER-LOCKOUT) condition occurs when the system locks an account because 
of a failed login attempt. To proceed, the administrator must unlock the account or the lockout time must 
expire.

3.3.35  USER-LOGIN
The Login of User (USER-LOGIN) occurs when you begin a new session by verifying your User ID and 
password.

This transient condition does not result in a standing condition.

3.3.36  USER-LOGOUT
The Logout of User (USER-LOGOUT) condition occurs when you stop a login session by logging out 
of your account.

This transient condition does not result in a standing condition.
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3.3.37    WORK-QUEUE-FULL
3.3.37  WORK-QUEUE-FULL
The Work Queue Full(WORK-QUEUE-FULL) condition occurs when the netTask Queue in VxWorks 
has filled up and task operations for the card are postponed.

This transient condition does not result in a standing condition.

3.3.38  WKSWBK
The Switched Back to Working (WKSWBK) condition occurs when traffic switches back to the working 
port/card in a non-revertive protection group.

This transient condition does not result in a standing condition.

3.3.39  WKSWPR
The Switched to Protection (WKSWPR) condition occurs when traffic switches to the protect port/card 
in a non-revertive protection group. This transient condition does not result in a standing condition. The 
(WKSWPR) is raised as a standing condition in a revertive protection group.

The Switched to Protection (WKSWPR) condition also occurs after the protection switch in a 1+1 
non-revertive protection group as a transient condition. When the protection group is changed to 
revertive, the (WKSWPR) is not raised as a standing condition or as a new transient condition. However, 
after a protection switch in a 1:1 protection group, the user will not be allowed to configure the protection 
group from non-revertive to revertive.

3.3.40  WTR-SPAN 
The Span is in Wait To Restore State (WTR-SPAN) condition occurs when a BLSR switches to another 
span due to a Signal Failure-Span command or a fiber is pulled from a four-fiber BLSR configuration. 
The condition is raised until the WaitToRestore (WTR) period expires. 

This transient condition clears when the BLSR returns to a normal condition or the IDLE state.
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C H A P T E R 4

Error Messages

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter lists the Cisco ONS 15454, Cisco 15454 SDH, Cisco ONS 15600, Cisco 15600 SDH, 
Cisco ONS 15310-CL, and Cisco ONS 15310-MA error messages. The error dialog box in Figure 4-1 
consists of three parts: the error title, error ID, and error message. The table lists two types of messages: 
error messages (EID-nnnn) and warning messages (WID-nnnn). Error messages are alerts that an 
unexpected or undesirable operation has occurred which either indicates the risk of loss of traffic or an 
inability to properly manage devices in the network. Warnings are alerts that the requested operation 
could lead to an error. Warnings are sometimes used to convey important information.

Figure 4-1 Error Dialog Box

Table 4-1 gives a list of all error or warning message numbers, the messages, and a brief description of 
each message.

12
46

87

Error Title Error Message

Error ID
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Table 4-1 Error Messages 

Error Warning 
ID Error Warning Message Description

EID-0 Invalid error ID. The error ID is invalid.

EID-1 A null pointer encountered in {0}. Cisco Transport Controller (CTC) 
encountered a null pointer in the area 
described by the specified item.

EID-1000 The host name of the network element cannot be resolved to an 
address.

Refer to the error message text.

EID-1001 Unable to launch CTC due to applet security restrictions. 

Please review the installation instructions to make sure that the 
CTC launcher is given the permissions it needs. 

Note that you must exit and restart your browser in order for the 
new permissions to take effect.

Refer to the error message text.

EID-1002 The host name (e.g., for the network element) was successfully 
resolved to its address, but no route can be found through the 
network to reach the address. 

The node is not reachable from CTC client 
station.

EID-1003 An error was encountered while attempting to launch CTC. 
{0}

Unexpected exception or error while 
launching CTC from the applet.

EID-1004 Problem Deleting CTC Cache: {0} {1} Unable to delete the CTC cached JARs, 
because another application may have the 
JAR files running; for example, another 
instance of CTC.

EID-1005 An error occurred while writing to the {0} file. CTC encountered an error while writing to 
log files, preference files, etc.

EID-1006 The URL used to download {0} is malformed. The URL used to download the specified 
JAR file is incorrect.

EID-1007 An I/O error occurred while trying to download {0}. An input or output exception was 
encountered when CTC tried to download 
the specified JAR file.

EID-1018 Password shall not contain the associated user-ID. The password is invalid. 

EID-1019 Could not create {0}. 
Please enter another filename.

CTC could not create the file due to an 
invalid filename. 

EID-1020 Fatal exception occurred, exiting CTC. 
Unable to switch to the Network view.

CTC was unable to switch from the node or 
card view to the network view and is now 
shutting down.

EID-1021 Unable to navigate to {0}. CTC could not display the requested view 
(node or network).

EID-1022 An IOS session cannot be opened right now with this slot. Most 
likely someone else (using a different CTC) already has a 
session opened with this slot. Please try again later. 

Refer to the error message text.

Ensure that the shell access in CTC 
(Provisioning>Security>Access) is set to 
non-secure mode.
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EID-1023 This IOS session has been terminated. 
Terminations are caused when the session has timed out, the 
card resets, there is already a session with the slot, or password 
configuration is required. 

Refer to the error message text.

EID-1025 Unable to create Help Broker. CTC was unable to create the help broker 
for the online help.

EID-1026 Error found in the Help Set file. CTC encountered an error in the online help 
file.

EID-1027 Unable to locate help content for Help ID: "{0}". CTC was unable to locate the content for 
the help ID.

EID-1028 Error saving table. {0} There was an error while saving the 
specified table.

EID-1031 CTC cannot locate the online user manual files. The files may 
have been moved, deleted, or not installed. To install online 
user manuals, run the CTC installation wizard on the software 
or documentation CD.

Refer to the error message text.

EID-1032 CTC cannot locate Acrobat Reader. If Acrobat Reader is not 
installed, you can install the Reader using the CTC installation 
wizard provided on the software or documentation CD.

Refer to the error message text.

EID-1035 CTC experienced an I/O error while working with the log files. 
Usually this means that the computer has run out of disk space. 
This problem may or may not cause CTC to stop responding. 
Ending this CTC session is recommended, but not required.

Refer to the error message text.

WID-1036 WARNING: Deleting the CTC cache may cause any CTC 
running on this system to behave in an unexpected manner.

Refer to the warning message text.

EID-1037 Could not open {0}. Please enter another filename. Invalid file name. CTC is unable to open the 
specified file. Ensure that the file exists and 
the filename was typed correctly.

EID-1038 The file {0} does not exist. The specified file does not exist.

EID-1039 The version of the browser applet does not match the version 
required by the network element. Please close and restart your 
browser in order to launch the Cisco Transport Controller.

Refer to the error message text.

WID-1041 An error occurred while closing the {0} connection. CTC encountered an error while closing the 
specified connection.

WID-1042 You have selected Java version {0}. 
This version is outside of the recommended range and may 
cause an unpredictable behavior of the software. 
Do you wish to continue? 

Refer to the warning message text.

EID-1043 Error writing to file: {0}. 
This might be caused by a directory permission, quota or disk 
volume full issue. 

Check for possible causes and try again.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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WID-1044 Warning: there is a discrepancy in the build timestamp between 
the NE cached jar file ({0}) and the NE ({1}). 
Your CTC jar cache should be emptied. 

Refer to the warning message text.

EID-1046 Selected CTC version ({0}) must be greater than or equal{to 
the login NE version ({1}). 

The CTC software version must be greater 
than or equal to the software version on the 
node being managed.

EID-2001 No rolls were selected. {0} No rolls were selected for the bridge and 
roll.

EID-2002 The roll must be completed or canceled before it can be deleted. You cannot delete the roll unless it has been 
completed or cancelled.

EID-2003 An error occurred while deleting the roll. 
{0}

There was an error when CTC tried to delete 
the roll.

EID-2004 No Cisco IOS slot was selected. You did not select a Cisco IOS slot.

EID-2005 CTC cannot find the online help files for {0}. 
The files might have been moved, deleted, or not installed. 
To install online help, run the setup program on the software 
CD.

CTC cannot find the online help files for the 
specified window. The files might have 
been moved, deleted, or not installed. To 
install online help, run the setup program on 
the software CD. 

EID-2006 An error occurred while editing the circuit(s). 
{0} 
{1}. 

An error occurred when CTC tried to open 
the circuit for editing.

EID-2007 The preferences could not be saved. CTC cannot save the preferences.

EID-2008 The circuit preferences could not be saved: 
{0} 

CTC cannot find the file needed to save the 
circuit preferences.

EID-2009 CTC was unable to download the package: 
{0} 

Refer to the error message text.

EID-2010 An error occurred while deleting the destination. CTC could not delete the destination.

EID-2011 The circuit could not be destroyed. CTC could not destroy the circuit.

EID-2012 The reverse circuit could not be destroyed. CTC could not reverse the circuit destroy.

EID-2013 The circuit creation failed. 
The circuit creation cannot proceed due to changes in the 
network which affected the circuit(s) being created. 
The dialog box will close. Please try again. 

Refer to the error message text.

EID-2014 No circuit(s) were selected. 
{0} 

You must select a circuit to complete this 
function.

EID-2015 The circuit {0} cannot be deleted because it has one or more 
rolls. 

You must delete the rolls in the circuit 
before deleting the circuit itself.

EID-2016 The circuit deletion failed. CTC could not delete the tunnel as there are 
circuits that use the tunnel.

EID-2017 An error occurred while mapping the circuit. 
{0} 

There was an error mapping the circuit.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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EID-2018 The circuit roll failed. 
The circuit must be in the DISCOVERED state in order to 
perform a roll. 

There was a failure in circuit roll. Change 
the circuit state to DISCOVERED and 
proceed.

EID-2019 The circuit roll failed. 
Bridge and roll is not supported on DWDM circuits. 

Refer to the error message text.

EID-2020 The circuit roll failed. 
The two circuits must have the same direction. 

Refer to the error message text.

EID-2021 The circuit roll failed. 
The two circuits must have the same size. 

Refer to the error message text.

EID-2022 The circuit roll failed. 
A maximum of two circuits can be selected for a bridge and roll 
operation. 

Refer to the error message text.

EID-2023 CTC was unable to create a new user account. Refer to the error message text.

EID-2024 An error occurred during node selection. There was an error during node selection.

EID-2025 This feature cannot be used. Verify that each endpoint of this 
circuit is running software that supports this feature. 

Refer to the error or warning message text. 
For example, this error is generated from 
the node view Provisioning> WDM-ANS> 
tabs to indicate that the selected ring type is 
not supported by the endpoints of the 
circuit. Another example is the 
Provisioning> VLAN tabs in card view 
(Ethernet card only), where it indicates that 
the back-end spanning tree protocol (STP) 
disabling is not supported.

EID-2026 The {0} request could not be applied. 
{1} 

Error occurred while attempting to switch a 
path protection.

EID-2027 An error occurred while deleting the circuit drop. CTC could not delete the circuit drop.

EID-2028 An error occurred while removing the circuit node. CTC could not remove the circuit node.

EID-2029 The requested operation is not supported. The task you are trying to complete is not 
supported by CTC.

EID-2030 An error occurred during provisioning. There was an error during provisioning.

EID-2031 An error occurred while adding the node. There was an error while adding a node. 

EID-2032 The circuit could not be renamed. 
{0} 

CTC could not rename the circuit.

EID-2033 An error occurred during validation. 
{0} 

There was an internal error while validating 
the user changes after the Apply button was 
pressed. This error can occur in the Edit 
Circuit dialog box or in the BLSR table in 
the shelf view (rare condition).

EID-2034 Network circuits could not be added: 
{0} 

Refer to the error message text.

EID-2035 The source and destination nodes are not connected. Refer to the error message text.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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EID-2036 The {0} cannot be deleted. 
LAN Access has been disabled on this node and this {0} is 
needed to access the node. 

You cannot delete the DCC/GCC link as it 
is needed to access the node.

EID-2037 The attribute for {0} cannot be found. CTC cannot find an attribute for the 
specified item.

EID-2038 The protection operation is invalid. The protection operation you tried to 
execute is invalid.

EID-2040 Please select a node first. You must select a node before performing 
the task.

EID-2041 No paths are available on this link. Please make another 
selection.

You must select a link that has paths 
available.

EID-2042 This span is not selectable. Only the green spans with an arrow 
may be selected.

Refer to the error message text.

EID-2043 This node is not selectable. Only the source node and nodes 
attached to included spans (blue) are selectable. Selecting a 
selectable node will enable its available outgoing spans.

Refer to the error message text.

EID-2044 This link may not be included in the required list. Constraints 
only apply to the primary path. Each node may have a 
maximum of one incoming signal and one outgoing link.

You must select only one link going in and 
out of a node. Selecting more than one link 
is contradictory to the path selection 
algorithm.

EID-2045 This link may not be included in the required list. Only one 
outgoing link may be included for each node.

Refer to the error message text.

EID-2047 Please enter a valid value for the slot number. There was an error due to an invalid slot 
number.

EID-2048 Please enter a valid value for the port number. There was an error due to an invalid port 
number.

EID-2050 The new circuit could not be destroyed. CTC could not destroy the new circuit.

EID-2051 The circuit cannot be downgraded. 
{0} 

The specified circuit cannot be 
downgraded.

EID-2052 An error occurred during circuit processing. There was an error during the circuit 
processing.

EID-2054 An error occurred while selecting an endpoint. There was an error during the endpoint 
selection.

EID-2055 No endpoints are available for this selection. Please make 
another selection.

This error occurs in the circuit creation 
dialog only during a race condition that has 
incorrectly allowed entities without 
endpoints to be displayed in the 
combination boxes.

EID-2056 A communication error occurred: {0} An internal error occurred in Network 
Alarm tab while synchronizing alarms with 
the nodes.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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EID-2059 An error occurred while deleting the node. 
{0} 

There was an error during the node deletion.

EID-2060 No PCA circuits were found. CTC could not find any protection channel 
access (PCA) circuits for this task.

EID-2061 An error occurred while provisioning the VLAN. There was an error defining the VLAN.

EID-2062 An error occurred while deleting VLANs. 
No VLAN(s) were selected.  
Please select a VLAN. 

Refer to the error message text.

EID-2063 The default VLAN cannot be deleted. The selected VLAN is the default VLAN 
and cannot be deleted.

EID-2064 An error occurred while deleting VLANs. 
{0} 

There was an error deleting the specified 
VLAN.

EID-2065 The profile cannot be imported. 
The profile "{0}" exists in the editor and the maximum number 
of copies (ten) exists in the editor.  
The import will be aborted. The profile has already been loaded 
eleven times. 

Cannot import the profile because the 
profile has reached the maximum number of 
copies in the editor.

EID-2066 The profile could not be stored. 
An error occurred while writing to {0}. 

CTC encountered an error while trying to 
store the profile. 

EID-2067 An error occurred while writing to the file. 
{0} 

CTC encountered an error while writing the 
specified file.

EID-2068 The alarm profile could not be loaded from the node. CTC encountered an error trying to load the 
alarm profile from the node.

EID-2069 The file could not be found or an I/O exception occurred. 
{0} 

Either the specified file was not found, or 
there was an input/output exception.

EID-2070 The profile could not be deleted. 
{0} 

There was a failure in deleting the specified 
profile.

EID-2071 Only one column may be highlighted. You cannot select more than one column 
during clone action.

EID-2072 Only one profile may be highlighted. You cannot select more than one profile.

EID-2073 This column is permanent and cannot be removed. You cannot delete a permanent column.

EID-2074 Select one or more profiles. You have not selected any profile or 
column. Reset operation is done by 
right-clicking the selected column.

EID-2075 This column is permanent and cannot be reset. Refer to the error message text.

EID-2077 This column is permanent and cannot be renamed. Refer to the error message text.

EID-2078 At least two columns must be highlighted. You cannot compare two profiles unless you 
select two columns.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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EID-2079 The alarm types cannot be loaded into table. 
There are no reachable nodes from which the list of alarm types 
can be loaded. 
Please wait until such a node is reachable and try again. 

Refer to the error message text.

EID-2080 The node {0} has no profiles. The specified node does not have any 
profiles.

EID-2081 An error occurred while removing profile {0} from the node 
{1}. 

There was an error while removing the 
specified profile from the specified node.

EID-2082 The profile {0} does not exist on the node {1}. CTC cannot find the specified profile from 
the specified node.

EID-2083 An error occurred while adding profile {0} to the node {1}. There was an error adding the specified 
profile to the specified node.

EID-2085 The profile selection is invalid. 
No profiles were selected. 

You tried to select an invalid profile. Select 
another profile.

EID-2086 The node selection is invalid. 
No nodes were selected. 

You tried to select an invalid node. Select 
another node.

EID-2087 No profiles were selected. 
Please select at least one profile. 

Refer to the error message text.

EID-2088 The profile name is invalid. The profile name cannot be empty.

EID-2089 Too many copies of {0} exist. Please choose another name. Select a unique name.

EID-2090 No nodes were selected. 
Please select the node(s) on which to store the profile(s). 

You must select one or more nodes on 
which you can store the profile.

EID-2091 Unable to switch to the node {0}. CTC is unable to switch to the specified 
node.

EID-2092 A general exception error occurred. CTC encountered a general exception error 
while trying to complete the task.

EID-2093 The name is too short. It does not have enough characters. 
{0} 

The name must have a minimum of six 
characters.

EID-2094 The password and confirmed password fields do not match. You must make sure the two fields have the 
same password.

EID-2095 The password is invalid. 
{0} 

The password you entered is not allowed.

EID-2096 The user must have a security level. You must have an assigned security level to 
perform this task.

EID-2097 No user name was specified. You did not specify a user name.

EID-2099 An error occurred while ring switching. There was an error during the ring switch.

EID-2100 Please select at least one profile to delete. You have not selected the profile to delete.

EID-2101 An error occurred while protection switching. There was an error during the protection 
switching.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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EID-2102 The forced switch could not be removed for some circuits. You 
must switch these circuits manually.

The forced switch could not be removed for 
some circuits. You must switch these 
circuits manually.

EID-2103 An error occurred while upgrading the span. There was an error during the span upgrade.

EID-2104 The circuits cannot be switched back because one or both nodes 
are not reachable. 

This error occurs during the path protection 
span upgrade procedure.

EID-2106 The node name cannot be empty. You must supply a name for the node.

EID-2107 An error occurred while adding {0}. The host is unknown. There was an error adding the specified 
item.

EID-2108 {0} is already in the network. The specified item exists in the network.

EID-2109 The node is already in the current login group. The node you are trying to add is already 
present in the current login group.

EID-2110 Please enter a number between 0 and {0}. You must enter a number in the range 
between 0 and the specified value.

EID-2111 This node ID is already in use. Please choose another. Select a node ID that is not in use.

EID-2113 The extension byte for the ring cannot be set. 
{0} 

CTC cannot set the BLSR/MS-SPRing 
extension byte.

EID-2114 A card communication failure occurred during the operation. This error can occur during an attempt to 
apply a BLSR protection operation to a line.

EID-2115 An error occurred during the operation. 
{0} 

There was an error in applying the specified 
operation.

EID-2116 The extension byte setting for the ring is invalid. 
{0} 

The extension byte set for the specified ring 
is invalid.

EID-2118 The ring cannot be deleted. 
A protection operation is set. All protection operations must be 
clear for ring to be deleted. 

Clear all the protection operations for the 
ring before deleting it.

EID-2119 {0} cannot be deleted because a protection switch is in effect. 
Please clear any protection operations, ensure that the reversion 
time is not "never" and allow any protection switches to clear 
before trying again. 

Clear all protection operations or switches 
before deleting the ring.

EID-2120 The following nodes could not be unprovisioned  
{0} 
Therefore you will need to delete this {1} again later.

The specified nodes could not be 
unprovisioned. Try deleting this BLSR or 
MS-SPRing later.

EID-2121 The ring cannot be upgraded. 
{0} 

CTC cannot upgrade the specified ring.

EID-2122 The ring speed for is inadequate for the upgrade procedure. 
Only {0} (or higher) {1} can be upgraded to four-fiber. 

You have selected an incorrect ring speed 
for upgrade. Only rings within the specified 
parameters can be upgraded to 4-fiber 
BLSR.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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EID-2123 Verify that the following nodes have at least two in-service 
ports with the same speed as the two-fiber {0}. The ports cannot 
serve as timing references, and they cannot have DCC 
terminations or overhead circuits. 
{1} 

Nonupgradable nodes. Verify that the 
specified nodes have at least two IS-NR 
ports with the same speed as the 2-fiber 
BLSR. 
The specified ports cannot serve as a timing 
reference, and they cannot have data 
communications channel (DCC) 
terminations or overhead circuits.

EID-2124 You cannot add this span because it is connected to a node that 
already has the east and west ports defined.

Refer to the error message text.

EID-2125 You cannot add this span as it would cause a single card to host 
both the east span and the west span. A card cannot protect 
itself.

Refer to the error message text.

EID-2126 An error occurred while provisioning the OSPF area. 
{0} 

There is an Open Shortest Path First (OSPF) 
area error.

EID-2127 You cannot add this span. It would cause the following 
circuit(s) to occupy different {0} regions on different spans: 
{1}

Either select a different span or delete the above circuit(s). 

A circuit cannot occupy different STS 
regions on different spans. You may add a 
different span or delete the specified circuit.

EID-2128 The state is invalid. An internal error occurred while trying to 
remove a span from a BLSR.

This alarm occurs in the network-level 
BLSR creation dialog box.

EID-2129 You cannot use same slot for east and west protect ports. Refer to the error message text.

EID-2130 The ring ID value, {0}, is not valid. Please enter a valid number 
between 0 and 9999.

Enter a ring ID value between 0 and 9999.

EID-2131 The reversion cannot be set to INCONSISTENT. You must select another reversion type.

EID-2135 The overhead circuit preferences could not be stored: 
{0} 

Input/Output error. Unable to store 
overhead circuit preferences. 

EID-2137 An error occurred during the circuit merge. 
{0} 

There was an error while merging the 
circuits.

EID-2138 Not all destinations could be deleted. 
Please try again. 

Refer to the error message text.

EID-2139 An error occurred while updating the destinations. There was an error in updating the circuit 
destinations.

EID-2143 No online help version was selected. 
The online help book cannot be deleted. 

Select the version of online help, and 
proceed.

EID-2144 An error occurred while deleting the online help book(s). 
{0} 

You cannot delete the specified online help.

EID-2145 No nodes appear to have a Cisco IOS card. Refer to error message.

EID-2146 This is a security violation. 
You may only logout of your own account. 

You cannot logout of an account other than 
your own.
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EID-2147 This is a security violation. 
You may only change your own account. 

You cannot change an account other than 
your own.

EID-2148 This is a security violation. 
You cannot delete the account under which you are currently 
logged in. 

You cannot delete the account you are 
currently logged in.

WID-2149 There is no exportable content in this view. Refer to the error message text.

WID-2150 The node {0} is not initialized. 
Please wait and try again. 

Wait till the specified node is initialized and 
try again.

WID-2152 Spanning tree protection is being disabled for this circuit. Refer to the warning message text.

WID-2153 Adding this drop will make the circuit a PCA circuit. Refer to the warning message text.

WID-2154 Monitor circuits cannot be created on a port grouping circuit. Refer to the warning message text.

WID-2155 Switch counts might not be fully supported on some nodes. 
{0} 

The specified nodes do not support switch 
counts completely.

WID-2156 The manual roll mode is recommended for dual rolls. 
For auto dual rolls, please verify that roll to facilities are in 
service and error-free. 

Refer to the warning message text.

WID-2157 The roll(s) cannot be completed. 
{0} 

CTC could not complete the roll because 
the roll is destroyed, in an incomplete state, 
in a TL1_roll state, is cancelled, or is not 
ready to complete.

EID-2158 The roll mode is invalid. 
{0} 

There are two roll modes: auto and manual. 
For a one-way circuit source roll, the roll 
mode must be auto and for a one- way 
circuit destination roll, the roll mode must 
be manual.

EID-2159 The roll is not ready for completion. 
{0} 

The roll is not ready for completion.

EID-2160 The roll is not connected. 
{0} 

Refer to error message text.

EID-2161 The sibling roll is not complete. 
{0} 

One of the rolls is not completed for the 
dual roll. If it is auto roll, it will be 
completed when a valid signal is detected. 
If it is a manual roll, you must complete the 
roll from CTC if Bridge and Roll is 
operated from CTC, or from TL1 if Bridge 
and Roll is operated from TL1.

EID-2162 An error occurred during roll acknowledgement. 
{0} 

Refer to the error message text.

EID-2163 The roll cannot be canceled. 
{0} 

CTC cannot cancel the roll.

EID-2164 An error occurred during the roll. 
{0} 

CTC encountered a roll error.
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WID-2165 The MAC address of the node {0} has been changed. All 
circuits originating from or dropping at this node will need to 
be repaired.

Repair the circuits that originate from or 
drop at the specified node, with the new 
MAC address.

WID-2166 The node cannot be inserted into the domain because it is not 
initialized. 

Initialize the node and proceed.

WID-2167 You have insufficient security privileges to perform this action. You do not have the privilege to perform 
this action.

WID-2168 The following warnings surfaced while loading {0}. 
{1} 

CTC encountered warnings while loading 
the alarm profile import file.

WID-2169 One or more of the profiles selected do not exist on one or more 
of the nodes selected.

The profile selected does not exist on the 
node. Select another profile.

WID-2170 The profile list on node {0} is full. Please delete one or more 
profiles if you wish to add the profile. 
{1}

The number of profile that can exist on a 
node has reached the limit. To add a profile, 
delete any of the existing profiles.

WID-2171 You have been logged out. Click OK to exit CTC. Refer to the warning message text.

WID-2172 The CTC CORBA (IIOP) listener port setting of {0} will be 
applied on the next CTC restart.

The Internet Inter-ORB Protocol (IIOP) 
listener port setting for the CTC Common 
Object Request Broker Architecture 
(CORBA) will be applied on the next CTC 
restart.

EID-2173 The port is unavailable. 
The desired CTC CORBA ({0}) listener port, {1}, is already in 
use or you do not have permission to listen on it. Please select 
an alternate port. 

Select an alternate port, as the current port 
is either in use or you do not have enough 
permission on it.

EID-2174 An invalid number was entered. Please check it and try again. You entered an invalid firewall port number. 
Try again.

WID-2175 An extension byte mismatch occurred. 
{0} 

There is a mismatch with the extension 
byte.

WID-2176 Not all spans have the same OSPF area ID. 
This will cause problems with protection switching. To 
determine the OSPF area for a given span, click on the span and 
the OSPF area will be displayed in the pane to the left of the 
network map. 

Refer to the warning message text.

WID-2178 Only one edit pane can be opened at a time. The existing pane 
will be displayed. 

Refer to the warning message text.

WID-2179 No update is available because the circuit has been deleted. Refer to the warning message text.

EID-2180 The CTC initialization failed during step {0}. CTC initialization has failed in the specified 
step.

EID-2181 This link cannot be included because it originates from the 
destination. 

You must not include this link as it 
originates from destination of a circuit. It is 
against the path selection algorithm.

EID-2182 The value of {0} is invalid. The value of the specified item is invalid.
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EID-2183 The circuit roll failed. 
Bridge and roll is not supported on VCAT circuits. 

Refer to the error message text.

EID-2184 Spanning Tree Protocol cannot be enabled on some ports 
because the ports have been assigned an incompatible list of 
VLANs. 
You can view the VLAN/Spanning Tree table or reassign the 
Ethernet port VLANs. 

Refer to the error message text.

EID-2185 The VLANs on some ports cannot be assigned because they are 
incompatible with the Spanning Tree Protocol. 
You can view the VLAN/Spanning Tree table or reassign the 
VLANs. 

Refer to the error message text.

EID-2186 The software download failed on node {0}. The software could not be downloaded onto 
the specified node.

EID-2187 The ring name cannot exceed {0} characters. 
Please try again. 

You must shorten the length of the ring 
name.

EID-2188 The nodes in this ring do not support alphanumeric IDs. Please 
use a ring ID between {0} and {1}.

The ring ID should not contain 
alphanumeric characters, and must be in the 
specified range.

EID-2189 The TL1 keyword "all" cannot be used as the ring name. 
Please provide another name.

Refer to the error message text.

EID-2190 Adding this span will cause the ring to contain more nodes than 
allowed.

You have reached the maximum number of 
nodes allowed. 

EID-2191 The ring name must not be empty. You must supply a ring name.

EID-2192 A valid route cannot be found for the circuit creation request. CTC could not complete the circuit creation 
request either because there are no physical 
links, or the bandwidth of the available 
links are already reserved.

EID-2193 A valid route cannot be found for the circuit drop creation 
request. 

Refer to the error message text.

EID-2194 A valid route cannot be found for the roll creation request. Refer to the error message text.

EID-2195 The circuit VLAN list cannot be mapped to one spanning tree. 
You can view the VLAN/Spanning Tree table or reassign 
VLANs.

Refer to the error message text.

EID-2196 CTC cannot be relaunched. 
{0} 

There is an error relaunching CTC.

EID-2197 A CORBA failure occurred. CTC cannot proceed. There was a CORBA failure, and the task 
cannot proceed. Verify the Java version. 

EID-2198 CTC is unable to switch to the {0} view. CTC is unable to switch to the specified 
view.

EID-2199 Login failed on {0} {1} The login failed on the specified tasks.

Table 4-1 Error Messages (continued)
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EID-2200 CTC has detected a jar file deletion. The jar file was used to 
manage one or more nodes. This CTC session will not be able 
to manage those nodes and they will appear gray on the network 
map. It is recommended that you exit this CTC session and start 
a new one.

Refer to the error message text.

EID-2202 An intra-node DRI circuit must have two sources. Intranode circuit must have two sources to 
be a dual ring interconnect (DRI).

EID-2203 No member was selected. You must select a member.

EID-2204 The number of circuits must be a positive integer. The number of circuits cannot be zero or 
negative.

EID-2205 The circuit type must be selected. You must select a circuit type.

EID-2206 The profile cannot be autoselected. Please select profile(s) to 
store and try again. 

Refer to the error message text.

EID-2207 You cannot add this span. Either the ring name is too long (that 
is, ring name length is greater than {0}) or the endpoints do not 
support alphanumeric IDs. 

Reduce the length of the ring name, or 
remove the alphanumeric characters from 
the end points.

EID-2208 This is an invalid or unsupported JRE. The version of Java Runtime Environment 
(JRE) is either invalid or unsupported. 

EID-2209 The user name must be at least {0} characters long. The user name must be at least of the 
specified character length.

EID-2210 No package name was selected. You must select a package name.

EID-2211 No node was selected for upgrade. You must select a node for the upgrade.

EID-2212 A protected line is not provisionable. The protected line cannot be provisioned. 
Choose another line.

WID-2213 The current type or state of some drops does not allow the new 
circuit state of {0} to be applied to them indirectly.

The circuit state, specified by {0} cannot be 
applied to the selected drops.

EID-2214 The node is disconnected. Please wait until the node 
reconnects.

Refer to the error message text.

EID-2215 An error occurred while leaving the {0} page. There was an error while leaving the 
specified page.

EID-2216 An error occurred while entering the {0} page. There was an error while entering the 
specified page.

EID-2217 Some conditions could not be retrieved from the network view Refer to the error message text.

EID-2218 The bandwidth must be between {0} and {1} percent. The bandwidth must be within the specified 
parameters.

EID-2219 The protection operation failed. An XC loopback was applied 
on the cross-connection. 

As the protection operation failed, a 
cross-connect (XC) loopback will be 
applied on cross-connection.

EID-2220 The tunnel status is PARTIAL. CTC is not able to change it. 
Please try again later.

Refer to the error message text.
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EID-2221 A valid route cannot be found for the unprotected to {0} 
upgrade request. 

Refer to the error message text.

EID-2222 One or more of the following nodes are currently part of a 
four-fiber {0}. Only a single four-fiber {0} is supported per 
node. 
{1} 

The nodes, specified by {1}, are already 
part of a 4-fiber BLSR/MS-SPRing type 
(specified by {0}).

EID-2223 Only one circuit can be upgraded at a time. Refer to the error message text.

EID-2224 This link may not be included because it terminates on the 
source. 

Refer to the error message text.

EID-2225 A valid signal could not be detected while trying to complete 
the roll. 
{0} 

Roll can be completed only when a valid 
signal is detected. If not, the roll completion 
may result in an error.

EID-2226 The circuit roll failed. 
{0} 

Refer to the error message text.

EID-2320 This VCAT circuit does not support deletion of its member 
circuits.

You can not delete a circuit that is a member 
of VCAT circuit.

EID-2321 An error occurred while deleting member circuits.  
{0} 

Refer to the error message text.

WID-2322 Not all cross-connects from selected circuits could be merged 
into the current circuit. They might appear as partial circuits.

Refer to the warning message text.

EID-2323 The circuit roll failed. 
Bridge and roll is not supported on monitor circuits. 

A monitor circuit does not support Bridge 
and Roll.

EID-2324 An error occurred during the circuit upgrade. 
{0} 

Refer to the error message text.

EID-2325 You have failed {0} times to unlock this session. CTC will exit 
after you click OK or close this dialog box.

The maximum amount of attempts to 
unlock this session has been reached.

WID-2326 Currently, CTC does not support bridge and roll on circuits that 
are entirely created by TL1. To continue with bridge and roll in 
CTC, the selected circuits must be upgraded. 
Is it OK to upgrade the selected circuits and continue the bridge 
and roll operation? 

Refer to the warning message text.

WID-2327 Currently, CTC does not support bridge and roll on circuits that 
are partially created by TL1. To continue with bridge and roll 
in CTC, the selected circuits must be upgraded. 
Is it OK to upgrade the selected circuits and continue the bridge 
and roll operation? 

Refer to the warning message text.

EID-2328 An error occurred during the circuit reconfiguration. 
{0} 

The attempt to reconfigure the specified 
circuit has failed.

EID-2329 {0} of {1} circuits could not be successfully created. A few circuits could not be created.

EID-2330 An error occurred during circuit verification. The selected {0} 
is invalid! 
{1} 

The selected item, specified by {0}, is 
invalid as per the details, specified in {1}.
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EID-2331 Deleting {0} might be service affecting. Deleting the item can affect the service of 
CTC.

EID-2332 A validation error occurred in row {0}. 
{1} hold-off timer for {2} must be between {3}-10,000 ms, in 
steps of 100 ms.

Refer to the error message text.

EID-3001 An Ethernet RMON threshold with the same parameters 
already exists. Please change one or more of the parameters and 
try again.

Change a few parameters in an Ethernet 
remote monitoring (RMON) threshold and 
try again.

EID-3002 An error occurred while retrieving defaults from the node: {0} There was an error while retrieving the 
defaults from the specified node.

EID-3003 The file {0} cannot be loaded. CTC cannot load the specified file.

EID-3004 Properties cannot be loaded from the node. Refer to the error message text.

EID-3005 NE update properties cannot be saved to the file {0}. CTC cannot save the network element (NE) 
update values to the specified file.

EID-3006 NE update properties cannot be loaded from the node. Refer to the error message text.

EID-3007 An error occurred while provisioning the {0}. There was a provisioning error for the 
specified item.

EID-3008 This is not a valid card. You cannot perform DWDM automatic 
node setup (ANS) from the Card view. 
Please navigate to the Node view and try 
again.

EID-3009 No {0} was selected. Select the specified item, for example, 
VLAN, port, slot, etc.

EID-3010 A bidirectional optical link could not be created. Refer to the error message text.

EID-3016 The subnet address is invalid. Refer to the error message text.

EID-3017 The subnet address already exists. Refer to the error message text.

EID-3019 The internal subnet address is incomplete. Enter the complete internal subnet address.

EID-3020 The subnet address cannot be the same for both TSC cards. 
The requested action is not allowed. 

A node’s internal subnet must be different 
from one another as each TSC is on separate 
ethernet buses, isolated by broadcast 
domains.

EID-3021 An error occurred while retrieving the diagnostics: 
{0} 

Refer to the error message text.

EID-3022 The requested action is not allowed. The requested action is not allowed.

EID-3023 The low order cross-connect mode could not be retrieved. Refer to the error message text.

EID-3024 The {0} cross-connect mode could not be switched. 
Please verify that the type and/or number of circuits 
provisioned does not exceed the criterion for switching modes.

CTC cannot switch the cross-connect mode 
for the specified item, as the type or the 
number of circuits does not match with the 
criterion for switching modes.

EID-3025 An error occurred while retrieving thresholds. There was an error retrieving the thresholds.
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EID-3026 The send DoNotUse attribute cannot be modified. You cannot modify the Send DoNotUse 
field.

EID-3027 The SyncMsg attribute cannot be modified. You cannot modify the SyncMsg field.

EID-3028 The port type cannot be changed. You cannot change the port type.

EID-3029 Unable to switch to the byte because an overhead change is 
present on this byte of the port.

Refer to the error message text.

EID-3031 An error occurred while hard-resetting the card. There was an error while resetting card 
hardware.

EID-3032 An error occurred while resetting the card. There was an error while resetting the card.

EID-3033 The lamp test is not supported on this shelf. Refer to the error message text.

EID-3035 The cross-connect diagnostics cannot be performed Refer to the error message text.

EID-3036 The cross-connect diagnostics test is not supported on this 
shelf.

The cross-connect diagnostics test is not 
supported on this shelf.

EID-3039 An error occurred while changing the card type. There was an error while changing the card.

EID-3040 The card type is invalid. The selected card type is invalid.

EID-3041 An error occurred while applying changes. CTC is unable to create a protection group. 
Check if the protect port supports circuits, a 
timing reference, SONET SDCC, 
orderwire, or a test access point.

EID-3042 The flow control low value must be less than the flow control 
high value for all ports in the card.

Refer to the error message text.

EID-3046 The flow control watermark value must be between {0} and 
{1}, inclusive.

The flow control watermark value must be 
between the two specified values.

EID-3047 The file {0} could not be read. 
Please verify the name and try again. 

Refer to the error message text.

EID-3048 There is no Cisco IOS startup configuration file available to 
download. 

CTC could not find the configuration file 
for IOS startup.

EID-3049 The download cannot be done at this time because an update in 
progress. 

Refer to the error message text.

EID-3050 An error occurred while trying to save the file to your local file 
system. 

Check whether the file already exists and 
cannot be over written, or there is a space 
constraint in the file system.

EID-3051 The configuration file has a maximum size of {0} bytes. The size of the configuration file should not 
exceed the specified number of bytes.

EID-3052 An error occurred while saving the configuration file to the 
TCC2/TCC2P. 

Refer to the error message text.

EID-3053 The value of {0} must be between {1} and {2}. The value of the item must be between the 
specified values.

EID-3054 The provisioned input/output ports cannot be removed or 
another user is updating the card. Please try to remove these 
ports later. 

Another user may be updating the card. You 
can try again later.
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EID-3055 The soak maintenance pane cannot be created. Refer to the error message text.

EID-3056 Defaults cannot be saved to the file {0}. CTC cannot save the defaults to the 
specified file.

EID-3057 Default properties cannot be loaded from the node. Refer to the error message text.

EID-3058 The file {0} does not exist. Refer to the error message text.

EID-3059 An error occurred while refreshing. There was an error while refreshing.

EID-3060 The ALS recovery pulse interval must be between {0} seconds 
and {1} seconds. 

The automatic laser shutdown (ALS) 
Recovery Interval must be between the 
specified range of seconds.

EID-3061 The ALS recovery pulse duration must be between {0} seconds 
and {1} seconds. 

The automatic laser shutdown (ALS) 
Recovery Duration must be between the 
specified range of seconds.

EID-3062 An error occurred while setting values in the table. Refer to the error message text.

EID-3064 This is not a G1000 card. This card is not a G1000-4 card.

EID-3065 An error occurred while attempting to create this RMON 
threshold: 
{0} 

You must wait some time before you try 
again.

EID-3066 The sample period must be between 10 and {0}. Refer to the error message text.

EID-3067 The rising threshold must be between 1 and {0}. This is an invalid rising threshold entry. The 
valid range is from 1 to the specified value.

EID-3068 The falling threshold must be between 1 and {0}. This is an invalid falling threshold entry. 
The valid range is from 1 to the specified 
value.

EID-3069 The rising threshold must be greater than or equal to the falling 
threshold. 

Refer to the error message text.

EID-3070 Error in data for ports {0} Exactly one VLAN must be marked 
untagged for each port. These changes will not be applied.

CTC encountered data error for the 
specified ports. Only one VLAN should be 
marked untagged for each port. 

EID-3071 An error occurred while retrieving the learned address list. Unable to retrieve the learned MAC address 
from the NE.

EID-3072 An error occurred while clearing the learned address. Failure attempting to clear the learned MAC 
address from a specific card or Ether group.

EID-3073 An error occurred while clearing the selected rows. Failure attempting to clear the learned MAC 
address from a specific card or Ether group.

EID-3074 An error occurred while clearing the learned address list by {0}. Error encountered trying to clear the 
learned MAC address from either a VLAN 
or a port.

EID-3075 At least one row in the parameter column must be selected. Refer to the error message text.

EID-3076 CTC lost its connection with this node. The NE Setup Wizard 
will exit.

Refer to the error message text.

EID-3077 No optical link was selected. Refer to the error message text.
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EID-3078 An optical link could not be created. Refer to the error message text.

EID-3079 Defaults cannot be applied to the node. {0} CTC cannot apply the defaults to the 
specified node.

EID-3080 CTC cannot navigate to the target tab. 
{0} 

CTC cannot go to the specified target tab.

EID-3081 The port type cannot be changed. Refer to the error message text.

EID-3082 The {0} extension byte cannot be changed. You cannot modify the specified extension 
byte.

EID-3084 An error occurred while retrieving laser parameters for {0}. There is no card, or there was an internal 
communications error when attempting to 
get the laser parameters for the card.

EID-3085 No OSC Terminations were selected Select an OSC termination and proceed.

EID-3086 One or more Osc terminations could not be created. Refer to the error message text.

EID-3087 The OSC termination could not be edited. Refer to the error message text.

EID-3088 No {0} card is present to switch. No card of the specified type is available to 
switch.

EID-3089 The {0} state cannot be used or changed when the {1} has 
failed or is missing. 

You cannot use or change the specified state 
when the card is failed or missing.

EID-3090 The operation cannot be performed because the {0} is 
{1}LOCKED_ON/LOCKED_OUT. 

You cannot perform operation.

EID-3091 The operation cannot be performed because the protect card is 
active. 

Refer to the error message text.

EID-3092 The requested action cannot be applied because the service 
state is invalid. 

Select another service state and proceed.

EID-3093 The operation cannot be performed because the duplex pair is 
{0}locked. 

Refer to the error message text.

EID-3094 The operation cannot be performed because no cross-connect 
redundancy is available. 

You cannot perform the requested operation 
on the cross connect card without having a 
backup cross connect card.

EID-3095 The deletion failed because the circuit is in use Refer to the error message text.

WID-3096 An internal communication error was encountered while 
retrieving laser parameters. 
This can happen when equipment is not present or when 
equipment is resetting. 
Check the equipment state and try to refresh the values again. 

Refer to the warning message text.

EID-3097 The ring termination is in use. The ring termination you are trying to 
access is in use. Try after sometime.

EID-3098 No ring terminations were selected. Select one of the ring terminations.

EID-3099 The entered key does not match the existing authentication key. Check the authentication key and reenter.
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EID-3100 An error occurred during authentication. There was an error in authentication. Verify 
that the key does not exceed the character 
limit.

EID-3101 The DCC metric must be between 1 and 65535. The DCC metric should be in the range of 1 
to 65535.

EID-3102 The DCC metric is invalid. There was an invalid DCC metric.

EID-3103 The IP address {0} is invalid}. The IP address is invalid.

EID-3104 The router priority must be between 0 and 255. The router priority should be in the range of 
0 to 255.

EID-3105 The router priority is invalid. The router priority is invalid.

EID-3106 The hello interval must be between 1 and 65535. The hello interval should be in the range of 
1 to 65535.

EID-3107 The hello interval is invalid. The hello interval is invalid.

EID-3109 The dead interval must be between 1 and 2147483647. The dead interval value must be between 1 
and 2147483647.

EID-3110 The dead interval must be larger than the hello interval. Refer to the error message text.

EID-3111 The LAN transmit delay must be between 1 and 3600 seconds. The LAN transit delay should be in the 
range of 1 to 3600 seconds.

EID-3112 The transmit delay is invalid. The transmit delay is invalid.

EID-3113 The retransmit interval must be between 1 and 3600 seconds. The retransmit interval should be in the 
range of 1 to 3600 seconds.

EID-3114 The retransmit interval is invalid. The retransmit interval is invalid.

EID-3115 The LAN metric must be between 1 and 65535. The LAN metric should be in the range of 1 
to 65535.

EID-3116 The LAN metric is invalid. The LAN metric is invalid.

EID-3117 If OSPF is active on the LAN, no DCC area IDs may be 0.0.0.0. 
Please change all DCC area IDs to non-0.0.0.0 values before 
enabling OSPF on the LAN. 

Refer to the error message text.

EID-3118 If OSPF is active on the LAN, the LAN area ID cannot be the 
same as the DCC area ID. 

LAN must be part of a different OSPF area 
other than the DCC network.

EID-3119 An error occurred during validation. CTC was unable to validate the values 
entered by the user. This error message is 
common to several different provisioning 
tabs within CTC (examples include the 
SNMP provisioning tab, the General> 
Network provisioning tab, the Security > 
Configuration provisioning tab, etc.).

EID-3120 No object of type {0} was selected for deletion. Choose an object of the specified type to 
delete.

EID-3121 An error occurred while deleting {0}. There is an error deleting the item.
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EID-3122 No object of type {0} was selected to edit. Choose an object of the specified type to 
edit.

EID-3123 An error occurred while editing {0}. There was an error editing the item.

EID-3124 The {0} termination is in use. 
Delete the associated OSPF range table entry and try again. 

Refer to the error message text.

EID-3125 No {0} terminations were selected. No specified terminations are selected.

EID-3126 The {0} termination could not be edited. CTC could not edit the specified 
termination.

EID-3127 Orderwire cannot be provisioned because the E2 byte is in use 
by {0}. 

Refer to the error message text.

EID-3128 The authentication key cannot exceed {0} characters. The authentication key cannot exceed the 
specified number of characters.

EID-3129 The authentication keys do not match! Refer to the error message text.

EID-3130 An error occurred while creating the OSPF area virtual link. CTC encountered an error while creating 
the area virtual link.

EID-3131 An error occurred while creating the OSPF virtual link. CTC encountered an error creating the 
virtual link.

EID-3132 An error occurred while setting the OSPF area range: {0}, {1}, 
false. 

CTC encountered an error while setting the 
area range for the specified values.

EID-3133 The maximum number of OSPF area ranges has been exceeded. OSPF area ranges exceeded the maximum 
number.

EID-3134 The area ID is invalid. Use the DCC OSPF area ID, LAN port 
area ID, or 0.0.0.0. 

Refer to the error message text.

EID-3135 The mask is invalid. Refer to the error message text.

EID-3136 The range address is invalid. The range address is invalid. Try again.

EID-3137 Your request has been denied because the timing source 
information was updated while your changes were still 
pending. Please retry. 

Refer to the error message text.

EID-3138 The clock source for switching is invalid. You have selected an invalid clock source. 
Choose another clock.

EID-3139 A switch cannot be made to a reference of inferior quality. Refer to the error message text.

EID-3140 A higher priority switch is already active. You cannot switch the timing source 
manually when a higher priority switch is 
already active.

EID-3141 An attempt was made to access a bad reference. Refer to the error message text.

EID-3142 No switch is active. None of the switches are active.

EID-3143 An error occurred while creating the static route entry. CTC encountered an error while a creating 
static route entry.

EID-3144 The maximum number of static routes has been exceeded. The number of static routes has exceeded its 
limit.
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EID-3145 The RIP metric must be between 1 and 15. The Routing Information Protocol (RIP) 
metric should be in the range of 1 to 15.

EID-3146 The RIP metric is invalid. Refer to the error message text.

EID-3147 An error occurred while creating the summary address. There was an error while creating the 
summary address.

EID-3148 No Layer 2 domain has been provisioned. You must provision any one of the layer 2 
domain.

EID-3149 The MAC addresses could not be retrieved. Refer to the error message text.

EID-3150 The target file {0} is not a normal file. The specified target file is not a normal file.

EID-3151 The target file {0} is not writable. The target file is not writeable. Specify 
another file.

EID-3152 An error occurred while creating the protection group. CTC encountered an error creating 
Protection Group.

EID-3153 The card cannot be deleted because it is in use. Refer to the error message text.

EID-3154 An error occurred while provisioning the card: 
CTC cannot {0} the card. 

CTC cannot perform the task on the card.

EID-3155 An error occurred while building the menu. CTC encountered an error building the 
menu.

EID-3156 An error occurred while building the menu. 
Cards were not found for the {0} group. 

CTC encountered an error while building 
the menu, as cards could not be found for 
the specified group).

EID-3157 The selected model could not be set because of an unexpected 
model class: {0}. 

CTC encountered an unexpected model 
class while trying to complete the task.

EID-3158 Probable causes: 
- Unable to switch, because a similar or higher priority 
condition exists on a peer or far-end card. 
- A loopback is present on the working port. 

Refer to the error message text.

EID-31591 An error occurred while applying the operation. CTC encountered an error while applying 
this operation.

EID-3160 An error occurred while provisioning the {0}. CTC encountered the specified error.

EID-3161 An error occurred while upgrading the ring. An error was encountered while attempting 
to upgrade the BLSR. Refer to the details 
portion of the error dialog box for more 
information.

EID-3162 This protection operation cannot be set because the protection 
operation on the other side has been changed but not yet 
applied.

Refer to the error message text.

EID-3163 The data in row {0} cannot be validated. CTC cannot validate the data for the 
specified row.

EID-3164 The new node ID ({0}) for ring ID {1} duplicates the ID of 
node {2}. 

The new specified node ID for the specified 
ring ID is the same as another node ID.
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EID-3165 The ring ID provided is already in use. Ring IDs must be 
unique.

Refer to the error message text.

EID-3166 An error occurred while refreshing the {0} table. CTC encountered an error while refreshing 
the specified table.

EID-3167 The slot is already in use. Refer to the error message text.

EID-3168 An error occurred while provisioning. An error was encountered while attempting 
the specified provisioning operation. Refer 
to the details portion of the error dialog box 
for more information.

EID-3169 An error occurred while adding the card. CTC encountered an error while adding the 
card.

EID-3170 You cannot delete this card: {0}. Refer to the error message text.

EID-3171 An error occurred while creating the trap destination. CTC encountered an error creating the trap 
destination.

EID-3172 No RMON thresholds were selected. Select an RMON threshold.

EID-3173 The contact ''{0}'' cannot exceed {1} characters. The specified contact exceeds the specified 
character limit.

EID-3174 The description ''{0}'' cannot exceed {1} characters. The specified location exceeds the specified 
character limit.

EID-3175 The operator identifier ''{0}'' cannot exceed {1} characters. The specified operator identifier exceeds 
the specified character limit.

EID-3176 The operator specific information ''{0}'' cannot exceed {1} 
characters. 

The specified operator specific information 
exceeds the specified character limit.

EID-3177 The node name cannot be empty. The specified name is empty.

EID-3178 The node name ''{0}'' cannot exceed {1} characters. The specified name exceeds the specified 
character limit.

EID-3179 The protect card is in use. Refer to the error message text.

EID-3180 The 1+1 protection group does not exist. Create a 1+1 protection group.

EID-3181 The Y-cable protection group does not exist. Refer to the error message text.

EID-3182 The topology element is in use and cannot be deleted as 
requested. 

You cannot delete the topology element 
which is in use.

EID-3183 An error occurred while deleting the protection group. CTC encountered an error while deleting 
the protection group.

EID-3184 No {0} was selected. You must select an item before completing 
this task.

EID-3185 This ring has an active protection switch operation and cannot 
be deleted at this time. 

Refer to the error message text.

EID-3186 The node is busy: {0} is {1} and cannot be deleted as requested. The request cannot be completed.

EID-3187 An error occurred while deleting the trap destination. CTC encountered an error deleting the trap 
destination.
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EID-3188 An error occurred during authentication. The password entered 
is invalid. 

The password you entered is invalid. Enter 
the password again.

EID-3189 The sum of the {0} must be between {1} and {2}. Refer to the error message text.

EID-3214 The number of high order circuits for the line could not be 
retrieved. 

The number of High Orders (STS/STM) for 
the line is not available.

EID-3215 An error occurred while refreshing. Used frequently in pane classes to indicate 
a general error condition when trying to 
refresh from the model.

EID-3216 The proxy port is invalid. Refer to the error message text.

EID-3217 The statistics could not be refreshed. CTC could not refresh statistics values.

EID-3218 The automatic node setup could not be launched. Refer to the error message text.

EID-3219 The automatic node setup information could not be refreshed. Failure trying to retrieve automatic node 
setup information.

EID-3220 An error occurred while refreshing row {0}. Error refreshing the specified row.

EID-3222 The statistics could not be cleared. Refer to the error message text.

EID-3225 An error occurred while refreshing the pane. Used frequently in pane classes to indicate 
a general error condition when trying to 
refresh from the model.

EID-3226 The {0} termination(s) could not be deleted.  
{1}

Refer to the error message text.

EID-3227 A baseline could not be recorded. Performance metrics will 
remain unchanged. 

CTC failed to set the baseline values while 
provisioning NE. Previous values remain 
unchanged.

EID-3228 The {0} termination(s) could not be created. 
{1}

Refer to the error message text.

EID-3229 RIP is active on the LAN. Please disable RIP before enabling 
OSPF.

Turn off the Routing Information Protocol 
(RIP) on the LAN, before enabling OSPF.

EID-3230 OSPF is active on the LAN. Please disable OSPF before 
enabling RIP.

Turn off the OSPF on the LAN before 
enabling RIP.

EID-3231 An error occurred while setting the OPR. An error was encountered while attempting 
to provision the optical power received 
(OPR).

WID-3232 The port state cannot be indirectly transitioned because the port 
is still providing services. 
If the port state should be changed, edit it directly through port 
provisioning. 

Edit the port state while provisioning the 
port.

EID-3233 The current loopback provisioning does not allow this state 
transition. 

Refer to the error message text.

EID-3234 The current synchronization provisioning does not allow this 
state transition. 

You cannot transition the port state to the 
target date while in the current 
synchronization state.
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EID-3235 The requested state transition cannot be performed on this 
software version. 

Refer to the error message text.

EID-3236 The database restore failed. {0} CTC failed to restore the specified 
database.

EID-3237 The database backup failed. {0} CTC failed to backup the specified 
database.

EID-3238 The send PDIP setting on {0} is inconsistent with the setting on 
the control node {1}. 

The send payload defect indicator path 
(PDI-P) setting on the specified item should 
be consistent with that of the specified 
control node.

EID-3239 The overhead termination is invalid Refer to the error message text.

EID-3240 The maximum number of overhead terminations has been 
exceeded.

Overhead terminations have exceeded the 
limit.

EID-3241 The {0} termination port is in use. The specified termination port is in use. 
Select another port.

EID-3242 An {1} exists on the selected ports.  
Therefore, you must create the {0}s one by one.

The specified DCC already exists on the 
selected port. You can create a DCC of 
another type.

WID-3243 The port you have chosen as an {0} endpoint already supports 
an {1}. The port cannot support both DCCs. After the {0} is 
created, verify that no EOC alarms are present and then delete 
the {1} to complete the downgrade.

The same port can not be used by multiple 
DCCs.

EID-3244 An {0} exists on the selected ports.  
Therefore, you must create the {1}s one by one.

The specified DCC already exists on the 
selected port. You can create a DCC of 
another type.

WID-3245 The port you have chosen as an {1} endpoint already supports 
an {0}. The port cannot support both DCCs. After the {1} is 
created, verify that no EOC alarms are present and then delete 
the {0} to complete the upgrade.

The port selected as a DCC endpoint 
already supports another DCC. Refer to the 
warning message text.

EID-3246 The wizard was not able to validate the data. 
{0} 

CTC encountered an error.

EID-3247 An ordering error occurred. The absolute value should be {0}. The absolute value entered was wrong.

EID-3248 The value for the parameter {0} is invalid. CTC changed the incorrect parameter.

EID-3249 The voltage increment value is invalid. Refer to the error message text.

EID-3250 The power monitor range is invalid. Refer to the error message text.

EID-3251 The requested action could not be completed. 
{0} 

CTC could not complete the specified 
action.

EID-3252 No download has been initiated from this CTC session. Refer to the error message text.

EID-3253 The reboot operation failed. {0} Refer to the error message text.
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EID-3254 An error occurred during validation. {0} The Cisco Transport Controller (CTC) was 
unable to validate the values entered by the 
user, specified by {0}. This error message is 
common to several different provisioning 
tabs within the CTC.

EID-3255 You cannot change the timing configuration because a 
Manual/Force operation is in effect. 

Refer to the error message text.

WID-3256 The timing reference(s) could not be assigned because one or 
more of the timing reference(s): 
- is already used and/or  
- has been selected twice and/or 
- is attempting to use the same slot twice. 
Please verify the settings. 

Refer to the warning message text.

EID-3257 Duplicate DCC numbers are not permitted. {0}. CTC detected more than one occurrence of 
the a DCC number. Remove one of them.

EID-3258 A software error occurred while attempting to download the 
file. 
Please try again later. 

Refer to the error message text.

EID-3259 An error occurred while creating the FC-MR threshold. You must create a Fibre Channel Multirate 
(FC_MR) card threshold.

EID-3260 An error occurred while provisioning the internal subnet: 
{0} 

The specified internal subnet could not be 
provisioned.

EID-3261 The port rate provisioning cannot be changed while circuits 
exist on this port.

Refer to the error message text.

EID-3262 The port provisioning cannot be changed when the port status 
is {0}. 

You must provision the ports only when the 
port is Out of Service.

WID-3263 You are using Java version {0}. CTC should run with Java 
version {1}. It can be obtained from the installation CD or 
http://java.sun.com/j2se/ 

CTC is being launched with the wrong 
version of the JRE {0}. This version of CTC 
requires a particular version of the JRE {1}. 
The CTC and browser must be closed and 
restarted to allow the correct Java version to 
be loaded.

EID-3265 An error occurred while modifying the protection group. Protection Group could not be modified.

EID-3266 Conditions could not be retrieved from the shelf or card view. Refer to the error message text.

WID-3267 The XTC protection group cannot be modified. Refer to the warning message text.

WID-3268 The filter entry is invalid. {0} The specified entry is invalid.

WID-3269 The {0} operation was successfully initiated for {1} but its 
completion status could not be obtained from the node. When 
the node is accessible, check its software version to verify if the 
{0} succeeded.

Refer to the error message text.

WID-3270 The file {0} does not exist. The specified file does not exist.
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WID-3271 The value entered must be greater than {0}. The value entered must be greater than the 
specified value.

WID-3272 An entry is required. An entry is required to complete this task.

WID-3273 {0} already exists in the list. The specified item already exists in the list.

WID-3274 A software upgrade is in progress. 
Network configuration changes that result in a node reboot 
cannot take place during a software upgrade. 
Please try again after the software upgrade is done. 

Refer to the warning message text.

WID-3275 Ensure that the remote interface ID and the local interface ID 
on the two sides match. 
(The local interface ID on this node should equal the remote 
interface ID on the neighbor node and vice-versa). 

Refer to the warning message text.

WID-3276 Both {0} and {1} exist on the same selected port. 
{2} 

The specified port has both SDCC and 
LDCC.

WID-3277 The description cannot exceed {0} characters. Your input will 
be truncated. 

The input exceeds the character limit. The 
value will be truncated to the maximum 
chapter limit.

WID-3279 This card has been deleted. CTC will return to the shelf view. CTC returns to node view.

WID-3280 ALS will not engage until both the protected trunk ports detect 
LOS.

Refer to the warning message text.

WID-3282 Performing a software upgrade while TSC 5 is active could 
result in a service disruption. It is recommended that you make 
TSC 10 the active TSC by performing a soft reset of TSC 5. The 
following ONS 15600s are currently unsafe to upgrade...

Refer to the warning message text.

WID-3283 Before activating a new version, ensure that you have a 
database backup from the current version.

Refer to the warning message text.

WID-3284 Reverting to an older version. CTC is being reverted to an older version of 
application.

WID-3285 Applying FORCE or LOCKOUT operations might result in 
traffic loss.

Refer to the warning message text.

WID-3286 The ring status is INCOMPLETE. CTC cannot determine if 
there are existing protection operations or switches in other 
parts of the ring. Applying a protection operation at this time 
could cause a traffic outage. Please confirm that no other 
protection operations or switches exist before continuing.

Refer to the warning message text.

WID-3287 There is a protection operation or protection switch present on 
the ring. Applying this protection operation now will probably 
cause a traffic outage.

Refer to the warning message text.

WID-3288 The status of this ring is INCOMPLETE. CTC will not be able 
to apply this change to all of the nodes in the {0}.

Change the ring status to apply the change 
to all nodes in the ring type.

EID-3290 The specified provisionable patchcord(s) could not be deleted. Refer to the error message text.
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EID-3291 The revertive behavior cannot be changed because a protection 
switch is active. 

Protection switch should not be active to 
change the revertive behavior.

EID-3292 An error occurred while resetting the shelf. CTC encountered an error while resetting 
the node.

EID-3293 No such provisionable patchcords exists. You are attempting to delete a provisionable 
patchcord that does not exist. This happens 
when multiple instances of CTC are 
running and attempting to delete the same 
provisionable patchcord concurrently.

EID-3294 No RMON thresholds are available for the selected port. Refer to the error message text.

EID-3295 This card does not support RMON thresholds. Refer to the error message text.

EID-3296 Buffer-to-buffer credit is only supported for Fibre Channel (FC) 
and FICON.

Refer to the error message text.

EID-3298 This interfaces does not support ALS auto restart. Refer to the error message text.

EID-3300 Duplicate OSPF area IDs are not permitted. OSPF area IDs should be unique.

EID-3301 The LAN metric cannot be zero. Refer to the error message text.

EID-3302 The standby {0} is not ready. Standby controller card is not ready.

EID-3303 The DCC area ID and {0} conflict. 
{1} 

DCC Area ID and ring type, specified by 
{0}, conflict each other due to the details 
specified by {1}.

EID-3304 The DCC number is out of range. Enter a DCC number that is within the range

EID-3305 OSPF cannot be active on the LAN interface when the 
backbone area is set on a DCC interface. 

You cannot have the default OSPF area on a 
DCC while OSPF is enabled on the LAN.

EID-3306 Ethernet circuits must be bidirectional. Refer to the error message text.

EID-3307 An error occurred while creating a connection object at {0}. CTC encountered an error at the specified 
connection while creating the connection.

EID-3308 DWDM links can be used only for optical channel circuits. Refer to the error message text.

EID-3309 The link was excluded because it was in the wrong direction. The optical channel (circuit) does not allow 
the specified link to be included because it 
is in the wrong optical direction.

EID-3310 The DWDM link does not have wavelengths available. Refer to the error message text.

EID-3311 The laser is already on. Refer to the error message text.

EID-3312 The power setpoint cannot be changed. 
{0} {1} 

CTC cannot change the power setpoint. The 
new setpoint would either make the 
thresholds inconsistent or set the fail 
threshold outside the range.

EID-3313 The offset cannot be modified because the service state of the 
port is IS. 

Refer to the error message text.

EID-3314 The requested action is not allowed. 
The state value is invalid. 

Refer to the error message text.
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EID-3315 This operation cannot be performed. CTC is unable to perform operation.

EID-3316 The node side is invalid. This task was applied to the wrong node 
side.

EID-3317 The ring name is too long. Reduce the number of characters in the 
name.

EID-3318 The ring name is invalid. The name you entered is illegal.

EID-3319 The wrong line was selected. Select another line

EID-3320 The optical link could not be deleted. CTC cannot delete the optical link.

EID-3321 This feature is unsupported by this version of software. Refer to the error message text.

EID-3322 The equipment is not plugged in. Plug-in the equipment and proceed.

EID-3323 The APC system is busy. Automatic Power Control (APC) system is 
busy.

EID-3324 There is no path to regulate. There is no circuit path to regulate.

EID-3325 The requested action is not allowed. Generic DWDM provisioning failure 
message.

EID-3326 The input was invalid. The input value is incorrect.

EID-3327 An error occurred while retrieving thresholds. There was an error retrieving the thresholds. 
This message is displayed only for the 
OSCM/OSC-CSM line thresholds.

EID-3328 An error occurred while applying changes to row {0}. 
The value is out of range. 

There was an error applying the changes to 
the specified row. The value is out of range. 

EID-3330 Unable to switch to the byte because an overhead channel is 
present on this byte of the port. 

Refer to the error message text.

EID-3331 An error occurred while applying changes to the row. Refer to the error message text.

EID-3334 Timing parameters on the protect port cannot be changed. You cannot change timing parameters on 
protect port.

EID-3335 The port type cannot be changed because the SDH validation 
check failed. Check if this port is part of a circuit, protection 
group, SONET DCC, orderwire, or UNI-C interface.

Refer to the error message text.

EID-3336 An error occurred while reading a control mode value. The Control Mode must be retrieved.

EID-3337 An error occurred while setting a set point gain value. The Gain Set Point must be set.

EID-3338 An error occurred while reading a set-point gain value. The Gain Set Point must be retrieved.

EID-3339 An error occurred while setting a tilt calibration value. The tilt calibration must be set.

EID-3340 An error occurred while setting expected wavelength. The expected wavelength must be set.

EID-3341 An error occurred while reading expected wavelength. The expected wavelength must be retrieved.

EID-3342 An error occurred while reading actual wavelength. The actual wavelength must be retrieved.

EID-3343 An error occurred while reading actual band. The actual band must be retrieved.

EID-3344 An error occurred while reading expected band. The expected band must be retrieved.
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EID-3345 An error occurred while setting expected band. The expected band must be set.

EID-3346 An error occurred while retrieving defaults from the node: {0}. There was an error retrieving defaults from 
the specified node.

EID-3347 The file {0} cannot be loaded. CTC cannot load the specified file.

EID-3348 Properties cannot be loaded from the node. Refer to the error message text.

EID-3349 NE update properties cannot be saved to a file. Check your file system for space constraint 
or any other problem.

EID-3350 NE update properties cannot be loaded from the node. Refer to the error message text.

EID-3351 The file {0} does not exist. The specified file does not exist.

EID-3352 An error occurred while setting a value at {0}. There was an error while setting the value at 
the specified location.

EID-3353 No such interface is available. The interface specified is not present in 
CTC.

EID-3354 The specified endpoint is in use. Select another endpoint that is not in use.

EID-3355 The specified endpoint is incompatible. Refer to the error message text.

EID-3357 The connections could not be calculated. Refer to the error message text.

EID-3358 An optical link model does not exist for the specified interface. Create an optical linkmodel for the 
interface, and proceed.

EID-3359 Optical parameters could not be set for the node. Refer to the error message text.

EID-3360 ANS cannot be performed. 
Please check {0} parameter value. 

Refer to the error message text.

EID-3361 The ring termination is in use. 
An error occurred while deleting the ring termination. 

You cannot delete a ring in use.

EID-3362 An error occurred while deleting the ring termination. There was an error while deleting ring 
termination.

EID-3363 No ring terminations were selected. You must select a ring termination.

EID-3364 An error occurred while creating the ring ID. There was an error while creating the ring 
ID.

EID-3365 The OSC termination is in use. Select another optical service channel 
(OSC) which is not in use.

EID-3366 The OSC termination could not be deleted. There was an error deleting the OSC 
termination.

EID-3370 No optical link was selected. You must select an optical link.

EID-3371 An error occurred while calculating the automatic optical link 
list. 

Refer to the error message text.

EID-3372 CTC attempted to access an OCHNC connection that has been 
destroyed. 

CTC destroyed an external attempt to 
access an optical channel network 
connection.

EID-3375 The expected span loss must be set. Refer to the error message text.
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EID-3376 The measured span loss could not be retrieved. Refer to the error message text.

EID-3377 The wrong interface was used. The interface used for the card is wrong.

EID-3378 This is a duplicate origination patchcord identifier. The provisionable patchcord identifier to 
the patchcord you are attempting to 
provision is already in use by another 
patchcord on the origination node.

EID-3379 This is a duplicate termination patchcord identifier. The provisionable patchcord identifier to 
the patchcord you are attempting to 
provision is already in use by another 
patchcord on the remote node.

EID-3380 The host cannot be found. Refer to the error message text.

EID-3381 The maximum frame size must be between {0} and {1} and 
may be increased in increments of {2}. 

The frame size must be in the specified 
range. It can increment by the specified 
value.

EID-3382 The number of credits must be between {0} and {1}. The number of credits must be between the 
specified values.

EID-3383 The GFP buffers available must be between {0} and {1} and 
may be increased in increments of {2}. 

The GFP buffers must be in the specified 
range. It can increment by the specified 
value.

WID-3384 You are about to force the use of Secure Mode for this chassis. 
You will not be able to undo this operation.  
Is it OK to continue?

Refer to the warning message text.

EID-3385 {0}. Delete the circuits and try again. Refer to the error message text.

EID-3386 The transponder mode could not be provisioned: 
{0} 

The specified transponder mode cannot be 
provisioned.

EID-3387 You must change port(s) {0} to an out-of-service state before 
changing card parameters. Click “Reset” to revert the changes.

All the card ports should be changed to 
out-of-service before changing the 
parameters.

EID-3388 The card mode cannot be changed because the card has circuits. Refer to the error message text.

EID-3389 An error occurred while changing the card mode. Refer to the error message text.

EID-3390 The port is in use. Refer to the error message text.

EID-3391 The port rate cannot be changed because the port has been 
deleted. 

You cannot change the port rate of a card 
that has been deleted.

WID-3392 The timing reference(s) could not be assigned because with 
external timing, only a single protected, or two unprotected 
timing references per BITS Out can be selected. 
Please use the "Reset" button and verify the settings. 

Refer to the warning message text.

WID-3393 The timing reference(s) could not be assigned because with line 
or mixed timing, only a single unprotected timing reference per 
BITS Out can be selected. 
Please use the "Reset" button and verify the settings. 

Refer to the warning message text.
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EID-3394 An error occurred while refreshing the power monitoring 
values. 

Refer to the error message text.

EID-3395 The configuration is invalid. 
{0} 

CTC encountered an error in IP address, net 
mask length, or default router, or a 
restricted IIOP port was selected.

EID-3396 The configuration is invalid. The standby controller card is not 
a TCC2P card. 

The standby controller card should be a 
TCC2P card.

EID-3397 The file {0} is the wrong version. The specified file is of wrong version.

EID-3398 The PPM cannot be deleted. Refer to the error message text.

EID-3399 The PPM cannot be deleted because it has port(s) in use. Remove the ports connected to the 
Pluggable Port Module before it can be 
deleted.

EID-3400 Unable to switch. A force to the primary facility is not allowed. Refer to the error message text.

EID-3401 {0} cannot be provisioned for the port while {1} is enabled. The relationship between parameters {0} 
and {1} are such that enabling either one, 
prevents the provisioning of the other.

EID-3402 The switch request could not be completed. 
The {0} card is not present or is not responding. 
Try again after ensuring that the {0} card is present and is not 
resetting. 

Refer to the error message text.

EID-3403 The administrative state transition has not been attempted on 
the monitored port. 

Refer to the error message text.

EID-3404 The far end IP address could not be set on the {0} termination. 
The IP address cannot be: 
loopback (127.0.0.0/8)

class D (224.0.0.0/4)

class E (240.0.0.0/4)

broadcast (255.255.255.255/32)

internal {1}

Refer to the error message text.

EID-3405 You cannot change card parameters with port {0} in {1} state. 
Click "Reset" to revert the changes. 

Refer to the error message text.

EID-4000 The {0} ring name cannot be changed now because a {0} 
switch is active.

You cannot change the ring name because a 
switch of the same ring type is active.

EID-4001 The {0} node ID cannot be changed now because a {0} switch 
is active.

You cannot change the ring ID because a 
switch of the same ring type is active.
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WID-4002 CAUTION: Reverting to an earlier software release may result 
in TRAFFIC LOSS and loss of connectivity to the node. It may 
require onsite provisioning to recover. 
If the node was running {0} before, reverting will restore the 
{0} provisioning, losing any later provisioning. If the node was 
running some other version, reverting will LOSE ALL 
PROVISIONING. 
{1} 
{2} 

Refer to the warning message text.

EID-4003 The Cisco IOS console is disabled for the card in Slot {0}. The card may not be an IOS-based card or it 
may be rebooting.

EID-4004 An error occurred while canceling the software upgrade. CTC encountered an error while cancelling 
the software upgrade.

EID-4005 {0} encountered while performing a database backup. CTC encountered the specified error during 
database backup.

EID-4006 The file {0} does not exist or cannot be read. Refer to error message.

EID-4007 The size of the file {0} is zero. The size of the file that is being backed up 
or restored is zero.

WID-4008 A software upgrade is in progress. 
{0} cannot proceed during a software upgrade. 
Please try again after the software upgrade has completed. 

The specified action cannot be performed 
during a software upgrade. You must try 
after the upgrade process is completed.

EID-4009 {0} encountered while restoring the database. CTC encountered the specified error while 
restoring the database.

EID-4010 The operation was terminated because: 
{0} 

Refer to the error message text.

EID-4011 An error occurred during provisioning: 
{0} 

Refer to the error message text.

EID-5000 A valid route cannot be found for the tunnel change request. Refer to the error message text.

EID-5001 The tunnel could not be changed. Refer to the error message text.

EID-5002 The tunnel could not be restored and must be recreated 
manually.

Refer to the error message text.

EID-5003 The circuit roll failed. 
{0} 

Refer to the error message text.

EID-5004 There is already one four-fiber {0} provisioned on the set of 
nodes involved in {1}. The maximum number of four-fiber {0} 
rings has been reached for that node. 

There is already one 4F BLSR provisioned 
on the set of nodes involved in the ring. The 
maximum number of 4F BLSR rings has 
been reached for that node.

WID-5005 A non-zero hold-off time can violate switching time standards, 
and should only be used for a circuit with multiple path 
selectors.

Refer to the warning message text.
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WID-5006 Warning: A different secondary {0} node should only be used 
for DRI or open-ended path protected circuits. 

You should use different secondary end 
point only for DRI or open-ended path 
protected circuits.

WID-5007 If you change the scope of this view, the contents of this profile 
editor will be lost.

Refer to the warning message text.

WID-5008 Please ensure that all the protection groups are in proper states 
after the cancellation. 

Refer to the warning message text.

WID-5009 The circuit {0} is not upgradable. 
No {1} capable {2}s are available at the node {3}. 

No VT capable STSs are available at the 
node.

EID-5010 The domain name already exists. Refer to the error message text.

EID-5011 The domain name cannot exceed {0} characters. You may have reached the maximum 
number of characters.

WID-5012 The software load on {0} does not support the addition of a 
node to a 1+1 protection group. 

Refer to the warning message text.

EID-5013 {0} does not support the bridge and roll feature. Please select a 
different port. 

The specified port does not support Bridge 
and Roll.

EID-5014 An automatic network layout is already in progress. 
Please wait for it to complete before running it again. 

You must for the automatic network layout 
to complete before running it again. 

WID-5015 {0} cannot be applied to {1}. You cannot apply the admin state operation, 
specified by {0}, to port count, specified by 
{1}.

EID-5016 An error occurred while attempting to provision the {0}. 
{1} 

CTC encountered an error while 
provisioning the card.

EID-5017 Provisioning could not be rolled back. The {0} might be left in 
an INCOMPLETE state and should be manually removed. 

You may have to remove the BLSR 
manually as it was left incomplete.

EID-5018 {0} is a(n) {1} node and cannot be added to a(n) {2} network. You cannot add the node {0} of type {1} to 
the host node of type {2}. This prevents you 
from hosting both SONET and SDH nodes 
in the same session.

EID-5019 The manual path trace mode for this equipment does not 
support an expected string consisting of all null characters. 
Please change the expected string or the path trace mode. 

The path trace mode does not support 
strings that consist of null characters. You 
must either change the expected string or 
the path trace mode.

EID-5020 Software activation is in progress. Provisioning is not allowed. Refer to the warning message text.

EID-5021 Software activation is in progress. {0} is not allowed. Refer to the error message text.

WID-5022 Warning: Ethergroup circuits are stateless (that is, always in 
service). 
The current state selection of {0} will be ignored. 

Refer to the warning message text.

EID-5023 CTC cannot communicate with the node. 
The operation failed. 

CTC encountered a network 
communication error. Connectivity between 
CTC and the NE was disrupted, either 
transiently or permanently.
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EID-5024 The overhead circuit will not be upgraded. Refer to the error message text.

WID-5025 The path targeted for this switch request is already active. The 
switch request can be applied, but traffic will not switch at this 
time. 

Refer to the warning message text.

EID-5026 An ONS 15600 cannot serve as the primary or secondary node 
in a four-fiber {0} circuit. Please change your ring and/or node 
selections so that an ONS 15600 is not chosen as the primary or 
secondary node in this four-fiber {1} circuit. 

Refer to the error message text.

WID-5027 The {0} Edit dialog box for the ring {1} has been closed due to 
significant provisioning changes. These changes might only be 
transitory, so you can reopen the {0} Edit dialog box to view the 
updated state. 

Re-open the BLSR/MS-SPRing edit 
window to view the updated state of the 
ring.

WID-5028 Warning: This operation should only be used to clean up rolls 
that are stuck. It might also affect completeness of the circuit. 
Is it OK to continue with the deletion? 

Refer to the warning message text.

EID-5029 A software downgrade cannot be performed to the selected 
version while an SSXC card is inserted in this shelf. Please 
follow the steps to replace the SSXC with a CXC card before 
continuing the software downgrade.

Refer to the error message text.

EID-5030 A software downgrade cannot be performed at the present time. Try the software downgrade later.

WID-5031 Canceling a software upgrade during a standby TSC clock 
acquisition might result in a traffic outage. 

Refer to the warning message text.

EID-5032 An error occurred while accepting the load. Refer to the error message text.

EID-5033 The profile could not be loaded. 
An error occurred while decoding the characters. 

CTC detected an error while decoding 
characters and could not load the profile.

EID-5034 The profile could not be loaded.

An error occurred while trying to recognize the file format. 

CTC detected an error and could not load 
the profile.

EID-5035 The profile could not be loaded. 
An error occurred while reading the file. 

CTC could not read the file and is therefore 
unable to load the profile.

EID-5036 The GNE hostname {0} is invalid. The specified host name is invalid. CTC 
could not resolve the host name to any valid 
IP address

EID-5037 Provisionable patchcords cannot be created between 
transponder trunk ports and multiplexer/demultiplexer ports on 
the same node. 

You must create provisionable patchcords 
between transponder trunk ports and 
mux/demux ports that are on different 
nodes.

EID-5038 Provisionable patchcords created between transponder trunk 
ports and multiplexer/demultiplexer ports must use the same 
wavelength: 
{0} is not equal to {1}. 

Wavelengths used by provisionable 
patchcords for transponder trunk ports and 
mux/demux ports must be the same.
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EID-5039 Provisionable patchcords created between transponder trunk 
ports and multiplexer/demultiplexer ports must use the same 
wavelength: 
{0} is not equal to {1}. 
Please provision the {2} wavelength on {3}. 

Transmitter and receiver port wavelengths 
are not equal. Provision the receiver and 
transmitter wavelengths on transmitter and 
receiver ports respectively.

EID-5040 Provisionable patchcords created between OC3/OC12 ports and 
multiplexer/demultiplexer ports are not supported. 

Refer to the error message text.

EID-5041 Provisionable patchcords created between gray OC-N trunk 
ports and multiplexer/demultiplexer ports are not supported. 

Refer to the error message text.

EID-5042 Provisionable patchcords created between OC-N trunk ports 
and multiplexer/demultiplexer ports must use the same 
wavelength: 
{0} is not equal to {1}. 

Wavelengths used by provisionable 
patchcords for OC-N trunk ports and 
mux/demux ports must be the same.

WID-5043 Warning: Only the line card was provisioned. 
The wavelength compatibility check was skipped. 

Refer to the warning message text.

EID-5044 Virtual links can be used only for OCH-Trail circuits. Refer to the error message text.

EID-5045 The virtual link does not have wavelengths available. Set wavelengths for the virtual link and 
proceed.

WID-5046 Warning: if you select "Use OCHNC Direction," your circuit 
will be limited to nodes prior to release 07.00.

Refer to the warning message text.

EID-5047 Provisionable patchcords created between OC3/OC12 ports are 
not supported. 

Refer to the error message text.

EID-5048 Provisionable patchcords created between gray OC-N trunk 
ports are not supported. 

Refer to the error message text.

EID-5049 Provisionable patchcords created between gray OC-N trunk 
ports and multiplexer/demultiplexer ports are not supported. 

Refer to the error message text.

EID-5050 The element model could not be found. 
{0} 

The specified Element Model cannot be 
located.

WID-5051 The port state cannot be indirectly transitioned because the port 
aggregates OCHCC circuits: if the port state needs to be 
changed, edit it directly through port provisioning.

Refer to the warning message text.

EID-5052 The operation is not valid for the connection type. You may have selected the incorrect switch.

EID-5053 The operation cannot be performed because the connection is 
under test access.

Refer to the error message text.

EID-5054 The TL1 tunnel could not be opened. {0} Refer to the error message text.

EID-5055 Some patchcords were not deleted. Patchcords cannot be 
deleted if they are incomplete or support any circuits, or if the 
nodes supporting them are not connected.

Refer to the error message text.

EID-5056 This PPC cannot be deleted because one or more circuits are 
provisioned over it. 

Remove the circuits provisioned over the 
provisionable patchcord before trying to 
delete it.
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EID-5057 The addition of the last node has not yet finished. 
Please wait before trying to add a new node. 

Refer to the error message text.

EID-5058 An OCHNC upgrade is applicable only to bidirectional circuits. Refer to the error message text.

EID-5059 The OCHNC upgrade failed. 
One or more communication failures occurred during the 
operation.

CTC encountered a complete failure while 
upgrading optical channel network 
connection.

EID-5060 The OCHNC upgrade partially failed. 
One or more communication failures occurred during the 
operation. 
Create the OCHCC manually. 

CTC encountered a partial failure while 
upgrading an optical channel network 
connection.

EID-5061 The overhead circuit source and destination must reside on the 
same shelf. 

Refer to the error message text.

EID-5062 A four-fiber {0} cannot be created using three cards. A four-fiber BLSR needs four cards.

WID-5063 The profile "{0}" includes a change to the OPEN-SLOT alarm 
severity. 
This change is disallowed for the ONS 15600. "{1}" will 
continue to use the OPEN-SLOT severity of MN that is 
included in the default configuration. 
Other changes from the "{2}" profile were successfully applied 
to {3}". 

Refer to the warning message text.

EID-5064 {0}

{1} 

This indicates the status of path protection 
switching.

WID-5065 If you apply routing constraints to more than {0} nodes, 
performance might be affected and the operation might require 
more time than expected. 
Select Yes if you intend to proceed in spite of this risk, or No if 
you prefer to review your selection. 

Refer to the warning message text.

WID-5066 The routing constraints will be lost. 
Are you sure you want to reset your changes? 

Refer to the warning message text.

WID-5067 The routing constraints will be lost. 
Are you sure you want to leave this panel? 

Refer to the warning message text.

EID-5068 The routing constraints could not be applied. Refer to the error message text.

EID-5069 A source node cannot be added to either of these lists. Select a node other than the source node to 
add to the route.

EID-5070 A destination node cannot be added to either of these lists. Select a node other than the destination 
node to add to the route.

EID-5071 This node already belongs to one of these lists. The node is already selected either in 
include or exclude list in the OCH circuit.

EID-5072 An OCH-Trail tunnel link was found but without any associated 
circuit. 

Create an OCH-Trail circuit associated with 
the link.

EID-5073 You are creating an unprotected link from a protected port. 
Do you want to continue? 

Refer to the error message.
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EID-5074 Deleting OCH DCN circuits will cause a loss of connectivity to 
nodes in the circuit path that do not have other DCN 
connections. 
Do you want to continue? 

Refer to the error message.

EID-5075 The VLAN ID must be a number between 1 and 4093. Enter a number between 1 and 4093.

EID-5076 An error occurred while provisioning the VLAN ID. 
The VLAN ID is already present in the current profile 

Select a VLAN ID that is not present in the 
current profile.

EID-5077 An error occurred while provisioning the VLAN database 
profile. 
{0} 

CTC could not save the VLAN profile to the 
file name mentioned.

EID-5078 The VLAN merge is not complete. 
You forgot to fill {0} record(s). 

Fill in the number of records specified and 
then proceed.

EID-5079 An error occurred while validating the provisionable patchcord. Refer to the error message text.

EID-5080 No rolls are available. You cannot delete a roll without selecting a 
roll.

EID-5081 An error occurred while tracing the RPR ring: 
{0} 

The circuit reference is invalid.

EID-5082 {0} does not support: 
- Low-order circuits that have both {1}-protected and 
{2}-protected spans and that cross a node that does not have 
low-order cross-connect capability. 
- High-order circuits that carry low-order circuits with the 
parameters described above.

Refer to the error message text.

EID-5083 This circuit is not the same size as the existing circuit {0}. 
This circuit has size {1} and the existing circuit has size {2}.

During an RPR circuit creation ML card, 
the new circuit size and the existing circuit 
size must be the same.

EID-5084 The Trunk model could not be found. 
{0} 

The trunk specified is not found.

EID-5085 The maximum number of VLAN DB profiles is {0}. Refer to the error message.

EID-5086 The circuit roll failed. 
You cannot bridge and roll the selected circuit because it has a 
monitor circuit. 

Refer to the error message.

EID-5087 You cannot use same slot for east working and west protect 
ports.

Refer to the error message text.

EID-5088 You cannot use same slot for east working and west protect 
ports.

Refer to the error message text.

WID-5089 The maximum number of circuits that can be deleted at a time 
is 200. 
Do you want to delete the first 200 circuits selected?

Refer to the error message text

EID-5090 This operation cannot be completed. 
The selected circuits have different state models; 
please select circuits of the same type. 

Refer to the error message text
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EID-5091 Some PPC terminations were not repaired. Refer to the error message text

WID-5092 The TL1 encoding mode for the tunnel is being changed. 
Do you want to modify the encoding? 

Confirm if you really want to modify TL1 
tunnel encoding.

EID-6000 This platform does not support power monitoring thresholds. Refer to the error message text.

EID-6001 One of the XC cards has failures or is missing. Check whether all the cross-connect cards 
are installed and working.

EID-6002 One of the XC cards is locked. Unlock the cross-connect card.

EID-6003 The OSC termination could not be created. 
This ring ID is already assigned. 

Enter a new ID for the ring.

EID-6004 A system reset cannot be performed while a BLSR ring is 
provisioned on the node. 

Remove the BLSR from the node and 
continue with the reset procedure.

EID-6005 The timing references could not be assigned. 
- Only two DS1 or BITS interfaces can be specified. 
- DS1 interfaces cannot be retimed and used as a reference. 
- BITS-2 is not supported on this platform. 

Refer to the error message text.

EID-6006 The timing references could not be assigned. 
- An NE reference can only be used if the timing mode is LINE. 
- A BITS reference can only be used if the timing mode is not 
LINE. 
- A Line reference can only be used if the timing mode is not 
EXTERNAL. 

Refer to the error message text.

EID-6008 SF BER and SD BER are not provisionable on the protect line 
of a protection group.

Refer to the error message text.

WID-6009 If autoadjust GFP buffers is disabled, GFP buffers available 
must be set to an appropriate value based on the distance 
between the circuit endpoints. 

Refer to the warning message text.

WID-6010 If auto detection of credits is disabled, credits available must be 
set to a value less than or equal to the number of receive credits 
on the connected FC endpoint. 

Refer to the warning message text.

WID-6011 Ingress idle filtering should be turned off only when required to 
operate with non-Cisco Fibre Channel/FICON-over-SONET 
equipment.

Refer to the warning message text.

EID-6012 The retiming configuration could not be changed because there 
are circuits on this port. 

You cannot change the timing configuration 
on this port unless the circuits on this port 
are deleted.

EID-6013 The NTP/SNTP server could not be changed.

{1}

Refer to the error message text.

EID-6014 The operation failed because the reference state is OOS. Change the Out-of-service state to Active.

EID-6015 The distance extension cannot be disabled if the port media type 
is FICON 1Gbps ISL or FICON 2Gbps ISL.

Refer to the error message text.
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EID-6016 The card mode cannot be changed to Fibre Channel Line Rate 
if the port media type is FICON 1Gbps ISL or FICON 2Gbps 
ISL. 

Refer to the error message text.

EID-6017 The destination of a {0} route cannot be a node IP address. A node IP address cannot be the destination 
for a static route.

EID-6018 The destination of a {0} route cannot be the same as the subnet 
used by the node.

Refer to the error message text.

EID-6019 The destination of a static route cannot be 255.255.255.255 The network address such as 
255.255.255.255 is not valid. Enter a valid 
address.

EID-6020 The destination of a static route cannot be the loopback network 
(127.0.0.0/8).

Refer to the error message text.

EID-6021 The subnet mask length for a non default route must be between 
8 and 32.

Length of subnet mask must be within the 
specified range.

EID-6022 The subnet mask length for a default route must be 0. Refer to the error message text.

EID-6023 The destination of a {0} route cannot be an internal 
network{1}. 

The destination of a static route must not be 
an internal network.

EID-6024 The destination of a {0} route cannot be a class D (224.0.0.0/4) 
or class E (240.0.0.0/4) address. 

The destination of a static route must not be 
a class D or class E address.

EID-6025 The destination of a {0} route cannot be a class A broadcast 
address (x.255.255.255/8).

The destination of a static route must not be 
a class A broadcast address. It should be 
(xxx.0.0.0).

EID-6026 The destination of a {0} route cannot be a class B broadcast 
address (x.x.255.255/16).

The destination of a static route must not be 
a class B broadcast address.

EID-6027 The destination of a {0} route cannot be a class C broadcast 
address (x.x.x.255/24).

The destination of a static route must not be 
a class C broadcast address.

EID-6028 The destination of a {0} route cannot be the subnet broadcast 
address associated with a node IP address.

The destination of a static route must not be 
a subnet broadcast address of a node IP.

EID-6029 The next hop of a static route cannot be the same as the 
destination of the route or an internal network{0}. 

Static route must have the default route as 
the next hop, and not destination of the 
route or internal network.

EID-6030 The next hop of a static default route must be the provisioned 
default router.

The default route is selected for networks 
that do not have a specific route.

EID-6031 No more static routes can be created. You have reached the maximum number of 
static routes.

EID-6032 This static route already exists. Refer to the error message text.

EID-6033 A previous operation is still in progress. Another operation is in progress. You must 
try after sometime.

EID-6035 The parent entity does not exist. Refer to the error message text.

EID-6036 The parent PPM entity does not exist. Create a parent entity for the PPM.

EID-6037 This equipment type is not supported. CTC does not support this equipment.
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EID-6038 The PPM port is invalid. Refer to the error message text.

EID-6039 The card is part of a regeneration group. Select another card.

EID-6040 Out of memory. Refer to the error message text.

EID-6041 The port is already present. Refer to the error message text.

EID-6042 The port is used as timing source. Choose another port because the selected 
port is being used as a timing source.

EID-6043 A DCC or GCC is present. Refer to the error message text.

EID-6044 The card or port is part of protection group. Refer to the error message text.

EID-6045 The port has overhead circuit(s). Refer to the error message text.

EID-6046 The ITU-T G.709 configuration is not compatible with the data 
rate.

Refer to the error message text.

EID-6047 The port cannot be deleted because its service state is 
OOS-MA,LPBK&MT.

To delete the port, you must change the port 
state to OOS-DSBLD.

EID-6048 {0} is {1}. The trunk port is in the wrong state to carry 
out the action.

EID-6049 The card operating mode of {0} is not supported. CTC does not support the mode of 
operation requested on the card.

EID-6050 Some {0} terminations were not {1}d. 
{2} 

Refer to the error message text.

WID-6051 All {0} terminations were {1}d successfully. 
{2} 

Refer to the warning message text.

EID-6052 The authentication key can not be blank. Enter an authentication key.

EID-6053 No more SNMP trap destinations can be created. You have reached the maximum number of 
SNMP trap destinations.

EID-6054 {0} is not a valid IP address for an SNMP trap destination. The IP address specified is not a valid 
receiver of SNMP traps.

EID-6055 The IP address is already in use. Refer to the error message text.

EID-6056 The SNMP trap destination is invalid. {0} The specified SNMP trap destination is 
invalid. Choose another destination.

WID-6057 Changing the card mode will result in an automatic reset. Refer to the warning message text.

EID-6058 The maximum number of IP-over-CLNS tunnels has been 
exceeded. 

Refer to the error message text.

EID-6059 The specified IP-over-CLNS tunnel already exists! Specify another IP Over CLNS tunnel.

EID-6060 An error occurred while trying to {0} an IP-over-CLNS tunnel 
entry: 
{1}. 

Refer to the error message text.

EID-6061 An error occurred while deleting the IP-over-CLNS tunnel 
entry. 

CTC encountered an error while deleting 
the IP Over CLNS tunnel entry.

EID-6062 The selected IP-over-CLNS tunnel does not exist. Create a IP Over CLNS tunnel.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
4-41
Cisco ONS 15454 Troubleshooting Guide, R8.5

November 2009



 

Chapter 4      Error Messages
  
EID-6063 The selected router does not exist. Create a router.

EID-6064 The MAA address list is full. Refer to the error message text.

EID-6065 The selected area address is duplicated. Enter another area address.

EID-6066 The primary area address cannot be removed. Refer to the error message text.

EID-6067 The selected area address does not exist. Choose another area address.

EID-6068 The IP-over-CLNS NSEL cannot be modified while there are 
IP-over-CLNS tunnel routes provisioned. 

You cannot change the NSEL address if 
tunnels are provisioned.

EID-6069 The node is currently in ES mode. Only Router 1 can be 
provisioned. 

An End System needs only one provisioned 
router.

EID-6070 No router was selected. Select a router.

EID-6071 The TARP data cache cannot be flushed. You cannot flush the cache in the Tunnel 
identifier Address Resolution Protocol 
(TARP) state.

EID-6072 The TARP data cache entry cannot be added: 
{0} 

You cannot add the specified cache entry.

WID-6073 A TARP request has been initiated. 
Try refreshing the TARP data cache later. 

Refer to the warning message text.

EID-6074 End system mode only supports one subnet. Refer to the error message text.

EID-6075 An error occurred while trying to remove a MAT entry. The 
entry does not exist. 

CTC is removing the MAT entry.

EID-6076 An error occurred while trying to {0} a TARP manual 
adjacency entry: 
{1} 

CTC cannot add the specified adjacency 
entry for reasons unknown.

EID-6077 The area address must be between 1 and 13 bytes long, 
inclusive. 

The area address should not be more than 13 
characters.

EID-6078 A TDC entry with this TID {0} does not exist in the table. The specified Tunnel Identifier does not 
exist.

EID-6079 A TDC entry with this TID {0} could not be removed. 
Please verify that TARP is enabled. 

You must enable TARP to remove the TDC 
entry.

WID-6080 Router {0} does not have an area address in common with 
Router 1. Switching from IS L1/L2 to IS L1 in this case will 
partition your network. 

Refer to the warning message text.

EID-6081 The limit of 10 RADIUS server entries has been reached. CTC does not allow more than 10 RADIUS 
servers.

EID-6082 {0} cannot be empty. The Shared Secrets field should not be 
empty.

EID-6083 The entry you selected for editing has been altered by another 
user. The changes cannot be committed. 

Refer to the error message text.

EID-6084 The RADIUS server entry already exists. Specify another RADIUS server entry.
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WID-6085 Disabling shell access will prevent Cisco TAC from connecting 
to the vxWorks shell to assist users. 

Refer to the warning message text.

EID-6086 The card cannot be changed because card resources are in use. The card you are trying to remove is being 
used. Cannot change the card.

EID-6087 The card cannot be changed because the card type is invalid or 
incompatible. 

Refer to the error message text.

EID-6088 This line cannot be put into loopback while it is in use as a 
timing source.

Refer to the error message text.

EID-6089 The interface was not found. {0} CTC cannot find the specified interface.

EID-6090 The interface type is not valid for this operation. {0} Choose another interface.

EID-6091 The current state of the interface prohibits this operation. {0} The port is in an invalid state to set a 
loopback.

EID-6092 This operation is prohibited for this interface. {0} CTC does not allow this operation for the 
specified interface.

EID-6093 The maximum number of TARP data cache entries has been 
exceeded. 

You have exceeded the number of 
characters permitted.

EID-6094 The maximum number of manual adjacency table entries has 
been exceeded. 

Refer to the error message text.

EID-6095 The AIS/Squelch mode is invalid. Refer to the error message text.

EID-6096 A default IP-over-CLNS tunnel route is only allowed on a node 
without a default static route and a default router of 0.0.0.0.

Refer to the error message text.

EID-6097 The authorization key does not comply with Cisco IOS 
password restrictions. 
{0} 

Specify another authorization key.

EID-6098 A default static route is not allowed when a default 
IP-over-CLNS tunnel exists.

Refer to the error message text.

EID-6099 You cannot create a subnet on a disabled router. Create the subnet on an active router.

WID-6100 Disabling a router that has a provisioned subnet is not 
recommended.

Refer to the warning message text.

EID-6101 The MAT entry already exists. Refer to the error message text.

WID-6102 The new card has less bandwidth than the current card. Circuits 
of size VT15 and larger will be deleted.

Refer to the warning message text.

EID-6103 The TDC entry already exists. Specify another entry for TARP Data 
Cache.

EID-6104 APC ABORTED. Automatic Power Control is aborted.

EID-6105 The 'Change Card' command is valid for MRC cards only when 
Port 1 is the sole provisioned port.

Refer to the error message text.

EID-6106 To delete all RADIUS server entries, RADIUS authentication 
must be disabled.

Disable Radius authentication and proceed.
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EID-6107 The node failed to restart the TELNET service on the selected 
port. Try using another unreserved port that is not being used 
within the following ranges: 
23, 1001-9999 (with the exception of 1080, 2001-2017, 2361, 
3081-3083, 4001-4017, 4022, 4081, 4083, 5000, 5001, 7200, 
9100, 9300, 9401).

Refer to the error message text.

EID-6108 That port is already in use. Restart a TELNET session.

EID-6109 A section trace is active on the trunk port. The action cannot be 
completed.

Actions such as putting the port in an 
incomplete state are not permitted while a 
section trace is active.

EID-6110 The maximum number of TARP requests has been reached. You have exceeded the maximum number 
of TARP requests.

EID-6111 The card in Slot {0} cannot be removed from the protection 
group while its traffic is switched. 

Refer to the error message text.

EID-6112 An error occurred while adding a shelf: {0} The shelf ID specified is invalid or already 
exists, the equipment does not support 
multishelf, the specified shelf position is 
out of range, or the specified shelf position 
is already in use.

EID-6113 An error occurred while deleting a shelf: {0} One or more of the equipment modules 
(provisioned virtual links, provisioned 
server trails, provisioned protection groups, 
or provisioned DCCs) in the shelf is 
currently in use. Delete cards from all the 
slots and try again.

EID-6114 The maximum number of supported shelves has already been 
provisioned. 

Refer to the error message text.

EID-6115 There are bad or duplicate shelf positions. 
Valid rack numbers are {0} to {1}. 
Valid rack positions are {2} to {3}. 

Refer to the error message text.

EID-6116 CTC attempted to access an OCH-Trail connection that has 
been destroyed. 

Software has prevented an attempt to access 
an OCH trail.

EID-6117 CTC attempted to access an OCH-Trail audit that has been 
destroyed. 

The resource cannot be accessed because it 
is released or fully utilized.

WID-6118 The following slots are provisioned but do not have cards 
installed: 
{0} 
CTC will assume they are ITU-T interfaces. 

Refer to the warning message text.

EID-6119 The shelves could not be rearranged. 
{0} 

One of the following conditions is present: 
duplicate shelf positions, invalid shelf 
positions, or concurrent movement (two 
CTC sessions are attempting to rearrange 
the shelves at the same time.)

EID-6120 This equipment does not support multishelf. Refer to the error message text.
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WID-6121 This internal patchcord cannot be provisioned because the 
endpoints have no compatible wavelengths.

The end points of an internal patchcord 
should have compatible wavelengths.

EID-6122 The wizard could not be started. 
{0} 

CTC was unable to initiate the wizard due 
to the specified reason.

EID-6123 The OSI request can not be completed successfully. A communication failure occurred.

EID-6124 The ALS recovery pulse interval is invalid. Refer to the error message text.

EID-6125 The ALS recovery pulse duration is invalid. Refer to the error message text.

EID-6126 The current setting does not support the specified ALS mode. Refer to the error message text.

EID-6127 All enabled routers are required to have the same area. Refer to the error message text.

EID-6128 A software download is in progress. Configuration changes that 
result in a card reboot cannot take place during a software 
download. 
Please try again after the software download is done. 

Refer to the error message text.

EID-6129 The payload configuration and card mode are incompatible. Refer to the error message text.

EID-6135 A DCC is present. A data communication channel (DCC) 
already exists.

EID-6136 An error occurred during provisioning: {0} CTC was not able to provision the specified 
port or card.

EID-6137 Multishelf cannot be disabled. 
{0} 

Multishelf is not supported on equipment, is 
already disabled, or modules on the shelf 
are currently in use.

EID-6138 The LAN configuration is invalid. Verify the LAN configuration.

EID-6139 Invalid card(s) are present. 
Please remove all non-MSTP cards and try again. 

Non-DWDM cards cannot be added to an a 
DWDM node. Remove the cards.

EID-6140 The shelf identifier for a subtended shelf cannot be provisioned 
through CTC. It must be changed using the LCD. 

Refer to the error message text.

EID-6143 The DHCP server could not be changed. Refer to the error message text.

EID-6144 The port provisioning cannot be changed when the port media 
is Undefined. 

If the port is not pre-provisioned with the 
type of media that is going to be inserted, 
you cannot access any of the existing values 
for the port.

WID-6145 OSPF on LAN should only be enabled when the LAN routers 
run OSPF. Otherwise, the node will not be reachable from 
outside its subnet. 
RIP implementation only advertise routes in one direction to 
connected routers. It does not learn or distribute routes 
advertised by other routers. 
Also note that enabling OSPF on the LAN will temporarily 
cause the current list of static routes to stop being advertised to 
remote nodes and only be used locally.

Refer to the warning message text.
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WID-6146 Deleting the protection group while in a switched state might 
cause a loss of traffic. It is recommended that you verify switch 
states before proceeding.

Refer to the warning message text.

EID-6147 The protection switch could not be performed. A protection switch cannot be performed 
during protection operations like manual 
switch, lockout, and so on.

EID-6148 A server trail is present. Refer to the warning message text.

EID-6149 The LAPD MTU size must be greater than or equal to the {0} 
LSP buffer size {1}. Alternatively, you can decrease the {0} 
LSP buffer size to {2}.

Refer to the error message text.

EID-6150 The value is out of range. Enter a value that is within the range.

EID-6151 The minimum span loss must be less than the maximum span 
loss.

Refer to the error message text.

EID-6152 The "Use NTP/SNTP Server" field is checked. Enter the 
NTP/SNTP server IP address or server name.

Enter the NTP/SNTP server name. To leave 
this field empty, uncheck the “Use 
NTP/SNTP Server" and proceed.

EID-6153 The maximum frame size is invalid. Refer to the error message text.

EID-6154 To combine unidirectional two-port provisioning and 
autonegotiation on the same port, autonegotiation must be set 
first.

Refer to the error message text.

EID-6155 Transponder mode cannot be provisioned with circuits on the 
card.

Refer to the error message text.

EID-6156 The transponder configuration is invalid. The transponder is not configured properly.

EID-6157 The watermark values are either out of range or inconsistent. Enter valid watermark values.

EID-6179 The 1+1 protection group is not optimized. Refer to the error message text.

EID-6196 The equipment has failed or is missing. Operation is requested on a failed or 
missing equipment.

EID-6197 Attributes cannot be changed when the port administrative state 
is {0}.

You cannot change the attributes when the 
port is in the specified administrative state.

WID-6204 This action will cause the node to reboot. When provisioning in 
single-shelf mode, Shelf {0} of the node that you connect to 
must be properly preprovisioned or you will lose traffic.  
Use the LCD to return to single-shelf mode. CTC cannot be 
used for this.  
Changing from subtended shelf mode to single-shelf mode 
could be traffic-affecting.

Refer to the warning message text.

EID-6205 The interlink port is not provisioned. The user creates an ADM peer group 
without interlink ports.

EID-6206 The ADM peer group has already been created on the peer card. The user creates an ADM peer group 
involving an ADM card inserted in a peer 
group.
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EID-6207 This card is not in the ADM peer group. The selected ADM card is not involved in 
an ADM peer group.

EID-6208 The payload is not OTU2. Refer to the error message text.

EID-6209 The side is already defined by the node. During the creation of a side on node, a side 
is already defined.

EID-6210 No side was selected. The user requests an operation on a side, but 
no side is selected.

EID-6211 The side was not deleted. CTC could not delete the selected side 
successfully.

EID-6212 One of the ports is connected to a patchcord or virtual link. An operation on a port was not performed 
because the port is connected to a patchcord 
or a virtual link.

EID-6213 It is not possible to associate the side to the two ports. During the creation of a side it is not 
possible to associate the selected ports to 
the new side.

EID-6214 The port is already assigned to a side. The selected port is already assigned to a 
side.

EID-6215 Error provisioning the CVLAN ID. 
Enter a valid number or range between 0 and 4094. 

The entered CVLAN ID was out of the 
admitted range.

EID-6216 Changing card will reset the optical thresholds to the default 
setting and may affect the optical connection. 
The optical connection will work only if the optical 
performance is compatible with {0} card. 
Please check the network design.

Refer to the error message text.

EID-6217 You cannot delete the {0} {1}. You cannot delete {0} {1} because it is part 
of an ADM peer group or one or more 
circuits are provisioned on it.

EID-6218 Invalid ethernet duplex value the Ethernet duplex value is invalid. Enter 
again.

EID-6219 Invalid committed info rate The committed info rate value is invalid. 
Enter again.

EID-6220 Invalid mode value The mode value is invalid. Enter again.

EID-6221 Invalid mtu value The MTU value is invalid. Enter again.

EID-6222 Invalid flow control value The flow control value is invalid. Enter 
again.

EID-6223 Invalid Network Interface Mode The network interface mode value is 
invalid. Enter again.

EID-6224 Invalid ingress COS value The ingress COS value is invalid. Enter 
again.

EID-6225 Invalid ethertype value The Ethertype value is invalid. Enter again.
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EID-6226 Invalid buffer size value The Buffer size value is invalid. Enter 
again.

EID-6227 Invalid egress QOS value The egress QOS value is invalid. Enter 
again.

EID-6228 Invalid QinQ working Mode The QinQ working mode is invalid. Enter 
again.

EID-6229 Configured protection status Not Supported The protection status is not supported

EID-6230 The number of provisioned entries exceeds the limit Refer to the error message text.

EID-6231 This is not a valid VLAN ID. Entered VLAN ID is not present in the 
database file.

EID-6232 The VLAN remapping ID is not allowed. Refer to the error message text.

EID-6233 The CVLAN is duplicated. You cannot have identical CVLAN IDs.

EID-6234 The VLAN ID is out of range. The VLAN ID entered is out of range.

EID-6235 This is not a valid VLAN name. The entered VLAN name exceeds the 
number of characters (32) allowed.

EID-6236 The protected VLAN number exceeds the maximum allowed. The user enters more than 256 protected 
VLAN in the VLAN database.

EID-6237 The port is not in OOS disabled admin state Refer to the error message text.

EID-6238 The VLAN ID is in use. The entered VLAN ID is in use by a node.

EID-6239 APC wrong node side. Refer to the error message text.

EID-6240 You cannot change the Admin State for an interlink port when 
it is part of an ADM peer group. This operation is not 
supported. 

Refer to the error message text.

EID-6242 The protection slot is invalid. You must select a valid protection slot.

EID-6243 The {0} address of {1} is invalid. Refer to the error message text.

EID-6244 The mask of {0} is invalid. The mask of the specified value is not valid.

EID-6245 The cost must be between 1 and 32767. Refer to the error message text.

EID-6246 The {0} address cannot be {1}. Refer to the error message text.

EID-6247 The authentication type is invalid. Enter a valid authentication type.

EID-6248 The cost must between 1 and 15. Refer to the error message text.

EID-6249 The port has a cross-connect. Refer to the error message text.

EID-6250 The reversion time is invalid. The reversion time is invalid. Enter again.

EID-6251 Invalid Margin For Span Aging. 
Value is not in the range 0 - 10. 

Enter a value between 0 and 10.

EID-6252 The data cannot be retrieved because ANS parameters cannot 
be calculated on the node in its current configuration. 

Refer to the error message text.

EID-6253 Invalid Margin For Span Aging. Refer to the error message text.
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EID-6254 SDH mode does not support timing references. Timing reference is not supported by SDH 
mode.

EID-6255 Only DS1 interfaces with ESF line types support timing 
references. 

Refer to the error message text.

EID-6256 sendDoNotUse and sendDoNotUseFF are mutually exclusive. Refer to the error message text.

EID-6257 The termination is already in use. Refer to the error message text.

EID-6258 The side is carrying services or traffic. Refer to the error message text.

EID-6259 A pluggable module on Port 22 remains unmanaged. Refer to the error message text.

EID-6260 You cannot delete this port. 
There was a severe architectural error related to the index of the 
pluggable trunk port object. 
Please contact technical support for assistance. 

Refer to the error message text.

EID-6261 This is not a valid VLAN ID. The VLAN database is empty. The user adds a row without a valid VLAN 
database loaded.

EID-6263 The equipment requires two slots. The user provisions a double footprint card 
in a single slot.

EID-6264 The patchcord is duplicated. Refer to the error message text.

EID-6265 The wavelength is in use by an OCH trail, a virtual link, or an 
internal patchcord. 

Refer to the error message text.

EID-6266 The card cannot be changed because the port has not been 
provisioned. 

Refer to the error message text.

EID-6267 Each port can have a maximum of 8 MAC addresses. Refer to the error message text.

EID-6268 This server trail does not have a valid start or end. Refer to the error message text.

EID-6269 The maximum number of server trails is 3743. Refer to the error message text.

EID-6270 A unique server trail ID could not be allocated. Refer to the error message text.

EID-6271 The server trail already exists. Refer to the error message text.

EID-6272 The server trail size must not exceed the port bandwidth. Refer to the error message text.

EID-6273 An OCH Trail circuit is active on the trunk port. 
To modify the ITU-T G.709 parameter, the circuit must be out 
of service. 

Refer to the error message text.

EID-6274 Unable to restore this database: 
The software version cannot be obtained from the node. Please 
try again.

Refer to the error message text.

EID-6275 You cannot change this parameter. 
The port is part of an active circuit.

Certain parameters like Port Rate and 
Admin State cannot be changed when the 
port is part is part of an active circuit. 
Delete all the circuits on the port before 
changing admin state of the port.

EID-6276 APC is disabled. APC Correction Skipped. Override cannot be 
performed. 

Refer to the error message text.
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EID-6277 There are no alarm conditions available to run APC Correction 
Skipped Override. 

Refer to the error message text.

EID-6278 APC Correction Skipped Override is not supported for this 
card. 

Refer to the error message text.

EID-6279 Protection cannot be disabled when the FPAS alarm is active. Refer to the error message text.

WID-6280 Any configuration change will be lost and the operation is 
traffic affecting. 

Refer to the error message text.

EID-6281 The port is involved in a protection group. 
The protected port is not in the {0} administrative state

Change the port state to administrative.

WID-6282 Forcing FPGA update will be traffic-affecting. Refer to the error message text.

WID-6283 Enabling ALS on a DWDM trunk port that is connected to a 
channel filter 
will result in a conflict with the ALS on the amplifier card or 
with the 
VOA startup process. Is it OK to continue? 

Refer to the error message text.

WID-6284 Changing the timing standard will re-initialize the shelf timing  
and might affect traffic. 
 
OK to continue? 

Refer to the error message text.

WID-6285 Since you are changing the IP address of one node containing 
some PPC terminations, 
you are also requested to run the PPC Repair tool in order to fix 
the IP addresses stored 
in the nodes connected by these PPCs

Refer to the error message text.

EID-6286 The port type cannot be changed because the port has been 
deleted. 

Refer to the error message text.

EID-6287 You cannot edit the {0} {1}. Port rate of Optical and Electrical ports 
cannot be changed while circuits are 
provisioned on them.

EID-6288 The BERT configuration is invalid. Refer to the eror message text.

EID-6289 The BERT mode is not yet configured Refer to the error message text.

WID-6290 The BERT mode is configured in unframed format Refer to the error message text.

WID-6291 Port has circuits; configuring the BERT mode will disrupt 
normal traffic. 

Refer to the error message text.

EID-6292 The alarm type name cannot exceed 20 characters Refer to the error message text.

EID-6294 The alarm type name contains invalid characters. 
Only the following characters are valid: 0-9, A-z, a-z and "-".

Refer to the error message text.

EID-6295 The alarm type is in use and cannot be deleted. Refer to the error message text.

EID-6296 Maximum number of alarm types that can be added cannot 
exceed 50. 

Refer to the error message text.

EID-6297 Hard coded alarm types cannot be deleted. Refer to the error message text.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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EID-6298 The alarm type already exists. Refer to the error message text.

EID-6299 The alarm type does not exist. Refer to the error message text.

EID-6300 Selective auto negotiation is allowed only when  
selected speed and duplex modes are non-auto. 
Click "Reset" to revert the changes.

Refer to the error message text.

WID-6301 Selective auto negotiation applies only to copper SFPs. Refer to the error message text.

EID-6302 Users are not allowed to perform this operation. When logged in as a maintainence user 
provisioning operation is not allowed.

EID-6303 The ITU-T G.709 configuration cannot be disabled  
when Fast Protection is enabled.

Refer to the error message text.

1. EID-3159 can appear if you attempt to perform another switching operation within a certain time interval. This interval is an algorithm of three seconds 
per working card in the protection group. The maximum interval is 10 seconds.

Table 4-1 Error Messages (continued)

Error Warning 
ID Error Warning Message Description
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I N D E X
Numerics

1+1 protection

Force switch see external switching commands

Manual switch see external switching commands

APS channel byte failure     2-39

APS invalid code condition     2-44

disable switching     2-131

far-end forced switch back to working 
condition     2-107

optimized 1+1 APS primary facility condition     2-45

2R logical object     2-20

A

ADMIN-DISABLE     3-4

ADMIN-DISABLE-CLR     3-4

ADMIN-LOCKOUT     3-4

ADMIN-LOCKOUT-CLR     3-4

ADMIN-LOGOUT     3-5

ADMIN-SUSPEND     3-5

ADMIN-SUSPEND-CLR     3-5

AICI-AEP logical object     2-20

AICI-AIE logical object     2-20

AIP

logical object     2-20

MAC address location     2-132

MEA     2-182

replace     2-283

air filter, replace     2-279

AIS

AIS     2-37

AIS-L     2-37
AIS-P     1-137, 2-38

AIS-V     1-136, 2-38

AUTOSW-AIS     2-52

FE-AIS     2-103

ODUK-1-AIS-PM     2-190

ODUK-2-AIS-PM     2-190

ODUK-3-AIS-PM     2-190

ODUK-4-AIS-PM     2-190

ODUK-AIS-PM     2-190

OTUK-AIS     2-193

TX-AIS     2-252

alarm logical objects

alarm index     2-23

definition list     2-19

alarms

alarms in this index appear individually by name

alphabetical list     2-11

characteristics     2-32

frequently used troubleshooting procedures     2-261

list of critical alarms     2-2

list of major alarms     2-3

list of minor alarms     2-4

states     2-35

TL1     2-1

alarm troubleshooting     2-1 to 2-285

alphabetical alarm list     2-11

ALS     2-39

AMI coding     2-149

AMPLI-INIT     2-39

AOTS logical object     2-20

APC-CORR-SKIPPED     2-39

APC-DISABLED     2-39

APC-END     2-39
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APC-OUT-OF-RANGE     2-39

APC-WRONG-GAIN     2-39

APSB     2-39

APSCDFLTK     2-40

APSC-IMP     2-41

APSCINCON     2-42

APSCM     2-42

APSCNMIS     2-43

APSIMP     2-44

APS-INV-PRIM     2-45

APSMM     2-45

APS-PRIM-FAC     2-46

APS-PRIM-SEC-MISM     2-46

ARP     1-132

AS-CMD     2-47

AS-MT     2-48

AS-MT-OOG     2-48

asynchronous mapping     2-197

AUD-ARCHIVE FAIL     3-5

AUD-LOG-LOSS     2-49

AUD-LOG-LOW     2-49

AUTOLSROFF     2-49

automatic protection switching

byte failure     2-39

channel failure on protect card     2-112

channel mismatch     2-42

invalid k bytes     2-41

mode mismatch failure     2-45

path protection alarms     2-53, 2-54, 2-55

path protection switch (condition)     2-53

ring switch failure     2-97

span switch failure     2-99

automatic reset     2-51

AUTONEG-RFI     2-50

AUTORESET     2-51

AUTOSW-AIS     2-52

AUTOSW-LOP (STSMON)     2-52

AUTOSW-LOP (VT-MON)     2-53

AUTOSW-PDI     2-53
IN-2
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AUTOSW-SDBER     2-54

AUTOSW-SFBER     2-54

AUTOSW-UNEQ (STSMON)     2-55

AUTOSW-UNEQ (VTMON)     2-55

AUTOWDMANS     3-5

AWG-DEG     2-56

AWG-FAIL     2-56

AWG-OVERTEMP     2-56

AWG-WARM-UP     2-56

B

B8ZS     2-148, 2-149

BAT-FAIL     2-56

BER

threshold range     2-218, 2-219

verify threshold level     2-276

BERT-ENBL     2-57

BERT-SYNC-FAIL     2-57

BIC logical object     2-20

bit error rate see BER

BITS

daisy-chained     1-139

errors     1-138

holdover timing     1-139

loss of frame     2-148

loss of signal     2-158

BITS logical object     2-20

BKUPMEMP     2-57

BLSR

change node ID number     2-262

change ring name     2-262

far-end protection line failure     2-112

improper configuration (alarms)     2-40

manual span condition     2-181

ring mismatch     2-208

ring switch failure     2-97

squelch alarm     2-229

verify node visibility     2-262
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BLSROSYNC     2-58

BLSR-RESYNC     3-5

BLSR-SW-VER-MISM     2-58

BNC connector     2-203, 2-251

BPLANE logical object     2-20

BPV     2-59

browser

applet security restrictions     1-126

does launch Java     1-117

limit Netscape colors     1-121

reconfigure     1-118

reset     1-121

stalls during download     1-123

supported     1-115

unsupported     1-116

C

card reset

LED activity     2-261

procedure     2-271

cards

replace     2-274

reseat     2-274

see also cross-connect cards

see also electrical cards

see also OC-N cards

see also TCC2 card

see also TCC2P card

see also CE-Series Ethernet cards

see also E-Series Ethernet cards

see also G-Series Ethernet cards

see also ML-Series Ethernet Cards

CARLOSS

cause of TPTFAIL     2-249

CE1000     2-59

CE100T     2-59

CEMR     2-59

E1000     2-60
November 2009
E100T     2-60

EQPT     2-61

FC     2-63

G1000     2-63

GE     2-66

ISC     2-66

ML100T, ML1000, MLFX, MLMR     2-66

TRUNK     2-67

carrier loss see CARLOSS

CASETEMP-DEG     2-67

CBIT framing     1-46

CE1000 logical object     2-20

CE100T

logical object     2-20

see also CE-Series Ethernet cards

CEMR

logical object     2-20

see also CE-Series Ethernet cards

CE-Series Ethernet cards

carrier loss     2-59

facility loopback behavior     1-4

LED activity     2-260

loopbacks     1-69

terminal loopback behavior     1-6

terminal loopback condition     2-174

transport layer failure alarm     2-248

circuits

see also hairpin circuits

see also loopbacks

AIS-V alarm on DS3XM-6 or DS3XM-12 card     1-136

bidirectional diagnostic circuits     1-110

circuit state transition error     1-135

delete     2-276

generic procedures     2-276

identify circuit state     1-135

path-in-use error     1-130

troubleshoot electrical circuits     1-9

troubleshoot Ethernet circuits     1-68

troubleshoot FC_MR-4 circuits     1-94
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troubleshoot optical circuits     1-47

VT1.5 circuit creation error     1-137

CLDRESTART     2-67

COMIOXC     2-68

COMM-FAIL     2-68

conditions

conditions are indexed individually by name

characteristics     2-32

list of not-alarmed conditions     2-6

list of not-reported conditions     2-10

CONTBUS-A-18     2-69

CONTBUS-B-18     2-69

CONTBUS-DISABLED     2-70

CONTBUS-IO-A     2-71

CONTBUS-IO-B     2-72

CPP-INCAPABLE     2-72

critical alarms

definition     2-32

list of alarms     2-2

cross-connect cards

LED activity during side switch     2-261

main payload bus failure     2-75

replace     2-275

reset (side switch)     2-272

test during a cross-connect loopback     1-20, 1-21

test during a hairpin circuit     1-16, 1-18, 1-34, 1-35, 1-76, 
1-77, 1-92, 1-93

cross-connect loopback

description     1-8

clear an OC-N card loopback circuit     2-277

perform on a destination-node OC-N carrying an 
electrical circuit     1-18

perform on a source-node STS carrying an electrical 
circuit     1-36

perform on a source OC-N port     1-53

CTC

applet not loaded     1-117

applet security restrictions     1-126

cannot change node view to network view     1-122

cannot launch     1-123
IN-4
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colors appear incorrectly on UNIX workstation     1-121

correct the core version build     1-128, 1-129

delete cache files     1-124

gray node icon     1-126

list of alarms     2-1

log-in errors     1-117, 1-123, 1-126, 1-129

loss of TCP/IP connection     2-61

release interoperability problems     1-128

slow operation or login problems     1-124

username and password mismatch     1-129

verifying PC connection     1-119

CTC_HEAP variable     1-122

CTNEQPT-MISMATCH     2-73

CTNEQPT-PBPROT     2-74

CTNEQPT-PBWORK     2-75

CTRL logical object     2-20

cyclic redundancy checking (CRC)     2-57

D

database

memory exceeded     2-77

out of synchronization     2-78

restore     1-114

verify version     2-283

data communications network see DCN tool

DATA-CRC     2-76

DATAFLT     2-77

DBBACKUP-FAIL     3-5

DBOSYNC     2-77

DBRESTORE-FAIL     3-6

DCC

channel loss     2-83, 2-85

connection loss     1-130

create or verify DCC terminations     2-276

delete a DCC termination     2-129

limitations with OC-3     1-138

DCN tool     1-113

DCU-LOSS-FAIL     2-78
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default K alarm     2-40

diagnostic tests

bidirectional diagnostic circuit     1-110

lamp test     1-108

overview     1-107

retrieve     1-110

DISCONNECTED     2-78

DS1 logical object     2-20

DS3 logical object     2-20

DS3-MISM     2-79

DS3XM-12 card

AIS-V alarm and unused VT circuits     1-136

clear a loopback circuit     2-277

create a facility loopback     1-11, 1-29

create a terminal loopback     1-25

facility loopback behavior     1-4

FEAC loopbacks     1-45

incomplete circuit from DS-3 card     1-137

terminal loopback behavior     1-6

test and clear a facility loopback circuit     1-12, 1-30

test and clear a terminal loopback circuit     1-26

DS3XM-6 card

AIS-V alarm and unused VT circuits     1-136

clear a loopback circuit     2-277

create a facility loopback     1-11, 1-29

create a terminal loopback     1-25

facility loopback behavior     1-4

FEAC loopbacks     1-45

incomplete circuit from DS-3 card     1-137

terminal loopback behavior     1-6

test and clear a facility loopback circuit     1-12, 1-30

test and clear a terminal loopback circuit     1-26

DS-N cards

see also DS3XM-12 card

see also DS3XM-6 card

see also electrical cards

DSP-COMM-FAIL     2-79

DSP-FAIL     2-79

DUP-IPADDR     2-79
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DUP-NODENAME     2-80

DUP-SHELF-ID     2-81

DWDM cards

GBIC compatibility     1-145

OCH alarm object     2-21

OCHNC-CONN alarm object     2-21

E

E1000

logical object     2-20

see also E-Series Ethernet cards

E100T

logical object     2-20

see also E-Series Ethernet cards

E1 logical object     2-20

east⁄west mismatch alarm     2-91

EC-1 card

loopback facility alarm     2-171, 2-175

LOS     2-163

see also electrical cards

EC1 logical object     2-20

EFM-ERR-FRM     3-6

EFM-FRM-PER     3-6

EFM-FRM-SEC     3-6

EFM-RLBK-FAIL     3-6

EFM-SYM-PER     3-7

EHIBATVG     2-81

EIAs

replace     2-282

test during a facility loopback     1-14, 1-32

electrical cable

CAT-5 problems     1-118

crimp     1-142

test during a facility loopback     1-13, 1-30

electrical cards

clear loopbacks     2-278

create a facility loopback     1-10, 1-28

create a hairpin circuit     1-15, 1-33
IN-5
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create a terminal loopback     1-23

DS-3 idle condition     2-131

facility loopback behavior     1-4

facility loopback example     1-3

failure to switch     2-95

frame format mismatch     2-79

idle DS-3 signal     2-108

initiate a protection switch     2-266

LED activity     2-260

LOF     2-149, 2-150

loopback facility alarm     2-170, 2-175

loopback signal received     2-169

loss of signal     2-159, 2-160

reset     2-271

terminal loopback behavior     1-6

test and clear a facility loopback circuit     1-11, 1-29

test and clear a terminal loopback circuit     1-24

test and delete a hairpin circuit     1-16, 1-34

test during a facility loopback     1-13, 1-31

test during a terminal loopback     1-27

ELWBATVG     2-81

ENCAP-MISMATCH-P     2-81

ENVALRM logical object     2-20

EOC

EOC     2-83

EOC-L     2-85

GCC-EOC     2-117

EQPT

EQPT     2-86

EQPT-DIAG     2-87

EQPT-MISS     2-87

logical object     2-20

MEA     2-183

equipment failure

far-end DS-1 failure     2-104

far-end DS-3 failure     2-106

hardware failure on reporting card     2-86

missing fan-tray assembly     2-88

software or hardware failure on reporting card     2-87
IN-6
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ERFI-P-CONN     2-88

ERFI-P-PAYLD     2-88

ERFI-P-SRVR     2-89

ERROR-CONFIG     2-89

error messages     4-1 to 4-51

ESCON logical object     2-20

E-Series Ethernet cards

carrier loss     2-60

verify LED operation     1-109

Ethernet

see also CE-Series Ethernet cards

see also E-Series Ethernet cards

see also G-Series Ethernet cards

see also ML-Series Ethernet cards

cable with reversed receive pairs     2-137

configure VLANs     1-134

connectivity problems     1-131

create a hairpin circuit     1-75, 1-91

Tag/Untag port connectivity     1-132

troubleshoot Ethernet circuit paths     1-68

verify connections     1-131

ETH-LINKLOSS     2-90

E-W-MISMATCH     2-91

EXCCOL     2-93

excess collisions     2-93

EXERCISE conditions

EXERCISE-RING-FAIL     2-93

EXERCISE-SPAN-FAIL     2-94

EXT     2-94

external switching commands

BLSR Force Ring condition     2-107

BLSR Force Span condition     2-108, 2-114

BLSR Lockout Protect Span condition     2-109

BLSR Manual ring condition     2-180

clear a 1+1 Force or Manual switch     2-264

clear a BLSR switching command     2-270

clear a lock-on or lockout     2-265

clear a path protection span switch     2-268

initiate a 1+1 Manual switch     2-263
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initiate a 1+1 Protection switch     2-263

initiate a 1:1 card switch command     2-266

initiate a BLSR exercise ring switch     2-270

initiate a BLSR Force ring switch     2-268

initiate a BLSR Force span switch     2-268

initiate a BLSR lockout     2-269

initiate a BLSR Manual ring switch     2-269

initiate a BLSR Manual span switch     2-269

initiate a lock-on     2-264

initiate a lockout     2-265

initiate a path protection Force switch     2-266

initiate a path protection lockout     2-267

initiate a path protection Manual switch     2-267

path protection Manual Ring condition     2-111

side switch a cross-connect card     1-21

EXTRA-TRAF-PREEMPT     2-95

EXT-SREF logical object     2-20

F

facility alarms, hierarchy     2-33

facility loopback

definition     1-3

card view indicator     1-3

clear an OC-N loopback circuit     2-277

create on an intermediate-node Ethernet port     1-78

perform on a destination-node electrical port     1-27

perform on a destination-node Ethernet port     1-84

perform on a destination-node FC_MR-4 card     1-103

perform on a destination-node OC-N port     1-63

perform on an intermediate-node Ethernet port     1-78

perform on an intermediate node FC_MR-4 card     1-99

perform on an intermediate node OC-N port     1-57

perform on a source-node Ethernet port     1-69

perform on a source-node OC-N port     1-48

perform on source-node FC_MR-4 cards     1-94

test a source electrical port     1-10

FAILTOSW     2-95

FAILTOSW-PATH     2-96
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FAILTOSWR     2-97

FAILTOSWS     2-99

FAN     2-100

FAN logical object     2-21

fan-tray assembly

MEA     2-186

missing unit alarm     2-88

replace     2-281

reseat     2-281

FAPS     2-101

FAPS-CONFIG-MISMATCH     2-101

far-end alarms, hierarchy     2-35

FC_MR-4 card

clear loopbacks     2-278

facility loopback behavior     1-5

facility loopback condition     2-172

FC-NO-CREDITS alarm     2-102

GFP-DE-MISMATCH alarm     2-118

GFP-EX-MISMATCH     2-119

GFP-NO-BUFFERS     2-120

GFP-UP-MISMATCH     2-121

LED test     1-109

terminal loopback condition     2-176

transport fail alarm     2-248

troubleshoot circuits with loopbacks     1-94

FC-DE-NES     2-101

FC logical object     2-21

FCMR

logical object     2-21

see also FC_MR-4 card

FC-NO-CREDITS     2-102

FDI     2-103

FEAC

alarms     1-47

inhibit loopbacks     1-47

send code     1-46

FE-AIS     2-103

FEC-MISM     2-103

FE-DS1-MULTLOS     2-104
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FE-DS1-NSA     2-104

FE-DS1-SA     2-105

FE-DS1-SNGLLOS     2-105

FE-DS3-NSA     2-105

FE-DS3-SA     2-106

FE-EQPT-NSA     2-106

FE-FRCDWKSWBK-SPAN     2-107

FE-FRCDWKSWPR-RING     2-107

FE-FRCDWKSWPR-SPAN     2-108

FE-IDLE     2-108

FE-LOCKOUTOFPR-SPAN     2-109

FE-LOF     2-109

FE-LOS     2-110

FE-MANWKSWBK-SPAN     2-110

FE-MANWKSWPR-RING     2-111

FE-MANWKSWPR-SPAN     2-111

FEPRLF     2-112

fiber

faulty connections     1-140

verify connections     1-140

FIBERTEMP-DEG     2-112

Fibre Channel card see FC_MR-4 card

FICON card see FC_MR-4 card

firewall, invalid port number     4-12

FIREWALL-DIS     3-7

flash manager     2-57

flow rate     2-93

FORCED-REQ     2-112

FORCED-REQ-RING     2-113

FORCED-REQ-SPAN     2-114

Force switch see external switching commands

FP-LINK-LOSS     2-114

FRCDSWTOINT     2-114

FRCDSWTOPRI     2-115

FRCDSWTOSEC     2-115

FRCDSWTOTHIRD     2-115

FRCDWKSWBK-NO-TRFSW     3-7

FRCDWKSWPR-NO-TRFSW     3-7

free run synchronization     2-115
IN-8
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FRNGSYNC     1-139, 2-115

FSTSYNC     2-116

FTA-MISMATCH     2-116

FUDC logical object     2-21

FULLPASSTHR-BI     2-116

G

G1000

logical object     2-21

see also G-Series Ethernet cards

GAIN-HDEG     2-117

GAIN-HFAIL     2-117

GAIN-LDEG     2-117

GAIN-LFAIL     2-117

GBICs

install     1-145

remove     1-145

replace     1-144

GCC-EOC     2-117

GE logical object     2-21

GE-OOSYNC     2-117

GFP

encapsulation mismatch     2-82

FC_MR-4 congestion     2-102

GFP-CSF alarm     2-117

GFP-DE-MISMATCH alarm     2-118

GFP-EX-MISMATCH alarm     2-119

GFP-FAC logical object     2-21

GFP-LFD alarm     2-119

GFP-NO-BUFFERS alarm     2-120

GFP-UP-MISMATCH alarm     2-121

G-Series Ethernet cards

carrier loss     2-63

clear loopbacks     2-278

facility loopback behavior     1-4

facility loopback condition     2-172

LED activity     2-260

LED test     1-109
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terminal loopback behavior     1-6

terminal loopback condition     2-177

terminal loopback PM behavior     1-7

transport layer failure alarm     2-249

troubleshoot Ethernet circuit paths     1-69

H

hairpin circuit

definition     1-8

perform on a destination-node electrical port     1-33

perform on a destination-node Ethernet port     1-90

perform on a source-node Ethernet port     1-75

perform on source-node electrical port     1-15

HELLO     2-121

HIBATVG     2-122

HI-CCVOLT     2-122

HI-LASERBIAS     2-123

HI-LASERTEMP     2-123

HI-RXPOWER     2-124

HITEMP     2-125

HI-TXPOWER     2-126

HLDOVRSYNC     1-138, 2-127

I

idle signal condition     2-108

I-HITEMP     2-128

ILK-FAIL     2-128

improper card removal     2-128

IMPROPRMVL     2-128

INC-ISD     2-130

INCOMPATIBLE-SEND-PDIP     2-130

INCOMPATIBLE-SW     1-128, 2-130

INHSWPR     2-131

INHSWWKG     2-131

Internet Explorer, reset as default browser     1-121

interoperability problems     1-128
November 2009
INTRUSION     3-7

INTRUSION-PSWD     2-132

INVMACADR     2-132

IOSCFGCOPY     2-134

IOSCFG-COPY-FAIL     3-7

IP connectivity

IP address unknown     1-120

no connectivity exists between nodes     1-130

retrieve IP address     1-120

verify     1-116, 1-119

IP subnets     1-131

ISC logical object     2-21

ISIS-ADJ-FAIL     2-134

J

Java

Jave Runtime Environment see JRE

browser does not launch     1-117

Java plug-in control panel, reconfigure     1-117

JRE

compatibility by software release     1-127

incompatibility     1-127

launch failure     1-117

K

KB-PASSTHR     2-136

KBYTE-APS-CHAN-FAIL     2-136

k bytes

APS default K byte received     2-40

APS node ID mismatch     2-43

K bytes pass through     2-136

test signal     2-41

L

lamp test     1-108
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LAN (CAT-5) cable

crimp     1-142

faulty     1-140

LAN-POL-REV     2-137

LASER-APR     2-137

LASERBIAS-DEG     2-137

LASERBIAS-FAIL     2-138

LASEREOL     2-138

LASERTEMP-DEG     2-138

LCAS

LCAS-CRC     2-138

LCAS-RX-DNU     2-139

LCAS-RX-FAIL     2-140

LCAS-RX-GRP-ERR     2-141

LCAS-TX-ADD     2-141

LCAS-TX-DNU     2-141

LED

blinking STAT LED     1-139

cross-connect card side switch     2-261

lamp test     1-108

traffic card after reset     2-261

traffic card during reset     2-261

traffic card insertion     2-260

line coding     2-148

line framing     2-148, 2-149, 2-151

line interface unit     1-3

LINK-KEEPALIVE     2-142

LKOUTPR-S     2-142

LMP

LMP-SD     2-144

LMP-SF     2-145

LMP-UNALLOC     2-146

LMP-FAIL     2-143

LMP-SD     2-144

LMP-SF     2-145

LMP-UNALLOC     2-146

LOA     2-147

lock initiation     2-263

lock-on see external switching commands
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LOCKOUT-REQ     2-148

lockout see external switching commands

LOF

BITS     2-148

DS1     2-149

DS3     2-150

E1     2-150

EC1     2-151

FE-LOF     2-109

OCN     2-152

OTUK-LOF     2-193

STSTRM     2-152

TRUNK     2-153

TX-LOF     2-252

LOGBUFR90     2-153

LOGBUFROVFL     2-153

logical objects

alarm index     2-23

definition list     2-19

log-in errors

applet security restrictions     1-126

browser login does not launch Java     1-117

browser stallls when downloading .jar file     1-123

no DCC connection     1-130

no IP connectivity     1-130

slow CTC operation     1-124

username/password mismatch     1-129

LOGIN-FAILURE-LOCKOUT     3-8

LOGIN-FAILURE-ONALRDY     3-8

LOGIN-FAILURE-PSWD     3-8

LOGOUT-IDLE-USER     3-8

LO-LASERBIAS     2-154

LO-LASERTEMP     2-154

LOM     2-155

loopback

see also cross-connect loopbacks

see also facility loopback

see also terminal loopback

LOP
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AUTOSW-LOP     2-52, 2-53

LOP-P     2-155

LOP-V     2-156

LO-RXPOWER     2-157

LOS

2R     2-158

BITS     2-158

DS1     2-159

DS3     2-160

E1     2-162

EC1     2-163

ESCON     2-164

FE-LOS     2-110

FUDC     2-164

ISC     2-165

LOS-O     2-167

LOS-P (OCH)     2-167

LOS-P (OMS)     2-167

LOS-P (OTS)     2-167

LOS-P (TRUNK)     2-167

MSUDC     2-165

OCN     2-165

OTS     2-167

TRUNK     2-167

loss of frame see LOF

loss of pointer see LOP

loss of signal see LOS

LO-TXPOWER     2-167

LPBKCRS     2-168

LPBKDS3FEAC     2-169

LPBKDS3FEAC-CMD     2-169

LPBKFACILITY

change alarm suppression defaults     2-32

CE1000     2-169

CE100T     2-169

DS1     2-170

DS3     2-170

E1     2-171

EC1     2-171
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ESCON     2-172

FC     2-172

FCMR     2-172

G1000     2-172

GE     2-173

ISC     2-173

OCN     2-173

TRUNK     2-174

LPBKTERMINAL

change alarm suppression defaults     2-32

CE1000     2-174

CE100T     2-174

CEMR     2-169, 2-174

DS1     2-175

DS3     2-175

E1     2-175

EC1     2-175

ESCON     2-176

FC     2-176

FCMR     2-176

G1000     2-177

GE     2-177

ISC     2-177

OCN     2-177

TRUNK     2-178

LWBATVG     2-178

M

MAC address

CTC location     2-283

invalid     2-132

mismatch     1-133

major alarms

definition     2-33

list of alarms     2-3

MAN-REQ     2-179

MANRESET     2-179

MANSWTOINT     2-179
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MANSWTOPRI     2-180

MANSWTOSEC     2-180

MANSWTOTHIRD     2-180

MANUAL-REQ-RING     2-180

MANUAL-REQ-SPAN     2-181

MANWKSWBK-NO-TRFSW     3-8

MANWKSWPR-NO-TRFSW     3-8

MAX-STATIONS     2-181

MEA

AIP     2-182

BIC     2-182

EQPT     2-183

FAN     2-185

PPM     2-186

SHELF     2-186

MEM-GONE     2-186

MEM-LOW     2-187

MFGMEM     2-187

minor alarms

definition     2-33

list of alarms     2-4

ML1000

logical object     2-21

see also ML-Series Ethernet cards

ML100T

logical object     2-21

see also ML-Series Ethernet cards

MLFX

logical object     2-21

see also ML-Series Ethernet cards

MLMR logical object     2-21

ML-Series Ethernet cards

see also LCAS

C2 byte mismatched path     2-81

carrier loss     2-66

error in startup configuration     2-89

IOS configuration copy in progress condition     2-134

LED activity     2-260

transport layer failure alarm     2-250
IN-12
Cisco ONS 15454 Troubleshooting Guide, R8.5
verify LED operation     1-109

MS-DEG     2-188

MS-EXC     2-188

MSUDC logical object     2-21

MT-OCHNC     2-188

N

near-end alarms, hierarchy     2-34

NE logical object     2-21

NE-SREF logical object     2-21

Netscape Navigator

clear cache     1-123

limit colors     1-121

unable to launch CTC help after removing 
browser     1-121

network testing

see hairpin circuits

see loopbacks

NIC card     1-118, 1-133

NO-CONFIG     2-188

node ID, identify     2-262

NON-CISCO-PPM     2-189

not alarmed alarms

definition     2-33

NOT-AUTHENTICATED     1-129, 2-189

not reported alarms

definition     2-33

O

OCH logical object     2-21

OCHNC-CONN logical object     2-21

OCHNC-INC     2-189

OCHTERM-INC     2-190

OCH-TERM logical object     2-21

OC-N cards

bit errors     1-140

circuit state transition error     1-135
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clear a cross-connect loopback circuit     2-277

clear a facility or terminal loopback circuit     2-277

create a cross-connect loopback     1-19

facility loopback behavior     1-4

hairpin circuits     1-8

LED activity     2-260

lockout request condition     2-148

loopback     1-2

OC-3 and DCC limitations     1-138

reset     2-271

terminal loopback alarm     2-177

terminal loopback behavior     1-6

terminal loopback condition     2-177

test and clear a cross-connect loopback circuit     1-20

transmit and receive levels     1-146

OCN logical object     2-21

ODUK-1-AIS-PM     2-190

ODUK-2-AIS-PM     2-190

ODUK-3-AIS-PM     2-190

ODUK-4-AIS-PM     2-190

ODUK-AIS-PM     2-190

ODUK-BDI-PM     2-190

ODUK-LCK-PM     2-190

ODUK-OCI-PM     2-191

ODUK-SD-PM     2-191

ODUK-SF-PM     2-191

ODUK-TIM-PM     2-191

OMS logical object     2-21

OOU-TPT     2-191

OPEN-SLOT     2-191

optical transmit and receive levels     1-147

OPTNTWMIS     2-192

OPWR-HDEG     2-192

OPWR-HFAIL     2-192

OPWR-LDEG     2-192

OPWR-LFAIL     2-192

OSC-RING logical object     2-21

OSPF

DCN tool     1-113
November 2009
disable OSPF     2-277

HELLO alarm     2-121

OSRION     2-192

OTS logical object     2-22

OTUK-AIS     2-193

OTUK-BDI     2-193

OTUK-IAE     2-193

OTUK-LOF     2-193

OTUK-SD     2-193

OTUK-SF     2-193

OTUK-TIM     2-193

OUT-OF-SYNC     2-193

P

PARAM-MISM     2-194

password⁄username mismatch     1-129

path alarms, hierarchy     2-33

path protection configurations

AIS alarm     2-52

failed switch path     2-96

initiate a Force switch     2-266

initiate a Manual switch     2-267

LOP alarm     2-53

PDI alarm     2-53

SD alarm     2-54

signal failure alarm     2-54

PC requirements     1-115

PDI

AUTOSW-PDI     2-53

PDI-P     2-194

PEER-NORESPONSE     2-195

ping     1-116, 1-119, 2-227

PLM

PLM-P     2-196

PLM-V     2-197

PMI     2-198

PM-TCA     3-8

PORT-FAIL     2-198
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PORT-MISMATCH     2-198

power

battery failure     2-56

extreme high voltage     2-81

extreme low voltage     2-81

high receive power     2-124

high transmit power     2-126

high voltage battery     2-122

improper power supply     1-150

low receive power     2-157

low transmit power     2-168

low voltage battery     2-178

measure power levels     2-85

power failure at connector     2-200, 2-202, 2-203

power monitoring mismatch     2-258

power supply problems     1-148

PPM     2-62

PPM logical object     2-22

PRC-DUPID     2-199

PROTNA     2-199

PROV-MISMATCH     2-200

PS     3-9

PTIM     2-200

PWR-FAIL-A     2-200

PWR-FAIL-B     2-201

PWR-FAIL-RET-A     2-202

PWR-FAIL-RET-B     2-202

PWR logical object     2-22

R

RAI     2-203

RCVR-MISS     2-203

receive levels     1-146

RFI     2-205

ERFI-P-CONN     2-88

ERFI-P-PAYLD     2-88

ERFI-P-SRVR     2-89

RFI-L     2-205
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RFI-P     2-206

RFI-V     2-206

RING-ID-MIS     2-207

RING-MISMATCH     2-208

RING-SW-EAST     2-208

RING-SW-WEST     2-209

RMON-ALARM     3-9

RMON-RESET     3-9

ROLL     2-209

ROLL-PEND     2-209

RPRIF logical object     2-22

RPR-PASSTHR     2-210

RPR-PEER-MISS     2-211

RPR-PROT-ACTIVE     2-212

RPR-PROT-CONFIG-MISM     2-213

RPR-RI-FAIL     2-213

RPR-SD     2-214

RPR-SF     2-215

RPR-SPAN-MISMATCH     2-216

RPRW     2-216

RSV-RT-EXCD-RINGLET0     2-204

RSV-RT-EXCD-RINGLET1     2-205

RUNCFG-SAVENEED     2-217

RX levels     1-147

RX packet     1-7

S

safety summary     2-35

SAN card see FC_MR-4 card

SD

AUTOSW-SDBER     2-54

DS1     2-218

DS3     2-218

E1     2-219

ODUK-SD-PM     2-191

OTUK-SD     2-193

RPR-SD     2-214

SD-L     2-221
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SD-L (trunk)     2-221

SD-P     2-221

SD-V     2-222

TRUNK     2-221

service-affecting alarms, definition     2-35

severities     2-32

SF

AUTOSW-SFBER     2-54

DS1     2-223

DS3     2-223

E1     2-223

ODUK-SF-PM     2-191

OTUK-SF     2-193

RPR-SF     2-215

SF-L     2-224

SF-L (trunk)     2-225

SF-P     2-225

SF-V     2-226

TRUNK     2-224

SFPs

install     1-145

remove     1-145

replace     1-144

SFTWDOWN     2-225

SFTWDOWN-FAIL     3-9

SHELF-COMM-FAIL     2-226

SHELF logical object     2-22

SH-IL-VAR-DEG-HIGH     2-226

SH-IL-VAR-DEG-LOW     2-226

SHUTTER-OPEN     2-227

side switch see external switching commands

SIGLOSS     2-227

signal failure see SF

SMB connector     2-203, 2-251

SNTP-HOST     2-227

SPANLEN-OUT-OF-RANGE     2-228

SPAN-SW-EAST     2-228

SPAN-SW-WEST     2-228

SQM     2-232
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SQUELCH     2-229

SQUELCHED     2-230

SSM

do not use for synchronization     1-138

failure     2-233

quality level degrade     2-233

SSM-DUS     2-233

SSM-FAIL     2-233

SSM-LNC     2-234

SSM-OFF     2-234

SSM-PRC     2-234

SSM-PRS     2-235

SSM-RES     2-235

SSM-SDN-TN     2-235

SSM-SETS     2-235

SSM-SMC     2-235

SSM-ST2     2-236

SSM-ST3     2-236

SSM-ST4     2-236

SSM-STU     2-237

SSM-TNC     2-237

synchronization traceability alarm     2-237

storage access networking card see FC_MR-4 card

STSMON

AUTOSW-LOP     2-52

AUTOSW-UNEQ     2-55

logical object     2-22

STS-SQUELCH-L     2-237

STSTRM logical object     2-22

switching

see automatic protection switching

see external switching commands

SW-MISMATCH     2-238

SWMTXMOD-PROT     2-238

SWMTXMOD-WORK     2-239

SWTOPRI     2-240

SWTOSEC     2-240

SWTOTHIRD     2-240

SYNC-FREQ     2-241
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synchronization status messaging see SSM

SYNCLOSS     2-241

SYNCPRI     2-242

SYNCSEC     2-243

SYNCTHIRD     2-243

SYSBOOT     2-244

T

TCC2 card

communication failure (TCC2 to TCC2)     2-69

flash memory exceeded     2-77

jar file dowload problem     1-123

reseat (remove and reinsert)     2-273

reset     2-271

TCC2P card

communication failure (TCC2P to TCC2P)     2-69

flash memory exceeded     2-77

jar file download problem     1-123

reseat (remove and reinsert)     2-273

reset     2-271

TCP/IP     1-119, 2-61

Telcordia

signal degrade definition     2-218

signal failure definition     2-223

temperature

fan-tray assembly alarm     2-100

high-temperature alarm     2-125

industrial high-temperature alarm     2-128

OC-192 alarm     2-50

TEMP-MISM     2-244

terminal loopback

definition     1-5

card view indicator     1-5

clear an OC-N loopback circuit     2-277

electrical card example     1-6

perform on a destination electrical port     1-22

perform on a destination-node Ethernet port     1-87

perform on a destination-node FC_MR-4 card     1-105
IN-16
Cisco ONS 15454 Troubleshooting Guide, R8.5
perform on a destination-node OC-N port     1-65

perform on an intermediate-node Ethernet port     1-81

perform on an intermediate-node FC_MR-4 
card     1-101

perform on an intermediate OC-N port     1-59

perform on a source-node electrical port     1-40

perform on a source node Ethernet port     1-71

perform on a source-node FC_MR-4 card     1-96

perform on a source-node OC-N port     1-50

TIM

ODUK-TIM-PM     2-191

OTUK-TIM     2-193

PTIM     2-200

TIM     2-245

TIM-MON     2-246

TIM-P     2-246

TIM-S     2-247

TIM-V     2-248

timing alarms

64 clock bipolor density     2-59

see also SSM

force switch to internal timing     2-114

force switch to primary timing     2-115

force switch to secondary timing     2-115

force switch to tertiary timing     2-115

free running synchronization     2-115

loss of frame on BITS     2-148

loss of primary reference     2-242

loss of service on BITS     2-158

loss of tertiary reference     2-243

synchronization     2-127

timing reference failure     2-116

timing reference

automatic switch to secondary source 
(condition)     2-240

automatic switch to third timing source 
(condition)     2-240

change     2-129

manual switch to internal source (condition)     2-179

manual switch to primary source (condition)     2-180
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manual switch to second source (condition)     2-180

manual switch to third source (condition)     2-180

switch error     1-138

TLINK logical object     2-22

TPTFAIL

CE1000     2-248

CE100T     2-248

CEMR     2-248

FCMR     2-248

G1000     2-249

ML100T, ML1000, MLFX, MLMR     2-250

TPTFAIL (ML1000)     2-250

TPTFAIL (ML100T)     2-250

TPTFAIL (MLFX)     2-250

TPTFAIL (MLMR)     2-250

transient conditions

transients are indexed individually by name

alphabetical list     3-1

characteristics     3-3

states     3-4

transmission failure     2-251

transmit levels     1-146

TRMT     2-251

TRMT-MISS     2-251

troubleshooting

see also alarm troubleshooting

see also loopback

alarm characteristics     2-32

conditions     2-32

frequently used procedures     2-261

service effect     2-35

severities     2-32

trouble notifications     2-32

TRUNK logical object     2-22

TX-AIS     2-252

Tx levels     1-147

TX-LOF     2-252, 2-256

Tx packet     1-7

TX-RAI     2-252
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U

UNC-WORD     2-253

UNEQ

AUTOSW-UNEQ (STSMON)     2-55

AUTOSW-UNEQ (VTMON)     2-55

UNEQ-P     2-253

UNEQ-V     2-255

UNIX

incorrect colors     1-121

reset the CTC_HEAP environmental variable     1-122

UNQUAL-PPM     2-256

untag     1-132

USER-LOCKOUT     3-9

USER-LOGIN     3-9

USER-LOGOUT     3-9

username/password mismatch     1-129

UT-COMM-FAIL     2-256

UT-FAIL     2-256

V

VCG-DEG     2-256

VCG-DOWN     2-257

VCG logical object     2-22

VirusScan, disable     1-123

VLAN

cannot connect to network device     1-132

change tagged and untag settings     1-133

VOA

VOA-HDEG     2-257

VOA-HFAIL     2-258

VOA-LDEG     2-258

VOA-LFAIL     2-258

voltage see power

VOLT-MISM     2-258

VT1.5 circuit creation error     1-137

VT-MON logical object     2-22

VT-TERM logical object     2-22
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W

warnings     2-35

west or east misconnection alarm     2-91

WKSWBK     3-10

WKSWPR     2-259, 3-10

WORK-QUEUE-FULL     2-259

workstation requirements     1-115

WTR     2-259

WTR-SPAN     3-10

WVL-MISMATCH     2-260

X

XFPs

install     1-145

remove     1-145

replace     1-144
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	Clear the MEA (BIC) Alarm

	2.7.273 MEA (EQPT)
	Clear the MEA (EQPT) Alarm
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	Clear the MEA (FAN) Alarm
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	Clear the MFGMEM Alarm
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	Clear the NO-CONFIG Condition
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	2.7.298 ODUK-TIM-PM
	2.7.299 OOU-TPT
	Clear the OOT-TPT Condition
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	Clear the OPEN-SLOT Condition
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	2.7.305 OPWR-LFAIL
	2.7.306 OSRION
	2.7.307 OTUK-AIS
	2.7.308 OTUK-BDI
	2.7.309 OTUK-IAE
	2.7.310 OTUK-LOF
	2.7.311 OTUK-SD
	2.7.312 OTUK-SF
	2.7.313 OTUK-TIM
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	2.7.315 PARAM-MISM
	2.7.316 PDI-P
	Clear the PDI-P Condition

	2.7.317 PEER-NORESPONSE
	Clear the PEER-NORESPONSE Alarm

	2.7.318 PLM-P
	Clear the PLM-P Alarm

	2.7.319 PLM-V
	Clear the PLM-V Alarm

	2.7.320 PMI
	2.7.321 PORT-FAIL
	2.7.322 PORT-MISMATCH
	Clear the PORT-MISMATCH Alarm

	2.7.323 PRC-DUPID
	Clear the PRC-DUPID Alarm

	2.7.324 PROTNA
	Clear the PROTNA Alarm

	2.7.325 PROV-MISMATCH
	2.7.326 PTIM
	2.7.327 PWR-FAIL-A
	Clear the PWR-FAIL-A Alarm

	2.7.328 PWR-FAIL-B
	Clear the PWR-FAIL-B Alarm

	2.7.329 PWR-FAIL-RET-A
	Clear the PWR-FAIL-RET-A Alarm

	2.7.330 PWR-FAIL-RET-B
	Clear the PWR-FAIL-RET-A Alarm

	2.7.331 RAI
	Clear the RAI Condition

	2.7.332 RCVR-MISS
	Clear the RCVR-MISS Alarm

	2.7.333 RSV-RT-EXCD-RINGLET0
	Clear the RSV-RT-EXCD-RINGLET0 Alarm

	2.7.334 RSV-RT-EXCD-RINGLET1
	Clear the RSV-RT-EXCD-RINGLET1 Alarm

	2.7.335 RFI
	2.7.336 RFI-L
	Clear the RFI-L Condition

	2.7.337 RFI-P
	Clear the RFI-P Condition

	2.7.338 RFI-V
	Clear the RFI-V Condition

	2.7.339 RING-ID-MIS
	Clear the RING-ID-MIS Alarm

	2.7.340 RING-MISMATCH
	Clear the RING-MISMATCH Alarm

	2.7.341 RING-SW-EAST
	2.7.342 RING-SW-WEST
	2.7.343 ROLL
	2.7.344 ROLL-PEND
	2.7.345 ROUTE-OVERFLOW
	Clear the ROUTE-OVERFLOW Condition

	2.7.346 RPR-PASSTHR
	Clear the RPR-PASSTHR Condition

	2.7.347 RPR-PEER-MISS
	Clear the RPR-PEER-MISS Condition

	2.7.348 RPR-PROT-ACTIVE
	Clear the RPR-PROT-ACTIVE Condition

	2.7.349 RPR-PROT-CONFIG-MISM
	Clear the RPR-PROT-CONFIG-MISM Alarm

	2.7.350 RPR-RI-FAIL
	Clear the RPR-RI-FAIL Condition

	2.7.351 RPR-SD
	Clear the RPR-SD Condition

	2.7.352 RPR-SF
	Clear the RPR-SF Condition

	2.7.353 RPR-SPAN-MISMATCH
	Clear the RPR-SPAN-MISMATCH Alarm

	2.7.354 RPRW
	Clear the RPRW Condition

	2.7.355 RUNCFG-SAVENEED
	2.7.356 SD (DS1, DS3)
	Clear the SD (DS1, DS3) Condition

	2.7.357 SD (E1)
	Clear the SD (E1) Condition

	2.7.358 SD (TRUNK)
	2.7.359 SD-L
	Clear the SD-L Condition

	2.7.360 SD-L (TRUNK)
	2.7.361 SD-P
	Clear the SD-P Condition

	2.7.362 SD-V
	Clear the SD-V Condition

	2.7.363 SF (DS1, DS3)
	Clear the SF (DS1, DS3) Condition

	2.7.364 SF (E1)
	Clear the SF (E1) Condition

	2.7.365 SF (TRUNK)
	2.7.366 SF-L
	Clear the SF-L Condition

	2.7.367 SF-L (TRUNK)
	2.7.368 SF-P
	Clear the SF-P Condition

	2.7.369 SFTWDOWN
	2.7.370 SF-V
	Clear the SF-V Condition

	2.7.371 SHELF-COMM-FAIL
	2.7.372 SH-IL-VAR-DEG-HIGH
	2.7.373 SH-IL-VAR-DEG-LOW
	2.7.374 SHUTTER-OPEN
	2.7.375 SIGLOSS
	Clear the SIGLOSS Alarm

	2.7.376 SNTP-HOST
	Clear the SNTP-HOST Alarm

	2.7.377 SPANLEN-OUT-OF-RANGE
	2.7.378 SPAN-SW-EAST
	2.7.379 SPAN-SW-WEST
	2.7.380 SQUELCH
	Clear the SQUELCH Condition

	2.7.381 SQUELCHED
	Clear the SQUELCHED Condition

	2.7.382 SQM
	Clear the SQM Alarm

	2.7.383 SSM-DUS
	2.7.384 SSM-FAIL
	Clear the SSM-FAIL Alarm

	2.7.385 SSM-LNC
	2.7.386 SSM-OFF
	Clear the SSM-OFF Condition

	2.7.387 SSM-PRC
	2.7.388 SSM-PRS
	2.7.389 SSM-RES
	2.7.390 SSM-SDH-TN
	2.7.391 SSM-SETS
	2.7.392 SSM-SMC
	2.7.393 SSM-ST2
	2.7.394 SSM-ST3
	2.7.395 SSM-ST3E
	2.7.396 SSM-ST4
	2.7.397 SSM-STU
	Clear the SSM-STU Condition

	2.7.398 SSM-TNC
	2.7.399 STS-SQUELCH-L
	2.7.400 SW-MISMATCH
	Clear the SW-MISMATCH Condition

	2.7.401 SWMTXMOD-PROT
	Clear the SWMTXMOD-PROT Alarm

	2.7.402 SWMTXMOD-WORK
	Clear the SWMTXMOD-WORK Alarm

	2.7.403 SWTOPRI
	2.7.404 SWTOSEC
	Clear the SWTOSEC Condition

	2.7.405 SWTOTHIRD
	Clear the SWTOTHIRD Condition

	2.7.406 SYNC-FREQ
	Clear the SYNC-FREQ Condition

	2.7.407 SYNCLOSS
	Clear the SYNCLOSS Alarm

	2.7.408 SYNCPRI
	Clear the SYNCPRI Alarm

	2.7.409 SYNCSEC
	Clear the SYNCSEC Alarm

	2.7.410 SYNCTHIRD
	Clear the SYNCTHIRD Alarm

	2.7.411 SYSBOOT
	2.7.412 TEMP-MISM
	Clear the TEMP-MISM Condition

	2.7.413 TIM
	Clear the TIM Alarm

	2.7.414 TIM-MON
	Clear the TIM-MON Alarm

	2.7.415 TIM-P
	Clear the TIM-P Alarm

	2.7.416 TIM-S
	Clear the TIM-S Alarm

	2.7.417 TIM-V
	Clear the TIM-V Alarm

	2.7.418 TPTFAIL (CEMR, CE100T, CE1000)
	Clear the TPTFAIL (CEMR, CE100T, CE1000) Alarm

	2.7.419 TPTFAIL (FCMR)
	Clear the TPTFAIL (FCMR) Alarm

	2.7.420 TPTFAIL (G1000)
	Clear the TPTFAIL (G1000) Alarm

	2.7.421 TPTFAIL (ML100T, ML1000, MLFX)
	Clear the TPTFAIL (ML100T, ML1000, MLFX) Alarm

	2.7.422 TRMT
	Clear the TRMT Alarm

	2.7.423 TRMT-MISS
	Clear the TRMT-MISS Alarm

	2.7.424 TX-AIS
	Clear the TX-AIS Condition

	2.7.425 TX-LOF
	Clear the TX-LOF Condition

	2.7.426 TX-RAI
	Clear the TX-RAI Condition

	2.7.427 UNC-WORD
	2.7.428 UNEQ-P
	Clear the UNEQ-P Alarm
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	Clear the UNEQ-V Alarm
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	Clear the UNQUAL-PPM Condition
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	Clear the VCG-DEG Condition
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	Clear the VOLT-MISM Condition
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	2.7.441 WKSWPR
	Clear the WKSWPR Condition

	2.7.442 WORK-QUEUE-FULL
	2.7.443 WTR
	Clear the WTR Condition on an IEEE 802.17b-Based RPR Span

	2.7.444 WVL-MISMATCH
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